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Welcome to the User's Guide for Oracle JDeveloper.
This document is intended for developers that use Oracle JDeveloper and provides detailed information on the functionality available in IDE.
Our goal is to make Oracle products, services, and supporting documentation accessible to all users, including users that are disabled. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Accessibility standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For more information, visit the Oracle Accessibility Program Web site at http://www.oracle.com/accessibility/.
Accessibility of Code Examples in Documentation
Screen readers may not always correctly read the code examples in this document. The conventions for writing code require that closing braces should appear on an otherwise empty line; however, some screen readers may not always read a line of text that consists solely of a bracket or brace.
Accessibility of Links to External Web Sites in Documentation
This documentation may contain links to Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.
Deaf/Hard of Hearing Access to Oracle Support Services
To reach Oracle Support Services, use a telecommunications relay service (TRS) to call Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle technical issues and provide customer support according to the Oracle service request process. Information about TRS is available at http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html.
The following text conventions are used in this document:
| Convention | Meaning |
|---|---|
| boldface | Boldface type indicates graphical user interface elements associated with an action, or terms defined in text or the glossary. |
| italic | Italic type indicates book titles, emphasis, or placeholder variables for which you supply particular values. |
monospace | Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter. |
For Release 11.1.2.0.0 the Oracle Fusion Middleware User Guide for Oracle JDeveloper replaces the non-context sensitive online help that was available in previous releases of Oracle JDeveloper.
While this guide is applicable to both the Studio and Java editions of Oracle JDeveloper, the following chapters only apply to the Studio edition of JDeveloper:
For changes made to Oracle JDeveloper and Oracle Application Development Framework (Oracle ADF) for this release, see the What's New page on the Oracle Technology Network at http://www.oracle.com/technetwork/developer-tools/jdev/documentation/index.html.
This part describes the general concepts of working with Oracle JDeveloper and contains the following chapters:
This chapter provides an introduction to JDeveloper, including resources available for you to learn Oracle JDeveloper and understand its features.
This chapter provides information on the accessibility features of JDeveloper.
This chapter provides information on working in the JDeveloper IDE.
This chapter provides an overview of Oracle JDeveloper.
This chapter includes the following sections:
JDeveloper is an integrated development environment (IDE) for building applications using the latest standards for Java, XML, Web services, and SQL. It supports the complete development lifecycle with integrated features for modeling, coding, debugging, testing, profiling, tuning, and deploying applications. JDeveloper is the main development platform for the Oracle Fusion Middleware suite of products. It is a cross-platform IDE that runs on Windows, Linux, Mac OS X, and other UNIX-based systems.
Oracle JDeveloper provides a visual and declarative development approach and works together with the Oracle ADF to simplify development.
Key features of JDeveloper include:
JDeveloper is available in two editions: Oracle JDeveloper Studio and Oracle JDeveloper Java. The Studio edition is the complete version of JDeveloper and includes all features. The Java edition contains only the core Java and XML features, and offers shorter download times. This guide is applicable to both editions of JDeveloper.
This section provides resources designed to get you up and running quickly on Oracle JDeveloper. You can learn about Oracle JDeveloper using various methods in addition to this guide, including online demonstrations, tutorials, and the Oracle Technology Network (OTN) forum. For more information, see Table 1-1, "Supporting Oracle JDeveloper Resources".
Table 1-1 Supporting Oracle JDeveloper Resources
| Resource | Description |
|---|---|
| Online demonstrations | Online demonstrations provide visual instructions for completing common tasks. All you need to watch the demos is your web browser with flash plug-in and a sound card. You can use the playback bar at the bottom of each demo to control the speed and flow of the demo. The demos are located at: |
| Oracle JDeveloper Tutorials | The tutorials provide step-by-step instructions to accomplish specific tasks in Oracle JDeveloper. The tutorials are located at: |
| Oracle Fusion Order Demo Sample Application | The Fusion Order Demo (FOD) is an end-to-end application sample application developed with the purpose of demonstrating common use cases in Fusion Middleware applications, including the integration between different components of the Fusion technology stack, (ADF, BPEL, and WebCenter). The demo contains several applications that make up various parts of functionality. The FOD is located at: |
| OTN Oracle JDeveloper Forum | You can use the Oracle JDeveloper page on the OTN forum to ask a question, contribute to a discussion, or interact with other users. The Oracle JDeveloper page on the OTN forum is located at: |
For complete information on supported migration paths, on how to migrate applications and projects or information about importing preferences and settings from an earlier version of Oracle JDeveloper to Oracle JDeveloper 11g, see the Oracle Fusion Middleware Installation Guide for Oracle JDeveloper.
This chapter provides information on the accessibility features of Oracle JDeveloper.
This chapter includes the following sections:
It is our goal to make Oracle Products, Services, and supporting documentation accessible to the disabled community. Oracle JDeveloper supports accessibility features. For additional accessibility information for Oracle products, see the Oracle Accessibility Program page at:
In order for assistive technologies, like screen readers, to work with Java-based applications and applets, the Windows-based computer must also have Sun's Java Access Bridge installed. Please refer to the Oracle Fusion Middleware Installation Guide for Oracle JDeveloper for the screen reader setup procedure, and for the recommended minimum technology stack.
Oracle JDeveloper provides features that are designed to support accessibility.
Oracle JDeveloper features support keyboard access to JDeveloper functionality; a summary is provided below. The mnemonic keys used to open menus and choose commands are included in all procedural topics. Please refer to the keyboard navigation topics for a summary of how keys are assigned within JDeveloper and the lists of accelerator keys provided for commands.
The following menu and toolbar functionality is provided through keyboard access:
The following functionality is available in JDeveloper IDE windows, which include the Application Navigator, Structure window, source editor, Property Inspector, Constraints, Profilers, Debugger windows, Help windows, Log windows and BC4J Tester. Users can:
| Tips:
|
The following functionality is available in Oracle JDeveloper dialogs and wizards:
Navigation and controls are available with runtime applications, which include all runnable files that are produced with Oracle JDeveloper, including Java applications, HTML applications, applets, JSF (Faces) applications, JSPs, and Servlets. With runtime applications, users can:
Here is a summary of screen readability in JDeveloper, when it is used with a screen reader.
When used with menus and toolbars:
When used with JDeveloper IDE windows:
When used with dialogs and wizards:
When used with runtime applications:
The user interface in JDeveloper improves usability for people who are visually impaired by offering flexibility in color and font choices. The following font and color features are included:
In JDeveloper, there is no situation in which the only feedback a user receives is audible feedback. All audible feedback is accompanied by a visual indicator. For example, a prompt accompanies the bell sound that occurs when an error or illegal action has taken place.
JDeveloper makes minimal use of a blinking cursor and animation:
The JDeveloper user interface works well with screen magnifiers. All features of the product can be magnified by a screen magnifier.
When you press Enter on a node in the Application Navigator, you open the default editor for that file. To switch to the different editors and views available for a document; for example, to display a JSP file in source view or history view instead of design view, you can use the Alt+Page Up and Alt+Page Down accelerators to invoke the Window > Go to > Right Editor and Window > Go to > Left Editor menu commands, respectively.
To have the text in a multi-line edit field read by a screen reader, you can select text by holding down the Shift key while moving the cursor either up or down with the Arrow keys, depending on the initial cursor position.
To have the line number read by a screen reader while you are editing a file in the source editor, you can press Ctrl+G.
After generating exception stack HTML links or Javadoc links in the Log window, they will not be recognized as links, but read as plain text by a screen reader. To access the links, set the cursor focus to the Log window. Right-click or press Shift+F1 and select Save As from the context menu. Save the contents of the Log window as an HTML file. Add the saved HTML file to a project or application workspace as a resource. Open the file from the Application Navigator in order to invoke the Oracle JDeveloper HTML/JSP visual editor, which will display the links correctly. Navigate the file and access the links from the HTML/JSP visual editor.
JDeveloper provides a number of customization features that enable users to specify their requirements for keyboard usage, display attributes of the IDE, and timing where appropriate. All customization features are organized within the Preferences dialog. For maximum usability and to accommodate your needs, you should consider changing any of the following from the defaults to a more usable customized setting.
You can add and change the default accelerator keys for Oracle JDeveloper in the Tools > Preferences > Shortcut Keys page. You can also load preset keymaps that you are accustomed to using.
In addition to changing the mapped accelerator keys, you can pass a conflicting accelerator key to JAWS by preceding the accelerator key combination with Insert+F3.
You can change the default look and feel for Oracle JDeveloper in the Tools > Preferences > Environment page. The look and feel determines the display colors and shapes of objects like menus and buttons.
You can change the font and font size that display in editors in the Tools > Preferences > Code Editor > Fonts page.
You can change the font style, as well as the foreground and background colors used in syntax highlighting within the source editor in the Tools > Preferences > Code Editor > Syntax Colors page.
You can display or hide line numbers in the source editor in the Tools > Preferences > Code Editor > Line Gutter page.
Oracle JDeveloper includes features that are highly visual, and these features have equivalent functionality that is available to people who are blind or visually impaired:
You can add a component from the Component Palette to the UI or visual editor using keystrokes.
Oracle JDeveloper also includes modeling features. It is possible to create, edit and move elements on a diagram using only keystrokes.
This chapter is designed to get you up and running quickly on Oracle JDeveloper. Find information about working with the general development environment, source files, connections, using the online help, and common development tools.
This chapter includes the following sections:
JDeveloper is the main development platform for the Oracle Fusion Middleware suite of products. It is a cross-platform IDE that runs on Windows, Linux, Mac OS X, and other UNIX-based systems.
Roles enable you to tailor the JDeveloper environment. The modified environment removes items that you do not need from JDeveloper, including menus, preferences, New Gallery, and even individual fields on dialogs. The role you select determines which features and options are available to you as you work in JDeveloper.
The roles available are:
| Note: The full set of online help is always available regardless of the role you have chosen for JDeveloper. |
JDeveloper prompts you to select a role the first time it is run. You can also change the role while JDeveloper is running.
To change the JDeveloper role:
To optimize performance and user experience, JDeveloper allows you to just load the features you need for your project. Managing features enables you to see only those components of the IDE that are most relevant to your work. Managing features has no affect on the data in a project itself.
For example, assume two projects used to create two different views into an application. The first project might have Java features loaded, which informs JDeveloper that the IDE should reflect the Java technology stack. Such filtering eliminates clutter from individual projects. The second project might have a features loaded for Swing/AWT, informing JDeveloper to reflect IDE components required for Swing/AWT development.
To add or remove features in JDeveloper:
JDeveloper allows you to arrange the windows according to your convenience. JDeveloper uses two kinds of windows in the IDE:
Double-click the title bar of any JDeveloper window to quickly maximize to full screen view. Double-click the title bar again to return the window to its former position in the IDE.
You can minimize any dockable window in JDeveloper, or set it to remain open in place. The default state is set to remain open.
When a window is set to stay open, its position is static. It remains always visible, in whichever position you have docked it.
When a window is set to minimize, its behavior is more fluid. When you give it focus, it opens fully in the general area (top, bottom, left, right) where you last left it docked. When you move the focus elsewhere, the minimized window collapses into the margin. Whether open or closed, any minimized window's status set to minimize is identified by a named button in the margin.
To minimize any dockable window:
If the window currently has focus, it now expands to full height and remains in place. If the window does not have focus, it collapses into the margin.
When you minimize a window, a button bearing that window's name appears in the margin. You can toggle the minimized window open and closed with this button.
| Note: When you minimize a window that exists in a docking zone that also contains other windows, all windows in the docking zone are minimized. |
All of the tools available under the View menu—the Application Navigator, Structure window, Property Inspector, and so on—can be arranged however you like. You can dock them singly or in groups. You can also tab windows together in one location, either as docked or floating windows.
The following table provides information on how to move dockable windows.
| Requirement | Action |
|---|---|
| Move a solitary docked window | Grab its title bar and drag |
| Decouple a docked window from a group | Grab its title bar and drag |
| Move a group of docked, tabbed, or docked and tabbed windows | Grab the title bar for the group—the topmost horizontal title bar, empty but for the close box—and drag. |
| To decouple one tabbed window from a group | Grab the window's tab and drag. |
| Note: The title bars for docked windows sometimes appear vertically, on the side of the window. |
The following table provides information on ways to reposition dock windows:
| Requirement | Action |
|---|---|
| Dock a window (or window group) against another edge of the development area | Drag the window (or window group) to the destination edge |
| Dock a window (or window group) alongside another window | Drag the window (or window group) to the top, bottom, or side edge of the docked window |
| Tab one window with another | Drag the window to be tabbed into the center of the destination window (or window group) and release |
You can float any window that's normally docked—the Application Navigator, any custom navigator, the Log window, the Property Inspector, the Component Palette. You can also resize and position it wherever you would like within JDeveloper.
Generally, floating windows are best suited for a large screen with enough room for displaying both the information windows and your source code. If you are using floating palettes on a smaller screen they can sometimes be hidden by other information windows as you work.
You can easily open and close the main elements of the JDeveloper IDE, which include the navigators, Structure window, Property Inspector, Component Palette, Resource Palette and Log window.
To open a closed window:
You can close an open window in one of these ways:
You can accomplish any task in JDeveloper using the keyboard as you use the mouse.
JDeveloper comes with several predefined keyboard schemes. You can choose to use one of these, or customize an existing set to suit your own coding style by changing which keyboard shortcuts map to which actions.
To load preset keyboard schemes:
To view JDeveloper commands and their associated keyboard shortcuts (if assigned):
To define a new keyboard shortcut for a command within a given keyboard scheme:
If this proposed shortcut already has a command associated with it, that command will now appear in the Conflicts field. Any conflicting shortcuts are overwritten when a new shortcut is assigned.
If you want to assign more than one shortcut to a command, select the command and click the Duplicate button. Then, type the shortcut key in the New Shortcut field and click Assign.
To import or export keyboard schemes:
For any action that can be accomplished with a mouse, including selection, there is a way to accomplish the action solely from the keyboard. You can accomplish any task in JDeveloper using the keyboard as you can using the mouse.
The shortcut keys defined in the Java Look and Feel guidelines provide the base set for JDeveloper. The various predefined keyboard schemes available in JDeveloper are then overlaid upon this base set. If the same shortcut key exists in both the look and feel guidelines and the JDeveloper keyboard scheme, the JDeveloper scheme prevails. If a shortcut key defined by the look and feel guidelines does not appear in a JDeveloper scheme, then it is the original look and feel definition that remains in effect when the scheme in question is enabled.
At any given time, then, the shortcut keys enabled in JDeveloper depend upon the interaction of the currently enabled scheme with the Java look and feel guidelines. When you first open JDeveloper, the default scheme is enabled. You can change this scheme whenever you wish, and within each scheme, you can customize any of the shortcut key assignments that you would like. Note that any customized shortcuts you create in a scheme are not retained when another predefined keyboard scheme is activated (or even if the same scheme is reloaded).
To load predefined keyboard schemes, view current shortcut assignments within a scheme, and customize those assignments, you will need to open the preferences dialog. To open the dialog, choose Tools > Preferences (or on the keyboard, press Alt+T+P) from the main menu and then, using the arrow keys in the left-hand pane, navigate to the Shortcut Keys node. For details on working with the dialog, with the page displayed, click Help (or on the keyboard press H).
The following table describes the common methods of moving the cursor in JDeveloper:
Table 3-1 Common Methods of Moving the Cursor
| Key | Cursor Movement | Ctrl+cursor Movement |
|---|---|---|
| Left Arrow | Left one unit (e.g., a single character) | Left one proportionally larger unit (e.g., a whole word) |
| Right Arrow | Right one unit | Right one proportionally larger unit |
| Up Arrow | Up one unit or line | Up one proportionally larger unit |
| Down Arrow | Down one unit or line | Down one proportionally larger unit |
| Home | Beginning of the line | To the beginning of the data (top-most position) |
| End | End of the line | To the end of the data (bottom-most position) |
| Tab | Next field or control, except when in a text area or field. In this case, press Ctrl+Tab to navigate out of the control. Where there are fields and controls ordered horizontally as well as vertically, pressing Tab moves the cursor first horizontally to the right, then at the end of the line, down to the left of the next line. | To the next pane which may be a navigator, an editor, or a palette, except when in a text area or field. In this case, press Ctrl+Tab to navigate out of the control |
| Shift+Tab | Previous field | To previous tab position. In property sheets, this moves the cursor to the next page |
| Enter | Selects and highlights the default button, except when in a combo box, shuttle button, or similar control. Note: The default button changes as you navigate through controls. | n/a |
This section describes keyboard navigation in standard JDeveloper components.
Buttons
The following table describes the keyboard actions to perform navigation tasks involving buttons.
Table 3-2 Keyboard Navigation for Buttons
| Navigation | Keys |
|---|---|
| Navigate forward to or from button | Tab |
| Navigate backward to or from button | Shift+Tab |
| Activate the default button (when the focus is not on a button) | Enter |
| Activate any button while it has focus | Enter, Spacebar, or keyboard shortcut (if one has been defined) |
| Activate Cancel or Close buttons on a dialog | Esc |
Checkboxes
The following table describes the keyboard actions to perform navigation tasks involving checkboxes.
Table 3-3 Keyboard Navigation for Checkboxes
| Navigation | Keys |
|---|---|
| Navigate forward to or from checkbox | Tab |
| Navigate backward to or from checkbox | Shift+Tab |
| Select or deselect (when the focus is on the checkbox) | Spacebar or keyboard shortcut (if one has been defined) |
| Navigate to checkbox and select or deselect (when the focus is not on the checkbox) | Keyboard shortcut (if one has been defined) |
Dropdown Lists And Combo Boxes
The following table describes the keyboard actions to perform navigation tasks involving dropdown lists and combo boxes.
Table 3-4 Keyboard Navigation for Dropdown Lists and Combo Boxes
| Navigation | Keys |
|---|---|
| Navigate forward to or from a combo box or dropdown list | Tab or keyboard shortcut (if one has been defined) |
| Navigate backward to or from a combo box or dropdown list | Shift+Tab |
| Toggle list open and closed | Spacebar (the current selection receives the focus) |
| Open a list | Down Arrow to open (first item on list receives focus) |
| Move up or down within list | Up and Down Arrow keys (highlighted value has focus) |
| Move right and left within the initial entry on a combo box | Right and Left Arrow keys |
| Select list item | Enter Note: The first time you press Enter, the item in the list is selected. The second time you press Enter, the default button is activated. |
| Close list (with the highlighted value selected) | Esc |
List Boxes
The following table describes the keyboard actions to perform navigation tasks involving list boxes.
Table 3-5 Keyboard Navigation for List Boxes
| Navigation | Keys |
|---|---|
| Navigate forward into or out of a list | Tab |
| Navigate backward into or out of list | Shift+Tab |
| Make a selection | Up Arrow, Down Arrow, Spacebar, or Enter Note: The first time you press Enter, the highlighted item in the list is selected. The second time you press Enter, the default button is activated. |
| Move within list | Up Arrow or Down Arrow |
| Move to beginning of list | Home or Ctrl+Home |
| Move to end of list | End or Ctrl+End |
| Select all entries | Ctrl+A |
| Toggle (select or deselect) an item | Spacebar or Ctrl+Spacebar |
| Select next item up in list without deselecting item with current focus | Shift+Up Arrow Key |
| Select next item down in list without deselecting item with current focus | Shift+Down Arrow Key |
| Select current item and all items up to the top of the list | Shift+Home |
| Select current item and all items up to the bottom of the list | Shift+End |
| Select current item and all items visible above that item | Shift+Page Up |
| Select current item and all items visible below that item | Shift+Page Down |
| Select item with current focus without deselecting other items (to select items that are not adjacent) | Ctrl+Spacebar |
| Navigate through list without deselecting item with current focus. | Ctrl+Up Arrow or Ctrl+Down Arrow |
Radio Buttons
Table 3-6 Keyboard Navigation for Radio Buttons
| Navigation | Keys |
|---|---|
| Navigate forward to or from radio button | Tab |
| Navigate backward to or from radio button | Shift+Tab |
| Navigate forward from radio button | Arrow Keys |
| Navigate backward from radio button | Shift+Arrow Keys |
| Select radio button | Arrow key (navigating to a radio button via arrows selects it) or keyboard shortcut (if one has been defined) |
| Deselect radio button | Select a different radio button in the group using one of the commands above |
Shuttles
The following table describes the keyboard actions to perform navigation tasks involving shuttles.
Table 3-7 Keyboard Navigation for Shuttles
| Navigation | Keys |
|---|---|
| Navigate forward into or out of a list | Tab |
| Navigate backward into or out of list | Shift+Tab |
| Make a selection | Up Arrow or Down Arrow |
| Move within list | Up Arrow or Down Arrow |
| Move to beginning of list | Home or Ctrl+Home |
| Move to end of list | End or Ctrl+End |
| Select all entries | Ctrl+A |
| Toggle (select or deselect) an item | Spacebar or Ctrl+Spacebar |
| Select next item up in list without deselecting item with current focus | Select next item up in list without deselecting item with current focus |
| Select next item down in list without deselecting item with focus | Shift+Down Arrow Key |
| Select current item and all items up to the top of the list | Shift+Home |
| Select current item and all items up to the bottom of the list | Shift+End |
| Select current item and all items visible above that item | Shift+Page Up |
| Select current item and all items visible below that item | Shift+Page Down |
| Select item with current focus without deselecting other items (to select items that are not adjacent) | Ctrl+Spacebar |
| Navigate through list without deselecting item with current focus. | Ctrl+Up Arrow or Ctrl+Down Arrow |
Sliders
The following table describes the keyboard actions to perform navigation tasks involving sliders.
Table 3-8 Keyboard Navigation for Sliders
| Navigation | Keys |
|---|---|
| Navigate forward to or from slider | Tab |
| Navigate backward to or from slider | Shift+Tab |
| Increase value | Up Arrow or Right Arrow |
| Decrease value | Left Arrow or Down Arrow |
| Minimum value | Home |
| Maximum value | End |
Spin Controls
The following table describes the keyboard actions to perform navigation tasks involving spin controls.
Table 3-9 Keyboard Navigation for Spin Controls
| Navigation | Keys |
|---|---|
| Navigate forward to or from spin control | Tab |
| Navigate backward to or from spin control | Shift+Tab |
| Increase value | Up Arrow or Right Arrow, or type the value you want |
| Decrease value | Left Arrow or Down Arrow, or type the value you want |
| Minimum value | Home |
| Maximum value | End |
Text Fields
The following table describes the keyboard actions to perform navigation tasks involving text fields.
Table 3-10 Keyboard Navigation for Text Fields
| Navigation | Keys |
|---|---|
| Navigate forward into or out of text box | Tab or keyboard shortcut (if one has been defined) |
| Navigate backward into or out of text box | Shift+Tab |
| Move to previous/next character within text box | Left Arrow/Right Arrow |
| Move to start/end of box | Home/End |
| Select all text | Ctrl+A |
| Deselect all text | Left Arrow or Right Arrow |
| Select current item and all items up to the Left/Right | Shift+Left Arrow, Shift+Right Arrow |
| Select current item and all items up to the Start/End | Shift+Home, Shift+End |
| Select current item and all items up to the previous/next word | Ctrl+Shift+Left Arrow, Ctrl+Shift+Right Arrow |
| Copy selection | Ctrl+C |
| Cut selection | Ctrl+X |
| Paste from clipboard | Ctrl+V |
| Delete next character | Delete |
| Delete previous character | Backspace |
This section contains information about keyboard shortcuts for complex UI components.
Dockable Windows
The following table describes the keyboard actions to perform navigation tasks involving dockable windows.
Table 3-11 Keyboard Navigation for Dockable Windows
| Navigation | Keys |
|---|---|
| Navigate forward in or out of dockable window | Ctrl+Tab |
| Navigate backward in or out of dockable window | Ctrl+Shift+Tab |
| Display context menu | Shift+F10 |
| Navigate between tabs within a dockable window | Alt+Page Down, Alt+Page Up |
| Move between elements including dropdown lists, search fields, panels, tree structure (but not individual elements in a tree), individual component buttons | Tab |
| Move up/down through dockable window contents (scrollbar) | Up Arrow, Down ArrowThis scrolls the window contents if the focus moves beyond visible area of canvas. |
| Move left/right (scrollbar) | Up Arrow, Down ArrowThis scrolls the pane contents if focus moves beyond visible area of canvas. |
| Move to start/end of data (component buttons) | Ctrl+Home, Ctrl+End |
| Select an element | Enter or Spacebar |
| Scroll left/right within the canvas area (without moving through the window contents) | Ctrl+Left/Ctrl+Right |
| Scroll Up/Down within the canvas area (without moving through the window contents) | Ctrl+Up/Ctrl+Down |
Menus
Context menus are accessed using Shift+F10. Menus from the main menu bar are accessed using the keyboard shortcut for the menu.
The following table describes the keyboard actions to perform navigation tasks involving the menu bar.
Table 3-12 Keyboard Navigation for Menus
| Navigation | Keys |
|---|---|
| Navigate to menu bar | F10 |
| Navigate out of menu bar | Esc |
| Navigate between menus in menu bar | Right Arrow, Left Arrow |
| Navigate to menu item | Up Arrow, Down Arrow |
| Navigate from menu item | Up Arrow, Down Arrow |
| Activate item | Enter, Spacebar, or keyboard shortcut (if one has been defined) |
| Open submenu | Right Arrow |
| Retract submenu | Left Arrow or Esc |
Panels
The following table describes the keyboard actions to perform navigation tasks involving panels.
Table 3-13 Keyboard Navigation for Panels
| Navigation | Keys |
|---|---|
| Navigate in/out forward | Tab |
| Navigate in/out backward | Shift+Tab |
| Expand panel (when focus on header) | Right Arrow |
| Collapse panel (when focus on header) | Left Arrow |
| Navigate within panel | Up Arrow, Down Arrow |
| Navigate to panel header from contents (when focus is on top item in list) | Up Arrow |
| Navigate to panel contents from header (when focus is on header) | Down Arrow |
Tables
Arrow keys move focus in the direction of the arrow, except when a web widget has focus; in that case, the down arrow or enter key initiates the widget control action, such as opening a choice list. tab moves the focus right, shift+tab moves the focus left.
The following table describes the keyboard actions to perform navigation tasks involving tables.
Table 3-14 Keyboard Navigation for Tables
| Navigation | Keys |
|---|---|
| Navigate forward in or out of table | Ctrl+Tab |
| Navigate backward in or out of table | Shift+Ctrl+Tab |
| Move to next cell (wrap to next row if in last cell) | Tab Arrow or Right Arrow |
| Move to previous cell (wrap to previous row if in first cell) | Shift+Tab or Left Arrow |
| Controls in cells open | Down Arrow or Enter |
| Block move left | Ctrl+Page Up |
| Block move right | Ctrl+Page Down |
| Block move up | Page Up |
| Block move down | Page Down |
| Move to first cell in row | Home |
| Move to last cell in row | End |
| Move to first cell in table | Ctrl+Home |
| Move to last cell in table | Ctrl+End |
| Select all cells | Ctrl+A |
| Deselect current selection (and select alternative) | Any navigation key |
| Extend selection on row | Shift+Up Arrow |
| Extend selection one column | Shift+Down Arrow |
| Extend selection to beginning of row | Shift+Home |
| Extend selection to end of row | Shift+End |
| Extend selection to beginning of column | Ctrl+Shift+Home |
| Extend selection to end of column | Ctrl+Shift+End |
| Edit cell without overriding current contents, or show dropdown list in combo box | F2 |
| Reset cell content prior to editing | Esc |
Tabs
This section refers to the tabs that appear within a dockable window, view or dialog. The following table describes the keyboard actions to perform navigation tasks involving tabs in dockable windows, views and dialogs.
Table 3-15 Keyboard Navigation for Tabs
| Navigation | Keys |
|---|---|
| Navigate forward into or out of tab control | Tab |
| Navigate backward into or out of tab control | Ctrl+Tab |
| Move to tab (within control) left/right | Left Arrow/Right Arrow |
| Move to tab (within control) above/below | Up Arrow/Down Arrow |
| Move from tab to page | Ctrl+Down |
| Move from page to tab | Ctrl+Up |
| Move from page to previous page (while focus is within page) | Ctrl+Page Up |
| Move from page to next page (while focus is within page) | Ctrl+Page Down |
Trees
The following table describes the keyboard actions to perform navigation tasks involving trees.
Table 3-16 Table Navigation for Trees
| Navigation | Keys |
|---|---|
| Navigate forward into or out of tree control | Tab |
| Navigate backward into or out of tree control | Shift+Tab |
| Expand (if item contains children) | Right Arrow |
| Collapse (if item contains children) | Left Arrow |
| Move to parent from child (if expanded) | Left Arrow |
| Move to child from parent (if already expanded) | Right Arrow |
| Move up/down one item | Up Arrow, Down Arrow |
| Move to first item | Home |
| Move to last entry | End |
| Select all children of selected parent | Ctrl+A |
| Select next item down in list without deselecting that item that currently has focus | Shift+Down Arrow |
| Select next item up in list without deselecting that item that currently has focus | Shift+Up Arrow |
| Select current item and all items up to the top of the list | Shift+Home |
| Select current item and all items up to the bottom of the list | Shift+End |
| Select the item with current focus without deselecting other items (to select items that are not adjacent) | Ctrl+Spacebar |
| Navigate through list without deselecting item with current focus | Ctrl+Up/Down Arrow |
Wizards
The Following Table Describes The Keyboard Actions To Perform Navigation Tasks Involving Wizards.
Table 3-17 Keyboard Navigation for Wizards
| Navigation | Keys |
|---|---|
| Navigate between stops on the roadmap or between pages | Up Arrow, Down Arrow (these do not wrap) |
| Navigate forward between components on wizard panel, wizard navigation bar buttons, and navigation panel | Tab |
| Navigate backward between components on wizard panel, wizard navigation bar buttons, and navigation panel | Shift+Tab |
| Navigate between buttons on Navigation Bar | Right and Left Arrow Key (does not wrap) |
| Navigate between stops on Roadmap/between wizard pages | Ctrl Page Up and Ctrl Page Down |
This section contains information about keyboard shortcuts for JDeveloper-specific UI components.
Dialogs
The following table describes the keyboard actions to perform navigation tasks involving dialogs.
Table 3-18 Keyboard Navigation for Dialogs
| Navigation | Keys |
|---|---|
| Close dialog without making any selections or changes | Esc |
| Activate the default button (if one is defined) | Enter |
Overview Editor (Form + Mapping)
The following table describes the keyboard actions to perform navigation tasks involving overview editors.
Table 3-19 Keyboard Navigation for the Overview Editor
| Navigation | Keys |
|---|---|
| Navigate into or out of overview editor from other pages in editor (for example Source or History) | Alt+Tab |
| Navigate from the tab group to next control in editor) | Tab or Ctrl+Down Arrow |
| Navigate forward or backwards between controls on overview editor | Tab or Alt+Tab |
| Move between tabs in the side tab control (when the focus in the tab group) | Up Arrow, Down Arrow |
| Move between tabs in side tab control (when focus on Page) | Ctrl+Page Up/Ctrl+Page Down |
| Move from page to tab group (from next control in editor) | Ctrl+Tab |
| Move from page to tab group (from any control in editor) | Ctrl+Up Arrow |
| Open and close Sections (when focus is on a section header) | Enter, Spacebar, Right Arrow/Left Arrow |
Component and Resource Palettes
The following table describes the keyboard actions to perform navigation tasks involving palettes.
Table 3-20 Keyboard Navigation for Component and Resource Palettes
| Navigation | Keys |
|---|---|
| Navigate forward in or out of palette | Ctrl+Tab This moves you into first item within the pane. |
| Navigate backward in or out of palette | Ctrl+Shift+Tab |
| Move between elements including dropdown lists, search fields, panels, tree structure (but not individual elements in a tree), individual component buttons | Tab, Shift+Tab |
| Move up/down elements in a list or tree | Up Arrow/Down Arrow |
| Move left/right elements in a list or tree | Left Arrow/Right Arrow |
| Move to start/end of data (component buttons) | Ctrl+Home/Ctrl+End |
| Select a component button | Enter |
Navigators
The following table describes the keyboard actions to perform navigation tasks involving navigators.
Table 3-21 Keyboard Navigation for Navigators
| Navigation | Keys |
|---|---|
| Navigate forward in or out of navigator | Ctrl+Tab This moves you into first item within the pane. |
| Navigate backward in or out of navigator | Ctrl+Shift+Tab |
| Move between elements including dropdown lists, search fields, panels, tree structure (but not individual elements in a tree), individual component buttons | Tab |
| Move up/down elements in a list or tree | Up Arrow/Down |
| Move left/right elements in a list or tree | Left Arrow/Right Arrow |
| Move to start/end of data (component buttons) | Ctrl+Home/Ctrl+End |
| Select a component button | Enter |
| Select an element | Enter |
Property Inspector
The following table describes the keyboard actions to perform navigation tasks involving the Property Inspector.
Table 3-22 Keyboard Navigation for the Property Inspector
| Navigation | Keys |
|---|---|
| Navigate forward into or out of Property Inspector | Ctrl+Tab |
| Navigate backward into or out of Property Inspector | Ctrl+Shift+Tab |
| Navigate from side tab group to page | Tab |
| Navigate backward and forwards between elements on page | Tab, Shift+Tab |
| Move to tab above/below (when focus is on the side tab) | Up Arrow, Down Arrow |
| Move to tab right or left, above or below (when focus is on the internal tab group) | Up Arrow, Down Arrow, Right Arrow, Left Arrow |
| Move from side tab group to page | Ctrl+Down Arrow |
| Move from page to side tab group | Ctrl+Up Arrow |
| Move to side tab above (previous) when focus on page | Ctrl+Page Up |
| Move to side tab below (next) when focus on page | Move to side tab below (next) when focus on page |
| Open and Close sections (when focus is on a section header) | Enter |
Text Editors
The following table describes the keyboard actions to perform navigation tasks involving the pane elements of text editors.
Table 3-23 Keyboard Navigation for Text Editors
| Navigation | Keys |
|---|---|
| Navigate forward in or out of editor | Ctrl+Tab |
| Navigate backward in or out of editor | Ctrl+Shift+Tab |
| Move from page to previous page | Alt+Page Up |
| Move from page to next page | Alt+Page Down |
The following table describes the keyboard actions to perform navigation tasks involving the text or canvas areas of text editors.
Table 3-24 Keyboard Navigation for Canvas Areas of Text Editors
| Navigation | Keys |
|---|---|
| Move up/down one line | Up Arrow, Down Arrow |
| Move left/right one character | Left Arrow, Right Arrow |
| Move to start/end of line | Home, End |
| Move to previous/next word | Ctrl+Left Arrow, Ctrl+Right Arrow |
| Move to start/end of text area | Ctrl+Home/Ctrl+End |
| Move to beginning/end of data | Ctrl+Home/Ctrl+End |
| Move up/down one vertical block | Page Up/Page Down |
| Block move left | Ctrl+Page Up |
| Block move right | Ctrl+Page Down |
| Block extend up | Shift+Page Up |
| Block extend down | Shift+Page Down |
| Block extend left | Ctrl+Shift+Page Up |
| Block extend right | Ctrl+Shift+Page Down |
| Select all | Ctrl+A |
| Deselect all | Up Arrow, Down Arrow, Left Arrow, Right Arrow |
| Extend selection up/down one line | Shift+Up Arrow/Shift+Down Arrow |
| Extend selection left/right one component or char | Shift+Left Arrow/Shift+Right Arrow |
| Extend selection to start/end of line | Shift+Home/Shift+End |
| Extend selection to start/end of data | Ctrl+Shift+Home/Ctrl+Shift+End |
| Extend selection up/down one vertical block | Shift+Page Up/Shift+Page Down |
| Extend selection to previous/next word | Ctrl+Shift+Left Arrow /Ctrl+Shift+Right Arrow |
| Extend selection left/right one block | Ctrl+Shift+Page Up/Ctrl+Shift+Page Down |
| Copy selection | Ctrl-C |
| Cut selection | Ctrl-X |
| Paste selected text | Ctrl-V |
Graphical Editors
The following table describes the keyboard actions to perform navigation tasks involving graphical editors.
Table 3-25 Keyboard Navigation for Graphical Editors
| Navigation | Keys |
|---|---|
| Navigate forward in or out of editor | Ctrl-Tab |
| Navigate backward in or out of editor | Ctrl+Shift+Tab |
| Move from page to previous page | Alt+Page Up |
| Move from page to next page | Alt+Page Down |
The following table describes the keyboard actions to perform navigation tasks involving the canvas areas of graphical editors.
Table 3-26 Keyboard Navigation for Canvas Areas of Graphical Editors
| Navigation | Keys |
|---|---|
| Move to the next focusable element within editor area | Up Arrow, Down Arrow, Left Arrow, Right Arrow |
| Select element | Spacebar |
| Activate context menu | Shift+F10 |
You can alter the appearance and functionality of a wide variety of JDeveloper features.
You can alter the appearance of JDeveloper using pre-defined settings.
To change the look and feel of the IDE:
| Note: The key bindings in Motif are different from key bindings in Windows. Under Motif, the arrow keys do not change the selection. Instead they change the lead focus cell. You must press Ctrl + Space to select an item. This is expected behavior. |
You can customize the default display options (such as whether or not the splash screen is displayed at start up, or whether dockable windows are always on top), as well as other general behavior, such as whether JDeveloper will automatically reload externally modified files and whether output to the Log window is automatically saved to a file.
To change the general environment settings for the IDE:
You can customize the layout for dockable windows in their docked position. You can also set dockable windows to remain on top of other GUI elements, or not, when those windows are moved.
To change the shape of one or more of the four docking areas:
To change whether dockable windows remain on top or not when moved:
You can customize the display of the Compare window.
To customize the options for comparing files:
The Component Palette offers you a quick method for inserting components into files open in the editor.
You can add pages to the Component Palette, within which to group additional components, or you can add components to existing pages.
To add a page to the Palette:
Alternately, right-click in the Component Palette and choose Add Page.
You can add pages to the Component Palette to group your JavaBeans components, or you can add components to existing pages. Once you add JavaBeans to the Palette, you can insert these beans into any file you have open in the Java Visual Editor by selecting them from the Palette.
To add a JavaBeans component to the Palette:
In the Class Path field, set the location of the bean class. If the bean is in an archive, use the archive. If the bean is contained in a project, use the output directory of that project.
Note that when you are creating your own JavaBeans for later deployment, it can be useful to defer putting them into an archive until you have finished development.
Skip to Step 6 if you do not want to add a new page.
Your new page name is added to the bottom of the Pages list in the Configure Component Palette dialog.
The new beans component now appears in the Component Palette when the appropriate page is selected. It also appears in the Components list of the Configure Component Palette dialog when the page it is associated with is selected in the Pages list.
You can add pages to the Component Palette to group your snippets, or you can add snippets to the existing Code Snippets page. Once you add snippets to the Palette, you can insert this code into any file you have open in the source editor by selecting the snippet from the Palette.
To add a Code Snippet to the Palette:
Skip to step 5 if you do not want to add a new page.
Your new page name is added to the bottom of the Pages list in the Configure Component Palette dialog.
The new snippet now appears in the Component Palette when the appropriate page is selected. It also appears in the Components list of the Configure Component Palette dialog when the page it is associated with is selected in the Pages list
Note that if you remove a page supplied by JDeveloper, the only way to recover it again is to restore the default setting for the Component Palette by moving the palette.xml file from jdev_install/system to jdev_install/system/release_and_build_number, where jdev_install is the root directory in which JDeveloper is installed.
To remove a page from the Palette:
If the page cannot be removed, the Illegal Request dialog appears.
The page no longer appears in the Component Palette dropdown list. It has also been removed from the Pages list of the Configure Component Palette dialog.
Alternately, with the page selected in the Component Palette, right-click in the Palette and choose Remove Page.
Note that if you remove a component supplied by JDeveloper, the only way to recover it again is to restore the default setting for the Component Palette by moving the palette.xml file from jdev_install/system to jdev_install/system/release_and_build_number, where jdev_install is the root directory in which JDeveloper is installed.
To remove a component from the Palette:
If the component cannot be removed, the Illegal Request dialog appears.
The component no longer appears in the Component Palette dropdown list. It has also been removed from the Components list of the Configure Component Palette dialog.
You cannot remove a component using the Component Palette context menu. You must work through the Configure Component Palette dialog.
You can change the roles that are used to shape JDeveloper. Shaping tailors the JDeveloper environment based on the role of the user.
When you change to a new role, it is only available after you restart JDeveloper.
To change the role for JDeveloper:
You can associate commonly used file types with JDeveloper. Once a file type has been associated with JDeveloper, opening a file of that type automatically launches JDeveloper. (This feature is supported only in Windows systems.)
To associate a file type with JDeveloper:
When designing and building applications, you may need to find and use many software assets. You may know what you want to find, but you may not certain where to find it or even what the artifact of interest is called. Even if you think you know where to find the artifact, and what it is called, you might not know how to establish a connection to the source repository. Consider the following:
The Resource Palette in JDeveloper addresses this. It lets you:
The resource palette allows you to create connections to a number of different resources, such as application servers, databases, WebDAV servers, from where you can use them in different applications and share them with other users.
To open the Resource Palette:
In the main menu, choose View > Resource Palette.
By default, the Resource Palette is displayed to the right of the JDeveloper window.
The connections defined in the Resource Palette are listed in the IDE Connections panel of the Resource Palette.
When you create a connection in JDeveloper, you can create it in the context of the Resource Palette as an IDE connection that can be reused in different applications, or shared between users, or as application connections.
Some types of connections may appear in special connection-type navigators. For example, database connections display in the Database Navigator under the IDE Connection node (for IDE connections), or the application-name node (for application resource connections). The Database Navigator is where you edit objects through the database connection.
The different types of connection that can be made depends on the technologies and extensions available to you. To see what you can create a connection to, choose New Connection from the New button in the Resource Palette.
The file system location for the Resource Palette connection descriptor definition information is
In JDeveloper 11g you have two ways of creating and managing connections. You can define a connection to be used in the context of an application (called an Application Resource connection), or for the IDE as a whole (called an IDE connection). You use the same dialog to define both of these, but their scope within JDeveloper is different.
When you first create a connection you choose the connection scope. You cannot subsequently change the connection scope.
These connections are locally scoped and just available within the application. Connections in application resources are artifacts of the application and are deployed within the application. These types of connection are listed in the Application Resources panel of the Application Navigator, under the Connections node.
The file system location for the connection descriptor definition information is application-folder/.adf/META-INF/connections.xml, where application-folder is the path for the selected application.
These are globally defined connections available for reuse, and they are listed in the IDE Connections panel of the Resource Palette. You can copy IDE connections to the application navigator to use them within an application.
You can create connections in the Resource Palette to resources available to JDeveloper.
The specific types of connections you can make depend on the technologies and extensions available to you.
To create an IDE connection:
Once you have created a connection in the Resource Palette, you can edit details of the connection, but you cannot change the connection name.
To edit an IDE connection:
You can use connections in the Resource Palette in an application.
The connection can be added to the application currently open in JDeveloper, and it is listed in the Application Resources panel of the Application Navigator, under the Connections node.
To add a connection to an application:
In the Resource Palette IDE Connections panel, choose Add to Application from the context menu of a connection.
Alternatively, drag the resource from the Resource Palette and drop it onto an application page.
Alternatively, drag the connection from IDE Connections in the Resource Palette and drop it onto the Application Resources pane in the Application Navigator.
There are two ways of searching in the Resource Palette:
In addition, you can define a dynamic folder in a catalog where the content of the folder is defined by a query expression that is executed when the folder is opened.
The time the search takes depends on how many resources there are in the Resource Palette, and how long it takes to connect to them, and the results are displayed in the Search Results panel.
You can stop a search before it has completed by clicking the Stop Search button.
In this case, the search is performed across all the contents of the Resource Palette, and it may take some time because JDeveloper connects to remote resources during the search.
To perform a simple search:
dep in the name, choose Name in step 1, and enter dep. Every resource that contains the string dep will be listed in the search results. You can specify a series of search criteria, and you can choose where to start the search from.
To perform an advanced search:
You can save a search and reuse it. There are two ways of saving a search in order to reuse it:
Dynamic folders can also be created directly in a catalog.
To save a search:
For more information at any time, press F1 or click Help from within the Resource Palette.
Filters allow you fine-tune the contents of catalog folders.
To filter the contents of My Catalogs:
Catalogs and connections are shared by importing Resource Catalog archive (.rcx) files that have been exported by another user.
To export a catalog:
| Note: When you select a catalog to export, any connections in the catalog are also selected. If you deselect the catalog before exporting, you must be sure to also deselect the connections that are not wanted in the archive file. |
To import a catalog:
You can refresh the contents of the Resource Palette.
To refresh the Resource Palette:
A catalog is a user-defined construct for organizing resources from multiple underlying repositories. The contents of a catalog and its associated folder structure can be designed to be used by an individual developer, or they can be targeted towards specific groups of users such as the UI designers for a development project.
Catalog folders organize resources in a catalog. You use catalog folders in the same way you would to organize files in a file system or bookmarks in a Web browser. Each catalog folder can contain any combination of:
You can organize the information in the resource palette in catalogs.
To create a catalog:
You can rename catalogs.
To rename a catalog:
You can create folders to organize the contents of catalogs.
You can organize the information within catalogs in folders.
To create a catalog folder:
Dynamic Folders provide a powerful way to dynamically populate a catalog folder with resources. The content of the folder is defined by a query expression that is executed when the folder is opened. The results of the query appear as the contents of the folder.
To create a dynamic folder:
You can add a connection from the IDE Connections panel or a resource from the Search panel in the Resource Palette to a catalog in My Catalogs.
To add a resource to a catalog:
Alternatively, you can drag an item from under IDE Connections and drop it on a catalog or catalog folder.
You can reorganize a catalog by selecting an item or folder in the catalog and dragging it to another folder in the same catalog, or to another catalog.
JDeveloper includes an editor for editing source files across several technologies, including Java and XML, among others.
JDeveloper includes an editor for editing source files across several technologies, including Java and XML, among others.
Depending on the type of source file you are editing, the source editor will be available in one of the following forms:
In addition to technology-specific features, the source editor also has a set of common features across all technologies that enhance the coding experience. These features include bookmarking, code insight, code templates, and several other features that enable you to code faster and better.
Use the Code Editor page in the Preferences dialog to customize the source editor to suit your coding style.
The source editor offers a set of common features across all technologies that provide intuitive support for a variety of coding tasks. Available across all forms of the editor, these features enhance your coding experience through quicker execution of coding tasks and better navigation through code.
Breadcrumb Navigation
The breadcrumb bar, located at the bottom of the editor window, shows the hierarchy of code entities from the current caret position up to the top of the file. Hovering the mouse cursor over a node pops up some information about the node, and clicking on the node navigates the caret to the node location.
A breadcrumb can be clicked to display a popup list of child breadcrumbs can be displayed (where appropriate). For example, for a Java class, you can click the breadcrumb to display the class' methods and inner classes in a list. Choosing an item on this list will navigate the editor to its location.
If block coloring has been activated and colors have been assigned, breadcrumbs are highlighted in the same color as their corresponding code blocks.
Overview Popup
The right margin of the editor provides colored overview marks that are indicators for a location in the source file. Hovering the mouse over an overview mark makes a popup appear which displays information about the item in that location of the source file, and a snippet of the relevant code.
The following overview indicators are provided:
You can also press Ctrl anywhere in the right margin to view a popup window that displays a portion of the source code that is not currently in view. By adjusting the position of the mouse while pressing Ctrl, you can view the entire code without scrolling in the editor itself
Hovers
Hovers enable you to position the mouse cursor over certain areas of the IDE and get some information on them in a popup window that appears floating in front.
Whitespace Display
Tools menu > Preferences > Code Editor > Display > Show Whitespace Characters
This feature optionally renders spaces, new lines, carriage returns, non-breaking spaces, and tab characters as visible characters in the editor. Turned off by default, this can be enabled and disabled using the Preferences Dialog.
Duplicate Selection
Edit menu > Duplicate Selection
Duplicates the currently selected block of code, and places the copied code beside the original code. After duplication, the newly inserted code is selected. The clipboard is not affected by this operation.
Vertical Selection
Edit menu > Wrap Selection
This feature enables you to select code vertically. when you do not want to select text that wraps around the end of lines. This is useful for selecting tabular data, or vertically aligned code blocks.
Join Lines
Join the current line to the next, or join all lines in a selection. Any comment delimiters or extra whitespace are intelligently removed to join the lines.
Default keyboard shortcut: Ctrl+J
Cursor Position
When the source editor is in use, the status bar at the bottom displays the line and column coordinates of the current position of the cursor.
Mouse Wheel Zoom
Hold down the Ctrl key and use the mouse scroller to zoom in to or zoom out of the code editor.
The generic source editor also provides a set of features through the context menu. To use these features, in the context menu, select Source. Depending on the type of source file in use, items other than the ones mentioned below may be present in the context menu. For example, the Java Source Editor contributes Java-specific options to the source editor context menu.
| Note: These features are also available through the Source menu. |
Completion Insight
Completion insight provides you with a list of possible completions, such as method names, and parameter types if they are applicable, at the insertion point, which you may use to auto-complete Java code you are editing. This list is generated based on the code context found at the insertion point. The contexts supported by completion insight are:
Default keyboard shortcut: Ctrl+Space
Parameter Insight
Parameter insight provides you with the types and names of the parameters of the method call you are typing. If the method is overloaded, multiple sets of parameter types and names are listed.
Default keyboard shortcut: Ctrl+Shift+Space
| Note: If errors for the file appear in the Structure window, Code (Completion or Parameter) Insight may not work. If the class(es) you are using are not in your project (that is, not on your classpath), Code Insight will not appear. Please note that you may need to compile your src files in order for Code Insight to have access to them. |
Complete Statement
Use to auto-complete code statements where such a completion is obvious to JDeveloper; for example, semi-colon insertions at the end of a statement.
Default keyboard shortcut: Ctrl+Shift+Enter
Expand Template
Insert a code template from a list of JDeveloper's predefined code templates. The code templates offered are context sensitive. For example, templates to declare class variables are only offered when the cursor is in the appropriate place in the class file.
Default keyboard shortcut: Ctrl+Enter
Code Assist
Code Assist examines your code in the editor and provides assistance to fix common problems. A Code Assist icon appears in the editor margin when JDeveloper has a suggestion for a code change. To invoke Code Assist manually, press Ctrl+Alt+Enter. To select an action listed in Code Assist, press Alt+ the underlined key.
Default keyboard shortcut: Ctrl+Alt+Enter
QuickDoc
Select to view the Javadoc or Jsdoc (depending on whether you are using the Java or JavaScript editor) for the element in focus.
Default Keyboard Shortcut: Ctrl+D
Toggle Line Comments
Comments out the line currently in focus in the source editor. Running this command on a commented line uncomments the line.
Default Keyboard Shortcut: Ctrl+Slash
Indent Block
Indents the line of code currently in focus. If a block of code is selected, the entire block is indented.
Unindent Block
Unindents a line or block of code, based on code has focus in the editor.
You can change the default settings of many of the features of the source editor by changing the preferences.
You can also view or change shortcut keys for the source editor, by modifying the predefined keyboard schemes.
To set tabs for the source editor:
To set fonts for the Source Editor
By default, all your system fonts are loaded. To limit the fonts available on this page to fixed-width fonts, select Display Only Fixed-Width Fonts.
To set caret behavior for the source editor:
For more information, press F1 or click Help from within the dialog page.
To set the options for width and the right margin in the source editor:
To set line gutter behavior for the source editor:
To set the options for syntax highlighting in the source editor:
The display on the page changes to reflect the current settings for the first style listed in this category, which is highlighted.
To set bookmark options for the source editor:
To set the options for Code Insight in the source editor:
Code templates assist you in writing code more quickly and efficiently while you are in the source editor. You can edit the existing templates or create your own.
To view existing code templates:
To edit an existing code template:
To define a new code template:
To customize the HTML and JSP options for the source editor:
To set undo behavior for the source editor:
To set printing options for the source editor:
Oracle JDeveloper possesses several capabilities for easier handling of files in the editor window.
You can open a file to fill the maximum view available in JDeveloper. This is done by maximizing the source editor to fill JDeveloper
The same technique of double-clicking a tab can be used for any of the other windows in JDeveloper, for example, the Help Center, or the Application Navigator.
To maximize the view of a file:
To reduce the view of a file to its former size
You can navigate through files visually (cycling through by tab), historically (cycling through by order of access), or numerically (cycling through based on file shortcut key assignment).
To navigate through open files by tab:
To navigate through open files based on history:
Use Ctrl+Tab to open the last active file. Note that opening a file renders it the currently active file, such that the previously active file now becomes the last file to have been active.
For example, given files A, B, and C (opened in the order C, B, A), where file A currently has focus, pressing Ctrl+Tab brings B to the foreground. Now B is the file with focus and A is the last active file. Pressing Ctrl+Tab again thus brings A back to the foreground.
You can display all the files currently open in the editor window, or all the files currently open in a particular tab group.
To display the alphabetical list of all the files currently open in a given tab group:
Click the File List button in the upper right-hand corner of the editor window. Alternately, with the focus in the editor window, press (in the default keyboard scheme) Alt+0.
If the editor window is not subdivided, the list will contain all open files. If the editor window is subdivided, the list will contain all the open files in that tab group.
To display the alphabetical list of all the files currently open in the editor window, regardless of split or detached files:
Oracle JDeveloper remembers the last files you have edited.
To access a recently-edited file, irrespective of whether it is currently open or not:
By default, only those files opened directly (through the navigator, for instance) appear in the list. Those opened indirectly (for example, as you debug code) do not automatically appear. To view files opened both directly and indirectly, select Show All.
You can split the editor window horizontally or vertically, opening a single file in multiple views. In each view, you've the choice of changing which editor the file is opened in.
You can split a file into as many views as you like. The split views are automatically synchronized with each other.
To open a single file in multiple views:
The editor window is now split in two, with two identical and independent windows opened on the same file. Each window has its own set of editor tabs at the bottom.
Note that some editors (such as the Java Visual Editor) permit only one view at a time on a file.
Alternately, you can split the file using the mouse, either horizontally or vertically.
To split the file horizontally, grab the splitter just above the vertical scroll bar (on the upper right-hand side of the window) and drag it downward.
To split the file vertically, grab the splitter just to the right of the horizontal scroll bar (on the lower right-hand side of the window) and drag it left.
To navigate quickly between split views:
To collapse those multiple views back into one:
Alternately, you can drag the splitter past the end of the editor window.
You can split the editor window horizontally or vertically, opening views on more than one file at a time. Each view is independent of the others
You can split the editor window into as many different independent views as you would like.
To view more than one file at a time, in independent windows:
The editor window is now split in two, with different files in each window. Each window has a set of document tabs at the top and a set of editor tabs at the bottom. Each window is known as a tab group.
You can create as many tab groups as you like.
Alternately, you can detach a file using the mouse, by grabbing the document tab for the file and dragging it towards the area of the window where you want the file displayed.
As you drag the tab, the icon that follows the cursor changes. A split window with an arrow to the left, right, top, or bottom indicates that if you release the mouse now, the new window will be placed in that relationship to the current window.
To move a file to a different tab group:
To collapse those multiple views back into one:
Alternately, you can simply grab the document tab for a detached file and drop it onto an existing tab or tab group. When the icon changes to show a miniature window with tabs, release the mouse.
You can close any file open in the editor window with a single click.
To close the current file, choose one of the following ways:
To close all files, choose one of the following ways:
To close all files except one:
To close multiple files at once:
To selectively close files:
Mouseover Popups enable you to position the mouse cursor over certain areas of the IDE and get some information on them in a popup window that appears floating in front. Information is available on the following:
The popup window appears when you move the mouse over and optionally press the key that you assign for the feature. The following are some of the areas of the IDE that mouseover popups are available for:
Smart-Popup
The Smart-Popup feature shows the most appropriate popup for a given situation, depending on the order of popups specified in the Mouseover Popups page of the Preferences dialog. Smart-Popup is activated by a keystroke which you can specify on the Mouseover Popups page of the Preferences Dialog.
For example, you may have the following popup configuration (set using the Mouseover Popups page of the Preferences dialog)
With this configuration, if you hover the mouse over a variable in the source editor and press Control, then:
With Smart-Popup, you only need to use the Smart-Popup activation keystroke for the IDE to display the most appropriate popup
| Note: Even with Smart-Popup enabled, the individual popups for Data Values, Documentation, and Source Code can still be activated by their respective activation keys. |
You can quickly locate the source node in the Application Navigator for any file opened for editing, whether or not that node is in the current project.
To locate the node for any file opened in the editor:
You can use bookmarks in your source files to help you quickly locate relevant code. You can use the Bookmarks Window to navigate to bookmarked material.
To set or remove a bookmark in a source file:
Oracle JDeveloper provides several features for editing source files.
JDeveloper provides a powerful source editor that will help you write different kinds of code quickly and efficiently.
You can set preferences for the specific editor for each file type.
To open your source code in its default editor:
The default editor associated with that file type appears in the content area. If the editor is already open on that file, the editor comes to the foreground.
To open your source code in a specific editor or viewer:
Changes made in the source will be immediately reflected in other views of that file.
You can also generate Java source code from modeled Java classes.
It is possible to edit source code that you have opened in JDeveloper with an outside editor, should you wish to do so. When you return to the JDeveloper IDE, it will detect the changes you have made.
Before you edit a file externally, you should first save any changes made in JDeveloper. If you do not, when you return to JDeveloper, you will be asked whether to reload those files or not. If you reload the externally modified files, you will lose the unsaved changes made in JDeveloper. If you do not reload them, you will lose the changes made outside JDeveloper once you save the file in JDeveloper.
To edit source code with an external editor, with the file open in JDeveloper:
By default, the file is reloaded in JDeveloper without a confirmation beforehand. To receive a confirmation dialog, deselect the Silently Reload When Buffer Is Unmodified option on the Environment page of the Preferences dialog.
Once you have added code snippets to the Component Palette, you can add them to files open in the editor.
Alternatively, you can use code templates to assist you in writing code more quickly and efficiently while you are in the source editor.
To insert a code snippet from the Palette into a source file:
The snippets defined for that page appear listed to the right. Toggle between list and icon views by right-clicking and choosing the view you want from the context menu.
The code snippet appears in the file.
You can record, and play back, keystroke sequences in files open in the source editor.
To define shortcut keys for recording and playing back:
Macro Toggle Recording. If this proposed shortcut already has an command associated with it, that command will appear in the Conflicts field.
Macro Playback. To record a macro:
To play back a macro:
You can create tasks that are directly related to lines in files of source code, or tasks that are associated with applications, projects or general files. Oracle JDeveloper comes with the tags TODO, TASK, and FIXME and the priorities HIGH, MEDIUM, LOW and NONE preconfigured, and you can add your own task tags and priorities in the Tasks page of the Preferences dialog.
To add your own task priorities and task tags:
For more information, press F1 or click Help from within the dialog page.
To create a task associated with a comment line in source code:
//TODO. To create a task associated with an application, project or file:
You can compare source files either belonging to the same project, or outside.
To compare a file currently being edited with its saved version:
The saved file opens side by side with the file in the editor buffer.
To compare one file with another file outside the project:
The two files open side by side, under a tab labeled Compare.
To compare any two files within the same project:
The two files open side by side, under a tab labeled Compare.
While you are in the process of making changes to a file, at any time you can revert to the last saved version of the file.
To revert to the last saved version of a file:
Any changes you have made since the last save are now undone.
Oracle JDeveloper provides a powerful source editor that will help you write different kinds of code quickly and efficiently.
To search a source file currently open in the source editor, with the option to replace text:
Text previously searched for in this session of JDeveloper appears in the Text to Search For dropdown list.
For more information, press F1 or click Help from within the dialog.
To do a simple search in the open source file for a single text string:
As you type, the cursor jumps to the next instance of the group of letters displayed.
Alternatively, enter the text string in the search box. As you type, the cursor jumps to the next instance of the group of letters displayed. Use the Previous or Next buttons to search up and down the file. Click in the search box to set Match Case, Whole Word, or Highlight Occurrences.
To search all files in a project or an application:
Text previously searched for in this session of Oracle JDeveloper appears in the Search Text dropdown list. By default, if you opened this dialog with text selected in the source editor, that text appears as the first entry.
For more information, press F1 or click Help from within the dialog.
Oracle JDeveloper enables you to print source files.
To print a source file:
Regular expressions are characters that customize a search string through pattern matching. You can match a string against a pattern or extract parts of the match.
JDeveloper uses the standard Sun regular expressions package, java.util.regex. For more information, see "Regular Expressions and the Java Programming Language" at http://download-llnw.oracle.com/javase/tutorial/essential/regex/.
Most of the basic functionality in JDeveloper is implemented as extensions—software packages which add features and capabilities to the basic JDeveloper IDE. You can add existing extensions into JDeveloper, or create your own.
Extensions are components that are loaded and integrated with JDeveloper after it is started. Extensions can access the IDE and perform many useful tasks. In fact, much of JDeveloper itself is composed of extensions.
This section contains information on finding, installing, and enabling or disabling JDeveloper extensions. The simplest way to find and download JDeveloper extensions is through the Check for Updates wizard.
If you need additional capabilities from the IDE (such as integration with a version control system or a special editor or debugger), you can add external tools to JDeveloper. See Section 3.12, "Adding External Tools to JDeveloper" for more information.
In addition, you can obtain additional extension development tools and functionality in the Extension Software Development Kit (SDK). You can download the Extension SDK via the Check for Updates wizard.
You can also download the Extension SDK from the Oracle Technology Network Web page.
| Note: Any time an extension is added or upgraded, the migration dialog appears at startup in case you need to migrate any previous settings related to that extension. |
The easiest way to find and install extensions is to use the Check for Updates wizard.
To install extensions using the Check for Updates wizard:
You can also access the Check for Updates wizard from the Tools > Features page.
Some extension providers prefer to have you install directly from their Web site, so that among other things they can contact you when there are updates to the extension. In this case, the Check for Updates wizard will inform you of the provider's preference, and will then open your default Web browser so that you can conduct the download and installation from the provider's Web site.
To download and install from the provider's Web site:
You can find and download extensions from the JDeveloper Extensions Exchange website on OTN. The page is located here:
http://www.oracle.com/technetwork/developer-tools/jdev/index-099997.html
The available extensions include:
To install extensions after you have downloaded them from OTN:
JDeveloper supports the concept of a "watched directory". A watched directory is a location where a user or script can drop files and have them discovered by JDeveloper automatically the next time it starts.
To install an extension using the dropins directory:
jdeveloper/dropins folder. ide.bundle.search.path property, either at the command line or by adding an entry in the jdev.conf file. You can access the JDeveloper online help through the Help Center. This section describes how you can effectively use the features of the Help Center.
The JDeveloper Help Center comprises two windows: the help navigator and the help topic viewer.
The following types of content are available:
From the Help Center, you can also access additional documentation on Oracle Technology Network (OTN).
The Help Center search feature lets you search the installed documentation, the documentation available from OTN, and the Fusion Middleware Documentation Library.
You can also customize the way you view content.
The Help Center enables you to browse the table of contents, locate relevant topics in the dynamic help links lists, and do a full text search of installed and online content. It also provides a Favorites navigator for saving links to frequently referenced topics. The Help Center comprises two windows: the help navigator and the help topic viewer. You can customize some aspects of these windows.
The following table describes the features available in the Help Center toolbar.
Table 3-27 Help Center Toolbar Icons
| Icon | Name | Description |
|---|---|---|
![]() | Keep Help Center on Top (Alt+K) | Keeps the Help Center on top of all other open windows. |
![]() | Navigators | Opens Help Center navigators you have previously closed. |
![]() | JDeveloper Forum | Launches an external browser window and visit the JDeveloper Forum on Oracle Technology Network (OTN). |
![]() | Search | Searches all the documentation installed as online help, Oracle Technology Network (OTN) and the Fusion Middleware and Database Libraries. |
The Help Center includes tabs for navigating content on the left:
The Help Center includes the following tabs for viewing content and search results on the right:
The JDeveloper Help Center comprises two windows: the help navigator and the help topic viewer.
To open the online help, use any of these methods:
To see a help page that is already open:
You can search all the documentation installed as online help by doing a full-text search, and you can also search Oracle Technology Network (OTN) and the Fusion Middleware and Database Online Documentation Libraries. You can search an individual help topic that is open by using the Find icon in the topic viewer toolbar.
To do a full-text search from the Help Center:
The Search Results page opens in the help viewer area, with the titles and sources of each matching document, as well as the beginning text.
Each help topic opens in a separate tabbed page. The Search Results page remains available. Each OTN and Documentation Library page opens in your default browser.
Using the Boolean Expressions option:
BooleanExpression is a recursive tree structure for expressing search criteria involving boolean expressions. The BooleanExpression is based on the following grammar:
To begin a documentation search from the main toolbar Search field:
By default, all locations are selected.
The Help Center opens with the Search Results page on the right, showing the titles and sources of each matching document, as well as the beginning text.
You can save links to frequently referenced help topics, stored in folders you create and name, on the Favorites page in the Help Center. The help topic must be open in the help topic viewer, in order to bookmark it. You can also add links to external sites.
To add links to help topics to the Favorites page:
The Add to Favorites dialog is displayed.
To add links to external sites to the Favorites page:
The Add External Favorites dialog is displayed.
To create a new Favorites folder:
You can also create a new folder when the Add to Favorites dialog is open, by clicking New Folder.
To rename a Favorites folder:
You can also rename a folder when the Add to Favorites dialog is open, by clicking Rename.
To delete a Favorites folder or link:
You can also delete a folder when the Add to Favorites dialog is open, by selecting the node and clicking Delete.
You can customize some features of the Help Center window, as well as the navigators and topic viewers through the toolbars and context menu.
Use the Keep on Top icon to keep the Help Center in front of all open windows, including JDeveloper.
You can select the following types of help that you want to display from the Navigators drop down in the Help Center toolbar:
Alternatively, you can right-click in the Help Center and choose a navigator from the Configure Tabs option on the context menu, to open navigators you previously closed.
You can also choose to view all help topics in the Contents navigator, or reduce what is displayed by selecting a single content type from the Contents drop down, as shown in the following figure.
Figure 3-1 Contents Dropdown List

Use the Change Font Size options in help topic viewer toolbar to increase or decrease the font size incrementally.
When you navigate through topics in the help system, the topics open in new tabbed pages.
To see a help page that is already open, use one of the following ways:
When you open topics by clicking links within topics, the topics open within the same viewer. To cycle through those topics, click the Forward or Back icons in the help topic viewer toolbar. Note that you cannot navigate forward or back between different types of help viewer tabs; for example, the search results and help topic tabs. Use the scroll buttons instead.
To close one or more pages open in the help topic viewer:
You can close the page in front, all the pages, or all the pages except the page in front.
You can print help topics individually or by section.
To print an individual help topic:
To print a topic grouping:
The container topic and its children are printed. Topics listed as links are not printed.
This section provides an introduction to fundamental JDeveloper IDE functionality and concepts.
Use the Application Overview pages to guide you as you build a Fusion Web application, and to create files and objects and view the status of them.
The Application Overview Checklist steps you through the building of a Fusion Web application, according to Oracle recommended best practices. The Checklist is displayed by default when a Fusion Web application is created, as part of the Application Overview pages.
The checklist optionally walks you through the entire process of configuring and building your application, with links to specific dialogs and wizards. Each step is also designed to teach you about the architecture, tools and resulting files using a combination of links to step-by-step instructions, relevant sections of the Developer's Guides, and descriptions of what happens in the IDE as a consequence of doing the work in a step.
Unlike a wizard, the Checklist itself is intended to provide a linear, but ultimately flexible and lightweight guide. You can follow the prescribed path in exact sequence, or explore tasks in a different preferred order. When using the Checklist, it suggests a best way to accomplish your goals, but you are not restricted by it. You can also close the Application Overview and work directly in the IDE, or work in both the IDE and Checklist interchangeably.
To use the Checklist:




All files and artifacts that you create within JDeveloper appear in the Application Overview file summary pages, organized by object type. You can create new files and artifacts, and view them filtered by status and project. The following table describes the types of file summary pages.
Table 3-28 File Summary Pages
| Page | Function |
|---|---|
| Status | Displays information about the object types available, using these status icons:
|
| File | Displays the names of the objects. You can sort the objects in ascending or descending order by clicking the Sort icon in any of the column headings. |
| Project | Displays the project in which the file or object is located. |
File Summary Pages Toolbar
The following table describes the icons in the File Summary Pages toolbar and their functions.
Table 3-29 Icons in the File Summary Pages Toolbar
| Icon | Name | Function |
|---|---|---|
![]() | New | Creates new objects of the types listed, in the selected project. The context menu lists the files and objects associated with the technology that can be created in each project. |
![]() | Edit | Opens the selected file or object in its default edito.r |
![]() | Delete | Removes the selected file or object. |
![]() | Filter Status or Project | Displays the list of all files of a particular status by selecting the status, as described above. By default, Show All is selected. If there is more than one project within the current application, use this list to select which project or projects you wish to be included in the file summary pages. You can choose:
|
Use the File List to search for and work on objects that you have created within an application. The rules, code assists, and metrics that are used to analyze Java code are specified by the Code Assist profile.
The following table describes the options available in the file list tab header.
Table 3-30 File List Tab Header Options
| Option | Function |
|---|---|
| Look in | If you have more than one project within the current application, use this list to select which project or projects will be searched for objects. The list includes all projects in the current application, plus options to show all projects and a selection of projects (multiple projects). You can choose:
|
| Saved Searches | Initially contains <New Search>. After you have saved at least one search, also lists all saved searches. Selecting a saved search will display the search criteria for that search. The search results will show the results of the most recent search, even as you change between saved searches. To obtain new search results, click the Search button. Saving a search is one of the actions available from the More Actions button. |
| Show History | Opens the Recent Searches dialog, through which you can return to a recent search. The search criteria of the selected search is shown, while the search results remain as they were for the most recent search. To obtain new search results, click the Search button. |
The following table describes the features available in the search criteria area.
Table 3-31 Features in the Search Criteria Area
| Option | Function |
|---|---|
| Search criteria input line(s) | Initially contains a single input line for search criteria. You can add further lines by clicking the Add icon at the end of the line. You can remove lines by clicking the Delete icon at the end of the line that you want to remove. By default, the first field in the line contains File Name: you can change this to File Extension, Date Modified, Status, or Category. The second field contains the options available for extending the entry in the first field. The third field contains a list of all object types that can be searched for. |
| Match options | Choose between Match All and Match Any to determine the scope of the search. |
| Search | Click to begin a search based on the search criteria currently shown. |
| More Actions | Click to reveal the following menu of options for use with named searches:
|
The following table describes the options available in the Search Results table.
Table 3-32 Options Available in the Search Results Table
| Option | Function |
|---|---|
| Results summary | Shows the number of files that match the search criteria, and the date and time that the search was completed. |
| Refresh | Reruns the search with the current search criteria. |
| Customize table | Opens a menu from which you can choose the columns that will be displayed in the results table. Also contains a Select Columns option, which opens the Customize Table dialog, through which you can choose which columns to display and the order in which they are displayed in the results table. The columns that are shown by default are Status, File, Project, and Date Modified, in that order. Other columns that you can choose to show are Application and Category. |
| Table headings | You can change the order of the columns by grabbing a table heading and moving it horizontally. You can change whether objects are shown in ascending or descending order within the columns by clicking a heading to give it focus, then clicking again to change the sort order. The sort icon (or) in the table heading will change as appropriate. |
| Objects list | Lists all the objects returned by the search. You can initiate actions for an object by selecting the name, right-clicking, and selecting from the context menu. |
The Compare Window allows you to view the differences between two files or two directories.
You might want to do this when deciding whether to check in a particular file to a source control system, especially if doing so will overwrite a file whose contents you are unfamiliar with. The Compare Window is integrated with the Application Overview and the Application Navigator, and with the Subversion source control system.
The following table describes the icons in the Compare Window toolbar and their functions.
Table 3-33 Compare Window Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Go to First Difference | Click to move the cursor to the first difference. |
![]() | Go to Previous Difference | Click to move the cursor to the previous difference. |
![]() | Go to Next Difference | Click to move the cursor to the next difference. |
![]() | Go to Last Difference | Click to move the cursor to the last difference. |
![]() | Generate Patch | Click to open the Generate Patch dialog, where you can generate a patch containing changes that have been made to the files. |
The Application Navigator allows you to manage the contents and associated resources of an application.
This section describes the features available from the Application Navigator toolbar.
Main dropdown list
Use the main dropdown list, displayed in the figure below, to create a new application, open an existing application, or choose from the list of open applications. Use the context menu to choose from the list of application level actions available.

Application menu
Use the application menu, displayed in the figure below, to choose from a list of actions available.

The following table describes the options available from the Application Menu.
Table 3-34 Application Menu Options
| Menu Option | Function |
|---|---|
| New Project | Opens the New Gallery ready for you to select the type of project to create. |
| New (Ctrl+N) | Opens the New Gallery. Only those items available to be created from an application are available |
| Open Project | Opens the Open Project dialog, where you navigate to a project that you want to open in this application. |
| Close Application | Closes the current application. |
| Delete Application | Deletes the application control file (.jws) from disk. |
| Rename Application | Opens the Rename dialog where you can change the name of the current application. |
| Find Application Files | Opens the File List, where you can search for specific files. |
| Show Overview | Opens the Application Overview which is the home for all files you can create in this application. |
| Filter Application | Opens the Manage Working Sets dialog where you can specify the files to include or exclude from being listed in the Application Navigator. |
| Secure | Secures your application resources. |
| Deploy | Allows you to choose from the deployment profiles defined for the application. |
| Application Properties | Opens the Application Properties dialog where you can set various properties for the application. |
You can several application operations from the Application Navigator. These include:
You can perform the following operations from the projects panel of the Application Navigator:
You can perform the following operations in the Application Resources panel:
You can perform the following operations in the Data Controls panel:
You can perform the following operations in the Recently Opened Files panel:
The Application Server Navigator allows you to manage connections to application servers. It is integrated with the Resource Palette.
When you create an application server connection in the Application Server Navigator it is available in the Resource Palette. Similarly, when you create an application server connection in the Resource Palette, it is available in the Application Server Navigator.
From the context menu of the Application Server Navigator, you can:
From the context menu of IntegratedWebLogicServer, you can:
The following table describes the icons in the Application Server Navigator toolbar:
Table 3-35 Application Server Navigator Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Refresh | Click to refresh the contents of the selected application server connection. |
![]() | Delete | Click to delete the selected application server connection. |
The Structure window offers a structural view of the data in the document currently selected in the active window of those windows that participate in providing structure: the diagrams, the navigators, the editors and viewers, and the Property Inspector.
Depending on the document currently open, the Structure Window enables you to view data in two modes:
In the Structure window, you can view the document or diagram data in a variety of ways. The structures available for display are based upon document or diagram type. For a Java file, you can view code structure, UI structure, or UI model data. For an XML file, you can view XML structure, design structure, or UI model data.
The Structure window is dynamic, tracking always the current selection of the active window (unless you freeze the window's contents on a particular view), as is pertinent to the currently active editor. When the current selection is a node in the navigator, the default editor is assumed. To change the view on the structure for the current selection, select a different structure tab.
The windows that participate in providing structure also follow selections made in the Structure window. Double-clicking the node for a method in the Structure window, for instance, makes the source editor the active view and takes you directly to the definition for that method.
You can open multiple instances of the Structure window, freezing the contents of any number of them, in order to compare the structures of different files. You can also switch structure views without changing editors.
Diagram objects (such as UML elements) listed in the Structure window can be dragged from the window and dropped directly onto diagrams.
The following table describes the icons in the Structure Window toolbar and their functions:
Table 3-36 Structure Window Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Freeze | Click to freeze the Structure window on the current view. A window that has been frozen does not track the active selection in the active window. |
![]() | New View | Click to open a new instance of the Structure window. The new view appears as a tabbed page in the same window. |
The Structure window view depends upon the document type of the current selection in the active window. Each view offers different options for viewing and sorting the structure of your files based on file type.
The following table describes the Structure Window views.
Table 3-37 Structure Window Views
| View | Description |
|---|---|
| ADF Business Components View | When you select any ADF business component in one of the navigators, the Structure window offers a structured view of the component's files, attributes, and other properties. |
| Cascading Style Sheet View | This view allows you to select and group CSS elements for easy editing. When a CSS file is open for editing, CSS selectors in the file are displayed in the Structure window as one of three types: Element, Class, and ID. |
| Java View | This view displays the code as well as design structure of the Java file currently being edited. Additionally, you can specify several display preferences to view structural data. |
| JSP/HTML View | This view displays the code structure and UI bindings for the JSP/HTML file that is currently selected. |
| Struts View | The Struts view shows the hierarchy of elements and attributes for the Struts configuration file currently selected in the active navigator or editor. |
| TopLink View | The TopLink view displays detailed information about the TopLink element selected in Application Navigator or TopLink editor, including descriptors, sessions, and mappings. |
| UML View | The UML view displays the behavior, interaction, and code structure in UML-based diagrams such as Activity Diagrams, Class Diagrams, and Use Case Diagrams. |
| Diagram View | When a diagram is open for editing, the Diagram view displays the components that have been added to the diagram. You can select an element in the Structure Window's diagram view and locate it in the diagram |
Use to view the data controls created to represent an application's business services and to create databound UI components by dragging and dropping the control panel objects onto an open web page or ADF Swing panel.
| Note: The Data Controls panel may appear empty if no data controls have been created for or imported into the application. |
The panel displays objects to which your UI components can be bound, including data collections, attributes, and methods that the business services developer exposed through the Oracle ADF data control, as well as specific, built-in operations that are generic to all data collections.
When you drag an object from the Data Controls panel onto a page, the context menu displays the UI components you can create for that specific object. Creating components this way means that they will automatically be databound to the dropped object.
After inserting a databound UI component into the displayed web page or Java panel, you can view the Oracle ADF data binding:
setModel() method call on the UI component initializes the data binding object and accesses the Oracle ADF binding context (specified by the setBindingContext() method call on the panel). Data Controls panel toolbar
The following table describes the icons in the Data Controls panel toolbar and their functions:
Table 3-38 Data Controls Panel Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Refresh Panel | Click to reload the panel if the underlying business components have changed. |
![]() | Filter Panel | Click to enter search criteria to find a specific item in the panel. |
The Log window displays tabbed windows for specific feedback from various components of the IDE.
The Log window displays information on:
To bring up the context menu for the contents of the Log window, right-click within the window. To bring up the context menu for the Log window as window, right-click on the tab.
From the context menu for the general Log window, you can:
Other actions may be available within the tabbed sections generated by specific processes.
From the context menu for the window itself, you can:
The Status Window is one of the JDeveloper features that helps you to audit your code. It displays audit violations in the document selected in the File List and provides information to help you resolve the issues.
The Code Assist audit profile determines the audit violations that are reported.
Status Window Toolbar
You can choose the items you want to view using the icons in the Status window toolbar.
The following table describes the icons in the toolbar and their functions:
Table 3-39 Status Window Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Show Error Issues | Toggle to show just the number of errors in the selected file, or to list the errors in the file. |
![]() | Show Warning Issues | Toggle to show just the number of warnings in the selected file, or to list the warnings in the file. |
![]() | Show Incomplete Issues | Toggle to show just the number of incomplete issues in the selected file, or to list the incomplete issues in the file. |
![]() | Show Advisory Issues | Toggle to show just the number of advisory issues in the selected file, or to list the advisory issues in the file. |
![]() | Fixes | Select one of the issues in the list, and click Fixes. A suggested fix is displayed, for example: Add missing Javadoc tags. |
Use this dockable window to record tasks associated with applications, projects and files.
If you are working in a Java Class source file, a task will automatically be created whenever you type // TODO (in other words, when you create a comment and use the source tag recognized by JDeveloper).
While you are using the Tasks window, these features are available:
Tasks Window Toolbar
The toolbar enables you to manage the tasks displayed in the Tasks window. The following table describes the icons in the Tasks Window toolbar and their functions.
Table 3-40 Tasks Window Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Current Application | Choose to define the current application as the scope of the tasks displayed. |
![]() | Current Project | Choose to define the current project as the scope of the tasks displayed. |
![]() | Current File | Choose to define the current file as the scope of the tasks displayed. |
![]() | Add task | Click to create a new task (independent of source file comments). |
![]() | Edit task | Click to edit the highlighted task. |
![]() | Delete task | Click to remove highlighted task. |
![]() | Filter | Click to open the Filter Tasks dialog, where you can set up filters to determine which tasks are and are not shown. |
External tools are custom JDeveloper menu items and toolbar buttons that launch applications installed on your system, applications that are not packaged as part of JDeveloper.
To find all external programs that JDeveloper is preconfigured to support:
To add access to an external program from JDeveloper:
To change how an external program appears, or remove access to an external program from JDeveloper:
This part describes how to develop applications with Oracle JDeveloper. You can find information on how to effectively build, test, run, and deploy applications.
This part contains the following chapters:
This chapter provides an overview of the features for developing applications available in JDeveloper.
This chapter describes how you can effectively work with applications and projects in the Oracle JDeveloper IDE.
This chapter describes the version control features available in JDeveloper.
This chapter provides an overview of the building, running, and debugging features in JDeveloper.
This chapter provides an overview of the auditing, profiling, and testing features in JDeveloper.
This chapter describes how to deploy applications in JDeveloper.
This chapter provides an overview of the features for developing applications available in JDeveloper.
This chapter includes the following sections:
JDeveloper provides several tools and features for developing applications. You can use these features to effectively build, test, run, and deploy your application. These features include:
This chapter describes how you can effectively work with applications and projects in the Oracle JDeveloper IDE.
This chapter includes the following sections:
The application is the highest level in the control structure. It is a view of all the objects you need while you are working. An application keeps track of all your projects while you develop programs.
A project is a logical container for a set of files that define a JDeveloper program or portion of a program. A project might contain files representing different tiers of a multi-tier application, for instance, or different subsystems of a complex application. These files can reside in any directory and still be contained within a single project.
You can remove application and project control files from the IDE without deleting them from the disk. (This is not true for other types of file, which will be deleted from the disk at the time that they are removed from the IDE.)
JDeveloper can recognize many different file types, displaying each in its appropriate viewer or editor when you double-click the file.
When adding a project to an application, you can choose to:
As soon as you create a new project or open an existing one, it is added to the application selected.
Projects control their files lists directly through the directory. Applications and packages also define where and how the files within a project are stored.
| Note: The same object (physical file) can appear in more than one project. This means that any actions carried out on the object in one project will show up in the other project (although some effects will become apparent only after the project is compiled). For packages, two or more projects should not share a package unless, first, they also share a source path used to generate the package and, secondly, the package is already compiled and will never be changed. |
New applications and projects are managed from the Application Navigator.
This section describes how to create a custom JDeveloper application and a project within it.
To create a new application:
This section describes how to create a custom application that includes a single project that can be customized to include any features.
To create a custom application:
In JDeveloper, you use the Application Navigator to keep track of the projects (collections of related files or components) you use while developing your application. You can also create a new project based on existing source.
You can create a new project from existing source or populated with new objects, or you can create a new empty project.
All projects inherit the settings specified in the Default Project Properties dialog. As soon as you create the project, it is added to the active application.
To create a new project from existing source or with new objects:
The new project appears in the navigator. It inherits whatever default properties you've already set. To alter project properties for this project, either double-click the filename or right-click and choose Project Properties.
A custom project can be customized to include any feature. All projects inherit the settings specified in the Default Project Properties dialog. As soon as you create the project, it is added to the active application.
To create a new custom project and add it to the active application:
JDeveloper provides several features to effectively manage your applications and projects.
You can create new applications and projects from scratch or open existing ones. As soon as you create or import the application, it is added to the Applications node in the Application Navigator. As soon as you create or import a project, it is added to the selected application.
To open an existing application and add it to the Application Navigator:
Be sure that the file type field either specifies .jws files or allows all types to be displayed.
The application is added to the list of applications in the navigator.
To open an existing project and add it to an application:
Be sure that the file type field either specifies .jpr files or allows all types to be displayed.
The project is added to the active application.
You can create new files of various types from scratch or open existing ones. When opening existing files, you can import them, along with their file structure, into an existing project or build a completely new project around them.
Alternatively, you can add source files to projects you already have.
You can import existing files of any type into JDeveloper, creating a new project as you do so.
To open existing files and import them into a new JDeveloper project:
.jpr file or accept the default. For more information on this or subsequent wizard pages, press F1 or click Help from within the wizard.
Alternatively, you can select File > Import, and choose either Java Source or Source into New Project.
The new project appears under the selected application node, populated with the imported files.
You can fine tune your project directories structure, for example to point to resource directories, in the Project Properties dialog.
You can import a WAR file into JDeveloper, creating at the same time a new project to contain its extracted contents.
To open a WAR file and import it into a new JDeveloper project:
For information when using this wizard, press F1.
The wizard analyzes the WAR file and extracts its contents.
The new project appears under the selected application node, populated with the imported files.
When you import an EAR file, JDeveloper will always create a new application and populate it with projects based on the EAR modules extracted. You cannot add the contents of an EAR file to an existing application or project.
You should not use this procedure to import an EAR file that you simply wish to deploy using JDeveloper. To do this, create a new application and project, then copy your EAR file into the project directory (or add its location to the project's content). The EAR file will then appear in the Application Navigator under the project's Application Sources node. From here, you can deploy the file by right-clicking it and choosing Deploy to.
To open an EAR file and import it into a new JDeveloper application:
The Import EAR File wizard is not sensitive to context, so you need not select anything specific in the navigator first.
On the Finish page, the contents of the final application are displayed.
The new application appears in the navigator, populated with projects based on the imported modules.
You can create new files of various types from scratch or open existing ones. When opening existing files, you can import them, along with their file structure, into an existing project or build a completely new project around them.
You can also create new projects from existing source.
You can import existing files of various types into a project you've already created, while maintaining their original file structure.
| Note: You can use the Import Existing Sources wizard to add.zip or.jar files to projects. You cannot use it to add.war or.ear files. A .war file requires the Import WAR File wizard to property extract its contents into the project. An EAR file requires the Import EAR File wizard, which extracts its contents into a new application. |
To open an existing file and add it to a project using the Import Existing Sources wizard:
For more information on this or subsequent wizard pages, press F1 or click Help from within the wizard.
You can return to this dialog as many times as you want, adding as many individual files or directories as you would like, by clicking Add again once you have returned to the wizard.
The files are now added to the selected project.
JDeveloper enables you to create custom folders or Java packages within your project to better organize your project files.
To create a folder or Java package:
To delete a folder or Java package:
Working sets allow you to configure the navigator to show you a subset of files from your project. This is particularly useful when working with large projects. Before you define your own working sets the only one available is Default, and it is a working set which includes all the files in the current application.
You can run and debug a working set in just the same way as you run and debug a project. This allows you to work on just a subset of a large application, for example a Java EE application, without affecting the entire application or incurring a performance hit.
You can define a working set by selecting from files or containers in the Application Navigator, or by providing include and exclude filter patterns through the Manage Working Sets dialog.
To group objects in the Application Navigator into a working set:
This opens a Save As dialog. For more information at any time, press F1 or click Help from within the Save As dialog.
To create a working set by defining file and directory filters:
This opens the Working Sets dialog. Use the tree on the left to select the projects to include. In the right panel, select which files in the current project to include. For more information at any time, press F1 or click Help from within the Working Sets dialog.
To create a working set from the results of a search in the Log window:
To see which working set you are currently using:
To change the active working set:
Files not belonging to the working set are removed from view.
To edit files and projects in a working set:
This opens the Working Sets dialog. For more information at any time, press F1 or click Help from within the Working Sets dialog.
To restore the view in the Application Navigator to show all files:
To run and debug a working set:
Be aware that any projects that are explicit dependencies (in the Dependencies page of the Project Properties dialog) will be included even if they are excluded from the working set.
Sometimes, you may not want to add files directly to a project, but yet have them handy for browsing. You can bring files into the JDeveloper IDE, without adding them to a project.
To open files in JDeveloper without adding them to a project:
As you are only going to view the files, it doesn't matter which node in the Application Navigator is currently selected.
Archive files appear twice: once as a virtual directory and then again as a file. If you will be opening an archive file, select its appearance in the list as a directory.
You can easily inspect the contents of any archive, after first opening the archived file in JDeveloper. You can add the contents of an archive to an existing or new JDeveloper project.
To open an archive in JDeveloper and view its contents:
As you are only going to view the contents of the archive, it doesn't matter which node in the Application Navigator is currently selected.
If you do not see the archive files, double-check that all file types are being displayed.
You can easily view any.gif, .jpg, .jpeg, or .png file from within JDeveloper.
To open and view an image in JDeveloper:
As you are only going to view the image, it doesn't matter which node in the Application Navigator is currently selected.
The image is displayed in the main working area of JDeveloper.
To view an image already imported into JDeveloper:
You can set the project properties for all subsequently created projects or fine-tune the properties for any individual project.
When you set project properties for an individual project, you override the default values for that project alone.
To view or change the default settings for a project:
The procedures you follow for setting default project properties are identical to those for setting properties for individual projects — with the exception that, as you are in default properties, you do not need to first select an individual project. Note that some project properties cannot be set from the Default Project Properties dialog.
You can set the project properties for all subsequent projects, or fine-tune the properties for any individual project. When you set project properties for an individual project, you override the default values for that project alone.
Additional project properties are also available, based upon specific tasks such as compiling, or debugging.
To view or change the current output path for an individual project:
The Project Properties dialog opens with the input paths displayed on the last page that you viewed.
When you include libraries in a project, the source paths defined for those libraries automatically become part of the project's classpath.
To view the current libraries for an individual project:
To add an existing library to a project:
To create a new library and add it to a project:
To edit an existing library in a project:
When you remove libraries from a project, the source paths defined for those libraries no longer form part of the project's classpath.
To remove a library from a project:
Setting the target Java SE specifies which Java SE JDeveloper will use when compiling and running your project.
To view or change the current Java SE for an individual project:
The Project Properties dialog opens with the common input paths displayed or on the last page that you viewed.
Complex applications generally comprise multiple projects, which may be related though dependencies. That is, project A must depend on project B when project A uses classes or resources from project B. When this dependency is set, compiling project A will automatically compile project B.
Deployment profile dependencies are created and edited in the Project Properties dialog available from the Tools menu.
To manage the project dependencies for an individual project:
When features are associated with a project, JDeveloper's design time filters the choices you see based upon what you are most likely to need for a project of this type.
To associate features with a project via its project template:
Application templates are listed as first-level nodes under Application Templates. Project templates appear below their application template.
To associate features with an individual project:
Every project you create carries the JDeveloper project defaults or those you have supplied yourself for all projects. You can also replace these defaults on a project-by-project basis. Setting these properties is the same in either case: only the location, and application, of the information differs.
To set Javadoc properties for an individual project:
Application and Project templates can assist you in organizing your projects and standardizing on that organization. When you combine templates with features, you can streamline the way you design and produce applications.
An application template organizes one or more project templates which specify the project types expected in the application. Using such templates enables you to standardize the way you develop an application.
To define a new application template:
For more information at any time, press F1 or click Help from within the appropriate dialog.
The new template appears in the template list of the Manage Templates dialog. All application templates are listed as first-level nodes under Application Templates.
The application template appears in the New Gallery in the Applications category of the Business Tier.
Project templates specify the various types of projects expected in a given application. Project templates are contained within application templates.
To define a new project template:
Alternately, if the template has already been defined, choose Application > Manage Templates.
The new template appears in the template list of the Manage Templates dialog. All project templates are listed as first-level nodes under Project Templates.
The project template appears in the New Gallery in the Projects category.
You can create an application or project template in a shared location. Other users can read templates from the shared location and use the same templates for their application and projects.
To create a shared template:
The shared templates folder is listed under both the Application Templates and Project Templates node.
You can editing existing user-defined application or project templates.
To edit an existing application or project template:
For more information at any time, press F1 or click Help from within the Manage Templates dialog.
You can delete existing user-defined application or project templates.
To delete an existing application or project template:
Application templates are listed as first-level nodes under Application Templates. Project templates are listed as first-level nodes under Project Templates.
For more information at any time, press F1 or click Help from within the Manage Templates dialog.
This section describes how to save, rename, or close an application, project, or individual component.
You can save an application or project in several ways.
To save all the components across applications, including all projects:
Alternately, you can save components individually by using File > Save.
It is important to note that saving the application or project container (.jws, .jpr) file alone does not save the individual files governed by that application or project. Nor does saving individual contained files save the container node.
Each node is an independent entity and must be saved as such. Using Save All takes care of changes to these container files, as well as all content files.
Using Save or Save As on a selected application or project node saves or duplicates the .jws or .jpr file only: it does not save or duplicate the files contained within the node.
Note too that if you do a Save As on a application or a project container file, that container is replaced, but the files contained are not altered. If you do a Save As on an individual file, that file is duplicated. However, if you want to rename a file, you should use File > Rename.
You can save an individual component in several ways.
To save an individual component or file:
The file is immediately saved, its italicized name changing to Roman font.
It is important to note that saving the application or project container (.jws, .jpr) file alone does not save the individual files governed by that application or project. Nor does saving individual contained files save the container node.
Each node is an independent entity and must be saved as such. Using Save All takes care of changes to these container files, as well as all content files.
Using Save or Save As on a selected application or project node saves or duplicates the .jws or .jpr file only: it does not save or duplicate the files contained within the node.
You can rename an individual file or component using File > Rename.
Note that if you do a Save As on a application or a project container file, that container is replaced, but the files contained are not altered. If you do a Save As on an individual file, that file is duplicated.
You can rename application control files, project control files, and individual files. The correct way of renaming Java classes is to use refactoring.
To rename an application or project container, or an individual source file:
For simple files, the Rename dialog opens. For Java files, the Rename File dialog opens.
If you choose to rename the class and update references, the Rename Object_Name dialog opens.
The node now appears in the navigator with the new name.
Alternately, you can use File > Save As. Note that Rename always replaces the target file. Save As replaces application or project container (.jws, .jpr) files, but duplicates source files.
When you are saving files, remember that saving a container file alone does not save the contents of the entire application or project. For that, you need to use Save All.
The Application Navigator presents a visual representation of the logical structure of applications and projects. It is not a file directory. It does not necessarily represent the physical location of those files.
To change the physical location of individual files, you can work in JDeveloper. To change the physical location of a group of files, it is easier to work through your operating system's file manager.
To change the association of files with projects or projects with applications, you would work in the Application Navigator, adding or removing as appropriate.
| Note: The best practice for relocating Java classes is to use the options available on the Refactor menu. |
To change the physical location of an individual file, whether within the project or a container (.jws or .jpr) file:
The file is now physically stored in the new directory. Its logical representation does not change in the navigator unless you explicitly alter it.
To change the physical location of an entire application or directory:
mywork folder. The files have now been moved, but JDeveloper no longer knows where they are.
To change the physical location of a group of files from one project to another:
The files are now physically located where you placed them in step 2, and logically associated in the navigator wherever you targeted them in step 4.
When you close an application, project, or file in the Application Navigator, that application or project is unloaded from memory. When an application or project is closed, it appears in its unexpanded form in the navigator.
In addition, you can remove applications, projects, or files from the navigator, which removes them only from the list, or you can delete them permanently, wherever they reside, from within JDeveloper.
To close an application or project:
If any files within that application or project were changed and not saved, you are prompted to save them.
The application or project now collapses and appears in the navigator with the plus sign indicating that is ready for expansion.
You can close a file opened in a viewer or an editor by clicking on the close box of the corresponding document tab above the editor window.
You can remove files from a project, which removes them only from the navigator list, or you can delete them permanently, wherever they reside, from within JDeveloper.
To remove a file from a project:
You can remove projects from the application by deleting the project control file (.jpr) from within JDeveloper.
To remove a project from an application:
You can remove an application from within JDeveloper:
To remove an application from the IDE:
JDeveloper enables you to manage libraries and Java SEs outside the project scope.
You can work with libraries completely outside the JDeveloper project scope, setting them up to be either available to you for use in any of your projects or available to a group of users across an installation.
To work with libraries or Java SEs outside of the scope of a project:
You can work with libraries completely outside the JDeveloper project scope, setting them up to be either available to you for use in any of your projects or available to a group of users across an installation.
To create libraries or Java SEs outside the scope of a project:
You can work with libraries completely outside the JDeveloper project structure, setting them up to be either available to you for use in any of your projects or available to a group of users across an installation.
To edit libraries or Java SEs outside the scope of a project:
You can also reorder the entries, by clicking the up and down buttons in the right margin.
You can work with libraries completely outside the JDeveloper project scope, setting them up to be either available to you for use in any of your projects or available to a group of users across an installation.
To delete libraries or Java SEs outside the scope of a project:
The library is deleted immediately.
This chapter describes how to use source control systems to manage the versions of applications developed in a team environment. It discusses the available version control systems, how to download the various version-control extensions available to Oracle JDeveloper, and then includes instructions for each of the source control systems that can be used with JDeveloper.
This chapter includes the following sections:
Developing in teams often requires coordination among multiple developers who may be called upon to make changes to the same files, to track these changes against project management or bug reporting systems, and eventually to check in or commit their edited files to a commonly used repository of content that will be built into a functioning product.
To assist in team development of software products, JDeveloper integrates the popular version control system, Subversion, into its available feature set. You can access a number of commands for Subversion directly from the JDeveloper interface, through the Version menu or through the Versioning Navigator.
For users familiar with other versioning systems, JDeveloper offers support for CVS, Perforce and Serena Dimensions as downloadable extensions. You can choose from these and other extensions by selecting Help > Check for Updates.
Finally, this section includes a compilation of several best-practices recommendations on writing XML in a way that makes version control much more effective and useful for this important data type.
JDeveloper offers a number of tools for developing in teams. These include an integrated solution, Subversion, as well as a selection of extensions that interface JDeveloper with popular version control systems. In addition, an application lifecycle management system, Oracle Team Productivity Center, is also available as a downloadable extension.
While most members of a team will interact with their selected versioning system by checking files in and out and managing their changes to the project they are working on, at least one team member is typically required to administer and maintain the versioning system as it relates to JDeveloper. If you are the administrator for your versioning system, you will most likely have additional tasks beyond checking files in and out.
If your team uses one of the versioning systems that require you to download a JDeveloper Extension to integrate your versioning system with JDeveloper, you can browse for the versioning system from the Update Center by selecting Help > Check for Updates. Be sure to select all update centers when you search for your versioning system.
JDeveloper is integrated with the popular team development solution Subversion (SVN). If you are part of a team that uses Subversion, JDeveloper's Versioning menu contains commands for using Subversion to manage the content you are working on while maintaining a connection to your team's repository and tracking changes, merges, and more. Setting up Subversion involves creating a repository for your source-controlled files, making sure that JDeveloper can connect to that repository, importing files to the repository, and more.
In general, you begin by importing your working files into the Subversion repository to bring them under version control. Once in the repository, your files are then available to be checked out from the Subversion repository to a local folder known as the "Subversion working copy". The working copy is typically in your local file system for ease and speed of access, but it can also be in a network location if you prefer. When you create a new file in JDeveloper (or move it into JDeveloper), you store it in the Subversion working copy. When you are ready to make your work available to the team, you add these new files to Subversion control. When it comes time to make your changed and new files available to other users, you can do so by committing them to the Subversion repository. To take advantage of the work others on your team have done, you can copy changed files from the Subversion repository to your working copy by updating your files.
After completing setup, your work with Subversion will revolve around checking files out, editing them in JDeveloper, and checking them in with your changes. You may also need to resolve conflicts between changes you made and those made by others in your team. Files may also be moved in and out of Subversion control, and finally, you might use special properties of the files associated with specific versions for tracking bugs, customer requests, and other characteristics.
Setting up Subversion involves creating a repository for your source-controlled files, making sure that JDeveloper can connect to that repository, importing files to the repository, and more.
You do not have to install any Subversion software in addition to the JDeveloper Subversion extension, except in the following circumstances:
In all of the above cases, you will need to install separate Subversion client software. If you wish to use an alternate Java binding, you will additionally have to install the binding software.
An alternate Java binding that you could use is JavaHL. This has the advantage of being developed and maintained by the makers of Subversion and thus allows repository access via a wide range of protocols (http, https, file, svn, svn+ssh). To use the JavaHL binding, you must install Subversion client software independently of JDeveloper. Once installed, JDeveloper will allow you to choose between JavaHL and SVNKit client options.
To Install Subversion Client Software:
svn-1.3.2-setup.exe) from http://subversion.apache.org/ (to, for example, c:\downloads). c:\subversion. Reboot your computer. This procedure assumes that the operating system is Windows. For non-Windows environments, consult the documentation for the operating system package management system to ensure the vendor-supplied Subversion client contains JavaHL.
To check the installation so far, open a command prompt and type svn help. You should see a list of subcommands. If not, check that the system path contains the bin directory of the location where the client software was installed (in this example, c:\subversion\bin).
To Install JavaHL Binding Software:
svn-win32-1.3.2_javahl.zip) from http://subversion.apache.org/ (to, for example, c:\downloads). libsvnjavahl-1.dll from svn-win32-1.3.2_javahl.zip into the bin directory of your Subversion client installation (in this example, c:\subversion\bin). c:\subversion. Reboot your computer. If you wish to connect to a Subversion repository through a proxy server, you must first install separate Subversion client software.
Once you have installed the Subversion client software, you will have a Subversion subdirectory in your Windows Application Data directory. To find the Application Data directory, at the c:/ prompt type cd %APPDATA%. Then open the Subversion subdirectory. (On Linux the equivalent subdirectory will be in ~/.subversion, where ~ is the home directory.)
In the Subversion subdirectory will be a file named servers. Open this file with a text editor and find the [global] section. Remove the comment marker (#) from the line http-proxy-host and overtype the placeholder proxy information with the details of the proxy server that you use. Remove the comment marker (#) from the line http-proxy-port and overtype the placeholder port information with the port number for the proxy server. If you wish to exclude certain URLs from using the proxy server, remove the comment marker (#) from the line http-proxy-exceptions and overtype the placeholder URLs with URLs that you wish to exclude.
Add additional http-proxy-host and http-proxy-port lines with details of any other proxy servers that you use.
It is important that the proxy server supports all the http methods used by Subversion. Some proxy servers do not support the following methods by default: PROPFIND, REPORT, MERGE, MKACTIVITY, CHECKOUT. If you experience problems with using a proxy server to access a Subversion repository, ask the server's system administrator to change the configuration to support these http methods.
In JDeveloper, select Subversion as the versioning system (Versioning > Configure, and then select Subversion).
Open the main Subversion preferences page (Tools > Preferences > Versioning), and then check that the required client installation is available. If more than one is listed, select the one that you wish to use.
Important: If you subsequently accept an update of the JDeveloper Subversion extension from the Update Center (Official Oracle Extensions and Updates), the client preference will be reset to SVNKit, even if you had previously chosen an alternate client.
In most cases, you will connect to your team's Subversion repository. As you develop your projects and applications, you will check files out from the Subversion repository, modify them, and check them back in. This is the typical, and recommended, practice for using Subversion.
Depending on your installation, however, you may find it necessary to create a Subversion repository on your local file system through JDeveloper. A connection to the repository will be created at the same time.
JDeveloper will try to use the file:/// protocol to access the newly created repository. SVNKit, the Subversion client installed with JDeveloper, supports the file:/// protocol. If you are using a Subversion client that does not support the file:/// protocol, you will need to use a different access method (http://, https://, svn:// or svn+ssh://). Consult the Subversion documentation for how to do this.
To Create a Subversion Repository:
If your installation does not support local repository creation, you will see an error message. Otherwise, the Create Subversion Repository dialog will open.
To obtain help while using the dialog, press F1 or click Help.
To Browse a Subversion Repository:
Before you can work with a Subversion repository through JDeveloper, you must create a connection to it. You can subsequently edit the connection details if they change for any reason.
Typically, you will obtain the details of your Subversion connection (server name, user ID, password, etc.) from your team or version control administrator. You will need to know those details before you create a connection to your Subversion repository.
To Create a Subversion Connection:
The Create Subversion Connection dialog is opened. For help when using this dialog, press F1 or click Help.
To Edit a Subversion Connection:
The Edit Subversion Connection dialog is opened. For help when using this dialog, press F1 or click Help.
You can view the current content of the Subversion repository through the Versioning Navigator. The nodes under your selected Subversion connection unfold to reveal the structure and file content of the Subversion repository.
You can open a read-only version of a Subversion repository file by choosing Open from its context menu. This will let you see what changes have been made to the files in the Subversion repository since you checked out or updated your local versions.
Folders in the Subversion repository, visible from the Versioning Navigator, offer the following operations:
Opens the new gallery, from which you can create applications, connections, projects, and other entities.
Opens the Create Directory dialog, which lets you create a new directory to associate with the URL of the element on which you right-clicked.
Removes the selected element immediately from the JDeveloper view, without a confirmation dialog. Use with caution.
By default, opens the Check Out from Subversion dialog.
If you have configured JDeveloper for a different version control system, Check Out will open the checkout dialog for your selected version control software.
When you begin working on a project in Subversion, you check out the files you will be working with. It is recommended that you check out the entire application from the Subversion repository, so that you will have access to all files in that application in your local work area. Subversion uses the term modules to refer to the application it is recommended you check out.
| Note: With Subversion, there is no "check in" procedure, so you do not check in files that you have updated and check them out again when you next want to work on them. Instead, when you have finished working on your local copies of files, you commit them to the Subversion repository to bring the files held there up to date. |
To incorporate into your local copies changes that other developers have committed to the Subversion repository since you checked out your files, you update them.
When you check out Subversion files, they are copied from the Subversion repository to a new location (specified by you) on your local machine. This location and the files within it constitute the Subversion "working copy".
To check out modules from the Subversion repository:
If there is no current connection to a Subversion repository, the Create Subversion Connection dialog is opened for you to create one.
The Check Out from Subversion dialog is displayed. To obtain more information when working with the dialog, press F1 or click Help.
When you have made all your selections, click OK.
Use these procedures to bring the files you have been working on up-to-date with a revision in the Subversion repository.
It is recommended that you perform the update operation on a working copy.
When you use Update Working Copy, all the files in your checked out working copy will be updated, regardless of which node you have active in your application in the JDeveloper Application Navigator. The alternative is to select Update. This will only update the folder or file (and any child folders and files) that you have selected in the Application Navigator.
To update a working copy (recommended):
The Update Working Copy dialog is displayed with the working copy folder listed.
To obtain more information about the options, press F1 or click Help.
You can also update individual files. However, this runs the risk of not updating all files that may have been modified by your team members since the last time you checked them out.
To update individual files:
The Update Resources dialog is displayed with the file(s) listed.
To obtain more information about the options, press F1 or click Help.
Files that you created within (or brought into) JDeveloper before using Subversion control must be imported into the Subversion repository, and then checked out from it.
To import an existing JDeveloper project or application into Subversion:
The Import to Subversion wizard opens.
If you allowed the wizard to check out the imported files, the files are shown in the Application Navigator with a version number next to them. You may have to refresh the view before the files are shown.
If you did not allow the wizard to check out the imported files, you must now check them out before you can work on them.
You can also import an entire application into Subversion using the JDeveloper Version Application feature.
To import files using Version Application:
After you import files into Subversion using the Version Application feature, you will notice that Subversion creates two directories, one as your work area and one as a backup directory.
For example: after creating a new application called Catalog, select Versioning > Version Application > Subversion. Be sure to select the Perform Checkout from the Options page, then finish the wizard.
When the wizard completes, browse to the local directory that you have specified as the Source Directory for this application in Subversion. You will see two directories listed there: Catalog.svn-import-backup and Catalog.svn-import-workarea.
JDeveloper (and Subversion) will use the Catalog.svn-import-workarea directory for file access, checkout/checkin, and other activities. You should avoid editing, moving, or manipulating files in those directories outside of JDeveloper and Subversion.
After completing setup, your work with Subversion will revolve around checking files out, editing them in JDeveloper, and checking them in with your changes. You may also need to resolve conflicts between changes you made and those made by others in your team. Files may also be moved in and out of Subversion control, and finally, you might use special properties of the files associated with specific versions for tracking bugs, customer requests, and other characteristics.
When you create a new file in JDeveloper that is part of a local working copy (that is, an application that has been versioned and checked out of your SVN repository), you need to add and then commit the file to Subversion control before you can use the JDeveloper Subversion facilities with it. The preferred method is to set up JDeveloper to do this automatically, through the Preferences menu.
To add new files on commit:
You can also place individual files under Subversion control.
To put individual files under Subversion control:
The files can be your work files, or they can be the application and project files used by JDeveloper.
The Add to Source Control dialog is displayed with the files listed.
The files are now shown in the Application Navigator with a black cross, meaning that they are stored in your JDeveloper workarea but are not yet committed to the Subversion repository. Files must be committed to the Subversion repository before they can be versioned and accessed by other users.
The Commit Resources dialog is displayed with the files listed.
You will later be able to see these comments when viewing the list of versions of a particular file.
The files are now shown in the Application Navigator with an orange dot, indicating that they are known to the Subversion repository and are up to date.
Change sets, or change lists, are essentially labels which can be applied to working copy files to enable group operation on each change list. The idea behind adding files to a change set is similar to sorting files into directories, but change lists can be created dynamically and the labels applied to each file, regardless of their level in the file system hierarchy. You can then address all the files in the change set as a single group. For example, if you make a single bug fix that requires editing three different files, you can add all three files to the change set and track them as a single logical unit in the JDeveloper Pending Changes window.
Subversion lets you associate files with a named change set, either manually or automatically. You make additions to the change set through the menu system; automatic additions are also possible through default association, when JDeveloper detects outgoing changes.
You can browse changes for a named change set in a view of the Pending Changes window. From there, you can manipulate the change sets, and commit associated changes to the repository.
To add a selected file to a new change set:
To add file to a change set:
JDeveloper creates a default, unnamed change set for each installed version control system, and uses this change set until you specify another change set as the default. You can make changes to the content and the status of individual change sets, including this default change set, by right-clicking any change set and selecting from the following:
Change the content of the selected change set.
Deletes the selected change set from Pending Changes. Does not delete the files associated with the change set.
Makes the selected change set the default for future operations. All newly created and edited files will be made part of this change set until you either change the default or manually add the file to a different change set.
Use this procedure to open the History Viewer and view the history of Subversion files.
To view the history of a file:
For more information while using the History Viewer, press F1 or click Help.
Use these procedures to bring the Subversion repository up to date with the latest version of the files you have been working on, at the same time adding any new files to or removing any unwanted files from the Subversion repository.
You can perform the commit operation on individual files, or in the context of a working copy.
If an individual object that you want to commit has uncommitted parent objects, you must first commit the parent objects. An alternative is to commit the working copy that the objects are part of, in which case all the uncommitted objects will be committed.
You can also use change sets to manage groups of files, which can help ensure that you commit all files pertaining to a particular sub-project or task within the overall application.
To commit individual files shown in the Application Navigator or the Pending Changes window:
The Commit Resources dialog is displayed with any files listed. Set the options on the Commit Resources dialog as required.
To obtain more information about the options, press F1 or click Help. To commit the listed file or files to the Subversion repository, click OK.
To commit a working copy from the Application Navigator:
To obtain more information about the options, press F1 or click Help. To update the Subversion repository with the content of the working copy, click OK.
When you use Commit Working Copy, all the files in your checked out working copy will be updated, regardless of which node you have active in your application in the JDeveloper Application Navigator. The alternative is to select Commit. This will only commit the folder or file (and any child folders and files) that you have selected in the Application Navigator.
Additionally, you can commit a working copy from the Pending Changes window.
To commit a working copy from the Pending Changes window:
To obtain more information about the Pending Changes window, press F1 or click Help.
If you are using Oracle Team Productivity Center, the work item ID will automatically be saved as a tag in the comment dialog when you commit.
Many team environments require the developer to enter comments when a file is checked in. These comments might include bug report numbers, dependencies on other files, or some other explanatory information to be stored in connection with the file being committed to the repository.
JDeveloper lets you create and select templates for use with such comments. The templates are available from the Commit menu.
To create a new template:
To select a template:
To make a comment to a file being committed:
Use the Revert command to:
To revert a file:
The Revert Local Changes dialog is displayed with the file or files listed.
For help while using the dialog, press F1 or click Help.
Use this procedure to replace a file with the base revision. The base revision is the revision from which the one you are currently working on originated.
To replace a file with the Subversion base revision:
Use these procedures to compare files that are under Subversion control with other revisions of the same files, or with other files.
To compare revisions of a file:
If there are no differences, a message is displayed. Otherwise the revision or revisions are shown in the Compare panel of the History tool.
To compare a file with another file:
The Select File to Compare With dialog is opened.
The files are shown in the Compare panel of the History tool.
To compare two files:
The files are shown in the Compare panel of the History tool.
You can hide (and later expose) the Compare panel of the History tool to view other panels in JDeveloper.
If there is a conflict between your copy of the file and the one in the Subversion repository, the icon next to the affected file will include an exclamation point. You will not be able to submit such a file to the Subversion repository. To overcome this problem, you should do one of the following:
Another reason you might need to do this is if you have resolved the conflict yourself in the file, rather than using the merge tool. This might be the case if you have chosen to merge files at the server rather than the more usual solution of merging files locally.
To revert to a non-conflicting file version:
To resolve the conflicts using the merge tool:
The file is opened with the Merge tab displayed, showing the merge tool.
For help while using the merge tool, press F1 or click Help.
To indicate that the conflict has been resolved, even if no changes have been made:
Use this procedure to merge two revisions of a file, where the revisions contain conflicting content. Conflicts are notified in the Pending Changes window: the outgoing status is "conflicts" or "conflicts on merge", and the Resolve Conflicts button is active.
To merge two revisions with conflicting content:
For help while using the merge tool, press F1 or click Help.
The merge tool has three panels. The left panel contains the content of the version in the repository. The right panel contains the content of the most recent local version. The center panel contains the results of the merge. In the margins between the panels are symbols representing suggested actions to resolve each conflict.
More suggested actions may be available from the context menus of the margin symbols.
Accepting an initial suggested action may cause the appearance of additional suggested actions.
You can also make changes to the content of the center panel by typing into it.
Subversion allows you to create and save properties associated with folders or files. These properties have a name and a value string.
You can resolve any such conflicts using Subversion's Resolve Tree Conflicts feature.
To resolve Subversion property conflicts:
This displays the versions with the conflicting properties in two adjacent panes, as with the Version Compare.
To resolve the conflict, you can make changes in the Subversion Properties window.
The Merge Wizard is instrumental to the way that JDeveloper supports Subversion merge tracking. Merge tracking in Subversion means in essence that Subversion remembers your merges so you don't have to. The Merge Wizard provides you with an easy way of selecting which components you wish to merge, such as specific revisions, branches, or change sets.
The Merge Wizard gives you a number of options:
Select this when merging a range of revisions to another branch, for example, when you are back-porting a group of bug fixes to the release branch.
Normally used when merging the changes on a branch back to the trunk, for example, if you completed the work on a feature branch and want to reintegrate the changes back to trunk.
Select this to merge the differences between two branches into the working copy.
Select this if you know that specific revisions are not yet ready, or not appropriate, to be merged into the trunk.
When you wish to work on files independently of the main line of development (the "trunk") you can create a branch. Using the same feature, you can also create a tag, a collection of files that captures the state of development at a particular point.
When you wish to put the work you have being doing on a branch back into the main line of development, you can start the process by using the merge revision facility. This will compare the content of two revisions and apply the differences to the current working copy. You can also use this facility whenever you wish to copy changes made in one revision to another revision.
You may want to change your working copy so that it is based on a different branch. You can do this using the switch feature, either as part of branch creation or independently.
To create a branch or tag:
For help when completing the dialog, press F1 or click Help.
To use the merge facility (that is, to compare two revisions and apply the results to the working copy):
For help when completing the dialog, press F1 or click Help.
To switch the working copy to be based on another location in the repository:
For help when completing the dialog, press F1 or click Help.
Subversion lets you define and add properties to various levels of the elements in the Application Navigator: files, folders, and other resources. You can define these properties and use them as a way of tracking files or folders that have something in common. For example, you can associate a specific Subversion property with a newly added feature. Viewing all files or folders with this Subversion property lets you see all the files associated with this feature: an HTML file, a JavaScript file, a class definition file, or any other elements that are involved in adding this new feature to your application.
If your team has been using Subversion properties for some time, you can use the View Subversion Properties menu to see a list of all elements that use a selected Subversion property. You can also compare the Subversion properties between different versions.
To view a list of Subversion properties:
If your project needs a new property for tracking and managing a particular aspect (such as a new feature or a bug fix), you can also add new properties.
To add a new Subversion property:
When you add or edit Subversion properties, the dialog lets you select or specify the following elements:
The file (or folder or other resource) to which this property is to be applied. To change this value, select a different file or resource. Note that if you wish to add this property at the application or project folder level, edit the resource file entry so that it refers to the folder, not the file.
Select a property name from the available list, or enter a new name to create a new Subversion property. Preface the new property name with svn: to be tracked as a Subversion property.
Enter the string to be displayed with this Subversion property when you view properties. For example, you can associate a specific Subversion property with a particular bug identification number or a specific upcoming release.
Note that the Value String might differ depending on the property. For instance, consider a property named svn:externals meant to record the connection between a local file and its external URL in the SVN repository. This property's value string would be a pair of text strings, respectively showing the local directory where the external file is to be checked out and the URL to the external file in the SVN repository
Assume for this example that the resource file is D:\temp and the property name is svn:externals. The value string (a value pair) might be:
external_libs https://ukp16449.uk.oracle.com/repos/trunk/FOD/StoreFront.jar
This indicates that the file StoreFront.jar held in the Subversion repository at that URL is to be checked out to D:\temp\external_libs. If the Value String entries were held in a specific file pointed to from this property, use the Value File entry.
If you know you will be adding the same Subversion property to a number of resources in your application, you can save the value string in a text file. Click Browse to select the text file that contains the value string you wish to use.
Select this if you wish Subversion to apply this property to all files and elements below the current level in the application or project hierarchy.
When you set an external property with a revision number, make sure you follow the correct format for the value string. You can use either of the following as the value string for a property of type svn:external to set the ExternalWebINF revision to 16, using the JDeveloper integrated Subversion:
ExternalWebINF -r 16 https://myserver.myteam.com/svn/repos/public-html/WEB-INFhttps://myserver.myteam.com/svn/repos/public-html/WEB-INF@16 ExternalWebInf
However, note that with Subversion 1.4 clients, only the first format is accepted.
Use this procedure to check the content status and any associated property status of a file that is under Subversion source control. You can also refresh the status of a file.
To view the status of a file:
The status labels shown are those used by Subversion to describe the source control status of content and any associated property.
The main statuses for content are:
The main statuses for associated properties are:
The source control status of a file is indicated in the JDeveloper navigators (Application Navigator and Team Navigator) by icon overlays, as below.
If the status of a file is changed outside JDeveloper, for example by using a Subversion client application, the new status might not immediately be shown in JDeveloper. To ensure that the status indicated in the navigator matches the true status of the file in the source control system, you can perform a manual refresh.
To refresh the status of files in JDeveloper:
If you wish to remove a file from Subversion control, use the JDeveloper Delete feature. This performs a "safe delete," which searches for usages of the file you are deleting and provides you with a dialog with options for proceeding.
To remove a file from Subversion control:
If JDeveloper finds usages of the file you are deleting, a dialog will offer you options for proceeding. Choose the appropriate option, then click OK.
Subversion provides features for creating and applying patches—methods for determining changes between two revisions of a file, and then applying those changes to a third file. In addition, Subversion contains features for exporting the details about repository connections, as well as files in the repository.
You may wish to record the changes between two revisions of a file, then apply those changes to a third file. You do this by creating a patch and then applying it.
To create a patch:
This generates a patch comprising the differences between a controlled revision of a file and a revision of the file held locally.
The History view lists all the revisions of the file. In the lower portion of the History view, the left pane shows the contents of a local revision, and the right pane shows the contents of the controlled revision.
The Select Patch Context dialog may open. For help while using this dialog, press F1 or click Help.
The Generate Patch dialog opens. Complete the dialog as required. For help while using the dialog, press F1 or click Help.
To apply a patch:
The resource can be an application, a project, or a source file.
If you chose to apply a patch to a project, the Select Patch Context dialog opens, through which you should specify whether you are applying a project file (.jpr) patch, or whether you are updating the contents of a project.
The Apply Patch dialog is opened.
You can export copies of JDeveloper files that are under Subversion control. You can do this from the Application Navigator, in which case the files will be exported from the Subversion "working copy", or from the Subversion Navigator, in which case the files will be exported from the Subversion repository. If you export using the Subversion Navigator, you can specify which revision of the files to export. Exporting the files means copying them to a local file system directory that you specify.
To export files from the Subversion "working copy":
An Export Files dialog opens.
To export files from the Subversion repository:
An Export Files dialog opens.
You can export the details of your Subversion repository connections to a file. You can subsequently import the connection details from the file to recreate the Subversion repository connections.
To export Subversion connection details to a file:
The Export Subversion Connections dialog opens.
To import Subversion connection details from a file:
The Import Subversion Connections dialog opens.
JDeveloper allows you to use the source control features of Concurrent Versions Support (CVS). Once you have installed the CVS extension, JDeveloper works in a seamless manner with CVS so that you can connect to the CVS repository, check out files, work on them and commit changes, all from within the JDeveloper navigators and menus.
| Note: For extensive information about how to use and administer CVS, see the CVS online manual athttp://www.cvshome.org. |
In general, CVS uses a common repository of files, accessible to JDeveloper, that you and your team share while developing a software project. To modify files in that repository, you first check them out so that CVS tracks the who, when, and what of file access. In the event that two team members edit the same file at the same time, CVS contains tools that help you determine whether those changes conflict, and to resolve problems that may arise and merge these simultaneous changes into a single, comprehensive file. Finally, CVS lets you check these changed files back into the repository so that your build tools will have access to the latest files, with new and/or merged content.
Before you can use CVS to manage your shared content, you need to connect JDeveloper to CVS. This means configuring JDeveloper, making a connection to your team's CVS repository, creating a local repository, and more. The topics in this section cover all the steps you'll need to make sure CVS is available from JDeveloper after downloading the CVS extension from Check For Updates. If your team is already using CVS, you should check with them for specifics on how CVS is implemented in your organization.
The process of setting up CVS with JDeveloper involves configuring JDeveloper, creating a CVS connection, importing files for the project into your CVS repository, and then checking out the CVS modules to be edited.
Before you can use CVS, you need to configure JDeveloper by setting preferences.
To configure JDeveloper for use with CVS:
For help while using this page, press F1 or click Help.
To select CVS as the versioning system:
After you have configured JDeveloper and selected CVS as the versioning system of course, you are ready to make the connection to CVS so that you can view and access files in the CVS repository
Before you can work with a CVS repository through JDeveloper, you must create a connection to it. When you create a local CVS repository, you can choose to create a connection to the repository automatically
CVS connections are shown in the CVS Navigator. You can subsequently edit the connection details.
To create a CVS connection:
The Create CVS Connection wizard is opened.
For help when using the wizard, press F1 or click Help.
To edit a CVS connection:
The Edit CVS Connection wizard is opened.
For help when using this wizard, press F1 or click Help.
Before you can start using your JDeveloper project with CVS, you have to import the project files into the CVS repository. This copies all your folders and files to the CVS repository and places them under source control.
You import your project files into the CVS repository using the Import to CVS wizard.
To use the Import to CVS wizard:
Before you can change any files, you have to copy them back to your machine, where you can work on them locally.
This is a configuration task you perform when you first start to use JDeveloper with files and folders that are under CVS source control. You perform this task once, after (if necessary) importing your JDeveloper project into the CVS repository.
To check out modules from the CVS repository:
Either:
Choose Versioning > CVS > Check Out Module.
or:
from the context menu, select Check Out Module.
The Check Out from CVS dialog is displayed.
In addition to setting up JDeveloper to be able to use CVS, there are certain tasks you need to perform to make CVS usable with JDeveloper. Some of these tasks may be performed by your administrator. You should always check to make sure which of these tasks have been performed in your installation.
In general, you need a local CVS repository for storing files as you are working on them. You may also need to configure a secure shell (SSH) for communicating with CVS, and you may need to choose a character set. Finally, you will need to log in to CVS.
From within JDeveloper, you can create a new CVS repository on your local file system. This feature is available only if you are using external CVS client software, rather than the internal CVS client installed as part of the CVS extension to JDeveloper.
To create a local CVS repository:
You can specify or select an existing directory if it is empty, or you can specify a new directory. If the directory you have specified exists and is not empty, you will see a warning dialog telling you to specify an empty or new directory for the repository.
The connection will be given a name in the form :local:{path}. If you later want to change this name, you can do so through the CVS Navigator: from the context menu of the connection name, open the properties dialog and, on the Name tab, overtype the existing name with a new one.
JDeveloper supports SSH Levels 1 and 2 as access methods for CVS repositories.
JDeveloper does not provide a direct way of using SSH Level 1 as an access method for the CVS repository. It is however possible to configure SSH Level 1 so that it can be used for remote shell access.
To configure SSH Level 1 to enable remote shell access:
ssh-keygen ~/.ssh/identity.pub public key file with ~/.ssh/authorized_keys on the machine with the CVS repository. Before running JDeveloper and attempting to use CVS with SSH Level 1, users should be explicitly authorized and the environment correctly configured. Follow the steps below to configure the environment correctly.
To configure the environment for SSH Level 1:
CVS_RSH environment variable to the location of the SSH client. ssh-agent {shell}, and then press Enter. ssh-add, and then press Enter. JDeveloper provides a direct way of using SSH2 as an access method for the CVS repository.
To use SSH2 for remote shell access:
If you are using an internal CVS client, you can generate SSH2 key files at any time by choosing Versioning > Administration > Generate SSH2 Key Pair. If you are using an external CVS client, this menu option is unavailable.
If your installation uses a local CVS client, you need to choose a character set.
For each CVS repository connection, you can choose the character set to be used for the encoding of files. The default is to use the character set specified by the platform/operating system.
You can change to the IDE default or to a specific character set through the Set Encoding dialog.
To choose a character set:
Some types of connection to a CVS repository require you to log in independently of making the connection. If you cannot access any CVS features even though a CVS connection exists, you need to log in.
To log in to a CVS repository:
If the Log In menu option is unavailable but the Log Out option is available, you are already logged in.
If JDeveloper finds a path to a CVS client on your machine, the JDeveloper CVS preferences will by default be set to use that CVS client (rather than the internal CVS client installed with JDeveloper). If no path to a CVS client is found, the preferences will be set to use the internal CVS client.
The internal CVS client cannot be used to access a local CVS repository (that is, one on your own machine). If you wish to access a local CVS repository, you must install a full client/server version of CVS onto your machine and set the JDeveloper CVS preferences accordingly.
If you wish to use an external CVS client, we recommend the following:
http://www.cvsnt.org/archive | Note: You may already have a CVS installation that is client-only. This will not be able to access a local CVS repository, and you should install a full client/server version instead. If you are unable to expand the connections node in the CVS Navigator or open the list of modules from the Get Module List button in the CVS wizards, you probably have client-only CVS software that is attempting to access a local CVS repository. You can check which type of CVS installation you have by typingcvs -v at the CVS command prompt. A client-only installation will display (client) at the end of the version information line, whereas a client/server installation will display (client/server). |
To access CVS through a firewall:
If you are accessing a CVS server through a firewall, you can connect to it if:
If there is an authentication failure when you log in, try using the CVS command line to connect. If this fails, the connection may be being blocked by the firewall, and you should contact your network administrator.
If necessary, you can alter the value of the CVS root variable to support connection through a firewall.
The CVS administrator has to configure the CVS repository for the automatic handling of binary files produced by JDeveloper, such as image file formats.
Where other file types are updated, CVS attempts to merge them. If you do not want is to occur, you must change the configuration of the CVS repository.
For more information about CVS, refer to the CVS documentation, or see the CVS website, http://www.cvshome.org. This is also where you can download CVS software.
Once JDeveloper is configured and your project files are available in the CVS repository, you will most likely use a workflow that follows the basic sequence of update, checkout, modify, and commit. In addition, you may occasionally need to resolve edit conflicts, and merge the resulting file(s) into the repository.
The CVS update operation updates your local files with data in the CVS repository. Alternately, you can choose to completely replace your local files with those held in the CVS repository.
You can update individual files (including project files), or you can update the entire contents of a project folder.
You can view the contents of the CVS repository through the CVS Navigator. The nodes under CVS Server unfold to reveal the structure and file content of the CVS repository. You can open a read-only version of a CVS repository file by choosing Open from its context menu. This will let you see what changes have been made to the files in the CVS repository since you checked out or last committed your local versions.
To update an individual file (including a project file):
To update the contents of a project folder:
To update files shown in the Pending Changes window:
To obtain more information about the Pending Changes window, press F1 or click Help.
Editing and watching are available only when an external CVS client executable is used.
These procedures allow you to obtain and release an editor on a file, to know who else in your team is editing files, and to know who is watching for files to be edited. Two or more developers retain the ability to edit the same file at the same time.
To set up JDeveloper to use editing and watching:
To obtain an editor on a file:
To release an editor on a file (to unedit a file):
This action reverses changes made in the current edit. Any local file modifications will be lost when the editor is released.
To turn on or turn off the file watching facility:
To add yourself to the list of people who receive notification of work done on files:
To remove yourself from the list of people that receive notification of work done on files:
To see who is watching for changes being made to files:
The Edit Notifications window is opened. The Watchers tab shows the files that are being watched and the user(s) who are currently watching for changes.
To see who is currently editing files:
The Edit Notifications window is opened. The Editors tab shows the files that currently have editors on them and the user(s) who have obtained those editors.
Use these procedures to update the CVS repository with the latest version of the files you have been working on, and to add any new files to or remove any unwanted files from the CVS repository.
You can perform this on a single file, or in the context of a project. When in the context of a project, JDeveloper determines which files have changed since they were last committed and displays them as a list.
If you select a project to be committed that includes files that are not yet part of CVS version control, the Add Files to CVS message dialog will open. To obtain information about using this dialog, press F1.
You can view the current contents of the CVS repository through the CVS Navigator. The nodes under CVS unfold to reveal the structure and file content of the CVS repository. You can open a read-only version of a CVS repository file by choosing Open from its context menu. This will let you see what changes have been made to the files in the CVS repository since you checked out or updated your local versions.
To commit individual files shown in the Application Navigator:
The Commit to CVS dialog is displayed with the file(s) listed.
To obtain more information about the options, press F1 or click Help.
To commit the contents of project folders shown in the Application Navigator:
If there are files in the project that are not under CVS control, you will be asked whether you want to add them.
The Commit to CVS dialog is displayed with the folder(s) listed.
To obtain more information about the options, press F1 or click Help.
To commit files shown in the Pending Changes window:
To obtain more information about the Pending Changes window, press F1 or click Help.
Use this procedure to merge two revisions of a file, where the revisions contain conflicting content. Conflicts are notified in the Pending Changes window: the outgoing status is "conflicts" or "conflicts on merge", and the Resolve Conflicts button is active.
To merge two revisions with conflicting content:
For help while using the merge tool, press F1.
The merge tool has three panels. The left panel contains the content of the version in the repository. The right panel contains the content of the most recent local version. The center panel contains the results of the merge. In the margins between the panels are symbols representing suggested actions to resolve each conflict.
More suggested actions may be available from the context menus of the margin symbols.
Accepting an initial suggested action may cause the appearance of additional suggested actions.
You can also make changes to the content of the center panel by typing into it.
CVS lets you define branches, used when development needs to be carried out separately from the main (or trunk) branch of a project. JDeveloper gives you access to CVS branches in your repository through the Tag, Branch and Merge menu.
In CVS, you can create a separate branch when you want to carry out specific work (such as bug fixes or specialized feature development) without any impact to the main set of files, also called the trunk.
Once you have created a branch, you interact with it as normally with CVS -- check out files, commit changes, etc. You can switch back and forth between branches, and you can merge the changes you have made to your branch back into the trunk.
CVS also lets you apply tags to specific branches, or to specific files in a branch (as well as generating a new tag for the branch you create, when you create it).
You create a new branch when you are beginning a project based on an earlier version of your code repository, such as for fixing bugs after a major release, or working on specific features for a subset of your customers.
To create a new branch:
The base tag is applied before the branch is created, allowing you to specify these versions as a merge point in future.
You can also specify that you wish to create your new branch from an existing branch, by choosing the branch to use as the base.
To create a new branch from an existing branch:
Branch selection is integrated into a number of CVS functions. You can switch branches or versions for files you are editing or have checked out; you can choose tags, branches, or version dates while updating the contents of your work area, as well as while you are checking out a CVS module.
You can switch the branch or version of a file you are editing, either from the JDeveloper Versioning menu or from the file or project's context menu.
To select a branch, version or date from the Versioning menu:
To select a branch, version or date from the project's context menu:
When you are updating your content to capture the latest revisions to the repository, you have the option of branch (via its associated tag) at the same time.
To select a tag and branch while updating:
As with other CVS operations, tags and branches are integrated into the process of checking out a CVS module.
To choose a branch while checking out:
Tags are a way of identifying branches, branch-specific content, or other content that you wish to identify and manipulate as a single logical group. You can tag files, folders, or projects. You can then later use these tags to identify branches, update files from a branch with a specific tag, and other operations.
You can select and browse tags from context menus as well as the Versioning > CVS > Tags menu. The availability of tags differs depending on the context of the operations you are performing on your content.
You can identify a project by adding a tag to it. You can then operate on this project by selecting the tag from any of the CVS menus that contain the tag chooser.
To add a tag to a project:
You can choose and apply a tag while using the Update from CVS dialog.
To select an existing branch, version or date from the Projects view:
You can also delete a tag. Deleting a tag removes it from any resources to which you have applied it. Deleting the tag does not delete the content to which the tag was applied; it merely removes it from the list of available tags.
To delete a tag:
In this context, only existing tag versions (regular non-branch tags) can be selected.
As a very general rule, working with files in CVS means checking out the latest version of a file, making your edits, and checking the file in with your changes. Occasionally, if you and a colleague have made edits to the same file, you may need to merge your changes to make sure your work is not lost. Other functions of CVS are also available, such as adding a new file or removing unused/obsolete files from the repository, but your general workflow will follow the checkout-edit-checkin pattern.
The file operations in CVS include refreshing the display of CS objects, adding and removing files, using templates, comparing files, replacing a file in CVS, viewing the history and status of a file, locking and unlocking files, and working with revisions and tags.
The source control status of an object is indicated in the Application Navigator by an icon overlay, as listed in Table 6-1.
Table 6-1 CVS Object Status
| Icon | Description |
|---|---|
|
| The object has been copied from the CVS repository and added to your working files directory. |
|
| The object is not under CVS source control, but may be added to the CVS repository. |
|
| There were conflicts when the object (a file) was updated from the CVS repository. In this case, you have to manually edit the file to resolve all the points of conflict. |
|
| The object has been scheduled for removal from the CVS repository with the next commit action. |
|
| The object is out of synch with the CVS repository due to local or remote changes. |
|
| The object is unmodified since it was last copied from the CVS repository. |
|
| The object is unmodified since it was last copied from the CVS repository but is read-only. |
|
| The package or node is a CVS sandbox folder. |
|
| The apparent object may comprise several underlying objects, the statuses of which may not all be identical. |
If the status of an object is changed outside JDeveloper, for example by checking in an object using external source control software, the new status might not immediately be shown in JDeveloper. To ensure that the status indicated in the Application Navigator matches the true status of the object in the source control system, you can perform a manual refresh.
To refresh the status of objects in JDeveloper:
You can add a file to CVS only if it is part of a project that is already under CVS version control.
When you create a new file, for example a new class, it has to be added to source control before you can use the other CVS operations on it. The file is added to source control locally, and the CVS repository is not updated. The file is identified in the Application Navigator by the icon +.
To add a file to CVS through the Application Navigator:
The file will be added to the CVS repository when the next commit is performed.
To add files shown in the Pending Changes window:
To obtain more information about the Pending Changes window, press F1 or click Help.
To remove a file from CVS:
When you remove a file from CVS it is removed from your local disk.
The file or files will be removed from the CVS repository when the next commit is performed.
Many team environments require the developer to enter comments when a file is checked in. These comments might include bug report numbers, dependencies on other files, or some other explanatory information to be stored in connection with the file being committed to the repository.
JDeveloper lets you create and select templates for use with such comments. The templates are available from the Commit menu.
To create a new template:
To select a template:
To make a comment to a file being committed:
Use these procedures to compare revisions of files that are under CVS source control. You can compare a file with its immediate predecessor, or you can compare with any of the file's previous revisions.
To compare a file shown in the Application Navigator:
If there are no differences, a message is displayed. Otherwise the Compare tool is displayed.
To compare a file shown in the Pending Changes window:
You can compare a file in the Pending Changes window either with a previous revision or with the HEAD revision, depending on which mode the window is in. To obtain more information when using the Pending Changes window, press F1.
If there are no differences, a message is displayed. Otherwise the Compare tool is displayed.
Use this procedure to replace a file with the base or head revision, or with a file with a specific revision number or tag. The head revision is the latest one. The base revision is the revision from which the one you are currently working on originated.
To replace a file with a CVS revision:
The history and status of a file will tell you what has been done to it, and what has been done to it last. This can help you make the determination of what you need to do to bring the file up to date, or to begin making your own modifications.
Use this procedure to open the History Viewer and view the history of CVS files.
To view the history of a project or file:
For more information while using the History Viewer, press F1.
Use this procedure to check the status of a file that is under CVS source control. You can also refresh the status of files under CVS control.
To view the status of a file:
Possible statuses are:
| Note: The locking of files is not supported in newer releases of CVS client software and this facility may be removed in future releases of JDeveloper. |
You can choose to prevent other users working on a file while you are working on it yourself. This is not normally considered necessary, because CVS can usually reconcile differing versions of files as they are being committed to the CVS repository. The JDeveloper compare and merge facilities will reconcile differing versions of files automatically, or present you with a tool for doing so manually if there are serious conflicts.
You may want to ensure that a file is worked on only by you, until you have finished working on it. This might be because a file is in binary format and therefore inherently difficult to merge. In this case, you can lock the file that you want to work on. The file is locked in the CVS repository, and other users are prevented from accessing it. When you want to let others work on the file, you unlock it.
To lock files in CVS:
To unlock files in CVS:
These procedures allow you to work with revisions and tags.
To open a CVS file revision:
This procedure will obtain a revision of a file from the CVS repository so that you can view it or save it locally.
To assign CVS tags:
This procedure will assign symbolic tags to the local CVS revisions of selected files.
To delete CVS tags:
This procedure will delete symbolic tags from the local CVS revisions of selected files.
To view CVS tags:
This procedure will display a dialog containing information about any existing tags that have been applied to the file revision.
To reset CVS tags:
This procedure will remove any sticky tags or dates that have been applied to the selected files and reset them to the HEAD revision.
At times, you may wish to use CVS with external tools (for comparing versions of files to be merged, for example) or to create and apply patches for projects you are developing with files under CVS control. Additionally, you may find it necessary to export a CVS module, or to copy the CVSROOT value to the clipboard. These procedures explain how.
JDeveloper has an integrated compare viewer that works well for most circumstances. However, you may prefer to use another compare tool or the simple output from CVS DIFF. JDeveloper lets you integrate third party tools and applications. This procedure describes how to use the External Tools support in JDeveloper to integrate external compare viewers.
To integrate CVS DIFF:
c:\cvsnt\cvs.exe) or just cvs-d ${cvs.root} diff ${file.name}-d ${cvs.root} diff -r ${cvs.revision} -r ${cvs.second.revision} ${file.name}${file.dir}To integrate a third party diff utility:
You can use external tools macros to view differences between two revisions in the history tool using a third party utility such as Araxis Merge. The following steps will install a menu item to invoke Araxis Merge. For other utilities, consult the documentation of the utility to determine which command line arguments need to be passed in.
c:\araxismerge\compare.exe)/wait /title1:"${file.name} revision ${cvs.revision}" /title2:"${file.name} revision ${cvs.second.revision}" /2 ${cvs.revision.file} ${cvs.second.revision.file}To integrate other CVS commands:
You can take advantage of the supplied external tool macros to easily integrate other CVS commands into JDeveloper. An example is the CVS annotate command (sometimes referred to as "blame"), which shows a summary of who changed each line of code and when the change was made. To integrate a tool for CVS annotate, set the following options in a new tool:
C:\cvs\cvs.exe)${file.dir}You use the CVS Export wizard to export the revisions of files for a module, creating a deployment-ready file structure.
To use the CVS Export wizard:
The files are exported to the location you have specified.
You can copy the path of the CVSROOT from a node in the CVS Navigator to the Clipboard, for use in other applications.
To copy the CVSROOT path to the Clipboard:
The full path of the CVSROOT is copied to the Clipboard, from where you can paste it into another application.
You may wish to record the changes between two revisions of a file, then apply those changes to a third file. You do this by creating a patch and then applying it.
To create a patch:
This generates a patch comprising the differences between a controlled revision of a file and a revision of the file held locally.
The History view lists all the revisions of the file. In the lower portion of the History view, the left pane shows the contents of a local revision, and the right pane shows the contents of the controlled revision.
The Select Patch Context dialog may open. For help while using this dialog, press F1.
The Generate Patch dialog opens. Complete the dialog as required. For help while using the dialog, press F1.
To apply a patch:
The resource can be an application, a project, or a source file.
If you chose to apply a patch to a project, the Select Patch Context dialog opens, through which you should specify whether you are applying a project file (.jpr) patch, or whether you are updating the contents of a project.
The Apply Patch dialog is opened.
Perforce uses a local directory structure to receive files that are going to be placed under formal source control. This location is called the "Perforce client workspace". Files created in (or moved into) JDeveloper must be stored in this location. Once files are in your Perforce client workspace, you bring them fully under source control by submitting them to a central location called the "Perforce depot". Files must be submitted to the Perforce depot before they can be versioned and accessed by other users.
Before using Perforce with JDeveloper, in addition to downloading the Perforce extension, you need to install a number of Perforce features so that they are available to JDeveloper. Once installed, you configure JDeveloper and connect to the Perforce client workspace. Finally, you need to bring your working files under Perforce control so that they are available from within JDeveloper while using Perforce.
There must be at least one Perforce server installed, on a machine that is accessible to the intended JDeveloper users. If a Perforce server installation does not already exist, obtain the necessary software (for example, from www.perforce.com) and install it in accordance with Perforce's instructions. Record the identity of the machine on which the Perforce server software has been installed: you will need this when you connect to it through JDeveloper.
Perforce Client Installation
You must install the Perforce client application on the machines that contain (or that will contain) JDeveloper. The Perforce client application can be installed from the same software as the server software, obtainable from www.perforce.com. The installation must include the "Command Line Client (P4)" and, for Windows installations, "Visual Merge for Windows (P4WinMrg)".
When you first run the Perforce client application, you will be required to create a Perforce client workspace. The Perforce client workspace is where the working copies of files under Perforce control will be stored. You can use the JDeveloper default directory as the Perforce client workspace, whether or not it already contains JDeveloper files. The JDeveloper default directory is <installation_directory>\jdev\mywork. Alternatively, you can accept the default Perforce client workspace, or specify one of your own. In these cases, you should note the location you have used, because you will need to specify it when creating applications and projects in JDeveloper.
f you set up passwords in the Perforce client application, you will also need to use them when connecting to Perforce through JDeveloper.
JDeveloper Installation
JDeveloper must be installed in the normal way. Each installation of JDeveloper can act as a client application for Perforce. You can install JDeveloper on every machine that you wish to be a Perforce client, or you can use a mixture of JDeveloper installations and Perforce's own client applications. The JDeveloper and Perforce client applications will work together in a seamless manner. In addition to the JDeveloper embedded support for Perforce, you will also be able to access a Perforce client application through the JDeveloper interface.
Before you can configure JDeveloper to use Perforce, you must have installed the Perforce server and client software.
To configure JDeveloper for use with Perforce:
To select Perforce as the version system:
Before Perforce operations become available within JDeveloper, you must connect to Perforce.
To connect to Perforce manually:
The Connection dialog is opened. The username, port and client information should have been derived automatically and should now appear in the Connection dialog.
To connect to Perforce automatically when you start JDeveloper:
In some development environments, you may need to make more than one connection to Perforce. For example:
The Perforce extension to JDeveloper permits all these operations. You begin by giving each Perforce connection a name as you create it.
To create a named Perforce connection:
The Connection dialog is opened. The username, port and client information should have been derived automatically and should now appear in the Connection dialog.
Note that your Perforce changelist will display the connection that applies to each file in the changelist.
Files that you create within JDeveloper, or files that you bring into JDeveloper from outside, must be brought under Perforce control before you can use the JDeveloper Perforce versioning facilities with them.
If you have an existing JDeveloper project that you wish to bring under Perforce control, use the Import to Perforce wizard.
To put individual JDeveloper files under Perforce control:
The files can be your work files, or they can be the application and project files used by JDeveloper.
The Add Files to Perforce dialog is displayed with the files listed.
The files are now shown in the navigator with a red cross, meaning that they are stored in your Perforce client workspace but not yet in the Perforce depot. Files must be added to the Perforce depot before they can be versioned and accessed by other users.
The Submit Files dialog is displayed with the files listed.
You will later be able to see these comments when viewing the list of versions of a particular file.
The files are now shown in the navigator with a green dot, indicating that they are known to the Perforce depot and are up to date.
To bring files created outside JDeveloper under Perforce control:
\src directory under the JDeveloper file storage directory (which should be the same as the Perforce client workspace). The files should now appear in the navigator, within the project whose \src directory you used. The files are marked with a white-on-blue diagonal cross, showing that they are known to JDeveloper but not under source control.
Before you can start using existing JDeveloper project and source files with Perforce, you have to import them into your Perforce client workspace. Once they are in your Perforce client workspace, you bring them fully under source control by submitting them to the Perforce depot.
You import JDeveloper project and source files into your Perforce client workspace using the Import to Perforce wizard.
To use the Import to Perforce wizard:
The project and files will be shown in the navigator. If you have chosen to display overlay icons, these will indicate the current source control status of the files.
Perforce provides features for creating and applying patches—methods for determining changes between two revisions of a file, and then applying those changes to a third file. In addition, Perforce contains features for exporting the details about repository connections, as well as files in the repository.
Another person may edit a file through their Perforce client and submit their changes to the Perforce depot. This will cause your copy of the file to become out of date compared with the controlled version.
To test that your view is showing the latest file statuses:
A file that is out of date with the controlled version is shown with an exclamation point icon.
To bring your files up to date compared with the controlled version:
The Sync Files dialog is displayed with the files listed.
For more information about the dialog options, press F1.
Your local files are replaced with copies of the controlled versions. The icon shown next to the files changes to a green dot.
The Perforce Navigator lets you browse the Perforce depot and update your working directory from content at the depot. Using the navigator, you can select folders or files to sync to your client workspace, downloading content from the Perforce Server to your computer. If new files are detected in the depot, you have several options for handling them.
If you opens a connection node and no connection has been made, Perforce displays the connection dialog.
To synchronize your files using the Perforce Navigator:
Head Revision
Synchronize to the Head revision of your project. If you select this, the Sync From Depot dialog displays the Force sync checkbox. Select Force Sync if you wish to download the depot content to your working directory regardless of the contents of each (for example, if you know you want to start with a clean download of the depot's contents).
Revision Number
Select this to synchronize to a specific revision number. The Sync From Depot opens the Target field; use the Target field to type the revision number to which you wish to synchronize your local working copy.
Changelist
Select this to synchronize to a specific changelist. The Sync From Depot opens the Target field; use the Target field to type the name of the change list from which you wish to synchronize your local working copy.
Label Name
Select this to open files with a specific label (typically, used to identify a specific branch). The Sync From Depot opens the Target field; use the Target field to type the name of the label from which you wish to synchronize your local working copy.
Date
Select this to specify a date (and, optionally, time) from which you wish to synchronize your local files. The Sync From Depot opens the Target field; use the Target field to type the date (in either yyyy/mm/dd or yyyy/mm/dd:hh:mm:ss format) of the files from which you wish to synchronize your local working copy.
Choose the field that applies to your current project, then click OK.
Open files in active project
Copy the files, and open them in the project you have selected.
Create new project from files
Creates a new project, using the files Perforce has detected.
Open editors onto files
Open the files in editor windows, so that you can review them and determine the best resolution (keep, rename, discard, or modify).
Do not open files
Leaves the files unopened, without copying them from the depot to your working directory.
If you have a very large number of files in your Perforce depot, it can be much easier to navigate to the files you're working on by filtering files in the Perforce workspace. You can do this by setting things up in the Perforce client, and then displaying the filtered view in JDeveloper.
Filtering files in Perforce (specifically, p4v) requires making sure that you are viewing the Depot Tree, then select the Filter icon > Tree Restricted to Workspace View.
To filter files in JDeveloper:
You will only see a difference in the JDeveloper Version Navigator if the Perforce client has a rule that restricts the Perforce workspace. (In p4v, the rules are shown and set in the View field of the Workspace dialog for the selected workspace.) You could restrict the workspace view in your p4v client with a rule like the following:
//depot/JDeveloper_1013/... //<client name>//JDeveloper_1013
In JDeveloper, if you select Filter by Client Workspace, the navigator would be filtered so only //depot/JDeveloper is shown.
By default, you can start editing a file under Perforce control just by opening it from the navigator. While the Perforce server is being contacted, you may experience a delay before you can type into the opened file. If you would prefer files to remain closed until you manually open them for editing, set the Automatically Open Files for Edit preference to off. The following procedure works whichever way the preference is set.
To edit a file under Perforce control:
The Open Files for Edit dialog is displayed with the file listed.
If you do not obtain the controlled version before editing the file, you may create a conflict between your file and the version in the Perforce depot. You will then have to resolve the conflict before your changes can be accepted into the controlled version.
Locking a file means that others can edit the file but cannot submit the file until the person who applied the lock has released it.
The file will be indicated to Perforce as editable. A red check mark is added to the file's icon in the navigator.
You can also close the file if you wish.
The changes that you made to the file are now saved in your Perforce client workspace. To add your changes to the controlled version of the file and make them available to other users, you must now submit them.
Any changes that you make to a file are initially saved in your Perforce client workspace. To add these changes to the controlled version of the file and make them available to other users, you must submit them. In the following procedure, if the Submit menu option is unavailable, it is because there are unresolved conflicts between your copy of the file and the one in the Perforce depot. Before proceeding, you will have to resolve the conflicts or revert the file to a non-conflicting version.
To submit changes to the Perforce depot:
The Submit Files dialog is displayed with the file listed.
The file is now shown in the navigator with a green dot, indicating that it is up to date compared with the version in the Perforce depot.
If there is a conflict between your copy of the file and the one in the Perforce depot, the icon next to the affected file will include an exclamation point. You will not be able to submit such a file to the Perforce depot. To overcome this problem, you should either revert to a non-conflicting version of the file, or resolve the conflict. You can resolve the conflict using the locally installed Perforce client application, or another merge tool of your choice, as specified on the Preferences page (Tools > Preferences > Versioning > Perforce > Version Tools).
To revert to a non-conflicting file version:
To resolve conflicting file versions (assumes use of Perforce merge tool):
If you cannot automerge the conflicts, run the merge tool and use its facilities to create a definitive version from the conflicting data.
The file will still be marked as open for edit.
If there is a conflict between your copy of the file and the one in the Perforce depot, the icon next to the affected file will include an exclamation point. You will not be able to submit such a file to the Perforce depot. To overcome this problem, you should either revert to a non-conflicting version of the file, or resolve the conflict. You can resolve the conflict using the locally installed Perforce client application, or another merge tool of your choice, as specified on the Preferences page (Tools > Preferences > Versioning > Perforce > Version Tools).
To revert to a non-conflicting file version:
To resolve conflicting file versions (assumes use of Perforce merge tool):
If you cannot automerge the conflicts, run the merge tool and use its facilities to create a definitive version from the conflicting data.
The file will still be marked as open for edit.
The source control status of a file is indicated in the JDeveloper navigators by icon overlays, as listed in.
Table 6-2 Perforce Status Icons
| Icon | Meaning |
|---|---|
|
| The file is in the Perforce client workspace but is not yet submitted to the Perforce depot. |
|
| The file will be deleted when next submitted to the Perforce depot. |
|
| The file is out of date compared with the Perforce depot. |
|
| The file is up to date compared with the Perforce depot. |
|
| The file is open for edit. |
|
| The file is locked. |
If the status of a file is changed outside JDeveloper, for example by using a Perforce client application, the new status might not immediately be shown in JDeveloper. To ensure that the status indicated in the Application Navigator matches the true status of the file in the source control system, you can perform a manual refresh.
To refresh the status of files in JDeveloper:
If you wish to delete a file that it is under Perforce control, you should do so using the Perforce facilities within JDeveloper or the Perforce client application. You should not use the Erase From Disk or Delete commands to delete a file that is under Perforce control, as this may cause versioning problems.
To delete a file under Perforce control:
The Delete Files dialog is displayed with the file listed.
The file is deleted from the local file system. A black diagonal cross is added to the file's icon in the navigator.
If you need to retrieve a file that has been deleted, you will need to use the Perforce client. To do this, select Versioning > Perforce > Launch Perforce Client.
In Perforce, changelists let you group files together to simplify operations. Once files are grouped in a changelist, you can check them out and submit them all in a single operation.
In Perforce, changes are submitted to a Perforce repository using a changelist. This lets you group changes to several files into a logical unit, and then submit this unit to the Perforce repository in one operation.
You can have more than one changelist. You may find it useful to create changelists for specific projects, for related groups of files, or for any other grouping of files that you find create a logical unit, based on the way you and your team work. You can also move files from one changelist to another.
In general, you use changelists by following this workflow: create a changelist, add files to your changelist, edit your files and submit your changelist with the edited files.
You can also browse existing changelists through the Changelist Browser. The Changelist Browser also lets you create, submit, and move files between changelists. If the submit operation fails on any file in the changelist, then the whole changelist fails. This means the Perforce repository is left in a consistent state.
A Perforce changelist lets you manipulate a number of changed files and folders in a single operation, simplifying the process when you have several files that you have been working on.
To create a Perforce changelist:
Annotating a Perforce revision or changelist lets you store the Perforce revision or changelist as a comment linked to every file in the revision. When you modify these files later in Perforce, you can view the sequence of revisions or changelists to these files, as annotations to the files.
To add annotations to a changelist:
Any previous annotations will be visible in the Comments field of the changelist.
A Perforce changelist lets you manipulate a number of changed files and folders in a single operation, simplifying the process when you have several files that you have been working on. When you add files to Perforce, you can select the changelist to which these files will be added at the same time, through the Open for Add menu.
To add files to a changelist:
Once you have made a series of edits to your files, you are ready to submit them in Perforce. If you have created a changelist, you can submit all the files on that changelist in a single operation, or select just the ones you have edited and submit them.
To select and submit the files in a changelist:
The Changelist Browser lets you see, at a glance, the state of all the pending changelists in your Perforce repository. Each pending changelist is shown with its name, description, and contents. The default changelist is always shown at the top of the browser. Under each changelist, you can browse the files that are associated with that changelist. Additionally, the Perforce connection and client are displayed at the top of the browser.
From the Pending Changelist browser, you can create and submit changelists, move files between changelists, and refresh the browser.
To create a changelist with the Changelist Browser:
To submit a changelist:
To move files between changelists:
You can also refresh the changelist browser by pressing F1.
You may wish to record the changes between two revisions of a file, then apply those changes to a third file. You do this by creating a patch and then applying it.
To create a patch:
This generates a patch comprising the differences between a controlled revision of a file and a revision of the file held locally.
The History view lists all the revisions of the file. In the lower portion of the History view, the left pane shows the contents of a local revision, and the right pane shows the contents of the controlled revision.
The Select Patch Context dialog may open. For help while using this dialog, press F1.
The Generate Patch dialog opens. Complete the dialog as required. For help while using the dialog, press F1.
To apply a patch:
The resource can be an application, a project, or a source file.
If you chose to apply a patch to a project, the Select Patch Context dialog opens, through which you should specify whether you are applying a project file (.jpr) patch, or whether you are updating the contents of a project.
The Apply Patch dialog is opened.
JDeveloper allows you to use the source control features of Dimensions. JDeveloper integrates the repository management and file access features of Dimensions so that you can access your repository, check files in and out, and view the checked-in versions of files under Dimensions control.
Dimensions is a popular version-control system that is part of a larger content-management and workflow control package. JDeveloper includes an extension which allows you to access the version-control features of Dimensions from within the JDeveloper IDE.
To use Dimensions from within JDeveloper, you need to complete several simple setup operations, to ensure that your Dimensions repository is available and your working files are under Dimensions control.
You can then set the current project for JDeveloper, under the control of Dimensions.
After setting up Dimensions and JDeveloper, your typical workflow will probably follow this basic sequence:
In addition to the general workflow outlined here, you may also find it useful to undo a file checkout.
Before you can use Dimensions as your version control system with JDeveloper, you need to perform some initial setup operations. This setup involves connecting to a Dimensions repository, learning how to disconnect if required, and choosing the initial project in JDeveloper.
You connect to a Dimensions repository when you want check out files, synchronize your working copies with the common repository, or check files in before a build. Once you are connected, most file operations in Dimensions are available from the context menu for a file, folder or project.
To create a Dimensions profile:
To connect to a Dimensions repository with an existing profile:
If you are connecting to Dimensions for the first time, you will need to create a profile for this connection. You can have multiple profiles for connecting to different servers and databases, if you use Dimensions for multiple projects.
Disconnecting from a Dimensions repository lets you connect to another repository, if your organization uses more than one repository or more than one version control system. You also need to disconnect from Dimensions if you plan to connect with a different profile.
To disconnect from a Dimensions repository:
As you create new files for your projects and applications, you need to add them to Dimensions control so that they are available to your other team members and to the build system.
To add files to Dimensions control:
If a file no longer applies to the project you are working on, you can remove it from Dimensions control.
To remove a file from Dimensions control:
Setting the current project lets Dimensions know which of your local directories to monitor for changes versus the Dimensions repository. Once you have set the current project, Dimensions will display files with unsaved changes in the Pending Changes list, as well as making the files in that project available in the Application Resources navigator and more.Before you can set a project, you must be connected to Dimensions.
To set the current project:
JDeveloper/mywork), select Use Global Project. If you are working in the default project defined by your Dimensions administrator, select Use Default Project. After initial setup, most of your work in Dimensions will involve files. You will need to add files to (and, occasionally remove files from) the Dimensions repository. You can browse files from the Versioning Navigator, where you can check them out, check them in, and otherwise manipulate them. Additionally, Dimensions lets you view a copy of a file in the repository so you can search for changes from a version of the same file that you are working on.
If you have created a new JDeveloper application, you can add all that application's files to Dimensions in a single operation by using the Import Wizard.
To import files to Dimensions:
JDeveloper uses several overlays on the file navigator icons to represent the state of the associated file in Dimensions, as listed in Table 6-3.
Table 6-3 Dimensions Status Icons
| Icons | Description |
|---|---|
![]() | File not under Dimensions control: The file is not under Dimensions control |
|
| File extracted by multiple users The file has been extracted by others, but is available for checkout |
|
| File extracted by others The file has been extracted by others and is not available for checkout |
|
| File extracted by single user The file has been extracted by a single user, but is available for checkout |
|
| File not extracted The file has not been extracted |
![]() | File not authenticated The user has not logged into the Dimensions server |
|
| File removed from server The local file has been removed from the Dimensions server |
Downloading files from the Dimensions repository to your local working directory is the key to working in Dimensions. You can do this after you have connected to Dimensions. Once you have signed in to the Dimensions server, use the Versioning Navigator to navigate to the content you wish to work with. After you select a folder, Dimensions lets you download the contents of the folder (giving you the option of expanding subfolders) to your local working directory.
Now that you have copied the content from the Dimensions repository to your working directory, you need to set this content as the current project in Dimensions.
To download from the Dimensions repository:
Enter the location of your local work area. Use the Browse button to select from a directory browser.
Select if your project uses substitution variables that you wish to expand when downloading to your work area.
Select if you wish the local file copies to be created with the same timestamps they have in your Dimensions repository. If you leave this unselected, files will be created with timestamps reflecting the date and time you downloaded them.
Select if you wish Dimensions to expand (recurse) directories, checking out all files in all directories of the project.
Select to overwrite any local files in your work area with content from the repository. Any changes you have made to the local files and have not yet checked in will be lost.
Checking out files from the Dimensions repository to your local working directory lets you make changes which will be tracked against the changes of others on your team. To do this, use the Dimensions Web client; your Dimensions administrator will have the URL and any login information you need to access the Dimensions Web client.Once you have signed in to the Dimensions Web client, use the left-hand pane to navigate to the content you wish to work with. The Web client displays this content in the right-hand viewing pane. If you select a folder, Dimensions will check out the contents of the folder (giving you the option of expanding subfolders) to your local working directory.You can control whether Dimensions automatically checks out files when you open a Dimensions-controlled file in JDeveloper. Select the Tools > Preferences > Versioning > Dimensions > General page. The option Automatically Check Out Files lets you specify whether Dimensions is to check out a file from the repository when you edit your local working copy.
To check out content from the Dimensions repository:
JDeveloper/mywork). Select Overwrite to force Dimensions to overwrite any writable file with the same name in your working directory. Otherwise, select Don't overwrite.
You can associate this checkout (and any changes you make as part of this checkout) to a request (a means of tracking build changes, bug fixes, and more) that is maintained by Dimensions. The Dimensions version control system is part of a much larger project-management system with integrated workflow, bug tracking, and more. For details, refer to the on-line help for the Dimensions Web client.
Select this if you wish to check out not only the content you have selected, but also the content of subdirectories inside the selected folder. If you perform local builds for testing and verification, and therefore need access to all the files in the project, you should select this.
Now that you have checked out the content from the Dimensions repository to your working directory, you need to set this content as the current project in Dimensions.
When you have made the required changes and verified them locally, you can check in your changed files.
Undoing a file check out essentially leaves the file in the repository untouched, while removing any record from the repository's database that pertains to who checked out the file and when it was checked out. This not only leaves the file unchanged since the last checkin, it also leaves the file available to be checked out by other team members.Note that undoing a check out will essentially discard any work you've done since checking out the files. Use your judgment as to whether undoing a file checkout is the most effective solution to the situation you find yourself in, and consider whether saving a local copy (outside your local Dimensions directory) will be worthwhile.
To undo a file checkout:
After undoing a check out, you will need to check out the latest content before you can work in Dimensions again.
You may also wish to get a copy of the Dimensions-controlled content on your local working directory.
After making and verifying your changes to the content for which you are responsible, you make your work available to the rest of the team by checking it in to Dimensions. This uploads your work to the Dimensions repository, where it will be available to other team members and to your organization's build process.
To check in files to Dimensions:
The Pending Changes list displays files, folders and other elements that have been created or modified and not yet added to Dimensions. This includes:
Files are added to the Pending Change list when you save a copy locally.
JDeveloper allows you to use the source control features of Rational ClearCase release 4.0 onwards (including ClearCase 2002). JDeveloper works in a seamless manner with ClearCase so that once you have it configured you can add files to source control, and check them in and out from the navigators
The JDeveloper Rational ClearCase extension allows you to use the source control features of Rational ClearCase inside JDeveloper. Once you have JDeveloper configured to work with your ClearCase installation, you can add files to source control, and check them in and out from the navigators.
To work in ClearCase, you have to store your workspaces, projects and files on your ClearCase view; before new projects and files are under ClearCase source control, you have to explicitly add them to ClearCase. Once your files are added to your ClearCase view, you can check them in and out, compare versions, review file histories, and (if necessary) remove files from ClearCase
To use ClearCase with JDeveloper, you must have ClearCase 4.0 or greater client installed on the same machine as JDeveloper.
To configure JDeveloper to use ClearCase:
If you have not chosen (in the preferences) to have connections made automatically, make sure that you have a connection to the ClearCase server, then select Versioning > Connect to ClearCase.
Now that you have configured JDeveloper to work with ClearCase, you can access files and folders that already exist in a mounted ClearCase view. New files and folders must be created in or copied to your ClearCase view.
To add new files to ClearCase, see Section 6.7.2, "How to Add a File to ClearCase".
To work in ClearCase, you have to store your workspaces, projects and files on your ClearCase view, and before new projects and files are under ClearCase source control, you have to explicitly add them to ClearCase. The comment pane in the Add to ClearCase dialog allows you to build up comments for different groups of files. The comments you type apply to the files you have selected. For example, you can select all the files and type a global comment. Next, select a smaller number of files. The first comment is displayed and you can add to it. Then you can select just a single file in this group and add another comment specific to that file.
To add one or more files to ClearCase:
If you want to continue working on the files, leave the Check In box clear. If you check the box, the files will be checked in and you must check them out when you want to work on them.
The source control status of an object is indicated in the Application Navigator by an icon overlay, as below.
Table 6-4 Status icons for ClearCase
| Icon | Description |
|---|---|
|
| The object is checked out and can be modified. |
|
| The object is checked in and must be checked out before it can be modified. |
If the status of an object is changed outside JDeveloper, for example by checking in an object using external source control software, the new status might not immediately be shown in JDeveloper. To ensure that the status indicated in the Application Navigator matches the true status of the object in the source control system, you can perform a manual refresh. To refresh the status of objects in JDeveloper, select Versioning > Refresh States.
You can remove a file from ClearCase if you no longer need it. The files are removed from the current version of the directory which contains them.
To remove a file from ClearCase:
The files are removed from the current version of the directory, and you will no longer be able to work with them.
When you have finished working on a file, you should check it into ClearCase.
To check in files shown in the Application Navigator:
The Check In to ClearCase dialog is displayed listing the files that you selected.
If you want to check in the files even though they are identical to the previous versions in ClearCase, check the Force Check In Where Files Are Identical box. If you do not check this box, the file may remain checked out, depending on how ClearCase handles files of that type. If the file remains checked out, you can use the Undo Checkout command to return the file to its previous checked in state.
Type comments for this checkin into the Comments box or, to use the same comments for the check in that were used for the checkout, check the Use Checkout Comments box.
To check in the listed files, click OK. The files in the list are checked in to ClearCase source control.
To check in files shown in the Checked Out Files window:
To work on a file, it must be checked out from ClearCase.
Files will be checked out automatically when you start to change them, if the Automatically Check Out Files preference is set on the ClearCase preferences page (available by choosing Tools > Preferences and selecting ClearCase). This preference applies to data files, workspace files and project files. For data files, the file is checked out when you begin to edit in the source view. If you check out a file unintentionally, immediately use Versioning > Undo Checkout to revert.
To check out one or more files manually:
If you want to prevent another user from checking out the same files and then checking them in before you do, check the Check Out Reserved To User box.
The files in the list are checked out from ClearCase source control and you can work on them.
Checked out files are shown in the Checked Out Files window. This window opens when files are first checked out. You can open it at other times by selecting Versioning > View Checked Out Files.
If you have checked out a file but not made any changes to it, or if you want to discard the changes you have made, you can undo the last check out of that file.
| Caution: You may lose you work if you use this on a file that you have changed since it was checked out. |
To undo checkout for one or more files:
You may want to see all the files that you have checked out from ClearCase, for example to see which files need to be checked in before performing another action.
To list ClearCase checkouts:
Use these procedures to compare versions of files that are under ClearCase source control. You can compare a file with: its immediate predecessor any of the file's previous revisions any other file on your file system.
You can choose which Compare Viewer to use (JDeveloper or ClearCase), by setting an option on the ClearCase Version Tools preference page under Tools > Preferences.
To compare a file with its immediate predecessor:
If there are no differences, a message is displayed. Otherwise, a Compare Viewer is displayed through which you can find and reconcile the differences.
To compare a file with another revision:
Previous versions of the file are listed in the Compare ClearCase File dialog. Select the version you want to compare the current file with and click OK.
If there are no differences, a message is displayed. Otherwise, a Compare Viewer is displayed through which you can find and reconcile the differences.
To compare a file with a file outside ClearCase source control:
The Select File to Compare With dialog is opened.
Browse to and select the file you want to compare the current file with, and then click Open.
Use this procedure to display the history of a file that is under ClearCase source control.
To display the history:
Use this procedure to display the description of a project or a file that is under ClearCase source control.
To display the description:
The description appears in the Messages Log window.
Oracle JDeveloper's Team System extension allows you to use the source control features of Microsoft Visual Team System inside JDeveloper. Once you have JDeveloper configured to work with Team System, you can add files to source control, and check them in and out from the navigators.
To begin using Team System with JDeveloper, you must first create a workspace using Team System software, and then populate this workspace with content from the Team System server. Files are checked out to the workspace, where they can be worked on. Files newly created within JDeveloper must be added to version control. Changed and new files are made available to other users by checking them in to the Team System server.
Before beginning to use Team System with JDeveloper, there are some initial steps you need to follow:
In practice, Team System (like any version control system) consists of operations that you use at varying times depending on the place in the product lifecycle. For example, if you create a new file, you'll need to add it to Team System control. Other operations you may perform, depending on the stage of development, include:
To set up Team System for use with JDeveloper, follow these steps:
Instructions for doing the above are given in the Team System online help.
Once you have set up Team System for use with Oracle JDeveloper, you are ready to configure JDeveloper to use Team System. In addition to the steps in Section 6.8.1.1, "How to Set Up Team System for Use with JDeveloper," make sure you have already i * Installed the JDeveloper Team System VCS extension (from the Official Oracle Extensions and Updates center).
To configure JDeveloper for use with Team System, carry out the following activities in JDeveloper:
To set JDeveloper preferences for use with Team System:
For more information about the specific preferences, press F1.
To select Team System as the versioning system:
To set the workspace to use with JDeveloper:
To create a JDeveloper project to hold the workspace files:
This opens the Project Content page of the Project Properties dialog.
If your workspace contained Java sources, a dialog is displayed through which you should confirm that you want the sources added to the project content.
To avoid confusion, you may wish to remove non-workspace locations from the Java Content list.
To refresh the workspace folders in JDeveloper:
In addition to the file system operations you are probably familiar with from most version control systems (that is, checking files in and out, adding files to the repository, etc.), Team System lets you specify individual file versions from the server.
JDeveloper lets you get (from the Team System server) a version of a file that is in the Application Navigator. You must previously have used the get command in the Team System client software to populate your workspace with source files.
You can use this procedure to obtain the following versions of files: the latest version; files from a previously saved named changelist; files with a particular date stamp; files from a previously created named label; files from a particular workspace version.
The version obtained from the Team System server will replace the version currently in the Application Navigator.
To get versions of files from the Team System server:
The Get dialog is opened.
For information while using the dialog, press F1.
Use to bring files under Team System source control. The files will be added to the Team System server and made available to other users when you next check in the file.
To add files to Team System Control
The Add dialog is opened.
For information while using the dialog, press F1.
Use to check out files so that you can work on them. The files must already by under Team System source control.
To check out files:
The Check Out dialog is opened.
For information while using the dialog, press F1.
Use this procedure to check the status of a file that is under Team System source control. See also Section 6.8.2.5, "How to Refresh the Status of Files."
To view the status of a file:
The status labels shown are those used by Team System to describe the source control status of the file.
The main statuses are:
The source control status of a file is indicated in the JDeveloper navigators by icon overlays, as below.
Table 6-5 File status icons in Team System
| Icon | Description |
|---|---|
|
| The object is checked in and must be checked out before it can be modified. |
|
| The object is checked out and can be modified. |
|
| The object is not under source control. |
|
| The file has been brought under source control but has not yet been checked in to the Team System server. |
|
| The object has been scheduled for removal from the Team System server the next time it is checked in. |
To refresh the status of files in JDeveloper:
Use to check in a file to the Team System server. A checked in version of a file can be seen and worked on by other users.
To check in files:
The Check In dialog is opened.
For information while using the dialog, press F1.
If there is a conflict between your copy of the file and the one in the Team System server when you attempt to check it in, you will see a message box saying that the operation cannot be completed. To overcome this problem, you must first cancel the check-in operation, then do one of the following:
To revert to a non-conflicting file version:
Use to undo the most recent change to a file.
To undo changes:
The Undo dialog is opened.
The change will be undone when you click OK.
Use this procedure to replace a file with the base version. The base version is the version from which the one you are currently working on originated.
To replace a file with the Team System base revision:
The Replace With Base Version dialog opens.
Use this procedure to open the History Viewer and view the history of files held under Team System control.
To view the history of a file:
For more information while using the History Viewer, press F1.
Use these procedures to compare files that are under Team System control with other versions of the same files, or with other files.
To compare versions of a file:
If there are no differences, a message is displayed. Otherwise the version or versions are shown in the History tool.
To compare a file with another file:
The Select File to Compare With dialog is opened.
The files are shown in the Compare tool.
To compare two files:
The files are shown in the Compare tool.
Shelving lets you save file changes in the Team System server without having to check the files in. As part of the shelving process, you can choose either to continue to work on the changed files or to remove them from view and revert to unchanged versions.
When you later want to make use of the file changes that were shelved, you can unshelve them.
If you decide you no longer want to keep changes that were shelved, you can delete the shelveset that you put them in.
To shelve a set of file changes that have not been checked in:
To shelve a set of file changes that have not been checked in:
The Shelve dialog opens.
For information while completing the dialog, click F1.
The file changes will be shelved when you click OK.
The file icons in the Application Navigator will change to reflect the new file statuses, if any.
To unshelve a set of file changes:
The Unshelve dialog opens.
The file changes will be unshelved when you click OK.
Files deleted since the shelveset was created will be reinstated and the file icons in the Application Navigator will change to reflect the new file statuses.
To delete a shelveset:
The Delete Shelveset dialog opens.
The shelveset will be deleted when you click OK.
Use to delete files from your workspace and from the Team System server.
To delete a file:
The Delete dialog is displayed with the file listed.
On the Outgoing tab of the Pending Changes window (Versioning > Pending Changes), the file will be indicated as ready for deletion: a black diagonal cross is added to the file's icon.
The Check In dialog is opened.
The file is deleted from your workspace and from the Team System server.
The JDeveloper import and export features allow you to create and apply patches from just the changes or revisions between two versions of a file.
You may wish to record the changes between two revisions of a file, then apply those changes to a third file. You do this by creating a patch and then applying it.
To create a patch:
This generates a patch comprising the differences between a controlled revision of a file and a revision of the file held locally.
The History view lists all the revisions of the file. In the lower portion of the History view, the left pane shows the contents of a local revision, and the right pane shows the contents of the controlled revision.
The Select Patch Context dialog may open. For help while using this dialog, press F1.The Generate Patch dialog opens. Complete the dialog as required. For help while using the dialog, press F1.
You may wish to record the changes between two revisions of a file, then apply those changes to a third file. You do this by creating a patch and then applying it.
To apply a patch:
The resource can be an application, a project, or a source file.
If you chose to apply a patch to a project, the Select Patch Context dialog opens, through which you should specify whether you are applying a project file (.jpr) patch, or whether you are updating the contents of a project.
The Apply Patch dialog is opened.
Web-based Distributed Authoring and Versioning, or WebDAV, is an extension to HTTP which allows users to edit and manage files on WebDAV-enabled servers in a collaborative fashion. WebDAV connections in JDeveloper allow you to view files hosted on WebDAV servers in the same way as you would files on the local file system. Files located on WebDAV servers, accessed using WebDAV connections in JDeveloper, can be viewed in the same way as files stored on the local file system or LAN.
As WebDAV clients provide access using HTTP, files can be accessed through firewalls (configured to support WebDAV extensions) that would otherwise prevent FTP file transfer. The JDeveloper read-only implementation of WebDAV supports the current WebDAV 1.0 standard, which does not support versioning. As a WebDAV client, JDeveloper can connect directly to any Oracle Internet File System, allowing you to view WebDAV files from the database.
You must run a WebDAV server to use JDeveloper as a WebDAV client. The WebDAV server must be one of the following:
| Note: If the Apache server is version 1.x, themod_dav module must also be installed. |
| Note: If you access the Internet through a firewall, it must be configured to process the extended HTTP commands used by WebDAV.If your web server is configured to redirect URLs to a different server (for example, if you are using |
If you'd like to find out more about WebDAV, see the following Web sites:
http://www.webdav.org http://httpd.apache.org/docs-2.1/mod/mod_dav.html WebDAV connections created in JDeveloper allow you to view files and folders as part of a JDeveloper project.
| Note: The same URL cannot be used for more than one WebDAV connection on the same JDeveloper client. |
To create a WebDAV connection in JDeveloper:
For more information while using the dialog, press F1.
If you access the internet via a proxy server you need to configure JDeveloper before accessing WebDAV-enabled servers on the internet.
To access a WebDAV-enabled server via a proxy server:
WebDAV connections are shown in the Application Resources section of the Application Navigator, listed under the Connections node.
Existing WebDAV connections can be modified.
To modify a WebDAV connection:
For help while using the dialog, press F1.
WebDAV connections are shown in the Application Resources section of the Application Navigator, listed under the Connections node.
To ensure that the folders and files accurately reflect the current contents of the WebDAV server, you can manually refresh the display of a WebDAV connection.
| Note: All folders and files listed for the WebDAV connection are refreshed. The properties of the folders and files, and their contents, are refreshed. |
To refresh the entire contents of a WebDAV connection:
WebDAV connections are shown in the Application Resources section of the Application Navigator, listed under the Connections node.
Deleting a WebDAV connection from JDeveloper does not affect any of the files or folders on the WebDAV server itself.
To delete a WebDAV connection:
You can subsequently recreate the connection, in which case the files and folders that were part of it will be shown beneath it again.
This chapter provides an overview of the building, running, and debugging features in JDeveloper. These features are explained in greater detail in the subsequent chapters of this guide.
This chapter includes the following sections:
After you have completed the design time aspects of your application, you are ready to build, run, and debug your project.
JDeveloper provides three ways to build projects: using the Make and Rebuild, Apache Ant, or Maven.
When you run your project, the Run Manager manages the processes that are run, debugged, or profiled. The Run Manager window is automatically displayed when two or more such processes are active at the same time,. When a process has completed, it is automatically removed from the Run Manager.
The debugger enables you to investigate your code, and identify and fix problem areas. Two types of debugging are available: local and remote debugging.
You can build your application using one of these ways:
Additionally, you can also clean your application and generate Javadoc for it.
The Make and Rebuild commands execute standard operations for compiling projects in JDeveloper.
Make operations compile source files that have changed since they were last compiled, or have dependencies that have changed. Rebuild operations, in contrast, compile source files unconditionally. You can invoke make on individual source files, on working sets, or on containers such as packages, projects, and workspaces.
Apache Ant is a build tool similar in functionality to the Unix make utility. Ant uses XML formatted buildfiles to both describe and control the process used to build an application and its components. Ant supports cross-platform compilation and is easily extensible. Apache Ant is a product of the Apache Software Foundation. For more information, see the website http://ant.apache.org/index.html.
Apache Maven is a software project management and comprehension tool. Maven can manage a project's build, reporting and documentation from a central piece of information, the project object model (POM). You can build the project using its POM and a set of plugins that are shared by all projects using Maven, providing a uniform build system.Maven can be extended by plugins to use a number of other development tools for reporting or the build process. For more information about Maven, see http://maven.apache.org/index.html.
For more information on Building Applications and projects, see Section 18.6, "Building Java Projects".
JDeveloper offers several techniques to monitor and control the way applications are run. The Run Manager enables you to manage all running processes.
The Run Manager keeps track of processes that are run, debugged, or profiled. When two or more such processes are active at the same time, the Run Manager window is automatically displayed. When a process has completed, it is automatically removed from the Run Manager.
For more information about the Run Manager, see Section 19.2, "Understanding the Run Manager".
JDeveloper provides you with a comprehensive debugger to assess and repair your code. Debugging can be of two types -- local and remote.
A local debugging session is started by setting breakpoints in source files, and then starting the debugger. When debugging an application such as a servlet in JDeveloper, you have complete control over the execution flow and can view and modify values of variables. You can also investigate application performance by monitoring class instance counts and memory usage. JDeveloper will follow calls from your application into other source files, or generate stub classes for source files that are not available
Remote debugging requires two JDeveloper processes: a debugger and a debuggee which may reside on a different platform. Once the debuggee process is launched and the debugger process is attached to it, remote debugging is similar to local debugging.
The Debugger provides a number of special-purpose debugging windows that enable you to efficiently identify the problematic areas in your code.
You can control what type of information is displayed in each of the debugger windows. To see what options are available in each window such as which columns to display, right-click in a window and choose Preferences from the context menu. Or, you can choose Tools > Preferences from the main menu and expand the Debugger node to display a preferences page for each debugger window. You can also save the debug information as text or HTML output file.
For more information on using the debugger, see Section 19.7, "Using the Debugger Windows".
Several technologies use debugging facilities provided by JDeveloper. The following table lists these technologies and the corresponding link to their debugging documentation.
Table 7-1 Technologies that Use Debugging
| Technology | Documentation Link |
|---|---|
| ADF Components | Section 19.6.3, "How to Debug ADF Components" |
| Java Servlet | Section 11.5.7, "How to Debug a Servlet" |
| JSP Pages | Section 11.4.2, "How to Debug and Deploy JSPs" |
| Java Programs | Section 19.6, "About the Debugger" |
| JavaScript | Section 19.6.21, "How to Debug a Javascript Program" |
| Web Services | Section 16.11.2, "How to Debug Web Services" |
| Integrated WebLogic Server | Section 9.2.3.2, "How to Run and Debug with an Integrated Application Server" |
| PL/SQL Programs and Java Stored Procedures | Section 29.3.3, "Debugging PL/SQL and Java Stored Procedures Prerequisites" |
| Extensions | Oracle Fusion Middleware Developer's Guide for Oracle JDeveloper Extensions |
This chapter describes the auditing and profiling capabilities of Oracle JDeveloper.
This chapter includes the following sections:
Use the auditing and profiling tools that JDeveloper provides to analyze the health and performance of your applications. These tools help you improve the quality of your code. You can use the JDeveloper auditing feature to analyze Java code for conformance to programming standards.
Use the profiler to gather statistics on your program that enable you to more easily diagnose performance issues, such as bottlenecks by identifying methods consuming more time, which method is called the most, how memory is used, and what kind of objects are being created.
Auditing is the static analysis of code for adherence to rules and metrics that define programming standards. Auditing finds defects that make code difficult to improve and maintain. The JDeveloper auditing tools help you find and fix such defects. Code can be audited even when it is not compilable or executable.
You can create and customize profiles, choose the rules to be used, and set parameters for individual rules. Browse the audit rules and metrics to learn more about them.
An audit report displays rule violations and measurements organized as a tree. A row of the tree corresponds to either a construct or a violation, and includes any measured values for the construct or theoretical violation. A construct is a method, class, file, project, or workspace. For more information on auditing tools and steps to audit your code, see Section 18.9, "Optimizing Application Performance".
The HTTP Analyzer allows you to monitor HTTP traffic, for example, to:
The HTTP Analyzer acts as a proxy between code in JDeveloper and the HTTP resource that the code is communicating with, and helps you to debug your application in terms of the HTTP traffic sent and received.
When you run the HTTP Analyzer, there are a number of windows that provide information for you.
When you open the HTTP Analyzer from the Tools menu, the HTTP Analyzer log window appears, illustrated in Figure 8-1. By default its position is at the bottom center of JDeveloper, alongside the other log windows.
When HTTP Analyzer runs, it outputs request/response messages to the HTTP Analyzer log window. You can group and reorder the messages:
Table 8-1 HTTP Analyzer Log Window Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Analyzer Preferences | Click to open the HTTP Analyzer Preferences dialog where you can specify a new listener port, or change the default proxy. An alternative way to open this dialog is to choose Tools > Preferences, and then navigate to the HTTP Analyzer page. For more information, see |
![]() | Create New Request | Click to open the HTTP Analyzer Test window, where you enter payload details, and edit and resend messages. |
![]() | Start HTTP Analyzer | Click to start the HTTP Analyzer running. The monitor runs in the background, and only stops when you click Stop or exit JDeveloper. If you have more than one listener defined clicking this button starts them all. To start just one listener, click the down arrow and select the listener to start. |
![]() | Stop HTTP Analyzer | Click to stop the HTTP Analyzer running. If you have more than one listener running, clicking this button stops them all. To stop just one listener click the down arrow and select the listener to stop. |
![]() | Send Request | Click to resend a request when you have changed the content of a request. The changed request is sent and you can see any changes in the response that is returned. |
![]() | Open WS-I log file | Click to open the Select WS-I Log File to Upload dialog, where you can navigate to an existing WS-I log file. For more information, see Section 16.13, "Monitoring and Analyzing Web Services." |
![]() | Save Packet Data | Click to save the contents of the HTTP Analyzer Log Window to a file. |
![]() | WS-I Analyze | Click to invoke the WS-I Analyze wizard which allows you to examine a web service at packet level. For more information, see Section 16.13, "Monitoring and Analyzing Web Services." |
![]() | Select All | Click to select all the entries in the HTTP Analyzer Log Window. |
![]() | Deselect All | Click to deselect all the entries in the HTTP Analyzer. |
![]() | Clear Selected History (Delete) | Click to clear the entries in the HTTP Analyzer. |
An empty HTTP Analyzer test window appears when you click the Create New Request button in the HTTP Analyzer Log window. A test window showing details of the request/response opens when you choose Test Web Service from the context menu of a web service container in the Application Navigator, or when you double-click a line in the HTTP Analyzer Log Window, illustrated in Figure 8-2. By default, its position is in the center of JDeveloper, in the same place that the source editor appears.
The test window allows you examine the headers and parameters of a message. You can test the service by entering a parameter that is appropriate and clicking Send Request.
The tabs along the bottom of the test window allow you choose how you see the content of the message. You can choose to see the message as:
When you open the HTTP Analyzer from the Tools menu, the HTTP Analyzer Instances window appears. By default, its position is at the bottom center of JDeveloper, as a tab alongside the HTTP Analyzer log window. This window provides information about the instances of the HTTP Analyzer that are currently running, or that were running and have been stopped. The instance is identified by the host and port, and any rules are identified. You can start and stop the instance from this window.
Figure 8-3 HTTP Analyzer Instances Window

You create a new instance in the HTTP Analyzer dialog, which opens when you click the Create New Request button.
Table 8-2 HTTP Analyzer Instances Window Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Analyzer Preferences | Click to open the HTTP Analyzer dialog where you can specify a new listener port, or change the default proxy. |
![]() | Create New Request | Click to open a new instance of the HTTP Analyzer Test window, where you enter payload details, and edit and resend messages. |
![]() | Start HTTP Analyzer | Click to start the HTTP Analyzer running. The monitor runs in the background, and only stops when you click Stop or exit JDeveloper. If you have more than one listener defined clicking this button starts them all. To start just one listener, click the down arrow and select the listener to start. |
![]() | Stop HTTP Analyzer | Click to stop the HTTP Analyzer running. If you have more than one listener running, clicking this button stops them all. To stop just one listener click the down arrow and select the listener to stop. |
When you start the HTTP Analyzer, all Java processes and application server activity with JDeveloper will send their traffic via the HTTP Analyzer, using the proxy settings in the HTTP Analyzer dialog, which opens when you click the Start HTTP Analyzer button in the Instance or Log window, or from the HTTP Analyzer page of the Preferences dialog. By default, the HTTP Analyzer uses a single proxy on an analyzer instance (the default is 8099), but you can add additional proxies of your own if you need to.
Each analyzer instance can have a set of rules to determine behavior, for example, to redirect requests to a different host/URL, or to emulate a web service.
By default, the HTTP Analyzer uses a single proxy on an analyzer instance (the default is 8099), but you can add additional proxies of your own if you need to.
To set HTTP Analyzer preferences:
For more information at any time, press F1 or click Help from the HTTP Analyzer preferences dialog.
You can have more than one instance of HTTP Analyzer running. Each will use a different host and port combination, and you can see a summary of them in the HTTP Analyzer Instances window.
To add an additional HTTP Analyzer Instance:
For more information at any time, press F1 or click Help from the HTTP Analyzer preferences dialog.
You can use external web browsers to route messages through the HTTP Analyzer so that you can see the traffic between the web browser and client. This section describes how you can use a profile in Firefox so that when you start the HTTP Analyzer and run an HTML or JSP or JSF page from within JDeveloper, a new instance of Firefox using the Debugger profile is started.
| Note: The steps below use the commandfirefox, which is correct for Linux. If you are using Windows, use firefox.exe. |
To configure a Firefox profile for the HTTP Analyzer:
firefox -no-remote -P Debugging. JDeveloper underlines this in red, and when you close the dialog you will see a Command Line Validation Error warning which you can safely ignore. Click OK. When you start the HTTP Analyzer and run an HTML or JSP or JSF page from within JDeveloper, a new instance of Firefox using the Debugger profile is started.
You can use the HTTP Analyzer with secured services or applications, for example, web services secured by policies. JDeveloper comes with a set of preconfigured credentials, HTTPS Credential, which is always present. You cannot delete or edit HTTPS Credential, but you can copy it to create a new credential of the same type.
Once you have configured the credentials, you can choose which to use in the HTTP Analyzer Test window.
HTTPS encrypts an HTTP message prior to transmission and decrypts it upon arrival. It uses a public key certificate signed by a trusted certificate authority. When the integrated application server is first started, it generates a DemoIdentity that is unique to your machine, and the key in it is used to set up the HTTPS channel.
The client keystore identity is used for configuring HTTPS. The server keystore identity is used when the HTTP Analyzer is acting as a server; it is not used when connecting to a remote server.
For more information about keystores and keystore providers, see Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server. When the default credential HTTPS Credential is selected, you need to specify the keystores that JDeveloper and the HTTP Analyzer should use when handling HTTPS traffic. Two keystores are required to run the HTTP Analyzer:
The client keystore is only required when mutual authentication is required.
Username token is a way of carrying basic authentication information. You supply a username/password to provide authentication.
X509 is a PKI standard for single sign-on, where certificates are used to provide identity, and to sign and encrypt messages. You enter details of an X509 certificate. When you supply a valid keystore and the password for the keystore, the client key aliases are populated.
If JDeveloper has any problems finding and opening the keystore, error messages will be displayed.
A Secure Token Service (STS) is a web service that issues and manages security tokens over HTTPS. You enter the Security Token Server provider URL and optionally a policy URL.
| Note: The client truststore must contain the server public key, otherwise when the HTTP Analyzer requests the SAML token it will fail. |
To configure the HTTP Analyzer to use different HTTPS values:
You can use the HTTP Analyzer to test web services that are secured using policies.
| Note: You cannot use the HTTP Analyzer with JAX-RPC web services that are secured with WebLogic 9.x policies. WebLogic 9.x policies are deprecated for JAX-RPC. |
The HTTP Analyzer supports:
You choose the credentials to use in the HTTP Analyzer Test window.
To add authentication information to the HTTP Analyzer:
The HTTP Analyzer allows you to view the content of request and response HTTP messages.
To monitor HTTP packets:
Each request and response packet is listed in the HTTP Analyzer Log window, and detailed in the HTTP Analyzer Test Window.
If you are using the HTTP Analyzer to examine how a web service developed in JDeveloper works, the HTTP Analyzer starts automatically when you choose Test Web Service from the context menu of the web service in the Application Navigator.
You can use the HTTP Analyzer when you are debugging Web pages, such as HTML, JSP, or JSF pages. This allows you to directly examine the traffic that is sent back and forth to the browse.
To debug Web pages using the HTTP Analyzer:
Each request and response packet is listed in the HTTP Analyzer Log window, and detailed in the HTTP Analyzer Test Window.
You can edit the contents of a HTTP request and resend it. You can then examine the response to see whether the changes you expect have occurred.
To send a request:
To edit and resend a request:
Alternatively, you can open a new test window by double-clicking a line in the HTTP Analyzer Log window.
You can set rules so that the HTTP Analyzer runs using behavior determined by those rules. You can set more than one rule in an HTTP Analyzer instance. If a service's URL matches a rule, the rule is applied. If not, the next rule in the list is checked. If the service does not match any of the rules the client returns an error. For this reason, you should always use a Pass Through rule with a blank filter (which just passes the request through) as the last rule in a list to catch any messages not caught by the preceding rules.
The types of rule available are:
The Pass Through simply passes a request on to the service if the URL filter matches. When you first open the Rule Settings dialog, two Pass Through Rules are defined:
http://localhost:631 to ignore print service requests. The Forward rule is used to intercept all URLs matched by the filter and it forwards the request on to a single URL.
The URL Substitution rule allows you to re-host services by replacing parts of URL ranges. For example, you can replace the machine name when moving between the integrated application server and Oracle WebLogic Server.
The tape rule allows you to run the HTTP Analyzer in simulator mode, where a standard WS-I log file is the input to the rule. When you set up a tape rule, there are powerful options that you can use:
An example of using a tape rule would be to test a web service client developed to run against an external web service.
To test a web service client developed to run against an external web service:
You can edit the WS-I file to change the values returned to the client.
Ensure that it is above the blank Pass Through rule in the list of rules.
When you rerun the client, it runs against the entries in the WS-I file instead of against the external web service.
There are other options that allow you to:
| Note: Tape Rules will not work with SOAP messages that use credentials or headers with expiry dates in them. |
You can set rules so that the HTTP Analyzer runs using behavior determined by those rules. Each analyzer instance can have a set of rules to determine behavior, for example, to redirect requests to a different host/URL, or to emulate a web service.
To set rules for an HTTP Analyzer instance:
Alternatively, the HTT Analyzer automatically opens when you choose Test Web Service from the context menu of a web service container in the Application Navigator.
Alternatively, choose Tools > Preferences, and then navigate to the HTTP Analyzer page.
This section contains information about using the HTTP Analyzer with web services developed in JDeveloper. In general, you can use HTTP Analyzer to examine the content of web services in the same way as using it to examine any packets across HTTP.
| Note: You cannot use the HTTP Analyzer to test JAX-RPC web services that have WebLogic Server 9.x policies attached. WebLogic 9.x policies have been deprecated in JAX-RPC. |
JDeveloper allows you to test web services using the HTTP Analyzer to examine the network traffic of a proxy connecting to a web service developed in JDeveloper.
To test a web service:
The response from the deployed web service is displayed in the Response pane of the HTTP Analyzer Test window.
You can examine the contents of the HTTP headers of the request and response packets to see the SOAP structure, the HTTP content, the Hex content or the raw message contents by choosing the appropriate tab at the bottom of the HTTP Analyzer Test window.
You can use the HTTP Analyzer to interact with RESTful web services. Representational State Transfer (REST) describes any simple interface that transmits data over a standardized interface (such as HTTP) without an additional messaging layer, such as SOAP. REST provides a set of design rules for creating stateless services that are viewed as resources, or sources of specific information, and can be identified by their unique URIs. A client accesses the resource using the URI, a standardized fixed set of methods, and a representation of the resource is returned. The client is said to transfer state with each new resource representation.
When using the HTTP protocol to access RESTful resources, the resource identifier is the URL of the resource and the standard operation to be performed on that resource is one of the HTTP methods: GET, PUT, DELETE, POST, or HEAD.
The HTTP Analyzer has support for Hypermedia as the Engine of Application State (HATEOAS), and so you can examine and test RESTful web services using the HTTP Analyzer.
Before you can create RESTful web services in JDeveloper, you need to download and add to your project the Jersey JAX-RS Reference Implementation (RI).
A Web Application Description Language (WADL) is an XML file created by Jersey that provides a description of the resources in the servlet. For more information about WADL, see https://wadl.dev.java.net/.
An outline of testing a RESTful service using WADL is given here, with more detailed steps in the procedure below. Not all RESTful services work this way. The HTTP Analyzer reads a WADL created by Jersey for the RESTful web service, and you examine the WADL in the HTTP Analyzer Test window. From the WADL, you can open an instance of the HTTP Analyzer Test window directly from a method, and test the method by entering a parameter and posting it to the service. The HTTP Analyzer redirects the response to a new URL which it displays, and when you click on it another instance of the HTTP Analyzer Test window opens with the response. Once you have finished, you use the WADL to locate the new resource that the HTTP Analyzer created to test the service and delete it.
Example 8-1 provides an example of a WADL document which uses POST, GET and DELETE.
Example 8-1 Simple Example of WADL
To test a REST web service
To test a REST web service requires that you:
To examine the RESTful service:
If necessary, use the left arrow to maximize the width of the pane to see the code more clearly.
To test the RESTful service:
201 Created HTTP status code along with the location of the URL that contains the response. | Note: When you click on the WADL, the correct content-type and accept headers will be generated. |
To work with the resource:
The HTTP Analyzer will pass unsecured WebSockets requests via a proxy.
The content of the request response stream will be available in the HTTP Analyzer after you close and reopen the message. The WebSockets messages are those with a response code of 101.
This section contains information to help resolve problems that you may have when running the HTTP Analyzer.
If you have an application waiting for a response, do not start or stop the HTTP Analyzer. Terminate the application before starting or stopping the HTTP Analyzer.
When you use the HTTP Analyzer, you may need to change the proxy settings in JDeveloper. For example:
If you run the HTTP Analyzer, and see the message
you probably need to add localhost|127.0.0.1 to the proxy exclusion list.
To set the HTTP proxy server and edit the exception list:
| as the separator. In order for Java to use localhost as the proxy ~localhost must be in the Exceptions list, even if it is the only entry.
The Profiler monitors and logs a running program's use of processor and memory resources. It gathers statistics that enables you to more easily diagnose the performance issues and correct the inefficiencies in your code.
JDeveloper offers two kinds of profilers: The CPU Profiler and the Memory Profiler, for local as well as remote profiling.
For more information on the profiler, including steps to profile your application and project, see Section 18.10, "Profiling a Project".
This chapter describes how to run and debug applications using the JDeveloper integrated application server, and how to deploy applications to a target application server, for example to Oracle WebLogic Server or to a third-party server.
This chapter includes the following sections:
Deployment is the process of packaging application files as an archive file and transferring it to a target application server. You can use JDeveloper to deploy Java or Java EE applications directly to the application server (such as Oracle WebLogic Server or IBM WebSphere), or indirectly to an archive file as the deployment target, and then install this archive file to the target server. For application development, you can also use JDeveloper to run an application in the integrated application server. JDeveloper supports deploying to server clusters, but you cannot use JDeveloper to deploy to individual Managed Servers that are members of a cluster.
If you are using Oracle® Fusion Middleware extensions, refer to the appropriate developer's guide for deployment information specific to the product. For example:
You can deploy applications in the following ways:
| Note: Normally, you use JDeveloper to deploy applications for development and testing purposes. If you are deploying applications for production purposes, you can use Enterprise Manager or scripts to deploy to production-level application servers.For more information about deployment to later-stage testing or production environments, see the Oracle Fusion Middleware Java EE Developer's Guide for Oracle Application Development Framework. |
Figure 9-1 shows the flow diagram that describes the overall deployment process. Note that preparing the target application server for deployment is outside the scope of this guide; you should refer to the Oracle Fusion Middleware Java EE Developer's Guide for Oracle Application Development Framework for deployment to Oracle WebLogic Server, or to the appropriate documentation for a third-party application server.
Java and Java EE applications are based on standardized, modular components and can be deployed to the following application servers:
Oracle WebLogic Server provides a complete set of services for those modules and handles many details of application behavior automatically, without requiring programming.
For information about which versions of Oracle WebLogic Server, Tomcat, WebSphere, or JBoss are compatible, see the JDeveloper Certification Information at http://www.oracle.com/technetwork/developer-tools/jdev/documentation/index.html.
You can use JDeveloper to:
You can run and debug applications using Integrated WebLogic Server and then deploy to a standalone WebLogic Server or to a third party server.
You can deploy applications directly to the standalone application server by creating a connection to the server and choosing the name of that server as the deployment target.
You can deploy applications indirectly by choosing an EAR file as the deployment target. The archive file can subsequently be installed on a target application server.
Deployment can be an iterative process where refinements to the application, or corrections to issues in the deployed application, require redeployment to either the test deployment environment, archive file, or application server. The process of deploying an application from JDeveloper can involve a number of processes.
JDeveloper is bundled with an integrated application server called Integrated WebLogic Server and a default connection called IntegratedWebLogicServer is defined for it. The integrated application server is a Java EE runtime for services using deployment optimized for the iterative code development cycle. You can use it for running and testing JDeveloper applications and projects as Java EE applications and modules within a Java EE container, as well as for post-run services such as launching a browser or tester. JDeveloper has a default connection to the integrated application server and does not require any deployment profiles or descriptors. In most cases, deploying to the integrated application server is a one-click operation, for example, running a web service by choosing Run from the right-mouse menu of the web service in the Application Navigator, or running an application by choosing Run from the JDeveloper main menu.
You debug the application using the features described in Chapter 7, "Building, Running and Debugging Applications."
Typically, for deployment to standalone application servers, you test and develop your application by running it in the integrated application server. You can then test the application further to more closely simulate the production environment by deploying it to standalone Oracle WebLogic Server in development mode or to a third-party application server.
In general, you use JDeveloper to prepare the application or project for deployment by:
You must already have an installed application server. For Oracle WebLogic Server, you can use the Oracle 11g Installer or the Oracle Fusion Middleware 11g Application Developer Installer to install one. For other applications servers, follow the instructions in the applications server documentation to obtain and install the server.
If necessary, you must prepare the application server by creating a global JDBC data source for applications that require a connection to a data source.
After the application and application server have been prepared, you can:
A Java EE archive file contains a Java EE module or application. A module consists of one or more JDeveloper projects of a common component type, which have been configured for deployment. An application is comprised of one or more modules. An archive also contains a deployment descriptor, which is an XML file that describes the configuration of the module or application to the server, and is specific to the type of server. A deployment descriptor can be server specific or generic for Java EE servers.
JAR, EJB JAR, and WAR files each contain a module consisting of one or more components. An Enterprise Archive (EAR file) contains an application consisting of one or more modules.
When you create a web (servlet, JSP, JSF, and ADF Faces) or EJB application and deploy it via an application server connection, JDeveloper packages it as a WAR or EJB JAR, which you can optionally wrap in an EAR file. If your application consists of components of differing types, the components will be packaged into multiple modules, which you can deploy independently or assembled as an EAR file.
Deployment profiles are application or project properties that govern the deployment of a project or application. A deployment profile names the source files, deployment descriptors, and other auxiliary files that will be packaged, the type and name of the archive file to be created, dependency information, platform-specific instructions, and other information.
Deployment descriptors define the content and organization of the deployed applications. Deployment descriptor files that are required by an application depend on the technologies the application uses and on its target application server.
You can control how an application is deployed using a deployment plan which allows you to make configuration adjustments in the application deployment descriptors web.xml, weblogic.xml, application.xml, and weblogic-application.xml.
Deployment plans are controlled using a descriptor called plan.xml. Only Weblogic deployment descriptor configuration can be customized using plan.xml. The primary use case for deployment customization is to modify Weblogic specific application configuration for different servers being deployed without requiring modification of the base Weblogic descriptor. For more information, see the section on Deployment Plans in Oracle Fusion Middleware Deploying Applications to Oracle WebLogic Server.
If you are using the Java edition of JDeveloper, which contains only the core Java and XML features, the only deployment actions you can perform are:
JDeveloper Java Edition provides the facility to package applications into a JAR file. The deployment dialog in Java Edition allows for only limited configuration of standard JAR options such as specifying JAR name, file groupings, or dependencies on other deployment profiles. Any application that requires more configuration than this must be deployed from the Studio edition of JDeveloper.
JDeveloper is installed with Integrated WebLogic Server, an integrated application server which you can use to test and develop your application. For most development purposes, the integrated application server will suffice. When your application is ready to be tested, you can select the run target and then choose the Run command from the main menu.
| Note: The first time you start the integrated application server by running or debugging a project, file, or web service, a dialog is displayed where you enter a password for the administrator ID on the default domain. When you click OK, the default domain is created. You only need to do this once. |
When you run the application target, JDeveloper detects the type of Java EE module to deploy based on artifacts in the projects and application workspace. JDeveloper then creates an in-memory deployment profile for deploying the application to the integrated application server. JDeveloper copies project and application workspace files to an "exploded EAR" directory structure. This file structure closely resembles the EAR file structure that you would have if you were to deploy the application to an EAR file. JDeveloper then follows the standard deployment procedures to register and deploy the "exploded EAR" files into the integrated application server. The "exploded EAR" strategy reduces the performance overhead of packaging and unpackaging an actual EAR file.
In summary, when you select the run target and run the application in the integrated application server, JDeveloper:
| Note: When you run the application in the integrated application server, JDeveloper ignores the deployment profiles that have been created for the application. |
The application will run in the base domain in the integrated application server. The base domain has the same configuration as a base domain in a standalone Oracle WebLogic Server instance. In other words, this base domain is the same as if you had used the Oracle® Fusion Middleware Configuration Wizard to create a base domain with the default options in a standalone Oracle WebLogic Server instance.
JDeveloper extends this base domain with the necessary domain extension templates, based on the JDeveloper technology extensions. For example, if you have installed JDeveloper Studio, JDeveloper will automatically configure the integrated application server environment with the ADF runtime template (JRF Fusion Middleware runtime domain extension template).
You can explicitly create additional default domains for the integrated application server which you can use to run and test your applications in addition to using the default domain. Open the Application Server Navigator, right-click IntegratedWebLogicServer and choose Create Default Domain.
The output messages generated when running or debugging an application in the integrated application server are displayed in a log window which has a title of either Running: IntegratedWebLogicServer or Debugging: IntegratedWebLogicServer.
The content of the Integrated WebLogic Server Log Window includes:
The generated log files are located at jdeveloper-user-home/DefaultDomain/server/DefaultServer/logs.
You can configure diagnostic logging parameters in the logging.xml file. Transient loggers can only be added while the server is running in debug mode.
You can control the level of information sent to the log file using the -verbose element in the jsp-descriptor and logging elements of weblogic.xml. For more information, see the weblogic.xml descriptor elements information in Oracle Fusion Middleware Developing Web Applications, Servlets, and JSPs for Oracle WebLogic Server
Deployment to the integrated application server uses default deployment profiles which rely on project metadata for the default mappings. Default contributors to the profiles are based on project dependencies, and the rules governing dependencies are:
WEB-INF/classes of the resulting WAR. Merging implies that you can only have one copy of any particular URI, because it can only exist once within WEB-INF/classes.
WEB-INF/lib of the resulting WAR. WEB-INF/web.xml is recognized as a web project and a default WAR profile is created for it. WEB-INF/lib of the WAR). lib of the EAR). classes directory) of Project B is merged with the build output of Project A and deployed in the root directory of the EJB JAR. The definition of an integrated application server controls the interaction of the instance with JDeveloper and your computer system.
JDeveloper is bundled with an integrated application server called Integrated WebLogic Server, and a default instance called IntegratedWebLogicServer is defined for it. All applications are bound by default to IntegratedWebLogicServer.
You can modify the properties of the integrated application server that an application is bound to.
| Note: WebLogic Server domains used as integrated application servers must be collocated on the same host as the JDeveloper process. |
To modify the properties of the integrated application server that an application is bound to:
You can create a new integrated application server instances.
To define an integrated server connection:
By default, the integrated application server is automatically started when you run or debug an EJB, servlet, HTML, web service, or JSP project. Alternatively, you can start the integrated application server by clicking Start Server Instance or Debug Server Instance from the Run menu.
After it has been started, an integrated application server does not terminate automatically when you terminate a running Java EE application. Therefore, you can select an object, such as a JSP or a servlet in the Application Navigator, and choose an option from the Run menu.
You can run or debug a working set, which is a group of files created by applying a named filter to a project, by choosing the Use Current Working Set (Java JEE Only) option from the Run menu.
Once this is enabled, when you select Run or Debug from the context menu of the source editor or from a node in the Application Navigator, it is the current working set that is run or debugged.
Only a single integrated application server can be run at any given time. Thus, if you attempt to start another instance of the server, JDeveloper will shut down the previous instance and restart the instance in order to perform the requested task on the selected icon in the Navigator. After an integrated application server is started, multiple applications can run on it independently of each other. If an application is running, rerunning the application redeploys the up-to-date version of the application.
To run in an integrated application server, an application must be bound to a server instance. JDeveloper is supplied with a WebLogic Server domain, and a default server instance named DefaultServer is defined for it. The unique integrated application server connection defined for this integrated application server is called IntegratedWebLogicServer, and has the Domain Home defined as the system directory $SYSTEM_ROOT/DefaultDomain. All applications are bound by default to IntegratedWebLogicServer.
If you have not explicitly created the integrated application server's default domain, it will automatically be created with default settings when you start the server by running or debugging an application.
Alternatively, you can explicitly create the default domain from the Application Server Navigator.
If necessary, you can delete the existing default domain so that you can create it again to use new values.
To explicitly create the integrated application server's default domain:
IntegratedWebLogicServer and choose Create Default Domain. The Configure Default Domain dialog opens, where you can accept the defaults, or explicitly set other values, such as choosing a different listen address. For more information at any time, click Help or press F1 from the Configure Default Domain dialog. When you install extensions to JDeveloper you may have to update the integrated application server's default domain.
To update the integrated application server's default domain:
IntegratedWebLogicServer and choose Update Default Domain. If you have already created the default domain, but you need to use specific settings you can delete the existing default domain and create it again.
To delete the integrated application server's default domain:
After the server has started, click the Run Manager tab in the navigator, or select Run Manager from the View menu, to display the integrated application server process.
| Note: You can run more than one application simultaneously on a server in run mode, however you can only debug one application at a time in debug mode. To return JDeveloper back into non-debug editing mode, the integrated application server must be shut down. |
You can test an application by running it in the integrated application server. You can also set breakpoints and then run the application with the integrated application server in debug mode. For more information about running and debugging, see Chapter 7, "Building, Running and Debugging Applications."
To run an application in the integrated application server:
The first time you start the integrated application server by running or debugging an application, a dialog is displayed where you enter a password for the default user weblogic on the default domain. When you click OK, the default domain is created. You only need to do this once.
Application-level and Global Data Sources
If you are deploying to an integrated application server, you can use application level data sources or global data sources.
For both one-click deployment to an integrated application, JDeveloper ensures that your web application web.xml, or EJB application ejb-jar.xml, contains the necessary <resource-ref> entry to identify an application resource name. The name is jdbc/connection-nameDS, where connection-name is the name of the application resources connection.
The application looks up this data source using the application-specific resource JNDI namespace of java:comp/env/jdbc/connection-nameDS, and it finds this resource because web.xml contains the <resource-ref> entry for jdbc/connection-nameDS.
To use application level data sources in one-click deployment to Integrated WebLogic Server, select Auto Generate JDBC Connections When Running Application in JDeveloper on the WebLogic page of the Application Properties dialog (available from the Application menu). This:
connection-name-jdbc.xml in the /META-INF directory of the application's EAR file <module> entry in the weblogic-application.xml file in META-INF that references this JDBC module If the application uses more than one application resources database connection, then a connection-name-jdbc.xml file will be created for each, and there will be a similar number of <module> entries in the weblogic-application.xml file.
To use global data sources in one-click deployment to Integrated WebLogic Server, deselect Auto Generate JDBC Connections When Running Application in JDeveloper on the WebLogic page of the Application Properties dialog (available from the Application menu), and:
By default, the integrated application server is automatically started when you run or debug an EJB, servlet, or JSP project. Therefore, you can select an object, such as a JSP or a servlet in the Navigator, and choose an option from the Run menu.
| Note: The first time you start the integrated application server by running or debugging a project, file, or web service, a dialog is displayed where you enter a password for the administrator ID on the default domain. When you click OK, the default domain is created. You only need to do this once. |
Only a single integrated application server can be run at any given time. Thus, if you attempt to start another instance of the server, JDeveloper will shut down the previous instance and restart the instance in order to perform the requested task on the selected icon in the Navigator.
After the server has started, click the Run Manager tab in the Navigator to display the integrated application server process. You can open the Run Manager by choosing View > Run Manager from the main menu.
To start an integrated application server:
Alternatively, choose Run > Start Server Instance from the main menu.
To start an integrated application server in debug mode:
Alternatively, choose Run > Debug Server Instance from the main menu.
If you are running a large application on the integrated application server, you can cancel it before it has finished deploying.
To cancel a running deployment:
After an integrated application server has started, the integrated application server process appears in the Run Manager. For more information, see Section 19.2, "Understanding the Run Manager."
You can open the Run Manager by choosing View > Run Manager from the main menu.
| Note: Applications deployed on an integrated application server are automatically undeployed whenever the integrated application server is terminated. |
The default behavior is to undeploy all the applications, but you can change the behavior.
To shutdown the running integrated application server:
Do one of the following:
To force shutdown of Integrated WebLogic Server:
You can configure startup and shutdown behavior for integrated application server connections.
To configure the startup and shutdown behavior for an integrated application server:
If you are viewing the properties of the default integrated application server, you can only change settings on the Configuration, Shutdown and Launch Settings tabs in the dialog. Otherwise you can edit everything except the connection name.
The integrated application server is an implementation of Oracle WebLogic Server and as such you can connect to the server's Administration Console.
| Note: To log in to the Administration Console, you must have the integrated application server running from JDeveloper, for example:
|
To launch and log in to the integrated application server Administration Console:
http://host:port/console. For example, if the default configuration is used, the browser uses http://localhost:7001/console.
The integrated application server is an implementation of Oracle WebLogic Server, so for more information about the integrated application server Administration Console refer to the Administration Console Online Help, which is available from the WebLogic Server online documentation in your JDeveloper installation, or from the Administration Console.
Before you deploy an application to a standalone application server, you must perform prerequisite tasks within JDeveloper to prepare the application for deployment.
Figure 9-2 show the process flow to prepare the application for deployment. After the application has been prepared and the application server has been prepared, you can proceed to deploy the application.
You can deploy applications to the application server via JDeveloper application server connections.
Before you begin:
Exceptions is populated with values from your machine. If you are deploying to a Oracle WebLogic Server configured to use SSL you should add *.company_name.com to the exception list.
To create a connection to an application server:
You can:
On the Usage page of the wizard ensure that Standalone Server is selected, and click Next.
For WebLogic:
.jar,.war,.ear) will be deployed. .jar,.war,.ear) will be deployed. If you don't specify a port, the port number defaults to 7001.
.jar,.war,.ear) will be deployed. Specifying an SSL port is optional. It is required only if you want to ensure a secure connection for deployment.
If you don't specify an SSL port, the port number defaults to 7002.
For JBoss:
.jar,.war,.ear) are. | Note: JMX configuration is optional and is not required for connecting to the JBoss Application Server. JMX is only needed for deploying SOA applications.You must use the Oracle JMX RMI connector ( |
For Tomcat:
.war files. For WebSphere:
.jar, .war, .ear) are deployed. If no name is entered, the name defaults to localhost 8879 machineNode01, where machine is the name of the machine the node resides on machineNode01Cell, where machine is the name of the machine the node resides on. ORACLE_HOME/oracle_common/common/bin directory, which are not the correct version. The default location is websphere-home/bin/wsadmin.sh for Unix/Linux and websphere-home/bin/wsadmin.bat for Windows. | Note: JMX configuration is optional and is not required for connecting to the WebSphere Application Server. JMX is only needed for deploying SOA applications. |
JDeveloper performs several types of connections tests. The JSR-88 test must pass for the application to be deployable. If the test fails, return to the previous pages of the wizard to fix the configuration.
How to Launch Oracle WebLogic Server Administration Console
You can launch and connect to the Oracle WebLogic Server Administration Console from the Application Server Navigator.
| Note: To log in to the console, the server must be started. |
http://host:port/console. For example, if the default configuration is used, the browser uses http://localhost:7001/console.
weblogic and password you entered when the default domain was created. For more information about the WebLogic Server Administration Console, refer to the Administration Console Online Help, which is available from the WebLogic Server online documentation in your JDeveloper installation, or from the Administration Console.
A deployment profile defines the way the application is packaged into the archive that will be deployed to the target environment. The deployment profile:
Deployment to application servers uses deployment profiles which rely on project metadata for the default mappings. Default contributors to the profiles are based on project dependencies, although you can customize the deployment profiles to change them.
The rules governing dependencies are:
Merging implies that you can only have one copy of any particular URI, because it can only exist once within WEB-INF/classes.
Application level deployment profiles are:
Project level Java EE deployment profiles are:
Deployment profiles can be created in various ways:
web.xml file, you can right-click it and choose Create WAR Deployment Profile. application.xml, you can right-click it and choose Create EAR Deployment Profile. To modify an existing deployment profile
To activate a deployment profile:
The project and any projects on which it depends will be compiled and packaged.
You may find that the application you created already contains the deployment profile you need, for example if you create a web-based project you should already have a default WAR deployment profile which includes the dependent model projects it requires.
To create a deployment profile:
For a project level deployment profile, in the Application Navigator, right-click the project that you want to deploy and choose New.
If you don't see Deployment Profiles in the Categories tree, click the All Features tab.
Deployment profiles are available from the Application Properties dialog, for application level deployment profiles, or from the Project Properties dialog, for project level deployment profiles, and you can edit them or delete them.
After you have created a deployment profile, you can view and change its properties.
To edit or delete a deployment profile:
For a project level deployment profile, choose Application > Project Properties to open the Project Properties dialog.
Configuring is the process of assembling an archive file from its component files. Configuring is specified in the File Groups branch of deployment profile properties dialogs.
The File Groups branch consists of a list of file groups, each specifying some components. The packaged archive will be the union of all the file groups. The order of the file groups resolves name collisions: if two files have the same name, the one from the file group higher in the list is included, and the one from the lower file group is omitted.
A newly created deployment profile will include one or more predefined file groups. You can add, delete, and edit file groups.
File groups are defined by a set of contributors pruned by a set of filters. Contributors are source files, JAR files, and directories that are selected for inclusion. Filters are rules that are applied to the contributors or contributor's component subdirectories and files to identify the set and files that will be packaged. There are three kinds of file groups:
Deployment dependencies between the components of an application are stated in their project's deployment profiles. In a project's deployment profile, name the profiles for the projects that are immediately upstream. When a deployment profile is activated for deployment, its dependencies will first be deployed.
Set deployment profile dependencies on the deployment profile's Profile Dependencies page. Only deployment profiles in the current workspace are listed and available for selection. Click the Help button for more information. The various profile dependencies you can select include:
When deploying a profile contained in a project that has project-to-profile dependencies on other profiles, at deploy-time the profile incorporates the dependencies specified in the project. For example, if Project1.jpr contains Servlet1.java and depends on ejb1.jar, and project2.jpr contains MySessionEJB and ejb1.jar, then deploying the first project will result in an EAR file containing both webapp1.war and ejb1.jar.
When creating profile dependencies between JAR, WAR, and EJB JAR modules that share common JAR files, you can use the META-INF/MANIFEST.MF Class-Path attribute to link JAR files together at deploy-time. From the deployment profile properties JAR options page, select Include Manifest File (META-INF/MANIFEST.MF). Doing so causes a single shared copy of any common JARs to be included in the EAR file.
Dependency projects can have dependencies of their own, but cyclical dependencies should be avoided. When JDeveloper encounters a circular dependency it will attempt to deploy anyway, but a warning will be displayed in the log window.
Deployment descriptors are server configuration files that define the configuration of an application for deployment and that are deployed with the Java EE application as needed. The deployment descriptors that a project requires depend on the technologies the project uses and on the type of the target application server. Deployment descriptors are XML files that can be created and edited as source files, but for most descriptor types, JDeveloper provides dialogs or an overview editor that you can use to view and set properties. If you cannot edit these files declaratively, JDeveloper opens the XML file in the source editor for you to edit its contents.
In addition to the standard Java EE deployment descriptors (for example, application.xml and web.xml), you can also have deployment descriptors that are specific to your target application server. For example, if you are deploying to Oracle WebLogic Server, you can also have weblogic.xml, weblogic-application.xml, and weblogic-ejb-jar.xml.
The essential descriptors are created by the wizards that create deployment profiles. Add other descriptors only if you wish to override default behavior. In some cases descriptors will be created and included in archive files as they are deployed.
Deployment descriptors can also be created from the New Gallery. Deployment descriptors are placed in a META-INF subfolder of a project's Application Sources or WEB-INF subfolder of a project's Web Contents folders.
Each Java EE standard deployment descriptor is extended by a corresponding Oracle WebLogic Server-specific descriptor. Table 9-1 provides a description of these files and illustrates how they relate to one another.
Table 9-1 Deployment Descriptors
| Java EE Standard Descriptors | Oracle WebLogic Server Proprietary Descriptors |
|---|---|
|
Describes the EJB modules and other resources used by a Java EE application client deployed as an archive. |
The file format is defined in For more information, see the chapter about client application deployment descriptor elements in Oracle Fusion Middleware Programming Stand-alone Clients for Oracle WebLogic Server. |
|
Specifies the components of a Java EE application, such as EJB and web modules, and can specify additional configuration for the application as well. This descriptor must be included in the /META-INF directory of the application's EAR file. |
The file format is defined in For more information, see Oracle Fusion Middleware Programming XML for Oracle WebLogic Server. |
|
Defines the specific structural characteristics and dependencies of the Enterprise JavaBeans within a JAR, and provides instructions for the EJB container about how the beans expect to interact with the container. |
The format of this file is defined in For more information, see Oracle Fusion Middleware Programming Enterprise JavaBeans for Oracle WebLogic Server.
For EJB 3.0 modules. The format of this file is defined in For more information, see Oracle Fusion Middleware Programming Enterprise JavaBeans, Version 3.0 for Oracle WebLogic Server.
For EJB 2.1 modules. The format of this file is defined in |
|
Contains information on implementation code, configuration properties and security settings for a resource adapter packaged within a RAR file. |
The format of this file is defined in For more information, see tOracle Fusion Middleware Programming Resource Adapters for Oracle WebLogic Server. |
|
Specifies and configures a set of Java EE web components, including static pages, servlets, and JSP pages. It also specifies and configures other components, such as EJBs, that the web components might call. The web components might together form an independent web application and be deployed in a standalone WAR file. |
The format of this file is defined by For more information, see Oracle Fusion Middleware Programming XML for Oracle WebLogic Server. |
| None. |
Defines data sources to be used in the deployed application. The format of this file is defined by For more information, see Oracle Fusion Middleware Configuring and Managing JDBC for Oracle WebLogic Server.
The format of this file is defined by Contains a list of name/value pairs, and a description of the various deployment descriptors in an application. It allows administrators to override values in deployment descriptors. For more information, see Oracle Fusion Middleware Deploying Applications to Oracle WebLogic Server.
The format of this file is defined by Used in the WebLogic Server Administration Console to create or modify diagnostic monitors in the diagnostic application module. For more information, see Oracle Fusion Middleware Configuring and Using the Diagnostics Framework for Oracle WebLogic Server.
The format of this file is defined by Used to configure JMS drivers in the Oracle WebLogic Server. For more information, see Oracle Fusion Middleware Programming JMS for Oracle WebLogic Server.
The format of this file is defined by For more information, see Oracle Fusion Middleware WebLogic Web Services Reference for Oracle WebLogic Server. |
Dependent libraries are any library needed for a module to compile and run. In the Libraries and Classpath page of the Project Properties dialog for the project containing the library, dependent libraries are shown as available for export.
In an application, dependent libraries can be in the following projects:
The example below illustrates project dependencies (arrows on the left) and profile dependencies (arrows on the right).
Figure 9-3 Dependencies Between Projects and Deployment Profiles

Project dependencies are recursive at deployment time, even though they are not at compile time, which is why the libraries from JavaProject are considered dependent libraries. WebProfile, which represents a web module, has the following dependent libraries:
EjbDepLib (a library from a project dependency to WebProject) EjbDep.jar (a library jar from a project dependency to WebProject) JavaDepLib (a library from a recursive project dependency to JavaProject) JavaDep.jar (a library jar from a recursive project dependency to JavaProject) SampleLib (a library from a profile dependency) Sample.jar (a library jar from a profile dependency) OtherLib (a library from a recursive profile dependency) Other.jar (a library jar from a recursive profile dependency) Dependent Libraries can either be resolved or unresolved. Dependent libraries are considered unresolved until they are included in an archive and placed on the classpath, thereby making the library content available to classes that need to reference it.
For example, a WAR profile resolves libraries by selecting those libraries in a library file group contributor where the target output directory is WEB-INF\lib. This ensures that the WAR archive created will include those libraries in the archive's WEB-INF\lib directory and thereby including the library content on the WAR archive's classpath.
When a library is not resolved by a deployment profile, this profile will expose the unresolved library in the application hierarchy so that it can be resolved at a higher level. Consider the situation where libraries contained in an EJB project remain unresolved from the EJB profile's perspective. This information will be exposed so that an EAR profile can ensure that those libraries are resolved at the EAR level (in the EAR profile's library file group).
In the illustration above, WebProject has a project dependency to JavaProject, and JavaProject includes a library called JavaDepLib. You can define a web application which creates a WAR deployment profile on WebProject. You can then resolve JavaDepLib in the web module by ensuring that this library is selected in the WEB-INF\lib library file group of the WAR deployment profile.
When libraries are included in an EAR archive in a directory other than the standard \lib or APP-INF\lib, JDeveloper automatically inserts the required manifest entries into the modules that refer to those libraries.
JDeveloper automatically creates many of the required deployment descriptors for you. If they are not present, or if you need to create additional descriptors, you can explicitly create them.
Before you begin:
Check to see whether JDeveloper has already generated deployment descriptors.
To create a deployment descriptor:
If you can't find the item you want, make sure that you chose the correct project, and then choose the All Features tab or use the Search field to find the descriptor. If the item is not enabled, check to make sure that the project does not already have a descriptor of that type. A project is allowed only one instance of a descriptor.
JDeveloper starts the Create Deployment Descriptor wizard and then opens the file in the overview or source editor, depending on the type of deployment descriptor you choose.
| Note: For EAR files, do not create more than one of any type of deployment descriptor per application or workspace. Only the application resources descriptors or descriptors generated at the EAR level will be used by the runtime. If multiple projects in an application have the same deployment descriptor, the one belonging to the launched project will supersede the others. This restriction applies toapplication.xml, weblogic-jdbc.xml, jazn-data.xml, and weblogic.xml. The best place to create an application-level descriptor is in the Descriptors node of the Application Resources panel in the Application Navigator. This ensures that the application is created with the correct descriptors. |
To inspect or change deployment descriptor properties:
The file will open in an overview editor specific to that descriptor type, or in an XML editor window.
After you have created a deployment descriptor, you can change its properties by using JDeveloper dialogs or by editing the file in the source editor. The deployment descriptor is an XML file (for example, application.xml) typically located under the Application Sources node.
To view or change deployment descriptor properties:
If the overview editor is not available, JDeveloper opens the file in the source editor.
You can set global deployment options in the Deployment page of the Preferences dialog.
To configure the deployment preferences:
| Note: Set application-specific and project-specific deployment profile options via the application properties or project properties. The Application Properties and Project Properties dialogs are available from the Application menu |
When deploying in JDeveloper, you can directly access the target application server connection in order to pass command line options. For example, you can specify the client JAR which contains the necessary stubs and skeletons on the client side to support RMI-IIOP deployment. These options would overwrite or bypass the server's default settings.
To pass options to target application server connections when deploying:
For instructions click Help.
This section describes the tasks you may have to perform for the application to deploy successfully to an application server.
When you create applications in JDeveloper You can deploy the packaged application to Oracle WebLogic Server through an application server connection. A packaged application will contain a deployment profile that names the files to be deployed, describes their organization, and specifies the target server. The target Oracle WebLogic Server instance must be installed locally or mapped to a network drive.
To configure an application for deployment to Oracle WebLogic Server:
weblogic-ejb-jar.xml, and choose Open. weblogic-ejb-jar.xml and any other EJBs that are already deployed to Oracle WebLogic Server. weblogic.xml with appropriate EJB references. A Java EE Client module is packaged as a client JAR file which contains one or more Java application components and a client deployment descriptor file named application-client.xml. After you have created the deployment profile and the deployment descriptor file, you can deploy the client JAR to the application server.
To package a client application for deployment:
A profile may have already been created for your project. If you wish to deploy to multiple targets, create a separate profile for each.
application-client.xml deployment descriptor file, if not already present in your project. Normally, this file is created with the application client.
A standalone applet is packaged as a web archive (WAR) file which contains the applet, the Applet HTML file, as well as the standard Java EE web deployment descriptor, web.xml and possibly target-specific deployment descriptors, as well. After you have created the deployment profile and the appropriate deployment descriptor files, you can deploy the application to an application server, or as an archive file.
To configure a web application for deployment:
A profile may have already been created for your project. If you wish to deploy to multiple targets, create a separate profile for each.
web.xml deployment descriptor to your project, if it is not already present. Normally, this file is created with the WAR file deployment profile.
| Note: If you encounter problems when deploying a Swing applet (JApplet), for example, the errorClass not found is displayed, this may indicate that JDeveloper cannot locate the Swing libraries. Your clients may need to use Sun's Java SE browser plugin or bundle the Swing libraries for JVMs version 1.1 with your applet. Deployed applet files must reside in a separate location from any other web application files you have deployed. |
To avoid passwords being present in plain text in deployed files, JDeveloper uses password indirection, which means that passwords for the data sources must be set on the server before the application will run correctly.
You do this using global data sources, which are set up in the Oracle WebLogic Server Administration Console using the Data Sources link under JDBC.
JDeveloper ensures that your web application web.xml, or EJB application ejb-jar.xml, contains the necessary <resource-ref> entry to identify an application resource name. The name is jdbc/connection-nameDS, where connection-name is the name of the application resources connection.
The application looks up this data source using the application-specific resource JNDI namespace of java:comp/env/jdbc/connection-nameDS, and it finds this resource because web.xml contains the <resource-ref> entry for jdbc/connection-nameDS.
An important control for the files that are generated is the Auto Generate and Synchronize weblogic-jdbc.xml Descriptors During Deployment field on the WebLogic page of the Application Properties dialog.
When the Auto Generate field is selected, JDeveloper does the following:
application-name-jdbc.xml file for each connection in the application resources, and sets the indirect password attribute Upon deployment, JDeveloper determines the JDBC connection password from the username in application-name-jdbc.xml, and populates the JDBC connection password using an Mbean.
weblogic-application.xml is updated to add each application-name-jdbc.xml as a module. web.xml (if it exists) has a resource reference to each JDBC JNDI name. How to Create a Global Data Source on Oracle WebLogic Server
You create a global data source on Oracle WebLogic Server Administration Console.
To set up a global data source:
The name can be anything.
The JNDI name must be of the form jdbc/connection-nameDS. For example, if the application has a connection name connection1, the JNDI name is jdbc/connection1DS.
Oracle and that the driver is Oracle's Driver (Thin) for Service Connections;Version 9.0.1,9.2.0,10,11. The database name is the Oracle SID.
The host name is the name of the machine the database is on.
The default port is 1521.
hr/hr. Deploying to an EAR File to Run on Oracle WebLogic Server
To deploy an application to an EAR file to run on Oracle WebLogic Server, you can:
If you are deploying using ojdeploy:
-nodatasources switch, in which case you can set up passwords on Oracle WebLogic Server by either: -nodatasources switch, you can only set up passwords using application level credential mapping. There may be specific tasks that you have to perform so that your application will run on a third party server.
Deploying to Tomcat:
tools.jar library in the Tomcat classpath, located in jdeveloper_install/jdk/lib. This file must be the same version of the JDK being used to run Tomcat. Otherwise, you may encounter problems when running applications in Tomcat. tomcat_install/webapps/subdirectory. Set this option in the General page of the WAR File deployment profile. conf/server.xml file: See Tomcat system administration documentation for more information.
Because Tomcat does not release tags after pooling, subsequent uses of the same tag with incompatible attributes defined will cause this error.
To avoid the error, you must disable tag pooling in Tomcat:
tomcat_home/conf/web.xml in a text editor. Change the value of <param-value> to false
Deploying to WebSphere
WebSphere deployment on Windows does not work when the directory containing the JDeveloper generated EAR contains spaces.
You can use deployment plans to override deployment values. One reason you might want to do this is to change settings so that an application that has finished testing can be run in a production environment without having to change the deployment profiles.
When an EAR, WAR, or EJB JAR archive configured to use a deployment plan is deployed, both the archive and the deployment plan are sent to the application server. You can use multiple deployment plans in an application.
For more information, see the section about deployment plans in the chapter about configuring applications for production deployment in Oracle Fusion Middleware Deploying Applications to Oracle WebLogic Server.
The following is an example of a deployment plan for an EAR called application.ear. Note that the module-name element must contain the name of the deployment profile that it is associated with.
Example 9-1 Example of a Deployment Plan
When an EAR, WAR, or EJB JAR archive configured to use a deployment plan is deployed, both the archive and the deployment plan are sent to the application server. You can use multiple deployment plans in an application.
You can create a deployment plan from the New Gallery and edit it in the XML editor.
Once created, a deployment plan can be associated with an EAR, WAR, or EJB JAR archive.
Alternatively, you can generate a deployment plan in Oracle WebLogic Server, then use it in JDeveloper.
To create a deployment plan:
If this is the first deployment descriptor you are creating in the application, you can choose Finish to create a deployment plan with the default name of plan.xml.
If you already have a deployment plan called plan.xml in the application, Navigate to the Select Name page and enter a new name for the deployment plan, then click Finish. The deployment plan will be created and added to the project, and it will be opened in an XML editor window.
Deployment plans enable you to export an application's configuration for deployment to multiple WebLogic Server environments.
You can create a deployment plan from scratch in JDeveloper.
Alternatively, you can generate a deployment plan which you can then add to your application in JDeveloper and edit it to suit your purposes, described in this topic. There are two ways to do this:
To generate a deployment plan using WebLogic Server Administration Console:
The WebLogic Server Administration Console automatically generates (or updates) a valid deployment plan for an application when you interactively change deployment properties for an application that you have installed to the domain. You can use the generated deployment plan to configure the application in subsequent deployments, or you can generate new versions of the deployment plan by repeatedly editing and saving deployment properties.
To use the weblogic.PlanGenerator command-line tool to generate a deployment plan:
install/wlserver_10.3/server/bin/ and run either setWLSEnv.sh or setWLSEnv.cmd script, to add the WebLogic Server classes to the CLASSPATH environment variable on your machine, and ensure that the correct JDK binaries are available in your PATH. java weblogic.PlanGenerator -plan plan.xml application-name.ear -all. The switch -all specifies that the deployment plan is generated containing elements for all possible attributes in your EAR file. If you remove this switch, the generated deployment plan will only contain elements for the existing attributes in your descriptor files.
JDeveloper supports deployment of applications containing a variety of technologies to a variety of application servers. This section provides instructions for deploying an application to an executable JAR file on your file system. If you wish to deploy an application containing Java EE technologies, or you wish to deploy to the integrated application server, Oracle WebLogic Server, or another supported application server, be sure to verify that you have performed the necessary configuration and preparation steps as outlined in Section 9.3, "Connecting and Deploying Java EE Applications to Application Servers."
Applications can be deployed indirectly by choosing an archive file as the deployment target. The archive file can subsequently be installed on a target Java EE application server
JDeveloper has various deployment modes for different applications. However, you may want to quickly and simply deploy your application as a JAR file to your file system.
| Note: Before deploying an executable JAR file you must first create a deployment profile. |
To deploy a simple archive in JDeveloper:
You can make your simple archive or Java EE Client Module into an executable JAR file that you can launch with the java command.
| Note: Before deploying an executable JAR file you must first create a deployment profile. |
To deploy an executable JAR file:
where myapp represents your JAR file name.
Applications can be deployed as OSGi bundles which can then be deployed to an OSGi container.
JDeveloper has various deployment modes for different applications. However, you may want to quickly and simply deploy your application as a JAR file to your file system.
| Note: Before deploying an OSGi bundle you must first create a deployment profile. For more information, see Section 9.3.2, "How to Create and Edit Deployment Profiles." |
To deploy an OSGi bundle in JDeveloper:
You can use JDeveloper to deploy Java EE applications directly to the standalone application server or create an archive file and use other tools to deploy to the application server.
The Java EE Enterprise Archive (EAR) deployment profile provides you with centralized control over the process of application assembly. This assembling task involves selecting which already-configured Java EE deployment profiles to include with the EAR file. You can mix and match any combination of configured WAR, EJB JAR, and/or client JAR profiles in projects within the same workspace. When you deploy an application to an application server connection, JDeveloper assembles a minimal EAR file which includes the profile combinations and deploys it with the EAR file to the target application server.
To deploy an application as a Java EE Enterprise Archive (EAR File):
To reopen the EAR deployment profile later to make changes, right-click the application in the Application Navigator toolbar and choose Application Properties, then select the name of the profile in the Deployment section of the Application Properties dialog and click Edit.
Stored in a Resource Adapter Archive (RAR) file, a resource adapter may be deployed on any Java EE server, much like the EAR file of a Java EE application. A RAR file may be contained in an EAR file or it may exist as a separate file
To deploy a resource adapter archive in JDeveloper:
| Note: To reopen a project deployment profile later to make changes, right-click the project in the Application Navigator and choose Project Properties, then select the name of the profile in the Deployment section of the Project Properties dialog and click Edit. |
The EAR profile supports Resource Adapter Archive files (RAR or .rar) in a JDeveloper project. A RAR file is typically provided by an Enterprise Intelligence Server (EIS) vendor, similar to a JDBC driver. Java EE developers may need to package a RAR file into their EAR file if their Java EE application makes use of the EIS services supported by the RAR. JDeveloper does not directly support RAR file creation, but RAR files can be assembled using the File Groups feature of a JAR file deployment profile.
The ra.xml file is the deployment descriptor for the RAR file for the J2EE Connector Architecture (JCA). For more information, see
To add a RAR to an EAR deployment profile:
At deploy-time, the EAR file's application.xml contains a <connector> element which is automatically added to the RAR file.
Metadata Archive (MAR) profiles are application level deployment profiles which are used to package seeded customizations or place base metadata in the MDS repository. In a MAR profile, selections can only be done at the package level, not at the file level.
There are two uses for a MAR profile
To deploy a MAR profile in an EAR:
Help from within the Deploy profile dialog. The Deploy to MAR option creates a metadata archive file, which is a convenient option that can be used to verify the MAR contents. The created metadata file should have the same MAR contents as the Export to Deployed Application option.
Alternatively, to add the MAR profile to an existing EAR profile, open the EAR profile.
To export MAR contents to MDS repository and deploy it to a deployed application in a remote server:
The Deploy to MAR option creates a metadata archive file, which is a convenient option that can be used to verify the MAR contents. The created metadata file should have the same MAR contents as the Export to Deployed Application option.
You can deploy web application components including applets as a WAR or EAR file to the target application server.
To deploy an applet as a WAR file:
| Note: The deployed applet files must reside in a separate location from any other web application files you have deployed. |
You can test the deployed web application by running it in a browser. For more information, see Section 9.7, "Testing the Application and Verifying Deployment."
If you encounter problems when deploying a Swing applet (JApplet), for example, the error "Class not found" is displayed, this may indicate that JDeveloper cannot locate the Swing libraries. You may need to force your clients to use Sun's Java SE browser plugin or bundle the Swing libraries for JVMs version 1.1 with your applet.
Shared Java EE libraries provides an easy way to share one or more different types of Java EE modules among multiple Enterprise Applications. You can deploy shared libraries as JAR files to the application server.
To deploy create and deploy a shared library archive:
For successful deployment, the Administration Server for the WebLogic Server domain has to be up as it is handling the deployment process. When you deploy to a server that is down, the deployment log window messages indicate that the server is currently down but the application will be installed when it is brought back up. The log messages will be similar to:
One situation that can occur is that deployment appears to succeed, but as the server is brought back up the deployment cannot successfully terminate, for example, because some validation that is part of the deployment process was not performed, or because a library that needs to be present for deployment to be successful is missing. In these cases, when the server is brought back up and deployment resumes, it fails.
You can only deploy an application once to a server that is down. If you attempt to redeploy the same application to the same down server a second time, an error is displayed.
After you have deployed your application to Oracle WebLogic Server, you can migrate it from one Oracle WebLogic Server to another.
You may need to perform some of the same steps you did for a first time deployment.
In general, to migrate an application to another application server, you would:
After you deploy the application, you can test it from Oracle WebLogic Server.
The deployment log window displays the context root URLs for any Web applications deployed. You can access a deployed web application by entering the application URL in a browser. The URL of the deployed web application appears in the deployment log window, for example:
You can copy the URL and paste it into a browser to test the deployed web application.
Depending on your browser proxy settings, you may need to specify the full domain name of the host machine. If the servlet engine and the browser used to view a deployed application are on the same machine, you may use localhost for the host name.
Applications or modules can be deployed from JDeveloper without starting the JDeveloper IDE.
Before deploying from the command line, you need to run JDeveloper at least once to create a deployment profile for either the application by choosing the Deployment page of the Application Properties dialog or the Project Properties dialog, both of which are available from the Application menu.
Deployment profiles are stored as part of either the application or project properties.
Applications or modules can be deployed from JDeveloper without actually starting the JDeveloper IDE itself. Deploying from the command line, using OJDeploy, is especially useful where you need to deploy existing projects or applications using a batch file or other script.
OJDeploy can run a deployment locally in-process, or submit to a background server, OJServer, using the -ojserver option.
Example 9-2 Using ojdeploy to Deploy from the Command Line
Table 9-2 Arguments That Can be Used With ojdeploy
| Argument | Description |
|---|---|
|
| Name of the profile to deploy. |
|
| Full path to the JDeveloper application file ( |
|
| Name of the JDeveloper project within the |
|
| Full path to a build file for batch deploy. |
|
| Print XML Schema for the build file. |
| Note: Deployment profiles can be classified into two broad categories, those that are defined at the application (workspace) level, and those defined at the project level. To deploy an application profile, OJDeploy takes the application location, and the name of the profile. To deploy a project profile it takes an additional-project argument. |
Table 9-3 Options Available to Use with ojdeploy
| Option | Description |
|---|---|
|
| The listen address for OJServer. Defaults to |
|
| Interpret path for application relative to a base directory. The built-in macro |
|
| Deletes all files from the project output directory before compiling. Deployment will stop for that profile, if a file or directory could not be deleted. |
|
| Allows for additional macros to be defined on the command-line. This can also be done in an XML build file using the |
| -failonwarning | Stop deployment on warnings. |
| -forcerewrite | Ensures output file is rewritten even if the contents have not changed in this run of OJDeploy. |
| -nocompile | Prevents the build system from being invoked. This is useful if an application or project just needs to be packaged, and not compiled at this time. |
| -nodatasources | For Java EE applications, this prevents the |
| -nodependents | Dependent profiles are not deployed. |
| -ojserver | Runs the deployment job on an OJServer. All paths referenced by the other options should be accessible on the server. |
| -outputfile | Specifies an alternate location for any JAR files created from the profile. The default is within a |
| -statuslogfile | Full path to an output file for status summary. No macros allowed. The |
| -stdout, -stderr | Lets these streams be redirected to a file for each profile and project. You can use macros in the name or path of the files. |
| -timeout | Specify the number of seconds after which deployment of a single profile should be aborted. |
| -updatewebxmlejbrefs | Update EJB references in |
Table 9-4 Macros Available to Use with ojdeploy
| Macro | Description |
|---|---|
|
| Name of the application (without the |
|
| Directory of the application |
|
| Name of the project (without the |
|
| Directory of the |
|
| Name of the profile being deployed. |
|
| Default deploy directory for the profile. |
|
| Override the current OJDeploy directory using this parameter. You can also override the current OJDeploy directory using the basedir attribute in the build script. |
| Note: The project.name and project.dir macros are only available when a project-level profile is being deployed. |
Examples
Deploy a project-level profile:
ojdeploy -profile webapp1 -workspace /usr/jdoe/Application1/Application1.jws -project Project1 ojdeploy -profile webapp1 -workspace Application1/Application1.jws -basedir /usr/jdoe -project Project1 Deploy an application-level profile:
ojdeploy -profile earprofile1 -workspace /usr/jdoe/Application1/Application1.jws Deploy all profiles from all projects of an application:
jdeploy -workspace /usr/jdoe/Application1/Application1.jws -project \* -profile \* Build in batch mode from a ojbuild file:
ojdeploy -buildfile /usr/jdoe/ojbuild.xml Build using ojbuild file, pass into, or override default variables in, the build file:
ojdeploy -buildfile /usr/jdoe/ojbuild.xml -define myhome=/usr/jdoe,mytmp=/tmp ojdeploy -buildfile /usr/jdoe/ojbuild.xml -basedir /usr/jdoe Build using ojbuild file, set or override parameters in the default section:
ojdeploy -buildfile /usr/jdoe/ojbuild.xml -nocompile ojdeploy -buildfile /usr/jdoe/ojbuild.xml -outputfile '${workspace.dir}/${profile.name}.jar' ojdeploy -buildfile /usr/jdoe/ojbuild.xml -define mydir=/tmp -outputfile '${mydir}/${workspace.name}-${profile.name}' More examples:
ojdeploy -workspace Application1/Application1.jws,Application2/Application2.jws -basedir /home/jdoe -profile app* ojdeploy -buildfile /usr/jdoe/ojbuild.xml -define outdir=/tmp,rel=11.1.1 -outputfile '${outdir}/built/${workspace.name}/${rel}/${profile.name}.jar' ojdeploy -workspace Application1/Application1.jws -basedir /home/jdoe -nocompile -outputfile '${base.dir}/${workspace.name}-${profile.name}' ojdeploy -workspace /usr/jdoe/Application1.jws -project * -profile * -stdout /home/jdoe/stdout/${project.name}.log ojdeploy -buildfile /usr/jdoe/ojbuild.xml -ojserver To pass in macro values or override the ones defined in a build script, use the -define option to supply a new value:
This will add the mycustomdir variable to the <defaults> section of the build script, or replace it if it already is defined with the value '/tmp'.
To pass in parameter values or override the ones defined in a build script, use the appropriate parameter option:
This will add the -nocompile and -nodatasources parameters to the default section of the build file.
Command-line deployment supports deployment of multiple applications in a single invocation. If more complex control is required, OJDeploy can take an XML build script and process it, running all deploy tasks found in it. Macros and wild cards can be used both in command-line and batch mode. Macros can be strung together or nested.
Each profile to be deployed is qualified by an application and a project. In addition each profile's output can be directed to a different output file/location. Further to this, the calling script assumes no knowledge of the projects within a workspace, only deploying all or a subset of them matching a criteria. The command-line syntax for specifying such inputs and criteria can quickly become cumbersome and inflexible.
A build file can be passed to OJDeploy. The build file will contain multiple <deploy> tasks, along with a shared <defaults> section which allows for setting up an environment. Each deploy-task specifies the type of deployment (the set mentioned before) and customizes any defaults as required. Each task also allows wild cards as applicable within parameter arguments that apply to the scope of that task. A pre-processor will parse the build file and pass it to OJDeploy, expanding wild cards and substituting variables as necessary.
The build file approach has the following advantages over the command-line syntax:
c:\temp\${profile.name} where the macro ${profile.name} is added automatically. A sample build file is shown below. To invoke all of these deploy actions, the command-line would be ojdeploy ojdeploy-build.xml. The file is processed from top to bottom.
Project and profile names can be specified as "*" or "name*" or "name1,name2,name3,..." or any combination of these. Workspace names need to be enumerated, so "*" is not allowed in workspace names, but workspace names can be specified as "workspace1" or "workspace1,workspace2,workspace3".
For example:
An example of using wild cards with an application:
The following built-in macros can be used in build files:
Table 9-5 Macros Available to Use With Build Files
| Macro name | Description |
|---|---|
|
| Name of application, excluding the vT file extension. |
|
| Directory containing the application ( |
|
| Name of project, excluding the |
|
| Directory containing the project ( |
|
| Defined name of the profile. |
|
| Default deploy directory, usually |
|
| Value of the |
You can use the parameter -statuslogfile c to provide the absolute path to a log file. The path should not contain macros.
The log file contains a list of the deployment tasks processed and the status from each task in XML format. The status will be either SUCCESS or FAILED and includes an exitcode attribute. Possible values for exitcode are:
A combined status is available in a summary section at the end of each log.
Example 9-3 Example of Batch Deployment Log Output
JDeveloper deployment is built around deployment profiles. A common implementation is an ArchiveProfile that describes the structure of a JAR archive. Deployment profiles can be created as part of a project or workspace. A command-line tool, OJDeploy, is available to allow deployment of ArchiveProfile(s) without invoking the JDeveloper IDE.
Command line deployment requires a JDeveloper installation, but this installation is invoked in 'headless mode', not displaying the JDeveloper IDE, loading all extensions defined for headless mode. This form of deployment can read JDeveloper applications and projects and their meta-data. Ant scripts to invoke command line deployment need to be created manually. The resulting deployed archive depends on version of JDeveloper used, and which extensions are enabled when command line deployment is invoked
To make it easier to create an Ant build script for command line deployment, an Ant script can be generated from JDeveloper.
Example 9-4 Structure of the Ant Build Script
The build.properties file, which is generated along with build.xml, defines the additional variables needed for command line deployment:.
Example 9-5 Example of the build.xml File
The Ant build script can be run outside of JDeveloper by simply changing to the directory containing build.xml and running Ant. It can also be run from within JDeveloper, by right-clicking on the build.xml node in the Application Navigator and selecting the "all" or the "deploy" targets.
Example 9-6 Example of the build;.properties File
| Note: By default, the command line deployment task has the nocompile option enabled as the task has dependency on the compile task. If this dependency is removed then the nocompile option can be removed. |
It is a best practice to generate an .ear file from JDeveloper for the application. The .ear file will be generated with all the right class dependencies required to deploy it. Deploying with Ant by referring to an application directly without generating an .ear file may require that dependencies for the classes and jars files must be resolved manually.
JDeveloper supports the creation of the XML-based JNLP (Java Network Launching Protocol) definition upon which the Java Web Start technology is based. Java Web Start allows you to deploy Java applications so that they can be launched from an internet browser. Java Web Start lets you maintain Java client applications and applets on the web server, which users download and run on their client machines.With the Create Java Web Start-Enabled wizard in JDeveloper, you can set up applications and applets to be maintained on the web server, but downloaded and run on client machines.
The process of developing a Java Web Start application can be summarized as:
| Note: To launch applications and applets with Java Web Start in JDeveloper, you must download and install the Java Web Start software. Users of your application or applet will also be required to install the software on their machines. |
For more information on Java Web Start and to download the Java Web Start software, see http://www.oracle.com/technetwork/java/javase/tech/index-jsp-136112.html.
Although Java Web Start and applets may appear to be similar technologies, there are several differences:
With the Java Web Start software installed once on the client machine, the application user can run applications and applets simply by clicking on a web page link. If the application is not present on their computer, Java Web Start automatically downloads all necessary files from the web server where the application libraries reside. It then caches the files on the client computer so the application is always ready to be relaunched anytime either from an icon on your desktop or from the browser link. The most current version of the application is always presented to the user since Java Web Start performs updates as needed.
Application users can use Java Web Start to run applications and applets on client machines, while you maintain the application on the web server. To support Java Web Start and web server downloading, the Create Java Web Start-Enabled wizard generates these files:
.jnlp file describes the archive files and whether this instance includes an applet or an application. Users can use Java Web Start to run applications and applets on client machines, while you maintain the application on the web server. To support Java Web Start and web server downloading, the Create Java Web Start-Enabled wizard generates these files:
JDeveloper provides an Integrated WebLogic Server web server. You can use it to simulate the process of deploying the Web Application Archive and downloading for use with Java Web Start. JDeveloper follows the J2SE deployment profile conventions for archiving components that run on the client machine (simple archive) and components that are deployed to the web server (Web Application Archive).
How to complete the Java Web Start setup:
.war) file which you deploy to the web server. It will contain the contents of the public_html directory in your JDeveloper mywork folder, including the JAR, HTML and JNLP files. | Note: You will not be required to deploy the application to use the JDeveloper-embedded web server. JDeveloper provides a default web.xml definition to locate the contents of thepublic_html directory in your JDeveloper mywork folder. |
Once you have set up the web server, you can launch the Java Web Start software in JDeveloper using the generated .html file. Java Web Start relies on your web browser to download the components identified by the .jnlp file. Another definition in the .jnlp file determines whether it will run as an application or a secure applet. Once you have launched Java Web Start and the downloading is complete, you can close your web browser and continue to run the application or applet.
A Java Network Launching Protocol definition file, application-name.jnlp, is automatically created when you use the Create Java Web Start-Enabled wizard to create Java clients to download and run Java applications and applets on client machines. However, if you want to control the contents of the application-name.jnlp, you can manually create your own file to use.
| Note: If this item appears grayed out, this indicates that there is anapplication-name.jnlp file already created in the project. You can have only one of each deployment descriptor type per project. |
To manually create a Java Web Start (.jnlp) file:
For more information on Java Web Start, see http://www.oracle.com/technetwork/java/javase/tech/index-jsp-136112.html.
You can use the JDeveloper Java EE web deployment process to set up the web server before downloading and running the application using Java Web Start.
Once the application resides on the web server, it becomes very easy to maintain. Java Web Start takes care of identifying and downloading application updates each time the user runs the application.
How to create the ADF Swing web application archive for Java Web Start:
Choose File > New to open the New Gallery.
In the Categories tree, expand Client Tier and select ADF Swing. In the Items list, select Java Web Start (JNLP) Files for ADF Swing, and click OK.
The dialog generates JNLP files for use with Java Web Start, an ANT build file ctbuild.xml, and a deployment profile in the project properties.
to:
ctbuild.xml in the ADF Swing project and choose: Build Target > sign to require authentication of the archive, this will sign the contained JAR files and is a required step.
The build file should generate two signed archive files in your project's public_html directory: client.jar and mymt.zip. These archives are referenced by the generated deployment profile in the project's properties.
web.xml file in the Application Navigator and choose Open. When you are ready to deploy the resulting WAR and EAR files to the target application server, make sure to create an application server connection.
You can use the JDeveloper Java EE web deployment process to set up the server before downloading and running the application using Java Web Start.
Once the application resides on the web server, it becomes very easy to maintain. Java Web Start takes care of identifying and downloading application updates each time the user runs the application.
To create Java client applications for deployment to the web server:
The newly created web.xml deployment descriptor appear in the Application Navigator below the specified project.
web.xml file in the Application Navigator and choose Open. When you are ready to deploy the resulting WAR or EAR to the target application server, make sure to create an application server connection.
| Note: The web module is deployed to the target deployment directory.Make sure that the web application deployment descriptor is located inside the Web Application Archive (WAR) file |
You use the Create Java Web Start-Enabled wizard to create the XML-based JNLP (Java Network Launching Protocol) definition file that the Java Web Start software uses to download and run Java applications and applets on client machines.
| Note: You must download and install the Java Web Start software to launch applications and applets with Java Web Start in JDeveloper. Users of your application or applet will also be required to install the software on their machines. See |
The application or applet must be delivered in a set of JAR files and all application resources, such as images, configuration files and native libraries, must be included in the JAR files. The resources must be looked up using the ClassLoader getResource or another method. Java Web Start only transfers JAR files from the web server to the client. for additional information, see http://www.oracle.com/technetwork/java/javase/tech/index-jsp-136112.html
The wizard adds a JNLP file and (optionally) an HTML file to your project. Java Web Start will use these generated files to determine what application source to download from the web server:
.jnlp file describes the archive files and whether this instance includes an applet or an application. Before you launch the Create Java Web Start-Enabled wizard to create the JNLP and HTML files, you must create a simple archive (JAR) file for it. You must also know in which class the main function can be found, as you will be asked to specify this.
To create the JNLP definition for your application or applet:
Click Next in the Welcome page.
You can also use a JSP file or servlet with Java Web Start; however, you will have to manually configure the file and change the content type. Here is an example JNLP with contentType = application/x-java-jnlp-file, specified in the first line:
Example 9-7 JNLP File
You can deploy the ADF Swing Web Archive to a server. Install the Java Web Start software on your machine. For more information on Java Web Start, see http://www.oracle.com/technetwork/java/javase/tech/index-jsp-136112.html.
To deploy the ADF Swing web application archive for Java Web Start:
web.xml file in the Application Navigator and choose Open. You can use the JDeveloper simple Java EE web deployment process to set up the web server before downloading and running the application using Java Web Start.
Once the application resides on the web server, it becomes very easy to maintain. Java Web Start takes care of identifying and downloading application updates each time the user runs the application.
To deploy Java client applications to the web server:
| Note: Make sure that the web application deployment descriptor is located inside the Web Application Archive (WAR) file WEB-INF/web.xml. |
The Oracle JDeveloper Weblogic SCA Spring Extension provides integrated support for WebLogic SCA and for the open-source Spring framework.
The extension allows you to create:
The extension provides support for creating WebLogic SCA applications in JDeveloper and deploying them in Oracle WebLogic Server. WebLogic SCA is based on a subset of the OASIS Service Component Architecture Spring Component Implementation Specification. For more information, see http://www.oasis-open.org.
Service Component Architecture (SCA) provides a model for building enterprise applications and systems as modular business services that can be integrated and reused. WebLogic SCA provides support for developing and deploying SCA applications using POJOs (Plain Old Java Objects). In SCA, the implementation of a component and its communication are separate. In WebLogic SCA, you can write Java applications using POJOs and, through the different protocols available, expose components as SCA services and access them via references. You do this using SCA semantics configured in a Spring application context. In SCA terms, a WebLogic Spring SCA application is a collection of POJOs plus a Spring SCA context file that declares SCA services and references with the appropriate bindings. WebLogic Spring SCA applications can be used without modification as components in Oracle SOA composites.
In WebLogic Server, WebLogic Spring SCA applications run in the WebLogic SCA Runtime. The runtime must be deployed to WebLogic Server as a shared Web application library before applications can be deployed to it. For more, see Section 9.10.4.3, "How to Deploy WebLogic SCA Applications to Integrated WebLogic Server."
For more information about Oracle WebLogic SCA, see Oracle Fusion Middleware Developing WebLogic SCA Applications for Oracle WebLogic Server.
Spring is an open-source framework that simplifies development of enterprise Java applications. The Spring framework includes models for various layers and functionality areas of Java applications. It focuses on using POJOs, leverages inversion of control concepts and dependency injection, and implements aspect oriented programming.
The Weblogic SCA Spring Extension provides integrated support for creating open source Spring projects in JDeveloper that can be used in Java EE applications. It adds the Spring JAR files as a library to JDeveloper, and it adds a wizard and editing features for creating Spring Bean configuration files. The extension creates: Adds the Spring JAR files as the Spring 2.5 library to JDeveloper. Adds a wizard for creating Spring Bean configuration files Registers the relevant XSDs and DTDs with the IDE to provide a productive editing experience for Spring definitions
For more information about Spring, see Oracle Fusion Middleware Spring Support in Oracle WebLogic Server.
In order to use the Oracle JDeveloper Weblogic SCA Spring Extension, you must download it and install it...
The extension adds the following to JDeveloper:
You can use the Weblogic SCA Spring Extension to create WebLogic SCA enabled projects that can be deployed as a JAR file which can then be included in an EAR file for deployment, or as a WAR file.
You begin developing a WebLogic SCA project by creating the WebLogic SCA Configuration file which acts as the control file for the application. As part of this process, JDeveloper configures either the JAR or WAR deployment descriptor for WebLogic SCA so that the necessary libraries are deployed to the server.
To create a WebLogic SCA application:
What the WebLogic SCA Wizard Does
When you run the WebLogic SCA Configuration wizard, the following happens:
META-INF/jsca and opened in the JDeveloper XML source editor. You can use the advanced XML editing framework to assist you as you edit it. web.xml file one is created. Next Steps
Once you have created an SCA project, you can:
The SCA definition file created when you create a WebLogic SCA project is called spring-context.xml, and it is created in META-INF/jsca and opened in the XML source editor.
The outline spring-context.xml file is
Example 9-8 Outline spring-context.xml File
The comment shows where you enter the bean definitions.
Use the XML source editor features, Structure Window features, the Component Palette, and the Property Inspector to navigate the hierarchy of the XML file and edit it.
Source Editor Features
The source editor has a number of features which help you to edit an XML file.
Structure Window Features
The Structure Window allows you to quickly navigate the hierarchy of the XML file, and it also offers editing features.
Component Palette Features
You can select tags from the Component Palette and drag and drop them directly into the source editor or the Structure Window to build spring-context.xml files.
| Note: You can only drop tags in places that are correct in terms of syntax. |
By default, the Component Palette displays all the available tags. Click All Pages and choose just the type of tags you want to reduce the number of tags displayed. For example, to use WebLogic SCA Bindings, choose that option at the top of the component palette and the components listed are EJB Binding and Webservice Binding.
Property Inspector Features
The Property Inspector allows you to edit the properties of tags.
Once you have created a WebLogic SCA project you can test the application by quickly deploying it to the Integrated WebLogic Server.
To deploy to Integrated WebLogic Server:
What Happens When You Run the Application in Integrated WebLogic Server
If Integrated WebLogic Server has not yet been started, the default domain is automatically created with default settings and the server is started.
The application is deployed to Integrated WebLogic Server and the Log Window displays messages that show the progress of the deployment.
In the Application Server Navigator, you can see the services deployed under the Web Services and EJB nodes under IntegratedWebLogicServer.
Once you have created a WebLogic SCA project you can deploy it to Oracle WebLogic Server.
The process is slightly different depending on whether you chose to create a JAR or a WAR file.
| Note: Before you deploy a WebLogic SCA application to Oracle WebLogic Server, you must install WebLogic SCA on the server. For more information, see the chapter about deploying WebLogic SCA Runtime to WebLogic Server in the Oracle Fusion Middleware Spring Support in Oracle WebLogic Server. |
To deploy an Application Containing a WebLogic SCA WAR File to WebLogic Server:
To deploy an Application Containing a WebLogic SCA JAR File to WebLogic Server:
| Note: The EAR file must contain at least one other Java EE artifact, for example a WAR file or EJB-JAR or the deployment will fail. |
What Happens When You Deploy the Application to WebLogic Server
If necessary, an EAR file is created.
The application is deployed to the WebLogic Server connection and the Log Window displays messages that show the progress of the deployment.
In the Application Server Navigator, you can see the services deployed under the Web Services and EJB nodes under the connection node for the application server.
The Weblogic SCA Spring Extension provides integrated support for the open-source Spring framework. The extension adds a number of libraries to JDeveloper, and adds support for creating Spring framework projects
The Weblogic SCA Spring Extension adds libraries to JDeveloper containing the JAR files of the Spring framework. You begin developing a Spring framework application by creating the Spring Bean Configuration file, which acts as the control file for the application.
To create a Spring Bean Configuration file:
When you create a Spring Bean Configuration from the Spring category in the Business Tier of the New Gallery, the Spring 2.5 and Commons Logging 1.0.4 libraries are automatically added to the project. You can access the library definitions by choosing Project Properties from the context menu of the project in the Application Navigator, and then choosing Libraries and Classpath.
The Spring Bean Configuration file, beans.xml, is created in META-INF/jsca and opened in the XML source editor. You can use the advanced XML editing framework to assist you as you edit it.
There a number of common problems that you may come across when deploying applications. This topic describes them and their solutions. It is divided into issues that may arise when deploying to both Integrated WebLogic Server and Oracle WebLogic Server, and issues that are specific to one or other type of deployment
This section contains information about issues that may arise when deploying to both Integrated WebLogic Server and Oracle WebLogic Server.
Oracle WebLogic Server instances use the domain edit lock to make sure that only one user can deploy applications and change configurations at one time, and this message is displayed when another deployment is going on at the same time (only one deployment at a time is allowed), or some change has been made in the WebLogic Server Administration Console that has not been activated. Rarely, this message may also appear when you are running an application on Integrated WebLogic Server.
To activate a change in the WebLogic Server Administration Console:
To enable or disable the domain configuration locking feature, see the section about enabling and disabling the domain configuration lock in the Administration Console Online Help, which is available from the WebLogic Server online documentation in your JDeveloper installation, or from the Administration Console.
If the error has appeared when you are deploying to Integrated WebLogic Server, you can check the Administration Console to determine what the problem is.
This section contains information about issues that are specific to running on integrated application servers.
If you need to stop integrated application server, for example, to clear out an orphaned WebLogic Server instance that was created and left running from an earlier JDeveloper session, and you are unable to do so from within JDeveloper, go to jdeveloper-user-home/DefaultDomain/bin, and run stopWebLogic.cmd (on Windows) or stopWebLogic.sh (on Linux). This gracefully shuts down the integrated application server so that it will not conflict with subsequent attempts to launch the integrated application server from JDeveloper.
You can force shutdown of an instance that is still actively under the JDeveloper control (i.e., not orphaned) by pressing the Terminate button twice.
If you run multiple applications on Integrated WebLogic Server, you may run out of memory and see the java.lang.OutOfMemoryError: PermGen space exception. To avoid this, increase the MEM_MAX_PERM_SIZE from the default of 128m to 256m, 512m, or higher. This is set in setDomainEnv.cmd (Windows) or setDomainEnv.sh (Linux), which is located at jdeveloper-user-home/DefaultDomain/bin.
You first need to stop Integrated WebLogic Server using one of the methods described above.
If you reinstall JDeveloper into a new location, you may find that you have problems because the integrated application server uses some hard-coded references to JDeveloper. You must do one of:
This section contains information about issues that are specific to deploying to Oracle WebLogic Server.
This is usually caused by a blank password in the <encrypted-password> entry of the application-name-jdbc.xml file or no <encrypted-password> entry at all.
This is usually caused by the wrong password in the <encrypted-password> entry of the application-name-jdbc.xml file.
This will cause logon to be denied, and it is due to using the Oracle WebLogic Server database driver, weblogic.jdbcx.oracle.OracleDataSource. This driver is not certified by Oracle and should not be used.
Make sure there is a target domain selected for the data source. If you clicked Finish before the last panel of the wizard, then this was not done.
Also, make sure that the Java naming lookup call is correct if you are using a lookup in Java code. For example, if the connection name is connection1, the naming lookup should be java:comp/env/jdbc/connection1DS.
You can only deploy an application once to a server that is down.
If you attempt to redeploy the same application to the same down server a second time, deployment fails with the following log message:
When you have successfully deployed an application to a Managed Server, the deployment wizard saves this deployment action in its history so that you can perform the same action later. However, if the Managed Server is removed from your Oracle WebLogic Server domain and you subsequently deploy using the deployment history action, deployment fails with the following log message:
If you are deploying to a server running on a machine that is not known to the network DNS server, and you have set a proxy for JDeveloper, deployment will fail with a 502 HTTP error code. This is because the proxy does not know where to forward the request. This will also happen if you are deploying to a server on the localhost that is referred to by its machine name, which typically happens with SOA development.
To avoid this happening either add the machine to the Exceptions list in the proxy settings in the Web Browser and Proxy page of the Preferences dialog, or choose not to use a HTTP Proxy Server for any connections.
If you see the following message, it usually means that an EAR using password indirection did not have the passwords injected via mbeans before deployment.
This usually happens when trying to deploy an EAR manually from the console or from an ant script.
This section contains information about issues that may arise when deploying to both Integrated WebLogic Server and Oracle WebLogic Server.
WebSphere deployment on Windows does not work when the directory containing the EAR generated by JDeveloper contains spaces.
When you deploy your application to IBM WebSphere application servers and use the same machine to log into the WebSphere administrative console, your application may display the name of the user logged into the administrative console, instead of the name of the user who logs into the application.
This part describes how to develop Java EE applications with Oracle JDeveloper including all of the frontend and business technologies you need to get your enterprise application up and running start to finish. This part of the book contains the following chapters:
This chapter introduces the technologies supported to build your Java EE Application.
This chapter introduces the features, and covers tasks related to building web pages and related business components with HTML, JSF/facelets, JSP, servlets and scripting. It also provides a detailed look at the related tools and technologies available for web page development.
This chapter introduces the features, and covers building your business components with EJB and JPA, including session bean and persistence technologies.
This chapter covers TopLink technology and related steps for building persistence functionality on object-oriented programs based on relational data structures.
This chapter introduces the features, and covers the steps of developing, deploying and administering secure applications.
This chapter introduces XML mappings and configuration files technologies, as well as creating and exiting the XML files.
This chapter introduces the features, and covers the discovery and implementation of existing system web services, and steps for deploying new web services.
This chapter overviews the Java EE features available for your application development, and related components, tools and technologies provided in Oracle JDeveloper.
This chapter includes the following sections:
JDeveloper comes with a complete package of tools and features to create and edit your Java EE 6 application components. Use the wizards, built in source and visual editors, Component Palette and property inspector, and other features to create, assemble, and reuse your web tier and business components. You can build, test, and deploy powerful interactive, multitiered applications that perform well on a variety of different platforms, and are easy to maintain.
For more information on Java EE see the Oracle Technology Network (OTN) Java EE documentation at: http://www.oracle.com/technetwork/java/javaee/overview/index.html
For the web-tier part of your Java EE application, take advantage of the ADF Faces rich client framework (RCF), which offers a rich library of AJAX-enabled UI components for web applications built with JavaServer Faces (JSF).
The ADF layer enables a unified approach to bind any user interface to any business service, without need to write code. When you build a Java EE application, and/or an EJB project, you can assign ADF data controls on your individual session beans. This adds a data control file with the same name as the bean.
The data control contains all the functionality of the application module. You can then use the representation of the data control displayed in JDeveloper Data Controls panel to create UI components that are automatically bound to the application module.
Using the ADF data control business-tier layer to perform business service access for your EJB projects ensures that the view and the business service stay in sync. For example, you could bypass the model layer and call a method on an application module by class casting the data control reference to the application module instance and then calling the method directly, but this renders the business services unaware of any changes.
For more information, see the Oracle Fusion Middleware Java EE Developer's Guide for Oracle Application Development Framework.
JDeveloper provides you with a wide range of tools to develop the web tier, or frontend of your Java EE applications. You can use wizards to walk you through creating all your HTML, JSP and JavaServer Faces (JSF) /Facelet pages and related files.
In addition, JDeveloper provides web page tools and step-by-step instructions for many of the tasks you will use to develop your application web pages. You can build web-tier components using all of the supported Java EE web application technologies such as JSF / Facelets, JavaServer Pages (JSP), Java Servlet, HyperText Markup Language (HTML), and Cascading Style Sheets (CSS). Web components in a Java EE application contain presentation logic and run on the integrated server.
For more information, see Chapter 11, "Developing Applications Using Web Page Tools."
You can create EJB projects, entities, Java persistence units, session beans, and message-driven beans using wizards in the New Gallery. You can build entities from online or offline database table definitions and from application server data source connections.
To quickly get started with your EJB application:
For more information on EJBs, see Chapter 12, "Developing with EJB and JPA Components."
Oracle TopLink is an object-persistence and object-transformation framework that provides development tools and run-time capabilities that reduce development and maintenance efforts, and increase enterprise application functionality
Use TopLink to configure TopLink descriptors and map Java classes, EJBs, and JPA entities to different data sources, including relational databases, enterprise information systems (EIS), and XML schemas. With the TopLink Editor, you can create this information without writing Java code. The TopLink Editor supports multiple standards, including JPA, JAXB, and Java EE.
For more information, see Chapter 13, "Developing TopLink Mappings."
You can secure Java EE applications using only container-managed security or, for Fusion web applications, Oracle ADF Security. Fusion web applications are Java EE applications that you develop using the Oracle Application Development Framework (Oracle ADF).
The Oracle ADF Security framework is the preferred technology to provide authentication and authorization services to the Fusion web application. The Oracle ADF Security is built on top of the Oracle Platform Security Services (OPSS) architecture, which provides a critical security framework and is itself well-integrated with Oracle WebLogic Server.
For more information, see Chapter 14, "Developing Secure Applications."
JDeveloper provides you with the tools you need to work with the XML files in your application. There is an XML source editor, an XML validator, and tools for working with XML schemas. You can also use JDeveloper to create and edit your XSQL files.
You can create your schema documents from scratch, generate schemas from XML documents or vice-versa in JDeveloper. Once your schema is created, manage your elements using the XSD Visual Editor and the Component Palette.
For more information, see Chapter 15, "Developing Applications Using XML."
Web services in JDeveloper provides a set of messaging protocols and programming standards that expose business functions over the internet using open standards. A web service is a discrete, reusable software component that is accessed programmatically over the Internet to return a response. JDeveloper provides tools that help you discover and use existing web services, and develop and deploy new web services.
JDeveloper also supports a set of standard Java-to-XML type mappings. You can also create custom serializers for types of objects that are not automatically supported. For more information, see Section 16.2, "Using JDeveloper to Create and Use Web Services."
You can create web services from Java classes, the remote interface of EJBs, and an ADF Business Components service session bean wrapped as an EJB. The Web service creation wizards create the deployment files for you, so once you have created your web service the final step is to deploy it to application servers. For more information, see Section 16.5, "Creating SOAP Web Services (Bottom-Up)."
Alternatively, you can create a web service starting with a WSDL, as a top-down web service. For more information, see Section 16.6, "Creating SOAP Web Services from WSDL (Top Down)."
Finally, you can develop web services that are based on Representational State Transfer (REST). A RESTful web service is a simple interface that transmits data over a standardized interface (such as HTTP) without an additional messaging layer, such as SOAP. Section 16.7, "Creating RESTful Web Services."
This chapter describes how to build Java EE applications user interfaces and business services with HTML, JSP, and JSF/facelets using the latest tools and technologies included in Oracle JDeveloper.
This chapter includes the following sections:
Oracle JDeveloper provides you with a wide range of tools to develop the frontend or view layer of your Java EE applications. There are handy wizards to walk you through creating all your HTML, JSP and JSF/facelet pages and related files. When you create web pages using the wizards your configuration files, bean mappings, tag libraries, and jar files are automatically set up and editable.
At the forefront of the web tools there are source editors, visual editors, and integrated component and property tools to add and edit the pages, elements and related properties in your pages, including your business service and localization components. You will be able to create and modify your style sheets and tag libraries, and use the Code Insight code and tag completion tools to efficiently code your HTML, JSP and JSF/facelet or Java source files.
This chapter walks you through the web page tools and step-by-step instructions for many of the tasks you will use to develop your application web pages.
The source editor is your basic code editor for most of your web pages. You will use the source editor to add non-visual components, and custom coding, in conjunction with the visual editor which allows you to drop in components and visually modify your pages. When you are using the source editor, there are many features to make coding tasks faster and easier. Figure 11-3 displays a source editor for a JSF page.
Figure 11-1 Source Editor with Typical JSF Code

Table 11-1 lists the primary source editor features.
Table 11-1 Primary Source Editor Features
| Features | Description |
|---|---|
| Quick Doc for Tags | View your tag definitions while you're coding. Put your curser on the tag and press Ctrl + d. A small window appears at the top of your editor with that tag definition detail. Click back in the editor and the window closes. You can also right-click and choose Quick TagDoc. |
| Code Templates | Save time by inserting pre-written code into source files instead of having to type it in manually. Templates can intelligently modify the inserted code to suit surrounding code. Use shortcuts to speed up the selection of the required template. See Section 3.8.3, "How to Customize Code Templates for the Source Editor" for more information on templates. |
| Code Insight | View and filter element and parameter options, and get code completion. The source editor provides Code Insight for tags, attribute names & values, and embedded CSS & JavaScript code. |
| Jump to Managed Bean | Quickly jump to your managed bean code from your web page source. Right-click in the source editor or Structure window and choose Go to, then select your choice from the list of all beans referenced from that page. |
| Editor Splitting | Toggle between code and visual views using the splitter. To split the file horizontally, grab the splitter just above the vertical scroll bar on the upper right-hand side of the window and drag it downward. To split the file vertically, grab the splitter just to the right of the horizontal scroll bar on the lower right-hand side of the window and drag it left. |
The JSP/HTML Visual Editor can be used for WYSIWYG editing of all your web pages including JSP, JSF, facelets, and HTML pages. The visual editor opens up with the Component Palette available to drop and drag components to the page, as shown in Figure 11-2.
Use the visual editor for the following tasks:
With the exception of dynamic content such as JavaScript elements, all your web page elements are visually displayed or structurally represented in the visual editor. JSP tags including JSTL, and BC4J tags are visually displayed in the visual editor using icon and tag names, while HTML template content is rendered based on the browser look and feel. You can toggle back and forth or split the screen to see the source editor during design-time.
The visual editor is integrated with the Java Source Editor, Structure window, Component Palette, Property Inspector, and Data Binding Palette to support the assembly of databound web pages using simple drag and drop operations. You can move from one tool to another and see or edit your changes reflected across the board immediately.
Key visual editor features include the following:
The visual editor comes with a toolbar at the top of the window that includes the usual toolbar icons to format font and paragraphs on your web pages. In addition you can set the window of the visual editor to your preferred resolution using the Match Current Monitor Resolution dropdown tool, as shown in Figure 11-3.
Use the Match Current Monitor Resolution drop-down list to choose a larger or smaller page picture in your visual editor window. Changing the monitor resolution does not impact the actual page or browser size, but only the way it is viewed in this editing window. By default the visual editor window is set to preview in the same resolution as the monitor you are using. You can also set it to fit the current size of the visual editor.
There are also some additional editing tools and features, as detailed below in Table 11-2.
Table 11-2 Toolbar Icon Features on the Visual Editor
| Icon | Name | Description |
|---|---|---|
![]() | Refresh | There are two types of refresh for you to choose from. Use the dropdown menu on the refresh button. Refresh Page rebuilds and re-renders the internal data structures of a page. Use this tool if you have an included page (like a page template) that has been changed, and you want to see the affects in the including page. Full Refresh is used to first fully restart the internal design time for a page project (which includes rebuilding the servlet context from web.xml and tag libraries, and (for Faces projects) the Faces context from the faces-config.xml. With Full Refresh the internal data structures of the active page are rebuilt and it is re-rendered. |
![]() | Show component status |
|
|
| Preview in Browser | Lets you see your how your web page will appear in your default browser. Click the icon or Shift+F10,V. |
Table 11-3 lists the features that are available with simple keystroke commands while you are editing your web pages.
Table 11-3 Primary Visual Editor Command Features
| Features | Description |
|---|---|
| Toggle Line Comments | Adds or removes comment markers from the beginning of each line in a selected block. Select a single line to comment or uncomment that line only. |
| Breadcrumbs | View and select your nested components in chronological order using the breadcrumb that appears at the bottom of the visual editor window. |
| Component Selection | Hovering your curser over a component on the page highlights that component with an orange outline. |
| Editing Containers | In the Structure window or visual editor window select a container. Right-click that container and choose Design This Container. That container is selected in the editing window. This feature allows you to more easily view and edit the individual components in that selected container. |
| Visual EL Expression View Preferences | Select whether to resolve expressions for viewing, and how to view those that are unresolved. Choose the Show toolbar feature to select your preference for EL rendering, or you can also go to Tools >Preferences > JSP and HTML Visual Editor. |
| Expression Builder and Text Popup | Select your component. Slow double-click or F1 to open a popup window with a value field for editing your expressions or text. |
| Corresponding Element Display | Page elements are displayed hierarchically in the Structure window. Double-clicking a node in the Structure window shifts the focus to the Property Inspector. |
| Visual and Code Editor Splitting | Edit your file simultaneously with the visual and source editors by opening the page in one of the editors and using the splitter to open a second page view in the alternate editor. To split the file horizontally, grab the splitter just above the vertical scroll bar (on the upper right-hand side of the window) and drag it downward. To split the file vertically, grab the splitter just to the right of the horizontal scroll bar (on the lower right-hand side of the window) and drag it left. |
| Easy Edit Focus | By default new JSP or HTML pages are opened with the visual editor in focus. Double-clicking a node in the Application Navigator opens or brings the default editor to the foreground. To locate the node in the Application Navigator that corresponds to the file you are currently working on, right-click and choose Select in Navigator. Or use the keyboard shortcut (default keymap, Alt+Home). |
| Tag Display | The scope of tags with embedded body content is structurally represented with the tag icon and name bounded by, or contained within, a shaded rectangle. These tag containers are nested or structurally displayed to represent, for example, an iterated row in a table. Click the tag to select a cursor for entering content in the tag container. |
| Extracting CSS code from HTML/JSP to a CSS files | Extract a CSS block from a HTML/JSP file to a new CSS file and all the references are updated automatically. This option is available to use from the Code editor and the Structure window. |
| Style sheet Linking to HTML files | Link a style sheet to your HTML files simply by dropping a |
| Mobile Device Display | For mobile-enabled JSP documents, the design view emulates the viewport of the selected device category. The device category icon is displayed on the toolbar along with the reference device dropdown list. |
Another feature that can be used while working in the visual editor or Structure window is the ability to expand or collapse JSP and HTML page elements containing or nesting other elements. To do this use the - (minus) and + (plus) sign to expand and collapse the parent container element.
For example, in the visual editor, JSP container tags are displayed as nested rectangles. An expanded JSP <c:choose> tag containing a <c:when> and <c:otherwise> tag displays as shown in Figure 11-4.
In the Structure window, the example of a collapsed HTML table with multiple rows displays as shown in Figure 11-5.
To collapse the container element:
Do one of the following:
You can customize the following default visual editor environment settings such as:
To change the general environment settings for the visual editor:
You can customize the display of invisible elements such as:
To change the display of invisible elements in the visual editor:
To get a close approximation of a runtime visualization, run the tag library in a simulated JSP/Servlet container available in the design time page context.
To set a JSP Tag Library to execute at design time:
To set this option for a particular project:
Display JSP tags by name only, by omitting embedded EL syntax. For example, <c:out value="${Row.Deptno}"></c:out> would display simply as out vs. ${Row.Deptno} if this select this option.
To display JSP tags by name only:
Use the JDeveloper keyboard or mouse for navigating any of your development tasks. You can also customize the default keymap, and within each keymap specify any of the accelerator assignments.
To customize keymap accelerators:
You can select a single element to manage, or select a container element along with included elements such as a table, or multiple elements. A dotted line encloses the selection. In the Structure window, a selected element is highlighted.
To select an element:
OR
Right-click the element. When you select an element by right-clicking, a context menu of options is displayed. For example, to highlight the element code in the Source view of the page, right-click the element and select Go to Source.
| Note: Double-clicking an element brings up an editor dialog for the tag. |
To select text:
In the visual editor in an open web page, do one of the following:
To select multiple element:
To select a range of adjacent elements:
| Tip: For JSP tag libraries, when you pass the mouse pointer over an element, a tooltip with the tag name is displayed, making it easier to know where to click to select a element.Press When you select an element in the visual editor, it is also selected in the Structure window, and vice-versa. You can look at the selection in both tools to see what is selected and where the insertion point is. |
While inserting, copying, or moving page elements, you select an insertion point on the page in the visual editor or in the structure window in relation to a target page element. JDeveloper provides visual cues to locate the insertion point before, after, or contained inside a target element.
To select an insertion point in the visual editor:
| Note: Copying an element from the clipboard into a selected element will replace the selected element. |
To select an insertion point in the Structure window:
When dragging a web page element to an insertion point, do one of the following:
When selecting a target position by clicking, highlight the target element.
| Note: A disallowed insertion point is indicated when the drag cursor changes to a slashed circle. |
Use the Component Palette to add UI and data elements to your web pages. You can insert page elements in the visual editor or the Structure window. When you select an insertion point, the selection is reflected in both, enabling you to verify the insertion position visually as well as hierarchically.
For more information, see Section 11.1.4, "How to Use the Component Palette."
To insert a page element:
When you insert a page element, JDeveloper generates the source code for the element. When you delete an element, the associated lines from the code are also deleted.
The Property Inspector displays the properties of web page elements selected in the visual editor or the Structure window. Use the Property Inspector to set or modify the property values for any element in your web pages. Set property values are marked with a green square. To undo changes, from the main menu select Edit > Undo action. Use the Set to Default button to reset a property with a default value to its original value.
For more information, see Section 11.1.3, "How to Use the Property Inspector."
To set element properties:
| Note: You can also use the Find box at the top of Property Inspector to search for the property. |
To display an editor to set or modify an element's properties:
As an alternative to working with the Data Control Palette to create databound UI components, you can set ADF bindings for UI components that you display in the visual editor.
Use the Property Inspector to set or remove a data source for an element property. From a Value Binding dialog you can select available data sources defined by the objects or the application ADF binding context that you specify for an EL expression. Note that before you can specify an ADF binding as a data source you must first create the binding.
To databind an element property:
| Tip: To remove a data source from a JSP element property, toggle the Bind to Data button off. |
If you have multiple elements selected, by default the Property Inspector displays all the properties of the selected elements. Click Union in the Property Inspector toolbar to toggle between displaying all the properties of the selected elements (union) and displaying only the properties that the selected elements have in common (intersection). Values represented in italic font indicate common properties that have differing value.
To set properties for multiple elements:
Do one of the following:
Cut, copy, and paste web page elements in the visual editor or Structure window. You can perform these operations between files of the same project or different projects.
To cut one or more elements:
The element is removed from the editor and placed into a local clipboard only accessible by JDeveloper not to the system clipboard. If you quit JDeveloper without pasting the element, the cut version of the element will be lost.
The cut command is the first step in a cut and paste action. You can also delete an element. Deleting an element removes it without changing the contents of your clipboard.
To delete web page elements:
To copy one or more elements
In the visual editor you can also:
To paste an element:
To move web page elements:
To Resize HTML Page Elements
JSF applications use the dataTable tag to display a data table. You use the Create Data Table Wizard to insert that tag on a JSF page. This wizard also provides rudimentary formatting. Once created, you can further edit the table by setting or changing attribute values. You can also add or delete columns, and add components or objects to columns.
To create and edit a data table:
h:dataTable component in the Structure window. To work with columns in a data table:
| Note: You can also select the data table in the visual editor or structure window. In the visual editor dropdown menu, select Insert inside Data Table > Column. |
| Note: You can also select the column in the visual editor or structure window. In the visual editor dropdown menu, select Insert inside Column > Output Text. |
JSF applications use the panelGrid tag to display an HTML table. You then place other components inside the panel grid. JDeveloper provides the Create PanelGrid Wizard to help you create the grid. Once created, you can further edit the grid by adding, moving, and deleting components in the grid.
To create and edit a panel grid:
h:panelGrid component in the Structure Pane. The properties editor opens. Change any values as needed. panelGroup tag in the cell. You can then elect to place other components inside the panelGroup tag. Note that you cannot add rows to a panel grid. You can only add columns using the Columns attribute. Components are then placed in columns along a row in the order they appear in the Structure window. You can copy and paste source code between files in the same project or different projects. Paste source code without interpretation, for example as sample code, by selecting No in the Confirm Markup Insert dialog.
To paste markup code
HTML head content such as style definitions and the browser window title are invisible elements on web pages. In the visual editor you can view and edit head section elements.
To view elements in the head section of a page:
With a web page open in the visual editor choose Design > Show > Head Content. For each element of the head section, an icon appears in a bar at the top of the page.
When you select an element in the head section bar, the source code for the element is highlighted in the code editor.
To edit an element in the head section of a page:
css/filename.css from the context menu. Use the Property Inspector to view and edit the properties of a selected component.
As shown in Figure 11-6, the title bar of the Property Inspector displays the name of the selected component, for example, form or body. The main area of the inspector displays the component properties and their values. If you have selected more than one component in the active tool, the word "Multiple" appears in the title bar, and only the properties shared among the selected components display.
The main area of the Property Inspector displays groups of properties in named sections that you can expand or collapse.
The Property Inspector displays component properties as fields, dropdown lists, or combo boxes. For boolean properties, a checkbox before the property name to indicates its current value. boolean properties that accept EL expressions use either a field or dropdown list, depending on whether the current value is an expression or an explicit value of true or false.
In all properties, an asterisk (*) appears next to a property name indicating that a value is required for that property. To see a description of a property, right-click a property name, field, dropdown list, or combo box to display a popup window. A description of the property appears in a scrollable box under Property Help at the bottom of the popup window. Click + (plus) and - (minus) to toggle the help box display within the popup window. Resize the popup window by dragging the bottom right corner of the window. When you resize the popup window, the new size is used for all subsequent property popup windows that you open until you change the size again.
Table 11-4 Toolbar Icon Features on the Property Inspector
| Icon | Name | Description |
|---|---|---|
|
| Enable/Disable Auto-Extend | Use to toggle on and off the automatic expansion of the Property Inspector to display the full contents when the cursor is over the Inspector. When focus moves to another part of the user interface, the Inspector returns to the default position. |
![]() | Bind to ADF Control | When available, click to bind or rebind a property to an ADF data control of your choice. |
To edit a property value, enter a new value in a field or select a value from a fixed set of values using a dropdown list. When you edit a property value, a green dot appears next to the property name to indicate that it has been changed from its default setting. Other ways to edit a property value include the following:
When you write your own property editors, you can control what the Property Inspector displays. If your property editor supports tags, the Inspector displays those tags in a dropdown list as the fixed set of values. If the property editor does not support tags, the Inspector will query your editor to see whether it supports a custom property editor. If neither are supported, a text area will be displayed for the user to type directly into.
The following additional features are available in Customization Developer role:
The Component Palette displays the elements of your component libraries, and lets you assemble a user interface by using simple drag and drop operations. The components available in the palette vary depending on the type of file in the active editor window. For example, if you are editing an HTML file, the palette displays a list of common components, as shown in Figure 11-7.
If you are editing a .java file, a completely different set of components display.
Your file or page components are organized in pages in the Component Palette. Select the palette page you want from the dropdown list at the top of the palette.
To insert a component into a file, open in the active editor, drag the component from the palette to an insertion point in the editor. In some file types you click a component in the palette and then click in the editor to insert the component.
The Component Palette provides the following features:
Use the overview editor for JSF configuration files to visually design and edit your JSF application configuration data stored in faces-config.xml. Figure 11-8 displays the overview editor.
When you open faces-config.xml its contents are displayed in an editor group. When you select the Overview tab at the bottom of this group, the overview editor appears.
When the overview editor is open, the Property Inspector displays the metadata child elements for the currently selected element. Use the Property Inspector to manage these. For instance, you use the Property Inspector to set the <description> and <display-name> child elements.
The overview editor has three sections:
You can add, delete, or edit your JSF element and child elements using the Overview Editor.
To work with a main JSF configuration element and its immediate child elements:
faces-config.xml file to open. To add, delete, or edit JSF configuration elements:
To view, add, delete, or edit child configuration element child element:
The JSF Navigation Diagrammer has features to diagram the JSF pages, and the navigation between the pages.
The pages are represented by icons, and the navigation between pages as lines. The navigation is mirrored in navigation cases in the faces-config.xml file for the application.
When a JSF navigation diagram is displayed, the Component Palette is also displayed. The JSF Diagram Objects page of the Component Palette shows entries for the elements that can be included on a JSF navigation diagram. To add JSF diagram elements to a JSF navigation diagram, select them from the Component Palette.
When you first view the navigation diagram, JDeveloper creates a diagram file to hold diagram details and it maintains this diagram file, and the corresponding JSF configuration file that holds all the settings needed by your application. If you are using versioning or source control, the diagram file is included as well as the configuration file it represents.
To view the navigation diagram for an JSF application:
faces-config.xml. When you view the Application Navigator using Group by Category (default), a single entry for the JSF configuration file represents both the configuration file and the associated diagram file. If you view all files using Group by Directory, you see separate nodes for the two separate files: the configuration file using the full file name, and the diagram file is shown as the name of the JSF configuration file with the .jsf_diagram extension.
When you first open the JSF configuration file, the configuration file node displayed in the Application Navigator indicates that there have been changes, even though no changes have yet been made to the JSF configuration file. This is because the node displayed in the Application Navigator represents both the JSF configuration file and the navigation diagram file. So, although the JSF configuration file has not changed, a navigation diagram file has been created. Similarly, if you make changes to a navigation diagram that do not affect the JSF configuration file, such as changing the layout, the node in the Application Navigator indicates that changes have been made.
If you have a large or complex application, the file can be large and loading can take a long time. If you do not want JSF diagram files to be created for your JSF configuration files, choose not to use the diagram as the default editor so that no diagram file will be created unless you specifically request one.
Use the JSF navigation diagram and the Component Palette to create a diagram representing the pages in your application and the navigation cases between them. The navigation cases you add to the diagram are automatically added in the JSF configuration file.
To add an element to a JSF Navigation Diagram
To add a JSF navigation case to a JSF navigation diagram:
To draw the navigation case as a line with angles in it, select either Polyline or Orthogonal in the editor toolbar as shown in Figure 11-12.
To add a note to a JSF navigation diagram
To attach a note to an element in a JSF navigation diagram:
To lay out the elements on a JSF navigation diagram automatically
Table 11-5 Navigation Diagram Layout Styles
| Icon | Icon Description |
|---|---|
![]() | Draws straight lines for navigation cases between page icons. |
![]() | Draws lines with angles for navigation cases between page icons. |
![]() | Draws lines with right angles for navigation cases between page icons. |
![]() | Arranges the icons in a horizontal layout. |
|
| Arranges the icons in a vertical layout. The elements on the diagram are laid out according to the pattern you chose. |
To refresh the JSF navigation diagram to reflect changes to the JSF configuration file:
You can use the navigation diagrammer to add, edit, rename, and delete JSF pages.
Effect of deleting
The associated web page is no longer visible in the JSF navigation diagram. If you created the file, it is still available from the Web Content folder in the ViewController project in the Application Navigator.
Effect of editing
When you edit web pages manually, JDeveloper does not automatically update either the JSF navigation diagram or the JSF configuration file.
Effect of renaming
If you rename a JSF page on a navigation diagram, this is like removing a page with the original name from the diagram and adding a new one with the new name. If you have created the underlying page, that page remains with its original name in the file system; on the diagram, the page icon changes to the icon that indicates the page does not yet exist.
If you have already created a JSF page and it is displayed on the diagram, if you rename it in the navigator, this is equivalent to removing the original file and creating a new file. The diagram retains the original name, and now displays the page icon that indicates the page does not exist.
Renaming a page on a JSF navigation diagram affects the navigation rules and cases in the JSF configuration file.
To view a web page from a JSF navigation diagram:
Double-click the icon for the web page you want to view. The page opens in the appropriate editor.
Use navigation diagrammer to delete navigation cases between the pages.
Effect of deleting
The associated <navigation-case> is removed from the JSF configuration file.
The associated web page is still visible in the diagram and, if it has been created, is still available from the Web Content folder in the ViewController project in the Application Navigation.
Effect of editing
When you edit the label for the navigation case on the diagram, the associated <navigation-case> is updated in the JSF configuration file.
Once you have created a navigation case in the JSF navigation diagram, you cannot change the destination of the navigation case in the diagram. To change the destination for an existing navigation case in the diagram, delete the existing navigation case and create a new one to the correct destination
If your JSF diagram file is large and would take a long time to open in the JSF navigation diagrammer, you may be asked if you would like to open the JSF configuration file in another editor instead.
To view properties of a navigation case on a JSF navigation diagram:
The navigation cases are displayed on the diagram as solid lines, with the <from-outcome> element value displayed as the label.
Diagrams can be saved as .jpg, .png, .svg or .svgz files for use in documents, or on web pages. Images saved in .jpg format will tend to create the largest files, followed by .svg, .png and .svgz.
To publish a diagram as a graphic:
Or
Click on the surface of the diagram that you want to publish as a graphic, then choose Diagram > Publish Diagram.
Use Code Insight to speed up your coding tasks by providing available options for you to select while coding to quickly complete or insert elements.
Code Insight provides completion insight and parameter insight. To invoke completion insight, pause after typing the period separator or, in the default keymap, press Ctrl+Space. To invoke parameter insight, pause after typing an opening (the left) parenthesis or, in the default keymap, press Ctrl+Shift+Space. To exit either type of insight at any time, press Esc.
To use Code Insight in a web page in the source editor:
<jsp:include. There should be no space between the prefix and the tag name. <jsp:include page. jsp:include page="filename.jsp". <select size="4" name="ListBox"></select>. Right-click any tag name in the editor and choose Select in Structure to highlight that tag in the Structure window. The Structure window also displays any syntax errors found as you edit. You can double-click an error, element, or attribute to edit it in the source editor.
To enable the End Tag Completion feature, choose Tools > Preferences > Code Editor > JSP/XML/HTML to open the panel and select the option.
Code Insight is also available in JavaScript and CSS files.
To use Code Insight in a JavaScript file:
JDeveloper will display a list of possible completions. You can filter the available completions by typing the first character; for example, if you type the letter d, JDeveloper will display completions beginning with D (Date, decodeURI, etc.)
Code Insight will also prompt for completion inside JavaScript-specific XML attributes.
To use Code Insight in a CSS file:
JDeveloper will display a list of possible completions at this point in the CSS file. You can filter the available completions by typing the first character of the element for which you are using Code Insight.
This section covers JDeveloper support and tools for your user interface development using JavaServer Faces (JSF) technology within the Java EE platform.
JDeveloper provides full support for developing user interfaces with JSF and facelets technology in accordance with the JSF 2.0 specification found at http://jcp.org/aboutJava/communityprocess/final/jsr314/index.html. The JSF content in this section assumes you are using facelets technology for your JSF development.
You can build your application from the ground up using the features provided in JDeveloper. The first thing to do is build a framework or application template for your web pages. Get started quickly using the application templates. Choose from a combination of technologies to include in your application as you build your application with the New Gallery Wizard. The application you choose determines the project folders created and the libraries added to the folders as shown in Table 11-6.
Table 11-6 Web Application Templates
| Application | Description |
|---|---|
| Fusion Web Application (ADF) | Creates a databound ADF web application. This application contains one project for the view and controller components (ADF Faces and ADF Task Flows), and another project for the data model (ADF Business Components). |
| Java EE Application | Creates a databound web application. This application contains one project for the view and controller components (JSF), and another project for the data model (EJB and JPA entities) |
| Generic Application | Creates an application with a single project. The project is not preconfigured with JDeveloper technologies and can be customized to include any technologies. |
Use the wizards to build a customized application framework.
To create a web application and project for a JSF application:
Once you have created the framework of your application, get your pages up and running fast with the page building, editing, and modeling tools.
To quickstart your JSF application end to end:
faces-config.xml. See Section 11.2.2.12, "How to Configure JSF Applications". To create your JSF pages:
Choosing a Business Service
With JDeveloper you can work with data sources based on Enterprise JavaBeans (EJB) or JavaBeans. You can also use Oracle TopLink to map your Java classes and EJBs to database tables. Web services is available if you don't need to create the backend business service and want to expose existing business services, including EJB components, stored procedures in the database, or other services writing Java and other languages.
None of the application model and backend classes should refer to JSF classes so that the same classes can be used with any type of user interface.
When you want to work with a specific business service, you can open the New Gallery and use the provided wizards and dialogs to create or, in the case of web services, expose the entities in your Model project, as shown in Table 11-7.
Table 11-7 Business Service New Gallery Options
| If you want to use... | Then choose this New Gallery option... |
|---|---|
| Enterprise JavaBeans in the Model project | EJB in the Business Tier category |
| Oracle TopLink in the Model project | TopLink in the Business Tier category |
| JavaBeans in the Model project | JavaBeans in the General category |
| Web services that were created based on legacy code, software components (such as EJB components), or even PL/SQL in the database and make it accessible through HTTP quickly and easily. | Web Services in the Business Tier category |
To create a business service:
JDeveloper comes with a Component Palette stocked with standard JSF components that you can easily drag and drop onto your JSF pages. When you create a JSF page the backing beans are created and automatically binded to all of the components you put on the page and to corresponding properties. In addition, there is a Property Inspector and Expression Language feature to assist you.
For localization, resource bundles are automatically added when you add content components to your page. You can manage your resource bundles, or create new resource bundles in the Project Properties feature of your application.
Among the many standard component options provided with JDeveloper, there are validating and converting components that are configurable through the Property Inspector, as well as a Message component to help you set up the error message output for your JSF pages, as shown in Figure 11-14.
JSF Common Components
For complete information about JSF tag libraries, see the tag libraries documentation at: http://download.oracle.com/docs/cd/E17410_01/javaee/6/javaserverfaces/2.0/docs/pdldocs/facelets/index.html.
Table 11-8 Standard JSF Core Tag Library Supported Elements
| Component Tag | Syntax | Description |
|---|---|---|
| f:actionListener | <f:actionListener [type] [binding] [for] /> | Registers an action listener on the UIComponent associated with the closest parent component. |
| f:ajax | <f:ajax [disabled] [event] [execute] [immediate] [listener] [oneevent] [oneerror] [render] /> | Registers an AjaxBehavior instance on one or more UIComponents implementing the ClientBehaviorHolder interface. This tag may be nested within a single component (enabling Ajax for a single component), or it may be "wrapped" around multiple components (enabling Ajax for many components). |
| f:attribute | <f:attribute [name] [value] /> | Adds an attribute to the UIComponent associated with the closest parent UIComponent custom action. |
| f:convertDateTime | <f:convertDateTime [dateStyle] [locale] [pattern] [timeStyle] [timeZone] [type] [binding] [for] | Registers a DateTimeConverter instance on the UIComponent associated with the closest parent UIComponent custom action. |
| f:converter | <f:converter [converterID] [binding] [for] /> | Registers a named Converter instance on the UIComponent associated with the closest parent UIComponent custom action. |
| f:convertNumber | <f:convertNumber [currencyCode] [currencySymbol] [groupingUsed] [integerOnly] [locale] [maxFractionDigits] [minIntegerDigits] [pattern] [type] [binding] [for] /> | Register a NumberConverter instance on the UIComponent associated with the closest parent UIComponent custom action. |
| f:event | <f:event [name] [listener] /> | Allows you to install ComponentSystemEventListener instances on a component in a page. |
| f:facet | <f:facet/> | Registers a named facet on the UIComponent associated with the closest parent UIComponent custom action. |
| f:loadBundle | <f:loadBundle [basename] [var] /> | Loads a resource bundle localized for the Locale of the current view, and expose it as a java.util.Map in the request attributes of the current request under the key specified by the value of the “var” attribute of this tag. The Map must behave such that if a get() call is made for a key that does not exist in the Map, the literal string “KEY” is returned from the Map, where KEY is the key being looked up in the Map, instead of a Missing Resource Exception being thrown. If the Resource Bundle does not exist, a JspException must be thrown. |
| f:metadata | <f:metadata/> | Declares the metadata facet for this view. This must be a child of the <f:view>. This tag must reside within the top level XHTML file for the given viewId, not in a template. The implementation must insure that the direct child of the facet is a UIPanel, even if there is only one child of the facet. The implementation must set the id of the UIPanel to be the value of the UIViewRoot.METADATA_FACET_NAME symbolic constant. |
| f:param | <f:param [binding] [id] [name] [value] [disable] /> | Adds a child UIParameter component to the UIComponent associated with the closest parent UIComponent custom action. |
| f:phaseListener | <f:phaseListener [type] [binding] /> | Registers a PhaseListener instance on the UIViewRoot in which this tag is nested. |
| f:selectItem | <f:selectItem [binding] [id] [itemDescription] [itemDisabled] [itemLabel] [escape] [itemValue] [value] [noSelectionOption] /> | Add a child UISelectItem component to the UIComponent associated with the closest parent UIComponent custom action. |
| f:selectItems | <f:selectItems [binding] [id] [value] [var] [itemValue] [itemLabel] [itemDescription] [itemDisabled] [itemLabelEscaped] /> | Adds a child UISelectItems component to the UIComponent associated with the closed parent UIComponent custom action. When iterating over the select items, toString() must be called on the string rendered attribute values. Version 2 of the specification introduces several new attributes, described below. These are: var, itemValue, itemLabel, itemDescription, itemDisabled, and itemLabelEscaped. |
| f:setPropertyActionListener | <f:setPropertyActionListener [value] [target] [for] /> | Registers an ActionListener instance on the UIComponent associated with the closest parent UIComponent custom action. This actionListener will cause the value given by the "value" attribute to be set into the ValueExpression given by the "target" attribute. |
| f:subview | <f:subview [binding] [id] [rendered] | This handles the Container action for all JavaServer Faces core and custom component actions used on a nested page via "jsp:include" or any custom action that dynamically includes another page from the same web application, such as JSTL's "c:import" |
| f:validateBean | <f:validateBean [validationGroups} [disabled] [binding] [for] | This is a validator that delegates the validation of the local value to the Bean Validation API. The validationGroups attribute serves as a filter that instructs the Bean Validation API which contraints to enforce. If there are any constraint violations reported by Bean Validation, the value is considered invalid |
| f:validateDoubleRange | <f:validateDoubleRange [disabled] [maximum] [minimum] [binding] [for] /> | Registers a DoubleRangeValidator instance on the UIComponent associated with the closest parent UIComponent custom action. |
| f:validateLength | <f:validateLength [disabled] [maximum] [minimum] [binding] [for] /> | registers a LengthValidator instance on the UIComponent associated with the closest parent UIComponent custom action. |
| :validateRegex | :<validateRegex [disabled] [pattern] [binding] [for] /> | This is a validator that uses the pattern attribute to validate the wrapping component. The entire pattern is matched against the String value of the component. If it matches, it's valid. |
| f:validateRequired | <f:validateRequired [disabled] [binding] [for] /> | This is a validator that enforces the presence of a value. It has the same affect as setting the required attribute on a UIInput to true. |
| f:validator | <f:validator [disabled] [validatorId] [binding] [for] /> | Registers a named Validator instance on the UIComponent associated with the closest parent UIComponent custom action. |
| :valueChangeListener | <:valueChangeListener [type] [binding] /> | Registers an ValueChangeListener instance on the UIComponent associated with the closest parent UIComponent custom action. |
| f:verbatim | <f:verbatim [escape] [rendered] /> | Creates and register a child UIOutput component associated with the closest parent UIComponent custom action, which renders nested body content. |
| f:view | <f:view [locale] [renderKitId] [beforePhase] [afterPhase] /> | Container for all JavaServer Faces core and custom component actions used on a page. |
| f:viewParam | <f:viewParam [converter] [converterMessage] [id] [required] [requiredMessage] [validator] [validatorMessage] [value] [valueChangeListener] [maxLength] [for] /> | Used inside of the metada facet of a view, this tag causes a UIViewParameter to be attached as metadata for the current view. Because UIViewParameter extends UIInput all of the attributes and nested child content for any UIInput tags are valid on this tag as well. |
View and set your component tag attributes in the Property Inspector. When you select an attribute, a brief description of the attribute appears in the text area below the attribute list. Most of the standard JSF component tag attributes accept value binding expressions, #{expression}.
When you add a component to the JSF page, the Property Inspector displays the supported attributes for the component tag grouped in these categories:
id and title. For localization there are language translation attributes such as lang and dir. onclick, onkeypress, and onmouseover. General and Core Attributes
Most standard JSF component tags support the following general and core attributes:
HTML Event and Style Attributes
The JSP actions in the tag library support most of the attributes that the HTML 4.01 specification declares for corresponding HTML elements. These attributes are optional and can be set to static values or using any type of JSF EL expression.
Client-side JavaScript event handling attributes supported could include:
onblur, onchange, onclick, ondblclick, onfocus, onkeydown, onkeypress, onkeyup, onload, onmousedown, onmousemove, onmouseout, onmouseover, onmouseup, onselect, onunload.
Style and presentation attributes supported could include background, border, cellpadding, cellspacing, font, margin, style, outline.
JDeveloper supports the standard JSF tag library contains JSF component tags for all UIComponent + HTML RenderKit Renderer combinations defined in the JavaServer Faces Specification.
All supported attributes are shown in square brackets ([ ]). Default values are provided, where applicable (e.g., [disabled="false"]). An asterisk (*) placed after an attribute means a value is required. Where applicable, supported child and facet components are also shown.
Backing beans are managed beans that contain logic and properties for UI components on a JSF page. JDeveloper provides an option to automatically bind components on the Managed Bean tab of the Create JSF page dialog. When this option is selected, a default backing bean is created (or uses a managed bean of your choice) for the page you are creating, and then automatically binds all components you place on the page to a corresponding property in that bean. It also creates the associated accessor methods.
Figure 11-15 Create JSF Dialog - Create Managed Bean Tab

When you create a JSF page using the Create JSF page dialog, you choose between two options for automatic component binding: Automatically Expose UI Components in a New Managed Bean Automatically, or Expose UI Components in an Existing Managed Bean.
When either option on, JDeveloper automatically uses a managed bean for the page you are creating, and automatically binds any component that you drag and drop onto the page to a corresponding property in the bean.
To create managed beans:
To add methods to a managed bean:
To create managed beans with the JSF configuration editor
faces-config.xml file. This file is located in the Web Content/WEB_INF directory. If you create a page and elect to automatically bind components, JDeveloper does the following automatically:
faces-config.xml file for the backing bean. By default, the managed bean name is backing_<page_name> and the bean uses the request scope. You can choose to let JDeveloper create and configure a default backing bean or use an existing managed bean for the page you are creating. When automatic component binding is turned on, JDeveloper controls the binding attribute of components that you drop onto the page. Choose from the component binding options when you are creating your new page in the New Gallery as shown in Table 11-9.
Table 11-9 Component Binding Options
| If you want to... | Then choose... |
|---|---|
| Use a default managed bean for a JSF page | Automatically Expose UI Components in a New Managed Bean. Accept the default names, or enter names of your choice. |
| Use an existing managed bean of your choice for a JSF page | Automatically Expose UI Components in an Existing Managed Bean. Then select a managed bean from the dropdown list. |
JavaServer Faces provides an expression language (JSF EL) that can be used in JSF pages to access the JavaBeans components in your page bean and in other beans in your web application, including the session and the application beans. To bind any property of a component, add the component to a page and then select the component and create the bindings from the Property Inspector.
You can use the Expression Builder dialog box to choose which JavaBeans property the component property is to be bound to and write your EL Expressions using the tools, as shown in Figure 11-16.
The JSF expression language syntax uses the delimiters #{}. An expression can be a value-binding expression for binding UI components, or their values to external data sources, or a method-binding expression for referencing backing bean methods.
The syntax supported for a JSF value binding expression is for the most part the same as the syntax defined in the JavaServer Pages Specification (v 2.0), with the following exceptions:
Examples of valid value binding expressions include:
#{Page1.name} #{Foo.bar} #{Foo[bar]} #{Foo[“bar”]} #{Foo[3]} #{Foo[3].bar} #{Foo.bar[3]} #{Customer.status == 'VIP'} #{(Page1.City.farenheitTemp - 32) * 5 / 9} Reporting Period: #{Report.fromDate} to #{Report.toDate} Method binding expressions must use one of the following patterns:
#{expression.value} #{expression[value]} Expression language provides the following operators, in addition to the . and []operators:
Empty: The empty operator is a prefix operation that can be used to determine whether a value is null or empty.
To construct an EL expression that uses JSF technology:
Automatic component binding in a page affects how you enter method binding expressions for the attributes of command and input components such as
action actionListener launchListener returnListener valueChangeListener validator Use the Expression Builder dialog box shown in Figure 11-16 to choose the component property that will be bound.
When Automatic Component Binding is Off
When automatic component binding is turned off, you have to select an existing managed bean or create a new backing bean as you enter method binding expressions for component attributes. If you create a new backing bean, a managed bean is configured in application faces-config.xml.
When Automatic Component Binding is On
When automatic component binding is turned on, you do not have to select a managed bean. As you enter method binding expressions for component attributes, you can select from existing methods in the bean, or if you enter new method names, JDeveloper automatically creates the new skeleton methods. You then add the logic to the method.
In addition, when you edit a Java file that is a backing bean, a method binding toolbar appears in the source editor for you to bind appropriate methods to selected components in the page.
Suppose you created a JSF page with the file name myfile.jsp. If you let JDeveloper automatically create a default managed bean, then JDeveloper creates the backing bean as view.backing.Myfile.java, and places it in the \src directory of the ViewController project. The backing bean is configured as a managed bean in the application resources file (faces-config.xml), and the default managed bean name is backing_myfile.
When automatic component binding is turned on, any component that you insert in the page is automatically bound (via its binding attribute) to a property in the backing bean, as shown in Example 11-1 and Example 11-2.
Example 11-1 JSF Page (myfile.jsf) Using Default Managed Bean
Example 11-2 Default backing bean Java file: Myfile.java
Application resources file: faces-config.xml
When editing a JSF page in the visual editor, you can turn off or turn on the automatic bind option or change the managed bean selection
To turn off or on automatic component binding
To select a managed bean for automatic component binding in a JSF page
To value bind a component to a property:
To manually bind component instances to properties
To bind to an existing method with auto component binding on:
To bind to a new default method with auto component binding on:
To bind to a new method with auto component binding on:
myMethod. Note that because the Action attribute can take either a string or a method, you must include the brackets for an action method, for example: myAction(). For other methods, the brackets should be omitted. A skeleton method in the associated backing bean, and the binding code in the JSF page is created. To bind to a method with auto component binding off:
All of the content you build in your JSF application components is stored in resource Bundles. You can add or remove resource bundles easily from your application in the Default Project Properties dialog.
During development right-click your component to select text resources. The resource bundles available for the project are displayed. Select the bundles to make available for the project you are working on. New text is stored in the resource bundle you select.
You can also assign a key value string to uniquely identify the text object in the resource bundle. By default the name, or a part of the name you enter for display value is used. This value is used by translators to correlate your base content with its localized partner. Existing content strings you have previously added to resource bundles are available and displayed when you are adding new content. Reusing existing content strings optimizes localization efforts, ensuring you don't add new content strings with unique identifiers when a duplicate string with a different identifier already exists. Recycling content strings across your project and application using resource bundles reduces translation efforts and costs.
To add resource bundles in your JSF application:
Add a Resource bundle to your project by going to Application > Project Properties > Resource Bundle > Bundle Search . Find your project resource bundle then click to add it to your project.
In your JSF page, you can reference a resource bundle string from any component tag attribute that accepts value binding expressions, e.g., #{bundle.key}.
To use localized resource bundles in JSF:
faces-config.xml to open it in the JSF Configuration Editor. Switch to the Overview, if necessary. Example 11-3 Resource Bundle Code Sample
In the faces-config.xml:
In the JSF page:
...
Many components use facets, and when you use wizards to create complex components (such as a table or panel), output tags are often automatically created and inserted into the facets. You can manually edit these components or add other components to facets. You can also add or delete facets using a context menu in the Structure window.
To work with facets:
Facelets removes the need to write custom tags for JSF components because the technology uses JSF custom components natively. You need very little special coding to bridge JSF and facelets. You can use JSF components directly within the facelets templating language. Facelets allows you to define component assemblies that can be included directly into a page or can easily be added to a facelet tag library. Facelets also allows you to define site templates (and smaller templates). You can also use facelets inside of a custom JSF component because the facelets API provides an interface that is easily integrated with.
Facelets technology offers the following features:
Facelets Tag Libraries
JSF uses various tags to express UI components in a web page. Facelets uses the XML namespace declarations to support the JSF tag library mechanism. All of these libraries are included in JDeveloper.
Table 11-10 Facelets Tag Libraries Included with JDeveloper
| Tag Library | URI | prefix | Example | Contains |
|---|---|---|---|---|
| JSF UI Tag Library | ui: | ui:component ui:insert | This tag Library is used for templating | |
| JSF HTML Tag Library | h: | h.head h.body h.outputText h.inputText | This tag library contains JavaServer Faces component tags for all UIComponent + HTML RenderKit Renderer combinations defined in the JavaServer Faces 2.0 Specification. | |
| JSF Core Tag Library | f: | f:actionListener f:attribute | This tag library contains tags for JavaServer Faces custom actions that are independent of any particular RenderKit. | |
| JSTL Core Tag Library | c: | c:forEach c:catch | JSTL 1.1 Core Tag Library | |
| JSTL Functions Library | fn: | fn:toUpperCase fn:toLowerCase | JSTL 1.1 Functions Tag Library |
Facelets support EL (expression language) based on the unified EL syntax defined by JSP 2.1. EL expressions are used to bind UI component objects or values or managed-bean methods or managed-bean properties. Note that for Unified EL in Facelets there is no difference between ${} and #{}.
To create a facelet:
What The Facelet Wizard Does
When you create a facelet the necessary classpath and deployment files are modified to use facelet technology in the following ways:
Example 11-4 Facelet Code Added to Your faces-config.xml
Example 11-5 Facelet Code Added to Your Web.xml
Example 11-6 Facelet Code Added or ADF
This is added to ensure you view your Facelets correctly, and not with the default JSP mappings. The facelets JAR, jsf-Facelets.jar is added to your classpath via the facelets runtime library.
JDeveloper provides a variety of tools and components to make converting and validating your JSF input data easier. There is a converter component to register a named converter instance, a convert number, and convert date and time all at your fingertips in the Component Palette.
You can configure your converter and validator properties in the Overview editor for your faces-config.xml file.
To register a JSF standard converter on a component using a supplied tag:
Example 11-7 Registered Standard Converter Code Sample
To register a JSF standard converter that does not have its own tag:
f:converter tag in the page. Instead of using the f:converter tag, you can use the Property Inspector to enter the converter ID on the component's converter attribute. Example 11-8 Registered Standard Converter Using a f:converter Tag within a Component Code Sample
Example 11-9 Registered Standard Converter Using a f:converter Attribute within a Component Code Sample
To register a JSF standard validator on a component using a standard tag:
Example 11-10 Registered Standard Validator Using a Supplied Tag Code Sample
To display a message next to the component that generated the conversion or validation error:
Example 11-11 Message Display Next To Component that Generated Conversion or Validation Error Code Sample
To register a custom converter or validator in the JSF application configuration file:
faces-config.xml file to open it in the JSF Configuration Editor. In the editor, click the Overview tab. To edit a custom converter or validator configuration in an application:
faces-config.xml file to open it in the JSF Configuration Editor. In the editor, click the Overview tab. To delete a custom converter or validator in the JSF application configuration file:
faces-config.xml file to open it in the JSF Configuration Editor. In the editor, click the Overview tab. To register a custom converter on a component using a converter identifier:
f:converter tag. You can use the Property Inspector to enter the registered converter ID. Example 11-12 Custom Converter with the f:converter tag, Code Sample
Example 11-13 Custom Converter using the Converter attribute, Code Sample
To register a custom converter on a component using a value binding expression:
f:converter tag to the component. Use the Expression Builder to enter a value binding expression. The bean property must be an object of a class that implements the converter interface. Example 11-14 Custom Converter Instance Using a Value Binding Expression, Code Sample.
To register a custom validator instance on a component:
Example 11-15 Registered Custom Validator Instance, Code Sample
To bind a component to a new validator method:
Example 11-16 Component Binded to a New Validator Method, Code Sample
JSF page with automatic component binding off:
Default validator method code:
JSF page with automatic component binding on:
Default validator method code:
JSF Standard Converters and Validator Tags and Syntax
All of the attributes supported by JDeveloper are shown in Table 11-11 and Table 11-12. Attributes in square brackets ([ ]) are not required. All accepted, predefined attribute values are separated with vertical bars (|); the default value is in boldface. For attributes that do not have a fixed set of accepted values, the values are shown in italics.
Table 11-11 JSF Standard Converter Tags
| Tag | Syntax |
|---|---|
| f:convertDateTime | <f:convertDateTime [dateStyle="default|short|medium|long|full"] [timeStyle="default|short|medium|long|full"] [pattern="pattern"] [type="time|date|both"] [locale="locale"] [timezone="timezone"] /> |
| f:convertNumber | <f:convertNumber [pattern="pattern"] [minIntegerDigits="min"] [maxIntegerDigits="max"] [minFractionDigits="min"] [maxFractionDigits="max"] [groupingUsed="true|false"] [integerOnly="true|false"] [type="number|currency|percent"] [currencyCode="currencyCode"] [currencySymbol="currencySymbol"] [locale="locale"] |
Create and define error messages using the Message component and the Property Inspector to define the attributes.
To display one error message next to a component that generated an error:
Example 11-17 Error Message Next To A Component, Code Sample
| Tip: To enable a component detail message to appear as a tooltip during runtime, set the message tag tooltip attribute to true. The tag showSummary and showDetail attributes must also be set to true. If you are using ADF data controls to create JSF forms and tables, the h:messages tag is automatically added, which displays all error messages by default. You don't have to add individual h:message tags manually. |
To display all error messages generated in a page:
Example 11-18 Display All Error Message, Code Sample
| Tip: Set the globalOnly attribute to true if you want to display only global messages which are not associated with components. If you're using ADF data controls to create JSF forms and tables, JDeveloper automatically adds the h:messages tag for you. You don't have to add the tag manually. |
To replace the standard message texts in JSF:
faces-config.xml to open it in the JSF Configuration Editor. Go to the Overview mode. model.login.Resources. h:message tag to display one error message, or h:messages tag to display all error messages. JSF first looks for messages in any registered resource bundle before looking into the JSF standard bundle. This lets you can override any JSF standard message by using the appropriate key in your resource bundle. For a list of messages see the JSF API javax/faces/Messages.properties. To add information about a form field to which a message refers:
PhaseListener implementation that retrieves and adds a generic attribute to a message. faces-config.xml to open it in the JSF Configuration Editor. Switch to the Overview mode, if necessary. To change the appearance of error messages in a JSF page:
ErrorClass attribute to the name of a style class defined in your CSS file. To do this, in the Property Inspector click the column next to ErrorClass, then select a style class. | Note: To use one or more inline styles, expand ErrorStyle in the Property Inspector; then enter or select a value next to the style you want to specify, e.g., background-color. |
Example 11-19 Changing The Appearance of Error Messages, Code Sample
You register JSF application resources such as managed beans, custom validators and converters, and define navigation rules in the application configuration file. Typically, this JSF configuration file is named faces-config.xml.
JSF allows more than one <application> element in a single faces-config.xml file. The overview editor for JSF configuration files only allows you to edit the first instance in the file. You'll need to edit the file directly using the XML source editor for any other <application> element.
You configure referenced beans in the faces-config.xml file. By declaring the bean in this file, design-time tools can understand beans that are not available at design time (such as data access) but will be available at runtime.
JDeveloper automatically creates a WEB-INF/faces-config.xml file when you create an application using one of the JSF web application templates. However, you can have more than one JSF configuration file. You might choose to do this if you need individual configuration files for separate areas of your application. Additionally, if you choose to have packaged libraries containing custom components and/or renderers, you need a separate faces-config.xml file for each library. For these, the configuration file is stored in the META-INF directory (as opposed to the WEB-INF directory).
To use the overview editor for configuration files to set the <application> element:
To add a bean to the configuration file using the JSF Configuration Editor:
faces-config.xml file. This file is located in the Web Content/WEB_INF directory. To manually add a bean to the configuration file:
faces-config.xml file. This file is located in the Web Content/WEB_INF directory. To create a new JSF configuration file:
web.xml, so that JSF reads it as part of your application configuration. .jar: faces-config.xml. META-INF. .jar file that you use to distribute your components or classes. Editing a JSF Configuration File:
faces-config.xml file. It is located in the WEB-INF node of the JSF project. JDeveloper has an Integrated WebLogic Server that enables you to run and test web applications from the IDE. No special connection setup is required. Run either the entire application project or individual JSF pages.
To run and test individual pages:
faces-config.xml), select the JSF page to run. To run and test an entire project:
To run a project, you must first specify a default run target. If you have not already done so, JDeveloper prompts you to enter a default run target the first time you run a project. You can also specify the default run target by editing the project properties.
When you run a JSF application from the IDE, JDeveloper automatically:
Launches the application in your default browser using the following default address : http://<your_machine_IP_address>:<http_port>/<ViewControler-context_root>/faces/
For example:
http://127.0.0.1:8988/myproject-ViewController-context-root/faces/home.jsp
Note that you can change the default application name and web context root in the project properties.
JDeveloper provides full support for developing with HTML technology in accordance with the HTML 4.01 W3C specification at http://www.w3.org/TR/html401/.
JDeveloper gives you a full set of integrated and synchronized design tools and components for creating and editing HTML pages. For information on the HTML Source Editor and Visual Editor see Section 11.1.1, "Getting to Know the Source Editor Features", and Section 11.1.2, "How to Work in the Visual Editing Environment".
To get started with you HTML web pages you first need to create a web application. To see the available application types go to Table 11-6, "Web Application Templates".
Once you have created your web application framework, you re ready to start building your HTML pages.
HTML Core Components
When you are building your HTML page use the Component Palette to click or drop and drag most of the commonly used tags into your page. JDeveloper features a commonly used set of HTML element tags as well as a set of form tags to add user input attributes and behaviors.
Figure 11-17 HTML Common Component Palette

Table 11-13 HTML Common Components
| Tag Name | Description |
|---|---|
| Anchor | Inserts a named anchor <A name> invisible element. |
| Applet | Embeds a Java applet in your page. |
| Email Link | Inserts an HTML <A> element in your page with the email address you provide. |
| Horizontal Rule | Inserts HTML <hr> element in your page at the current cursor location to display a horizontal line. |
| Hyper Link | Inserts a link to a HTML reference you define. |
| Image | Adds the HTML <img> element to insert an image into your page. |
| Line Break | Inserts a line break.. |
| Link | Inserts a link to an external style sheet or any other external document. |
| Noscript | Provides alternate content when a script is not executed using an HTML <noscript> element. |
| Script | Embeds the <script> element and custom code into the page. Use code for any scripting language including VBScript, Tcl, and JavaScript. |
| Style | Embeds an internal style sheet in the document. |
| Table | Inserts a skeleton HTML <table> tag. |
Figure 11-18 HTML Forms Component Palette

Table 11-14 HTML Forms Components
| Tag Name | Description |
|---|---|
| Button | Inserts an HTML <button> element with the type attribute specified, to create a push button. |
| Checkbox | Inserts the HTML <input> element with the type attribute specified, to create a checkbox control in a form. |
| Combo Box | Inserts a select element to define a form control for the selection of options. |
| Fieldset | Inserts a fieldset element that defines a form control group. By grouping related form controls, authors divide a form into smaller, more manageable parts, improving usability issues when confronting users with too many form controls. |
| File Field | Inserts an HTML <input> element with the type attribute specified, to create a file select control. The file select control creates a Browse button and field so a user can select files to be submitted with a form |
| Form | Inserts an HTML <form> tag to insert form processing information into your page. |
| Hidden Field | Inserts an HTML <input> element with the type attribute specified, to create a hidden control in a form. |
| Image Button | Inserts an HTML <input> element with the type attribute specified, to create a graphical submit button. |
| Input Button | Inserts an HTML <input> element with the type attribute specified, to create a push button. Push buttons have no default behavior. |
| IsIndex | Use to insert an HTML <isindex> tag to create a single-line text input control. This element has been deprecated. Authors should use the <input> element. |
| ListBox | Use the HTML <select> element to create a menu of choices represented by an <option> element |
| Password Field | Inserts an HTML <input> element with the type attribute specified, to create a password field. |
| Radio Button | Inserts an HTML <input> element with the type attribute specified, to create a radio button control in a form. |
| Reset Button | Inserts an HTML <input> element with the type attribute specified, to create a reset button; this resets all controls to their initial values. |
| Spinner | Inserts an HTML <select> element to create a menu of choices represented by an <option> element. A <select> element must contain at least one <option> element. |
| Submit | Inserts an HTML <input> element with the type attribute specified, to create a button that submits a form. |
| Text Area | Inserts an HTML <textarea> element to create a multiline text input field. |
| Text Field | Inserts an HTML <input> element with the type attribute specified, to create a text field. |
To create an HTML page:
The New Gallery wizard walks you through all of the necessary steps to build the web pages framework for your application.
To Save JSP Files as HTML:
You can save your JSP pages as HTML pages by opening your JSP file in the source editor and choosing File > Save as HTML.
The Save as HTML option saves a copy of your file with the HTML extension leaving the original file unchanged. The HTML file preserves text formatting so when it is viewed in a browser or as a snippet of code on a blog it looks the same as when viewed. The saved HTML file can be reopened and viewed as HTML, but it won't be understood as code.
Use Cascading Style Sheets (CSS) to control the style and layout of multiple web pages. CSS styles can define the formatting attributes for HTML tags, ranges of text identified by a class attribute, or text that meets criteria conforming to the Cascading Style Sheets (CSS2) specification. For more information on CSS, see the W3C web page at http://www.w3.org/TR/1998/REC-CSS2/.
For CSS Development, JDeveloper provides the following tools:
Table 11-15 lists the Cascading Style Sheet Source Editor features:
Table 11-15 CSS Source Editing Features
| Feature | Description |
|---|---|
| Code insight for CSS | Displays a list of HTML selectors, properties, values, pseudo-classes and pseudo-elements, for the CSS file under the cursor, to select an appropriate completion. For example, if you place the cursor just after the opening brace in a style rule, it displays a list of all possible properties to enter at that point in the file. |
| Reformat for CSS | Correctly reformats your code on that CSS page. Right-click on your file in the CSS editor or from the Application Navigator and choose Reformat. |
| CSS Error handling | Highlights invalid CSS properties, values, and missing semicolon and braces. |
| Stylesheet linking to HTML files | In the Component Palette, select the HTML palette, Common page, and link a stylesheet to your HTML files simply by dropping a Link element into your HTML page. Another option is to choose CSS in the Component Palette. The list of available CSS files displays in the Component Palette. You can then drag and drop any CSS file from the Componenet Palette to the page. |
| Style preview | See what your styles look like while you're coding. |
| Code colors | Easily spot properties, values, and keywords. |
| CSS Refactoring | Refactors across the application when you rename CSS files, class and ID attributes, or move, copy, and safe delete files. |
| Brace Matching for CSS Code Editor | Highlights the matching braces, brackets, and parentheses in the code editor based upon the cursor position. |
| Toggle Line Comments | Adds or removes comment markers from the beginning of each line in a selected block. Select a single line to comment or uncomment that line only. |
| Quick docs | Open the description from the W3C standard. |
When a CSS file is open for editing, CSS selectors in the file are displayed in the Structure window in the following type icons:
Element

The HTML element or tag defined by the CSS selector. Property and value are separated by a colon and surrounded by curly braces. For example: body {color:black;.}
Class 
Different styles defined for the same type of HTML element. For example p.right {text-align:right;} to define right-aligned paragraph text, and p.left {text-align:left;} to define left aligned paragraph text. You can also omit the tag name in the selector to define a style that will be used by all HTML elements that have a certain class. For example center {text-align:center;} defines all HTML elements with class="center" to be center-align.
ID

Style unique to one HTML element. For example p#para1 {color:green;} defines the p element that has the id value="para1" and *#ver905 {background-color:red;} defines the first HTML element with id value="ver905".
Tools For Grouping Elements
You can use the Categories dropdown list in the Structure window toolbar to show CSS selectors by categories.

No category
Displayed in order of appearance in the CSS file. Default setting.
Type Category
Arranged by CSS selector types: Element, Classes or ID.
Element category
Arranged by HTML element or tag.
Select a CSS selector in the Structure window to highlight the selector in the CSS file and display associated properties and values in the Property Inspector for editing.
Select the Separate Grouped Selectors icon to separate or ungroup the selector categories in the Structure window.

Select an element group and right click and select Comment Out , to comment out the selected element in your CSS file.

You can create your CSS stylesheet with a New Gallery wizard. Once created, drag and drop a stylesheet onto your web page to link the stylesheet. Use the soure editor with Code Insight to make changes directly in the CSS code, and edit your selector properties and values in the Property Inspector.
| Note: The Preview tab is located near the Source tab in the source editor. You can use it to see what the CSS formatting you have entered on the Source tab will look like. |
To create a simple Cascading Style Sheet:
To set or modify CSS selector properties and values:
To edit a CSS File in the Source editor:
{background-color: body {text: blue; {text-align:center; color:red; | Note: The Structure window displays any CSS syntax errors found as you edit.Double-click an error or element in the Structure window to edit it in the Source editor. |
Using the visual editor, use tables to lay out data on your HTML pages. Once you create a table you can easily modify both the appearance and the structure of the table. You can edit tables to add text and images; add, delete, resize, reorder, split, and merge rows and columns; modify table, row, or cell properties for color and alignment; copy and paste cells, and nest tables in table cell.
To add text to a table cell:
Using a table cell as the insertion point you can add and remove graphics or other UI and data elements to tables.
To remove content from one or more cells select cells:
Or
Note that only the contents of the cell, not the cell, will be removed from the table. If the entire row or column is selected, the table structure will be modified to remove the row or column along with the contents of the cell.
Set the properties of HTML tables, rows, columns, and cells using the design tools. Use the Property Inspector, the Edit Table dialog, or the visual editor toolbar to set table element properties.
When formatting tables with the design tools, you can define properties that apply to the entire table or to selected cells, rows, or columns in the table. When a property like background color or alignment is set with a value for the whole table and a different value for individual table cells, precedence in formatting is applied in the following order:
table cell, <td> tag table row, <tr> tag If you specify a background color of green for a single cell and then set the background color of the entire table to red, the green cell will not change to red, since the <td> tag takes precedence over the <table> tag.
To set table and cell properties using the Property Inspector:
| Tip: To quickly locate a property in a long list, click the search button in the Property Inspector toolbar. In the Find text field, type the name of the property, then press Enter. |
To set table and cell properties using the visual editor Toolbar:
<table>, <tr>, <td> in the Structure window. To resize a table, do one of the following:
<table> element in the Structure window, and then set the table width attribute in the Property Inspector. To change the size of rows or columns:
To add rows or columns to a table:
<td> element in the Structure window. To remove rows or columns in a table:
<td> element in the Structure window. You can also select one or more rows or columns in the visual editor or the corresponding <tr> element in the Structure window and do one of the following:
To merge table cells:
Or
From the main menu select Design and select Table, then click Merge Cells. The contents of the individual cells are placed in the resulting merged cell.
To split a table cell:
Or
From the main menu select Design and select Table, then click Split Cells.
To change the display order of rows, columns, or groups of table cells using the visual editor:
To change the display order of rows using the Structure window:
<tr> element you wish to change the order of in the table. The selected cells must be contiguous and form a rectangular region. To increase row or column span in a table:
<td> element in the Structure window. To reduce row or column span in a table:
<td> element in the Structure window. Use the design tools to add and format text on JSP or HTML pages. Use the Component Palette to add your HTML forms, and the Property Inspector and Structure window to manage elements and the configure properties for your HTML forms.
For your HTML graphics, use the Component Palette to easily add graphics to your pages, or you can drag and drop them from your Windows Desktop or Explorer. You can insert an image into a page, table, or form, or use an image as a background. Modify images to set image size, add a border, and set alignment on a page or in a table cell. Create interactive graphics, such as rollover images or navigation bars, by adding a JavaScript event to your image.
Use HTML forms on your HTML pages to interact with or gather information from users of your web pages. Forms are composed of:
To create a new HTML form:
With a JSP or HTML file open, do one of the following:
After creating the skeleton form, add form fields and buttons and specify form processing information. By default, forms are created with a Get form processing attribute.
When form fields or buttons from the Component Palette are added to the HMTL or JSP page, a <form> element is automatically inserted as a parent element.
To delete a form element:
Select the form in the visual editor or the corresponding <form> element in the Structure window, and do one of the following:
To insert a form field or button:
To delete a form field or button, do one of the following:
To edit form processing information using an Edit Form dialog:
<form> element in the Structure window, and select Edit > Tag. <form method="post" action="http://www.oracle.com/orderEdit.html" enctype="application/x-www-form-urlencoded" name="form1"></form>. To set form processing information using the Property Inspector:
Ctrl+Shift+I. | Tip: To quickly locate a property in a long list, click the search button in the Property Inspector toolbar. In the Find text field, type the name of the property, then press Enter. |
To change the form method from the context menu:
Use the visual editor to add and format text to your HTML files.
Use the toolbar in the visual editor to set text properties in your pages. Attributes set using the toolbar are marked with a green square in the Property Inspector. To undo changes, from the main menu select Edit > Undo action. To reset text properties to default values, select and delete the value from the Property Inspector.
To add text, do one of the following:
You can format inserted text using the Toolbar in the visual editor. The Toolbar applies manual or inline formatting in the page. For example
<H5><EM><FONT color="#ff0000">This is a Heading 5 in italics iUse the Toolbar to:n the color red</EM></FONT></H5>
HTML Toolbar Features
When editing your pages in the visual editor you can use the toolbar for formatting changes.
Use the tool bar to:
Formatting Text with CSS Features
You can also use Cascading Style Sheets (CSS) to automatically update text and page formatting within a page or across several web pages. CSS styles define the formatting for all text in a particular class or redefine the formatting for a particular tag such as h2 or I. Apply CSS styles with an external style sheet.
You can use CSS styles and manual or online HTML formatting within the same page. Manual HTML formatting overrides formatting applied by a CSS style. For complete information on CSS style sheets, see the W3C Cascading Style Sheets home page at, http://www.w3.org/Style/CSS.
To set text properties:
The JDeveloper design tools support the following graphic file formats:
To insert an image:
You can also drag an image from your Windows Desktop or Explorer to the desired location on the page. You will be prompted with an option to add the file to the directory based on current context in the Application Navigator. Click Yes for a Save Image dialog to add the image to the document root. The image will appear on your page.
To delete an image, do one of the following:
To resize an image, do one of the following:
Image properties set using the visual editor are marked in the Property Inspector with a green square. To return a resized element to its original dimensions delete the values in the width and height fields in the Property Inspector, or click the Reset Size button.
To move an image by dragging:
In the visual editor or Structure window do any of the following:
In the visual editor or Structure window do any of the following:
To use an image as a background:
<body> element in the Structure window. The Property Inspector displays the property values for the selected element. If the Property Inspector is not in view choose View > Property Inspector or Ctrl+Shift+I. This section covers JDeveloper support and tools for your user interface development using JavaServer Faces (JSP) technology within the Java EE platform.
JDeveloper provides a complete user interface development environment for Java Server pages (JSP) development in accordance with the JSP 2.1 specification defined at http://jcp.org/aboutJava/communityprocess/final/jsr245/index.html.
You can build your application from the ground up using the features provided in JDeveloper. The first thing you'll want to do is build a framework, or application template for your web pages. Get started quickly with your JSP projects using the application templates. Choose from a combination of technologies to include in your application as you build your application with the New Gallery Wizard. The application you choose determines the project folders created and the libraries added to the folders as shown in Table 11-6.
JDeveloper comes with a Component Palette stocked with standard JSP components that you can easily drag and drop onto your JSP pages as shown in Figure 11-21 and Table 11-16.
Table 11-16 JSP Core Components
| Tag | Description |
|---|---|
| Attribute | Defines the value of a tag attribute in the body of an XML element instead of in the value of an XML attribute. |
| Body | Specifies the body of the tag. |
| Declaration | Declares a method or variable valid in the scripting language used in the JSP page. |
| EL Expression | Contains an expression in the JSP Expression Language (EL) to provide easy access to application data stored in JavaBeans components. |
| Element | Dynamically defines the value of the tag of an XML element. This action can be used in JSP pages, tag files and JSP documents |
| Expression | Contains an expression valid in the scripting language used in the JSP page. The expression is evaluated, converted to a String, and inserted into the response where the expression appears in the JSP page. |
| Fallback | Displays a text message if the dialog to initiate the download of plug-in software fails. A translation error will occur if the element is used elsewhere. |
| Forward | Forwards the request object containing the client request information from one JSP page to another resource. The target resource can be an HTML file, another JSP page, or a servlet, as long as it is in the same application context as the forwarding JSP page. |
| GetProperty | Gets a bean property value using the property's getter methods and insert the value into the response. |
| Hidden Comment | Documents the JSP page without inserting the comment in the response. |
| Include | Sends a request to an object and include the result in a JSP file. |
| Include Directive | Inserts a static file of text or code in a JSP page at translation time, when the JSP page is compiled. |
| Page Directive | Defines attributes that apply to the entire JSP page. |
| Param | Passes one or more name/value pairs as parameters to an included resource. |
| Params | Provide key value information. |
| Plugin | Executes an Applet or JavaBean in the specified plugin. |
| Scriptlet | Inserts a code fragment valid in the page scripting language. |
| SetProperty | Sets a property value or values in a JavaBean |
| Taglib Directive | Defines a tag library and prefix for the custom tags used in the JSP page. |
| UseBean | Locates or instantiate a JavaBean with a specific name and scope. |
The New Gallery wizard walks you through all of the necessary steps to build the web pages for of your application.
To create a new JSP page:
web.xml is also added to your project. The deployment descriptor file is used by the Integrated WebLogic Server when you run the JSP. The Create Servlet Filter wizard available from the Web Tier category in the New Gallery creates a new filter you can use to process requests or responses to or from your JavaServer Page.
To register a servlet filter in a JSP page:
A new servlet filter is generated and appears in your active project. The deployment descriptor file web.xml is updated with the <filter> element. The deployment descriptor file is used by the embedded web server in JDeveloper when you run the JSP.
Web applications implement flow control by directing the display content of the web browser in response to specific user actions. Typically, web application developers create separate JSP pages or sets of pages for each task the application provides. The user makes choices in one page and clicks a link to submit their choices on the Request object. The link they click directs the Request object to the page responsible for handing the action.
How Can I Handle Flow Control in JDeveloper?
You decide the way your application handles the Request object. JDeveloper supports various options for implementing JSP page flow control:
Or
What Features Can I Use for These Approaches?
The following approaches are supported:
JDeveloper supports deploying Web applications on any Java EE application server through the creation of a Web Module Archive (WAR). There is additional support for deployment to Integrated WebLogic Server.
To debug a JSP:
JDeveloper performs the following functions when debugging a JSP:
http://<your_machine_IP_address>:<http_port>/<context_root>/<path_to_JSP>
for example:
http://127.0.0.1:8988/Project1-context-root/untitled1.jsp
To create a web deployment descriptor:
Or, to add the web deployment descriptor file yourself:
In the New Gallery Categories tree, expand General and select Deployment Profiles. In the Items list, select web.xml (Web Deployment Descriptor). Click OK.
If the desired item is not enabled, check to make sure the project does not already have a web deployment descriptor: a project may have only one instance of a descriptor.
To inspect or change web deployment descriptor properties:
To edit a web deployment descriptor as an XML file:
WEB-INF folder. The Integrated WebLogic Server is responsible for running JSPs. After building your JSP, you can run it in a few easy steps.
To run a JSP:
The JSP is launched.
JDeveloper performs the following functions when a JSP is run.
http://<your_machine_IP_address>:<http_port>/<context_root>/<path_to_JSP> for example,
http://127.0.0.1:8988/Project1-context-root/untitled1.jsp.
Dynamically Modifying JavaServer Pages Files While Running
When running your JSP in the Integrated WebLogic Server, you can modify and view changes that you make to your JSP files without having to restart WebLogic Server. To view changes in your browser, you can either reload the page from the browser or you can run the page again in JDeveloper because the WebLogic Server is able to change only the file, running from JDeveloper is much faster than reloading the page from the browser.
Running JSPs with ADF Business Components Application Modules
If you are running JSPs with business components application modules in both the Integrated WebLogic Server and in a remote server instance, and have two JSPs contained in two different projects that depend on the same middle tier project, you must declare that middle tier is running inside of a WebLogic Server instance with the jbo.server.in_wls=true property.
Working with Timestamps on Source JSPs
When developing, compiling, and running JSPs, if the timestamp of a source JSP file is ever changed to an earlier timestamp, the JSP will not automatically be recompiled by JDeveloper or by WebLogic Server. It must be forced to recompile. To force recompilation, right-click on the JSP and select Rebuild, use Build->Rebuild , Build->Rebuild All, Build->Clean , or Build->Clean All.
Timestamps can go backwards in time when using source control systems (restoring an older version) or using timestamp preserving copy commands like xcopy or mv.
A JSP fragment is a JSP page that can be included in another JSP page.
JSP segments use .jspf as a filename extension. By default JSP fragment files are placed with the rest of the static content in the web application folder. JSP segments that are not complete pages should always use the .jspf extension.
JSP segments are defined using JSP syntax as the body of a tag for an invocation to a SimpleTag handler, or as the body of a <jsp:attribute> standard action specifying the value of an attribute that is declared as a fragment, or to be of type JspFragment in the TLD.
A servlet is a platform-independent, server-side Java component used to extend the capabilities of a web server. Using servlets, you can dynamically tailor content, function, and the look and feel of your web pages. Servlets process client requests and can respond by returning any MIME type to the requesting client, including images, XML, and HTML. Servlets run inside web servers, so they do not require a graphical user interface. They are typically used to dynamically generate HTML content and present it to the requesting client. You can think of a servlet as the server-side counterpart to an applet.
Servlets are based on a standard API and protocol defined by JavaSoft. To run a servlet, your environment needs a web server that supports the JavaSoft servlet API, such as Oracle WebLogic Server, JavaSoft Java Server, and Apache Tomcat, among others. JDeveloper provides support for servlet filters and listeners (Servlet API 2.5). When you use the Create Filter wizard and Create Listener wizard, it updates the web.xml with filter and listener entries. The web.xml can also be manually edited to include or modify these entries.
For more information, see the Oracle Fusion Middleware Developing Web Applications, Servlets, and JSPs for Oracle WebLogic Server.
Servlets are often used to process HTTP requests submitted by a client, and to provide dynamic content by returning results of a database query to a client. This type of Java servlet is known as an HTTP servlet. A typical runtime scenario for an HTTP servlet is as follows:
A filter is a reusable piece of code that can transform the content of HTTP requests, responses, and header information. Filters do not usually create a response; instead you use filters to modify the requests or responses, or to perform some other action based on the requests or responses, including:
By default, the Create Servlet Filter wizard available from the Web Tier Servlets category in the New Gallery creates a filter that dynamically intercepts requests and responses to transform or use the information contained in the requests or responses.
A listener can be used to monitor and react to events on a servlet's life cycle by defining listener objects whose methods get invoked when life cycle events occur. Application event listeners are classes that implement one or more of the servlet event listener interfaces. Servlet event listeners support notification for state changes in the ServletContext and HttpSesion objects, specifically:
You can have multiple listener classes listening to each event type and specify the order in which the container invokes the listener beans for each event type.
The Create Servlet Listener wizard available from the Web Tier > Servlets category in the New Gallery creates a new listener you can use with your servlet or other web components; you can run this wizard multiple times to create additional listeners.
WEB-INF folder. This wizard will create the servlet for you based on information you specify, including the methods and parameters for the servlet. Click the Help button to obtain context-sensitive help in the wizard panels.
A simple servlet is generated and appears in your active project. The deployment descriptor file web.xml is also added to your project. The deployment descriptor file is used by the Integrated WebLogic Server in JDeveloper when you run the servlet.
When you use the Create HTTP Servlet wizard to create an HTTP servlet, the wizard creates a Java class for the servlet. This class contains an initialization method and the HTTP methods you specified for the servlet when using the wizard. To customize the servlet, you must implement the servlet's HTTP methods.
The following methods are available from the Create HTTP Servlet wizard:
doGet handles GET, conditional GET, and HEAD requests. doPost handles POST requests. doPut handles PUT requests. doDelete handles DELETE requests. service handles Service requests. JDeveloper creates skeleton code for these methods. These methods take two objects as arguments HttpServletRequest and HttpServletResponse. You can also pass in additional parameters and get them programmatically by calling the ServletRequest.getParameter method within your servlet's Java code.
The first HTTP argument in a basic servlet method is an HttpServletRequest object. This object provides methods to access
The methods you call when implementing your servlet methods depend on the kind of HTTP request the servlet will receive. Table 11-17 summarizes the relationship between the possible kinds of HTTP requests and the corresponding methods you should use when implementing your servlet methods.
Table 11-17 Types of HTTP Requests
| Possible Client HTTP Requests | Corresponding Client Data Access Methods and Techniques to Use in Your Servlet Code |
|---|---|
| Any HTTP request | Use the |
| HTTP GET request | Use the |
| HTTP POST, PUT, and DELETE requests | In general, use the |
The second HTTP argument in a basic servlet method is an HttpServletResponse object. This object encapsulates the information from the servlet to be returned to the client. This object supports the following ways of returning data to the client:
getWriter method) getOutputStream method) You can also send a cookie in the response using the addCookie method.
To change the HTTP Response Type:
By default, the Create HTTP Servlet wizard creates a servlet that dynamically generates HTML content (MIME type: text/html). You can change to another MIME type by selecting the desired type from the Generate Content Type dropdown in the Create HTTP Servlet wizard. The wizard adds the setContentType method in the servlet's Java file with the selected type to set. For example, if you choose the XML content type, the wizard generates:
The Create Servlet Filter wizard available from the Web Tier - Servlets category in the New Gallery creates a new filter you can use to process requests or responses to or from your servlet or JavaServer Page.
To create a servlet filter:
The Create Servlet Filter wizard will create the servlet filter for you based on information you specify, including the implementation class and initialization parameters. Press F1 or click Help to obtain context-sensitive help in the wizard.
A new servlet filter is generated and appears in your active project. The deployment descriptor file web.xml is updated with the <filter> element. The deployment descriptor file is used by the Integrated WebLogic Server in JDeveloper when you run the servlet or JSP.
The Create Servlet Listener wizard available from the Web Tier - Servlets category in the New Gallery creates a new listener you can use with your servlet or other web components.
To create a servlet listener:
The Create Servlet Listener wizard creates the servlet listener for you based on information you specify, including the implementation class and interface. Press F1 or click Help to obtain context-sensitive help in the wizard.
A new servlet listener is generated and appears in your active project. The deployment descriptor file web.xml is updated with the <listener> element. The deployment descriptor file is used by the Integrated WebLogic Server in JDeveloper when you run the servlet.
The Create Servlet Filter wizard available from the Web Tier category in the New Gallery creates a new filter you can use to process requests or responses to or from your JavaServer Page.
To register a servlet filter in a JSP page:
This will start the Create Servlet Filter wizard which will create the servlet filter for you based on information you specify, including the implementation class and initialization parameters. Press F1 or click Help to obtain context-sensitive help in the wizard panels.
A new servlet filter is generated and appears in your active project. The deployment descriptor file web.xml is updated with the <listener> element. The deployment descriptor file is used by the Integrated WebLogic Server in JDeveloper when you run the JSP.
A servlet is a Java program that runs in a Java EE application server. Think of a servlet as the server-side counterpart to a Java applet. The Integrated WebLogic Server is responsible for running servlets in JDeveloper.
As an alternative to running your servlets inside the Integrated WebLogic Server, your servlet can contain a main() routine that lets you run the servlet class as an application. That declaration is: public static void main(String[] args)
This is useful when you want to test servlet classes without running under the Oracle WebLogic Server.
To run a servlet:
After building your servlet, you can run it by executing the run command in one of the following ways:
Select the option you desire, then click OK.
JDeveloper performs the following functions when a servlet is run in Integrated WebLogic Server:
http://<your_machine_IP_address>:<http_port>/<context_root>/servlet/<servlet_full_class_name>
For example :
http://127.0.0.1:8988/Project1-context-root/servlet/package1.Servlet1
You can debug a servlet using the embedded Integrated WebLogic Server in JDeveloper. The Debug command attempts to debug the selected Java file containing your servlet. In JDeveloper, you can set breakpoints within servlet source code and the debugger will follow calls from servlets into JavaBeans.
To debug a servlet:
When you debug a servlet, JDeveloper opens the default Web browser and invokes the servlet.
JDeveloper performs the following functions when a debugging a servlet:
http://<your_machine_IP_address>:<http_port>/<context_root>/servlet/<servlet_full_class_name>
For example :
http://127.0.0.1:8988/Project1-context-root/servlet/package1.Servlet1
JDeveloper supports deploying your Servlet applications on any Java EE application server through the creation of a Web Module Archive (WAR).
For more information, see the Oracle Fusion Middleware Developing Web Applications, Servlets, and JSPs for Oracle WebLogic Server.
JDeveloper provides scripting functionality including support for basic JavaScript when working with JSP and HTML pages. This section discusses support in Oracle JDeveloper for script languages, how to work with script languages, and how to refactor JavaScript code.
JDeveloper supports script languages, specifically JavaScript and JSON, by offering code insight, breadcrumb support, and the JDeveloper structure pane. JDeveloper JavaScript Code Insight completes labels, variables, parameters and functions when typing inside a script region, or inside an HTML event handler. Breadcrumb support displays the location of a selected JavaScript function in the hierarchy as you work on the file. And the Structure Pane shows the hierarchy of functions defined in the file, and also of the variables defined in the functions.
The JDeveloper JavaScript Code Insight completes labels, variables, parameters and functions when typing inside a script region, or inside an HTML event handler.
The JavaScript Code Insight feature displays a dynamic list of possible completions for a given JavaScript function at the bottom of the editing pane. As you type, the Code Insight feature will display a list of possible values appropriate to the values you have already typed. To see a list of possible entries that have already been used or defined in your project, click on the drop-down arrow and then select Show.
JavaScript Code Insight is available when editing an .html, .jsp, or .jspx source file, or an included .js file for both user-defined and built-in JavaScript functions. The assist window displays any referenced .js files as well as any .js file in the project not yet included.
In a normal JavaScript Code Insight invocation, a large list of potential properties may display. However, you can invoke JavaScript Smart Code Insight in the source editor by pressing Ctrl-Alt-space. JDeveloper then attempts to smartly figure out the type of the object on which insight is invoked, and then show only those properties.
The JavaScript Code Insight feature creates templates for the following elements.
To invoke Code Insight:
Type the JavaScript element or its abbreviation:
case for foreach if ife (if-else) sw (switch) wh (while) fori (for loop with range) try trycf tryf al (alert) fn (function) fne (function-expression) dne (do-while loop) JavaScript Code Insight is DOM-based and browser-aware, displaying one or more browser icons for Internet Explorer, Mozilla, or Safari, to indicate browser support for a method or variable.
When you are editing a JavaScript file in the Source Editor and have the cursor located in a function, JDeveloper displays a breadcrumb trail in the lower margin of the Source Editor window.
This breadcrumb trail shows the position of this function in the JavaScript hierarchy, along with its subelements such as methods, parameters, and such. JDeveloper also displays breadcrumbs for if, if-else, do, while, for, and try/catch/finally (just as it does for Java).
To explore available functions within the hierarchy:
While you are editing a JavaScript file, JDeveloper tracks the location in the structure of the project or application you are building and displays it in the Structure Pane.
The Structure Pane shows the hierarchy of functions defined in the file, and also of the variables defined in the functions.
To find a location in the code editor from the Structure Pane:
Working with script languages not only includes the direct use of script elements inside an HTML or JSP page, but also involves using references to script files which are associated with the overall application.
The JDeveloper code editor provides a syntax highlighting feature which assists in determining the proper code for a script or script-language element.
Other elements of working with script languages include creating a JavaScript Object Notation (JSON) file.
You can create a client-side script to include or embed in an HTML or JSP page.
To create a script in JDeveloper:
text/javascript, text/tcl, text/vbscript) and enter the script code. For additional assistance, press F1 or click Help in the dialog. A script element that references the external script file is embedded in the page similar to the following:
<script language="JavaScript" src="foo.js"></script>
or
The script code is embedded in the page and visible from the Source editor similar to the following:
<SCRIPT type="text/vbscript">
<!--
>Sub foo()
...
End Sub
' -->
</SCRIPT>
JDeveloper provides basic JavaScript support when working with HTML and JSP pages. In addition to drag and drop support, you can change the text presentation of the JavaScript code in the Java Code Editor and associate file extensions for JavaScript file recognition in JDeveloper.
To insert a JavaScript into a JSP or HTML page:
.js) file. The JavaScript file appears in the Application Navigator below the HTML or JSP project's Web Content folder.
JDeveloper creates a script element that references the JavaScript file.
| Note: You can also import a JavaScript file into the project. |
Syntax highlighting is a JDeveloper feature that lets you more easily identify syntax elements (such as brace matching) while you are editing Java, JavaScript, and JSON files.
To set syntax highlighting options for JavaScript in the Code Editor:
The display on the page changes to reflect the JavaScript style settings.
For detailed help on any field, press F1 or click Help.
When you return to work in the Java Code Editor, JavaScript syntax is highlighted according to these style settings.
By default, JDeveloper recognizes files with the .js file extension as JavaScript. You can associate any other file extension for JDeveloper to recognize.
To add or remove file extensions for JavaScript file recognition in JDeveloper:
.js file extension is associated. Click Add to create a JavaScript file extension.
In the Add Extension dialog, enter the file extension you want to associate to a JavaScript file.
For detailed help on any field, press F1 or click Help.
When you open a file with any of these extensions, JDeveloper recognizes the file as JavaScript.
You can create a JSON (JavaScript Object Notation) file in JDeveloper. A JSON file allows you to pass structured data easily between applications or between files within an application, in a lightweight format that is easily readable by humans and easily interpreted by dozens of programming languages.
To create a JSON file:
File Name
The name of your JSON file. By default, this is untitled.json. The .json extension makes it possible for other parsers to read the JSON format of the data inside your file.
Directory
The pathname in your local file system for storing the JSON file.
Browse
Opens the file system browser for selecting a path in your local file system.
The JSON file is now available to be edited in JDeveloper. Use the normal functions of the JavaScript editor to add content.
JDeveloper provides support for renaming references to a function or variable. JDeveloper also replaces all occurrences of function names with the new name when you perform delete operations. This method of renaming and replacing function names is known as refactoring.
Refactoring is an editing technique that modifies code structure without altering program behavior. A refactoring operation is a sequence of simple edits that transforms a program's code but keeps it in a state where it compiles and runs correctly. JDeveloper provides a collection of automated refactoring operations for JavaScript code and files.
Use refactoring when you modify a program's source code to make it easier to maintain, extend, or reuse. Perform the modification as a series of refactoring steps. After each step you can rebuild and revalidate the program to insure that no errors have been introduced.
JDeveloper supports these refactoring operations for JavaScript code and files:
You can search within a JavaScript file for specific usages of code elements such as functions, variables and labels. This allows you, when refactoring, to determine where an element is used so that you can safely change it, or choose not to.
To search in a JavaScript file for a function, variable or label:
JDeveloper will search through the JavaScript file for the element you have selected.
You can make two optional selections while searching for the element:
Select this if you want JDeveloper to search inside comments for the variable, label or function name. This can be useful if you have commented out a section of code that you plan to restore at a later date, or if you simply want to ensure that the comments reflect the updated name of the element involved in the refactoring.
Select this if you want JDeveloper to display the results of the search in a new tab. If you do not select this, JDeveloper displays the results in the Log window.
While working with JavaScript code you can easily rename the definition and all references to a function or variable. If you wish, you can first generate a preview — a list of the usages that will be replaced. Use the preview to inspect and modify or exclude selected usages, before causing the rest to be renamed.
The scope of a renaming operation is the full scope of the element in the project. Function usages are replaced anywhere they appear in the project. Variables are renamed only in the lexical scope of their definitions; other elements with the same name are not modified.
By default, the operation will be run on JavaScript files, excluding comments (but not documentation comment tags that name code elements) and annotations. Usages that are not ambiguous will be replaced.
To rename a code element:
or
or
While developing your JavaScript code, you can safely delete the definition of a function, label or variable. The deletion will not be performed without your confirmation if the element is still in use.
If the element is in use, a log showing the usages will be displayed. Use the list to inspect and resolve the usages. If you then confirm the deletion, any remaining usages will remain in the code as undefined references.
To delete a code element:
or
or
The Delete Safely dialog will open while the project files are searched for usages.
or
When performing a refactoring operation that may modify many usages, it is useful to preview the refactoring to identify those usages that should be modified by hand or be excluded. You have the option, before committing these operations, of having usages listed in the Preview Log window, from which you can inspect and resolve them. Once you have confirmed the modifications, you can commit the operation.
The log displays a collapsible tree of packages and Java files. Under each file, the log displays lines of code containing modified usages. For more information about the Preview window, press F1.
To view a usage in an Edit window:
To exclude a usage from the refactoring operation:
To commit the refactoring operation:
Often when editing JavaScript, you can lose sight of the initial scheme for indentations, braces, and other visual cues that help you maintain a sense of the scope of the operation you are editing and where it fits in the overall structure of the function. To aid clarity, JDeveloper can reformat your JavaScript code, causing parallel elements to line up and make it easier for you to find visual cues to the parts of the function you are editing. In addition, reformatting removes extraneous line breaks and other whitespace from the JavaScript, rendering it more compact, which can improve the efficiency of deployment by reducing file size.
To reformat a section of JavaScript code:
The selected section of JavaScript code is reformatted. When you save the file, the code will be saved in the new format.
You can customize the code editor look and feel, general behavior, and Code Insight and Java Insight options.
To change code formatting preferences
| Note: From this dialog, you can also choose options for editing Java files in the Java source editor. Your selections apply to JavaScript as well as Java files. |
You can also reformat a .js file if you have made modifications that affect readability or file size. In addition, code folding can help with readability, as it lets you concentrate only on specific areas of the file by "folding" selected logical elements (such as function definitions) of the file. When folded, only the initial few key words of the code element (such as the name of the function being defined) are displayed; the rest are indicated by ellipsis (...) after the initial keywords.
To use code folding:
This folds the code in the selected element, and changes the - sign to a +.
To unfold a section of code:
Note that all JavaScript code formatting and highlighting features, as well as code folding, also apply if you are editing or creating a JSON file.
When you move a file, references to that file need to change throughout your application. JDeveloper helps with this task during refactoring by changing references in the <script src=...> tag.
To refactor and move a JavaScript function:
On completion of the refactor, JDeveloper updates the <script src=...> tag in all HTML files affected by the refactoring.
JDeveloper supports both JSP 2.0 and JSP 1.2, and Facelet 2.0 custom tag libraries, which enable the development of reusable modules called custom actions. Form processing, accessing databases or email, and flow control are examples of tasks that can be performed by custom actions. To invoke a custom action, you use a custom tag inside a JSP page. A collection of custom tags forms a custom tag library. A tag library descriptor (.tld) file is an XML document that describes your tag library and each tag in it.
There are several tools to simplify the task of creating new JSP or facelet custom tag libraries as well as importing and registering custom tag libraries from another source. Custom tag libraries are supported by JDeveloper Code (tag) Insight and can be added to the Component Palette. When working with custom tag libraries you can create custom tag libraries and tags. Register custom tag libraries in order to invoke Code (Tag) Insight for the tags while you are editing pages in the Java Code Editor. Add customized pages to the Palette to display the available tags on the Palette while you are editing pages.
The tags are common to many JSP or facelet applications. There is support for core iteration and control-flow features, text inclusion, internationalization-capable formatting tags, and XML-manipulation tags. Such standardization lets you learn a single tag and use it on multiple containers for easy recognition and optimization across containers. Using the expression language (EL) and a set of four standard tag libraries, JSTL lets you develop dynamic, Java-based web sites.
With JSTL, using the Business Components Data Tag library is simpler since tags such as <jbo:showvalue> and <jbo:rowsetiterate> are no longer required. Instead of spending time on coding these common operations, you can focus on developing tags and web pages that are specific to your own web application project.
You can manage your libraries, including locating the source for your tag libraries by going to Tools > Manage Libraries > JSP Tag Libraries or Facelets Tag Libraries.
Tag support includes these custom tag libraries that you can use to create JSP or Facelet pages:
http://myfaces.apache.org/core20/myfaces-impl/tlddoc-facelets/ui/tld-summary.html http://myfaces.apache.org/trinidad/index.html. http://jdevadf.oracle.com/adf-richclient-demo/docs/enhanced-tagdoc.html#Components. After you create a custom tag library, you can reuse it in other applications you are developing. JDeveloper includes a tag library as part of a deployment descriptor when you use it in an application.
To add, delete, or edit project level tag libraries
To browse to a JSP tag library descriptor (TLD) file:
<%@ taglib. To browse pages or individual JSP tags:
To create a custom tag library, you will create the tag library descriptor file and then create simple tags or component tags. A tag library descriptor file (TLD) is an XML document that describes your tag library and each tag in it. It is used by a container to validate the tags. Once you create tags, you can add attributes and scripting variables to them.
To create a custom JSP or facelets tag library:
To add pages and JSP or facelets tags to the Component Palette:
To modify a custom TLD file using the Tag Library Descriptor property editor:
To edit a TLD file in the XML Source Editor:
| Tip: To edit a TLD file with the Component Palette, choose View > Component Palette to open the Palette and select Tag Lib or one of the available pages from the dropdown list. Then choose elements from the page. |
To register a JSP or facelet custom tag library:
To add a scripting variable to a tag:
Tag.java or WebTag.java file. To deploy your custom JSP tag library or facelets tag library as a JAR File:
This chapter describes how to use JDeveloper tools to build the business tier of a J2EE enterprise application using Enterprise JavaBeans (EJB) 3.0 and Java Persistence API (JPA) components.
This chapter includes the following sections:
JDeveloper includes step-by-step wizards for creating EJB projects, entities, persistence units, session beans, and message-driven beans. You can build entities from online or offline database definitions and from application server data source connections. There is also seamless integration with JPA and TopLink technology to provide a complete persistence package.
JDeveloper supports EJB 3.0, as well as versions 1.0 through 2.1. The current JDeveloper documentation, including this chapter of the User Guide and the embedded online help, focus on EJB 3.0 development tasks.
Previous versions of the JDeveloper documentation tell how to work with EJB 2.1 and earlier. For those versions of the documentation, see http://www.oracle.com/webapps/online-help/jdeveloper/10.1.3 and search for and navigate to the topic "Developing Enterprise JavaBean Components." Be aware that EJB application development interfaces may change from version to version, and some historical help content will be outdated for the current version.
For the complete EJB Java Community Process specifications and documentation for all versions, see the Oracle Technology Network at http://www.oracle.com/technetwork/java/docs-135218.html.
| Note: If you are using EJB 3.0, you may be using annotations instead of some deployment files. Include deployment descriptors to override annotations or specify options not supported by annotations. |
Supported EJB 3.0 Features
The key differences between EJB 3.0 and previous versions are:
javax.ejb.EnterpriseBean interfaces. The EJB bean class can be a pure Java class (POJO), and the interface can be a simple business interface. The bean class implements the business interface. create() method on EJB and can now directly invoke a method on the EJB. Session Beans
javax.ejb.SessionBean interfaces. The home interface is optional. A session bean has either a remote, local, or both interfaces and these interfaces do not have to extend EJBObject or EJBLocalObject. @Stateless or @Stateful to specify the bean type. Message-Driven Beans (MDBs)
javax.ejb.MessageDriven interface; they implement the javax.jms.MessageListener interface. @MessageDriven for specifying the bean type. Entities - Java Persistence API (JPA)
EntityManager API that is used to create, find, remove, and update entities. The EntityManager API introduces the concept of detachment/merging of entity bean instances similar to the Value Object Pattern. A bean instance may be detached and may be updated by a client locally and then sent back to the entity manager to be merged and synchronized with the database. JDeveloper includes a complete set of features to set up the EJB business layer of an enterprise application.
You can start by using the step-by-step wizard to create the framework for your EJB web application, setting up the model layer of your enterprise application. You can then use wizards to create entities that correspond to database tables. You can then use a wizard to create session beans and facades and to build a persistence unit. Oracle ADF provides components to enable data controls. When you are ready, you can use the JDeveloper integrated server capabilities to test it.
JDeveloper includes tools for developing EJB applications, as described in the following sections.
Use the entity wizards to create entities or to create entities from tables using online, offline, or application server data source connections. Use the Entity Beans from Tables Wizard to reverse-engineer entities from database tables. In the entity wizards you can select or add a a persistence unit and a database connection, or you can select a database to emulate. You can also select database tables for your entity. For more information, see Section 12.6.2, "How to Create JPA Entities".
You can create entities from existing tables, or manually in the Java Source Editor. If you create entities from existing tables, the mapping is done automatically. If you create entities manually, you have more control over the mapping, but you must code it by hand. You can create entities using wizards or by using an EJB diagram.
You can use session beans to implement the session facade design pattern. A session facade aggregates and presents data, provides a place for business logic, and has a transactional context via the container. For more information, see Section 12.7, "Implementing Business Processes in Session Beans" and Section 12.7.1, "Using Session Facades".
When you create a session bean with the wizard, you have the option of generating session facade methods for every entity in the same project. You can choose which core transactional methods to generate, get() and set() accessors, and finder methods on the entities. If you create new entities or new methods on entities, you can update your existing session facade by right-clicking it in the Navigator and choosing Edit Session Facade.
JDeveloper provides Oracle WebLogic Server as a container for deployed EJBs. A JDeveloper server-specific deployment profile is generated by default. You can also create a WebLogic-specific deployment profile. For more information, see Section 12.9, "Deploying EJB Modules and JPA Persistence Units".
JDeveloper can also create a sample client for use with a remote server. You generate the sample client in the same manner as a local client, providing the remote connection details. For more information, see Section 12.10.2, "How to Test EJB/JPA Components Using a Remote Server".
ADF provides components for enabling data controls for your entities. Your Java EE application integrates selective components as you manually add a data control for your entities. For more information, see "Using ADF Model Data Binding in a Java EE Web Application" in Oracle Fusion Middleware Java EE Developer's Guide for Oracle Application Development Framework.
Create a model business services layer for a web-based EJB 3.0 application.
To create a web-based application:
A list of available applications appears. For EJB projects you can choose to build either a custom application or the Java EE Application. The Java EE Application creates an EJB/JPA data-bound web application.
To create JPA entities:
persistence.xml, or click New to create a new persistence grouping within the existing META-INF/persistence.xml file. To implement a session facade:
When you get to the EJB Name and Options page, be sure to check Generate Session Facade Methods.This automatically adds the session facade methods to your session bean. Note that you can create and edit session facade methods for all entities in your project by right-clicking your session bean and choosing Edit Session Facade. JDeveloper automatically recognizes new entities in your project and new methods on the entities.
To register the business services model project with the data control:
This creates a file called DataControls.dcx which contains information to initialize the data control to work with your session bean.
To run and test your application:
To deploy your application:
The integrated server runs within JDeveloper. You can run and test EJBs using this server and then deploy your EJBs with no changes to them. You do not need to create a deployment profile to use this server, nor do you have to initialize it. Create the deployment descriptor, ejb-jar.xml using the Deployment Descriptor wizard, and then package your EJB modules for deployment with your application.
The Java EE design patterns are a set of best practices for solving recurring design problems. Patterns are ready-made solutions that can be adapted to different problems, and leverage the experience of successful Java EE developers.
JDeveloper can help you implement the following Java EE design patterns in your EJB applications:
The persistence tier is the part of your EJB application that contains all of the persistent data object that represent tables in a database. These business components are called JPA entities since the entity model introduced in EJB 3.0 is defined in the Java Persistence API.
JPA entities adopt a lightweight persistence model designed to work seamlessly with Oracle TopLink and Hibernate.
The major enhancements with JPA entities are:
JPA entities are now POJOs (Plain Old Java Objects) and there are no component interfaces required for them. JPA entities support inheritance and polymorphism as well.
Example 12-1 contains the source code for a simple JPA entity.
Example 12-1 Source code for a simple JPA entity
Note that the bean class is a concrete class, not an abstract one, as was the case with CMP 2.x entity beans.
The O-R mapping annotations allow users to describe their entities with O-R mapping metadata. This metadata is then used to define the persistence and retrieval of entities. You no longer have to define the O-R (object Relational) mapping in a vendor-specific descriptor.
The example above uses the @Entity, @Table, and @Column annotations to specify at the class level that this is an entity, and to specify the underlying database table and column names for the entity. You can also use mapping annotations to define a relationship between entities, as shown in Example 12-2.
Inheritance is very useful in many scenarios. The two types of inheritance that are commonly used and supported by Oracle Application Server for JPA entities are:
The inheritance can be expressed using annotations. Example 12-3 contains code that uses the joined sub class strategy.
Example 12-3 Joined Subclass Strategy
The javax.persistence.EntityManager API is used for CRUD (Create, Read, Update, and Delete) operations on entity instances. You no longer have to write code for looking up instances and manipulating them. You can inject an instance of EntityManager in a session bean and use persist() or find() methods on an EntityManager instance to create or query entity bean objects, as show in Example 12-4.
Example 12-4 EntityManager in a Session Bean
Queries are defined in metadata. You may now specify your queries using annotations, or in a deployment descriptor. JPA entities support bulk updates and delete operations through JPQL (Java Persistence Query Language). For more information, see Section 12.6.7, "JDK 5 Annotations for EJB/JPA".
JDeveloper offers you two easy wizards to create your JPA entities. You can create entities from online or offline databases, add a persistence unit, define inheritance strategies, and select from available database fields. The Entity from Tables wizard allows you to create entities from online or emulated offline databases, as well as from a application server data sources.
To create entities or entities from tables:
To create EJBs in an existing module:
Or, choose File menu, then New, then Business Tier, then EJB, then Entity or Entities from Tables.
To create EJBs in a new EJB module:
Or, select the module and choose File menu, then New, then Business Tier, then EJB, then Entity or Entities from Tables.
JDeveloper provides support for the SDO (Service Data Objects) data application development framework.
Use the SDO 2.0 framework and API to easily modify business data regardless of how it is physically accessed. SDO encapsulates the backend data source, offers a choice of static or dynamic programming styles, and supports both connected and disconnected access. SDO handles XML parser operations, and automatically integrates the data parsing logic with the application. For more information, "Integrating Service-Enabled Application Modules" in Oracle Fusion Middleware Fusion Developer's Guide for Oracle Application Development Framework.
The SDO architecture supported by JDeveloper offers the following:
SDO is a unified framework for data application based on the concept of disconnected data graphs. A data graph is a collection of tree-structured or graph-structured data objects. To enable development of generic or framework code that works with Data Objects, it is important to be able to introspect on Data Object metadata, which exposes the data model for the Data Objects. As an alternative to Java reflection, SDO provides APIs to access metadata stored in XML schema definition (XSD) files that you create, based on the entity or data model information detailed in your EJB session beans.
The SDO feature in JDeveloper can be used as an EJB service or as an ADF-BC service. If you choose to use an ADF-BC service you need add the listener reference to your weblogic-application.xml file. For more information, see Section 12.6.5, "How to Create an SDO Service Interface for JPA Entities".
For more information and specifications on SDO, see the OSOA (Open Service Oriented Architecture) at http://osoa.org/display/Main/Service+Data+Objects+Home
You can easily create a service interface API to access JPA entity data through either an EJB session bean or a plain old Java object (POJO). This service class exposes operations for creating, retrieving, updating, and deleting the JPA entities in your JDeveloper J2EE application.
To create a SDO service interface:
You can use the wizard to create your session beans. For more information, see Section 12.7.2, "How to Create a Session Bean".
By default all of the methods in your session bean interface are selected. Click the checkbox to select or unselect a method.
DeptSDO or EmployeeSDO. Select Backup File(s) to create a backup of your original session bean file. To use an EJB/POJO SDO ADF-BC service from a fabric composite using SDO external bindings, you need to set up the Weblogic application deployment listener to invoke the ServiceRegistry logic. Set this up by adding the listener reference to your weblogic-application.xml file.
To add the listener reference:
Add the code in Example 12-5 to the weblogic-application.xml which by default is located in <workspace-directory>/src/META-INF.
Example 12-5 Code Added to weblogic-application.xml
Once this listener is added, JDeveloper automatically registers the SDO service application name _JBOServiceRegistry_ into the fabric service registry in the composite.xml.
When you create your SDO service interface, the necessary files to support your service interface are automatically created. These files include the following:
XSDHelper.INSTANCE.define() method. A static type-specific DataObject is defined for each SDO type. When you deploy the JDeveloper integrated server, database tables are automatically created for every entity that does not have a corresponding existing mapped table. One database table will be generated per unmapped JPA entity.
| Note: Primary key referential integrity constraints will be generated, but other constraints may not be. |
To generate database tables from JPA entities:
http://www.oracle.com/technetwork/java/docs-135218.html. Annotations can simplify your development tasks by reducing the number of deployment descriptors needed for your application components. Annotations can also be used to generate artifacts such as interfaces.
An annotation is a metadata modifier that is added to a Java source file. Annotations are compiled into the classes by the Java compiler at compile time, and can be specified on classes, fields, methods, parameters, local variables, constructors, enumerations, and packages. Annotations can be used to specify attributes for generating code, for documenting code, or for providing services like enhanced business-level security or special business logic during runtime.
Every type of annotation available for your EJB/JPA classes can also, alternatively, be added to an XML deployment descriptor file. At runtime the XML will override any annotations added at the class level.
Annotations are marked with the @ symbol, such as this stateless session bean annotation:
@Stateless public class MySessionBean
For more information on annotations for EJB 3.0, see http://download.oracle.com/javase/1.5.0/docs/guide/language/annotations.html
| Note: Annotations are new to EJB 3.0, and not available for previous versions of EJB. |
During design time, JDeveloper displays a list of available annotations through the Property Inspector. You can change any suitable Java class to an EJB or JPA component using the annotation feature. For more information, see Section 12.6.8, "How to Annotate Java Classes.".
Annotations are available to indicate the bean type. Adding your bean type annotation to a regular class turns it into an EJB.
The following types of annotations are available:
Annotations support a new Java Persistence API as an alternative to entity beans.
The following types of annotations are available:
Once you transform your regular Java class into an EJB/JPA component, or if you used one of the EJB/JPA wizards to create the component, the Property Inspector displays a different set of contextual options, which you can use to add or edit annotations for the various members within the component class.
During design time, JDeveloper provides you with the list of available annotations to insert into your classes. The options change depending on what type of class you are working on, and what member you have selected.
You can annotate any regular Java class to turn it into an EJB/JPA component. Once the class is defined with annotations as an EJB/JPA, you can easily customize the component with a variety of member-level annotations available to choose from in the JDeveloper Property Inspector.
| Note: Annotations are only available for EJB 3.0, and not available for previous versions of EJB. |
To annotate your Java class as an EJB/JPA component:
If your class is already open in the Java source editor, put your curser in the class definition line.
After your Java class is annotated as an EJB/JPA component, the EJB/JPA tab disappears from the Property Inspector and a new tab appears, specific to the component type you chose. To change the component back to a regular Java class, remove the annotation from the code to reset the EJB/JPA component types displayed in the Property Inspector.
| Note: EJB or JPA components created through the wizards already contain the class type annotations. For more information, see Section 12.3, "Building EJB 3.0 Applications and Development Process.". |
Once your Java class is transformed into an EJB/JPA component using a class-level annotation, use the Property Inspector to add or edit annotations to member fields or methods within that component.
To add or edit annotations in an EJB/JPA component:
As an alternative, if your class is already open in the Java source editor, put your curser in the location where you intend to insert your annotation.
When you create entities from database tables, foreign keys are interpreted as relationships between entities. You can further define these relationships, create new relationships, or map existing relationships to existing tables using the JDeveloper modeling tools. With the modeling tools you can represent relationships as lines between entities, and change the relationships by changing the line configurations. For more information, see Section 23.3, "Modeling EJB/JPA Components on a Diagram.".
Java Persistence Query Language (JPQL) offers a standard way to define relationships between entity beans and dependent classes by introducing abstract schema types and relationships in the deployment descriptor. JPQL also defines queries for navigation using abstract schema names and relationships.
The JPAQL query string consists of two mandatory clauses: SELECT and FROM, and an optional WHERE clause. For example:
select d from Departments d where d.department_name = ?1
There are two kinds of methods that use JPQL, finder methods and select methods.
cmp-field type, or the remote interfaces represented by the cmr-field. The Java Persistence API lets you declaratively map Java objects to relational database tables in a standard, portable way that works both inside a Java EE 5 application server and outside an EJB container. This approach greatly simplifies Java persistence and provides an object-relational mapping approach.
With Oracle TopLink you can configure the JPA behavior of your entities using metadata annotations in your Java source code. At run-time the code is compiled into the corresponding Java class files.
To designate a Java class as a JPA entity, use the @Entity annotation, as shown in Example 12-6.
You can selectively add annotations to override defaults specified in your deployment descriptors.
For more information on JPA Annotations, see the TopLink JPA Annotation Reference at http://www.oracle.com/technetwork/middleware/ias/toplink-jpa-annotations-096251.html.
A Java service facade implements a lightweight testing environment you can run without an application server.
With EJB 3.0 the Java service facade is similar to an EJB session facade, because you can generate facade methods for entities in the same persistence unit, without the container.
Separating workflow with Java service facades eliminates the direct dependency of the client on the participant JPA objects and promotes design flexibility. Although changes to participants may require changes in the Java service facade, centralizing the workflow in the facade makes such changes more manageable. You change only the Java service facade rather than having to change all the clients. Client code is also simpler because it now delegates the workflow responsibility to the session facade. The client no longer manages the complex workflow interactions between business objects, nor is the client aware of interdependencies between business objects.
You may choose to make the Java service class runnable by generating a sample Java client with a main() method.
Use the JDeveloper Java service facade wizard to create a Java class as a service facade to entities. To create a new Java service facade select the File menu, then New, then Business Tier, then EJB, then Java Service Facade.
You can also create a data control from a service facade. In the Application Navigator, right-click the name of the service facade, then select Create Data Control. From the Bean Data Control Interface Chooser dialog, you can choose to implement oracle.binding.* data control interfaces. The interfaces are TransactionalDataControl, UpdatableDataControl, and ManagedDataControl. For more information, select the Help button in the dialog.
A session bean represents a single client inside the application server. To access an application deployed on the server, the client invokes the session bean methods. The session bean performs work for its client, shielding the client from complexity by executing business tasks inside the server. A session bean is similar to an interactive session. A session bean is not shared and has only one client, in the same way that an interactive session can have only one user. Like an interactive session, a session bean is not persistent as it does not save data to the database. When the client terminates, its session bean appears to terminate and is no longer associated with the client.
Create your session beans and session bean facades using the JDeveloper Session Bean Wizard. For more information, see Section 12.7.2, "How to Create a Session Bean.".
There are two types of session beans:
With JDeveloper you can select to automatically generate your session facade methods any time you create a session bean through the session bean wizard. This creates a session bean that functions as a session facade for your business workflow. For more information, see Section 12.7.2, "How to Create a Session Bean.".
The session facade is implemented as a session bean. The session bean facade encapsulates the complexity of interactions between the business objects participating in a workflow by providing a single interface for the business services of your application.The session facade manages the relationships between numerous BusinessObjects and provides a higher level abstraction to the client.
Session facades can be either stateful or stateless, which you define while creating a session facade in the wizard.
For more information on session facades, see the Oracle Technology Network at http://www.oracle.com/technetwork/java/sessionfacade-141285.html
Use the wizard to automatically implement a session facade when you create a session bean, and to choose the methods you want to implement. Once you've created EJB entities, any session beans you create in the same project are aware of the entities and the methods they expose.
Use the session bean wizard to create a new session bean or session facade bean. Or you can create a session bean using the modeling tools.
To create a session bean or session facade using a wizard:
| Note: You must have already created a persistence unit before you can generate a session facade bean. To generate a persistence unit follow the same steps, but select JPA Persistence Unit instead of Session Bean. |
To add or remove session bean facade methods:
For more information on session facades, see the Core J2EE Pattern Catalog at http://www.oracle.com/technetwork/java/sessionfacade-141285.html.
You can also create a session facade manually by creating a local reference between a session bean and an entity.
To create a local reference:
To create a session bean on an EJB diagram:
If you do not have an EJB diagram, select File, then New, then select EJB Diagram from the Business Tier category.
If the Component Palette is not visible, from the View menu, choose Component Palette.
You can create EJBs in both new and existing modules.
To create EJBs in an existing module:
Or, select the module and choose File menu, then New, then Business Tier, then EJB Session or Message-Driven Bean.
To create EJBs in a new EJB module:
Or, select the module and choose File menu, then New, then Business Tier, then EJB Session or Message-Driven Bean.
Once an EJB has been added to your project, you can add, delete, or edit the methods in it. Adding methods as described below ensures that changes are synchronized with remote and home interfaces, when defined.
To add methods (EJB 2.1):
To add methods (EJB 3.0):
To delete methods (EJB 2.1):
To delete methods (EJB 3.0):
To edit methods (EJB 2.1):
To edit methods (EJB 3.0):
You can add fields to EJBs on an EJB diagram or through the EJB Module Editor.
To add a field on an EJB Diagram (EJB 2.1):
To add a field using the EJB Module Editor (EJB 2.1):
To add a field (EJB 3.0):
You can remove fields from EJBs, as described below.
To remove a field on an EJB Diagram:
To remove a field using the EJB Module Editor (EJB 2.1):
To remove a field (EJB 3.0):
Environment entries are name-value pairs that allow you to customize the bean's business logic. Since environment entries are stored in an enterprise bean's deployment descriptor, a bean's business logic can be changed without changing its source code.
For example, an EJB that calculates an order might give a discount depending on the number of items ordered, a certain status (silver, gold, platinum), or for a promotion. Before deploying the bean's application you could assign the discount a certain percentage. When the application runs, a method would call the environment entry to find out the discount value. If you wanted to change that percentage in a different deployment, you would not need to change the source code, you would just need to change the value in the environment entries for the deployment descriptor.
Environment entries are annotated in the source code.
For the complete EJB 3.0 Java Community Process specifications and documentation, see http://www.oracle.com/technetwork/java/docs-135218.html.
Depending on how your develop your application, there are different methods of exposing data to clients.
A resource reference is an element in a deployment descriptor that identifies the component's coded name for the resource. Resource references are used to obtain connector and database connections, and to access JMS connection factories, JavaMail sessions, and URL links.
To add or modify EJB 3.0 resource references:
Go to your source code to annotate resource references.
A primary key is a unique identifier with one or more persistent attributes. It identifies one instance of a class from all other instances of the same type. Use primary keys to define relationships and to define queries.
Each JPA entity instance must have a primary key. To accommodate your database schema, you can define simple primary keys from persistent fields or composite primary keys from multiple persistent fields. You can also define automatic primary key value generation to simplify your JPA entity implementation.
The simplest way to specify a simple primary key is to use annotations for a single primitive, or JDK object type entity field as the primary key. You can also specify a simple primary key at deployment time using deployment XML.
To configure a simple primary key using annotations:
@Id annotation, as shown in Example 12-7. Example 12-7 Configuring Primary Key Using Annotations
To configure a simple primary key using deployment XML:
For certain ADF Faces features, a designated primary key is required. For example, if you have an ADF Faces table that uses an af:tableSelectMany component, you will need to specify a primary key to be able to implement sorting. When you create EJB/JPA entities from tables (using EJB 3.0), the primary key is specified by default. But if you have to specify a primary key, do the following:
To specify an attribute as primary key:
JDeveloper automatically provides a complete set of data control components when you build an ADF Fusion web application. When you build a Java EE application, and/or an EJB project, you assign ADF data controls on your individual session beans. This adds a data control file with the same name as the bean.
For complete details on using ADF data controls for EJBs, see "Using ADF Model Data Binding in a Java EE Web Application" in Oracle Fusion Middleware Java EE Developer's Guide for Oracle Application Development Framework.
For information about modeling EJB and JPA components on a diagram, see Section 23.3, "Modeling EJB/JPA Components on a Diagram.".
An EJB module is a software unit comprising one or more EJBs, a persistence unit, and an optional EJB deployment descriptor. A JDeveloper project contains only one EJB module. At deploy-time, the module is packaged as an ejb.jar file.
Entity beans were once packaged in the EJB JAR file along with the session and message-driven beans. Today, with JPA entities and the persistence unit technology, at deploy-time, they are packaged in their own JAR file, persistenceunit.jar.
Now your entity beans (JPA entities) are contained separately, in a JPA persistence archive JAR, which includes a persistence.xml file. The JPA persistence unit does not have to be part of the EJB module package, but can be bundled inside the ejb.jar file.
JDeveloper project can contain only one EJB module. When you create your first session or message-driven bean in a project, a module is automatically established, if one does not already exist. You are given the option of choosing the EJB version and the persistence manager for your new EJB module.
When you deploy your project you convert the aggregate of session and message-driven beans, plus deployment descriptor into an a EJB JAR file (.jar file), ready for deployment to an application server or as an archive file. By confining the persistence unit to its own JAR file, the persistence unit can easily be reused in other applications. For more information, see Section 9.1, "About Deploying Applications."
A JPA persistence unit is comprised of a persistence.xml file, one or more optional orm.xml files, and the managed entity classes that belong to the persistence unit. A persistence unit is a logical grouping of the entity manager, data source, persistent managed classes, and mapping metadata. A persistence unit defines an entity manager's configuration by logically grouping details like entity manager provider, configuration properties, and persistent managed classes.
Each persistence unit must have a name. Only one persistence unit of a given name may exist in a given EJB-JAR, WAR, EAR, or application client JAR. You can package a persistence unit in its own persistence archive and include that archive in whatever Java EE modules require access to it.
The persistence.xml file contains sections or groupings, these groupings correspond to your entities, and run-time data related to the entities. When you create a new entity using the entity wizards, and if you have an existing persistence unit in the project, the entity will be inserted into its own section in the persistence.xml. If you do not have an existing persistence unit, one will be created automatically, with a section included for the entity definitions.
The JAR file or directory, whose META-INF directory contains the persistence.xml file, is called the root of the persistence unit. An EJB 3.0 application that uses entities must define at least one persistence unit root either explicitly or using the OC4J default persistence unit. When you deploy your persistence unit, a JAR file is created called persistenceunit.jar. For more information, see Section 9.1, "About Deploying Applications."
You can easily create a persistence unit for your entities using the JDeveloper Persistence Unit wizard. Or, when you create a JPA entity, a default persistence unit is created for you, if you do not already have one.
To create a JPA persistence unit:
To remove an EJB from an EJB module, select the EJB in the System Navigator and press Delete.
You can import existing EJBs from a JAR file or from a deployment descriptor.
To import an EJB module, or a subset of EJBs within an EJB module into a project:
To import an EJB deployment descriptor (ejb-jar.xml) file:
| Note: If you import a deployment descriptor using this wizard, and then use the wizard to import more files, the wizard caches the last used descriptor file, JAR file, and descriptor source directory in the IDE preferences file for convenience. This makes it easier to do tasks such as splitting an EJB module into multiple modules, importing multiple JAR files residing in the same directory, etc. |
To import a WebLogic deployment descriptor (weblogic-ejb-jar.xml) file:
To avoid conflicts, if an EJB with the same name already exists in your existing module, that EJB will not be imported.
To test your EJBs you need to run a client program that can create or find EJB instances and call their remote interface methods. JDeveloper provides a sample client utility that will help you create clients quickly. You can run and test EJBs using either the integrated server or a remote server; the sample client utility can be used to create a client for either type.
The integrated Oracle WebLogic Server runs within JDeveloper. You can run and test EJBs quickly and easily using this server, and then deploy your EJBs with no changes to them. You do not need to create a deployment profile to use this server, nor do you have to initialize it.
To run a sample client on the integrated Oracle WebLogic Server:
Notice in the Message pane that Oracle WebLogic Server has been launched.
The client is created and opens in the code editor.
If your session bean serves as a facade over JPA entities, code is generated to instantiate the query methods. If you exposed methods on your bean, the generated client contains methods that can be uncommented to call them.
To test EJBs on a remote server you need to deploy the EJB and then create a sample client. If you deploy first, the framework picks up the deployed applications, which populates the client pick list.
| Note: You cannot mix different version EJBs in the same module. |
To run a sample client on a remote server:
The new deployment profile is displayed in the Application Navigator.
The client is created and displays in the Application Navigator.
The Message pane shows you the running output.
JDeveloper provides support for JUnit regression testing for your EJBs. JUnit is an open source Java regression testing framework that comes as an optional feature in JDeveloper. To use this feature you'll need to install the JUnit extension.
Use JUnit to write and run tests that verify your code. After you install the JUnit extension, you can use the simple wizard to select your session bean or Java class files, to select the methods that you want to test within those files, and then to start the JUnit test.
To run a JUnit test on an EJB:
For detailed information about JUnit, visit the JUnit website, http://www.junit.org/.
This chapter describes how to develop TopLink Mappings within Oracle JDeveloper. Using the TopLink Editor, you can quickly and easily configure TopLink descriptors and mappings for your Java classes, EJBs, and JPA entities to data source elements (such as database tables or XML schema elements). With the TopLink Editor, you can create this information without writing Java code.
This chapter includes the following sections which describe the general process for creating TopLink mappings and integrating them in a JDeveloper project:
For more information, see the following:
Oracle TopLink is an advanced, object-persistence and object-transformation framework that provides development tools and run-time capabilities that reduce development and maintenance efforts, and increase enterprise application functionality.
Using the TopLink Editor available within JDeveloper you can configure and map your Java classes, EJBs, and JPA entities to different data sources, including relational databases, enterprise information systems (EIS), and XML schemas without using Java code. The TopLink Editor supports multiple standards, including JPA, JAXB, and Java EE.
TopLink links object-oriented programs with relational data structures. Using TopLink, you can build high-performance applications that store persistent object-oriented data in a relational database. TopLink successfully transforms object-oriented data into either relational data or XML documents. Using TopLink, you can integrate persistence and object-transformation into your application, while staying focused on your primary domain problem by taking advantage of an efficient, flexible, and field-proven solution.
TopLink enables you to address the disparity between Java and data sources, known as impedance mismatch. While object-relational databases consist of such elements as tables, rows, columns, and primary and foreign keys, Java and Java EE include entity classes (regular Java classes or Enterprise JavaBeans (EJB) entity beans), business rules, complex relationships, and inheritance. In a nonrelational data source, you must match your Java entities with EIS records or XML elements and schemas. These differences (as shown in Figure 13-1) are known as the object-persistence impedance mismatch.
You can use TopLink to perform a variety of persistence and data transformation functions on any enterprise architecture that uses Java, including:
TopLink can be used in the following ways:
The TopLink metadata is the bridge between the development of an application and its deployed runtime environment. You can capture the metadata using:
sessions.xml and project.xml files that you pass to the TopLink runtime environment. persistence.xml, orm.xml, and TopLink JPA annotation and TopLink property extensions. The TopLink JPA persistence provider interprets these metadata sources of metadata to create an in-memory TopLink session and project at runtime. The metadata enables you to pass configuration information into the runtime environment, which uses the information in conjunction with the persistent classes (Java objects, JPA entities, or EJB entity beans) and the code written with the TopLink API, to complete the application.
Using TopLink JPA, you also have the option of specifying your metadata using TopLink sessions.xml and project.xml while accessing your persistent classes using JPA and an EntityManager.
The TopLink metadata architecture provides many important benefits, including the following:
Using TopLink JPA, you have the flexibility of expressing persistence metadata using standard JPA annotations, deployment XML, or both. Optionally, you can take advantage of TopLink JPA annotation and persistence unit extensions.
A TopLink project contains the mapping metadata that the TopLink runtime uses to map objects to a data source. The project is the primary object used by the TopLink runtime. The principal contents of project metadata include the following:
Using JPA, TopLink runtime constructs an in-memory project based on the employed annotations, persistence.xml, orm.xml, and TopLink JPA extensions.
The TopLink Session configuration file (sessions.xml) allows you to easily manage all of the sessions for a specific project. You can fully customize the information for each session, including your data source login information, JTA transaction usage, and caching.
A TopLink session contains a reference to a particular project.xml file, plus the information required to access the data source. The session is the primary object used by your application to access the features of the TopLink runtime.
The agent responsible for creating and accessing session metadata differs, depending on whether or not you are creating a CMP project. In a POJO project, your application acquires and accesses a session directly. In a CMP project, your application indirectly accesses a session acquired internally by the TopLink runtime.
Using TopLink JPA, the TopLink runtime constructs an in-memory session based on any combination of JPA annotations, persistence.xml, orm.xml, and TopLink JPA annotation and persistence.xml property extensions. The use of a sessions.xml file is optional.
TopLink uses descriptors to store the information that describes how a particular class can be represented by a data source. Descriptors own mappings that associate class instance variables with a data source and transformation routines that are used to store and retrieve values. As such, the descriptor acts as the connection between a Java object and its data source representation.
Two objects – a source (parent or owning) object and a target (child or owned) object are related by aggregation if there is a strict one-to-one relationship between them, and all the attributes of the target object can be retrieved from the same data source representation as the source object. This means that if the source object exists, then the target object must also exist, and if the source object is destroyed, then the target object is also destroyed.
JDeveloper enables you to create the following TopLink descriptor types:
Relational descriptors describe Java objects that you map to tables in a relational database. Using relational descriptors in a relational project, you can configure relational mappings. In a relational project, you can designate the descriptor as an aggregate, enabling you to configure an aggregate mapping, one that associates data members in the target object with fields in the source object's underlying database tables.
When you designate a relational descriptor as an aggregate, TopLink lets you specify a mapping type for each field in the target class, but defers associating the field with a database table until you configure the aggregate object mapping in the source descriptor. In other words, the target class descriptor defines how each target class field is mapped, but the source class descriptor defines where each target class field is mapped. This lets you share an aggregate object among many parent descriptors mapped to different tables.
TopLink transforms the data from an object representation to a representation specific to a data source. This transformation is called mapping and it is the core of a TopLink project. A mapping corresponds to a single data member of a domain object. It associates the object data member with its data source representation and defines the means of performing the two-way conversion between the object and data source. A TopLink map belongs to a TopLink session, the facade through which applications access TopLink functionality. The available mapping types may vary, depending on the TopLink map and TopLink descriptor.
The relational mappings transform any object data member type to a corresponding relational database representation in any supported relational database. Use them to map simple data types including primitives (such as int), JDK classes (such as String), and large object (LOB) values. You can also use them to transform object data members that reference other domain objects by way of association where data source representations require object identity maintenance (such as sequencing and back references) and possess various types of multiplicity and navigability. The appropriate mapping class is chosen primarily by the cardinality of the relationship
Table 13-1 illustrates the relational mapping types build maps using the TopLink concepts of directionality, transformers, converters, and EJB 2.n CMP relational mapping.
Table 13-1 Relational Mapping Types
| Mapping Type | Description |
|---|---|
| Direct-to-field | Map a Java attribute directly to a database field. |
| Direct-to-XMLType | Map Java attributes to an |
| One-to-one | Map a reference to another persistent Java object to the database. |
| Variable one-to-one | Map a reference to an interface to the database. |
| One-to-many | Map Java collections of persistent objects to the database. |
| Many-to-many | Use an association table to map Java collections of persistent objects to the database. |
| Direct collection | Map Java collections of objects that do not have descriptors |
| Direct map | Direct map mappings store instances that implement |
| Aggregate object | Create strict one-to-one mappings that require both objects to exist in the same database row. |
| Transformation | Create custom mappings where one or more fields can be used to create the object to be stored in the attribute. |
TopLink enterprise information system (EIS) mappings provide support for accessing legacy data sources and enterprise applications through Java EE Connector architecture (JCA) adapter. TopLink EIS mappings use the JCA Common Client Interface (CCI) to access the EIS through its resource adapter. This provides the ability to directly map from an existing Java object model to any transactional data source, such as mainframes with flat file/hierarchical data. An EIS mapping transforms object data members to the EIS record format defined by the object's descriptor.
Table 13-2 illustrates the EIS mapping types that TopLink provides:
Table 13-2 EIS Mapping Types
| Mapping Type | Description |
|---|---|
| Direct mapping | Map a simple object attribute directly to an EIS record. |
| Composite direct collection mapping | Map a collection of Java attributes directly to an EIS record. |
| Composite object mapping | Map a Java object to an EIS record in a privately owned one-to-one relationship. Composite object mappings represent a relationship between two classes. |
| Composite collection mapping | Map a |
| One-to-one mapping | Define a reference mapping that represents the relationship between a single source object and a single mapped persistent Java object. |
| One-to-many mapping | Define a reference mapping that represents the relationship between a single source object and a collection of mapped persistent Java objects. |
| Transformation mapping | Create custom mappings where one or more EIS record fields can be used to create the object to be stored in a Java class's attribute. |
The XML mappings transform object data members to the XML elements of an XML document whose structure is defined by an XML schema document (XSD). You can map the attributes of a Java object to a combination of XML simple and complex types using a wide variety of XML mapping types. TopLink stores XML mappings for each class in the class descriptor. TopLink uses the descriptor to instantiate objects mapped from an XML document and to store new or modified objects as an XML document.
Table 13-3 indicates the XML mapping types you can use to map the attributes of a Java object to a combination of XML simple and complex types:
Table 13-3 XML Mapping Types
| Mapping Type | Description |
|---|---|
| XML Direct Mapping | Map a simple object attribute to an XML attribute or text node. |
| XML Composite Direct Collection Mapping | Map a collection of simple object attributes to XML attributes or text nodes. |
| XML Composite Object Mapping | Map any attribute that contains a single object to an XML element. The TopLink runtime uses the descriptor for the referenced object to populate the contents of that element. |
| XML Composite Collection Mapping | Map an attribute that contains a homogenous collection of objects to multiple XML elements. The TopLink runtime uses the descriptor for the referenced object to populate the contents of those elements. |
| XML Any Object Mapping | The XML Any Object mapping is similar to the XML Composite Object mapping except that the reference object may be of different types (including |
| XML Any Collection Mapping | The XML Any Collection mapping is similar to the XML Composite Collection mapping except that the referenced objects may be of different types (including |
| XML Transformation Mapping | Create custom mappings where one or more XML nodes can be used to create the object to be stored in a Java class's attribute. |
Use the TopLink editor to configure and map Java classes to different data sources, including relational databases, enterprise information systems (EIS), and XML schemas without using code. The TopLink editor supports multiple mapping standards, including EJB 3.0 JPA.
The TopLink editor displays the information or properties specific to the element selected in the Application Navigator or the Structure view. For example, selecting TopLink project elements in the Application Navigator, such as a the TopLink Map or the sessions configuration file (sessions.xml), enables you to configure their properties in the TopLink editor. Likewise, selecting TopLink Maps, descriptors, and mapped or unmapped attributes in the Structure view results in the display of their respective properties in the TopLink editor.
The TopLink Map contains the information about how classes map to database tables or XML schema. Use the TopLink editor to edit each component of the mappings, including:
To configure a TopLink Map, choose Application Navigator context menu for a TopLink Map (for example, tlMap) Open or choose the Structure view for TopLink Map. The TopLink editor displays the properties for the object map depending on its type, such as relational, or EIS. When using the TopLink editor for relational object maps, for example, you can configure the sequencing policy. For more information about TopLink editor, see Oracle Fusion Middleware Developer's Guide for Oracle TopLink.
TopLink mappings use descriptors to store the information that describes how an instance of a particular class can be represented in the data source. To configure a map's descriptors, choose Structure view for tlMap descriptor. For example, using the editor, you can improve application performance by creating named queries and also prevent users from overwriting each other's work by configuring locking policies.
TopLink mappings define how an object's attributes are represented in the data source. The Structure view enables you to configure the mappings for the descriptor's attributes by choosing Structure view for tlMap descriptor attribute Map as context menu mapping type.
The TopLink Sessions configuration file (sessions.xml) enables you to manage all of the sessions for a specific project. For more information about TopLink sessions, see Oracle Fusion Middleware Developer's Guide for Oracle TopLink.
By choosing Structure view for sessions.xml Open, you can use the TopLink editor to fully customize the information for each session, such as data source login information, JTA transaction usage, and caching. You can also use the TopLink editor to create and configure individual sessions and the session brokers that manage them. To manage session brokers, Structure view for sessions.xml session broker.
The TopLink editor enables you to configure the persistence.xml file, which packages entities in TopLink JPA projects. By choosing Application Navigator for persistence.xml Open, you can create persistence units.
The Structure window displays JPA descriptors and persistence units. By choosing Structure view for persistence.xml persistence unit, you can configure the persistence unit.
The Structure view displays detailed information about the TopLink element selected in Application Navigator or TopLink editor. For example:
The Structure view contains a toolbar that provides access to modify descriptors, mapping, sessions, and persistence units. This toolbar is context-sensitive; the buttons displayed vary depending on the element that you select in the Structure view.
Table 13-4 Icons in the TopLink Structure View Toolbar
| Icon | Name | Function |
|---|---|---|
![]() | Add or Remove Descriptors | Adds or removes descriptors from the TopLink map |
![]() | Automap | Attempts to automap the selected descriptor or attribute to a similarly named database field. |
![]() | Aggregate Descriptor | Changes the descriptor type to aggregate descriptor, meaning that the descriptor's definitions for table, primary key and other options are from the owning descriptor. |
![]() | Class Descriptor | Changes the descriptor type to class descriptor. |
![]() | Map As | Selects a mapping type for the selected attribute. |
![]() | New Persistence Unit | Click to create a new persistence unit. |
![]() | Create a New Database or Server Session | Click to create a session within the sessions configuration file. |
![]() | Create Session Broker | Click to create a new session broker. |
![]() | Create a New Named Connection Pool | Click to create a new named connection pool, a connection pool used for any purpose, but typically for security purposes. |
![]() | Add the Sequence Connection Pool | Click to add a connection pool exclusively used for sequencing. TopLink uses the sequence connection pool whenever it needs to assign an identifier to a new object. |
The Application Navigator displays each element associated with your TopLink project, including the TopLink Map, deployment descriptors, and sessions configuration information.
TopLink project elements in the Application Navigator may include:
sessions.xml) The TopLink Editor displays your TopLink mapping information. The information in the editor will vary, depending on the TopLink element you selected in the Application Navigator or Structure view.
The Structure view displays detailed information about the TopLink element selected in Application Navigator or TopLink Editor:
When you select an item in the Structure view, the following properties appear in the TopLink Editor:
You can perform specific functions for an item by selecting the item in the Application Navigator and then:
The TopLink Editor Structure view contains a toolbar that offers quick access to modify descriptors and mappings. This toolbar is context-sensitive; the actual buttons displayed will vary, depending on which element in the Structure view is selected.
Error and status messages from the TopLink Editor appear in the TopLink Problems window.
You can configure which persistence provider to use, which JPQL editor to use, and query types and formats.
To configure TopLink Editor preferences:
JDeveloper stores the TopLink descriptors (for more information, see Section 13.1.7, "Using TopLink Descriptors") and mappings (for more information, see Section 13.1.8, "Using TopLink Mappings") in a TopLink map (.mwp file), and sessions in the sessions.xml file. The TopLink map contains the information about how classes map to database tables. Use the TopLink Editor to edit each component of the mappings, including:
When you select a TopLink map (or an element in a TopLink map), its attributes display in the TopLink Editor.
TopLink maps persistent entities to the database in the application using the descriptors and mappings you build with JDeveloper Mapping Editor. The Mapping Editor supports such approaches to project development as:
Although JDeveloper Mapping Editor offers the ability to generate persistent entities or the relational model components for an application, these utilities are intended only to assist in rapid initial development strategies–not complete round-trip application development.
To create a new TopLink-enabled project:
The New TopLink-Enabled Project dialog displays.
JDeveloper creates a new project, including an object map.
To add a TopLink map to an existing JDeveloper project:
JDeveloper creates a TopLink map file in an existing project.
TopLink no longer uses the following direct mapping types:
Instead, TopLink uses a direct-to-field mapping with a specialized converter. To generate backward-compatible deployment XML files, use the Generate Deprecated Direct Mappings option on the General page of the TopLink Map options.
The TopLink Automap wizard can automatically map your Java class attributes to a similarly named database field. The Automap wizard only creates mappings for unmapped attributes; it does not change previously defined mappings.
You can use the Automap wizard for an entire project or for specific classes or descriptors.
To automap TopLink descriptors:
The TopLink Map (and its attributes) appear in the Structure window.
The Automap Wizard wizard displays. Complete each page of the wizard.
Use a TopLink JPA (Java Persistence API) project for persisting Java objects based on Plain Old Java Objects (POJOs).
The Java Persistence API is a lightweight framework for Java persistence based on Plain Old Java Objects. JPA is a part of EJB 3.0 specification. JPA provides an object-relational mapping approach that enables you to declaratively define how to map Java objects to relational database tables in a standard, portable way. In addition, this API enables you to create, remove and query across lightweight Java objects within both an EJB 3.0-compliant container and a standard Java SE 5 and Java SE 6 environment.
The TopLink implementation of JPA is provided by EclipseLink. For more information, see http://wiki.eclipse.org/EclipseLink.
You can perform object relational mapping with TopLink JPA through the following:
Table 13-5 Methods for Performing Object Relational Mapping with TopLink JPA
| Method | Description |
|---|---|
| Using Metadata Annotations | An annotation is a simple, expressive means of decorating Java source code with metadata that is compiled into the corresponding Java class files for interpretation at run time by a JPA persistence provider to manage persistent behavior.You can use annotations to configure the persistent behavior of your entities. |
| Using XML | You can use XML mapping metadata on its own, or in combination with annotation metadata, or you can use it to override the annotation metadata. |
| Defaulting Properties | Each annotation has a default value. A persistence engine defines defaults that apply to the majority of applications. To override the default value, you need only to supply the appropriate values. A configuration value is not a requirement, but the exception to the rule. This is known as configuration by exception. |
| Configuring an Entity | You can configure an entity's identity, as well as the locking technique and sequence generation option for the entity. |
| Declaring Basic Property Mappings | Simple Java types are mapped as part of the immediate state of an entity in its fields or properties. Mappings of simple Java types are called basic mappings. By default, TopLink persistence provider automatically configures a basic mapping for simple types. |
| Mapping Relationships | TopLink persistence provider requires that you map relationships explicitly. Use such annotations as |
| Mapping Inheritance | By default, TopLink persistence provider assumes that all persistent fields are defined by a single entity class. Use the |
| Mapping Embedded Objects | An embedded object does not have its own persistent identity. It is dependent upon an entity for its identity. By default, TopLink persistence provider assumes that every entity is mapped to its own table. Use the following annotations to override this behavior for entities that are owned by other entities:
|
Use the persistence configuration file (persistence.xml) file to package your entities.
To create a persistence configuration:
The New JPA Persistence Descriptor dialog displays.
persistence.xml) and click OK. Example 13-1 contains a sample persistence configuration.
Example 13-1 Sample Persistence Configuration (persistence.xml)
To configure a persistence configuration (persistence.xml) file:
persistence.xml) page. To create a persistence unit:
persistence.xml) in the Application Navigator or Structure window. orm.xml mapping descriptor file. (See Section 13.2.4, "How to Create JPA Descriptors.") Example 13-2 contains a sample persistence unit.
Example 13-2 Example Persistence Unit
The tabs of the Persistence Unit page (accessed by first selecting persistence.xml in the Application Navigator and then expanding the JPA descriptor in the Structure view) enable you to configure a persistence unit.
Configuring Persistence Units encompasses many steps, such as configuring:
To configure the general information for a JPA persistence unit:
persistence.xml) in the Application Navigator. The Persistence Unit page displays.
To configure the connection information for a JPA persistence unit:
persistence.xml) in the Application Navigator. The Persistence Unit page displays.
To configure the TopLink session-specific information for a JPA persistence unit:
persistence.xml) in the Application Navigator. The Persistence Unit page displays.
To configure the DDL generation options:
Although most JPA persistence providers provide this support, these options are TopLink-specific.
persistence.xml) in the Application Navigator. The Persistence Unit page displays.
To configure the non-TopLink specific properties for the persistence unit:
persistence.xml) in the Application Navigator. The Persistence Unit page displays.
To configure metadata overrides for a persistence unit:
persistence.xml) in the Application Navigator. The Persistence Unit page displays.
This tab is available only if the persistence unit contains a JPA mapping descriptor.
The JPA mapping descriptor is used as an alternative to annotations. Any information you add as a JPA mapping descriptor will override the Java annotations.
To create new JPA mapping descriptors:
persistence.xml) in the Application Navigator. JDeveloper adds the Mapping Descriptors (orm.xml) to the project.
orm.xml) page: To configure the general information for a JPA mapping descriptor:
orm.xml) in the Application Navigator. The ORM (orm.xml) page appears.
You can configure the settings that apply to persistence units and associated entities that include this mapping descriptor. These values will be overridden by any configuration settings at the persistence unit-level.
To configure persistence unit defaults:
orm.xml) in the Application Navigator. The ORM (orm.xml) page appears.
You can define the generators used by this mapping descriptor.
To configure generators:
orm.xml) in the Application Navigator. The ORM (orm.xml) page appears.
You can define the JPQL and native queries in this mapping descriptor for use in associated persistence units.
To configure queries:
orm.xml) in the Application Navigator. The ORM (orm.xml) page appears.
Oracle TopLink provides a complete, JPA 2.0-compliant JPA implementation. It provides complete compliance for all of the mandatory features, many of the optional features, and some additional features.
TopLink offers support for deployment within an EJB 3.0 container or outside the container. This includes Web containers, other non-EJB 3.0 Java EE containers, and the Java SE environment.
Through its pluggable persistence capabilities TopLink can function as the persistence provider in any compliant EJB 3.0 container.
The Java Persistence API (JPA), part of the Java Enterprise Edition 5 (Java EE 5) EJB 3.0 specification, greatly simplifies Java persistence. It provides an object relational mapping approach that allows you to declaratively define how to map Java objects to relational database tables in a standard, portable way that works both inside a Java EE 5 application server and outside an EJB container in a Java Standard Edition (Java SE) 5 application.
TopLink JPA provides extensions to what is defined in the JPA specification. These extensions come in persistence unit properties, query hints, annotations, TopLink's own XML metadata, and custom API.
The TopLink Editor provides complete support for creating relational projects that map Java objects to a conventional relational database accessed using JDBC. Use a TopLink relational project for transactional persistence of Java objects to a conventional relational database or to an object-relational database that supports data types specialized for object storage, both accessed using JDBC.
To create relational projects for an object-relational database, you must create the project using Java code. You can create a relational project for transactional persistence of Java objects to an object-relational database that supports data types specialized for object storage (such as Oracle Database) accessed using JDBC.
To create relational projects for an object-relational database, you must create the project using Java code. You can create a relational project for transactional persistence of Java objects to an object-relational database that supports data types specialized for object storage (such as Oracle Database) accessed using JDBC.
To create a new relational project:
The New TopLink-Enabled Project dialog displays.
JDeveloper creates a new project, including the TopLink map and TopLink sessions configuration file (sessions.xml).
To create a new TopLink object map for a relational project:
The New TopLink Object Map dialog displays.
JDeveloper creates a new project, including the TopLink map and TopLink sessions configuration file (sessions.xml).
Relational descriptors describe Java objects that you map to tables in a relational database. In a relational project, you can designate the descriptor as a class descriptor or an aggregate descriptor.
A class descriptor is applicable to any persistent object, but not an aggregate object. Using a class descriptor, you can configure any relational mapping except aggregate collection and aggregate object mappings.
An aggregate object is an object that is strictly dependent on its owning object. Aggregate descriptors do not define a table, primary key, or many of the standard descriptor options as they inherit these from their owning descriptor. If you want to configure an aggregate mapping to associate data members in a target object with fields in a source object's underlying database tables, you must designate the target object's descriptor as an aggregate.
You can configure inheritance for a descriptor designated as an aggregate, however, in this case, all the descriptors in the inheritance tree must be aggregates. Aggregate and class descriptors cannot exist in the same inheritance tree.
You can change a class descriptor to an aggregate descriptor, or remove the aggregate designation from a relational descriptor and return it to its default type. For more information, see Section 13.3.3, "How to Configure Relational Descriptors.".
| Note: When you change a class descriptor to an aggregate descriptor, the descriptor's existing information is permanently lost. If you convert the descriptor back to a class descriptor, you will have to configure it again. |
To create new TopLink descriptors:
JDeveloper adds the descriptors to the TopLink Map in the Structure window.
You can configure a relational descriptor as a Class type or an Aggregate type. By default, when you add a Java class to a relational project, JDeveloper automatically creates a relational class descriptor for it.
You can change a class descriptor to an aggregate descriptor.
To configure a TopLink relational class descriptor to an aggregate descriptor:
The selected descriptor is now an aggregate descriptor.
Use an XML project for nontransactional conversions between Java objects and XML documents using JAXB (Java Architecture for XML Binding) which defines annotations to control the mapping of Java objects to XML.
The TopLink runtime performs XML data conversion based on one or more XML schemas. In an XML project, the TopLink Editor directly references schemas in the deployment XML and exports mappings configured with respect to the schemas you specify.
TopLink provides an extra layer of functions on top of JAXB. In particular, TopLink provides the TopLink JAXB compiler, which generates both JAXB- and TopLink-specific files.
The JAXB complier generates implementation classes that are named according to the content, element, or implementation of the name attribute in the XSD. The generated implementation classes are simple domain classes with private attributes for each JAXB property. Public get and set methods return or set attribute values.
The JAXB complier generates TopLink project files, session.xml files, and TopLink project XML files. The TopLink JAXB compiler generates a single class called DescriptorAfterLoads if any implementation class contains a mapping to a type safe enumeration.
TopLink can validate both complete object trees and subtrees against the XML schema that was used to generate the implementation classes. In addition, TopLink will validate both root objects (objects that correspond to the root element of the XML document) and non-root objects against the schema used to generate the object's implementation class.
JAXB provides a standard Java object-to-XML API. JAXB defines annotations to control the mapping of Java objects to XML. For more information, see http://www.oracle.com/technetwork/java/index-jsp-137051.html.
JAXB also defines a default set of mappings which TopLink uses to marshal a set of objects into XML, and unmarshall an XML document into objects. TopLink provides an extra layer of functions on top of JAXB. It allows for the creation and subsequent manipulation of TopLink mappings from an existing object model, without requiring the recompilation of the JAXB object model.
To create a new XML project:
The New TopLink-Enabled Map dialog appears.
JDeveloper adds the TopLink map and TopLink sessions configuration file (sessions.xml).
To create a new TopLink object map:
The New TopLink-Enabled Map dialog appears.
JDeveloper adds the TopLink map and TopLink sessions configuration file (sessions.xml).
To create new TopLink descriptors for an XML project:
JDeveloper adds the descriptors to the TopLink element in the Structure window.
If you have an existing data model (XML schema document), but you do not have a corresponding object model (Java classes for domain objects), use this procedure to create your TopLink project and automatically generate the corresponding object model.
To add an XML schema:
JDeveloper adds the schema (tlmap) to the TopLink map
Using the TopLink JAXB compiler simplifies JAXB application development with TopLink by automatically generating both the required JAXB files and the TopLink files from your XML schema (XSD) document. Once generated, you can fine-tune XML mappings without having to recompile your JAXB object model.
Use a TopLink EIS project for transactional persistence of Java objects to a nonrelational data source accessed using a Java EE Connector Architecture (JCA) adapter and EIS records.
Oracle recommends using EIS projects to integrate TopLink with a legacy or nonrelational data source. TopLink provides support for mapping Java objects to EIS mapped, indexed, and XML records, through J2C, using the TopLink mappings. J2C provides a Common Client Interface (CCI) API to access nonrelational EIS. This provides a similar interface to nonrelational data sources as JDBC provides for relational data sources.
EIS includes legacy data sources, enterprise applications, legacy applications, and other information systems. These systems include such sources as Customer Information Control System (CICS), Virtual Storage Access Method (VSAM), Information Management System (IMS), ADABASE database, and flat files. Oracle recommends using EIS projects to integrate TopLink with a legacy or nonrelational data source. Other methods of accessing EIS data sources include:
Use an EIS project for transactional persistence of Java objects to a nonrelational data source accessed using a Java EE Connector Architecture (JCA) adapter and EIS records.
To create an EIS project:
JDeveloper creates a new project, including the TopLink map and TopLink sessions configuration file (sessions.xml).
An EIS mapping transforms object data members to the EIS record format defined by the object's descriptor.
To create a new TopLink object map for an EIS project:
JDeveloper adds the TopLink map to the project.
EIS descriptors describe Java objects that you map to an EIS data source by way of a JCA adapter.
To create an EIS descriptor:
JDeveloper adds the EIS descriptors to the Structure window.
Each TopLink map belongs to aTopLink session. A session is the facade through which an application accesses TopLink functionality. A session associates data source platform information, data source login information, and mapping metadata for a particular application. You can reuse mapping metadata in different applications by defining different sessions.
TopLink session provides the primary access to the TopLink runtime. It enables applications to perform persistence operations with the data source that contains persistent objects. A session associates data source platform information, data source login information, and mapping metadata for a particular application. You can reuse mapping metadata in different applications by defining different sessions.
TopLink provides different session types, each optimized for different design requirements and data access strategies. You can combine different session types in the same application.
The TopLink Editor provides the following TopLink sessions:
You acquire a client session from a session broker at run-time to provide access to all the data sources managed by the session broker for each client.
Other session types are can be configured directly in Java code. For more information about session types, see the Oracle Fusion Middleware Developer's Guide for Oracle TopLink.
Each TopLink sessions configuration (sessions.xml file) can contain multiple sessions and session brokers. In addition, you can specify a classpath for each sessions configuration that applies to all the sessions it contains.
To create a new sessions configuration file:
The Create TopLink Sessions Configuration dialog appears.
In Application Navigator, JDeveloper adds the sessions.xml file in the folder where it was created and the default session to the sessions configuration node in the Structure view.
A TopLink session provides the primary access to the TopLink runtime. It is the means by which your application performs all persistence operations with the data source that contains persistent objects.
A session associates data source platform information, data source login information, and mapping metadata for a particular application. You can reuse mapping metadata in different applications by defining different sessions.
To create a new TopLink session:
The TopLink sessions configuration file appears in the TopLink Editor, showing the existing sessions and session brokers in this sessions configuration file.
JDeveloper adds the new session to the sessions configuration node in the Structure view.
After you create and configure sessions, you can use the TopLink session manager to acquire a session instance at run time. The TopLink session manager enables developers to build a series of sessions that are maintained under a single entity. The session manager is a static utility class that loads TopLink sessions from the sessions.xml file, caches the sessions by name in memory, and provides a single access point for TopLink sessions.
The session manager has two main functions: it creates instances of the sessions and it ensures that only a single instance of each named session exists for any instance of a session manager.
The session manager instantiates sessions as follows:
sessions.xml file. If the session name exists, the session manager instantiates the specified session; otherwise, it raises an exception. Once you have a session instance, you can use it to acquire additional types of sessions for special tasks. This is particularly useful for EJB applications in that an enterprise bean can acquire the session manager and acquire the desired session from it.
The session broker is a mechanism that enables client applications to transparently access multiple databases through a single TopLink session. A session broker may contain both server sessions and database sessions. Oracle recommends that you use the session broker with server sessions because server sessions are the most scalable session type.
After you create and configure a session broker with server sessions, you can acquire a client session from the session broker at run time to provide a dedicated connection to all the data sources managed by the session broker for each client.
To create a new session broker:
sessions.xml). The sessions configuration displays in the TopLink Editor.
The TopLink sessions configuration file (sessions.xml) overrides any login information that you specified in the TopLink map. You can create data source logins for relational database or EIS data sources.
To create a data source:
sessions.xml) in the Application navigator. sessions.xml Structure view and then select the TopLink session. The TopLink session information appears in the TopLink Editor.
A connection pool is a service that creates and maintains a shared collection (pool) of data source connections on behalf of one or more clients. The connection pool provides a connection to a process on request, and returns the connection to the pool when the process is finished using it. When it is returned to the pool, the connection is available for other processes.
Because establishing a connection to a data source can be time-consuming, reusing such connections in a connection pool can improve performance. TopLink uses connection pools to manage and share the connections used by server and client sessions. Reusing connections to a single data source reduces the number of connections required and allows your application to support many clients.
To create a new connection pool.
sessions.xml) in the Application navigator. sessions.xml Structure window and then select the TopLink session. JDeveloper adds the connection pool to the Structure window.
Its properties appear in the Connection Pool page in the Editor window.
Oracle TopLink is an advanced, object-persistence and object-transformation framework that provides development tools and run-time capabilities that reduce development and maintenance efforts, and increase enterprise application functionality.
The TopLink cache is an in-memory repository that stores recently read or written objects based on class and primary key values.
TopLink uses the cache to:
TopLink uses two types of cache:
TopLink adds objects to the session cache from the following:
TopLink preserves object identity through its cache using the primary key attributes of a persistent entity, which may or may not be assigned through sequencing. Oracle recommends that you always maintain object identity. Disable object identity only if absolutely necessary, for example, for read-only objects.
A query that is run against the shared session cache is known as an in-memory query.
By default, a query that looks for a single object based on primary key attempts to retrieve the required object from the cache first, searches the data source only if the object is not in the cache. All other query types search the database first, by default. You can specify whether a given query runs against the in-memory cache, the database, or both.
Stale data is an artifact of caching, in which an object in the cache is not the most recent version committed to the data source.
For systems that require several objects be current, you can specify that these objects be explicitly refreshed from the database without incurring the full cost of distributed cache coordination. To do this:
Use a cache invalidation policy to specify how or when a cached object becomes invalid. Using cache invalidation ensures that an application does not use stale data. You can configure the cache to invalidate objects at a certain time of day, mark an object as invalid after a specified time period after the object was read, or you can set the set the invalidation policy to invalidate an object only explicitly. You can set an invalidation policy to apply to all objects by configuring it at the project level, to certain objects by applying it at the descriptor level, or to the results returned by a query by applying it at the query level.
Cache coordination enhances performance by avoiding data source access. By enabling the instances of a session to broadcast object changes to one another so that each session's cache is kept current or notified that the cache must update an object from the data source the next time that it is read, it also reduces stale data. In addition, cache coordination reduces the optimistic lock exceptions in distributed environments as well as the number of failed or repeated transactions in an application. Use cache coordination for applications that are read-based, regularly request and update the same objects, and have changes performed by a single Java application with multiple, distributed sessions.
As an alternative to cache coordination, you can tune the TopLink cache for each read-only, read-mostly, and write-mostly classes using identity type, cache invalidation, or cache isolation. You can perform this tuning before cache coordination.
Isolated client sessions provide a mechanism for disabling the shared server session cache. Any classes marked as isolated only cache objects relative to the life cycle of their client session. These classes never utilize the shared server session cache. This is the best mechanism to prevent caching as it is configured on a per-class basis allowing caching for some classes, and denying it for others.
In JDeveloper, you can configure the TopLink cache for a specific TopLink map. The cache options will apply globally to all descriptors. You can override the map-level cache configuration by defining cache configuration at the descriptor level.
To configure the TopLink cache at the TopLink map-level:
The TopLink cache is an in-memory repository that stores recently read or written objects based on class and primary key values.
To configure the TopLink cache at the descriptor-level:
TopLink enables you to create, read, update, and delete persistent objects or data using queries in both Java EE and non-Java EE applications for both relational and nonrelational data sources. For more information about queries, see the Oracle Fusion Middleware Developer's Guide for Oracle TopLink.
Querying a data source means performing an action on, or interacting with, the contents of the data source. To do this, perform the following:
For TopLink, you must also consider how the query affects the TopLink cache.
TopLink enables you to express a query using any of the following query languages:
DatabaseQuery stored by name in a Session or a descriptor's DescriptorQueryManager where it is constructed and prepared once. Such a query can then be repeatedly executed by name. DatabaseQuery. TopLink supports Call instances for custom SQL, stored procedures, and EIS interactions. DescriptorQueryManager defines a default DatabaseQuery for each basic data source operation (create, read, update, and delete), and provides an API with which you can customize either the DatabaseQuery or its Call. JPAQLCall and EJBQLCall, a call that takes JPA/EJB QL. In most cases, you can compose a query directly in a given query language or, preferably, you can construct a DatabaseQuery with an appropriate Call and specify selection criteria using a TopLink Expression. Although composing a query directly in SQL appears to be the simplest approach (and for simple operations or operations on unmapped data, it is), using the DatabaseQuery approach offers the compelling advantage of confining your query to your domain object model and avoiding dependence on data source schema implementation details.
Some queries are implicitly constructed for you based on passed in arguments and executed in one step (for example, session queries) and others you create explicitly, configure, and then execute, such as database queries.
To create a query:
The Queries tab allows you to create and manage queries associated with a TopLink descriptor. You can create a named query in the Named Queries section, or create a custom query in the Custom Calls section.
The TopLink basic query API includes support for the following, most commonly used queries:
The TopLink query API also allows the use of the following, more advanced query API calls and techniques:
For more information about advanced query API, see the Oracle Fusion Middleware Developer's Guide for Oracle TopLink.
A redirect query is a named query that delegates query execution control to your application. redirect queried allow you to define the query implementation in code as a static method. To perform complex operations, you can combine query redirectors with the TopLink query framework.
To make a query time-aware, you specify an AsOfClause that TopLink appends to the query. Use the AsOfClause class if your historical schema is based on time stamps or the AsOfSCNClause class if your historical schema is based on database system change numbers. You can specify an AsOfClause at the time you acquire a historical session so that TopLink appends the same clause to all queries, or you can specify an AsOfClause on a query-by-query basis.
You can use a fetch group with a ReadObjectQuery or ReadAllQuery. When you execute the query, TopLink retrieves only the attributes in the fetch group. TopLink automatically executes a query to fetch all the attributes excluded from this subset when and if you call a getter method on any one of the excluded attributes.
In cases where you know that data is read-only, you can improve performance by specifying a query as read-only: this tells TopLink that any object returned by the query is immutable.
You can configure an object-level read query as read-only. When you execute such a query in the context of a UnitOfWork, TopLink returns a read-only, non-registered object. You can improve performance by querying read-only data in this way because the read-only objects need not be registered or checked for changes.
When you define descriptors for an interface to enable querying, TopLink supports querying on an interface, as follows:
When you query on a class that is part of an inheritance hierarchy, the session checks the descriptor to determine the type of the class, as follows:
You can set the query manager to automatically append an expression to every query it performs on a class. For example, you can add an expression that filters the database for the valid instances of a given class. Use this to do the following:
To create a finder for an entity bean that uses the TopLink query framework, you must define, declare, and configure it. For predefined finders, you do not need to explicitly create a finder. For default finders, you only need to define the finder method.
Cursors and streams are related mechanisms that let you work with large result sets efficiently. A stream is a view of a collection, which can be a file, a device, or a Vector. A stream provides access to the collection, one element at a time in sequence. This makes it possible to implement stream classes in which the stream does not contain all the objects of a collection at the same time.
Large result sets can be resource-intensive to collect and process. To improve performance and give the client more control over the returned results, configure TopLink queries to use a cursor or stream. Cursors & streams are supported by all subclasses of DataReadQuery and ReadAllQuery.
TopLink expressions let you specify query search criteria based on your domain object model. When you execute the query, TopLink translates these search criteria into the appropriate query language for your platform.
TopLink provides the following two public classes to support expressions:
Expression class represents an expression that can be anything from a simple constant to a complex clause with boolean logic. You can manipulate, group, and integrate expressions. ExpressionBuilder class is the factory for constructing new expressions. You can specify a selection criterion as an Expression with DatabaseQuery method setSelectionCriteria and in a finder that takes an Expression. A simple expression usually consists of the following parts:
GreaterThan, Equal, or Like. To create basic expressions for use in named queries:
A database transaction is a set of operations (create, update, or delete) that either succeed or fail as a single operation. The database discards, or rolls back, unsuccessful transactions, leaving the database in its original state. Transactions may be internal (that is, provided by TopLink) or external (provided by a source external to the application, such as an application server).
In TopLink, transactions are contained in the unit of work object. You acquire a unit of work from a session and using its API, you can control transactions directly or through a Java 2 Enterprise Edition (Java EE) application server transaction controller such as the Java Transaction API (JTA).
As a transaction is committed, the database maintains a log of all changes to the data. If all operations in the transaction succeed, the database allows the changes; if any part of the transaction fails, the database uses the log to roll back the changes.
Transactions execute in their own context, or logical space, isolated from other transactions and database operations. The transaction context is demarcated; that is, it has a defined structure that includes the following:
The degree to which concurrent (parallel) transactions on the same data are allowed to interact is determined by the level of transaction isolation configured. ANSI/SQL defines four levels of database transaction isolation. Each offers a trade-off between performance and resistance from the following unwanted actions:
The unit of work isolates changes in a transaction from other threads until it successfully commits the changes to the database. Unlike other transaction mechanisms, the unit of work automatically manages changes to the objects in the transaction, the order of the changes, and changes that might invalidate other TopLink caches. The unit of work manages these issues by calculating a minimal change set, ordering the database calls to comply with referential integrity rules and deadlock avoidance, and merging changed objects into the shared cache. In a clustered environment, the unit of work also synchronizes changes with the other servers in the coordinated cache.
Like any transaction, a unit of work transaction provides the following:
This chapter describes how you can develop, deploy, and administer secure Java EE applications in Oracle JDeveloper.
This chapter includes the following sections:
The Fusion Middleware Suite lets you develop, deploy, and administer secure applications. You can secure Java EE applications using only container-managed security or, for Fusion web applications, you can use Oracle ADF Security. Fusion web applications are Java EE applications that you develop using the Oracle Application Development Framework (Oracle ADF).
A Java EE application can be enhanced to use OPSS. In this scenario, you work with JDeveloper's declarative editors to configure users and roles. You secure application resources using Java EE container-managed security.
This scenario is a fully declarative implementation that adds ADF Security to enable fine-grained security policies for Oracle ADF resources. You work with JDeveloper's declarative editors to configure a file-based identity store, policy store, and credential store; and, because your application utilizes Oracle ADF, you also run a wizard to configure security for web pages associated with ADF resources (such as ADF task flows and ADF page definitions) and then use the jazn-data.xml policy editor to define security policies.
The Java EE security model is a role-based, declarative model based on container-managed security, where resources are protected by roles that are assigned to users. This model allows decoupling an application from its underlying security infrastructure since security can be specified separately from the application logic in an application deployment descriptor. The container, where an application runs, provides security for the application according to a specifications in the deployment descriptor. This model also allows embedding security data (annotations) in the application code that can be referenced in deployment descriptors.
For more information about container-managed security, see the Oracle Fusion Middleware Security Guide.
The Oracle ADF Security framework is the preferred technology to provide authentication and authorization services to the Fusion web application. A prime reason is that Oracle ADF Security is built on top of the Oracle Platform Security Services (OPSS) architecture, which provides a critical security framework and is itself well-integrated with Oracle WebLogic Server.
For more information about Oracle ADF security, see the "Enabling ADF Security in a Fusion Web Application" chapter of the Oracle Fusion Middleware Developer's Guide for ADF.
For more information on OPSS, see the Oracle Fusion Middleware Application Security Guide.
When developing secure applications in JDeveloper it is often useful to think of development and deployment (to the production environment) as different phases, each with different needs. This is because during development and testing, JDeveloper supports easy to manage file-based security through integration with Oracle Platform Security Services (OPSS).
JDeveloper simplifies the application development life-cycle for security, and allows you to store the data in a flat file, for easy development. The jazn-data.xml file is JDeveloper's default file-based security provider for integration with OPSS. The jazn-data.xml file stores the users, groups, roles, and policies that you define the Fusion web application built using the Oracle Application Development Framework (Oracle ADF) and Oracle ADF Security. JDeveloper provides a dedicated editor for this file that simplifies creating the security data stores.
A feature of OPSS is the abstraction of users defined by the production environment's enterprise roles into application roles that are specific to the functions of your application. During development the application developer adds application roles and security policies that use application roles to the policy store of the jazn-data.xml file. Then, to simplify testing, the developer may add a few users to the identity store and directly assign these test users to application roles. Therefore, for testing the application, the jazn-data.xml can also be used as the identity store.
During development, your application does not ned to be aware of the enterprise roles defined in the production environment. After deployment an administrator will use Oracle Enterprise Manager Fusion Middleware Control to map the production-level enterprise roles to the application roles of your application's policy store. This mapping will allow a user who is a member of a given enterprise role to have access to the resources that are accessible from the associated application role.
After you complete the application, you migrate the policy store to the production environment provider on Oracle WebLogic Server. At that point, you will replace your test user identity store with enterprise users configured in the Oracle WebLogic Server embedded LDAP server. In contrast to the jazn-data.xml file, the LDAP server supports a distributed application server configuration that may be employed in a production environment. For details about the LDAP server, see Oracle Fusion Middleware Securing Oracle WebLogic Server.
Therefore, working with the file-based provider and OPSS in JDeveloper helps separate the demands of the production environment through:
system-jazn-data.xml security provider during deployment Java EE declarative security in Oracle WebLogic Server is implemented with Oracle Platform Security Services (OPSS), Oracle's implementation of the JAAS standard. OPSS extends Java EE security to provide application developers, system integrators, security administrators, and independent software vendors with a portable, integrated, and comprehensive security platform framework for Java SE and Java EE applications.
To learn more about OPSS and its features, see Oracle Fusion Middleware Security Guide.
JDeveloper provides tools to support configuring Java EE security for web applications and for deploying secure web applications to an application server instance. A developer, while developing an application, can configure OPSS services from JDeveloper through wizards and editors.
JDeveloper provides specific editors to create and edit Oracle Platform Security configurations (jps-config.xml), JAAS configurations (jazn-data.xml), and Web application deployment descriptors (web.xml). JDeveloper also supports direct deployment of web applications to application servers. For more information, see Section 14.2, "Securing Applications in Phases."
When you develop web applications you may choose to use Oracle Application Development Framework (Oracle ADF) to work with data-aware components in the user interface. When your user interface contains ADF resources, such as ADF task flows and ADF page definitions, then you have the option to secure the web pages that rely on those resources through the ADF Security framework. JDeveloper tools support iterative development of security so you can easily create, test, and edit security policies that you create for ADF resources. You can proceed to create test users in JDeveloper and run the application in Integrated WebLogic Server to simulate how end users will access the secured resources. For more information, see. Section 14.5.2, "How to Secure ADF Resources Using ADF Security in Fusion Web Applications."
For more information on web application security, see Oracle Fusion Middleware Programming Security for Oracle WebLogic Server.
Authentication in declarative security is enforced when a user requests a protected web application area.
Authentication in declarative security is enforced when a user requests a protected web application area. If the user has not been authenticated before, the container will retrieve credentials from the user. Users stay authenticated throughout the server session.
The supported types of authentication are: FORM based authentication, BASIC authentication, and CLIENT-CERT authentication. The type of authentication is specified in the web.xml deployment descriptor using the <login-config> element.
BASIC authentication uses the browser login dialog for the user to enter his user name and password. This dialog form cannot be customized and thus varies in its look and feel depending on the type of browser used. The user credentials are stored in the browser session for the authenticated realm. A realm is a repository that contains a set of permissions for the authenticated user. The default realm in Oracle Platform Security Services is jazn.com.
The code snippet in Example 14-1 demonstrates how BASIC authentication is specified in the web.xml file:
FORM based authentication allows the application developer to specify a custom login dialog. The username parameter must have a name of j_username, the password field must be named j_password. The login form action must have a value of j_security_check for the Java EE container to authenticate the request.
The code snippet in Example 14-2 demonstrates how FORM authentication is specified in the web.xml file:
CLIENT-CERT authentication uses the X.509 certificate to authenticate users. This type of authentication is also known as public key encryption.
For more information about authentication type choices, see the Oracle Fusion Middleware Security Guide.
For more information about authentication type using Oracle WebLogic Server, see Oracle Fusion Middleware Programming Security for Oracle WebLogic Server.
As password encryption is specific to a WebLogic Server domain, you must manually add the password handling to the weblogic-jdbc.xml file. To encrypt a password, use the encrypt utility (weblogic.security.Encrypt) for the domain to which you want to deploy.
| Note: Passwords are domain-specific, so each time you want to deploy to a different domain you must re-encrypt the password for the target domain |
The XML code you need to add to the weblogic-jdbc.xml should look something like this:
You can either put the clear text password or the encrypted password string in between the tags. This element goes inside of the <jdbc-driver-params> element, which will already be present in the weblogic-jdbc.xml if it has been edited using the Overview Editor.
The weblogic.security.Encrypt utility encrypts cleartext strings for use with WebLogic Server. The utility uses the encryption service of the current directory, or the encryption service for a specified WebLogic Server domain root directory.
| Note: An encrypted string must have been encrypted by the encryption service in the WebLogic Server domain where it will be used. If not, the server will not be able to decrypt the string. |
You can only run the weblogic.security.Encrypt utility on a machine that has at least one server instance in a WebLogic Server domain; it cannot be run from a client. Table 14-1 defines the arguments for the weblogic.security.Encrypt utility.
| Note: It is recommended that you run the utility from the Administration Server domain directory or on the machine hosting the Administration Server and specifying a domain root directory. |
Syntax
Table 14-1 Arguments for the weblogic.security.Encrypt utility
| Argument | Definition |
|---|---|
|
| Optional. WebLogic Server domain directory in which the encrypted string will be used. If not specified, the default domain root directory is the current directory (the directory in which the utility is being run). |
|
| Optional. Allows echoing characters entered on the command line. weblogic.security.Encrypt expects that no-echo is available; if no-echo is not available, set this property to true. |
|
| Optional. Cleartext string to be encrypted. If omitted from the command line, you will be prompted to enter a password. |
Examples
The utility returns an encrypted string using the encryption service of the domain located in the current directory:
The utility returns an encrypted string using the encryption service of the specified domain location:
The utility returns an encrypted string in the current directory, without echoing the password:
An identity store is a data store of users, enterprise roles (user groups), and login credentials. The credentials are verified during authentication and used to authorize the user's access to application functions.
Understanding Users, Roles, and Realms
A user is an end user accessing a service; it could be an individual or a software component. A enterprise role is a collection of users that you group with the purpose of conferring the same set of permissions. A realm is a collection of authenticated users and enterprise roles.
For more information about users, enterprise roles, and realms, see the Oracle Fusion Middleware Security Guide.
Understanding Identity Stores in JDeveloper
When you develop secure applications in JDeveloper, you work with a file-based data store to define the users you wish to allow to log on. The advantage of defining a file-based identity store through the jazn-data.xml file is that it supports easy testing yet remains compatible with deployment to your production environment through migration to the system-jazn-data.xml file. It also avoids the complexity of setting up and maintaining an Oracle Internet Directory service for the LDAP-based identity store.
When you create a Fusion web application with Oracle ADF, the identity store will be created automatically when you run the Configure ADF Security wizard.
| Note: The LDAP-based identity store is a design time feature in JDeveloper, and is not available at runtime. JDeveloper's Integrated WebLogic Server overrides any LDAP identity store configuration. |
For more information about identity stores, see the Oracle Fusion Middleware Security Guide.
To create an identity store:
jps-config.xml Overview Editor. idstore.xml. idstore.oid. Note: The LDAP-based identity store is a design time feature in JDeveloper, and is not available at runtime. The Integrated WebLogic Server in JDeveloper overrides any LDAP identity store configuration.
The identity store is an XML file that stores users and enterprise roles, and is used while authenticating users. There can be an identity store at either the domain or application level.
To add users to the identity store:
jazn-data.xml file. jazn-data.xml file. An enterprise role is a set of users that you group with the intention of conferring the same permission grants. You add enterprise roles to the identity store. You add application roles to the policy store.
| Note: Before adding a user to an enterprise role, ensure that you have created users in the identity store |
To add roles to the identity store:
jazn-data.xml file. To manage users assigned to enterprise roles:
jazn-data.xml file. To view assigned enterprise roles:
jazn-data.xml file. A credential store is a wallet-based file for storage of system credentials required by Oracle Platform Security Services (OPSS) in connecting to external systems such as databases. In JDeveloper, the credential store is the cwallet.sso file. The file contains all your OPSS-based credentials, and will be used in JDeveloper to store credentials that you define for Oracle ADF security. This file is normally not edited directly.
JDeveloper checks for the existence of a credential store service instance and creates the store the first time the you create a connection, for example, a database connection, in the Application Resources panel of the Application Navigator.
For more information about credential stores, see the Oracle Fusion Middleware Security Guide.
To create a credential store:
jps-config.xml file in the Descriptors > META-INF folder in the Application Resources panel of the Application Navigator. jps-config.xml Overview Editor. | Note: You can create only one credential store in an application. |
A login module is a component that authenticates users and populates a subject with principals. Login modules can be plugged in and used by applications without changing application code. An application can use more than one login module.
The login authentication process occurs in two distinct phases:
All login modules in a domain are configured in the file jps-config.xml using the following elements:
serviceProvider — to define a service provider for the login module. serviceInstance — to define one or more instances of the service provider jpsContext — to specify which instances to use In JDeveloper, you can choose a pre-defined login module for your application, or create a new custom login module. Table 14-2 contains the pre-defined login modules that are available in JDeveloper:
Table 14-2 Predefined Login Modules
| Module | Description |
|---|---|
|
| Used for SAML token assertion and implements the |
|
| Used for Kerberos token assertion and implements |
| wss.digest.loginmodule | Used to authenticate the digest based user name token based on WSS Digest specification and implements |
| certificate.authenticator. loginmodule | Used to assert the X509 certificates and implements |
|
| Used to authenticate the user based on valid user name and password, and implements |
| user.assertion.loginmodule | Used to authenticate the user based on valid user name and password, and implements |
|
| Used to authenticate JSE bases use cases and implements |
For more information about login modules, see the Oracle Fusion Middleware Security Guide.
To add a login module:
jps-config.xml file in the Descriptors > META-INF folder in the Application Resources panel of the Application Navigator. jps-config.xml Overview Editor. A key Oracle Platform Security component is the login service. Conceptually, the login service is an adapter that ties the JAAS login module SPI (javax.security.auth.spi.LoginModule) to the Oracle Platform Security for Java framework (OPSS).
The primary role of the login service is to enable JAAS login module implementations to be configured and used in OPSS.
To add a custom login module:
jps-config.xml Overview Editor. A key store is a repository of private keys and digital certificates.
If you have keys and certificates and wish to use them for secure services in your application, JDeveloper allows you to import a Java Key Store, Oracle Wallet (from a *.sso or *.p12 file), or PCKS12 file (from a *.p12 file). You cannot create a key store in JDeveloper.
For more information about key stores and key store providers, see the Oracle Fusion Middleware Understanding Security for Oracle WebLogic Server guide.
To add a key store:
jps-config.xml Overview Editor. *.jks file), Oracle Wallet (from a *.sso or *.p12 file), or PCKS12 (from a *.p12 file) file as a key store. The anonymous provider is an alternative to public pages in that unauthenticated user access can have permissions assigned that are more fine grained than allowing access to the whole (public) page.
Enabling the anonymous provider creates an anonymous JpsContext, which contains the anonymous service instance and the anonymous login module. Anonymous credentials will be used at runtime when the application user has not been authenticated and the application allows some resources to be accessible without authentication.
For more information about the anonymous provider, see the Oracle Fusion Middleware Security Guide.
To enable an anonymous provider for a web application:
jps-config.xml Overview Editor. Credentials contain the authentication password for a user. The credentials appear in obfuscated form by default. Before adding credentials in the identity store, the member users must first be defined for the identity store.
To add credentials to users in the identity store:
jazn-data.xml. Authentication in declarative security is enforced when a user requests a protected web application area. If the user has not been authenticated before, the container will retrieve credentials from the user. Users stay authenticated throughout the server session.
The supported types of authentication are: FORM based authentication, BASIC authentication, and CLIENT-CERT authentication. The type of authentication is specified in the web.xml deployment descriptor using the <login-config> element.
For more information on authentication types, see Section 14.4.1, "About Authentication Type Choices".
To select the authentication type for the web application:
web.xml for the application in the Application Navigator. web.xml Overview Editor. Web pages and other resources of the web application should be secured. Depending on the type of application, you can secure your application in one of the two following ways:
Using OPSS Security
The following tasks outline the process of securing an application using Java EE security:
Using Oracle ADF Security
You can use the Oracle ADF Security framework to provide authentication and authorization services to the Fusion web application.
For more information about Oracle ADF security, see the "Enabling ADF Security in a Fusion Web Application" chapter of the Oracle Fusion Developer's Guide for ADF.
JDeveloper enables you to secure your application resource types. The resource types can be known, that is, recognized by JDeveloper, or you can create your own resource type.
A resource type represents the type of a secured artifact, such as a flow, a job, or a web service, and, essentially, it is a template for creating resources of a particular type. All resources have an associated type and are filtered or grouped according to type.
To secure an application resource:
jazn-data.xml file. jazn-data.xml file. Security policies that you define in a Fusion web application support fine-grained access control for ADF security-aware resources, including ADF task flows and ADF page definitions. To enable ADF security policies, you begin by running the Configure ADF Security wizard on the user interface project.
After you enable ADF Security you must grant users access rights so that they may view the web pages of the Fusion web application. Access rights that you grant users are known as a security policy that you specify for the page's corresponding ADF security-aware resource. Ultimately, it is the security policy on the ADF resource that controls the user's ability to enter a task flow or view a web page:
ADF security policies are maintained in the file-based jazn-data.xml policy store. Defining and updating ADF security policies in JDeveloper is supported by the overview editor for this file. The resulting declarative ADF security policies are easy to read.
The detailed steps for securing Oracle ADF resources are in the "Enabling ADF Security in a Fusion Web Application" chapter of the Oracle Fusion Developer's Guide for ADF.
To define security policies for ADF resources:
If your application contains top-level web pages that are not associated with an ADF resource because they do not contain data-aware components, you can optionally secure these pages too.
Security policies for web application resources are stored in the application-level policy store.
A Policy Store is the repository of application and enterprise policies. A policy specifies the permissions granted to code running from a specific location.
An Application Policy Store is a repository of application policies together with application roles, application policies, principals, and permissions. Application roles can include application users and roles, and roles specific to the application (such as administrative roles). A policy can use any of these roles or users as principals. Similarly, a System Policy store is a repository of system policies, principals, and permissions. A system policy store does not contain roles.
When you create a Fusion web application with Oracle ADF, the policy store will be created automatically when you run the Configure ADF Security wizard.
The difference between an application policy store and a system policy store is in their scope. An application policy store is constrained within an application limiting it's accessibility, where as a system policy store can be accessed openly.
For more information on policy stores, see the Oracle Fusion Middleware Security Guide.
A Principal is an identity assigned to an entity; the entity could be a user or a role. A Permission is a set of operations allowed for a group of entities; the entity could be a principal too. A Grant, or a custom policy, includes permissions and principals. In JDeveloper, you cannot create a principal or a permission without creating a grant.
A Principal is an identity assigned to an entity; the entity could be a user or a role. A Permission is a set of operations allowed for a group of entities; the entity could be a principal too. A Grant, or a custom policy, includes permissions and principals. In JDeveloper, you cannot create a principal or a permission without creating a grant.
Application roles are specific to an application and defined in the application policy store. They are used by the application directly (either a Java SE or Java EE application) and are not necessarily known to the Java EE container. In the file-based policy store in a jazn-data.xml file, these application roles are defined in <app-role> elements under <policy-store>, and then written to system-jazn-data.xml at the domain level during deployment.
To add application roles to the application policy store:
jazn-data.xml file. jazn-data.xml file. For more information, see the Oracle Fusion Middleware Securing Resources Using Roles and Policies for Oracle WebLogic Server guide.
Deployment users and roles are defined in the security provider that you use. For the file-based provider, deployment users and roles are defined in the jazn-data.xml file.
| Note: Before adding member users or member roles to an application role, the member users and member roles must first be defined for the identity store. |
To add users or enterprise roles to an application role:
jazn-data.xml file. jazn-data.xml file. You can create custom resource types and specify them in the jazn-data.xml file.
A resource type represents the type of a secured artifact, such as a flow, a job, or a web service, and, essentially, it is a template for creating resources of a particular type. All resources have an associated type and are filtered or grouped according to type.
To create a custom resource type:
jazn-data.xml file. jazn-data.xml file. You can add application resource grants to an application policy store by updating the Resource Grants page of the overview editor for jazn-data.xml.
A resource is an instance of a resource type that represents a concrete resource; it defines an application resource that can be secured by a policy, such as software components managed by a container (for example, URLs, EJBs, JSPs) or an application business (for example, Reports, Transactions, Revenue Charts).
To add a resource grant for the application policy store:
jazn-data.xml file. Using the Entitlement Grants page of the overview editor for jazn-data.xml, you can define a set of resource permissions and grant those permissions to multiple application roles without having to grant each permission to each application role individually.
An entitlement is a collection of permissions. Typically, it encapsulates the list of permissions needed to perform a given business function or task.
To add entitlement grants to an application policy store:
jazn-data.xml file. jazn-data.xml file. | Tips:
|
A new permission class is useful when you want to create your own JAAS permission for a logical artifact type to secure. For example, although Oracle ADF already provides built-in permission classes for the artifacts on which it enforces security (including task flows, page definitions, entity objects, and entity attributes), you might create a custom permission class for a set of UI components that you want to secure in the user interface. Once this class is created, you can add enforcement checks using Java, Expression Language (EL), or embedded Groovy expressions, and then you can grant the new custom permission class to application roles by editing the jazn-data.xml file directly. For example, you could define a security policy to limit access to a menu that your application displays and then associate the rendering of the menu with the user's granted custom permission using the EL value userGrantedPermission on the component's rendered property.
To create a custom JAAS-compliant permission class:
Currently, this release does not provide an editor to add system permission grants to a system policy store; you will need to manually add grants in the source code for jazn-data.xml.
To add a grant to the system policy:
jazn-data.xml to open the overview editor. <jazn-data> element, create a <jazn-policy> element. <jazn-policy> element create a <grant> element that defines the <grantee> with the desired application role and the <permission> with the fully qualified class name of the permission class, the name that you want to use as the target for the grant, and the action that you want to grant to the application role principal. jazn-data.xml file. JDeveloper is configured by default to deploy the security objects from your application repositories to Integrated WebLogic Server each time you run the application. You can change this behavior by selecting security deployment options in the Application Properties dialog to:
jazn-data.xml file. If you make no changes to the deployment settings, each time you run the application, JDeveloper will overwrite the domain-level security policies and system credentials. Additionally, JDeveloper will migrate new user identities you create for test purposes and update existing user passwords in the embedded LDAP server that Integrated WebLogic Server uses for its identity store. However, if you prefer to run the application without updating the existing security objects in Integrated WebLogic Server, you have this option.
When you are ready to deploy the application to standalone Oracle WebLogic Server, you can use the same configuration settings to control how JDeveloper handles migration of the security objects.
To configure deployment of security objects:
By default, each time your run the application, JDeveloper will overwrite the application policies and credentials at the domain level with those from the application. If you prefer not to overwrite either of these repositories, deselect Application Policies or Credentials. When deselected, JDeveloper will merge only new policies or credentials into the domain-level stores. For further details, see the sections below.
By default, each time you run the application, JDeveloper will migrate new user identities you create for test purposes and update existing user passwords in the embedded LDAP server that Integrated WebLogic Server uses for its identity store. You can disable migration of the application identity store by deselecting Users and Groups. For further details, see the sections below.
Application policies, specified in jazn-data.xml, can be migrated to a domain policy store when the application is deployed to a server in the Oracle WebLogic Server environment. If desired, the policies can also be removed from the domain policy store when the application is undeployed, or updated when the application is redeployed.
If Application Policies is selected in the Application Properties dialog, a jps.policystore.migration property is set to OVERWRITE in the packaged weblogic-application.xml when you deploy the application using JDeveloper. If Application Policies is unselected, the jps.policystore.migration setting will not be added to the packaged weblogic-application.xml, and will be removed if it is already present. This causes the default operation MERGE to be used by Oracle WebLogic Server. Merge will only migrate policies the first time the application is deployed if they do not already exist. If the policies for the application already exist, they will not be remigrated.
To find out more about automatic and manual migration of application policies, see the Oracle Fusion Middleware Security Guide.
When you migrate your application policies, you might also want to migrate your credentials. Application credentials, specified in cwallet.sso, can be migrated to a domain credential store when the application is deployed or redeployed to a managed server in the WebLogic environment. Thus, credential migration includes the passwords for all connections created within JDeveloper, including those created for web services. (This is not related to user credentials specified in the identity store of the jazn-data.xml file. See Section 14.7.4, "Migrating Users and Groups" below for details about identity store migration.)
If Credentials is selected in the Application Properties dialog, a jps.policystore.migration property is set to OVERWRITE in the packaged weblogic-application.xml when you deploy the application in JDeveloper. If Credentials is unselected, the jps.policystore.migration setting will not be added to the packaged weblogic-application.xml, and will be removed if it is already present. This causes the default operation MERGE to be used by Oracle WebLogic Server. Merge will only migrate credentials the first time the application is deployed if they do not already exist. If the credentials for the application already exist, they will not be remigrated.
The credential migration is possible only when the server is running in development mode only. In production mode, credential overwrite is prohibited. Application credentials must be manually migrated when you deploy using tools outside of JDeveloper.
Users and roles, specified in jazn-data.xml, can be migrated to a domain identity store when the application is deployed to a server in the WebLogic environment.
If Users and Groups is selected in the Application Properties dialog, JDeveloper will make calls when you deploy the application to create Oracle WebLogic Server users and groups corresponding to the application's jazn-data.xml users and role. If the user already exists in the domain store, only the description and password will be remigrated during deployment. If a group exists in the domain store with the same name as the roles in the jazn-data.xml file, it will be replaced entirely. If Users and Groups is unselected, JDeveloper will not try to migrate the identity store from the application jazn-data.xml.
| Note: Before migrating users and groups ensure that administrator roles (admin) and users (weblogic) are not used in the application jazn-data.xml file so that the domain identity store is not overwritten. When your application is ready for deployment to a production environment, you should remove the identities from the jazn-data.xml file or disable the migration of identities by deselecting Users and Groups from the Application Properties dialog. |
A JDBC database connection created in JDeveloper derives its encryption properties from the database client install on your machine. To create a secure connection using JDBC:
This chapter describes how to create and update applications using the XML tools and editors provided by JDeveloper.
This chapter includes the following sections:
JDeveloper provides you with the tools you need to work with the XML files in your application. There is an XML source editor, an XML validator, and tools for working with XML schemas. You can also use JDeveloper to create and edit your XSQL files. It provides a robust XML editing environment that allows you to create and edit many different types of XML files in your application.
XML Schema development is easy with JDeveloper. You can create a schema document from scratch, generate schemas from XML documents or vice-versa. Once your schema is created, manage your elements using the XSD Visual Editor and the Component Palette. For more information, see Section 15.5, "Working with XML Schemas".
You can also create XSQL files from scratch or edit existing files. JDeveloper provides a complete development environment to simplify the task of developing databound XML pages with XSQL servlet. For more information, see Section 15.6, "Developing Databound XML Pages with XSQL Servlet".
JDeveloper provides three different editors for working with your an XML files.
Table 15-1 summarizes the editing features that are available when you're working with XML files.
Table 15-1 XML Editing Features
| Feature | Purpose |
|---|---|
| Code Insight | While you are typing, you can invoke Code Insight by pausing after typing the |
| XML Validation | In an open XML Source Editor window, or in the Application Navigator, right-click an XML file and choose Validate XML. The Validate XML command will validate the XML against a schema registered with JDeveloper defined in the XML file. To register a schema with JDeveloper choose Tools > Preferences > XML Schemas. This command on the context menu is disabled whenever an XML file does not have an XML namespace defined. |
| Quick Form Check | Right-click on an XML file and choose Make to check for well-formedness of the file. |
| XML Schemas Preferences | Use the options on the XML Schemas page in the Preferences dialog to view all the currently registered XML schemas, to add new schemas, to support additional namespaces and elements, to remove user-defined schemas, and to unload schemas from memory. To get to the Preferences dialog choose Tools > Preferences > XML Schemas. |
| XML Preferences | These features can be customized in the XML Preferences page. Choose Tools > Preferences > Code Editor > XML and JSP/HTML to display XML Preferences. If Required Attribute Insertion is selected, the required attributes of an element will also be inserted for you. If End Tag Completion is selected, the end tag will be automatically inserted when you close the start tag, for example if you have |
| Component Palette | You can choose View > Component Palette to open the palette and select one of the available pages from the dropdown list. For example, while editing XSD files, you can select elements from the XML Schema pages on the palette. |
| Property Inspector | The Property Inspector displays attributes of elements in the file. You can edit the values of attributes in the Property Inspector to update your file. |
| Structure Window | A file's elements are displayed hierarchically in the Structure window, which also displays any XML syntax errors found as you type and edit. You can double-click on an element or error to edit it in the XML editor. |
| Validate XML | In an open XML editor window, or in the Application Navigator, right-click an XML file and choose Validate XML. The Validate XML command will validate the XML against the schema defined in the XML file. It validates the XML constraints and definitions but not XSDs. This context-menu command is disabled whenever an XML file does not have an XML namespace defined. |
| F2 Key | After creating an XML schema, select an element in the Structure window and press F2. The element now has focus in the XML design editor. You are automatically able to input new text for the element into the XML design editor. |
| Expand/Collapse Attributes | You can expand or collapse attributes that display under the complexType element. This is convenient because the list of attributes that display under the element can be large. |
Table 15-2 contains the icons that display on the XML Editor toolbar.
Table 15-2 XML Editor Toolbar Icons
| Icon | Name | Description |
|---|---|---|
|
| Search ( | Enter search text in the XML Editor. Click the down arrow to view and set additional parameters for the search, including Match Case to perform a case-sensitive search, Whole Word to locate complete word matches only, and Highlight Occurrences to use shading to show the location of the match. |
|
| Find Next ( | Click to locate the first occurrence of the text that meets the specified parameters in the file. |
|
| Find Previous ( | Click to locate the previous occurrence of the text that meets the specified parameters in the file. |
The New Gallery offers several different XML file type options, as shown in Table 15-3. To create a new XML file choose File menu > New > General > XML.
Table 15-3 XML File Types
| File Type | Description |
|---|---|
| XML Document | Create a new XML file that includes only the |
| XML Document from XML Schema | Generates an XML document from an existing XML schema. |
| XML Localization File (XLIFF) | Creates an XML-based localization file with an .xlf extension. For more information, see Section 15.3.1, "Localizing with XML". |
| XML Document from XML Schema | Generates as XML Document from an XML Schema. |
| XQuery File | Creates an XQuery File with an .xq extension. For more information, see Section 15.4.2, "Using XQuery with XML". |
| XSL Map | Creates an XSL Map File with an .xsl extension. |
| XSL Map from XSL Stylesheet | Creates an XSL Map File with an .xsl extension from an XSL Stylesheet. |
| XSL Stylesheet | Creates an XSL Stylesheet with an .xsl extension. For more information, see Section 15.6.12, "How to Create an XSL Style Sheet for XSQL Files". |
| XSQL File | Creates an XSQL file with an .xsql extension. For more information, see Section 15.6.2, "How to Create an XSQL File". |
JDeveloper has tools to support full localization for your application based on XML-based XLIFF technology. XLIFF supports a full localization process by providing tags and attributes that hold the data your translators and vendors will use when you internationalize your application.
You create a new XMLFF file in the JDeveloper New Gallery under the XML node.
To create a new XLIFF file:
Choose File menu >New > General > XML > XML Localization File.
For more information on XLIFF, see the OASIS open standard website at, http://www.oasis-open.org/home/index.php
The main elements in an XLIFF file are the trans-unit elements. These elements store localizable text and its translations. These elements represent segments (usually sentences in the source file that can be translated reasonably independently). The trans-unit elements contain source, target, alt-trans, and a handful of other elements.
There are also elements for review comments, the translation status of individual strings, and metrics such as word counts of the source sentences. The XLIFF file consists of one or more file elements. Each of these contains a header and a body section. The header contains project data, such as contact information, project phases, pointers to reference material, and information on the skeleton file.
JDeveloper uses Resource Bundles to hold all of the localization information, including the XLIFF files. When you create content in a JSF page, a resource bundle is automatically created for you in that project.
Use the options on the XML Schemas page in the Preferences dialog to view all the currently registered XML schemas, add new schemas to support additional namespaces and elements, remove user-defined schemas, and unload schemas from memory.
To import and register an XML schema:
JDeveloper automatically validates the schema when you add it.
| Tips: You can only remove user-defined schemas with the Remove button.If a schema changes, you must use the Clear Cache button to unload all currently loaded schemas from memory. JDeveloper will then reload any needed schemas including the modified schema. |
You can add pages to the Component Palette in JDeveloper to include the elements from a registered schema or you can add elements to an existing page. Once you add the elements to the Palette, you can insert the elements into the XML file while you are editing, by selecting them from the Palette.
To add XML elements to the Component Palette:
Skip to step 4 if you do not want to add a new page.
Your new page name is added to the bottom of the Pages list in the Configure Component Palette dialog.
The XML Elements dialog displays the Registered Schemas.
You can also click Use Default Icon or Select Icon to select the icon that will display for an individual element on the Palette, before you click OK.
The name of the page you added displays in the dropdown list in the Palette. All the elements you added are displayed with angle brackets (< >) as the icon, if you accepted the default icon. If you do not see any element names on the Palette, right-click in the Palette and choose List View.
In JDeveloper you can use JAXB (Java Architecture for XML Binding) to generate Java classes from XML schemas. JAXB is an easy way to incorporate XML data and processing functions in Java applications without having to know XML. You can generate a JAXB 1.0 or 2.0 content model, including the necessary annotations, from an XML schema.
When the JAXB binding compiler is run against an XML schema, JAXB packages, classes, and interfaces are generated. You can then use the generated JAXB packages and the JAXB utility packages in a binding framework to unmarshal, marshal, and validate XML content.
To generate Java classes from XML schemas with JAXB:
The JAXB package and generated classes are added to the Application Resources folder.
The XML Source Editor in JDeveloper is a specialized schema-driven editor for editing XML languages including XSD, WSDL, XSQL, XHTML, and XSL files.
To edit an XML file in the XML Source Editor:
| Tip: To edit an XML document with the Component Palette, choose View > Component Palette to open the Palette and select one of the available pages from the dropdown list. Then choose elements from the page. |
When editing XML files in the XML Editor you can set two editing options.
To customize editing options for the XML Editor:
You can create and edit your XML-based XQuery files in JDeveloper. XQuery provides the means to extract and manipulate data from XML documents or any data source that can be viewed as XML, such as relational databases or office documents.
You create a new XQuery file in the JDeveloper New Gallery under the XML node.
To create a new XQuery file:
Choose File menu, > New, > General > XML > XQuery File.
For more information on XQuery, see the W3C website at, http://www.w3.org/TR/xquery/
XQuery uses XPath expression syntax to address specific parts of an XML document. It supplements this with a SQL-like "FLWOR expression" for performing joins. A FLWOR expression is constructed from the five clauses after which it is named: FOR, LET, WHERE, ORDER BY, RETURN.
The language is based on a tree-structured model of the information content of an XML document, containing seven kinds of node: document nodes, elements, attributes, text nodes, comments, processing instructions, and namespaces.
JDeveloper provides an XSD Visual Editor that gives a visual representation of the structure, content, and semantics of an XML document.
The JDeveloper XSD Visual Editor provides a visual representation of the structure, content, and semantics of an XML document. Use the XSD Visual Editor to author a new, or to edit an existing, XML Schema.
The selection of any component or attribute in the editor is indicated by highlighting the selected item in blue. In Figure 15-1, the selected simpleType component defines a simple type and specifies the constraints and information about the values of attributes or text-only components, in this case restricting the string type.
The XML Schema component is displayed at the top of an XSD file, as shown in Figure 15-2. Right-click the element and select Properties to display a dialog for configuring the schema namespaces.
The choice component allows only one of the components contained in the <choice> declaration to be present within the containing component, as shown in Figure 15-3. Set attribute maxOccurs to >1 to have more than one item from the choice in the parent.
The all component shown in Figure 15-4 specifies that the child components can appear in any order and that each child component can occur zero or one time.
The sequence component shown in Figure 15-5 specifies that the child components must appear in a sequence. Each child component can occur from 0 to any number of times.
In the example of cardinality shown in Figure 15-6, components are displayed with the following attributes:
In Figure 15-7, the complexType component extends a base type, and inherits an attribute and children from that base type. The yellow background represents a reference to the baseType defined elsewhere in the schema and illustrated below the complexType component. The component attributes are displayed as:
The attribute group component groups a set of attribute declarations so that they can be incorporated as a group into complex type definition.
Figure 15-8 displays three attribute groups.
If you add an element to a schema that has multiple attributeGroups, you can add choose one or more attributeGroups for the element by clicking on the element's attribute and choosing from a drop-down list.
The union component defines a simple type as a collection (union) of values from specified simple data types. In Figure 15-9, the union represents all strings that begin with the letter "i".
The list component defines a simple type component as a space separated list of values of a specified data type. In Figure 15-10, the component represents a series of short value objects.
Use the XML wizard in the New Gallery to help you quickly generate industry standard W3C XML schema (.xsd) from your XML (.xml) documents. Conversely, you can also generate XML documents from your XML schema.
To generate an XML schema from an XML document:
To generate an XML document from an XML schema
You can generate an XML schema document (XSD) file from a document type definition (DTDs) file.
To generate an XSD file from a DTD:
Open a schema (.xsd) file for editing in the XSD Visual Editor or XML Source Editor. By default new schema files are opened with the XSD Visual Editor in focus. Double-clicking a file in the Application Navigator opens or brings the default editor on the Design tab to the foreground. Clicking the Source tab opens the file in the XML Source Editor. Changes made in one editor are automatically updated in the other editor.
A schema file (.xsd) can be edited simultaneously with the visual and source editors by opening the page in one of the editors and using the splitter to open a second page view in the alternate editor.
To display a schema file in both editors:
In the XSD Visual Editor, you can quickly navigate an XML Schema that displays with scroll bars using a grab scroll operation. Use the grab scroll to invoke a small hand cursor to grab an XML Schema page and drag it inside the editor window.
To navigate using grab scroll in an XML Schema:
The pointer turns into an open hand cursor.
The hand closes and grabs the XML Schema page.
While working in the XSD Visual Editor or Design structure window, you can expand or collapse XSD components to display children components or collapse container components to create a higher level view of the schema.
To expand one level beyond the parent component:
Click the + (plus) sign of the parent component.
To collapse all levels below the parent component:
Click the - (minus) sign of the parent component.
To expand all parent components in the schema:
Press Ctrl + *, using the * on the numeric keypad of the keyboard.
| Note: This view can be big. |
Zooming enables you to magnify (zoom in) or shrink (zoom out) on the display of an XML Schema in the XSD Visual Editor.
To zoom in:
| Note: Use the Plus on the numeric keypad of the keyboard. |
To zoom out:
| Note: Use the Minus on the numeric keypad of the keyboard. |
One of the most common actions you perform in the XSD Visual Editor or Structure window (Design or Source view) is to select components in order to do something with them. There are several reasons for selecting components:
You can select a single component without children, a component along with its children, and multiple components.
To select a component:
If the selected component contains children, selecting the component also selects all its children. If you copy, move, or delete the parent, all its children are also copied, moved, or deleted.
| Tip: Double-clicking an XSD component in the XSD Visual Editor displays a property editor for the component. |
To select multiple components:
Selecting multiple, non-adjacent components for any reason other than deleting them can lead to unexpected results. For example, if the components exist at different levels in the schema hierarchy, they can lose their relative hierarchical positions if you move or copy them to another position in the schema page.
In the XSD Visual Editor it is possible to select a container component (and thereby select its children) and also explicitly select one or more of the children. That means that any explicitly selected child is selected twice. If you do this and then copy and past the selection, the double-selected child will be pasted twice, once as a child to the copied parent and once as a peer to the copied parent.
When a component is selected in the XSD Visual Editor, the component displays in blue. When a container component is selected and any of its children are also explicitly selected, all are displayed in blue.
When selected in the Structure window (Design or Source view), the component is highlighted. However, when you select any components with children, the children are also selected with it, even if their names are not selected. If you delete or move the parent, all the children are deleted or moved with it.
Whenever you select an component, you are also selecting a position in which another component can be inserted. For more information, see Section 15.5.9, "How to Select Target Positions for XSD Components".
| Tips: When you pass the mouse pointer over a component, a tooltip with the component's name is displayed. That makes it easier to know where to click to select a component.When you select a component in the XSD Visual Editor, it is also selected in the Design and Source view of Structure window, and vice versa. That means that you can look at the selection in both tools to clarify what is selected and where the insertion position is. The JDeveloper status bar explicitly states the insertion point for a selected component. |
While inserting, copying, or moving XSD components in the XSD Visual Editor or Structure window (Design or Source view), you need to select a target position in relation to the node on which you are performing the activity. The possible target positions on a node are before, after, and inside.
To select a target position:
Choose from one of the following options:


Not all options are always available. Choosing an option displays a submenu from which you can choose a component list and then select the component you desire. Depending on the node you select, the submenu may also contain one or more components that are eligible for insertion inside the selected node.
| Note: When you select a target position in the Design or Source views in the Structure window, the selection is also reflected in the XSD Visual Editor, and vice versa. This enables you to verify the insertion position visually as well as hierarchically. The selection is also explicitly stated in the status bar at the bottom of the JDeveloper window. |
In the XSD Visual Editor and Structure window (Design and Source view), you can insert XSD components by dragging from the Component Palette or by using a context menu. You can also insert XSD components by copying or by cutting and pasting. If you are cutting and pasting, you can insert multiple components at a time. For more information, see Section 15.5.13, "How to Cut, Copy, and Paste XSD Components".
| Note: Pasting multiple components that were copied from different places in the XML schema hierarchy can lead to unexpected results. |
To insert XSD components using the Component Palette:
You can also select the target position in the visual editor or Structure window and then click the desired component in the Component Palette.
| Tip: A brief description of a component appears when the cursor is placed over a component name in a list. For detailed help, right-click a components in the list and choose Help. |
To insert XSD components using the context menu:
Not all options in the context menu are always available. Choosing an option displays a submenu from which you can choose a component list and then select the component you desire. Depending on the node you select, the submenu may also contain one or more components that are eligible for insertion inside the selected node.
The Property Inspector displays the properties of XSD components selected in the XSD Visual Editor or the Structure (Design or Source view) window. Use the Property Inspector to set or modify the property values for any component in your XML Schema. Set property values are marked with a green square.
To undo changes, from the main menu select Edit, > Undo action. Use the Set to Default button to reset a property that has been set to its default value (if any).
To set a component's properties:
The Property Inspector displays the property values for the selected component. If the Property Inspector is not in view choose View > Property Inspector or use the shortcut Ctrl+Shift+I.
A brief description of the property is displayed at the bottom of the Property Inspector.
| Tip: To quickly locate a property in a long list, click the search button in the Property Inspector toolbar. In the Find text field, type the name of the property, then press Enter. |
| Tips: Double-click an XSD component or right-click the component and choose Properties to display a property editor for the component.In the property editor select an attribute and view a brief description in the status area below the editor. Click Help in the property editor for a link to a component reference topic. |
If you have multiple components selected, by default the Property Inspector displays all the properties of the selected components. Click the Union button in the Property Inspector toolbar to toggle between displaying all the properties of the selected components (union) and displaying only the properties that the selected components have in common (intersection). Values represented in italic font indicate common properties that have differing values.
To set properties for multiple components:
If the value is shown in italic font, the selected components have differing values. Editing the value of a shared property will cause all selected components to have the same value.
You can cut, copy, and paste XSD components in the XSD Visual Editor or Structure (Design or Source) window. You can perform these operations between files of the same project or different projects.
When you cut a component, it is removed from the editor and placed into a local clipboard only accessible by JDeveloper, not to the system clipboard. If you quit JDeveloper without pasting the component, the cut version of the component will be lost.
Deleting a component removes it without changing the contents. If you get in the habit of using the cut command to remove items permanently, there is a chance that one day you will inadvertently replace something in the clipboard that you would rather have kept. For more information, see Section 15.5.15, "How to Delete XSD Components".
To cut one or more components:
You can copy XSD components in the visual editor or the Structure window.
To copy one or more components:
The elements you cut or copy from the XSD Visual Editor or Structure window can be pasted into any other XSD file in JDeveloper. For more information, see Section 15.5.9, "How to Select Target Positions for XSD Components".
To paste an element:
You can move an XSD component to a new insertion point in the XSD Visual Editor or Structure (Design or Source view) window by dragging or by cutting and pasting. You can work in the visual editor or the Structure window to move components or work in both at once, moving components between the editors. Move an XSD component to a valid insertion point in another file in the same project or a different project by cutting and pasting. For more information, see Section 15.5.8, "How to Select XSD Components".
You can move one or multiple components at a time. However, you should be aware that selecting and moving multiple, non-adjacent components or multiple components from different levels in the schema hierarchy can lead to unexpected results.
To move components by dragging
In the visual editor or Structure window do either of the following:
To move components by cutting and pasting:
In the visual editor or Structure window do either of the following:
| Note: The selected components and all of its child components are moved to the new target position. |
You can remove components from your XML Schema in the XSD Visual Editor or Structure (Design or Source view) window. When you delete a component, JDeveloper deletes the associated lines from the source code.
To delete one or more XSD components:
JDeveloper provides a complete development environment to simplify the task of developing databound XML pages with XSQL servlet.
JDeveloper provides support for XSQL Servlet with these features:
XSQL servlet lets you create and use XSQL pages as clients. These pages are written in XML with embedded SQL queries and other data manipulation language (DML) statements. In addition, you can use action handlers to provide more functionality than SQL, such as writing the XML data to a file.
An action handler is an application that allows you to call a Java class from within an XSQL page. There are predefined action handlers that can talk directly to the database or to Business Components for Java (BC4J), and you can create your own.
An XSQL Servlet application has these logical layers:
XSQL servlets offer a simple and productive way to get XML in and out of the database. Using simple scripts developers can:
For example, a file such as emp.xsql in Example 15-1:
Example 15-1 emp.sql File
Generates the XML in Example 15-2:
Example 15-2 XML File
With JDeveloper, you can easily develop and execute XSQL files. The built-in web server and your default web browser will be used to display the resulting pages.
For more information on XSQL Servlet, see your Oracle9i documentation.
With JDeveloper, you can easily develop and execute XSQL files. The built-in web server and your default web browser will be used to display the resulting pages.
To create an XSQL file:
This will add a skeleton XSQL file named untitled#.xsql to your project, which opens in the XML Editor. You can type code in this editor, add tags by selecting them from the Component Palette, and modify the file with your own style sheet information.
JDeveloper's XML Editor supports syntax highlighting, Structure window view, and the Property Inspector. You can also select tags from the Component Palette to insert in your pages while you are editing.
To use the XML Editor to edit an XSQL file:
All XSQL tags can be inserted by selecting them from the Component Palette, as described below. You can also insert XSQL tags by typing them in the file. Code Insight is available for XSQL tags.
To add XSQL tags to a file:
<page xmlns:xsql="urn:oracle-xsql"> tag. If the tag has no attributes, it appears in the XSQL page immediately. If the tag has one or more attributes, a dialog displays.
The button you see and the number of dialogs depend on which tag you select. Notice that the tag and attributes you entered appear in the XSQL page.
After adding tags, you can view the raw XML data or format the XML data with a style sheet.
You can check your XSQL file to determine if it is a well-formed XML document and if not, to find any errors.
To check the syntax in an XSQL file:
In the Navigator, or in an open XML Editor window, right-click an XSQL file and choose Check XML Syntax.
The results display in the Log window.
| Note: The Validate XML command on this context menu is disabled whenever an XML file does not have an XML namespace defined. |
You can create XML based clients for XSQL servlets using XSQL tags. XSQL servlets allow you to easily get data in and out of the database in XML format. The following procedure shows how to use the XSQL Query tag to display data
To create an XSQL servlet client that directly accesses the database:
This adds a skeleton XSQL file named untitled#.xsql to your project.
<page xmlns:xsql="urn:oracle-xsql"> tag. The Query tag executes a SQL statement and includes its result set in XML format
For example, you might type select * from customer to display all the records in the customer database, based on the attributes you entered.
Notice that the Query tag and attributes you entered appear in the XSQL page.
You can format the XML data with a style sheet. The XML data also can be passed on to another application through a messaging service.
You can create XML based clients for business components using XSQL servlet. XSQL servlet allows you to easily get data in and out of the database in XML format. The following procedure shows how to bind an XSQL client to a business components project you have already created, using the ViewObject Show tag to display the view object's data in XML format. You could also use the ViewObject Update tag to process inserts, updates, and deletes to a view object.
To create an XSQL servlet client for business components:
This adds a skeleton XSQL file named untitled#.xsql to your project.
<page xmlns:xsql="urn:oracle-xsql"> tag. ViewObject Show tag from the Palette. The ViewObject Show tag shows the view object's data in XML format. The ViewObject Update processes inserts, updates, and deletes to a view object based on an optionally transformed XML document.
Notice that the tag and attributes you entered appear in the XSQL page.
You can format the XML data with a style sheet. The XML data also can be passed on to another application through a messaging service.
| Note: Please refer to the section titled "Caveats while Querying View Objects with Circular ViewLink Accessors" in the ViewObject Show F1 help topic if you get the XSQL error JBO-27122. |
To use XSQL pages with the Business Components XSQL action handlers, the XSQL Runtime and the JBO HTML libraries need to be in your project's classpath, in addition to any JBO libraries that are needed based on your intended connection mode. JDeveloper includes them in the classpath automatically.
An action handler in an XSQL page is a Java class that gets invoked to perform a specific task. There are prebuilt action handlers for various tasks such as setting cookies, applying style sheets, performing queries against databases, etc. However, if you choose to perform some operation which is not provided by the built-in action handlers, then you can write what is called a custom action handler. A custom action handler is a Java class that can be invoked from an XSQL page just as easily as a predefined action handler.
To create an action handler:
<page> tag. XSQLActionHandlerImpl class. The XSQL action handlers for BC4J are packaged as part of the JBO HTML library in JDeveloper, which includes the relevant: <JdevHome>/BC4J/jlib/bc4jhtml.jar archive in the build.
Example 15-3 Action Handler For XSQL
After you have completed your XSQL file, you should check your XML syntax and then run it.
To run an XSQL servlet file:
JDeveloper will scan the XSQL file looking for XML syntax errors and display the results in the Log window.
JDeveloper compiles the servlet. It then starts the Integrated WebLogic Server, launches your default web browser, and displays the output of the servlet in the browser.
After creating an XSQL file and adding tags, you can view the raw XML data or format the XML data with a style sheet.
To view an XSQL file as raw XML data:
Select the XSQL file in the Navigator, right-click and choose Run filename.xsql to open the source file in your web browser.
JDeveloper starts the Integrated WebLogic Server, launches your default web browser, and displays the raw XML data that is produced after the XSQL servlet processes the XSQL page.
After creating an XSQL file and adding tags, you can format the XML data with an XSL style sheet or view the raw XML data. You can use a style sheet you previously created or create a new one in JDeveloper and apply it. By applying a style sheet, you can convert the XML data into HTML or another markup language, such as wireless markup language (WML).
To format the XML data with a style sheet:
<?xml-stylesheet?> line by moving it below the --> closing comment bracket. YourStyleSheet.xsl with the name of your style sheet; for example, your style sheet could be named stylesheet1.xsl. Next, add the file that you just specified to your project, if you used one created outside of this project.
The file you added displays in the Navigator and opens in the XML Editor. You can close the open files.
You can see the formatted XML data in the browser.
In JDeveloper, you can create an XSL style sheet that you can apply to your XSQL files in order to format the data for HTML, WML or another output. When you create an XSL style sheet, it is added to the selected XSQL project.
To create an XSL style sheet:
A skeleton XSL file is generated and appears in your active project.
You can edit it in the XML Editor to create your own custom style sheet. An example of an XSL style sheet that transforms XML data into wireless markup language (WML) is provided below. When you are finished, you can specify the style sheet name in your XSQL file to format the raw XML data.
XSL Style Sheet Example
The style sheet in Example 15-4 demonstrates the conversion of XML to WML. It uses the default DeptView in a BC4J application.
Example 15-4 Conversion of XML to WML
The XSQL configuration file, XSQLConfig.xml, is on the classpath, so your XSQL pages always have access to it. The connection information is added to the XSQLConfig.xml file when you create a new connection in JDeveloper. XSQLConfig.xml is located in the system directory and gets copied to the WEB-INF directory when a project containing an XSQL file is compiled. You can add the file to your project if you need to modify it; for example, to register custom action handlers.
| Note: When you migrate an XSQL project in JDeveloper, the XSQLConfig.xml file is not updated for you. You can update your connections after migrating the project by recreating the connection or editing an existing connection in JDeveloper. |
To modify the XSQL configuration file for your project:
XSQLConfig.xml and click Open. The custom properties shown in Table 15-4 affect XML generation when using the writeXML method of a view object or row.
Table 15-4 Metadata Properties
| Property Name | Value | Valid For |
|---|---|---|
| XML_ELEMENT | a legal element name | view objects and view attributes |
| XML_ROW_ELEMENT | a legal element name | view objects |
| XML_CDATA | any value (not empty) | view attributes |
| XML_EXPLICIT_NULL | any value (not empty) | view objects and view attributes |
If the XML_ELEMENT custom property is present for a view object, its value is used as the XML element name for the view object in XML, when it is generated using the writeXML method and "consumed" by the readXML method.
If the XML_ELEMENT custom property is present for a view attribute, its value is used as the XML element name for the attribute in XML, when it is generated using the writeXML method and "consumed" by the readXML method.
For example, for a view object named DeptView with an attribute named Sal, setting:
would produce XML like:
Instead of the default:
If the XML_ROW_ELEMENT custom property is present for a view object, its value is used as the XML element name for each row of query results produced by the view object in XML, when it is generated using the writeXML method and "consumed" by the readXML method.
For example, for a view object named DeptView with an attribute named Sal, setting:
would produce XML like:
instead of the default:
If the XML_CDATA custom property is set to a not empty value for a view attribute, then its value will be output as a CDATA section instead of as plain text.
If the XML_EXPLICIT_NULL custom property is set to a not empty value for a view object, then any attribute with a null value will generate an XML element that looks like:
instead of omitting the <AttributeName> element from the XML result, which is the default.
If the XML_EXPLICIT_NULL custom property is set to a not empty value for a view attribute, then in the case that the indicated attribute has a null value, the system will generate an XML element that looks like:
instead of omitting the <AttributeName> element from the XML result, which is the default.
This chapter describes how JDeveloper provides powerful tools that help you discover and use existing web services, and develop and deploy new web services.
This chapter includes the following sections:
Web services consist of a set of messaging protocols and programming standards that expose business functions over the Internet using open standards. A web service is a discrete, reusable software component that is accessed programmatically over the Internet to return a response.
You can create web service clients to access existing web services. If you use web services in your application, you can create bottom-up (starting from Java) and top-down (starting from WSDL) web services as follows:
Once deployed, your web services can then be accessed and used in other applications.
You can quickly create a client to an existing web service in order to use it in your application. You can view all web services in the application under the Web Services folder in the Application Navigator.
In addition, JDeveloper incorporates a UDDI browser and you can define connections to UDDI registries, for example, to one within your organization. For more information, see Section 16.3, "Working with Web Services in a UDDI Registry".
You can create web services from Java classes, the remote interface of EJBs, and an ADF Business Components service session bean wrapped as an EJB. The Web service creation wizards create the deployment files for you, so once you have created your web service the final step is to deploy it to application servers. For more information, see Section 16.5, "Creating SOAP Web Services (Bottom-Up)".
Alternatively, you can create a web service starting with a WSDL, as a top-down web service. For more information, see Section 16.6, "Creating SOAP Web Services from WSDL (Top Down)".
Finally, you can develop web services that are based on Representational State Transfer (REST). A RESTful web service is a simple interface that transmits data over a standardized interface (such as HTTP) without an additional messaging layer, such as SOAP. For more information, see Section 16.7, "Creating RESTful Web Services"
JDeveloper also supports a set of standard Java-to-XML type mappings. You can also create custom serializers for types of objects that are not automatically supported. For more information, see Section 16.2, "Using JDeveloper to Create and Use Web Services".
This following information will help you understand more about web services, and how you can use JDeveloper to create, configure, and use them.
By default, JDeveloper uses the proxy settings from the default browser on the same machine. If you have problems making connections from JDeveloper, for example, connecting to an application server that is on the same machine as JDeveloper, you may need to change the proxy server settings you use.
For example, if you are connecting to an IP address behind a proxy server, and your machine is also behind the same proxy server, then make sure that the web proxy preferences exclude the IP address you are trying to connect to.
When you use the HTTP Analyzer, the analyzer itself is a proxy and any traffic to be monitored by it is routed through it, just as though it was a normal proxy server. If you already have a proxy set in JDeveloper, the analyzer will make sure that the traffic goes through the original proxy after it has been passed through the analyzer.
To exclude an IP address:
For more information at any time, click F1 or Help from the Web Browser and Proxy dialog.
To turn off use of the browser proxy server:
For more information at any time, click F1 or Help from the Web Browser and Proxy dialog.
The context root appears as part of the web service endpoint for a generated web service, so it is important that it is set to an appropriate value. You set the context root at the project level.
The web service context root is the string that comes after the host:port portion of the web service URL. For example, if the deployed WSDL of a WebLogic web service is as follows: http://hostname:7001/financial/GetQuote?WSDL
The context path for this web service is financial.
To set the context root:
For more information at any time, click F1 or Help from the Project Properties dialog.
Click Browse to browse the local directory.
You can develop simple web services that you can test using the Integrated WebLogic Server. However, to develop more complex web services, and to deploy web services, you will need the appropriate connections.
Objects that can be passed to and from web services have to be able to be serialized to an XML type, and then deserialized back to their original type. Objects that are automatically handled are Java primitive types and certain Java standard types. If you want to create a web service using objects that are not automatically serialized, you can write your own custom serializer.
The objects that can be passed to and from web services are ones that conform to the JavaBean conventions For the purposes of web services, a JavaBean is any Java class that conforms to the following restrictions:
setMethod() and getMethod()) must not matter. name the accessors must be called getName and setName. For more information, refer to the JavaBean spec at http://java.sun.com/javase/technologies/desktop/javabeans/api/index.html.
For web services, each property of the object must be of one of the Java types that maps to an XML schema simple type. These are listed in the table below, which shows the primitive XML Schema types and arrays of primitive XML Schema types that are supported as parameters, and the return values for web services. In addition, a service method can accept and return a single piece of XML element data, passed as an org.w3c.dom.Element.
Table 16-1 XML schema type mapping to Java types
| XML Schema type | Java type |
|---|---|
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JAX-WS web services use Java Architecture for XML Binding (JAXB), described at http://jcp.org/en/jsr/detail?id=222, to manage all of the data binding tasks. Specifically, JAXB binds Java method signatures and WSDL messages and operations and allows you to customize the mapping while automatically handling the runtime conversion. This makes it easy for you to incorporate XML data and processing functions in applications based on Java technology without having to know much about XML.
This section describes the limitations for which PL/SQL web services cannot be created for a particular circumstance:
Overloaded Program Units
A program unit that shares its name with another program unit in the same package is an overloaded program unit. At runtime the WSDL processor cannot determine which program unit to execute when there is more than one program unit with the same name. Therefore, the PL/SQL program units cannot be deployed as web services.
You can avoid the problem of overloaded program units that you can adapt to suit your requirements. Consider the following example of a PL/SQL package containing the following program:
You can workaround the overloaded types in one of the following ways:
or
The new procedures are:
BFILE Type
The PL/SQL type BFILE can only be used as an OUT argument or as a function return value.
BCLOB Type
The PL/SQL type BCLOB is not supported.
OUT and IN-OUT Parameters
When you publish a program unit with OUT or IN-OUT parameters, these are transferred back to the caller in a return type structure with one attribute for each OUT or IN-OUT parameter. For example, a service with the following signature:
Returns the final values of val2 and val3 in a generated result class. You can use accessor methods on the generated class to access these values.
Creating PL/SQL web services from PL/SQL records
JDeveloper does not allow you to create web services directly from PL/SQL packages that use PL/SQL records. If your organization uses PL/SQL packages that have been migrated from earlier versions of the Oracle database, you may find that you want to expose some functionality as web services and be unable to do so because the packages accept and return parameters that are record types, rather than object types.
You can use Oracle JPublisher on the packages that contain record types. For more information, see Section 28.3.1, "How to Use JPublisher".
A SQL file is produced that you run against your database to create equivalent packages that contain object types. You can then use the new packages to create your PL/SQL web services in the usual manner.
Stored procedures of the same name which are accessible in more than one schema
On Oracle9i Database release 2, when a stored procedure or function of the same name and the same package name is accessible in more than one schema, then the SQLJ translator invoked during publication of PL/SQL web services will fail.
In order to resolve this problem, ensure that packages to be published are visible only in one schema, and that no other packages in other schemas share the same name.
Ref Cursors Return Types
You cannot create a web service from a packages that uses ref cursor as a return type, for example:
SYS Schema
In order to prevent an arbitrary user from assuming SYS privilege, a connection cannot be specified from the middle tier as SYS. This means that you cannot create a web service from a package in the SYS schema.
If you need to access a PL/SQL package in the SYS schema from the middle tier, for example, to create a web service in JDeveloper, log on to the database as SYS, and grant package EXECUTE privileges to the user you then use to create the JDeveloper database connection.
Types Declared Within a Package Spec
PL/SQL packages can have types declared within the package spec, however these packages cannot be published as web services. To avoid this, create the types outside the scope of the package.
PL/SQL nested tables
JDeveloper does not allow you to create web services directly from PL/SQL packages that use PL/SQL nested tables.
When you create a web service using the web services wizards, you are offered a choice of deployment platforms, as defined in Table 16-2. The platform you choose determines the options available to you in the wizard, and the libraries that are added to the WAR/EAR file for deployment.
Table 16-2 Deployment Platforms
| Deployment Platform | Description |
|---|---|
| J2EE 1.4 JAX-RPC with support for WebLogic Server 10.3 | Generates a JAX-RPC web service that is configured for deploying to Oracle WebLogic Server 10.3. |
| Java EE 1.5 with support for JAX-WS Annotations | Generates a web service that takes advantage of the JAX-WS web services API, released as part of Java EE 1. 5. This option provides support for deploying to WebLogic Server 10.3 with Java annotations using the JAX-WS annotation specification. |
| Java EE 1.5 with support for JAX-WS RI | Generates a JAX-WS web service for deploying to any container that supports the Sun JAX-WS Reference Implementation. You can see more about the Sun JAX-WS Reference Implementation at |
The web services Code Insight completes annotations when typing in a Java class, and is available for WSDL documents in the XML editor (that is, when typing in the Source tab). You can configure how fast Code Insight responds. You can access the Code Insight page in JDeveloper from Tools menu > Preferences > Code Editor > Code Insight.
| Note: Code Insight does not work with Java classes for JAX-RPC web services, only with Java classes for JAX-WS web services. |
When you create a JAX-WS web service from a Java class by adding annotations in the source editor, the Code Insight features of Quick Fixes and Code Assists are available to help you.
For example, when you create a web service from a Java class by manually adding the @WebService annotation, a ragged line appears under the annotation. Click the Audit Fix icon and choose Configure project for web services.
From the Select Deployment Platform dialog, select one of the following JAX-WS platforms for your service:
import javax.jws.WebService; statement to the class import javax.jws.WebService; statement to the class Other examples include:
@Pol, then click Alt+Enter you can choose whether to use @Policy, for a single policy, or @Policies for multiple policies. The appropriate import statement is also added to the class. You can migrate web services created as J2EE 1.4 JAX-RPC web services in JDeveloper 10.1.3.n.
| Note: You cannot migrate EJB 2.1 web services because they are deprecated in this version of JDeveloper. You cannot migrate JMS web services because they are Oracle-proprietary and no longer supported. |
The following actions are performed during the upgrade:
The WSDL is not changed. After performing the upgrade, you can use the Edit Web Service dialog to make any additional changes.
The limitations of the migrated service are:
| Note: JAX-RPC web services can only use Oracle WebLogic Server security policies. |
To migrate a web service:
The migration wizard is automatically invoked enabling you to migrate the application and projects. For more information at any time, press F1 or click Help from within the wizard.
Universal Description, Discovery and Integration (UDDI) is one of the standards and protocols that underpin web services. It provides a common standard for publishing and discovering information about web services. It contains a UDDI browser that searches a UDDI registry using search criteria that you specify to find web services that are described by Web Services Description Language (WSDL). For more information about UDDI including the specification, see the UDDI OASIS standards at http://uddi.xml.org/.
The following sections describe how to work with web services in a UDDI registry:
You can define connections to UDDI registries, for example, to browse your organization's internal UDDI registry. In addition, all defined UDDI registry connections are accessible to any workspace or project.
For more information about UDDI including the specification, see the UDDI OASIS standards at http://uddi.xml.org/.
The following sections describe how to define UDDI registry connections.
You can create a new connection to a UDDI registry that is public or private (within your organization). The UDDI registry connection is listed in the Resource Palette, in the Connections panel.
To create a new connection:
For more information at any time, press F1 or click Help from within the Create UDDI Registry Connection wizard.
Alternatively, you can create the connection directly in the Resource Palette as described in Section 6.9, "Using WebDAV with JDeveloper".
You can edit an existing UDDI registry connection to change the name of the connection, or to change the URL of the inquiry endpoint.
To change the inquiry endpoint of a registry:
The reentrant UDDI Registry Connection wizard is launched.
For more information at any time, press F1 or click Help from within the Create UDDI Registry Connection wizard.
You can change the order that web services are listed in the UDDI registry from Category view to Business view, or from Business View to Category view. For more information, see Section 16.3.2, "How to Configure the View of UDDI Registry Connections".
To change the view of a registry:
You can refresh a UDDI registry connection to ensure that information stored under the connection is up to date.
To refresh a connection:
When no longer needed, you can delete a UDDI registry connection from the Resource Palette.
To delete a connection:
When you create the connection, as described in Section 16.3.1, "How to Define UDDI Registry Connections", you are prompted whether the web services in the registry are displayed in Business View or Category View. The view you choose will determine how you search for services in the registry.
A UDDI registry contains four data structure types that group information about web services:
If you choose Business View, services are listed under Business Entities and Business Services.
If you choose Category View, you can search for web services based on one or more of the following categories:
When you search by name, you can enter all or part of a name and you can use wildcards. The results are tModels where the name of the tModel matches the search criteria. When a number of web services have the same tModel, they are listed in the wizard so that you can choose the one that best fits your requirements.
You can search a UDDI registry connection in the Resource Palette for a web service.
| Note: If you are creating a top-down web service, you can use the Find Web Service Wizard to search a UDDI registry connection from within the Create Java Web Service from WSDL wizard. |
To search for a web service in a UDDI Registry:
You can create a proxy to a web service in a UDDI registry connection in the Resource Palette.
| Note: You can only generate a proxy to a web service if the service uses a WSDL link. To determine this, open the web service report, and check that the Overview Description in the tModel Instances section of the report iswsdl link. |
To generate a proxy:
In the main menu, choose View > Resource Palette. By default, the Resource Palette is displayed to the right of the JDeveloper window.
For more information at any time, press F1 or click Help from within the wizard.
You can display a report of a web service in a UDDI registry.
To display a report of the service:
A report of the web service is displayed in the source editor.
You can publish a web service to a UDDI registry through a connection to the registry in the Application Server navigator. Before you can publish a service to a UDDI registry, you must already have a connection to the registry in the Resource Catalog. For more information, see Section 16.3.1.1, "Creating UDDI Registry Connections".
To publish a web service to a UDDI registry:
| Note: If you deploy the web service to the Integrated WebLogic Server, then the UDDI registry to which you are publishing must be local to the Integrated WebLogic Server. |
For more information at any time, press F1 or click Help in the Publish WSDL to UDDI Registry dialog.
JDeveloper makes it easy to use a web service in your application by allowing you to create client and proxy classes to access the service using the Create Web Service Client and Proxy wizard. You can launch the wizard when you locate or create a web service. Alternatively, you can launch the wizard directly and enter the URL for the web service or use the Find Web Service wizard to locate a web service in a UDDI registry.
JDeveloper automatically generates the correct type of proxy for an RPC or document style web service.
| Note: JAX-WS web services do not support RPC style. |
For more information about:
The following sections describe how to create and use web service clients:
Use JDeveloper to automatically create a client and proxy classes to access a web service and call its methods in your application. Using the wizard, you can also generate asynchronous methods and attach policies, as required.
You can create a client and proxy classes to access a web service using the Create Web Service Client and Proxy wizard. The wizard generates a new service class (JAX-WS) or stub (JAX-RPC) and service interface for each exposed port and lists them in the Application Navigator. It opens the generated client file port-nameClient.java in the source editor. Once generated, you can call the methods in your application.
| Note: In some cases, you may encounter errors when you run a web service client that you have created for a web service accessed on the Internet or using a UDDI registry. Because web services standards are still evolving, it is possible that the web services that you locate may not conform to the latest standards, or the standards to which they conform may not be compatible with those supported by the server on which the client is running. If a web service client that you have created in JDeveloper returns an error, examine the error message and consider creating a client to another web service that provides a similar service, but that is compatible with the server and will run without problems. |
You can access the Create Web Service Client and Proxy wizard using one of the following methods. For help in completing the wizard, press F1 or click Help from within the wizard.
To create a client and proxy classes to access a web service:
For more information at any time, press F1 or click Help from within the Create Web Service Client and Proxy wizard.
To create a client and proxy classes to access a web service defined in JDeveloper:
| Note: When you create the client and proxy classes for an EJB web service that uses JavaBean parameters, the JavaBean must implement thejava.io.Serializable interface. |
JDeveloper generates a number of files that define a proxy to the web service. Using the generated files, you can develop the following types of web service client applications:
| Note: In addition to the procedures described below, you can use web service injection (using the@WebServiceRef method) to define a reference to a web service and identify an injection target in your web service client. For more information see Section 16.4.7, "How to Reference Web Services Using the @WebServiceRef Annotation" |
A stand-alone client application, in its simplest form, is a Java program that has the Main public class that you invoke with the java command. It runs completely separate from WebLogic Server.
To use the generated client proxy classes in a stand-alone client:
port_nameClient.java, in the source editor. This file opens automatically when you create the web service client proxy initially. To re-open the class, right-click on the client proxy container and select Go to Client Class or simply double-click on the file in the Application Navigator.
// Add your own code here, which is in a try-catch block in the main method, and add the appropriate code to invoke the web service. Include the generated proxy classes as part of a Java Standard Edition (SE) application and reference them to access the remote web service.
To use the generated client proxy classes in a JSE component:
port_nameClient.java, as your guide, add appropriate methods to access the web service from your application. In this case, the web service runs inside a Java Platform, Enterprise Edition (Java EE) Version 5 component deployed to WebLogic Server, such as an EJB, servlet, or another web service. This type of client application, therefore, runs inside a WebLogic Server container.
To use the generated client proxy classes in a Java EE component:
port_nameClient.java, in the source editor. This file opens automatically when you create the web service client proxy initially. To re-open the class, right-click on the client proxy container and select Go to Client Class or simply double-click on the file in the Application Navigator.
You can view the WSDL that was used to generate the web service client under the following circumstances:
| Note: In most cases, the local copy of the WSDL will match the WSDL of the remote web service. If the remote web service is modified, the local WSDL may become out-of-sync with the remote WSDL. To ensure the web service client will be able to access the remote web service, you can regenerate the local WSDL using the remote WSDL, as needed. See Section 16.4.5, "How to Regenerate Web Service Client and Proxy Classes". |
To view the client WSDL:
The WSDL is displayed.
In some cases, you may need to update your application to reference imported XML resources, such as WSDLs and XSDs, from a source that is different from that which is part of the description of the web service. Redirecting the XML resources in this way may be required to improve performance or to ensure your application runs properly in your local environment.
For example, a WSDL may be accessible during client generation, but may no longer be accessible when the client is run. You may need to reference a resource that is local to or bundled with your application rather than a resource that is available over the network.
You can modify the location of the WSDL that will be used by the web service at runtime using one of the following methods:
@WebServiceRef) and a Deployment Plan When you create or regenerate a web service client, a jax-ws-catalog.xml file is created automatically in the META-INF directory. The file complies with the OASIS XML schema, as described in the Oasis XML Catalogs specification at http://www.oasis-open.org/committees/download.php/14809/xml-catalogs.html.
You can update the web service WSDL by modifying the uri attribute of the <system> element in the jax-ws-catalog.xml file. The specified value will be used at run time.
The following provides a sample XML catalog (jax-ws-catalog.xml) file for a remote WSDL:
The following provides a sample XML catalog (jax-ws-catalog.xml) file for a local WSDL:
In the preceding examples:
<catalog> root element defines the XML catalog namespace and sets the prefer attribute to system to specify that system matches are preferred. <system> element associates a URI reference with a system identifier. | Note: When creating the client and proxy classes for multiple web services on a local system that share the same endpoint, to ensure that URL is unique for each web service in the jaxws-catalog.xml file, the service QName is appended as anchor text. For example:http://foo.org/helloworld?wsdl Might become: http://foo.org/helloworld#%7Bhttp%3A%2F%2Fexample.com%2F%7DHelloService?wsdl. |
This method involves the following steps:
@WebServiceRef annotation to define a reference to a web service and identify an injection target. Step 1: Using the @WebServiceRef Annotation
The @WebServiceRef annotation injects an endpoint for the Web service interface that is defined in the web.xml file. The following example demonstrates how to use the @WebServiceRef annotation to define a reference to a web service and identify an injection target.
The web service class for the CreditRatingService is hard-coded in the web.xml file, as shown in the following example:
Step 2: Updating the Deployment Plan
To modify the value of the WSDL that is used at run time, you can generate and update a deployment plan.
A deployment plan is an optional XML document that you use to configure an application for deployment to a specific WebLogic Server environment. A deployment plan defines or overrides deployment property values that would normally be defined in an application's WebLogic Server deployment descriptors. To update the configuration for your application, you add or update variables in the deployment plan, defining both the location of the WebLogic Server descriptor properties and the value to assign to the properties. For more information, see the Oracle Fusion Middleware Deploying Applications to Oracle WebLogic Server.
The following example illustrates a deployment plan that overrides the value of the CreditRatingService web service WSDL, where:
variable-definition element defines the CreditRatingService variable and the value to assign to it. module-override element for the LoanApplication-LoanApprover-context-root.war, a variable-assignment element defines the CreditRating Service variable and the exact location within the descriptor where the property is overridden. There are times that you may need to regenerate the web service client and proxy classes.
| Note: When you regenerate the web service client and proxy classes, JDeveloper discards any changes that you have made to the class, WSDL, or supporting files since the client was last generated. |
To regenerate the web service client and proxy classes:
The Web Service Client and Proxy Editor wizard is displayed.
The local copy of the WSDL is refreshed and the web service client and proxy classes are regenerated.
To regenerate the web service client and proxy classes:
You can regenerate the web service client and proxy classes quickly and easily using the set of properties last defined in the Web Service Client and Proxy Editor wizard and the current locally stored WSDL as follows:
The web service client class, WSDL, and supporting proxy files are regenerated.
JDeveloper provides the ability to both edit and delete web service clients.
To edit web service clients:
You can edit a web service client using the Web Service Client and Proxy editor. To access the Web Service Client and Proxy editor:
For help in completing the wizard, press F1 or click Help from within the wizard.
To delete web service clients:
package.proxy, and select the files. package.proxy.runtime, and select the files. The files are permanently erased.
When you use the javax.xml.ws.WebServiceRef annotation, you can inject a reference to a web service into any container-managed Java class.
To add a @WebServiceRef annotation to your Java class quickly and easily, right-click within the Java class editor at the location you want to inject the web service reference, and select one of the following options:
This command invokes the Create Web Service Client and Proxy wizard, enabling you to generate a web service client and proxy classes. Then, the javax.xml.ws.WebServiceRef and web service proxy classes are imported automatically and a reference to the selected web service is injected at the specified location.
The javax.xml.ws.WebServiceRef and web service proxy classes are imported automatically and a reference to the selected web service is injected at the specified location. If no web service proxy classes are currently available, then this option is greyed out.
The following excerpt provides an example of the code that is automatically added to the Java class:
For more information, see "Defining a Web Service Reference Using @WebServiceRef Annotation" in GD.
Web services can be created using two development methods: top-down or bottom-up. Bottom-up development refers to the process of developing a web service from the underlying Java implementation using SOAP. For information about using top-down development—starting from the WSDL—see Section 16.6, "Creating SOAP Web Services from WSDL (Top Down)".
The following sections describe how to generate different types of web services from the bottom up:
You can create web services from:
The web service creation wizards create the deployment files for you, so once you have created your web service the final step is to deploy it.
Before you begin:
If you have not already done so, set an appropriate context root for your web service. For more information, see Section 16.2.2, "How to Set the Context Root for Web Services".
To create the web service:
For detailed help about completing the wizard, press F1 or click Help from within the wizard.
| Note: The Select Deployment Platform page is only displayed the first time a web service is created in a project. Thereafter, all additional web services in the same project will use the same version. |
JSR-181 specifies web services meta data, which allows you to use annotations to declaratively to make creating and managing web services easier. You use the annotations for methods and classes in order to expose these methods as web service end-points.
You can add JSR-181 annotations to a class manually, choose to have JDeveloper add them to the class when creating the web service, or add them when editing the web service using the Edit Web Services dialog.
| Note: If you delete the annotations using the Edit Web Services dialog, any annotations that you entered manually are also deleted. |
To add annotations:
@ and pause for a couple of seconds. Code Insight displays possible values. For more information, see Section 16.2.7, "How to Work with Web Services Code Insight".
For more information, see the following references:
http://jcp.org/en/jsr/detail?id=18 http://jcp.org/aboutJava/communityprocess/mrel/jsr224/index2.html The Create PL/SQL Web Service wizard makes it easy to generate a web service from a PL/SQL package or a Java stored procedure that uses object types. A Java stored procedure is defined by a SQL specification that invokes it, and the PL/SQL Web Service wizard treats these in the same way as packages.
| Note: You can only create JAX-RPC PL/SQL Web Services. For more information, see Section 16.2.6, "How to Choose Your Deployment Platform". |
PL/SQL web services can be deployed to Oracle WebLogic Server. The Create PL/SQL Web Service wizard uses the functionality of Oracle JPublisher to wrap the PL/SQL in Java so that the service can be published. For more information see Section 28.3.1, "How to Use JPublisher".
You can either:
It should be noted that:
To create the PL/SQL web service from a project:
For detailed help about completing the wizard, press F1 or click Help from within the wizard.
To create the web service from a PL/SQL package:
The Create TopLink DB Web Service Provider wizard enables you to build a JAX-WS web service provider for a TopLink database to perform one of the following tasks:
Based on the type of service selected, the wizard generates a web service provider and WSDL document that can be deployed to an application server, such as Oracle WebLogic Server. Deploying TopLink web service providers is similar to deploying other J2EE Web Applications. For more information, see Section 16.12, "Deploying Web Services".
It should be noted that:
To create the TopLink web service provider from a project:
For detailed help about completing the wizard, press F1 or click Help from within the wizard.
WebLogic web services enable interoperability with other external transaction processing systems, such as Websphere, JBoss, Microsoft .NET, and so on, through the support of the following specifications:
http://docs.oasis-open.org/ws-tx/wstx-wsat-1.2-spec-cs-01/wstx-wsat-1.2-spec-cs-01.html http://docs.oasis-open.org/ws-tx/wstx-wscoor-1.2-spec-cs-01/wstx-wscoor-1.2-spec-cs-01.html These specifications define an extensible framework for coordinating distributed activities among a set of participants. The coordinator is the central component, managing the transactional state (coordination context) and enabling web services and clients to register as participants. For more information about web service atomic transactions, see "Using Web Service Atomic Transactions" in Oracle Fusion Middleware Programming Advanced Features of JAX-WS Web Services for Oracle WebLogic Server.
To enable atomic transactions for a web service implementation at the class level or synchronous method level (for two-way methods only) use one of the following methods:
@weblogic.wsee.wstx.wsat.Transactional annotation directly in the Java class; the JDeveloper Code Insight feature can help you. For more information, see Section 16.2.7, "How to Work with Web Services Code Insight". To enable atomic transactions for web service clients use one of the following methods:
@WebServiceRef annotation or web service injectable target, and select Add Transactional from the menu to add the @Transactional annotation. weblogic.wsee.wstx.wsat.TransactionalFeature as a parameter when creating the web service proxy or dispatch. For more information, see "Using Web Service Atomic Transactions" in Oracle Fusion Middleware Programming Advanced Features of JAX-WS Web Services for Oracle WebLogic Server. When enabling web service atomic transactions, configure the following information:
WSAT10, WSAT11, and WSAT12, and DEFAULT. The DEFAULT value for web services is all three versions (driven by the inbound request); the DEFAULT value for web services clients is WSAT10. @TransacationAttribute annotation. Table 16-3 Transaction Configurations
| Value | Web Service Client | Web Service | Valid EJB @TransactionAttribute Values |
|---|---|---|---|
|
| JTA transaction: Do not export transaction coordination context. No JTA transaction: Do not export transaction coordination context. | Transaction flow exists: Do not import transaction coordination context. If the CoordinationContext header contains mustunderstand="true", a SOAP fault is thrown. No transaction flow: Do not import transaction coordination context. |
|
|
| JTA transaction: Export transaction coordination context. No JTA transaction: Do not export transaction coordination context. | Transaction flow exists: Import transaction context. No transaction flow: Do not import transaction coordination context. |
|
|
| JTA transaction: Export transaction coordination context. No JTA transaction: An exception is thrown. | Transaction flow exists: Import transaction context. No transaction flow: Service-side exception is thrown. |
|
To enable web service atomic transactions in the Java class:
Start typing the annotation, for example, @Transactional. When you pause, or click Ctrl+Shift+Space, a popup appears from which you can choose the correct entry to complete the statement.
To enable web service atomic transactions in the Property Inspector:
For more information at any time, press F1 or click Help from within the Property Inspector.
@WebService, or two-way method line of the class, navigate to the Web Services Extensions node in the Property Inspector. The Property Inspector is refreshed to display options to set the flow type and version. For more information about the configuration options, see Table 16-3.
Supports, Never, and Mandatory. This field defaults to Supports. WS-AT 1.0, WS-AT 1.1, WS-AT 1.2, and Default. The Default value for web services is all three versions (driven by the inbound request); the Default value for web services clients is WS-AT 1.0. To enable web service atomic transactions in a web service client's injectable target:
@WebServiceRef annotation or injectable target and select Add Transactional from the menu. The @Transactional annotation is added to the web service client.
For more information about the configuration options, see Table 16-3.
There are times that you may need to regenerate your web service. For example, if the source from which the service was originally generated has changed.
| Note: When you regenerate the web service, JDeveloper discards any changes that you have made to the WSDL since it was last generated. |
After you regenerate the web service, you may need to regenerate the client to the web service. Otherwise, you may get compilation errors (when the client is in the same project as the web service), or run-time errors (when the client is in a different project to the web service).
If you are not using annotations and change the name of the method in the underlying class, when you regenerate the service you will receive an error message indicating that no methods were selected. Because methods are tracked using namespaces, if you modify the namespace JDeveloper is not able to determine what needs to be regenerated. To correct this error, double-click the web service container to open the Web Services Editor, go to the Methods page, and select the methods on which to base the web service.
To regenerate a web service from source:
The service is automatically regenerated, and any changes you made to the WSDL since it was last generated are lost.
JDeveloper allows you to specify the handler classes to deal with the web service message. The handlers can use initialized parameters, SOAP roles or SOAP headers.
To define handlers:
or
Open the web service editor. For more information, see Section 16.10, "Editing and Deleting Web Services".
For more information at any time, press F1 or click Help from within the dialog.
| Note: For JAX-WS web services, superclass methods are always exposed. |
To expose superclass methods for JAX-RPC, consider the following two examples:
and
In class Circle, which extends Shape, there is a public method callParentMethod() which is responsible for calling the parent class method area. To call the superclass method area(), create a J2EE Java web service on the Circle class using the public method callParentMethod().
If the Java class on which you base a web service has overloaded methods, JDeveloper handles them automatically. However if you create a J2EE 1.4 web service, and then change the class on which it is based so that an existing method becomes an overloaded method you have to take action to update the mapping file.
The procedure to handle overloaded methods depends on the type of web service that you are developing, JAX-WS or JAX-RPC.
Handling Overloaded Methods for JAX-WS Web Services
For JAX-WS web services, you can use the @WebMethod annotation to change the name of an overloaded method. For example:
In the example, the sayHello() method of the SimpleImpl JWS file is exposed as a public operation of the web service. The operationName attribute specifies, however, that the public name of the operation in the WSDL file is sayHelloOperation.
For more information about @WebMethod, see "Specifying that a JWS Method Be Exposed as a Public Operation (@WebMethod and @OneWay Annotations)" in Oracle Fusion Middleware Getting Started With JAX-WS Web Services for Oracle WebLogic Server.
Handling Overloaded Methods for JAX-RPC Web Services
For JAX-RPC web services, there are two ways that you can handle overloaded methods:
To manually modify the mapping file
After you create the web service based on the Java class, add the overloaded method to the class.
To delete the mapping file and recreate the web service
JAX-RPC maps Java types to WSDL definitions. However when the types you want to support are not covered by the JSR-109 specification, or when you want to use different mappings to provide the functionality your web service requires, you can use the JAX-RPC Mapping File Editor to amend an existing mapping file, or to create your own.
The JAX-RPC Mapping File Editor is a specialized schema-driven editor which helps you to create a JSR-109 compliant mapping file for a J2EE 1.4 web service. The mapping file standardizes the Java- WSDL mappings, and in general you have to provide a full mapping only when the default mapping rules in JSR-109 are not satisfied.
These features are available while you are using the JAX-RPC Mapping File Editor:
JDeveloper allows you to develop top-down web services, that is, starting with the WSDL. JDeveloper will generate a service implementation and its deployment descriptors. You can browse to a WSDL in the file system, or use the Find Web Service Wizard to locate a web service in a UDDI registry connection in the Resource Palette.
To create a SOAP web service from WSDL (top down):
For detailed help about completing the wizard, press F1 or click Help from within the wizard.
The SOAP web service is created and the Java implementation class is opened automatically in the editor
Representational State Transfer (REST) describes any simple interface that transmits data over a standardized interface (such as HTTP) without an additional messaging layer, such as SOAP. REST provides a set of design rules for creating stateless services that are viewed as resources, or sources of specific information, and can be identified by their unique URIs. A client accesses the resource using the URI, a standardized fixed set of methods, and a representation of the resource is returned. The client is said to transfer state with each new resource representation.
When using the HTTP protocol to access RESTful resources, the resource identifier is the URL of the resource and the standard operation to be performed on that resource is one of the HTTP methods: GET, PUT, DELETE, POST, or HEAD.
The following sections describe how to create RESTful web service and clients:
Before you can create RESTful web services in JDeveloper, you need to download and add to your project the Jersey JAX-RS Reference Implementation (RI). The Jersey JAX-RS RI is available at https://jersey.dev.java.net. Click Download for more information about the Jersey RI and to download the ZIP file that contains the relevant library JAR files. Once downloaded, you need to add the Jersey RI to your project.
| Note: The Jersey RI 1.1.5.1 (jersey-archive-1.1.5.1) version or above is compatible with this release of JDeveloper. |
To add the Jersey JAX-RS RI to your project:
To display the dialog, double-click the Project folder or select Edit > Properties.
| Note: If you do not select this check box, you will experience errors during deployment of your RESTful web services and clients. |
| Note: If you are developing RESTful web services only (that is, you are not developing RESTful clients), you do not have to include the jersey-client-1.1.5.1.jar. Similarly, if you are developing RESTful web service clients only, you do not have to include the jersey-server-1.1.5.1.jar. |
Once you have added the Jersey JAX-RS RI to your project, you can then create JAX-RS web services and clients.
After you have added the Jersey JAX-RS RI to your project, you can start creating JAX-RS web services and clients using JDeveloper. All of the standard Java source editor features will work with the JAX-RS calls, such as code insight, import assistance, and so on.
For more information about JAX-RS and samples, you might find it helpful to review the Jersey RI documentation at: http://wikis.sun.com/display/Jersey/Main.
Once you create your RESTful web services, you can test them using the HTTP Analyzer. For more information, see Section 16.13.4, "How to Examine Web Services using the HTTP Analyzer".
| Note: If you experience errors during the deployment of your RESTful web services and clients, ensure that you have selected the Deployed by Default check box when adding the Jersey JAX-RS RI to your project. |
A Simple Hello World Example
Example 16-1 provides a very simple example of a RESTful web services:
Example 16-1 RESTful web services
Example 16-2 provides a simple RESTful client that calls the RESTful web service defined previously. This sample uses classes that are provided by the Jersey JAX-RS RI specifically; they are not part of the JAX-RS standard.
Example 16-2 RESTful client
About the web.xml File
JDeveloper does not automatically add the servlet class to the web.xml file. Instead, you are prompted to confirm whether you want to add it when you call a JAX-RS method from your code. For example, see Figure 16-1.
| Note: Why is the web.xml file not updated automatically? In the future, when you deploy to a Java EE 6.0 container, an update to the web.xml will not be required. Therefore, this is set up as an optional activity. |
To update the web.xml:
To update the web.xml, select Configure web.xml for Jersey JAX-RS web services as follows:
JDeveloper provides a number of ways that you can manage WSDLs for a web service, as described in the following sections:
You can create a WSDL document, for example, to create a top-down web service.
To create a WSDL:
For detailed help about completing the wizard, press F1 or click Help from within the dialog.
You can generate a WSDL file for a web service and add it to the project using the procedures described below. The WSDL file is generated automatically and added to the WEB-INF/wsdl directory for Web applications and to the META-INF/wsdl directory for EJB applications within the project. In addition, the @WebService annotation is updated with the wsdlLocation attribute to reference the location of the local WSDL. For example:
| Note: If a WSDL file already exists in theWEB-INF/wsdl or META-INF/wsdl directory, you are prompted whether or not to overwrite the existing WSDL file. |
To add a WSDL to a web service project:
In the Application Navigator, right-click the web service for which you want to add a WSDL and select Generate WSDL and Add to Project from the context menu. The WSDL is automatically generated and added to the project in the WEB-INF/wsdl directory.
You can display the WSDL for a web service. The WSDL file is generated based on the annotations defined in the web service to a temporary directory and displayed.
To display the WSDL to a web service project:
In the Application Navigator, right-click the web service for which you want to display the WSDL and select Show WSDL for Web Service Annotations from the context menu.
The WSDL is generated to a temporary directory and displayed.
When viewing a remote WSDL for a web service, you can save the WSDL to your local directory.
| Note: If you want to use the WSDL within a web service project, you need to copy it to a location that is accessible by the project directory (for example,WEB-INF/wsdl for Web applications and META-INF/wsdl for EJB applications) and update the @WebService annotation to reference the WSDL location. |
To save a WSDL to your local directory:
The WSDL is saved to the location specified.
This section describes how to use policies with web services created in JDeveloper. You can use the following types of policies:
You cannot mix the two types of policies in the same web service, so you should decide which to use at the planning stage. Once you have added policies of one type to your web service, you cannot switch to the other type without deleting the policies that are currently attached. For example, if you have configured Oracle WSM policies and later decide that you want to use Oracle WebLogic web service policies, you must delete the Oracle WSM policies before you can attach the Oracle WebLogic web service policies.
The following sections describe how to use policies with web services:
Before you begin:
A detailed examination of all the tasks to be performed to use policies is outside the scope of this guide, but in general the steps you need to perform are:
Oracle WSM policies can be attached to JAX-WS web services at the port-level. JDeveloper currently supports Oracle WSM security policies only.
JDeveloper is preconfigured to use the policy store set at the default location in the WS Policy page of the Preferences dialog at:
or
You can specify another policy store location to use your organization's custom Oracle WSM policies. For more information Section 16.9.8, "How to Use a Different Oracle WSM Policy Store".
For more information about Oracle WSM policies, see the Oracle Application Server Web Services Security Guide.
Policy Annotations
You can attach a single policy using the weblogic.wsee.jws.jaxws.owsm.SecurityPolicy annotation in the Java class, for example:
You can attach multiple policies as a composite using @SecurityPolicies containing a number of @SecurityPolicy elements, for example:
| Note: To display a list of valid policies, click Ctrl+Alt+Enter to invoke the Code Assist feature. |
Oracle WebLogic web service policies can be attached to JAX-WS and JAX-RPC web services at the port or operation level. With Oracle WebLogic web service policies it is possible to specify the usage direction of the policies, i.e., to be applied on the inbound (request) message or outbound (response) message, or both.
You can configure JDeveloper to use your organization's custom Oracle WebLogic web service policies. For more information, see Section 16.9.7, "How to Use Custom Web Service Policies".
For more information, see the Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server.
Policy Annotations
You can attach a single policy using the weblogic.jws.Policy annotation in the Java class, for example:
You can attach multiple policies as a composite using @Policies containing a number of @Policy elements, for example:
| Note: To display a list of valid policies, click Ctrl+Alt+Enter to invoke the Code Assist feature. |
JDeveloper allows you to attach Oracle Web Service Manager (Oracle WSM) policies or Oracle WebLogic web service policies to web services.
After you attach a policy to a web service, you need to configure the policies. For more information, see "Configuring Policies" in the Oracle Application Server Web Services Security Guide.
You can attach policies to web services by:
To attach policies in the web service wizard or editor:
In the Create Java Web Service wizard or web service editor, navigate to the Configure Policies page. For more information at any time, press F1 or click Help from within the dialog.
When attaching Oracle WSM policies, you can view more information about the policy and its assertions as follows:
To attach policy annotations in the Java class:
Start typing the annotation, for example, @Policies. When you pause, or click Ctrl+Shift+Space, a popup appears from which you can choose the correct entry to complete the statement.
For more information about using policy annotations, see "Updating the JWS File with @Policy and @Policies Annotations" and "SecurityPolicy and SecurityPolicies Annotations" in Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server.
To attach policies in the Property Inspector:
For more information at any time, press F1 or click Help from within the Property Inspector.
public class or @WebService line of the class, navigate to the Web Services Extensions node where you can choose to use Oracle WSM Policies or Oracle WebLogic web service policies. The Property Inspector is refreshed to display options to select single or multiple policies for the policy type selected (Oracle WSM or WLS).
When using the Edit Property: Multiple Policies dialog box to attach multiple Oracle WSM policy files, click View to review the policy assertions in the policy file.
You cannot use both types of policy in the same web service. If you choose the wrong type, delete the lines containing the policy statements from the JAX-WS class so that you can choose again.
JDeveloper allows you to attach Oracle Web Service Manager (Oracle WSM) to web service clients.
After you attach an Oracle WSM policy to a web service client, you need to configure the policies. For more information, see "Configuring Policies" in the Oracle Application Server Web Services Security Guide.
| Note: For information about updating client applications to invoke web services that use WebLogic web service policies, see "Updating a Client Application to Invoke a Message-Secured Web Service" in Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server. |
You can attach Oracle WSM policies to web service clients by:
For more information at any time, press F1 or click Help from within the dialog.
weblogic.wsee.jws.jaxws.owsm.SecurityPolicyFeature class to attach a single policy or weblogic.wsee.jws.jaxws.owsm.SecurityPoliciesFeature to attach multiple policies. For more information, see the Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server.
When creating or editing a web service client from a WSDL that advertises a WebLogic web service policy, you can configure credentials to invoke the web service.
To configure credentials for a web service client that invokes a web service secured using WebLogic web service policies:
For help in completing the wizard, press F1 or click Help from within the wizard.
The client class is updated to include methods for setting the client credentials. Once added, you can modify the credential values, as required.
The following provides an example of the code that is generated and included in the client class:
For information about how to program your web service client to invoke a web service that is secured using WebLogic web service policies, see "Updating a Client Application to Invoke a Message-Secured Web Service" in the Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server.
You can edit policies and remove them entirely from web services with either of the following:
To change or remove policies using the web service editor:
For more information at any time, press F1 or click Help from within the dialog.
To change or remove policies using annotations in the Java class:
To change or remove policies using the Property Inspector:
For more information at any time, press F1 or click Help from within the Property Inspector.
public class or @WebService line of the class, navigate to the Web Services Extensions node: You can use custom policies from within JDeveloper. The process is different based on whether you are using custom Oracle Web Service Manager (Oracle WSM) policies or Oracle WebLogic web service policies, as described in the following sections:
To use custom Oracle Web Service Manager (Oracle WSM) policies, perform one of the following steps:
JDEV_USER_HOME\system11.1.1.2.x.x.x\DefaultDomain\oracle\store\gmds. If not set,
JDEV_USER_HOME defaults to C:\Documents and Settings\user-dir\Application Data\JDeveloper.
Within this directory, policies must be included using one of the following directory structures:
owsm/policies/oracle/policy_file owsm/policies/policy_file | Note: When exporting policy files from the Oracle WSM repository for use in JDeveloper, this directory structure is not maintained. You must ensure that when adding the exported policy to the JDeveloper environment that you use the required directory structure noted above. Otherwise, the policies will not be available in the JDeveloper environment. For more information about exporting policies from the Oracle WSM repository, see "Understanding the Different Mechanisms for Importing and Exporting Policies" in the Oracle Application Server Web Services Security Guide. |
If you elect to use a policy store on a remote application server, you can import custom Oracle WSM policies to the MDS repository on the remote application server using Fusion Middleware Control or WLST.
For more information about importing policies to the Oracle WSM MDS on the remote application server, see "Understanding the Different Mechanisms for Importing and Exporting Policies" in the Oracle Application Server Web Services Security Guide.
For more information about creating custom policies, see "Creating Custom Assertions" in Extensibility Guide for Oracle Web Services Manager.
To use custom Oracle WebLogic web service policies, perform one of the following steps:
property weblogic.wsee.policy.LoadFromClassPathEnabled to true. WEB-INF/policies (Web application) or META-INF/policies (EJB). WEB-INF (Web application) or META-INF (EJB). To access the policies:
@Policy annotation, ensure that you add the policy prefix; for example, policy:mypolicy.xml. For more information about creating custom policies, see "Creating Custom Assertions" in Extensibility Guide for Oracle Web Services Manager.
The Oracle Web Service Manager (Oracle WSM) policy store is installed as part of JDeveloper. You can use a different policy store, for example, to use a shared policy store. You can use a policy store that is available on the local file store or on a remote application server.
To specify a different policy store location:
For more information at any time, press F1 or click Help from within the Preferences dialog.
To add a new remote application server connection, click New.
| Note: The remote application server that you select must be configured with the Oracle WSM Policy Manager. To verify that the Oracle WSM Policy Manager has been properly configured, use the following URL:http://<host>:<port>/wsm-pm/validator. Enter the username and password for the server when prompted. If the Oracle WSM Policy Manager is operational, then a list of the predefined policies is displayed with descriptions. For more information about troubleshooting the Oracle WSM Policy Manager, see "Diagnosing Problems" in the Oracle Application Server Web Services Security Guide. |
You can edit or delete a web service that you have created in JDeveloper, for example to change the exposed method or a file location.
To edit a web service:
For detailed help about completing the wizard, press F1 or click Help from within the wizard.
After editing the web service files, you must redeploy the web service. For more information, see Section 16.12, "Deploying Web Services".
When you edit a web service, the previously generated WSDL file is overwritten, and any changes you have made to it will be lost. If you have already deployed the web service and you edit it, you must redeploy it.
When you edit a PL/SQL web service, ensure that the database connection is present; otherwise, you will receive an error message. If you have deleted the database connection, create a new one with the same name as the original one.
To delete a web service:
The files are deleted and any references to the service web.xml are removed.
When you delete a web service from JDeveloper, the web service container and the files it contains (a WSDL file and possibly some interfaces) are deleted. The entries for the web service in web.xml are removed, although the file is not deleted. The WebServices.deploy file is unchanged as it may be used for other web services.
Developer provides a number of ways that you can test web services. You can use the debugger, which enables you to debug web services that you create locally, on the Integrated WebLogic Server, and remotely, on Oracle WebLogic Server. You can also run a web service deployed to Integrated WebLogic Server in a browser to check that it returns what you expect.
In addition to the topics described in this section, you can use HTTP Analyzer to examine the content of web services over HTTP, similar to examining other packet information. For more information, see Section 16.13.4, "How to Examine Web Services using the HTTP Analyzer".
The following sections describe how to test and debug web services:
Once you have created and deployed a web service, you can check that it returns what you expect by running it in the browser.
The process that you use to test web services depends on whether you are testing WebLogic web services or Oracle Infrastructure web services, such as ADF business components.
To test WebLogic Java EE web services in a browser:
http://IP_address:port/wls_utc For example: http://IP_address:port/Project1-context-root/MyWebService1?WSDL
The browser shows a simple page which lists the operations available on the service.
Testing Oracle Infrastructure Web Services in a Browser
For Oracle Infrastructure web services, such as ADF business components, you can test web services in a browser deployed to:
To test a service deployed to Integrated WebLogic Server:
Use the following context root(s) to test your web application(s): http://IP_address:port/Project1-context-root/MyWebService1
To test a service deployed to Oracle WebLogic Server:
The application can be accessed at location: http://IP_address:port/Project1-context-root
This URL only shows the context root for the web service.
http://IP_address:port/Project1-context-root/MyWebService1
The browser shows a simple page which lists the operations available on the service.
The debugging tools allow you to debug web services created using the web service wizards. This is similar to debugging Java programs; you can debug a web service locally or remotely by running a client against the service in debug mode. You set breakpoints in the client, which is the proxy to the web service, to investigate the functionality of the service.
Although you can debug a PL/SQL web service, what you are debugging is the Java class generated by JDeveloper to wrap the PL/SQL for deployment as a web service. Therefore, the correct way to ensure that a PL/SQL web service runs as expected is to debug the PL/SQL before you create a web service from it. For more information, see Section 29.3, "Debugging PL/SQL Programs and Java Stored Procedures".
You can use the HTTP Analyzer to examine and monitor HTTP request and response packets. It acts as a proxy between code in JDeveloper and the HTTP resource that the code is communicating with, and helps you to debug your application in terms of the HTTP traffic sent and received. For more information, see Section 16.13.4, "How to Examine Web Services using the HTTP Analyzer".
JDeveloper lets you debug a web service that is running in the Integrated WebLogic Server, locally or a web service that is deployed remotely.
Debugging Web Services Locally
Once the web service is running in Integrated WebLogic Server, you can create a proxy client to the web service. This client contains methods to run against each exposed method in the web service, and you can add your own code and set breakpoints to examine how the web service runs.
You can quickly debug a web service created in JDeveloper by debugging it locally. There are two ways to do this:
Before locally debugging a web service, you should turn off the proxy settings. Remember to turn the proxy settings back on when you have finished debugging.
To debug a web service locally:
The Integrated WebLogic Server is started in debug mode, and the web service is deployed to it. The results are displayed in the log window.
A proxy container is generated and displayed in the navigator, with a Java class called web_serviceSoapHttpPortClient.java displayed in the source editor.
// Add your own code here, and enter some code. Alternatively, if you have set breakpoints in the web service class, choose either Debug or Run from the context menu.
The debugger operates as for any Java class. For more information, see Chapter 19, "Running and Debugging Java Programs".
Debugging Web Services Remotely
JDeveloper lets you debug a web service that is deployed remotely.
The web service could be running on Oracle WebLogic Server on the local machine, or it could be running on a service located on a remote machine. In either case, you will need a connection to the server, and the server must be running in debug mode.
When you remotely debug a web service, you have to start the server in debug mode, deploy the web service to it. You can then create a client to the service and set breakpoints in it, and run the client in debug mode.
To debug a web service remotely:
// Add your own code here, and enter some code. The debugger operates as for any Java class. For more information, see Chapter 19, "Running and Debugging Java Programs".
JDeveloper provides tools that help you create and deploy web services to Oracle WebLogic Server, where they run within a Java EE container. You can:
In addition, you can define a different WebLogic Server domain to be the Integrated WebLogic Server on which to run web services. For more information, see Section 9.2, "Running Java EE Applications in the Integrated Application Server".
You can deploy web service generated in JDeveloper to Integrated WebLogic Server.
To deploy a web service to Integrated WebLogic Server:
The first time you start Integrated WebLogic Server by running or debugging an application or web service, a dialog is displayed where you enter a password for the administrator ID on the default domain. When you click OK, the default domain is created. You only need to do this once.
You can deploy a web service generated in JDeveloper to Oracle WebLogic Server.
When you used one of the Create Web Services wizards to generate the files for your Java EE web service, the wizard automatically created all the files that you need, including a deployment profile named WebServices.deploy. The WebServices.deploy file is created at project level. The deployment profile contains a WAR file and an EAR file.
| Note: If you are deploying a PL/SQL web service, you must create an EAR, which is a deployment profile at application level, and deploy the EAR file. The database connection information is contained in the EAR, although password indirection is used so you also have to set a JDBC data source on Oracle WebLogic Server. |
To deploy a web service:
To deploy a PL/SQL web service:
For more information, see Section 9.4.1, "Deploying to a Java JAR".
To examine the contents of a web services deployment profile:
.java and .wsdl files for the web service. If you have deployed the web service to Integrated WebLogic Server you do not need to undeploy it as the integrated server resets itself to the new application and project whenever it is started.
If you have deployed the web service to a server using an application server connection, you can undeploy it from the Resource Palette.
To undeploy a web service:
application-name_project-name_ws and choose Undeploy. You can analyze web services in a number of ways, for example to check whether they conform to WS-I Basic Profile 1.1, or to investigate the contents of SOAP packets.
The Web Services-Interoperability Organization (WS-I) was formed by Oracle and other industry leaders to promote the interoperability of web services technologies across a variety of platforms, operating systems, and programming languages. JDeveloper provides tools that allow you to test the interoperability of web services by checking that the services conform to the WS-I Basic Profile 1.1. For more information about WS-I, see the web site of The Web Services-Interoperability Organization (WS-I) at http://www.ws-i.org.
In order to monitor a web service against the WS-I Basic Profile, or analyze the log file resulting from monitoring a service, you need to have downloaded a WS-I compliant analyzer.
You can analyze a web service for conformity to WS-I standards. The service can either be one you have created that is listed in the Application Navigator, or it can be a web service that you have located using a UDDI registry that is listed in the Resource Palette. Alternatively, you can create a client and proxy classes to access a deployed web service and use the HTTP Analyzer to create a log file that you then use to analyze whether the web service conforms to WS-I standards.
In order to use a WS-I compliant analyzer to analyze a web service, you need to download one to your machine and register it with JDeveloper.
To download and register a WS-I analyzer:
http://www.ws-i.org. For detailed help in using this dialog, press F1 or click Help from within the dialog.
The following sections describe how to monitor and analyze web services:
You can produce a report of a web service that is listed in the Application Navigator, or that you have located using a UDDI registry and that is listed in the Resource Palette to see whether it conforms with WS-I Basic Profile 1.1 standards. Before you can do this you must have downloaded a WS-I compliant analyzer to your machine and registered it with JDeveloper.
The parts of the WS-I Basic Profile that check the content of messages sent between a web service and a client cannot be used until the client is run against the service. When invoked from the navigator, the WS-I analyzer can only analyze the description of the service in its WSDL document.
To analyze a web service:
For detailed help in using the wizard, press F1 or lick Help from within the wizard.
wsi-report.html is displayed in JDeveloper. The report may take a few moments to appear, depending on whether you are analyzing a local web service or one deployed elsewhere on the Web. You can use the HTTP Analyzer to produce a log from running a web service client. Then you can use a WS-I compliant analyzer that you have downloaded and registered with JDeveloper to check whether the web service complies with WS-I standards.
Because you are running the analyzer against a client to the web service, discovery, description and messages of the service are reported on.
| Note: If you are working within a firewall, make sure that the proxy server exceptions do not include the IP address of the machine on which the web service is running. |
To create and analyze a web service:
or
or

or


There are a number of reasons why you may find you have problems when performing an analysis of a web service. Some of these are outside the scope of the JDeveloper documentation, but there are two issues you might come across:
When the Message section of the wsi-report.html is missing all inputs
This can happen when the WSDL for an external web service has an endpoint that contains the machine name in upper or mixed case, and the client generated by JDeveloper has the _endPoint variable with the machine name in lower case. This is similar to the case discussed in Section 16.13.3, "How to Analyze Web Services Running in the Integrated Server".
The workaround is to import the WSDL into JDeveloper so that it is listed in the navigator, then edit the WSDL so that the machine name is lower case. Then you can generate the client (and associated proxy classes) and run it with the Http Analyzer running.
To import the WSDL into the navigator:
When the Discovery section of the wsi-report.html is missing all inputs
The Discovery section of wsi-report.html reports on the REGDATA artifacts that are used by web services you locate in a UDDI registry. If you have created a report of a web service that you have not located using a UDDI registry, then it all the Inputs in this section of the report will be missing.
The WS-I compliant analyzer correlates messages in the log file against a set of standard assertions, and in particular the soap:address subelement of the service element in the WSDL document must exactly match that specified in the wsi-log.xml messageEntry's senderHostAndPort or receiverHostAndPort, otherwise the messages will not be analyzed for WS-I compatibility.
When the web service is run in the Integrated Server (by choosing Run from the web service's context menu), and you create the log by running the Http Analyzer while running a generated client against the web service, you may need to change the web service endpoint in the WSDL or the _endPoint variable in the generated client before creating the log file of the client running.
To make sure the web service endpoint is the same as the _endPoint variable in the proxy:
soap:address subelement, and edit the endpoint. IP_address:integrated_port_no (the default integrated port number is 8988) hostname (lower-case) EmbeddedStub.java file by double-clicking on it and navigate to the _endPoint variable. After ensuring the web service endpoint is the same as the _endPoint variable in the proxy you can create and analyze the web service logs. For more information, see Section 16.13.2, "How to Create and Analyze Web Service Logs". For JAX-WS web services, you can change the endpoint address without modifying the WSDL, as shown in the following example:
You can use the HTTP Analyzer to examine the network traffic of a client connecting to a web service. More information, see Section 8.3, "Monitoring HTTP Using the HTTP Analyzer". It allows you to:
You can use the results to debug a locally or remotely deployed web service.
| Note: In order to use the HTTP Analyzer, you may need to amend the proxy settings. For more information, see Section 16.2.1, "How to Use Proxy Settings and JDeveloper". |
To examine the packets sent and received by the client to a web service:
or
Deploy and run the web service on Oracle WebLogic Server. For more information, see Section 16.12, "Deploying Web Services".



This part describes how to develop Java applications with Oracle JDeveloper. JDeveloper enables you to build and assemble Java applets and client applications using JavaBeans, and interactive, desktop-based GUI applications using Swing and AWT components. You can also create and run Java client applications with Java Web Start within the JDeveloper IDE.
This chapter describes the tools and features that JDeveloper provides to help you develop Java applications. These include the Java Source Editor, toolbar icons, and Code Insight.
This chapter describes how to build Java applications. It explains how to define classes on a diagram. Class members, inheritance, and composition relationships are all derived directly from the Java source code for those classes
This chapter describes how to run and debug Java programs. JDeveloper offers several techniques to monitor and control the way Java programs run. When running Java programs, JDeveloper keeps track of processes that are run and debugged, or profiled.
This chapter describes how to develop Java Swing interfaces. It explains the fundamental tasks you perform as you work with components and the JDeveloper UI design tools to create a user interface.
This chapter provides an overview of the tools and features that JDeveloper provides to help you develop Java applications.
This chapter includes the following sections:
JDeveloper enables you to build and assemble Java applets and client applications using JavaBeans, and interactive, desktop-based GUI applications using Swing and AWT components. You can also create and run Java client applications with Java Web Start within the JDeveloper IDE.
JDeveloper provides resources for editing, optimizing, running, and debugging Java code:
The Java Source Editor displays Java source files, and facilitates editing of Java code. The Java Source editor is a specialized form of the generic Source Editor that JDeveloper provides for editing source code across several technologies, including XML, JSP, and HTML.
In additional to the Java-specific features of the Java Source Editor, you can also use the common set of features that JDeveloper provides to enhance coding across all domains. These features are available through the context menu or the Source menu.
Double-clicking a node in the Application Navigator either opens or brings the default editor to the foreground. When a file is open in the Source Editor, its corresponding elements are displayed hierarchically in the Structure window. Double-clicking a node in the Structure window shifts the focus to the definition of that element in the Source Editor.
You can customize the behavior of the Java Source Editor by specifying preferences in the Preferences Dialog.
The Java Source Editor provides features to enable easier and quicker navigation through code.
With Java Code Insight, you can filter out information not likely to be as useful to you (such as top-level packages, imported classes, default Object methods, deprecated items) and emphasize the information that you'll want to focus on (local variables, locally declared members, overloaded methods).
You can configure member insight, the Java-specific implementation of Code Insight's completion insight, and you can choose to display deprecated members or not in Code Insight's parameter insight window.
Member insight provides you with a list of which instance and static members (fields, methods, inner classes) are accessible from a given statement context. For example, it tells you which methods you can call from any given method.
You can use Code Insight to speed up the process of writing code. Code Insight has two varieties: completion insight and parameter insight. You can enable or disable each independently and set the delay in seconds for each to appear when the cursor is paused at an appropriate insertion point.
To invoke completion after typing the period separator or, in the default keymap, press Ctrl+Space. To invoke parameter insight, pause after typing an opening (the left) parenthesis or, in the default keymap, press Ctrl+Shift+Space. To exit either type of insight at any time, press Esc. Note that if you change your keymapping, these keyboard accelerators may change. You can click QuickDoc, located at the bottom right of the completion insight list, to display the Javadoc for the currently selected element
After a method has been completed by completion insight, the source editor automatically fills in the parameters based on the method code. You can tab between these parameters, and edit them manually or using parameter insight.he source editor will automatically add an import if it can find only one exact match for an unresolved reference to a class. You can set preferences for this feature in the Preferences Dialog.
To change Code Insight settings or to view or change accelerators, from the main menu choose Tools > Preferences to open the Preferences dialog and then navigate to the appropriate page. For more information, see Section 17.4.1, "How to Set Code Insight Options for the Java Source Editor"
Use the Code Insight feature to quickly add annotations to your Java code. An annotation is used to associate information with a program element. Annotations can be used in classes, fields, methods, parameters, local variables, constructors, enumerations, and packages. To add annotations in your Java code: declare the annotation, create a function, and then add your annotations.
When you start adding an annotation, Member Insight (Ctrl-Space) displays a list of options (fields, members, classes) based on the statement context. Parameter Insight (Ctrl-Shift-Space) displays information about the annotation like the names of the elements of the annotation type, the default values, and the created values. It also highlights the element currently under the cursor in the annotation.
For more information see Section 18.5, "How to Customize Javadoc Options for the Java Source Editor."
You can hold down the Shift key and then hover over a variable or method to show its definition in a ghost window. This feature makes it convenient to quickly view code without moving cursor focus from your current code.
While dragging the vertical scroll bar, a small tip window appears next to the bar, revealing the methods that are visible or partially visible on screen. This enables you to more easily see what methods are in view while quickly scrolling. You can also see the name of the method whose beginning is not immediately in view.
To search incrementally, from the main menu choose Search > Incremental Find Forward or Search, then Incremental Find Backward. In the dialog that appears, begin typing. As you type, the cursor jumps to the next instance of that particular letter combination, either forward or backward. The search does not support wildcards.
Shortcut keys, or accelerators, are combinations of keys that you can use to navigate or to perform certain operations using the keyboard instead of the mouse. You can select from a variety of predefined keymaps or define your own accelerators.
To view or change existing accelerators, to define new accelerators, or to load preset keymaps, from the main menu choose Tools, then Preferences to open the Preferences dialog and then navigate to the Shortcut Keys page. To view or change accelerators for the editor, select Code Editor from the Category list.
Note that block commenting is indicated by Toggle Line Comments. It is defined in the default keymap as Ctrl-Shift-Slash or Ctrl-Slash.
While bookmarking code:
To navigate to the source for any identifier in an open Java file, right-click on the identifier you would like to browse and choose Go to Declaration. Alternatively, you can hold down the Ctrl key and click on an identifier to navigate to its source. If the source is not available, JDeveloper will reverse-engineer the class file.You may browse imported classes and interfaces, member fields and methods, and local variables. If you are browsing a method or constructor invocation, this declaration search will resolve the types in order to determine the correct method or constructor invocation. For instance, the code in Example 17-1 revokes the declaration search at SetText. It brings up the source code for javax.swing.JButton, with the SetText() method displayed.
Example 17-1 Revoking the Declaration Search
If the identifier cannot be browsed or if there is nothing at that cursor position, this search command on the context-sensitive menu will be disabled. If JDeveloper is unable to locate the appropriate location to jump to or if the identifier cannot be browsed due to access restrictions (for example, private members), the Java Source Editor's status bar will display a message indicating so.
Code templates are sections of pre-written code that can be conveniently inserted into source file to avoid typing it in manually. Templates can intelligently modify the inserted code to suit its surrounding code, and imports required by code templates are automatically imported. You can use shortcuts to speed up the selection of the required template. Pressing Ctrl+Enter anywhere in the source file brings up a list of code templates that you can select. The templates provided in this list are contextual and only those suitable for the current location are offered. You can click QuickDoc on the bottom right corner of this list to see the structure of the selected code template.If you were using the existing template for the for loop, for instance, you would type for and then (in the default keymapping) press Ctrl+Enter. The template would then be filled in as follows:
for (;;)
A complete list of all code templates is available in the Code Editor Help.To edit or create code templates, or to view or change accelerators, from the main menu choose Tools > Preferences to open the Preferences dialog and then navigate to the appropriate page.
For more information, see Section 18.3.9, "How to Use Code Templates."
You can customize the behavior of the Java Source Editor using the Preferences Dialog.
You can also use the Preferences Dialog to specify settings for the general source editing environment.
You can set various Insight options to create the behavior you want.
To set the options for Code Insight as it applies to Java:
JDeveloper enables you to set comment and brace-matching options for the Java source editor.
To set the options for Java comment and brace matching in the source editor:
Note that block commenting is an accelerator function. In the default keymap, use Ctrl+Shift+/ or Ctrl+/ to block-comment Java code.
You can view assistance that enables you to organize import statements in the Java Source Editor.
To enable assistance for automatically adding import statements:
You can set options to sort import statements in the Java Source Editor.
To set the options for sorting import statements:
The Java Source Editor displays Java source files, and facilitates editing of Java code. Icons that perform various features are located at the top of the Java Source Editor, as described in Table 17-1.
Table 17-1 Toolbar Options
| Icon | Name | Description |
|---|---|---|
|
| Quick Outline | Click to display a tree of the available methods and fields of the current class and its super classes. Clicking this icon brings up the Quick Outline window (for more information, see Section 17.6, "Using the Quick Outline Window"). This window floats just above the code and contains a tree of the available methods and fields of the current class and its super classes. You can instantly start typing in a filter field to reduce the visible items, allowing quick and easy selection for navigation to the desired place |
|
| Code Highlight | Click to highlight all instances of the code component that the cursor is currently placed on. |
|
| Clear All Highlighting | Click to clear all highlighting. |
|
| Generate Accessors | Click to insert get and set methods into a class, using the Generate Accessors dialog. |
![]() | Override Methods | Click to override inherited methods for the class in focus. |
|
| Implement Interfaces | Click to modify a target class to implement one or more interfaces, or to make a target interface extend one or more other interfaces, using the Implement Interface dialog. |
|
| Reformat | Click to apply source formatting to your code. |
|
| Surround | Click to surround the currently selected block of text in the Java Source Editor with a coding construct, using the Surround With dialog. |
|
| Toggle Bookmark | Click to insert or remove a bookmark on the line of code currently in focus. |
|
| Go to Next Bookmark | Click to place the cursor at the next bookmark. |
|
| Go to Previous Bookmark | Click to place the cursor at the previous bookmark. |
![]() | Show Selected Element Only | Click to view only one particular element in the editor. You can use this feature to tightly focus on a method, class, inner class, or field declaration. A message at the bottom of the file reminds you that the Show Selected Element mode is currently active. |
|
| Block Coloring | Click to activate block coloring. You can use this feature to highlight blocks of code for better readability. Coloring preferences can be set using the Preferences Dialog. |
Clicking the Quick Outline Toolbar icon directly to the right of the Find field brings up the Quick Outline window shown in Figure 17-1. This window floats just above the code and contains a tree of the available methods and fields of the current class and its super classes. You can instantly start typing in a filter field to reduce the visible items, allowing quick and easy selection for navigation to the desired place.
Table 17-2 lists the available icons and options.
Table 17-2 Quick Toolbar Icons
| Icon | Name | Description |
|---|---|---|
|
| Show Methods | Click to display methods and constructors. The default is methods, fields, and static members all displayed. |
|
| Show Fields | Click to display fields. The default is methods, fields, and static members all displayed. |
|
| Show Static Members | Click to display static members. The default is methods, fields, and static members all displayed. |
|
| Show Public Members Only | Click to display only public members. The default value is deselected. |
![]() | Show Inherited Member | Click to display only inherited members. |
![]() | Sort Alphabetically | Click to sort class members alphabetically. The default value is deselected. |
|
| Sort by Type | Click to sort class members first by type (in this order: constructors, methods, fields, inner classes), and then alphabetically within those categories. The default value is selected. Click the down arrow next to Sort Alphabetically to view the option. |
|
| Sort by Access | Click to sort class members first by access modifier, and then alphabetically within those categories. The default value is deselected. Click the down arrow next to Sort Alphabetically to view the option |
The Java UI Visual Editor displays the visual components of a user interface in Editing mode. Note: You can use the Java Visual Editor for Swing/AWT Applications only.
When a Java Visual Editor is open, its corresponding elements are displayed hierarchically in the Structure window. If the Property Inspector is open, selecting elements in either the Structure window or the Java Visual Editor changes the selection in the Inspector as well.
The Java Visual Editor displays a GUI hierarchy. If these are menu items, the hierarchy is displayed in one fashion; if these are nonmenu items, it is displayed in another. The mode of presentation differs, as the sort of editing that you are engaged in differs. For more information, see Section 18.2.9, "How to View the Hierarchy of a Class or Interface."
When the node is selected in the Navigator, its GUI structure also displays in the Structure window. All nonmenu GUI items for this object appear under a node labeled UI. Any menu items appear under a node labeled Menu. Any non-GUI items appear under a node labeled Other. Once you have opened the Java Visual Editor for an object in the Navigator, to switch between the display of nonmenu GUI elements and menu elements you have only to click on a node below these UI or Menu nodes in the Structure window.
Because the display in the Java Visual Editor is rooted in the GUI hierarchy, when you click on a node (for all GUI objects) in the Structure window what loads into the editor is the visual representation of the root node and all its descendants: the entire hierarchy opens, regardless of which node in the hierarchy you selected. What displays in the editor reflects the complete GUI hierarchy; the specific element selected in the display reflects the specific node selected in the window. Selections in the Structure window and the Java Visual Editor are kept in synch.
If you have an orphan node in the Structure window, that node and its descendants comprise the entire hierarchy, with the orphan being the root of the hierarchy. The Java UI display will reflect this. If you had a control, for instance, that was not parented, and you selected the node for that control, the control and any descendants would now appear in the editor, without a container. Any changes you make to that control, however, will result in generated code.
Right-click anywhere within the Java Visual Editor to bring up a context-sensitive menu of commands. The context menus differ, depending upon whether you are editing nonmenu or menu items, and the commands available within the context menu depend on the selected object.
Use Swing and AWT JavaBeans components to assemble the user interface (UI) for a Java application or applet. You construct the UI in the Java Visual Editor by selecting JavaBeans from the Component Palette, such as buttons, text areas, lists, dialogs, and menus. Then, you set the values of the component properties and attach event-handler code to the component events. Tools to visually design and program Java classes to produce new compound or complex component.
For more information, see Section 20.1, "About Implementing Java Swing User Interfaces."
This chapter describes how to use the tools and features provided by JDeveloper to build Java applications. It explains how to define classes on a diagram. Class members, inheritance, and composition relationships are all derived directly from the Java source code for those classes.
This chapter includes the following sections:
JDeveloper enables you to build and assemble Java applets and client applications using JavaBeans, and interactive, desktop-based GUI applications using Swing and AWT components. You can also create and run Java client applications with Java Web Start within the JDeveloper IDE.
JDeveloper provides resources for performing the following tasks in the Java domain:
JDeveloper supports Java-aware features for locating and moving to the source code for your projects' classes and interfaces and their members.
While working in JDeveloper, you can browse Java elements directly from the UI or directly from a file open in the Java Source Editor.
To browse a Java element directly from the UI:
To browse a class or an interface for a file currently open in the editor:
The source file opens in the Java Source Editor.
When working in the Java Source Editor, you can quickly locate the declaration of any identifier.
To navigate to the declaration of a code element:
The source code for that element opens, with the line on which it is declared highlighted.
While working in the Java Source Editor, you can quickly locate references to a class or interface and its members. By default, usages in the current project and its dependency projects will be reported. You can extend the search to libraries if the source files for the libraries are accessible.
The Find Usages command can also be applied to individual methods and fields, and to local variables and parameters.
To find the usages of a class:
The Usages of <Object> dialog will open
The search will commence, and the results will be displayed in the Usages Log window.
While working in the Java Source Editor, you can quickly locate references to a method.
The search will show applications of the method to instances of the class or interface for which the method is defined and also for instances of its subclasses or subinterfaces, if any, that inherit the method.
The Find Usages command can also be applied to classes and interfaces, fields, and to local variables and parameters.
To find the usages of a method:
The Usages of <Method> dialog displays. This dialog provides various options that you can specify to search for usages.
While working in the Java Source Editor, you can quickly locate references to a field.
The search will show references to the field in instances of the class or interface for which the field is defined and also for instances of its subclasses or subinterfaces, if any, that inherit the field.
The Find Usages command can also be applied to classes and interfaces, methods, and to local variables and parameters.
To find the usages of a field:
The search will commence, and the results will be displayed in the Usages of <Object> Log window.
While working in the Java Source Editor, you can quickly locate references to a local variable or a parameter in a method body.
The Find Usages command can also be applied to classes and interfaces, methods, and fields.
To find the usages of a local variable or parameter:
The search will commence, and the results will be displayed in the Usages Log window.
While working in the Java Source Editor, you can easily identify methods that override superclass definitions. Overriding definitions are marked with the Overrides up arrow icon in the Java Source Editor margin.
To view the overridden definition of a method, click the Overrides margin icon.
If you navigate to the override, then click the Back Main toolbar button to return to the previous view.
While working in the Java Source Editor, you can easily identify methods that override superclass definitions. Overriding definitions are marked with the Implements down arrow icon in the Java Source Editor margin.
To view the overridden definition of a method, click the Implements margin icon.
If you navigate to the override, then click the Back Main toolbar button to return to the previous view.
While working in the Java Source Editor, you can inspect the hierarchy of subtypes and supertypes of a class or interface. The Hierarchy window displays the hierarchy of the selected classes or interface.
To view the hierarchy of a class or interface in the Java Source Editor:
The Hierarchy window will open (if it is not already open) and the tree of either subtypes or supertypes will be shown.
To open a hierarchy initially in the Java Visual Editor:
The entire GUI hierarchy for the this node displays in the editor. The method of display depends upon whether this hierarchy consists of menu or nonmenu items.
You can use keyboard accelerators to step from member to member in a class definition in a Java Source Editor:
These additional code-stepping commands are also defined, but are not assigned default accelerators:
These commands are listed in the Navigate category of the Shortcut Keys page of the Preferences dialog. You can add or change accelerators.
JDeveloper provides many Java-aware editing features you can use to improve your productivity. As an alternative to text editing, you can also use the Java Visual Editor when developing graphical user interfaces. The Source Editor and Visual Editor are synchronized; a change in one is immediately reflected in the other. These Java editing features augment generic source editing features that support coding in any technology.
The Java Visual Editor displays the visual components of a user interface in Editing mode.
When a Java Visual Editor is open, its corresponding elements are displayed hierarchically in the Structure window. If the Property Inspector is open, selecting elements in either the Structure window or the Java Visual Editor changes the selection in the Inspector as well.
The Java Visual Editor displays a GUI hierarchy. If these are menu items, the hierarchy is displayed in one fashion; if these are nonmenu items, it is displayed in another. The mode of presentation differs, as the sort of editing that you are engaged in differs.
To open a hierarchy initially in the Java Visual Editor, you have only to select a node in the Navigator and then right-click and choose Edit, or use the View menu. The entire GUI hierarchy for the this node displays in the editor. The method of display depends upon whether this hierarchy consists of menu or nonmenu items.
When the node is selected in the Navigator, its GUI structure also displays in the Structure window. All nonmenu GUI items for this object appear under a node labeled UI. Any menu items appear under a node labeled Menu. Any non-GUI items appear under a node labeled Other. Once you have opened the Java Visual Editor for an object in the Navigator, to switch between the display of nonmenu GUI elements and menu elements you have only to click on a node below these UI or Menu nodes in the Structure window.
Because the display in the Java Visual Editor is rooted in the GUI hierarchy, when you click on a node (for all GUI objects) in the Structure window what loads into the editor is the visual representation of the root node and all its descendants: the entire hierarchy opens, regardless of which node in the hierarchy you selected. What displays in the editor reflects the complete GUI hierarchy; the specific element selected in the display reflects the specific node selected in the window. Selections in the Structure window and the Java Visual Editor are kept in synch.
If you have an orphan node in the Structure window, that node and its descendants comprise the entire hierarchy, with the orphan being the root of the hierarchy. The Java UI display will reflect this. If you had a control, for instance, that was not parented, and you selected the node for that control, the control and any descendants would now appear in the editor, without a container. Any changes you make to that control, however, will result in generated code.
Right-click anywhere within the Java Visual Editor to bring up a context-sensitive menu of commands. The context menus differ, depending upon whether you are editing nonmenu or menu items, and the commands available within the context menu depend on the selected object.
Right-click the Java file in the Navigator that you want to modify and choose Open > click the Design tab.
The source code is accessible in the Code Editor (right-click the file in the Navigator and choose Open to view the source code) so you can view and edit your source code in parallel with designing your UI. Any changes made in the Java Visual Editor or Property Inspector are immediately reflected in the source code, and vice-versa.
The Java Visual Editor toolbar lets you easily work with components and duplicates commands that you can choose from the context sensitive menu displayed on a selected component. Among the component operations included are:
JDeveloper is a lightweight (JFC) application. As such, using heavyweight (AWT) controls directly in the Java Visual Editor will not work as expected. Heavyweight components always obscure lightweight components, including the lightweight JDeveloper environment (including the Code Editor and UML Modelers).
The Java Visual Editor includes a proxy mechanism for registering lightweight proxies to represent heavyweight controls for instantiation in the Java Visual Editor. By default JDeveloper includes lightweight proxies for all the standard AWT controls.
JDeveloper supports lightweight views of heavyweight components that you register for use by the Java Visual Editor.
To register the proxy class:
Add a key-value definition to oracle.jdevimpl.uieditor.UIEditorAddin section in the JDeveloper\lib\addins.xml file, as shown in Example 18-1.
Example 18-1 Key-value Definition
where:
jdeveloper.concreteProxy For example; if you were to register a hypothetical heavyweight component implementation jdeveloper.concreteProxy.java.awt.Component using the oracle.jdevimpl.uieditor.proxy.Component proxy class, the property to add would look like Example 18-2.
Example 18-2 Heavyweight Component
In order for the Java Visual Editor proxy class to be available from within the IDE, so that it will appear can be added to the Component Palette, the proxy class must be added to the IDEClasspath as a directive in JDeveloper\bin\jdev.conf file. For example:
AddJavaLibFile <myUiProxies.jar>
where myUiProxies.jar contains the compiled class file for your Java Visual Editor proxy implementation.
Before creating a new class, note that you must first create an application and a project. As soon as you create the class, it is added to the active project.
To create a new class and add it to a project:
The new class appears in the active project.
Before creating a new interface, note that you must first create an application and a project. As soon as you create the interface, it is added to the active project.
To create a new interface and add it to a project:
The new class appears in the active project.
In the source editor, you can quickly add framework code to modify a target class to implement an interface or to make a target interface extend another interface.
An implements or extends clause is added to the declaration for the target class or interface, and an import statement is added to the file. If the target is a class, stub definitions for the implemented interface's methods are appended to the class or interface body.
To implement an interface:
In the source editor, you can quickly add stub definitions to a class to override methods inherited from superclasses.
To override methods:
The list displays methods inherited from all superclasses. Abstract methods are shown in bold type.
The stub method definitions are added to the class.
JDeveloper provides predefined code templates that you can use. Code templates assist you in writing code more quickly and efficiently by inserting text for commonly used statements. For example, the "Iterate over a list" (itli) template inserts the following code:
| Note: If the template contains variables, the variables are highlighted. You can edit each variable to complete the template. Pressing Tab moves the caret to the next template variable. |
In addition to the templates provided by JDeveloper, you can also define your own code templates in the Code Editor - Code Templates page of the Preferences dialog.
To evoke a defined code template:
The code as defined in the template is inserted in the source file. Import statements needed for the template, if any, are inserted at the top of the file.
| Note: Ctrl+Enter is the accelerator assigned in the default keymap. You can assign an alternative. |
This section lists the predefined code templates. The shortcut and the code that the template introduces are shown for each.
Array Iterator
Data Action Event Handler
for loop
if statement
if else statement
integer based loop
integer based loop
instanceof + cast
Instantiate a BC4J application module
Iterate over array
Iterate over a collection
Iterate over a list
Iterate over map keys
Iterate over map values
JDBC Connection
List to array
main method
out.println()
private ArrayList
private boolean
private HashMap
private int
private String
public static final
public static final boolean
public static final int
public static final String
Reverse array iterator
Reverse iteration over a list
System.err.println
System.out.println
switch statement
try statement
Insert a tag
while statement
You can use the Expand/Narrow Selection option to successively expand or narrow a selected block of code, based on Java syntax.
To expand selected code:
The selection expands to include the smallest logical unit containing the element previously selected or within which the cursor previously resided.
With each successive application of the option, the selection expands to include the next logical step up in the Java hierarchy, based on the starting point, until the entire file is selected. For example: method name, qualified method call, assignment, definition, and so on.
Use the Narrow Selection option (or press Ctrl+Shift+Minus) to successively reduce selected code in the same fashion.
You can easily surround Java statements and blocks with coding constructs in the Java Source Editor.
To surround a block of code with a construct:
| Note: This icon is only enabled when the selected code is a valid code block to which the Surround With feature can be applied. |
You can add needed import statements while working in the Java Source Editor. If, as you are typing in the Source Editor, you introduce a reference to a class that has not yet been imported, a ragged line will appear below it. A popup will open showing that an import is needed, giving the fully-qualified name of the class. JDeveloper will automatically add an import if it can find only one exact match for an unresolved reference to a class.
JDeveloper will automatically add an import if it can find only one exact match for an unresolved reference to a class. If the import assistance matches more than one possible match, then a popup list appears that lists all possible matches from the class path. The user can then choose the appropriate import and the import statement is automatically added.
The import assistance popup can be triggered at any time by pressing Alt+Enter.
The gutter-based code assistance can be used to add an import statement. If the editor doesn't recognize a class, a lightbulb appears in the gutter when the line is highlighted and various import options are displayed.
To configure or disable Import assistance, you can set Import Statement Options in the Java Source Editor.
You can organize import statements easily in the Java Source Editor. Set the options for organizing imports to your liking in the Preferences dialog. The following options are provided:
You can configure or disable import organizing options. For more information, see Section 17.4.3, "How to Enable Automatic Import Assistance for the Java Source Editor."
To organize import statements in a source file:
With the file open in the editor, right-click and choose Organize Imports.
You can use JDeveloper's editing commands to create and maintain documentation comments.
You can add documentation comments to your source files in the Java Source Editor.
To add documentation comments to a source file:
/**), and press Enter. A template for the documentation comment will be inserted in the file. Add information to the template to describe the element.
You can customize the use of documentation comment tags in the Java code editor. You can define custom tags, and choose which tags will be automatically included when a documentation comment is created. These choices apply to all projects.
To define a custom tag:
new will be added to the list. You can update documentation comments in the Java Source Editor.
To update documentation comments in a source file:
Tags will be added to or removed from the documentation comment to reflect changes you have made to the element. Add descriptions for the new tags.
You can validate documentation comments in your source files. The audit will report formatting errors and missing or extraneous tags.
To check documentation comments in a source file:
The Audit Profile dialog opens.
The results of the audit appear in the Log window.
You can add new Javadoc tags and customize the attributes of some existing tags. When creating custom tags, you can associate the tag with code elements, define it as required or not, assign it a default value, and give it an order in the tag list.
To customize the options for Javadoc in the Java Source Editor:
To do this without using the mouse, tab to the button and press the spacebar.
You can add documentation comments to your source files in the Java Source Editor.
To add documentation comments to a source file:
/**), and press Enter. A template for the documentation comment will be inserted in the file. Add information to the template to describe the element.
Every project you create carries the JDeveloper project defaults or those you have supplied yourself for all the projects across workspaces. You can also replace these defaults on a project-by-project basis. Setting these properties is the same in either case: only the location, and application, of the information differs.
To set Javadoc properties for an individual project:
The Project Properties dialog opens.
When working in the Java Source Editor, you can quickly access Javadoc-generated documentation for the following code elements: a class, interface, or an individual member, using the Quick Javadoc feature.
The Quick Javadoc feature looks up the selected entity on the source path and displays the Javadoc comment entered in a popup window. If no Javadoc comment exists for that element, an empty Javadoc comment is displayed. The source code is available if one of the following is met:
To display Javadoc for a code element:
A popup window displaying the documentation for the element appears. Click outside the window to close it.
The Quick Javadoc feature is available when the selected source code meets of the following criteria:
You can preview documentation comments in your source files, in the same way that you view Javadoc for a single source element.
To display documentation comments for a given class, member, or method call:
A popup window showing the Javadoc for just that element now appears. From this window, you can link to other Javadoc as you would in a browser.
JDeveloper provides these facilities for building projects:
The Make and Rebuild commands execute standard operations for compiling projects in JDeveloper.
Make operations compile source files that have changed since they were last compiled, or have dependencies that have changed. Rebuild operations, in contrast, compile source files unconditionally. You can invoke make on individual source files, on working sets, or on containers such as packages, projects, and workspaces.
If you wish to compile more selectively, you can add an Ant buildfile to a project, define additional targets, and run Ant to make those targets.
You cancel a compilation currently in progress by clicking the Cancel Build icon in the main toolbar. When you click this icon, an error message gets printed to the top row of the Compiler Log window.
Ways to make source file(s):
Rebuild operations compile all the source files in a project or workspace. Unlike make operations, which recompile only those source files that have changed or have dependencies that have changed, rebuild operations are not conditional.
If you wish to compile more selectively, you can add an Ant buildfile to a project, define additional targets, and run Ant to make those targets.
You cancel a compilation currently in progress by clicking the Cancel Build icon in the main toolbar. When you click this icon, an error message gets printed to the top row of the Compiler Log window.
Ways to rebuild source files:
JDeveloper provides fast yet complete compiling by analyzing dependencies while building. Dependency checking results in fewer unnecessary compiles of interdependent source files, and thus accelerates the edit and compile cycle.
When you compile using JDeveloper, dependency checking is performed whenever you compile with Make. Make uses a dependency file that is automatically created within JDeveloper.
If you compile from the command line, you create or use a dependency file by specifying the following parameter:
javac -make <makedepfile>
For each project, you can configure Java compilation options.
To configure project properties for compiling:
The Project Properties dialog appears.
| Note: If you want to have all your project files automatically saved before compiling, specify this in the Environment page of the Preferences dialog. |
You can specify an encoding scheme to control how the compiler interprets multibyte characters. If no setting is specified, the default native-encoding converter for the platform is used.
Text characters are represented using different encoding schemes. In the Windows environment, these are code pages, whereas Java refers to them as native encodings. When moving data from one encoding scheme to another, conversion needs to be done. Since each scheme can have a different set of extended characters, conversion may be required to prevent loss of data.
Most text editors, including the JDeveloper source editor, use the native encoding of the platform on which they run. For example, Japanese Windows uses the Shift-JIS format. If the source code has been encoded with Shift-JIS and you are compiling it in a US Windows environment, you must specify the Shift-JIS encoding for the compiler to read the source correctly.
JDeveloper supports the character encoding schemes included with your currently installed J2SE.
To set the encoding option, do one of the following:
-encoding option followed by the encoding name. The Java SDK supported encodings are listed at http://download.oracle.com/javase/6/docs/technotes/guides/intl/encoding.doc.html
JDeveloper uses the Java Compiler (Javac) to compile Java source code (.java files) into Java bytecode (.class files). The resulting bytecode is the machine code for a Java Virtual Machine (JVM). Compiling a Java source file produces a separate class file for each class or interface declaration. When you run the resulting Java program on a particular platform, its JVM runs the bytecode contained in the class files.
Javac compiles the specified Java file and any imported files that do not have a corresponding class file. Unless dependency checking is specified (with the -make option), the compiler compiles all of the target Java files. For more information, see Section 18.6.1.3, "Understanding Dependency Checking."
When you work inside JDeveloper, the compiler used is Javac. You can adjust compiler options in the Project Properties > Compiler > Option.
The following command line options are supported:
-classpath path
The path used to find classes. It overrides the default CLASSPATH or the CLASSPATH environment variable. Directories are separated by semicolons. For example, to search for the class foo.java in the myclasses directory, you would enter the following:
mydir;c:\jdeveloper\myclasses foo.java (Windows)mydir;/usr/jdeveloper/myclasses foo.java (UNIX)If you are using the Java 2 platform (the default target is JDK 1.6), then the SYSTEM CLASSPATH is prepended to the CLASSPATH. For the above example, SYSTEMCLASSPATH would look similar to the following:
Windows
mydir; c:\jdeveloper\myclassesUNIX
~/mydir;/usr/jdeveloper/myclasses If JAVAHOME is not defined, then the JDK defined by the SetJavaHome in jdev.conf will be used. If there is no JAVAHOME, then the JDK in the <jdev_install>/jdeveloper/jdk will be used (if present).
If the target JDK is 1.6 (by using -target 1.6), the SYSTEM CLASSPATH is appended to the CLASSPATH. For the above example it would then look similar to the following:
Windows
mydir;jdeveloper\myclassesUNIX
~/mydir;~/usr/jdeveloper/myclassesTo change the SYSTEMCLASSPATH use option -sysclasspath or option -bootclasspath.
-sourcepath pathlist
A semicolon-separated list of paths used to locate required Java files.
-sysclasspath pathlist
A semicolon-separated list of paths used to find the system class files.
-bootclasspath pathlist
Equivalent to -sysclasspath.
-d outdir
The root directory of the class (destination) file hierarchy. For example:
javac -d C:\JDeveloper\myclasses JavaBean.java (Windows)
javac -d ~/usr/jdeveloper/myclasses JavaBean.java (Unix)
causes the class files for the classes defined in the JavaBean.java source file to be saved in the directory C:\JDeveloper\myclasses\MyPackage, assuming that JavaBean.java contains the package statement MyPackage.
Java files are read from the SOURCEPATH and class files are written to the CLASSPATH directory. The destination directory can be part of the CLASSPATH. The default destination matches the package structure in the source files and starts from the root directory of the source.
-deprecation:self
Detects usage of deprecated types, fields, and methods within the class they are defined in.
-encoding name
You can specify a native-encoding name (or code page name) to control how the compiler interprets characters beyond the ASCII character set. The default is to use the default native-encoding converter for the platform. For more information, see Section 18.6.1.5, "How to Specify a Native Encoding for Compiling."
For example,
javac -encoding SJIS JavaBean.java
compiles JavaBean.java and any directly imported Java files that do not have class files. Characters in all source files are interpreted as the Shift-JIS character set for Japanese.
-endorseddirs pathlist
Allows you to override the default value for java.endorsed.dirs, the default endorsed standards JDK classes provided by Sun. In pathlist, separate path names with semicolons.
-exclude classname(s)
This option allows you to specify class names to exclude from your build. The compiler will ignore all calls to public static void methods of the specified class(es). This is useful mainly for diagnostics where your non-production application build may contain code that will need to be compiled in the official production build. More than one class may be excluded by separating them with semicolons or specifying -exclude more than once. For example: -exclude p1;p2;p3 -exclude p4 will exclude four classes, p1, p2, p3, and p4.
| Note: This option is also supported in the JDeveloper IDE, on the Compiler - Options page of the Project Properties dialog. |
Example 18-3 contains example code that uses the -exclude option.
Example 18-3 -exclude option
When compiling the application in Example 18-3 without the -exclude option, the output is:
When compiling with the following -exclude option:
the output becomes:
and successfully ignores all calls to diag.Trace.
-extdirs pathlist
A semicolon-separated list of paths that overrides the location where the compiler looks for extensions.
-g
Generates debugging information in the class file. It is required to access local variables and other information while debugging the class.
-g:none
Forces the compiler not to generate debugging information in the class file.
-g:source,lines,vars
Generates selective debugging information in the class file.
-help -?
Displays the options for the compiler.
-make depfilename
Uses the named dependency file for dependency checking. If the specified file is not found, it will be created.
-msglimit:#
Maximum number of errors and warnings written to output. Use -1 to represent no limit. The default is 1000.
-noquiet
Displays file names as they are compiled.
-nowarn:<id>
When specified with an argument, suppresses the warning associated with the number entered by the user.
-nowarn:486
Suppresses unused import statements.
-nowarn:487
Suppresses partially used import statements.
You can also use -nowarn in combination with -warn:
-nowarn -warn:487
to output warnings only for warning 487.
-nowrite
Compiles the program without outputting class files.
-p packagename(s)
Compiles all the source files found in the specified package(s)
-rebuild
Rebuilds specified files regardless of dependencies. Rebuild is assumed unless the -make option is used.
-recurse [level]
Instructs the compiler to recursively descend into directories when expanding file name specifications containing wildcards.
For example:
might be the equivalent to entering:
The option [level] takes an optional integer argument specifying the maximum recursive level.
For example:
might be the equivalent to entering:
Note that foo/lish/lee/*java would not be within the scope of the [level] variable.
-s sourcefile
Compiles the specified source file name(s).
-source {1.1|1.2|1.3|1.4|1.5|1.6}
By default, the source is compatible with J2SE 1.5, which enables J2SE assertions in the source code. You can enter -source 1.4 if you want the source compatibility to be J2SE 1.4.
-strictfp
Forces the compiler not to use extended precision for intermediate floating point calculations.
-target [1.1|1.2|1.3|1.4|1.5|1.6]
If the target is set to 1.1, the compiler compiles for JSDK 1.1. If the target is set to 1.2, the compiler compiles for Java 2 (JSDK 1.2). If the target is set to 1.3, the compiler compiles for Java 2 v1.3 (J2SE 1.3). If the target is set to 1.4, the compiler compiles for Java 2 v1.4 (J2SE 1.4).
The default target is JDK 6 (J2SE 1.6), consistent with Sun's javac defaults
-verbose
This option gives more information about compiling, such as which class files are loaded from where in the CLASSPATH. You get information about:
-verbosepath
This option displays SOURCE PATH and CLASSPATH values used by the compiler.
-warn:<id>
This option allows you to specify warnings. You can have any number of warnings in combination with any suppressed warnings. When used with no arguments, all warnings are displayed. Two useful warnings:
-warn:486
Displays Unused Import Statement
-warn:487
Displays Partially used Import Statement.
-warningtag tag[, tag]
A list of javadoc comment tags. If listed tag occurs in source comment, a warning is output. Use a comma to separate tags names.
You have two ways to compile applications (workspaces) and projects:
ojmake and ojdeploy. You can find both in the jdeveloper/jdev/bin directory.
ojmake can be used for applications and projects that don't involve any deployment, for example, projects with no deployment profile defined. ojdeploy can handle the build of any application and project (including any that involve deployment). You can think of it as a super-set of ojmake. You can view help for the tools simply by executing ojmake or ojdeploy on the command line. The help will display in the console.
| Note: When you work from the command line, it is possible to use Javac to compile Java files, but it's not possible to build applications and projects by executing Javac manually. You must useojmake or ojdeploy. |
You can clean your application or project using the Clean command. Running this command cleans the output and deploy directories in your project or application.
Running the Clean command on an application or project removes all class files, all copied resource files, and all deployed files. You can do this to ensure that there are no outdated files in the output and deploy directories. For instance, classes get renamed, moved, or deleted, and obsolete class files belonging to those classes need to be removed. Similarly, resources and deployments also get renamed, moved or deleted, and their obsolete copies in the output directory or deployment directory need to be removed. Cleaning enables you to remove previous build artifacts and start afresh.
You can run the Clean command on applications or projects.
When you clean an application:
The content in the deploy directory of the application is deleted.
The following conditions must be satisfied for the Clean command to run successfully:
The Clean command enables you to remove artifacts left over from previous builds in order to begin a fresh build process.
To clean a project:
To clean an application and all its projects:
You can generate API references and other documentation directly from the navigator, based upon the properties set for the project in the Javadoc page of the Preferences dialog. The documentation will be generated by the javadoc utility from the code and documentation comments in your files.
To run Javadoc on a package, file, or project:
The Javadoc is generated in the background. Information and results appear in the Log window. A link in the Log window allows you to add the index.html file to the project.
Apache Ant is a build tool similar in functionality to the Unix make utility. Ant uses XML formatted buildfiles to both describe and control the process used to build an application and its components. Ant supports cross-platform compilation and is easily extensible. Apache Ant is a product of the Apache Software Foundation. For more information, see the website http://ant.apache.org/index.html.
An Ant buildfile defines targets and dependencies between targets. A target is a sequence of programmatic tasks. When Ant is run to make a target, it first makes other targets on which it depends, and then executes the target's own tasks.
Ant is integrated into JDeveloper. Ant buildfiles can be added to or created for projects. Ant buildfiles can be edited with the XML Source Editor. Ant can be invoked from the user interface to make targets defined in buildfiles.
Ways to run Ant on buildfile targets:
You can invoke Ant from JDeveloper's main menu and toolbar to build targets defined in the current project's project buildfile.
A project can contain several Ant buildfiles, one of which can be designated as the project buildfile. You can configure the Run Ant on project toolbar button and dropdown menu to give easy access to the project buildfile's targets.
To select and configure a project's project buildfile, go to the Ant project properties page (choose Application > Project Properties).
Ways to run Ant on targets in the project buildfile:
Ant will make the project's designated default target.
Ant will make the project's designated default target.
The Ant Log window displays messages specific to the Ant build. Some features of the Ant Log window are:
Apache Maven is a software project management and comprehension tool. Maven can manage a project's build, reporting and documentation from a central piece of information, the project object model (POM). You can build the project using its POM and a set of plugins that are shared by all projects using Maven, providing a uniform build system.Maven can be extended by plugins to use a number of other development tools for reporting or the build process. For more information about Maven, see http://maven.apache.org/index.html.
The Project Object Model (POM) is an XML file that contains information about the project and configuration details used by Maven to build the project. The XML file contains most of the information required to build a project. Configuration information that can be specified in the POM includes the project dependencies, the plugins or goals that can be executed, and the build profiles.
For more information about the Maven Project Object Model, see: http://maven.apache.org/index.html
Use options in the New Gallery to:
To create a POM:
You can create a Maven POM based on an existing project that you select in the Application Navigator. Build elements will be added for multiple source directories. Settings will be added for the Java compiler you have specified for the project.
To create a Maven POM from a project:
You generate a new Project Object Model (POM) for the selected application and optionally, a new POM for each project in the application. This generates a top level POM for the application, and a POM for each project.
To generate a POM from a application:
You can create a:
This generates an application, a top level Project Object Model file (pom.xml) for the application, and a default pom.xml file for each project.
This generates a Java project that includes a default Project Object Model file and Maven Configuration. The Project Object Model file is automatically created during project creation.
To create a JDeveloper Project with a default POM:
Use the Application Navigator to locate and run a Maven project.
To run a Maven Project:
pom.xml file you want to run. The pom.xml file is typically located in the Resources folder under the project.
pom.xml file. The list of goals that displays in the context menu is set using the Maven: Goals properties dialog.
In the Maven project properties dialog, you can specify which version of Maven to use. Maven version 2.0 and above is supported.
To specify the Maven version:
Use the Maven Project Properties dialogs to specify:
settings.xml file pom.xml file To set Maven project properties:
JDeveloper comes with a set of ready-to-use JavaBeans on the Component Palette. You can also supplement these components by creating new JavaBeans yourself or by installing third-party ones.
JavaBeans Component technology lets you implement your own framework for data retrieval, persistence, and manipulation of Java objects. You can use JavaBeans technology to create reusable software components for building Java applets and Java client applications. In a Java EE application, applets and application clients can communicate with business-tier components directly or indirectly through web-tier components. For example, a client running in a browser would communicate with the business tier through JSP pages or servlets.
Although JavaBeans components are not considered Java EE web components according to the Java EE specification, JavaBeans components are often used to handle data flow between server components and application clients or applets on the client tier, or between server components and a database on the back end.
For more information on JavaBeans, for example, the basic notion of JavaBeans and what makes a bean, see http://download.oracle.com/javase/tutorial/javabeans/. The tutorial also contains lessons on writing a simple bean, bean properties, manipulating events and other topics.
JavaBeans are the Java building blocks used in the Java Visual Editor to build a program. Each JavaBean represents a program element, such as a user interface object, a data-aware control, or a system facility. You build your program by choosing and connecting these elements.
In order to speed up your UI design work in the future, create JavaBean components such as toolbars, status bars, checkbox groups, or dialog boxes that you can add to the Component Palette and reuse with no (or only minor) modifications
JDeveloper comes with a set of ready-to-use JavaBeans on the Component Palette. You can also supplement these components by creating new JavaBeans yourself or by installing third-party ones.
JavaBeans are objects in the true object-oriented programming (OOP) sense. Because they are true objects, JDeveloper components exhibit the following:
Each component encapsulates some element of a program, such as a window or dialog box, a field in a database, or a system timer. Visual components must ultimately extend either java.lang.Object or extend some other class that derives from it such as javax.swing.Panel. Non-visual JavaBeans components do not have this requirement.
To be recognized and used in JDeveloper, components must conform to the JavaBeans specification.
To be useful in a program, a JavaBean must provide the means by which it can be manipulated or interact with other components. JavaBeans meet this requirement by defining properties, methods, and events.
All components have properties, methods, and events built into them. Some of the properties, methods, and events that components provide are actually inherited from ancestor classes, which means they share these elements with other components. For example, all UI components inherit a property called background that represents the background color of the component. Each component can also introduce its own unique properties, methods, and events. For example, the Swing Checkbox component has a property called selected that indicates whether or not this component initially appears checked.
The first step in developing a bean for reuse is to create the JavaBean class. Using the Create Bean dialog, you can either create a new empty bean or extend an existing class to conform to the requirements of the JavaBeans component model.
To create a JavaBean:
The BeanInfo class defines a set of methods that allow bean implementors to provide explicit information about their beans. By specifying BeanInfo for a bean component, you can hide methods, specify an icon for the toolbox, provide descriptive names for properties, define which properties are bound properties, and much more.
When you create a bean and install it on the Component Palette, in most cases you will want its properties and events to appear in JDeveloper's Inspector. If you followed the JavaBeans design and naming conventions while creating your bean, all the properties and events you defined, plus all those inherited from superclasses, appear automatically.
However, you may not use the JavaBeans design and naming conventions, or you may have existing classes that don't use them. In addition, you may not want to give the user of your bean access to every property at design time.
To handle these situations, you can create a BeanInfo class that will provide explicit information about a bean to JDeveloper, rather than having JDeveloper derive the information through automatic introspection. You create this class by extending the SimpleBeanInfo class.
To create a BeanInfo class using the BeanInfo dialog:
SimpleBeanInfo for the BeanInfo that you want to implement. In the Java Visual Editor, you see an event primarily as the event-handling method that must be implemented in the class that contains the component. For example, suppose you want to place a button named button1 into a container called Frame1. In addition, you want something to happen when an end user clicks button1.
To implement the event-handling method
actionPerformed (actionPerformed is the event generated when a button is pressed). This creates a default action-listener name, which you may edit.
Frame1 source view and inserts an event-handling method into Frame1 that is called when that event occurs. The method is called button1_actionPerformed() by default. The body of the method is initially empty.
The end user sees all of the potential events from button1 listed on the Events page of the Property Inspector. As the component writer, you are responsible for creating the component class in such a way that all the events it generates will appear in the Property Inspector. All the end user must do to use your bean is write the code that fills in the event-handling method.
Behind the scenes, JDeveloper also generates additional code in the Frame1.java file to handle the other aspects of event listening:
ActionListener interface. Frame1. button1.addActionListener(). All of this code is visible in the source, but your primary task is to fill in the event-handling method that the action adapter calls when the event occurs.
The particular type of inner-class event adapters that JDeveloper generates by default are known as anonymous adapters. This style of adapter avoids the creation of a separate (named) adapter class. The resulting code is compact.
Example 18-4 contains code that is generated for an action-performed event using an anonymous adapter:
Example 18-4 Code Generated for an Action-performed Event Using an Anonymous Adapter
You can control how JDeveloper generates the adapter class by selecting the desired option from the Code Style page of the Project Properties dialog. The standard event adapters have only public- and package-level access, unlike anonymous adapters that have access to all variables in the scope where the adapter is declared.
Example 18-5 contains code that is generated for an action-performed event using a standard class:
Example 18-5 Code Generated for an Action-performed Event Using a Standard Class
JDeveloper generated the code in Example 18-4 using an anonymous inner class. Example 18-5 contains code that is generated for an action-performed event using a standard class. Both ways of using adapters provide the code to handle action-performed events, but the anonymous adapter approach is more compact.
To make standard adapters the default for your projects:
Now JDeveloper will generate standard adapters (as opposed to anonymous, inner classes) for its events.
When creating a bean for reuse, you will want to define its events. Once you have defined its events, you will want to select an event-handling adapter.
To make standard adapters the default for your projects:
Now JDeveloper will generate standard adapters (as opposed to anonymous, inner classes) for events.
JDeveloper provides the functionality to create a set of custom events and create an EventListener interface and an EventObject class to support those events.
To create an event set:
For complex beans, JDeveloper gives you the option of creating a customizer. A customizer allows you to modify the appearance and behavior of a bean within an application builder so it meets your specific needs. Sometimes properties are insufficient for representing a bean's configurable attributes. Customizers are used where sophisticated instructions would be needed to change a bean, and where property editors are too primitive to achieve bean customization.
For a complex customizer, you might create a wizard that questions the user about how the component should be customized. Based on the user's responses, the customizer edits all affected properties of the component. Whenever a customizer generates an event informing JDeveloper that something happened, JDeveloper generates the appropriate code.
To create a customizer:
When you develop a bean, you must think of all the events that the bean should be able to generate.
To make a component capable of firing events:
fire<yourEventName>Event() Refactoring is an editing technique that modifies code structure without altering program behavior. A refactoring operation is a sequence of simple edits that transform a program's code but, taken together, do not change its behavior. After each refactoring operation the program will compile and run correctly. JDeveloper provides a collection of automated refactoring operations.
Use refactoring when you modify a program's source code to make it easier to maintain, extend, or reuse. Perform the modification as a series of refactoring steps. After each step you can rebuild and revalidate the program to ensure that no errors have been introduced.
Some examples of simple refactoring operations are:
JDeveloper also provides more sophisticated refactoring operations such as:
If the results of the refactoring operation are not as desired, you can undo the refactoring as you would any editing operation, by pressing Ctrl+Z.
If you rename or move a class using the in-place edit functionality on a diagram, the source code for the class will be refactored automatically. Renaming or moving a Java package on a diagram will automatically refactor the contents of that package.
Deleting a field, method, or inner class on a diagram will automatically apply the Delete Safely refactoring pattern. For more information, see Section 18.8.4, "How to Delete a Code Element".
To apply a refactoring pattern to a Java class, interface, enum, or member on a diagram, select the class or member on the diagram and choose the refactoring pattern from the Refactoring menu. Where a refactoring pattern is applied in this way, the appropriate dialog is displayed, including the facility to preview the results of the refactoring. For more information, see Section 18.8.6, "Refactoring Classes and Interfaces."
The following refactoring patterns are available for the Java classes, interfaces, and enums on a Java class diagram:
The following refactoring patterns are available for the Java fields and methods on a Java class diagram:
JDeveloper provides a wide range of automated refactoring operations that enable you to enhance code quality in such a way that it does not alter the external behavior of the code, yet improves its internal structure.
To invoke a refactoring operation:
Refactoring context menus reflect the operations that are available in the current context. This is determined by the source element that was at the cursor when you right-clicked. These operations differ from element to element. Therefore, the refactoring context menus contain different items depending on where in JDeveloper you are right-clicking to display the menu.
For example, you can display different context menus containing different refactoring operations by right-clicking on:
If the results of the refactoring operation are not what you want, you can undo the refactoring as you would any editing operation, by pressing Ctrl+Z.
While developing your Java application you can easily rename the definition and all references to a package, class, interface, method, field, parameter, or variable. If you wish, you can first generate a preview — a list of the usages that will be replaced. Use the preview to inspect and modify or exclude selected usages, before causing the rest to be renamed.
The scope of a renaming operation is the full scope of the element in the project. Project, class, interface, and member usages are replaced anywhere they appear in the project. Parameters and variables are renamed only in the lexical scope of their definitions: other elements with the same name are not modified.
By default, the operation will be restricted to.java files, excluding comments (but not documentation comment tags that name code elements) and annotations. Usages that are not ambiguous will be replaced. Usages of class and interface names will be replaced if they are fully qualified or if they are named in import statements.
For package, type, and member elements, you can choose to extend the operation to comments or to other files. When extended to comments, replacements will be made in line comments, commented-out code, the bodies of documentation comments, and in annotations. When the operation is extended to other files, text replacements will also be made in project files of types designated as text files in the File Types page of the Preferences dialog. Replacements in comments and other files will be made more aggressively than replacements in Java code.
To rename a code element:
The Rename dialog opens.
If you selected Preview, to avoid all the usages being modified, finish the renaming operation from the Preview log window. For more information, see Section 18.8.3, "How to Rename a Code Element."
While developing your Java application you can safely delete the definition of a class, interface, method, or field. The deletion will not be performed without your confirmation if the element is still in use.
If the element is in use a log showing the usages will be displayed. Use the list to inspect and resolve the usages. If you then confirm the deletion, any remaining usages will remain in the code as undefined references.
To delete a code element:
The Delete Safely dialog displays while the project files are searched for usages.
When performing a refactoring operation that may modify many usages, it is useful to preview the usages to identify those that should be modified by hand or be excluded. You have the option, before committing these operations, of having usages listed in the Preview Log window, from which you can inspect and resolve them, and if you wish, commit the operation.
The log displays a collapsible tree of packages and Java files. Under each file, lines of code containing usages are listed.
To view a usage in an Edit window:
Double-click the entry in the log.
To exclude a usage from the refactoring operation:
Right click it and choose Exclude.
To commit the refactoring operation:
While developing your Java application you can easily define new classes and interfaces and repurpose existing ones.
When developing your Java application you can easily move a package, class, or interface to a different package. If you wish, you can first generate a preview — a list of the usages that will be replaced. Use the preview to inspect and modify or exclude selected usages, before completing the move.
When moving types, only primary classes and interfaces — those having the same name as their file — can be selected to be moved. In effect the file is renamed, and the definitions of secondary classes and interfaces remain with the primary. Accessibility will be preserved: if other classes in the original package refer to the class being moved, it will be given public access. If the class being moved refers to other classes in the original package, those classes will be made public.
The scope of an operation to move a class or interface is the entire project.
By default, the operation will be restricted to .java files, excluding comments (but not documentation comment tags that name code elements) and annotations. Usages that are not ambiguous will be replaced. Usages will be replaced if they are fully qualified or if they are named in import statements.
You can choose to extend the operation to comments or to other files. When extended to comments, text replacements will be made in line comments, commented-out code, the bodies of documentation comments, and in annotations. When the operation is extended to other files, replacements will also be made in project files of types designated as text files in the File Types page of the Preferences dialog. Replacements in comments and other files will be made more aggressively than replacements in Java code.
To move a class or interface:
The Move Vehicle dialog opens.
If you selected Preview, to avoid all the usages being modified, finish the renaming operation from the Preview log window. For more information, see Section 18.8.3, "How to Rename a Code Element."
Classes can also be moved in the Application Navigator by dragging multiple classes from one package to another.
While developing your Java application you can easily duplicate a class or interface.
Only primary classes and interfaces — those having the same name as their file — can be selected to be duplicated. The duplicated class or interface is added to the same package as the original.
Member names in the new class are given the same name as those in the original, except for those derived from the original class or interface name. When the original name is embedded in a member name, the new name is substituted.
To duplicate a class or interface:
| Note: Only primary classes and interfaces - those having the same name as their file - can be selected to be moved. |
The Duplicate type dialog opens.
The new class will be added to the project.
While developing your Java application you can easily derive a new interface from selected methods and static fields defined in an existing class.
Optionally, you can also generalize declarations — such as the type specifications of parameters, variables, and members — by replacing each type name in the declaration with the new interface name. Not all such declarations can be replaced. For example, the replacement cannot be done for the declaration of a variable that is used in a method invocation, if that method was not extracted into the new interface. The replacements will be done anywhere in the project.
The declaration of the class will be modified to show that it is an implementation of the new interface.
To extract an interface:
The Extract Interface dialog opens.
Otherwise, the interface will be created, and no usages will be replaced.
You can create a superclass based on chosen members of the current class. The superclass will consist of field and method declarations that match the chosen members.
To extract a superclass:
The Extract Superclass dialog opens
If you want a method to be created as an abstract method in the superclass, check the Abstract box against that method. If you want dependencies of a method to be included in the superclass, check the Dependencies box.
This option is enabled only if you have selected Replace Usages.
If you selected Preview, finish the extraction operation from the Preview log window. For more information, see Section 18.8.3, "How to Rename a Code Element."
Otherwise, the interface will be created, and no usages will be replaced.
While developing your Java application you can easily generalize declarations — such as the type specifications of parameters, variables, and members — by replacing references to the selected class with references to one of its supertypes. Not all such declarations can be replaced. For example, the replacement cannot be done for the declaration of a variable that is used in a method invocation, if that method is not also defined in the supertype. The replacements will be done anywhere in the project.
To generalize declarations:
The Use Supertype dialog opens.
If you selected Preview, finish the extraction operation from the Preview log window. For more information, see Section 18.8.3, "How to Rename a Code Element."
Otherwise, the substitutions will be made immediately.
You can convert an unnamed inner class (an anonymous class) into a named inner class.
To convert an anonymous class into an inner class:
The Convert Anonymous to Inner Class dialog opens
You can move an inner class to a newly created class at the top level.
To move an inner class:
While developing your Java application you can easily move member definitions from one class to another.
You can move a class member (for example, a method) to another class.
To move a non-static method:
If there is at least one suitable target to which the member can move, the Move Member dialog opens. Otherwise, a message box is displayed.
To move a static method:
The Move Members dialog opens.
You can change the signature of a method. The signature of a method is the combination of the method's name along with the number and types of the parameters (and their order.)
To change the signature of a method:
The Change Method dialog opens.
If you change the name of the method to one that already exists in the class, you will later see a second dialog. Through this you can opt to replace all usages of the method that you are changing to usages of the existing method.
| Note: This feature does not apply to constructors. |
You can assign the static modifier to a method.
To change a method to a static method:
If the class is part of a class hierarchy, the Make Static dialog opens. Otherwise, the static modifier is added immediately.
The options listed are derived from local object names.
While developing your Java application you can easily move the definitions of members from a class (the source class) to one of its superclasses (the target class). This operation can be applied to a class only if it has one or more potential target classes in the project. Members cannot be pulled up into library classes. Also, this refactor command is only available for a class that is declared with a superclass clause or a list of implemented interfaces.
By default, when a method is pulled up, its definition is moved from the source class to the target class. You can instead choose to abstract the method, in which case the method definition will remain in the source class, and a declaration for it will be added to the target class. Abstracting a method will convert the target class to an abstract class, if it is not already.
A member that you wish to pull up may have dependencies. A member is a dependency if it is used in the definition of a member that is to be pulled up. Pulling a member up without also pulling its dependencies up will introduce undefined references in the target class. When you select a member to be pulled up, its dependencies will be indicated. You can choose whether or not to pull up the dependencies as well.
When a member declared to be private is pulled up, its access changes to protected.
To pull members up:
The Pull Members Up dialog will open.
The members that are the dependencies of the selected members, if any, will be indicated.
| Note: Members that are to be abstracted do not have dependencies. |
This selection is transitive. It will cause dependencies of dependencies to also be pulled up.
While developing your Java application you can easily move the definitions of members from a class (the source class) to its immediate subclasses (the target classes).
By default, when a method is pushed down, its definition is moved from the source class to the target classes. You can instead choose to leave a method declaration in the source class, converting it to an abstract class, if it is not already.
A member that you wish to push down may have dependencies. A member is a dependency if its definition uses a member that is to be pushed down. Pushing a member down without also pushing its dependencies down will introduce undefined references in the source class. When you select a member to be pushed down, its dependencies will be indicated. You can choose whether or not to push down the dependencies as well.
To push members down:
The Push Members Down dialog opens.
The members that are the dependencies of the selected members, if any, will be indicated.
This selection is transitive. It will cause dependencies of dependencies to also be pushed down.
While developing your Java application you can easily convert expressions into named elements.
You can incorporate the body of a method into the body of its callers and remove the original method. This is known as inlining a method call.
To inline a method call:
While developing your Java application you can easily convert an expression into a reference to a field. A new field declaration will be added to the class, and the selected expression will become its initialization. The original expression will be replaced by a reference to the new field.
An expression cannot be converted into a field if its type is void.
To introduce a field:
The Introduce Field dialog opens.
The menu lists all types that are consistent with the expression. This option will not be shown if only a single type is valid.
You can modify or replace it, or choose another suggestion from the drop-down menu.
While developing your Java application you can easily convert an expression into a reference to a variable. A new variable declaration will be added to the method, and the selected expression will become its initialization. The original expression will be replaced by a reference to the new member.
An expression cannot be converted into a member if its type is void.
To introduce a member:
The Introduce Variable dialog opens.
The menu lists all types that are consistent with the expression. This option will not be shown if only a single type is valid.
You can modify or replace it, or choose another suggestion from the drop-down menu.
While developing your Java application you can easily convert a constant expression in a method body into a new parameter for the method. The expression will be replaced by the new parameter name, the new parameter will be added to the method's parameter list, and in all invocations of the method the expression will be inserted as an additional argument.
Expressions can be introduced as parameters only if they are literals or operations on literals.
This operation is disallowed for methods that implement an interface. Altering the signature of such a method would invalidate the implementation.
To introduce a parameter:
The Introduce Parameter dialog opens.
The menu lists all types that are consistent with the expression. This option will not be shown if only a single type is valid.
You can modify or replace it, or choose another suggestion from the drop-down menu.
While developing your Java application you can easily convert a constant expression into a constant reference. The new constant declaration initialized by the expression will be added to the class, and the original expression will be replaced by the name of the constant.
Expressions can be introduced as constants only if they are literals or operations on literals.
To introduce a constant:
The Introduce Constant dialog opens.
The menu lists all types that are consistent with the expression. This option will not be shown if only a single type is valid.
You can modify or replace it, or choose another suggestion from the drop-down menu.
While developing your Java application you can easily extract part of the body of one method to create another. The extracted code is replaced in the original method with a call to the new method. Local variables and parameters used in the extracted code become parameters of the new method. An assignment made by a statement in the extracted code, if any, will be converted in the original member to an assignment that takes the value of the call to the new method.
To be extractable, a piece of code must satisfy several restrictions:
break or continue statement for a loop outside of the selection, or a return statement. The new method is added to the same class as the original. The new method is declared to be private.
| Note: Only the selected code block gets replaced by the extracted method. Other occurrences of the same code block do not get replaced. |
To extract a method:
The Extract Method dialog opens.
This option is disabled if the method is forced to be static because it is called from a static method, or if it is forced to be non-static because it uses a non-static member.
The new method is added to the class, and the code you selected will be replaced by a call to the new method.
You can convert a constructor into a factory method.
To convert a constructor into a factory method:
The Replace Constructor With Factory Method dialog opens.
A suggested name based on the current class name already appears in the box.
You can change the fields of a class from being publicly accessible to being accessible only from within the class.
To encapsulate a field:
The Encapsulate Fields dialog opens.
In this dialog, you can also specify options for method/field accessibilities and the scope for replacements.
If you selected Preview, finish the extraction operation from the Preview log window. For more information, see Section 18.8.3, "How to Rename a Code Element."
While developing your Java application, you can select a boolean field, parameter or local variable and initialize it with the opposite value. JDeveloper automatically corrects all references to maintain the same code functionality. JDeveloper looks at all fields, parameters and local variables and inverts all usages. This refactoring changes the sense of a Boolean method or variable to the opposite one. A Boolean expression evaluating to true will be false. Likewise, a Boolean expression evaluating to false will be true.
For example, if you have a variable that is enabled and you want to change to change the meaning to disabled, the Invert Boolean menu choice changes usages to disabled.
To invert a boolean method:
Table 18-1 contains an example of an inverted boolean expression.
JDeveloper provides a suite of tools for analyzing the quality and performance of your Java code. Use these tools to improve both the quality of your code and your own programming skills.You can use JDeveloper's Auditing feature to analyze Java code for conformance to programming standards.
Auditing is the static analysis of code for adherence to rules and metrics that define programming standards. Auditing finds defects that make code difficult to improve and maintain. JDeveloper's auditing tools help you find and fix such defects. Code can be audited even when it is not compilable or executable.
You can create and customize profiles, choose the rules to be used, and set parameters for individual rules. Browse the audit rules and metrics to learn more about them. For more information, see Section 18.9.25, "How to Browse Audit Rules, Code Assists, and Metrics."
Developers's audit and metrics features are extensible. Audit and metrics are two facets of a source code analysis and transformation framework that can be customized and extended. The public API for both audit and metrics is the oracle.jdeveloper.audit package.
To audit Java code:
An audit report displays rule violations and measurements organized as a tree. A row of the tree corresponds to either a construct or a violation, and includes any measured values for the construct or theoretical violation. A construct is a method, class, file, project, or workspace.
The following properties are found in the rules:
Default fix
The fix that will be used for violations of this rule are when Apply Default Fix is applied to a construct.
Pattern
A regular expression used as a filter to find unconventional identifiers.
Severity
Use to sort rule violations in the audit report.
Visibility
A threshold based on the accessibility keyword. Violations will be reported only if they occur in classes or methods having at least the chosen visibility.
Audit rules are static, qualitative, analyses of code.
In an auditing profile individual rules can be enabled and configured by setting their properties. When a code construct does not satisfy a rule, a rule violation is reported. Some rules define automatic fixes that you can choose to apply.
Table 18-2 Audit Rules
| Rule | Description |
|---|---|
| Default Fix | The fix that will be used for violations of this rule are when Apply Default Fix is applied to a construct. |
| Pattern | A regular expression used as a filter to find unconventional identifiers. |
| Severity | Use to sort rule violations in the audit report. |
| Prefix | A regular expression used to find identifiers with unconventional prefix. |
| Visibility | A threshold based on the accessibility keyword. Violations will be reported only if they occur in classes or methods having at least the chosen visibility. |
Audit metrics are static, quantitative analyses of code.
In an auditing profile individual metrics can be enabled and configured. Metrics are configured by setting a threshold: when a code construct exceeds the threshold, an over-threshold measurement is reported in the audit report.
JDeveloper measures the following metrics:
Depth of Inheritance Tree (DIT)
The depth of the inheritance tree of a class. By convention, java.lang.Object has DIT of 1, a class which directly extends java.lang.Object has DIT 2, and so on.
Number of Statements (NOS)
The size, in Java statements, of a method, class, or other construct.
Cyclomatic complexity (V(G))
The branching complexity of a method. Constructs which enclose methods, such as classes and projects, are assigned the maximum complexity measured for an enclosed method. Values above 10 are generally considered problematic.
You can use auditing tools to view audit reports and to investigate and correct rule violations and over-threshold measurements. A new tab will be created in the Log window when auditing starts, and the audit report will be displayed in it.
Auditing is the static analysis of code for adherence to rules and metrics that define programming standards. Auditing finds defects that make code difficult to improve and maintain. The JDeveloper auditing tools help you find and fix such defects. Code can be audited even when it is not compilable or executable.
An audit report is a set of rule violations and metrics measurements presented as a tree organized into constructs. A construct is a method, class, package, file, project, or workspace. If the audit profile includes rules, the table will have a Severity column that shows the designated severity of the constructs. If the audit profile includes metrics, the table will have an additional column for each metric showing the measurements for the constructs.
To sort the report by the contents of a column, click the column header. To reverse the sort order, click again.
From the Log window toolbar you can perform the operations shown in Table 18-3.
Table 18-3 Audit Window Toolbar Icons
| Icon | Name | Description |
|---|---|---|
|
| Refresh | Click to rerun the audit on the same selection with the same profile. |
|
| Cancel | Click to terminate a running audit. Note that this may give partial results. |
|
| Export | Click to open the Export Results Dialog, from which you can save the report to a file. You may save the results in XML, HTML, or plain text. |
|
| Expand All | Click to expand all the container nodes in the report, exposing all the rows. |
|
| Collapse All | Click to collapse all the container nodes in the report, hiding all but the top-level constructs. |
|
| Group Constructs By | Click to open the Group By dialog, from which you can specify the types of container constructs that will be shown. Grouping by constructs enables you to organize the results better, track defects and violations quickly, and analyze the results easily. |
|
| Fix | Choose a fix for a rule violation from the dropdown menu. For an individual rule violation, choose among the fixes defined for that violation's type. For a group construct, the only choice is Apply Default Fixes, which applies the default fix defined for its type, if any. |
|
| Show Over Threshold Only | Toggle the display of measurements that are within acceptable limits. The threshold is a settable property of metrics. |
You specify filters to prune the set of Java classes whose violations are shown. You can filter by package names, class names, or both. A filter consists of one or more patterns separated by commas.
A pattern can contain the following special characters:
The set of classes that passes a filter is determined by considering the patterns in order. A non-exclusion pattern adds all classes that match the pattern to the set, an exclusion pattern removes all classes that match the pattern from the set. Table 18-4 contains the filters you can specify
Table 18-4 Filters
| Name | Description |
|---|---|
| Package | Enter filter patterns that will apply to all but the last element of fully qualified class names. If this field is empty it has no effect. |
| File | Enter filter patterns that will apply only to the last element of fully qualified class names. If this field is empty it has no effect. |
| Apply | Click to apply the given Package and File filters to the report's rows. |
| Clear | Click to erase the Package and File filters, and to restore the report's rows. |
Select one or more constructs (container nodes) or rule violations (leaf nodes) and right-click to open the context menu. From the context menu you can perform the operations shown in Table 18-5 on the selected constructs or rule violations.
Table 18-5 Audit Window Context Menu Items
| Name | Description |
|---|---|
| Apply Default Fixes | Choose to apply the default fix, if any, to each selected rule violation or to all the violations in the selected constructs. You can define the default fixes using the Tools > Preferences > Audit: Profiles page. |
| Apply <Fix> | Choose to apply this fix to the selected rule violation in the construct. |
| About <Rule> | Choose to display an explanation of the rule that applies to this rule violation. |
| Hide <Rule> Violations | Choose to remove all violations of the selected rule from the report. |
| Show Hidden Violations | Choose to restore all previously hidden violations. |
| Show Over Threshold Only | Click to toggle the display of measurements that are within acceptable limits. |
| Cancel | Choose to terminate a running audit. |
| Refresh | Choose to rerun the audit. |
| Group By | Choose to open the Group By dialog, from which you can specify the types of container constructs that will be shown. |
| Expand All | Click to expand all the container nodes in the report, exposing all the rows. |
| Collapse All | Click to collapse all the container nodes in the report, hiding all but the top-level constructs. |
| Go to Source | Choose to open the source file at the point of the rule violation. If you wish, you can edit the file and correct the violation. |
| Export | Choose to open the Export Results Dialog, from which you can save the report to a file. |
JDeveloper's auditing tools help you find and fix defects that make code difficult to improve and maintain. You can audit code even when it is not compilable or executable. The focus of an audit is defined by a profile, which is a set of audit rules and metrics.
You can browse the audit rules and metrics to learn more about them. For more information, see Section 18.9.25, "How to Browse Audit Rules, Code Assists, and Metrics."
To audit Java Code:
An Audit Report displays rule violations and measurements organized as a tree. A row of the tree corresponds to either a construct or a violation, and includes any measured values for the construct or theoretical violation. A construct is a method, class, file, project, or workspace.
You can save the finished audit report as an XML file or as a formatted HTML or text file. For more information, see Section 18.9.14, "How to Save an Audit Report." Formats are defined by XSL stylesheet files in the /jdev//audit/stylesheets directory (this directory is not created until audit is run). To create a custom format, adapt a copy of one of the predefined stylesheet files, and add it to the directory.
You can audit a workspace, a project, or a source file from the command line by invoking ojaudit.exe, which is included in your JDeveloper installation, in the <jdev_install>/jdeveloper/jdev/bin directory.
Synopsis
ojaudit option... file...
Table 18-6 contains the parameters you can use during the audit.
Table 18-6 Command Line Parameters
| Parameter | Description |
|---|---|
|
| The workspace ( |
| - | Set class path for files to audit, if a project is not being audited. |
|
| The character encoding for the report. If absent, the character encoding specified for the project is used (see the Compiler page of the project's Project Properties dialog). |
|
| Disable rule in profile. To supply multiple values, repeat this option. |
|
| Enable rule in profile. To supply multiple values, repeat this option. |
|
| Set the issue severity that the Auditor will regard as failure. |
|
| Applies default fixes to the code. This option modifies source files. |
|
| Prints help for the command help and exits. |
|
| The pathname of the output file. If omitted, output is written to standard output. |
|
| (required) The profile to use. It is either one of the profiles defined in JDeveloper (as set in the Audit > Audit Profiles page of the Tools > Preferences dialog), or the path name of an exported Audit profile file. Case and whitespace are ignored when searching for a matching profile. |
|
| Print defined profile names and exit. |
| - | The project context to use for parameters that are source files. If all parameters are projects or workspaces, this option is not required. |
| - | Suppresses the copyright message. |
|
| Set source path for files to audit, if a project is not being audited |
|
| The XSLT stylesheet to apply to the report. The name can either be a style sheet defined in JDeveloper, or a pathname to a style sheet file. If absent, the output will be an XML file. Case and whitespace are ignored when searching for a matching predefined stylesheet. |
|
| Print defined style sheet names and exit. |
|
| The title to use for the report. If absent when |
|
| Causes the title to be omitted from the report. |
|
| Causes all execution messages to be displayed. |
| - | Prints the command's version and exits. |
|
| The workspace context to use for parameters that are not workspaces. If no workspace is designated, a default workspace is synthesized. |
|
| Sets workspace context for files to audit. |
Developer allows you to audit your Java programs and generate an audit report.
To audit Java code in JDeveloper:
The Audit <File, Project, or Application> Dialog dialog appears.
An audit report appears in the Log window, and the audit begins. If you wish to stop the audit, click the stop icon in the log's toolbar.
An object is marked serializable by implementing the java.io.Serializable interface, which signifies that the object can be flattened into bytes and subsequently inflated in the future.
There is an identifier called serialVersionUID that enables versioning.
You can run an audit that flags all classes that implement java.io.Serializable but do not also have the serialVersionUID.
To set audit rules
An object is marked serializable by implementing the java.io.Serializable interface, which signifies that the object can be flattened into bytes and subsequently inflated in the future.
To turn off serialization on a field of an object, tag the field of the class of the object with the Java's transient keyword. If a class is marked as serializable, but contains unserializable fields that are not marked as transient, then the class is not serializable. You can run an audit to detect these unserializable fields.
To set audit rules:
Audit reports are displayed as tabbed panes of the Log window. Use the audit report to investigate and correct rule violations and over-threshold measurements.
Use refresh to rerun an audit using the same profile. You may wish to perform a refresh after you have made changes and fixes to your code.
To refresh an audit report:
The Export Audit Results dialog is cleared, and a new audit will begin. If you wish to stop the audit, click in the Log's toolbar.
You can rearrange the audit report columns to follow your preferred organization.
To organize audit report columns:
Audit report rows are rule violations or measurements, or groups of violations and measurements. The report is organized as a tree. A row of the tree corresponds to either a construct or a violation, and includes any measured values for the construct or a theoretical violation. A construct is a method, class, file, package directory, project, or workspace.
You can choose the constructs that are shown in the report.
To organize audit report rows:
The Group By dialog opens.
To sort a metrics report:
You can use a class name pattern filter to hide violations and measurements in classes that do not match the filter.
A filter is a sequence of patterns separated by commas, semicolons, or spaces. A pattern can contain the following special characters:
The set of visible classes is determined by considering the patterns in order. A non-exclusion pattern adds all classes that match the pattern to the set; an exclusion pattern removes all classes that match the pattern from the set. Patterns are matched against classnames.
To filter audit report rows:
The report will be redisplayed to show only the selected rows.
Click Clear to delete text from the Package and File boxes.
You can save an audit report as an XML file or as a formatted HTML or text file.
Formats are defined by XSL stylesheet files in the <jdev_install>/jdev/< system>/audit/stylesheets directory (this directory is not created until audit is run). To create a custom format, adapt a copy of one of the predefined stylesheet files, and add it to the directory.
To save an audit report:
The Export Audit Results dialog opens. Choose a title, format, and destination for the report, and click OK.
JDeveloper generates a report of all audit rule violations.
To inspect an audit rule violation:
An editor for the source file opens with the cursor positioned at the location of the rule violation or the code element measured
You can fix an audit rule violation manually by editing the source, or for some rules, by selecting an automated fix.
To manually fix an audit rule violation:
An editor for the source file opens with the cursor positioned at the location of the rule violation.
To apply an automated fix to an audit rule violation:
or
Click in the Log window toolbar, and choose one of the Apply <Rule> Fix menu items.
You can apply automated fixes to all the rule violations in a construct. Default fixes will be applied to each rule violation in the construct that has a Default Fix property with a value other than None.
To fix a construct's audit rule violations:
You can suppress the display of all the rule violations of a given type in the audit report. It is not possible to suppress individual rule violations.
To hide audit rule violations:
All of the violations of <Rule> are removed from the audit report. The removed rules are not tallied in their parent construct's summaries. Empty constructs are removed if Show Over Threshold Only is enabled. If not, just the violations are removed.
To restore hidden audit rule violations:
All of the previously hidden rule violations are restored to the audit report.
Metrics reports display measurements for the constructs in the analyzed code. You can focus the report on over-threshold measurements by hiding the others. The threshold is a settable property of metrics.
To show only over-threshold measurements:
In the Log window toolbar, click the over threshold icon. Click again to show all measurements.
Removed measurements are not tallied in their parent construct's summaries. Empty constructs are removed if Show Over Threshold Only is enabled. If not, just the violations are removed.
An audit profile defines the focus of an audit by specifying the rules, code assists, and metrics that will be used to analyze Java code. While several profiles are predefined, you can create others. You can modify an audit profile by enabling or disabling rules, code assists, and metrics, or by changing their configuration.
Certain audit profiles are used by default with some JDeveloper processes and features.
JDeveloper allows you to specify the rules, code assists, and metrics used to analyze Java programs.
To create an audit profile:
The Preferences dialog opens.
| Note: Names are not case or space sensitive, though case and space are preserved. If the new name differs only in case or space from an existing name, a warning message appears to inform you of this. |
The new profile name is shown in the in the Audit Profiles preferences page's Profile box.
JDeveloper allows you to modify audit profiles you created to analyze Java programs.
To modify an existing audit profile:
The Preferences dialog opens.
To delete an existing audit profile:
The Preferences dialog opens.
The profile's name will be removed from the Profile box.
You can import or export audit profiles. This would enable you to share profiles, for example, or to maintain a checked in profile used by ojaudit and a nightly build. Audit profiles are imported or exported as XML files.
To import or export an audit profile:
Browse the audit tests to learn more about them.
To browse the audit rules:
The Preferences dialog opens.
A description of the category will be shown in the Explanation box.
A description of the selected item will be shown in the Explanation box, and its properties and settings will be shown in the right pane
Activate and deactivate rules, code assists, and metrics for an audit profile from the Audit Profiles preferences page while creating or modifying the profile.
To activate or deactivate a rule, code assist, or metric:
To activate or deactivate a category:
In the left-hand list, click the checkbox for a rule category to activate or deactivate all the category's items. Clicking on any item in the category while pressing the Ctrl key achieves the same result.
To set an audit rule's property values:
The profiler gathers statistics on your program that enable you to more easily diagnose performance issues, such as bottlenecks by identifying methods consuming more time, which method is called the most, how memory is used, and what kind of objects are being created.
The Profiler monitors and logs a running program's use of processor and memory resources. It gathers statistics that enables you to more easily diagnose the performance issues and correct the inefficiencies in your code.
JDeveloper offers two kinds of profilers: The CPU Profiler and the Memory Profiler, for local as well as remote profiling.
Memory profiling displays which parts of the application are using the most memory. It also enables you to investigate which objects are responsible for holding the most memory. The Memory Profiler displays data in three views: Classes and Allocators for new objects/garbage collection reporting, and the References view for heap snapshots.
The Classes view shows new objects/garbage collection data organized by Java class. It is used to discover which classes allocated the most memory.
The Allocators view shows the threadgroups, threads and methods that created the most memory.
The References view contains a hierarchical display of all classes, objects and references to objects in the application heap at the time of the snapshot.
Profilers are invoked from the Run menu. You can use the Profiler pages of the Edit Run Configuration dialog to specify the mode of profiling you would like to analyze your code.
In the dialog, you can also specify how you want to profile your programs, locally or remotely. To profile your program locally, set Profiler Connection Parameters, and to profile your program remotely, set Remote Profiling Parameters in the Profiler page of the Edit Run Configuration dialog.
You can profile your application locally or remotely. In local profiling, you profile your application within JDeveloper by choosing one of the CPU Profile or Memory Profile commands from Run menu, or outside JDeveloper by choosing Attach Profiler from the Run menu. In remote profiling, you run a profiling session remotely. You profile your application external to JDeveloper with, or without, profiler parameters. The application's JVM can be on the same host or on a network.
You can configure options for the CPU and Memory profilers by right-clicking on a project and clicking Project Properties. Click Run/Debug/Profile > Edit > Tool Settings > Profiler to set the options.
You use the CPU Profiler to gather statistics on the performance of your application. The CPU Profiler can be used to test functions of your application, such as startup, initialization, repainting, and compiling.
The CPU Profiler collects sample data on a running application at regular intervals based on the Sample Interval setting, which you can change using the CPU Profiler options page. For more information, see Section 18.10.13, "How to Set Options for the CPU Profiler."
The Profiler provides two CPU profiling options: Sample CPU Time and Count Method Calls. You can use Sample CPU Time to determine the areas of your code which are accounting for the most (or least) execution time. Count Method Calls display which methods are called and the number of times they are called.
| Note: The Profiler does not allow you to sample time and count method calls at the same time. Counting method calls will cost you a high level of CPU time, and also distorts the profiler results. |
Counting method calls is the most expensive form of profiling, both in terms of CPU overhead and memory usage, because the process uses extra CPU for every method entry and exit and it collects data for every method that is called during the use case.
The CPU Profiler window displays data that the Profiler returns. It provides several options to view, sort, and organize Profiler results, as well as to begin, label, compare, and end Profiler use cases.
The profiler has two tools for memory profiling: New objects/garbage collection reporting and reference snapshots (also known as heap dumps). Use new objects/garbage collection reporting to find out what parts of an application are using the most memory. Use reference snapshots to find out what objects are responsible for holding the most memory. The options allow you to use both at the same time, but usually you would not need a snapshot unless you have spotted a memory leak, and you would not need another new objects/G.C. report if you are investigating a particular leak.
The Memory Profiler window displays data that the profiler returns. It provides several options to view, filter, sort, and organize Profiler results, as well as to begin, label, compare, and end Profiler use cases
The Profiler itself consumes CPU and memory resources during use. The overhead varies depending on the profiling mode in operation. In general, CPU sampling (with a 20 ms. sample interval) and reference snapshots are the fastest and use the least memory.
Both CPU method call count and memory new objects/garbage collection profiling are much more expensive in terms of CPU and memory in both the Profiler and profilee. This is because they intercept essentially every method call and record per method, per call stack, per thread data.
In the case of reference snapshots, it takes only a few seconds for the Profiler agent to write a snapshot file. All other processing is done outside the application, so memory snapshots have little effect on application performance.
Table 18-7 contains some actual performance times for an application's benchmark.
Table 18-7 Application Benchmark Times
| Profile Type | Relative Time | Time (seconds) | Notes |
|---|---|---|---|
| No profiling | 1.0 | 720 | |
| CPU samples | 1.025 | 738 | 20ms sample rate |
| CPU samples | 1.29 | 930 | 10ms sample rate |
| Memory new objects/garbage collection | 1.56 | 1125 | |
| Reference Snapshot | 1.02 | 735 |
Table 18-8 contains the numbers produced by a shorter run:
Table 18-8 Shorter Run Times
| Profile Type | Relative Time | Time (seconds) | Notes |
|---|---|---|---|
| No profiling | 1.0 | 30.7 | |
| CPU samples | 1.4 | 41.8 | 20ms sample rate |
| CPU samples | 1.7 | 51.2 | 10ms sample rate |
| Method call count | 4.6 | 141.2 | With method filter |
| Method call count | 6.6 | 201.3 | No filter |
As the Profiler output is essentially the same for both the 10 and 20 ms. sample intervals, the 20 ms. interval is preferable.
The two tables illustrate that while profiling overhead can vary dramatically for different use cases, CPU samples and reference snapshots are always less expensive than the other alternatives.
In JDeveloper, you can profile a usecase in the default allocated 512MB memory, but some use case require a memory of 1GB or more for new objects/G.C. memory profiling.
The aim of profiling is to discover those parts of an application that use more resources than desired, and improve them so that optimization of resources can be achieved. The process is to find individual commands, transactions, or sequences of actions that are perceived to be slow, use too much memory or leak memory. You then investigate the cause, make changes intended to improve performance, and then measure again to see if the changes had the desired effect.
In the profiler, we call such a command, transaction, or sequence of actions a use case. The profiler is designed to allow you to isolate meaningful use cases and measure them precisely. By default, the profiler measures nothing until you begin a use case and stops measuring when you end the use case. The data displayed is always relative to a given use case.
The toolbar in the profiler tab indicates the current use case status and provides controls to start and stop use cases and navigate between them.
The Begin Use Case icon in the top left of the toolbar is used to start a new use case. The End Use Case icon beside it is used to stop a running use case. When you start a use case, the End Use Case toolbar icon is enabled and the Begin Use Case toolbar icon is disabled.
If you save an active use case, the use case stops immediately; the End Use Case toolbar icon is disabled, and Begin Use Case toolbar icon is enabled.
Both the begin and end use case controls are disabled when:
The Profiler monitors and logs a running program's use of processor and memory resources. It gathers statistics that enable you to diagnose performance issues and correct the inefficiencies in your code.
The steps for profiling a project are:
For example, you can specify if you want the Profiler to sample CPU time usage by your application, or to count method calls. Or you can specify if you want the Profiler to report data on new objects and garbage collection, or to provide a heap snapshot.
You can also run a profiling session remotely. When you start a remote profiling session, the Profiler connects and profiles remote applications as if they were local. For more information, see Section 18.10.16, "Profiling Remotely."
The Begin Use Case control in the top left of the toolbar is used to start a new use case. The End Use Case control beside it () is used to stop a running use case. When you start a use case, the End Use Case toolbar icon is enabled and the Begin Use Case toolbar icon is disabled.
After you have completed your Profiling session, you can then use its statistics to more easily diagnose the performance issues and correct the inefficiencies in your code.
The CPU Profiler tabulates and displays statistical data on the performance on your application, either in terms of time usage, or methods called.
The CPU Profiler enables you to profile your code in one of two ways:
CPU profiling tabulates the processing time spent by each method in your application by displaying Java Platform calls, and counting those method calls. The CPU Profiler displays data in two views: Hotspots and Call Stacks.
The Hotspots view lists all Java platform methods and all methods they call, sorted by time usage in the CPU Profiler's time sampling mode of operation. It also displays the cumulative amount of CPU time spent in each method. During the method call count operation, the Hotspots view shows all the methods and the number of times they were called.
The Call Stacks view, during the CPU Profiler's time sampling mode of operation, lets you view the Java platform methods called in their call hierarchy. In the count method call mode, the Call Stacks view lists the Java platform methods called, sorted by thread group.
The CPU profiler, when used in time sampling mode, analyzes your program and reports results on CPU time usage. The data is displayed in two views: Hotspots and Call Stacks.
The Hotspots view lists all methods sorted by the value of the time spent in them. The hierarchy beneath each method shows the callers of the method, and in turn, their callers, and so on.
The topmost methods in Hotspots are often just noise; the path that the event dispatcher takes to accomplish a task. You can use the Stack Filter to narrow the view down to only relevant methods. Alternatively, you can use the Edit Filter dialog to enter a find or filter expression that will specify the methods to be displayed.
The Call Stacks view lets you see the methods called in their call hierarchy. That is, each level is called by the level immediately above it. Table 18-9 contains the data columns that display in the Calls Stacks View.
Table 18-9 Profiler Data Columns
| Column | Description |
|---|---|
| Name | Displays the fully qualified method names. |
| CPU% | Displays the percentage of the currently selected data column. For example, if the CPU column is selected, indicated by a downward-pointing triangle, this column is named CPU%. If CPU Shallow column is selected, the column name would be CPU Shallow%. |
| CPU (ms) | Displays the cumulative amount of CPU time spent in seconds, in each method and all the methods it calls. |
| CPU Shallow (ms) | Displays the amount of CPU time spent in each method individually. |
| Blocked (ms) | Displays the cumulative blocked time spent in each method and all the method it calls. The column is available if the Collect Blocked and Wait Time checkbox is selected in the Edit Run Configuration dialog. |
| Blocked Shallow (ms) | Displays the blocked time spent in each method. The column is available if the Collect Blocked and Wait Time checkbox is selected in the Edit Run Configuration dialog. |
| Wait (ms) | Displays the cumulative wait time of each method and all the method it calls. The column is available if the Collect Blocked and Wait Time checkbox is selected in the Edit Run Configuration dialog. |
| Wait Shallow (ms) | Displays the wait time of each method. The column is available if the Collect Blocked and Wait Time checkbox is selected in the Edit Run Configuration dialog. |
| Elapsed (ms) | Displays the cumulative elapsed time of each method and all the method it calls. The column is available if the Collect Elapsed Time checkbox is selected in the Edit Run Configuration dialog. |
| Elapsed Shallow (ms) | Displays the elapsed time of each method. The column is available if the Collect Elapsed Time checkbox is selected in the Edit Run Configuration dialog. |
| I/O (ms) | Displays the cumulative Input/Output time of each method and all the method it calls. The column is available if the Collect IO Time checkbox is selected in the Edit Run Configuration dialog. |
| I/O Shallow (ms) | Displays the Input/Output time of each method. The column is available if the Collect IO Time checkbox is selected in the Edit Run Configuration dialog. |
| Note: If you see more than one top-level method per thread in the Stacks view, the stack depth is too low for your application. To increase the stack depth, you need to update the CPU Profiler options page in the Edit Run Configuration dialog. |
The CPU Profiler, when used to count method calls, confirms that methods are being called and tells you how many times. Method call counting is useful when you want to know why a particular method is taking too much CPU time. You can use the Profiler's count method call data to analyze the callers to that method, and edit your code appropriately to reduce the number
You can specify if you want the Profiler to sample CPU time usage by your application, or to count method calls.
To set CPU Profiler options:
You can specify if you want the profiler to sample CPU time or count method calls.
Starting a CPU profiling session will automatically run your program. Once the CPU profiler window is open, you can begin a use case to profile your application.
To start the CPU Profiler:
project. If no default run target is specified in the Launch Settings page of the Edit Run Configuration dialog (Application menu > Project Properties > Run/Debug/Profile), the Choose Default Run Target dialog opens. Use this dialog to specify the default run target
| Note: If you want to profile your application immediately when the profiler is launched, select the Begin Use Case on Application Startup checkbox in the Profiler page of Edit Run Configuration dialog. |
The Memory Profiler enables you to find out how your program is using the Java heap. You can find inefficient heap usage and any suspect memory behavior.
The profiler has two tools for memory profiling: new objects/garbage collection (hereafter referred to as new/G.C. reporting) and reference snapshots (also known as heap dumps). Note the following points while using these tools:
Memory profiling and method call counts, slows down the system and the application considerably. Note the following points of information before you start profiling an application:
jdev -J-Xmx1024m
This command allocates 1 GB of virtual memory to JDeveloper, overriding the default memory of 512 MB.
-J-Xmx1024m parameter to increase the memory size before you start profiling. The Memory Profiler displays data in three views: Classes view, Allocators view for new/G.C. reporting, and the References view for heap snapshots.
A reference snapshot is a hierarchical display of classes, objects and references to objects in the application heap at the time of the snapshot. There are two fundamental kinds of references: references from JVM garbage collection roots to objects, and references from one object to another.
JVM garbage collection roots include references from an active thread, references from JNI local and global variables, and internal JVM references. These are the references that keep objects in memory; if there is no path from a gc root to an object, it is eligible for garbage collection. The snapshot contains only objects that are reachable from one or more JVM gc roots.
Note that static references and references from class loaders are not garbage collection roots. A class loader can be garbage-collected when there are no more references to the class loader, any classes loaded by the class loader or any objects of these classes. When a class loader is garbage collected, all classes it has loaded are also garbage collected, as well as all objects that are only referred to by static references from these classes.
There are four types of references from objects to objects: normal (strong) references, soft references, weak references and pseudo references. When you are looking for memory leaks, you normally only care about strong references. You can toggle between viewing only strong references, or all references.
New and old references in different snapshots are indicated using different font styles. When you compare two memory snapshots, the methods in the current snapshot show up in boldface font. If there are methods that are also in the other snapshot, they are shown in bold-italic font in the current snapshot.
There are several ways to compare reference snapshots. In the Memory Profiler References view, for example, you can choose Compare With to select a different use case (snapshot) from the current one. Or, if you have two profiler tabs open (for example, if you have opened a saved profile session) select Compare With and Other, then choose a use case from another session.
You can specify if you want the Profiler to sample CPU time usage by your application, or to count method calls.
To set memory profiler options:
You can specify if you want the profiler to collect new objects/garbage collection data, take a heap snapshot, or do both.
Starting a Memory profiling session also automatically runs your program. Once the Memory profiler window is open, you can begin a use case to profile your application.
To start the Memory Profiler:
project. You can run a profiling session remotely. When you start a remote profiling session, the Profiler connects and profiles remote applications as if they were local. Since you still run the Profiler locally, you can profile applications on other computers provided that they have a reachable IP address or DNS name.
The main difference between remote and local profiling is the way in which you begin the profiling session. For local profiling, JDeveloper automatically launches the program that you want to profile (the profilee) and then attaches the Profiler to that program. For remote profiling, you must manually launch that profilee program and attach the Profiler later. Once the profilee is launched and the JDeveloper Profiler is attached to it, remote profiling is no different from local profiling. Remember that you can use remote profiling whether or not the profilee process is running on the same machine as JDeveloper.
| Note: If you are profiling your application remotely, you can start your external application with or without profiler parameters. An application started with profiler parameters can have JVM can be on the same host (local) or on a network. An application started without profiler parameters must have JVM on the same host, and you may attach the profiler later. |
Remote profiling and local profiling each have advantages over the other. When you remote profile, the Profiler and profilee can be run on two different computers so that they are not competing for the same resources. However, transferring large amounts of data over a network could make profiler performance significantly slower.
To profile remotely in JDeveloper, you invoke the profiler agent. The JDeveloper profiler agent supports 32- and 64-bit JVMs in Windows and Linux. You specify a JVM for a project using the Edit Run Configuration - Launch Settings page.
The names of the profiler agent files are based on the supported architecture and JVM size:
If you launch the profilee from JDeveloper, the profiler automatically detects the size of the JDeveloper JVM.
If you attach locally and the JDeveloper JVM is 32-bit, the profiler attempts to load the 32-bit agent and if that fails, tries to use the 64-bit agent. If the JDeveloper JVM is 64-bit, the profiler only tries the 64-bit agent.
To profile a program remotely in JDeveloper, you must start the Java process from the command line. From the command line, you also invoke the Profiler Agent. Once the process has started, you can connect the JDeveloper Profiler to the Profiler Agent.
You can invoke the Profiler Agent using the -agentlib or -agentpath option.
To invoke the Profiler Agent using the -agentlib option:
At the command line, enter the following execution string:
| Note: While specifying the -agentlib, you may specify the absolute path of the agent excluding the .dll extension, or add the agent's path to your PATH variable and then specify the agent without absolute path and extension. |
Example 1
Example 2
To invoke the Profiler Agent using the -agentpath option:
At the command line, enter the following execution string:
where
<Path_to_Agent_Library> is the full path to the profiler_x32.dll or profiler_x64.dll. For example, <jdev_install>\jdeveloper\jdev\lib\profiler_x32.dll.
| Note: While specifying the -agentpath, you must specify the absolute path to the agent including the.dll extension. |
Example
Table 18-10 contains the suboptions that are available with the -agentlib and -agentpath options.
Table 18-10 Suboptions
| Suboption | Description |
|---|---|
|
| Specifies the port over which the data will be transferred. Defaults to 4000. |
| j | Path to profiler JAR file. This JAR is located at |
|
| Enables agent capabilities.
Only one of t, c or m may be specified. r may be specified in combination with m or by itself. |
|
| If a use case is to begin on startup, you may specify one of the following:
It is not possible to have a use case running unless the profiler is connected.
|
|
| Sets maximum stack depth used for collection. Defaults to 1000. |
| i | Sample interval in milliseconds. Defaults to 20. This is only applicable to CPU time sampling. |
|
| Report wait and blocked times. Default is n. This is only applicable to CPU time sampling. |
|
| Sets the path used to write reference snapshot files. Required if The same path is used for all snapshots, so it is important that the file be copied before the next use case ends. The profiler and file client do this automatically. |
|
| Specifies classes to include or exclude in stack traces. For example:
This expression will ensure that no reported stack trace contains any class whose name begins with |
|
| Collects only stacks containing the specified methods specified in the expression. For example:
This expression will ensure that no stack will appear unless it contains at least one call to |
|
| Object classes to include or exclude from memory reports. For example:
This expression will ensure that no class that contains java.lang in its string will be displayed. |
Command line examples
java -agentlib:profiler_x32=port=4000, jarpath=C:\JDeveloper\jdeveloper\jdev\lib\profiler-agent.jar,enable=t,depth=1000,startup=time,interval=20 -classpath C:\JDeveloper\jdeveloper\mywork\Application1\Project1\classes project1.Application1 java -agentlib:profiler_x64=port=4000, jarpath=C:\JDeveloper\jdeveloper\jdev\lib\profiler-agent.jar,enable=m,startup=connect -classpath C:\JDeveloper\jdeveloper\mywork\Application1\Project1\classes project1.Application1 java -agentlib:profiler_x32=port=4000, jarpath=C:\JDeveloper\jdeveloper\jdev\lib\profiler-agent.jar,startup=connect,mem -classpath C:\JDeveloper\jdeveloper\mywork\Application1\Project1\classes project1.Application1 java -agentpath:C:\JDeveloper\jdeveloper\jdev\lib\profiler_x64.dll=jarpath=C:\JDeveloper\jdeveloper\jdev\lib\profiler-agent.jar,port=4000,enable=t,startup=connect,depth=1000,interval=20 -classpath C:\JDeveloper\jdeveloper\mywork\Application1\Project1\classes project1.Application1 * To profile a program remotely in JDeveloper, you must first start the Java program session and invoke the Profiler Agent. For more information, see Section 18.10.18, "How to Invoke the Profiler Agent."
Once the session has started, you can connect the JDeveloper Profiler to it. Connecting the Profiler involves first preparing JDeveloper for remote profiling.
To set up a remote profiling session:
To connect remotely:
| Note: The Connect on Application Startup and Begin Use Case on Application Startup checkboxes in the Profiler page of the Edit Run Configuration dialog have no impact if you attach the profiler to a local process. The checkboxes are applicable when you attach profiler to a remote process only. |
JDeveloper allows you to dynamically attach and detach a profiler to a running process. This is similar to profiler attached remote profiling, but doesn't require you to specify profiler parameters on the command line when you launch the application. For example, if you are running an application with no plan to profile it when you started it, but later you wish to profile it because it is exhibiting some performance problems. In such a scenario, dynamically attaching a profiler to a running process saves you from restarting your JVM to attach a profiler to it.
Dynamically attaching a profiler has its limitations too. You can do CPU time sampling or take memory reference snapshots (heap dumps), but you cannot do method call counts or new/gc memory profiling as they require byte code instrumentation, which can only be requested on the command line before the JVM is launched.
To dynamically attach/detach the profiler to a running process:
To detach profiler from a running process, select Detach from the Run menu. If you disconnect the profiler by closing the Profiler tab, you cannot reattach to it. To reattach later, you must use Detach command.
To reattach the profiler to a process:
You can detach and attach the profiler to a process as many times as you want, but you must remember the following points before reattaching:
When you reattach profiler to a process, you can change your configuration settings and reattach with the new configuration settings. For example, if you are profiling CPU, you can change CPU configuration to enable or disable collect I/O time, CPU time, wait time, and so on. If you are memory profiling, you can reattach profiler to take heap dumps. You can also switch back and forth between CPU profiling and memory profiling.
However, you cannot reattach if you change your CPU profiling configuration to count method calls, or memory profiling configuration to New/gc. These require capabilities the profiler cannot acquire after the application starts running. To do either of these, you must launch the application with appropriate profiling parameters and attach profiler using the Attach to Remote Process command.
The Profile Points allow you to set a method filter on a method or class. This means that only stacks that contain those methods, or classes, are reported by the profiler. It is used to filter data so you only see a method, what calls it, and what it calls.
To set a profile point:
Disabling a Profile Point
You can disable a profile point in any of the following ways:
Deleting a Profile Point
When you no longer need to examine the code at a profile point location, you can delete the profile point. You can delete a profile point in any of the following ways:
The profiler allows you to save output for later viewing and analyzing.
To save a running profiler session to disk, in the File menu, select Save As. In the Save As dialog, enter an appropriate name to describe your session, for example, uianalysis.opr, or accept the default.
| Note: If you are saving an active use case, it will be automatically terminated. The End Use Case toolbar icon is disabled, and Begin Use Case toolbar icon is enabled. |
To open a saved profiler session, in the File menu, select Open, and navigate to the session you want to view.
A saved session is visually distinguishable from an active session by its unique profiler icon. In a saved session, the use case begin and end icons are disabled, but the use case navigation controls are active when multiple use cases are available.
JDeveloper allows you to open heap dumps in HPROF binary format and display them in the profiler. HPROF binary format heap dumps can be created by the HPROF profiler, by the JDK tools jmap and jconsole, or through the Java parameter -XX:+HeapDumpOnOutOfMemoryError.
For example, to create the HPROF file using the jmap command, you could enter on the command line:
For more information about HPROF, see http://java.sun.com/javase/reference/index.jsp
To open HPROF Binary File:
The heap dump opens in the profiler References editor tab.
| Note: Opening large heap dumps is a slow process and may take several minutes to open. The Writing output... progress item, which appears when file open process is approximately halfway done, indicates that the heap dump file is valid and will open for viewing. |
A Java class diagram allows you to visually create classes, interfaces, enums, and inheritance and composition relationships, and to view existing Java classes and interfaces. If you want to visualize a particular facet of your application, add only the classes that contribute to that aspect to the diagram.
To model Java classes you should start with a Java class diagram, although you can subsequently add other elements to the diagram. For more information, see Section 18.11.10, "How to Create a Diagram of Java Classes." You can create and modify the classes that comprise your application directly through the diagram. Changes made on the Java class diagram are immediately available in the Java source editor, and vice versa.
Dependencies are represented on the diagram as a dashed line with an open arrowhead in the direction of the dependency and are used for documentation purposes only and do not change the underlying Java code.
Java classes, interfaces, or enums are created on a diagram by clicking on the Java Class icon, Java Interface icon or Java Enum icon on the Java Component Palette for the diagram, and then clicking on the diagram where you want to create the class. The Java source file for the modeled class or interface is created in the location specified by your project settings.
Java Class, Java Interface, and Java Enum icons are represented on a diagram as rectangles containing the name and details of the Java class. Java classes and interfaces are divided into compartments, with each compartment containing only one type of information.
An ellipsis (...) is displayed in each compartment that is not large enough to display its entire contents. To view a modeled class so that all the fields and methods are displayed, right-click the class and choose Optimize Shape Size, then Height and Width.
Each type of class on a diagram is identified by a stereotype in the name compartment. This is not displayed by default.
Members (fields and methods) display symbols to represent their visibility. The visibility symbols are: + Public, - Private, # Protected. If no visibility symbol is used, the field or method has package visibility.
An interface is normally used to group together method signatures for groups of methods that together define a coherent service. Classes that want to provide the service defined by an interface do this by implementing the interface. Interface names must be unique within a namespace. Because interfaces can be used to specify a set of services that other classes provide, they can be used to enforce some level of consistency on those other classes.
| Note: Modeled Java interfaces can inherit from other interfaces using extends relationships. |
For more information, see Section 18.3.6, "How to Create a New Java Interface."
A diagram can include primary or inner classes from different packages, the current application, or from libraries. Inner Java classes and inner interfaces are defined as members of their 'owning' class. Hence, they are also referred as member classes.
Inner classes and inner interfaces are displayed in the inner classes compartment of the modeled Java class or interface on the diagram. Inner classes are prefixed with the term Class, and inner interfaces are prefixed with the term Interface, between the visibility symbol and the class or interface name.
To create an inner class or inner interface on a modeled Java class or interface, either add the inner class to the implementing Java code, or create a new Java class or interface as an internal node on an existing modeled class.
Inner Java classes and inner Java interfaces cannot have the same name as any containing Java class, Java interface or package or contain any static fields or static methods.
A variety of references (previously referred to as associations) can be created quickly between classes and interfaces on a diagram using the various reference icons on the Java Class component palette for the diagram. References created between modeled Java classes are represented as fields in the source code of the classes that implement the references. Compositional relationships are represented on the diagram as a solid line with an open arrowhead in the direction of the reference. Table 18-11 displays the references that can be modeled on a diagram.
Table 18-11 References Between Classes or Interfaces
| Reference | Description |
|---|---|
| Reference (Object) | A singular, direct reference from one class or interface to another. This is represented in the code of the reference's originating class as a field of type |
| Reference (Array) | A reference to an array of another class or interface. This is represented in the code as an array of type |
| Reference (Collection) | This is represented in the code as a Collection declaration, and adds an |
| Reference (List) | This is represented in the code as a List declaration, and adds an |
| Reference (Map) | This is represented in the code as a Map declaration, and adds an |
| Reference (Set) | This is represented in the code as a Set declaration, and adds an |
| Note: If you want to quickly change the properties of a reference on a diagram, double-click it to display the Code Editor and change the details of the reference. |
Labels are not displayed on references by default. To display the label for a reference, right-click the reference and choose Visual Properties, then select Show Label. The default label name is the field name that represents the reference. If you select this label name on the diagram and change it, an @label <label_name> Javadoc tag will be added before the field representing the reference in the code.
You can change the aggregation symbol used on a reference on a diagram by right-clicking the reference, choosing Reference Aggregation Type, then choosing None, Weak (which adds an @aggregation shared Javadoc tag to the code representing the reference), or Strong (which adds an @aggregation composite Javadoc tag to the code representing the reference). Aggregation symbols are for documentary purposes only.
Inheritance structures, which are represented in the Java source as extends statements, can be created on a diagram of Java classes using the Extends icon on the Java Class Component Palette for the diagram. Extends relationships are represented on the diagram as a solid line with an empty arrowhead pointing towards the extended class or interface.
Where an interface is implemented by a class, this can be created using the Implements icon on the Java Component Palette for the diagram. Creating an implements relationship adds implements statement to the source code for the implementing class. Implements relationships are represented on the diagram as a dashed line with an empty arrowhead pointing towards the implemented Java interface.
Extends relationships model inheritance between elements in a class model. Extends relationships can be created between Java classes and between Java interfaces, creating an extends statement in the class definition. Enums cannot extend other classes, or be extended by other classes.
| Note: As multiple class inheritance is not supported by Java, only one extends relationship can be modeled from a Java class on a diagram. Multiple extends relationships can be modeled from a Java interface. |
Implements relationships specify where a modeled Java class is used to implement a modeled Java interface. This is represented as an implements keyword in the source for the Java class. Implements relationships are represented on class diagrams as dashed lines with an empty arrowhead pointing towards the interface to be implemented. Enums cannot implement interfaces.
If the implemented interface is an extension (using an extends relationship) of other modeled interfaces, this is reflected in the Java source code for the interface.
A class that implements an interface can provide an implementation for some, or all, of the abstract methods of the interface. If an interface's methods are only partially implemented by a class, that class is then defined as abstract.
You can create members (fields and methods) of a Java class or interface on a diagram. The fields and methods are added to modeled Java classes and interfaces on a diagram by double-clicking the modeled Java class or interface then adding the field or method using the Java Source Editor.
When a field or method is displayed on a class on a diagram, it is prefixed with + (if declared as public), - (if declared as private) or # (if declared as protected). Static fields are underlined on the diagram.
A package is a general purpose mechanism for organizing elements into groups. It may contain many different types of elements including packages, files, classes and model elements (for example; classes, interfaces, entity objects). Packages may be nested within other packages.
A package owns the elements within it and provides the context and namespace for those elements. Elements owned by the same package must have unique names within the package. Each element is directly owned by a single package, but can be referenced (imported) from other packages; in other words, referred to by other elements in other packages.
If a package is renamed on a diagram, or moved to another package, the contents of the moved or renamed package will be refactored automatically to reflect this package change.
Package names must be unique within a namespace, even if the names have different capitalization.
Java packages can be either created on a diagram, or dragged onto a diagram from the navigator. To open a diagram for a Java package, right-click the package on the diagram and choose Drill Down.
Java classes and interfaces related to those currently displayed on the diagram can be brought onto the diagram. This includes classes or interfaces that are extended, implemented, or referenced by the selected class or interface.
| Note: Where classes are added to a diagram from the project's source path, and are not already part of the project, those classes are automatically added to the current project. |
To display related classes on a diagram, use one of the two following ways:
Relationships between Java classes or interfaces can be visualized on a diagram using references. You can hide a reference on a diagram.
To hide a reference between Java classes:
To display a hidden reference between Java classes:
attribute Javadoc tag from above the member representing the reference. The hidden reference will be displayed on the diagram.
| Note: Hiding a reference between Java classes on a diagram adds a comment to the Java source for the class, so if this class is also on any other diagrams, that reference will also be hidden on those diagrams. |
The definitions of the classes on a diagram, their members, inheritance, and composition relationships are all derived directly from the Java source code for those classes. These are all created as Java code, as well as being displayed on the diagram. If you change, add to, or delete from, the source code of any class displayed on the diagram, those changes will be reflected on those classes and interfaces on the diagram. Conversely, any changes to the modeled classes are also made to the underlying source code. Some information relating to composition relationships, or references, captured on a Java class diagram is stored as Javadoc tags in the source code.
A Java class diagram can contain shapes from other diagram types (Oracle ADF Business Components, UML elements, Enterprise JavaBeans, and database objects). A form of UML notation is used to display the classes on your diagram. Modeled UML classes can be transformed to modeled Java classes. Likewise, modeled Java classes can be transformed to modeled UML classes. You can annotate a diagram of Java classes using notes, dependency relationships and URL links.
Java classes, interfaces, and enums can be visually created on a Java class diagram, together with their members, inheritance and composition relationships.
You can create UML classes, UML use cases, offline database objects, business components, Enterprise JavaBeans, and web services on a Java class diagram.
Java classes on a diagram must have valid Java class names and must be unique within the class's package. If you define a modeled Java class as abstract you should create a concrete Java class with a generalization to the abstract Java class. The names of modeled abstract Java classes are displayed in italics.
To create a diagram of Java classes:
Also, Java classes and interfaces available to the current project can be dragged from the navigator and dropped on the diagram to either modify the code for those classes, or to visualize the structure of existing code.
| Tip: You can also annotate your diagram by creating and attaching notes to diagram elements, and adding URL links to other locations such as files or web locations. |
JUnit is an open source regression testing framework for Java. Use JUnit to write and run tests that verify Java code. For detailed information about JUnit, visit the JUnit website, http://www.junit.org/
Use JUnit wizards in JDeveloper to create test fixtures, cases, and suites. In addition to wizards for creating test components for generic projects, specialized wizards for business components projects are provided.
JUnit is an optional feature that can be installed and integrated with JDeveloper.
After you install JUnit as an extension, additional online documentation is installed. These help topics appear under Help Table of Contents under the folder Creating a JUnit Test for a Java Project.
JUnit is an optional feature that is not distributed with JDeveloper. You must download and install it if you wish to use it.
| Note: JUnit is provided under an IBM public license agreement. You must accept to the license agreement before downloading JUnit. |
To install JUnit in JDeveloper:
A JUnit test application consists of the following components:
A test fixture is a set of objects, having known values, that provide data for the test cases. Any class can serve as a test fixture, but JDeveloper provides wizards to help you create custom test fixture classes and various specialized test fixture classes.
To create a JUnit custom test fixture class:
The class created by the wizard will be opened for editing.
A test fixture is a set of objects, having known values, that provide data for the test cases. A JDBC test fixture provides code that establishes a database connection for the test cases to use.
To create a JUnit JDBC test fixture class:
The class that was created will be opened for editing.
setUp() method add code that initializes test fixture objects, and to the tearDown() method add code that releases any resources they acquire. A test case class has one or more methods that perform tests by calling JUnit assertions. Example 18-6 shows a typical test case in JUnit 3.x. It passes test fixture data to the method being tested, and then compare the result with a known value to confirm that it is what is expected.
Example 18-6 JUnit 3.x Test Case
Example 18-7 JUnit 4 Test Case
In the test case shown in Example 18-7, countChars() is being tested, and the result of the test is checked by assertEquals(), which is one of a variety of assertion methods defined in the JUnit Assert class. The state of the test fixture, fixture1, is established in the setUp() method, which will have been called before the test case is called, as shown in Example 18-8.
Example 18-8 setUp() method
To create a JUnit test case class:
A test suite is a class that invokes test cases.
The JUnit Test Suite wizard has options to insert a main() method and a call to a TestRunner class. Within JDeveloper, this will open the JUnit TestRunner log window to display the test results. Edit the method if you wish to use a different test runner.
In the JUnit 3.x test suite shown in Example 18-9, the suite() method creates a TestSuite instance and adds the test cases to it. Edit this method if you wish to add or remove test cases.
Example 18-9 JUnit 3.x Test Suite
In the JUnit 4 test suite shown in Example 18-10, the test case classes are written with @Suite and @RunWith annotations.
Example 18-10 JUnit 4 Test Suite
To create a JUnit test suite class:
You can add a unit test for a method to an existing JUnit test case class.
To add a test to a JUnit test case class:
You update a test suite with all test cases in a project.
To update a test suite:
This chapter describes how to use the tools and features provided by JDeveloper to run and debug Java programs. For information about writing and compiling a Java program, see Chapter 18, "Programming in Java."
This chapter includes the following sections:
JDeveloper offers several techniques to monitor and control the way Java programs run. When running Java programs, JDeveloper keeps track of processes that are run and debugged, or profiled. In addition, JDeveloper offers both local and remote debugging of Java, JSP, and servlet source files.
The Run Manager keeps track of processes that are run, debugged, or profiled. When two or more such processes are active at the same time, the Run Manager window is automatically displayed. When a process has completed, it is automatically removed from the Run Manager.
To open the Run Manager:
To terminate a process with the Run Manager:
To view the Run Log:
Settings that control the way programs are run - such as the target, launch options, and the behavior of the debugger, logger, and profiler - are collected in run configurations.
A project may have several run configurations, each set up for a specific facet of the project or phase of the development process. A run configuration can be bound to the project and be available to all who work on the project, or it can be custom configuration, for your use only.
A default run configuration is created for each new project. You can modify run configurations, and you can create a new configuration by copying an existing one.
To select a run configuration:
To modify a run configuration:
The Edit Run Configuration dialog is opened.
For help while using the dialog pages, press F1.
To create a run configuration:
The Create Run Configuration dialog is opened.
JDeveloper lets you run applets in the AppletViewer or in the Integrated WebLogic Server instance. The AppletViewer provides a test bed to run your applet without launching the web browser. When you want to run your applet in a browser, you can run in the Integrated WebLogic Server instance.
After creating your applet and ensuring that the classpath is set up properly in the HTML file, you can run it by executing the Run command in one of the following ways:
<APPLET> tag. An applet runs in an HTML page, from which it obtains its display size and other parameters. To run an applet in JDeveloper, you need to provide an HTML file containing the appropriate <APPLET> tag.
Parameter names are case-sensitive, although parameter tags are not:
You can also pass parameters to the applet by including a <PARAM> tag between the <APPLET> and </APPLET> tags:
Example 19-1 shows an HTML fragment that is used to pass parameters.
Example 19-1 HTML Fragment That is Used to Pass Parameters
After building your project or file, you can run it.
To run a project or file:
The main method of your Java application is started.
The following conditions must exist to run a project from the operating system command line:
To launch an application:
Enter the following:
To launch the executable JAR file from the command line:
Enter the following:
where <application> is your JAR file name.
You may need to change the Java Virtual Machine (VM) for which you are developing because of operating system considerations. For example, for client-side applications, you would use the HotSpot Client VM, whereas for executing long-running server applications, you would use the Server VM.
To change the Java Virtual Machine:
This opens the Edit Run Configuration dialog.
The selected JVM is used when running and debugging the project.
When you run a Java program from the command line, you must provide the Java Virtual Machine (JVM) with a list of the paths to the class files and libraries that comprise your application. The form of the classpath changes depending on the method you use to run the Java program.
Your Java classes can be stored in Java Archive (*.jar) files, or as separate class (*.class) files in their package directory. There are differences in the ways Java handles JAR files and package directories.
CLASSPATH, you use the fully qualified path to the JAR file. When you refer to package directories in your CLASSPATH, you use the path to the parent directory of the package. CLASSPATH statement. When you refer to more than one CLASSPATH in the same statement, each CLASSPATH is separated with a semicolon(;). Once you have defined the classpath, you pass the value to the JVM in different ways, depending on how you run your Java program.
CLASSPATH environment variable to run a standalone application using java.exe. CLASSPATH environment variable to.use the -classpath option of java.exe. CLASSPATH in the <APPLET> tag of an.html file to run an applet in an Internet browser. You have the option of using either the -classpath option when calling an SDK tool (the preferred method) or by setting the CLASSPATH environment variable.
The java.exe is included as part of the Java2 Standard Edition (J2SE). It is intended to be used as a development tool, and is not licensed for distribution with your Java programs. It is used to test your Java applications from the command prompt.
In order to run a Java application from the command prompt, the system environment variable CLASSPATH must be defined to include all of the classes necessary to run your program. This includes any library classes provided with JDeveloper that your program uses.
JDeveloper ships hundreds of library classes to help you generate your Java programs. The classes come from J2SE, third-party developers, and Oracle Corporation. Each of the libraries is kept separate for easy upgrade. As a result, many archive files may need to be included in your classpath to ensure that any program you create in JDeveloper can be run from the command prompt.
Oracle recommends that you list only the paths to each of the libraries that your project uses. If you list paths that your project does not use, your program will still run, but for performance reasons, you will want to eliminate any unnecessary libraries.
The command to set the CLASSPATH variable takes this format:
| Note: Never use quotation marks in the classpath even when there is a space character in one of the paths. |
If you have used the default directory for your output path, you can test your Java application using java.exe by appending the following directory to your classpath:
Having set this variable, you can use java.exe to run your application from the output directory mywork.
If you have deployed your Java program to any other directory, you need to add the path to the parent directory of the application package.
The CLASSPATH variable is a long string that can be difficult to type accurately. To save time and reduce errors, you can set the CLASSPATH as a system environment variable.
The Java Runtime Engine (java.exe) doesn't use the CLASSPATH environment variable. The CLASSPATH must be included as a parameter to the java.exe command. The format for the command is:
Where classpath is the complete CLASSPATH to your Java program and the dependency classes it uses. The quotation marks are optional if there are no spaces in any of the CLASSPATH directory names.
When running applets, the browser uses a CLASSPATH you supply in the ARCHIVE and CODEBASE parameters to the <APPLET> tag in the host *.html file.
The CODEBASE parameter sets the root directory where the Internet browser will look for your class files. If the classes are stored in the same directory as the HTML page calling the applet, you can omit the CODEBASE parameter entirely. Otherwise, use either an absolute or relative path from the HTML file to the location of the CODEBASE directory. Use forward slashes (/), not backslashes(\) to indicate directories.
The ARCHIVE parameter lists the locations and names of the JAR files that contain your program and its supporting library files, similar to the CLASSPATH used with applications. There are three important differences:
CODEBASE, use forward slashes (/), not backslashes(\), to indicate directories. ARCHIVE parameter can only be located in subdirectories of the CODEBASE directory. This means that if you attempt to set the location of an archive file using a parent directory (../) you will receive a security violation error. Debugging is the process of locating and fixing errors in your programs. The JDeveloper integrated debugger enables you to debug Java applications, applets, servlets, JavaServer Pages (JSPs), and Enterprise JavaBeans (EJBs). You can debug a single or several objects on the same or different machine as JDeveloper supports distributed debugging.
The Debugger provides you with a number of features to investigate your code, and identify and fix problem areas. Two types of debugging are available to analyze your code - local and remote.
A local debugging session is started by setting breakpoints in source files, and then starting the debugger. When debugging an application such as a servlet in JDeveloper, you have complete control over the execution flow and can view and modify values of variables. You can also investigate application performance by monitoring class instance counts and memory usage. JDeveloper will follow calls from your application into other source files, or generate stub classes for source files that are not available.
Remote debugging requires two JDeveloper processes: a debugger and a debuggee which may reside on a different platform. Once the debuggee process is launched and the debugger process is attached to it, remote debugging is similar to local debugging.
JDeveloper provides a number of special-purpose debugging windows that enable you to efficiently identify the problematic areas in your code:
You can open the debugger windows by choosing View > Debugger.
Table 19-1 contains the various JDeveloper debugger and runner icons. These icons are available from areas in the JDeveloper user interface, including the Debugger window and the Log window.
Table 19-1 Debugger and runner icons
| Icon | Name | Description |
|---|---|---|
![]() | Array | Represents an array class in any JDeveloper data-related window. |
|
| Add Breakpoint | Represents the Breakpoint toolbar button used to create a breakpoint. |
|
| Breakpoints menu | Represents the View > Debugger > Breakpoints menu option or the tab icon for the Breakpoints window. |
|
| Class | Represents the View > Debugger > Classes menu option, the tab icon for the Classes window and a class in the Classes window (grayed if the class has tracing disabled). |
|
| Class Without Line Number Tables | Appears in the Classes window. Represents a class which does not have line number tables (obfuscated class) |
|
| Current Execution Point | Represents the current execution point shown in the source editor margin which you can display by choosing the Run > Show Execution Point menu option. |
|
| Current Thread | Represents the current thread in the Threads window. |
|
| Data | Represents the View > Debugger > Data menu option; the View > Debugger > Smart Data menu option; and the tab icon for the Data window and Smart Data window. |
|
| Debug (Shift + F9) | Represents the Run > Debug <project_name> menu option; the debug toolbar button, a debugging process contained in the processes folder in the Run Manager Navigator, a log page for a debugging process, the debug layout, and the Remote Debugging and Profiling Project Wizard |
|
| Debug Listener Node | Represents a debug listener node in the Run > Manager navigator. |
|
| Debug with Diagram | Represents the Run > Debug with Diagram <project_name> menu option. Lets you create a UML sequence diagram while debugging. |
|
| Disabled Breakpoint | Represents a disabled breakpoint in the source editor margin and a disabled breakpoint in the Breakpoints window. The icon also represents the Breakpoint toolbar button to disable a breakpoint |
|
| Delete Breakpoint | Represents the Breakpoint toolbar button to remove a breakpoint. |
|
| Edit Breakpoint | Represents the Breakpoint Toolbar button, which you can use to edit the selected breakpoint |
|
| Garbage Collection | Represents the Run > Garbage Collection menu option and the Garbage Collection toolbar button which you can click |
|
| Interface | Represents an interface in the Classes window |
|
| Heap | Represents the View > Debugger > Heap menu option and the tab icon for the Heap window |
|
| Heap Folder | Represents a folder in the Heap window. |
|
| Method | Represents a method in the Stack window |
|
| Monitors | Represents the View > Debugger > Monitors menu option and the tab icon for the Monitors window. |
|
| Object | Represents an object in any JDeveloper data-related window |
|
| Package | Represents a package in the Classes window (grayed if the package has tracing disabled) |
|
| Pause | Represents the Run > Pause menu option and the Pause toolbar button which you can click. |
|
| Primitive | Represents a primitive item in any JDeveloper data-related window. |
|
| Resume | Represents the Run > Resume menu option and the Resume toolbar button which you can click. |
|
| Run | Represents a running process in the Run Manager navigator, in a log page for a running process, and in the toolbar to run the selected node. |
|
| Run to Cursor (F4) | Represents the Run > Run to Cursor menu option. Lets you run to a specified location and execute the code until it reaches that location |
|
| Stack | Represents the View > Debugger > Stack menu option and the tab icon for the Stack window. |
|
| Stack Folder | Represents the static folder in the Data window |
|
| Step to End of Method | Represents the Run > Step to End of Method menu option and the Step to End of Method toolbar button which you can click. |
|
| Step Into (F7) | Represents the Run > Step Into menu option and the Step Into toolbar button which you can click. |
|
| Step Out | Represents the Run > Step > Out menu option and the Step Out toolbar button which you can click. |
|
| Step Over | Represents the Run > Step Over menu option and the Step Over toolbar button which you can click. |
|
| Terminate | Represents the Terminate toolbar button which you can click to stop debugging your application. |
|
| Thread | Represents the View > Debugger > Thread menu option and the tab icon for the Thread window. |
|
| Threads | Represents the View > Debugger > Threads menu option and the tab icon for the Threads window. |
|
| Thread Group | Represents a thread group in the Threads window. |
|
| Unverified Breakpoint | Represents an unverified breakpoint in the source editor margin, and an unverified breakpoint in the Breakpoints window |
Your code must be compiled with debugging information before you can make use of some of the debugger features such as viewing arguments and local variables in the Data window.
To set breakpoints and step through your code:
The unverified breakpoints icon appears in the left margin.
The class runs and stops at the first breakpoint.
To edit and recompile:
JDeveloper allows you to debug with breakpoints using the ADF Declarative Debugger. If an error cannot be easily identified, you can use the ADF Declarative Debugger in JDeveloper to set breakpoints. When a breakpoint is reached, the execution of the application is paused and you can examine the data that the Oracle ADF binding container has to work with, and compare it to what you expect the data to be. Depending on the types of breakpoints, you may be able to use the step functions to move from one breakpoint to another.
JDeveloper provides three windows for debugging ADF components:
You can control what type of information is displayed in each of the debugger windows. To see what options are available in each window such as which columns to display, right-click in a window and choose Preferences from the context menu. Or, you can choose Tools > Preferences from the main menu and expand the Debugger node to display a preferences page for each debugger window. You can also save the debug information as text or HTML output file. For more information. see Section 19.6.7, "How to Export Debug Information to a File."
To use the JDeveloper debugger to control the execution of a program:
A breakpoint is a trigger in a program that, when reached, pauses program execution. This allows you to examine the values of some or all of the program variables. When your program execution encounters a breakpoint, the program pauses, and the debugger displays the line containing the breakpoint in the source editor.
If the execution point is located on a call to a method, the Step Into command steps into that method and places the execution point on the method's first statement.
If you issue the Step Over command when the execution point is located on a method call, the debugger runs that method without stopping, instead of stepping into it. Program statements are executed one at a time.
This allows you to go to a particular location in the program without having to single step or set a breakpoint.
You can pause your program when the program is running in the debugger. You can then use the debugger to examine the state of your program with respect to this program location. When you have finished examining that part of the program, you can then continue running the program.
When finished, you can modify program values as a way to test hypothetical bug fixes during a program run. If you find that a modification fixes a program error, exit the debugging session, fix your program code, and recompile the program to make the fix permanent.
JDeveloper allows you to control how your program is debugged, including enabling and disabling packages and classes and configuring remote debugging options.
To configure debugger and remote debugger options in JDeveloper:
By setting up the debugger start option, you are specifying how you would like the debugger to behave when you start a new debugging session. Specifically, decide if you want the debugger to execute until a breakpoint is reached, or if you want the debugger to stop when it reaches your project's code (for example, at the beginning of your application's main method).
To set the debugger start options:
When you start debugging, the debugger will let the program you are debugging execute until a breakpoint is reached.
When you start debugging, the debugger will let the program you are debugging execute until a method in a tracing-enabled class is reached, but it will not stop in a class static initializer method.
When you start debugging, the debugger will let the program you are debugging execute until any method, including a class static initializer method, is reached.
You must build the project before debugging it.
To build a project and start the debugger:
If the project builds successfully, the debugger starts.
You can export debug information generated by the JDeveloper debugger to either a text or HTML output file from within any of the debugger windows.
To export debug information to file:
.html or .htm (case-insensitive). If the project builds successfully, the debugger starts.
When the debugger stops (for example, at a breakpoint after completing a step command, or when paused), the source file for the current class will open in the source editor and will be marked with the execution point, as shown in Figure 19-1.
If JDeveloper cannot locate the source file for the class while debugging, the Source Not Found dialog is displayed prompting you for the source file location.
You can use the source editor to debug in the following ways:
Figure 19-2 Breakpoint Icon

Using Context Menu Items
The debugger adds several menu items to the source editor's context menu including those shown in Table 19-2.
Table 19-2 Context Menu Items
| Item | Function |
|---|---|
| Run to Cursor | Lets you run to the current location of the cursor and execute the code until it reaches that location. |
| Watch (Ctrl+F5) | Lets you add an expression to the Watches Window. |
| Inspect | Lets you open up a floating Inspector window. |
| Step Into Method at Cursor | Executes Run to Cursor, and then steps into the method that the cursor is currently on. |
Using Tooltips
The debugger will show tool tips in the source editor if you hover the mouse over the name of a data item. By default, the tooltip will show the name, value, and type of the data item; providing an easy way to quickly inspect a data item without adding it in Data window or Watches window. If the data item is an array or object, you can inspect children of the selected item deep in the object hierarchy. The tooltip displays 20 children data items, use the navigation buttons to view remaining data items.
The columns which display in the tooltip depend on the column settings that were enabled in the Tools > Preferences – Debugger – Tooltip page.
If the project builds successfully, the debugger starts.
Java expressions are used in the Watches window, Inspector window, Breakpoint Conditions, and Breakpoint Log Expressions. The debugger accepts Java expressions in the forms shown in Table 19-3.
Table 19-3 Java Expressions Accepted by Debugger
| Java Expression | Form |
|---|---|
| Simple variable name |
|
| Field access |
|
| Method call |
|
| Array element |
|
| Array length |
|
| Comparison operation |
|
| Arithmetic operation |
|
| Logical operation |
|
| Instance of operator |
|
| Shift operator |
|
| Binary Operator |
|
| Question-colon operation |
|
| Static field name |
|
| Fully qualified class name | j |
If the project builds successfully, the debugger starts.
The JDeveloper debugger lets you control the execution of your program; you can control whether your program executes a single line of code, an entire method, or an entire program block. By manually controlling when the program should run and when it should pause, you can quickly move over the sections that you know work correctly and concentrate on the sections that are causing problems. For more information, see Section 19.6.5, "How to Set the Debugger Start Options."
The debugger lets you control the execution of your program in the following ways:
The Step Into and Step Over commands offer the simplest way of moving through your program code. While the two commands are very similar, they each offer a different way to control code execution.
The smallest increment by which you step through a program is a single line of code. Multiple program statements on one line of text are treated as a single line of code – you cannot individually debug multiple statements contained on a single line of text. The easiest approach is to put each statement on its own line. This also makes your code more readable and easier to maintain.
The Step Into command executes a single program statement at a time. If the execution point is located on a call to a method, the Step Into command steps into that method and places the execution point on the method's first statement.
If the execution point is located on the last statement of a method, choosing Step Into causes the debugger to return from the method, placing the execution point on the line of code that follows the call to the method you are returning from.
The term single stepping refers to using Step Into to run successively though the statements in your program code.
You can step into a method in any of the following ways:
Figure 19-3 Step Into Button

Unlike previous JDeveloper releases, you cannot start debugging by pressing the Step Into button. Step Into will only cause stepping on an already-started debugging process.
When you set the debugger to start by stepping into, the debugger will let the program you are debugging execute until a method in a tracing-enabled class is reached.
As you debug, you can step into some methods and step over others. If you are confident that a method is working properly, you can step over calls to that method, knowing that the method call will not cause an error. If you aren't sure that a method is well behaved, step into the method and check whether it is working properly.
The Step Over command, like Step Into, enables you to execute program statements one at a time. However, if you issue the Step Over command when the execution point is located on a method call, the debugger runs that method without stopping (instead of stepping into it), then positions the execution point on the statement that follows the method call.
If the execution point is located on the last statement of a method, choosing Step Over causes the debugger to return from the method, placing the execution point on the line of code that follows the call to the method you are returning from.
You can step into a method in any of the following ways:
Figure 19-4 Step Over Button

Unlike previous releases of JDeveloper, you cannot start debugging by pressing the Step Over button. Step Over will cause stepping only on an already-started debugging process.
When you set it to start by stepping over, the debugger will let the program you are debugging execute until a method in a tracing-enabled class is reached, but it will not stop in class static initializer method.
As you debug, you can step into some methods and step over others. If you are confident that a method is working properly, you can step over calls to that method, knowing that the method call will not cause an error. If you aren't sure that a method is well behaved, step into the method and check whether it is working properly.
Normally, you should set the tracing include and exclude lists in the project properties before you start debugging. However, if you need to change the tracing include and exclude lists, you can do so from the Classes window. Right-click in the Classes window and choose Tracing from the context menu. The Tracing dialog appears in which you can adjust the tracing include and exclude lists.
When you specify a package to be included or excluded from tracing, all descending classes within that package are included or excluded as well unless you've specified them individually.
To closely examine part of your program, you can enable tracing on only the files you want to step through in the debugger. For example, you usually don't want to step through classes that are in the J2SE library because you're not going to troubleshoot on them; you usually only want to trace into your own classes.
If you exclude a class or package, and you instruct the debugger to step into that class, the debugger runs straight through that code without pausing. The debugger pauses at the next line of code in a class which has not been excluded. The tracing include and exclude lists are used for all step commands including Step Into, Step Over, Step Out, and so on. Using these lists does not prevent you from setting a breakpoint in a class which has been excluded. If the debugger stops at such a breakpoint, the step commands will be disabled.
To enable tracing for a class, you can adjust the tracing include or exclude list by adding or removing a class or package:
Alternately, click Edit to open the Tracing Classes and Packages to Include/Exclude dialog, then click Add or Remove. If you click Add, the Class and Package Browser dialog appears. If you click Remove, the selected class or package is removed from the appropriate tracing List. Navigate to the class or package you want to add and click OK. The class or package is added to the appropriate tracing list.
By leaving the include lists blank, you are actually specifying that you would like to enable tracing in all packages except for those specifically listed in the exclude list. For example:
When you're debugging, the line of code that is the current execution point for the current thread is highlighted and the execution point icon appears in the left margin of the source editor.
The execution point marks the next line of source code to be executed by the debugger.
To find the current execution point:
The debugger displays the block of code containing the execution point in the source editor.
When stepping through your application code in the debugger, you may want to run to a particular location without having to single step or set a breakpoint.
To run to a specific program location:
Any of the following conditions may result:
You can pause your program when the program is running in the debugger. You can then use the debugger to examine the state of your program with respect to this program location. When you have finished examining that part of the program, you can then continue running the program.
When you are using the debugger, your program can be in one of two possible states: running, or paused by the debugger. When your program is waiting for user input, it is still considered to be running. When your program is in the running mode, Pause is available. When your program is paused by the debugger, the available debugger buttons include Resume, Step Over, and Step Into.
You can pause the debugger in the following ways:
Figure 19-5 Pause Icon

Your program may be paused at a location for which there is no source available. In this case, the Source Not Found dialog is displayed prompting you for the source file location or whether to generate stub files.
Also, your program may be paused at a location where tracing is disabled because the class is on the tracing exclude list. For example, your program may be paused in the java.lang.Object.wait method.
While the debugger is paused, you can force garbage collection to occur. The results of the garbage collection are immediately reflected in the Classes and the Heap window. This enables you to find memory leaks in your application.
To resume the debugger when it is paused, choose Run > Resume.
Sometimes while debugging, you will find it necessary to restart the program from the beginning. For example, you might need to restart the program if you step past the location of a bug.
To terminate the current debugging session:
Terminating a debugging session closes all debugger windows. However, this action does not delete any breakpoints or watches that you have set, which makes it easy to restart a debugging session.
The Debugger log displays information about the debugging process. You can view the Debugger log at any time while the debuggee process is still active.
To view the Debugger log while the process is still active, use one of the two following ways:
JDeveloper allows you to control how your Applet program is debugged.
To debug an applet:
<APPLET> tag. The applet starts. The debugger will stop at breakpoints you have set in your applet source code.
JDeveloper allows you to control how your Javascript program is debugged, including configuring your browser for remote debugging.
To configure Javascript debugger options in JDeveloper:
Choose FireFox/Mozilla and you'll get more options to control your Javascript debugging. If JDeveloper is not already configured for Firefox as your debugging browser, follow these steps:
firefox.exe) in Browser Command Line, or click Browse and select the executable file. To debug a Javascript program:
The program starts in Firefox browser and, in JDeveloper, the debugger stops at the first breakpoint you have set in the source code.
JDeveloper provides a number of special-purpose debugging windows to help you analyze your code.
Information about set breakpoints can be viewed in the Breakpoints window. For more information about this window including its context menu options, press F1 in the Breakpoints window.
To open the Breakpoints window to displays a list of set breakpoints:
To change which columns are displayed in the Breakpoints window:
Unlike the Data window which displays all arguments, local variables, and static fields for the current method, the Smart Data window displays only the data that appears to be relevant to the source code that you are stepping through. Specifically, the debugger analyzes the source code near the execution point and finds the variables, fields, and expressions, that are used in the lines of code that you are stepping through.
For more information, see Section 19.6.15, "How to Locate the Execution Point for a Thread."
The Smart Data window also displays the current return value of a non-void method when you set a breakpoint in the method and issue a Step to End of Method command or Step Out command. The return value is not displayed for Step Over or Step Into commands.
By default, the debugger analyzes only one line of code for each location and analyzes up to two locations. You can adjust these settings in the Tools > Preferences - Debugger - Smart Data page which you can also access by right-clicking in the Smart Data window and choosing Preferences from the context menu.
To open the Smart Data window:
To change which columns are displayed in the Smart Data window:
If the project builds successfully, the debugger starts.
You use the Data window to display information about variables in your program. The Data window displays the arguments, local variables, and static fields for the current context, which is controlled by the selection in the Stack window. If you move to a new context, the Data window is updated to show the data for the new context. If the current class was compiled without debug information, you will not be able to see the local variables. The debugger analyzes the local variable memory locations in the stack frame to show you as much information as possible.
| Note: By default, the Data window displays local variable information while debugging a program. To disable local variable information in Data window, clear the Full Debug Info checkbox in the Compiler page of the Project Properties dialog. The Full Debug Info checkbox is selected by default. |
The Data window also displays the current return value of a non-void method when you set a breakpoint in the method and issue a Step to End of Method command or Step Out command. The return value is not displayed for Step Over or Step Into commands.
To open the Data window:
To view array elements in Data window:
To change which columns are displayed in the Data window:
If the project builds successfully, the debugger starts.
A watch enables you to monitor the changing values of variables or expressions as your program runs. After you enter a watch expression, the Watches window displays the current value of the expression. As your program runs, the value of the watch changes as your program updates the values of the variables in the watch expression.
A watch evaluates an expression according to the current context which is controlled by the selection in the Stack window. If you move to a new context, the expression is re-evaluated for the new context. If the execution point moves to a location where any of the variables in the watch expression are undefined, the entire watch expression becomes undefined. If the execution point returns to a location where the watch expression can be evaluated, the Watches window again displays the value of the watch expression.
To open the Watches window:
To change which columns are displayed in the Watches window:
To add a watch:
To watch a static field:
Enter the full name of the class followed by a period (.) and the name of the field. For example:
To watch the current exception while stopped at an exception breakpoint, enter:
The Inspector window allows you to single out a selected variable, field or object, and display the same information that is available in the Watch or Data windows. For more information about this window, including its context menu options, press F1 in the Inspector window.
The Inspector window is slightly different from the other windows in that it floats by default, and you can have multiple instances of Inspector windows. Each Inspector window contains one data item. You can drag one Inspector window into another and dock them together.
To open the Inspector Window:
The floating Inspect window appears and contains the variable you selected. If you want to inspect something else, enter a new expression or variable in the text field, or select a previous one from the dropdown list.
If no variable or expression is selected, the Inspect dialog appears pre-populated with the text under the cursor in the editor as the expression to inspect. Click OK to open the Inspector window.
The Inspector window will appear floating in the center of your screen, but you can dock the Inspector window with other windows. To prevent docking, press the Ctrl key while moving the window. An inspector evaluates an expression according to the current context of the Stack window. For more information, see Section 19.7.7, "How to Use the Stack Window."
If you move to a new context, the expression is reevaluated for the new context. If the execution point moves to a new location where any of the variables in the expression are undefined, the entire expression becomes undefined. If the execution point returns to a location where the expression can be evaluated, the inspector again displays the value of that expression.
To change which columns are displayed in the Inspector window:
The Heap window displays information about the heap in the program you are debugging and helps you to detect memory leaks in your program. You can view all instances of a class as well as why an object has not been garbage collected.
Two types of folders display in the Heap window:
Displays the name of the class and how many instances of the class exist in memory, and when expanded lists the specific instances and their addresses in the heap.
Contains all the "root" references which point, either directly or indirectly, to a specific object. Root references are static fields, stack variables, pinned objects. The garbage collector will not discard an object if there are any root references. Expanding a root reference will show you the reference path from the root reference to the specified object.
To open and use the Heap window:
To change which columns are displayed in the Heap window:
The Stack window displays the call stack for the current thread. When you highlight a line in the Stack window, the Data window, Watches window, and all Inspector windows are updated to show data for the highlighted method.
To open the Stack window:
To view the stack of a thread:
To change which columns are displayed in the Stack window:
The Classes window displays which classes have been loaded and may also include useful information, such as the number of instances of a class. In conjunction with the Classes window, the debugger also includes a garbage collection tool when you want to force a run of the Java garbage collector. When you run the garbage collector, the impact is shown immediately in the Classes window. You can only force a run of the garbage collector when you are using a virtual machine that allows the debugger to do so.
To open the Classes window:
The Classes window displays all the classes that are currently loaded, how many instances of that class are being used, and how much memory that number of instances requires.
To choose information that is displayed in the Classes window:
To change the ascending or descending view order:
If the Show Packages check box is selected, by default the classes are displayed in a tree structure, where each branch represents a package. Also, the icon and entry next to each class or package indicates whether the class is included or excluded from tracing. The special icon shown in Figure 19-6 for a class without line number tables is used for classes to indicate that tracing is not possible because the class has been stripped or obfuscated.
In the Classes window, choose Preferences from the context menu to select which columns to view from the following available options:
Java supports multithreading at the language level through the use of synchronization. Synchronization is the coordinating of activities and data access among multiple threads. The mechanism that Java uses to support synchronization is the monitor. The Monitors window displays status and control information for active monitors.
To open the Monitors window:
To choose information that is displayed in the Monitors window:
The Threads window displays the names and status of all the threads and thread groups in your program.
To open the Threads window:
The step commands including Step Over, Step Into, and Set Next Statement apply to the current thread. To select a different thread, right-click a thread and choose Select Thread from the context menu.
When you highlight a thread in the Threads window, the Stack window is automatically updated to show the stack for the highlighted thread.
To change which columns are displayed in the Threads window:
You can choose to customize various debugger window settings including the column resize mode and other options you want to display.
| Tip: If the debugger has trouble connecting to the debuggee (the program you are debugging), try increasing the connection retry setting. |
To set any of the Debugger window preferences:
The debugging panel appears with customizable fields.
A breakpoint is a trigger in a program that, when reached, pauses program execution allowing you to examine the values of some or all of the program variables. By setting breakpoints in potential problem areas of your source code, you can run your program until its execution reaches a location you want to debug. When your program execution encounters a breakpoint, the program pauses, and the debugger displays the line containing the breakpoint in the source editor. You can then use the debugger to view the state of your program. Breakpoints are flexible in that they can be set before you begin a program run or at any time while you are debugging. Figure 19-7 displays an example breakpoint in a Java Application source file.
Breakpoints set on comment lines, blank lines, declarations, and other non-executable lines of code are invalid and will not be verified by the debugger.
The JDeveloper debugger supports a number of different types of breakpoints:
Deadlock breakpoints are useful in situations when you find it difficult to locate the source of the deadlock. When a deadlock breakpoint is encountered, the debugger halts. The deadlock breakpoint is automatically enabled when you start debugging.
Information about set breakpoints can be viewed in the Breakpoints window.
While debugging, you can place a breakpoint to the left of any line of code in the source editor. However, for a breakpoint to be valid, it must be set on an executable line of code. Before a method is first executed, the debugger verifies all valid breakpoints in the method. Breakpoints set on comment lines, blank lines, declarations, and other non-executable lines of code are invalid and will not be verified by the debugger.
When a breakpoint has been verified as valid, the icon displayed in the source editor margin and in the Breakpoints window changes to the icon shown in Figure 19-8.
A deadlock occurs when one or more threads in your program are blocked from gaining access to a resource or waiting on a condition that cannot be satisfied. A common deadlock in Java is a monitor block cycle deadlock.
A monitor block cycle deadlock occurs when two or more threads are unable to proceed because each is waiting to enter synchronized code that one of the others has already entered.
Example 19-2 shows a typical Java synchronization deadlock.
At the same time, thread 2 is executing the following code:
A deadlock will occur if thread 1 enters the synchronized (a) as thread 2 enters the synchronized (b). Thread 1 will be blocked from entering synchronized (b) until thread 2 finishes the synchronized (b) and thread 2 will be blocked from entering synchronized (a) until thread 1 finishes the synchronized (a). A deadlock is also called a "deadly embrace." This example is for two threads but the same situation could occur for 3, 4, 5, and so on threads. The deadlock breakpoint can detect this type of deadlock.
Another kind of deadlock is where one thread calls the wait method on a particular object and no other threads call the notify method on that object. The most common cause of this kind of deadlock is timing. The notifying thread may have called notify before the waiting thread called wait. The important thing to know about calling wait is that even if notify was already called many times before, the wait method waits until notify is called again. Also, notify doesn't return any kind of error if there was no thread waiting. The deadlock breakpoint cannot detect this type of deadlock.
If you think your program is hanging, click Pause to pause your program in the debugger, and open the Monitors window. Perhaps you can see that one thread is waiting, investigate the code. If you can see that another thread probably called notify before the first thread called wait, there is a deadlock. This kind of deadlock is very hard to detect. You must know your code well in order to figure out which other thread should have called notify.
The JDeveloper debugger sets a persistent deadlock breakpoint when it starts running. A deadlock breakpoint is useful in situations when you find it difficult to locate the source of the deadlock. When the debugger encounters a deadlock breakpoint, the debugger halts. It can detect a monitor block cycle deadlock as described above. The Monitors window can be useful when working with deadlocks.
The deadlock breakpoint has the following characteristics:
The JDeveloper debugger automatically creates a persistent deadlock breakpoint; this breakpoint will occur whenever a monitor block cycle is detected. You cannot delete a persistent breakpoint. You cannot create a new deadlock breakpoint, but you can edit the existing persistent deadlock breakpoint.
Not all Java Virtual Machines support deadlock detection; for example, the HotSpot VM does not support deadlock detection.
Grouped breakpoints let you enable a set of breakpoints. When the debugger reaches a certain point in your code, you can instruct the debugger to enable a breakpoint or a group of breakpoints that was previously disabled.
For example, even though your code might be catching a NullPointerException, it may not be behaving correctly. In some cases, NullPointerExceptions occur more frequently than expected which causes the debugger to stop repeatedly for NullPointerExceptions, including those that are of no consequence to your code. This situation can be resolved by creating a breakpoint group, adding this breakpoint to the group, and disabling the breakpoint group so that the debugger does not stop at this breakpoint when debugging.
Next, you can create a source breakpoint in some code that you know is executed just before the problematic NullPointerException is thrown. You can set the actions for this source breakpoint so that when the source breakpoint occurs, it will automatically enable the breakpoint group which contains the exception breakpoint.
JDeveloper allows you to edit the options of a breakpoint after you have added it in the source code.
To view and modify the options of a breakpoint:
The Edit Breakpoint dialog appears with a Definition tab, a Conditions tab, and an Actions tab.
From the Edit Breakpoint dialog, you can:
You can right-click to edit a breakpoint located in the source editor:
The Edit Breakpoint dialog displays, where you can specify the definition of the breakpoint.
You can also hover over a breakpoint in the source editor:
The popup dialog shown in Figure 19-9 displays.
In the dialog, you can edit some of the most important breakpoint attributes, such as enabled/disabled, condition and more.
A source breakpoint is a breakpoint set in the source code and is the default type of breakpoint.
You can set a source breakpoint in any of the following ways:
You'll probably want to set a least one breakpoint before you start debugging, but it is not necessary. While your program is running in the debugger, you can set a breakpoint. The program pauses when it reaches the breakpoint.
You can control how the debugger behaves when a breakpoint occurs.
To control how the debugger behaves when a breakpoint occurs:
When you disable a breakpoint, all the breakpoint settings remain defined, but the breakpoint is not triggered when your program is run; your program will not stop on a disabled breakpoint. Disabling a breakpoint is useful if you have defined a breakpoint that you don't need to use now, but might need to use at a later time.
To disable breakpoints:
You can also disable breakpoints from the Breakpoint toolbar. Select the breakpoint or breakpoint group, and click Disable on the toolbar.
To reenable disabled breakpoints:
You can also enable breakpoints from the Breakpoint toolbar. Select the breakpoint or breakpoint group, and click Enable on the toolbar.
To delete breakpoints:
When you no longer need to examine the code at a breakpoint location, you can delete the breakpoint. You can delete breakpoints either using the source editor or in the Breakpoints window.
| Caution: You cannot undelete a breakpoint. |
Breakpoints typically have effect whenever they are reached. An instance breakpoint is associated with a specific instance of the class that defines the method where the breakpoint appears.
An instance breakpoint is a source breakpoint that has been associated with an instance filter that identifies the selected instances. Instance breakpoints do not persist between runs of the debugger. Instance filters are shown in the Instance Filters column of the Breakpoints window.
To set an instance breakpoint:
Repeat for other instances you wish to track.
The debugger will stop at the instance breakpoint only for the selected instances.
Breakpoints are typically attached to a particular line of code; they pause the debugger when a particular line of code is about to be executed. In addition, you can set a breakpoint to be activated when a certain type of exception is thrown. Exception breakpoints are not associated with a particular line of code.
To set an exception breakpoint:
The Create Exception Breakpoint dialog appears.
The debugger will now pause if an exception of the specified type is thrown.
By default, the debugger automatically creates a persistent exception breakpoint for uncaught throws for java.lang.Throwable. This breakpoint will occur whenever an uncaught exception is thrown. You cannot delete a persistent breakpoint, although you can disable it.
When you make a breakpoint conditional, the debugger pauses when a certain condition is met. When a breakpoint is first set, the debugger pauses the program execution each time the breakpoint is encountered. However, using the Edit Breakpoints dialog, you can customize breakpoints so that they are activated only in certain conditions.
The Conditions tab in the Edit Breakpoint dialog is where you enter an expression that is evaluated each time the debugger encounters the breakpoint while executing the program. If the expression evaluates to true, then the breakpoint pauses the program. If the condition evaluates to false, then the debugger does not stop at that breakpoint location.
For example, suppose you want a breakpoint to pause on a line of code only when the variable mediumCount is greater than 10.
To set a breakpoint condition:
mediumCount > 1 You can enter any valid Java language expression in the Edit Breakpoint dialog, but all symbols in the expression must be accessible from the breakpoint's location, and the expression cannot contain any method calls. For an exception breakpoint, you may want to use the exception object in your condition by using _throw.
You can also right-click a breakpoint located in the source editor to set conditions:
The Edit Breakpoint dialog displays, where you can specify conditions.
You can also hover over a breakpoint in the source editor to set conditions:
The Edit Breakpoints popup dialog shown in Figure 19-9 displays. You can set conditions in the dialog.
The Pass Count field specifies the number of times that a breakpoint must be passed for the breakpoint to be activated. Pass counts are useful when you think that a loop is failing on the nth iteration. The debugger pauses the program the nth time that the breakpoint is encountered during the program run. The default value is 1.
If the Pass Count column is shown in the Breakpoints window, you can see the pass count value decrement each time the breakpoint line of code is encountered during the program execution. If the pass count equals 1 when the breakpoint line is encountered, the breakpoint is activated, and the program pauses at that line.
When pass counts are used together with breakpoint conditions, the breakpoint pauses the program execution the nth time that the condition is true; the condition must be true for the pass count to be decremented.
To see the list of breakpoints, choose View > Debugger > Breakpoints from the main menu. Breakpoints that have been verified as valid by the debugger are indicated by the icon shown in Figure 19-8. You can use the Breakpoints window to quickly find the breakpoint location in your source code.
To use the Breakpoints window to locate a breakpoint in the source editor:
You can enable or disable several breakpoints with a single action, by creating a breakpoint group and putting breakpoints into it. Once you've created a breakpoint group, you can enable, disable, or remove it like a single breakpoint.
You can also drag and drop a breakpoint into or out of a group in the Breakpoints window.
To create a breakpoint group:
The Edit Breakpoint dialog appears.
A new group is created in the Breakpoints window, and is indicated by a folder icon. The breakpoint you just edited is automatically put in the new group.
To move a breakpoint into a breakpoint group:
Either drag-and-drop the breakpoint into the breakpoint group, or follow these steps.
The Edit Breakpoint dialog appears.
The breakpoint is added into the specified group.
To enable, disable, or remove a breakpoint group, in the Breakpoints window, right-click a breakpoints group, and choose Enable Group, Disable Group, or Delete Group from the context menu.
You can also enable or disable a group from the Breakpoint toolbar. With the group name selected in Breakpoints window, click the Enable or Disable icon on the toolbar. All the breakpoints of the selected group will be enabled or disabled.
Even though you can view your program by running and stepping through it, you usually need to examine the values of program variables to uncover bugs. For example, it is helpful to know the value of the index variable as you step though a loop, or the values of the parameters passed in a method call. When your program is paused in the debugger, you can examine the values of variables, arguments, fields, and array items.
You can inspect and change the values of data items using the Data, Smart Data, Inspector, or Watches windows during the course of your debugging sessions.
When you inspect a data item, you evaluate it with different expressions while your debugging session is running. If desired, you can then modify program data values as a way to test hypothetical bug fixes during a program run. If you find that a modification fixes a program error, you can exit the debugging session, fix your program code accordingly, and recompile the program to make the fix permanent.
You can modify program data values during a debugging session as a way to test hypothetical bug fixes during a program run. If you find that a modification fixes a program error, you can exit the debugging session, fix your program code accordingly, and recompile the program to make the fix permanent.
When you modify the value of a variable, the modification is effective for that specific program run only; the changes you make through the Data or Watches windows do not affect your program source code or the compiled program. To make your change permanent, you must modify your program source code in the source editor, then recompile your program.
The new value needs to be type-compatible with the variable you want to assign it to. A good rule of thumb is that if the assignment would cause a compile-time or run-time error, it is not a legal modification value.
To inspect a data item:
The floating Inspector window opens displaying the item's name, value, and other related information. The columns which display in this window depend on those column settings that were enabled in the Tools > Preferences - Debugger - Inspector page. For more information, see Section 19.7.5, "How to Use the Inspector Window."
You can also add a watch expression or further inspect the data item.
To quickly inspect a data item:
If you just want to view a data item's value and do not want to evaluate it for any expression, you can use the Quick Inspect feature.
JDeveloper also allows you to inspect a data item without adding it in Data window. When the debugger has stopped at a breakpoint in the Source Editor, hover the mouse over a data item to view the its name, value, and type. If the data item is an object or an array, you can inspect children of the selected item deep in the object hierarchy.
To modify the value of a variable in the Data window:
The Modify Value dialog appears with the selected item's name and its current value.
The new value appears in the Data, Smart Data, Inspector, or Watches windows.
A watch enables you to monitor the changing values of variables or expressions as your program runs. After you enter a watch expression, the Watch window displays the current value of the expression. As your program runs, the value of the watch changes as your program updates the values of the variables in the watch expression.
A watch evaluates an expression according to the current context which is controlled by the selection in the Stack window. If you move to a new context, the expression is reevaluated for the new context. If the execution point moves to a location where any of the variables in the watch expression are undefined, the entire watch expression becomes undefined. If the execution point returns to a location where the watch expression can be evaluated, the Watches window again displays the value of the watch expression.
To open the Watches window:
To add a watch from the Source Editor:
A dialog appears with the expression.
Or, add a watch in the following ways:
To edit a watch:
The Edit Watch dialog appears.
To delete a watch:
| Caution: You cannot restore a deleted watch. |
You can modify an existing expression in the inspector window.
To modify an expression in the Inspector window:
The Edit Expression dialog appears.
While debugging, you can use filters to reduce the number of fields that are displayed when you expand an object in a data-related debugger window. You can perform this task in the Smart Data window, the Data window, the Inspector window, the Watches window, and the left-hand side of the Monitors window through the Object Preferences dialog. Displaying fewer fields narrows your focus when debugging and may make it easier to locate and isolate potential problems in your program.
For example, you can create filters for classes in the data windows so that the debugger displays only the fields of interest to you. This drastically reduces clutter and allows you to find the relevant data more quickly.
To show or hide fields in the filtered classes list:
Choosing Object Preferences lets you go directly to the Object Preferences dialog for this specific object from which you can specify filters to control which fields are displayed and which fields are not displayed when you expand an object.
In addition to debugging code locally in the JDeveloper IDE, you can also debug code which is located on a remote machine or running in a different VM instance. This means that you can use the debugger to debug code that has already been deployed. The debugger can simultaneously attach to multiple remote VMs, so you can seamlessly debug distributed applications, such as JSPs deployed to a web server accessing EJBs deployed to an application server.
The main difference between remote debugging and local debugging is how you start the debugging session. For local debugging, JDeveloper automatically launches the program you want to debug (called a debuggee process) and then attaches the debugger to that program. For remote debugging, you must manually launch the program you want to debug. Also, if you are debugging a JSP or a servlet, you must manually start a browser to invoke your JSP or servlet.
Once the debuggee is launched and the JDeveloper debugger is attached to it, remote debugging is very similar to local debugging. Remember that you can use remote debugging when the debuggee process is running on the same machine as JDeveloper or when the debuggee process is running on a different machine.
Unlike local debugging, you must choose which protocol to use before you start your remote debugging session. The remote debugging protocols are configured in Debugger - Remote page of the Edit Run Configuration dialog.
You can also debug Web pages such as JSPs or servlets using the HTTP Analyzer. For more information, see Chapter 8, "Auditing and Profiling Applications."
Attach to JPDA
Select to attach to the debugger application at a specified address. For more information about the Sun Java Platform Debugger Architecture (JPDA) Connection and Invocation, see http://java.sun.com/javase/6/docs/technotes/guides/jpda/conninv.html.
Listen for JPDA
Select to specify that the debugger listen for a debuggee to attach to the debugger. Also, choose this option if you are debugging remote PL/SQL programs.
After you've configured a project for remote debugging, you can start your remote debugging session by issuing the appropriate command based on the debugging protocol and the environment.
To start the Java process, enter the following at the command line:
project_directory>\classes -agentlib:jdwp,<option1>[=<value1>],<option2>[=<value2>]... <java_main_class> The available options are:
server(=n/y) If set to y, then the Java process waits for a Debugger to attach. If set to n (default), the process attaches itself to the debugger application at the specified address.
address Specifies the port for the connection. Defaults to 4000.
timeout Time interval after which the connection attempt times out. Defaults to 2 seconds.
suspend =(y/n) If set to y (default), the Java process runs after the debugger connects to it. If set to n, the debuggee process starts right away without waiting for the debugger to connect to it.
Command line examples:
java -cp <project_directory>\classes -agentlib:jdwp=transport=dt_socket,server=y,suspend=n,address=4000 Listen for a debugger connection on port 4000, but begin execution without waiting for the debugger. Timeout after 2s (default). Implement the Client VM (default).
java -server -cp <project_directory>\classes -agentlib:jdwp=transport=dt_socket,server=n,suspend=y,timeout=3,address=8000 Attach to a debugger connection on port 8000. Begin execution only after connecting to the debugger. Timeout after 3s. Implement the Server VM.
For more information about the Sun JPDA Connection and Invocation, see http://www.oracle.com/technetwork/java/javase/documentation/index-jsp-135444.html.
JDeveloper allows you to remote debug a Javascript program in local instances and server instances.
Before you start remote debugging, install the Firefox plugin for Javascript debugging and configure JDeveloper for Javascript remote debugging.
To remote debug a Javascript program (HTML/JS files):
firefox AnHtmlFile -oraclejsdebugport=<port> <another browser argument>
For example:
C:\>firefox file://C:/Shopcart/Servlet/public_html/index.html -oraclejsdebugport=4000
Firefox won't open, but its process will start in the background. Open Windows Task Manager and verify that firefox process is running.
To remote debug a Javascript program in a server instance (JSP/Servlets/HTML files):
firefox webaddress -oraclejsdebugport=<port> <another browser argument>
For example:
C:\>firefox http://130.35.102.18:7101/Shopcart/index.jsp -oraclejsdebugport=4000
Firefox won't open, but its process will start in the background. Open Windows Task Manager and verify that firefox process is running.
Any project can be configured to perform remote debugging.
To configure a project for remote debugging:
The appropriate Attach to dialog appears.
In the Log window, once the debugger has connected, a successful connection message appears.
In the following steps, you will configure JDeveloper for Java Platform Debugger Architecture (JPDA) remote debugging.
To configure your project for remote debugging:
To configure JDeveloper for remote debugging:
This chapter describes how to use the tools and features that JDeveloper provides to help you develop Java Swing interfaces. It explains the fundamental tasks you perform as you work with components and JDeveloper's UI design tools. Included is a description of the UI debugger, which is used to debug user interfaces specifically for AWT and Swing-based client applications and applets.
This chapter includes the following sections:
Using the Java Visual Editor in JDeveloper, you can quickly and easily assemble the elements of a user interface (UI) for a Java application or applet using Swing components. You construct the UI with JavaBeans selected from the component palette, such as buttons, text areas, lists, dialogs, and menus. Then, you set the values of the component properties and attach event-handler code to the component events.
With JDeveloper tools, you can visually design and program Java classes to produce new compound or complex components.
JDeveloper UI design tools include the following:
If you want to use the UI design tools on a file, it must meet the following requirements:
jbInit(). jbInit(). This is necessary in order for the JDeveloper Java Visual Editor and Property Inspector to reflect the settings. Any file that meets the above requirements can be visually designed using the Java Visual Editor and the Property Inspector. You can also visually design a non-UI class.
| Note: These requirements are satisfied when you create your files with any of the JDeveloper dialogs. |
When you first add a component to your design, the JDeveloper Java Visual Editor ensures that your class has a default constructor, a private jbInit() method, and that this jbInit() method is called correctly from the default constructor. If JDeveloper does not find this code, it will add it. It will also add any imports needed by the component.
When you open the file in the Java Visual Editor, JDeveloper updates the Structure window tree. For example, if your class has a frame and a menu, there will be subtrees for UI and Menu. If you drop any other JavaBeans components into the Structure window, an 'Others' folder appears so you can select and edit these components in the Property Inspector.
JDeveloper includes the Swing GUI components. The Swing classes allow you to specify a look and feel for a user interface. You can take advantage of this new Java pluggable look-and-feel to create applications that have the look and feel of a user's native desktop for Windows or Solaris machines. You can also ensure a uniform look and feel in your applications across platforms with the Java Metal look and feel.
There are four look and feel choices in JDeveloper:
There are also several considerations when setting the look and feel using the UI Manager:
Application>.java static main() method. com.sun.java.swing package. To change to the Oracle look and feel:
It is necessary to have the Oracle look and feel (OLAF) share.jar and jewt4.jar files from the jlib directory in the classpath.
To change to the Windows look and feel:
It is necessary to have the Oracle look and feel (OLAF) share.jar and jewt4.jar files from the jlib directory in the classpath.
The Metal look and feel is default for Swing components. If you want to use the Metal look and feel, you do not have to change your code.
To change to the Metal look and feel:
| Note: It is necessary to have the Oracle look and feel (OLAF)share.jar and jewt4.jar files from the jlib directory in the classpath. |
Use Swing and AWT JavaBeans components to assemble the user interface (UI) for a Java application or applet. You construct the UI in the Java Visual Editor by selecting JavaBeans from the Component Palette, such as buttons, text areas, lists, dialogs, and menus. Then, you set the values of the component properties and attach event-handler code to the component events. Tools to visually design and program Java classes to produce new compound or complex component.
Swing components are lightweight components that are self-rendering and do not use Windowing resources as do AWT components. In many cases, these components have corresponding AWT components, but the Swing version is enhanced to allow greater flexibility and consistency between platforms.
| Note: Swing components rely on underlying functionality in Swing containers. If you intend to use Swing JavaBeans, you must create your program using a JFrame, JPanel or other container that implements the basic Swing functionality. |
Table 20-1 contains the Swing JavaBeans components.
Table 20-1 Swing JavaBeans Components
| Component | Description |
|---|---|
| JButton | A simple push button. A JButton can have an embedded icon. |
| JCheckBox | A square box used to display boolean (true/false) values. When its value is set to true, the box displays a checkmark by default. You have the option of setting your own checkmark graphic. |
| JComboBox | Similar to the Choice control in AWT, displays a list of values that the user can select at runtime. JComboBox has the property editable which enables the user to type a new value at runtime. |
| JEditorPane | A specialized JTextComponent that displays text formatted with HTML 3.2 or RTF. It is intended to allow you to create help pages for your application or applet. |
| JLabel | A text component that enables you to display a text string and optional icon. Additional properties enable you to set the position of the text relative to the icon. |
| JList | Displays a list of objects. Tip: The JList, unlike the AWT List component, doesn't have a scrolling facility built into the component. To make a scrollable list, you need to drop the list component into a JScrollPane container. |
| JPasswordField | A JTextField that by default displays asterisks (*) in place of the characters entered by the user. |
| JProgressBar | Displays a progress bar that graphically depicts the percentage of completion for a process. |
| JRadioButton | This component is specifically designed to behave as a Radio Button. When grouped with other JRadioButtons in a ButtonGroup, only one of the buttons in the group can be selected at one time. The ButtonGroup is a non-visual component. |
| JScrollBar | A graphic control the user can use to set an integer value. This component can be displayed with either a horizontal or a vertical orientation. |
| JSeparator | A component that draws a straight line. It is intended to be used as a component in a JMenu, but since it is an actual component, you can use it to draw a line in your UI that separates one set of controls from another. The JSeparator can be displayed in vertical or horizontal orientation. |
| JSlider | Similar to a JScrollBar, this control allows the user to set an integer value using a graphic control. JSlider allows you to set major and minor tick marks, and to display a border around the control. |
| JTable | Displays information in a two-dimensional grid, similar to a spreadsheet application. |
| JTextArea | An editable text area that displays a single string in multiple rows, each of which ends in a newline character. Tip: In order to make a JTextArea scrollable, it needs to be displayed in a JScrollPane container. |
| JTextField | An editable text area that displays a single string in a single row. |
| JTextPane | A full-featured text editor control that enables word wrap, image display, and style definition. |
| JTree | Displays hierarchical information, such as file directories, in a tree format. Tip: The JTree, unlike the AWT List component, doesn't have a scrolling facility built into it. To make a scrollable tree, you need to drop the list component into a JScrollPane container. |
| JToggleButton | Toggle buttons are similar to JCheckBox controls. When they are pushed (set to true) they remain true until they are set to false by pressing them again. JToggleButtons can be placed in a ButtonGroup so that only one in the group can be true at one time. Toggle buttons are useful in toolbars to display a tool in an active state. The buttons in the Component Palette are examples of toggle buttons. |
AWT JavaBeans components use the standard controls of the underlying platform to display the user interface. This architecture makes AWT components simple and straightforward to implement, but limits control over the final display of the UI and reduces flexibility. They also require more system resources to run, which is why they are sometimes referred to as heavyweight components. Swing components are implemented in Java to be self-rendering and therefore make less use of system resources, which is why they are referred to as lightweight components. Swing components can be more complex to implement, but offer greater flexibility and consistency between host platforms.
Table 20-2 contains the AWT JavaBeans Components.
Table 20-2 AWT JavaBeans Components
| Component | Description |
|---|---|
| Button | Displays a simple push button |
| Checkbox | True/false, on/off boolean control. As a standalone component, the checkbox appears as a square with an X to indicate when its value is set to true. When set as a member of a checkbox group, the checkbox becomes a circle (Radio Button): a dot in the circle indicates that its value is set to true. Add a checkbox component to a CheckboxGroup by setting its CheckboxGroup property to the name of the CheckboxGroup to which it belongs. |
| CheckboxGroup | Non-visual component used to integrate the behavior of a set of check box components. Only one item in a checkbox group can be set to true at one time. Checkbox components are added to the CheckboxGroup by setting the CheckboxGroup property to the name of the corresponding CheckboxGroup. The default value for a CheckboxGroup can be set by setting its SelectedCheckbox property to the name of the checkbox component. Tip: Depending on the order in which you add the Checkbox components and CheckboxGroup, the CheckboxGroup may be instantiated before the Checkboxes. To ensure that the correct default is set, you can move the SelectedCheckbox and current initialization statements to the bottom of the JbInit method so that all of its constituents are instantiated before the default is set. |
| Choice | Displays a popup menu. The label of the Choice control is the currently selected item. This is similar to a combobox. |
| Label | Displays a non-editable text label in the application, though its value may change programmatically. |
| List | Displays a scrolling list of data items. The user may be able to select one or more items depending on the property settings of the List. |
| MenuBar | Displays a menubar. Any container can add a MenuBar control as a child, however only Frame has the setMenubar() method which will parent the MenuBar at a specific location and will not interfere with the locations of any other children. Menubars are not available in Applets. |
| PopupMenu | Displays a popup menu with a list of commands. Popup menus can be attached to panels, and are available for use in Applets. For more information about creating menus, see Section 20.9, "Working with Menus". |
| Panel | A container which is used to display a group of controls. Each panel can have its own layout to give you control over the positioning of components in relation to one another. |
| Scrollbar | A slider control that allows the user to set an integer value. The scrollbar can be set to display horizontally or vertically. |
| ScrollPane | A type of panel that has horizontal and vertical scrollbars available to enable you to display a child component that is larger than the ScrollPane itself. |
| TextArea | A text component that displays a single string of text in multiple rows, each ending with a newline character. Text can be scrolled up and down, left and right. |
| TextField | An editable text component that displays a single string of text in a single row. |
Use JDeveloper's layout managers to control how components are located and sized in the container each time it is displayed. A layout manager automatically arranges the components in a container according to a particular set of rules specific to that layout manager.
A Java program can be deployed on more than one platform. If you use standard UI design techniques of specifying absolute positions and sizes for your UI components, your UI might not look good on all platforms. What looks fine on your development system might be unusable on another platform. To solve this problem, Java provides a system of portable layout managers. Layout managers allow you to specify rules and constraints for the layout of your UI in a way that will be portable.
Layout managers give you the following advantages:
A Java UI container uses a special object called a layout manager to control how components are located and sized in the container each time it is displayed. A layout manager automatically arranges the components in a container according to a particular set of rules specific to that layout manager.
The layout manager sets the sizes and locations of the components based on various factors such as:
preferredSize, minimumSize, maximumSize, alignmentX, and alignmentY In Java, certain types of containers use specific layout managers by default.
When you create a container in a Java program, you can accept the default layout manager for that container type, or you can override the default by specifying a different type of layout manager.
Normally, when coding your UI manually, you override the default layout manager before adding components to the container. When using the Java Visual Editor, you can change the layout whenever you like. JDeveloper will adjust the code as needed.
The Java Visual Editor in JDeveloper uses a default layout manager for each container, usually null layout. If you want to use a different layout manager than the default, you can do so by explicitly adding a layout manager to the source code for the container, or by selecting a layout from the container's layout property list in the Inspector.
| Note: If you want to change the properties for a layout manager using the Java Visual Editor, you must explicitly specify a layout for a container so its properties will be accessible in the Property Inspector. |
Choose a layout manager based on the overall design you want for the container. Some layouts can be difficult to work with in the Java Visual Editor because they immediately take over placement and resizing of a component as soon as you add it to the container. To alleviate this problem during initial layout prototyping, JDeveloper provides a default layout called null, which leaves the components exactly where you place them and at the size you specify. Starting with an null makes prototyping easier in your container. Later, after adding components to the container, you can switch to an appropriate portable layout for your design.
In some designs, you might use nested panels to group components in the main Frame, using various different layouts for the Frame and each of its panels.
| Note: If you really want to design a panel without a layout manager, you can set the layout manager in the source code to null. However, you should not leave it this way for deployment. |
Experiment with different layouts to see their effect on the container's components. If you find the layout manager you've chosen doesn't give you the results you want, try a different one, or try nesting multiple panels with different layouts to get the desired effect.
Layout managers use various pieces of information to determine how to position and size components in their container. Components provide a set of methods that allow layout managers to intelligently lay out components. All of these methods allow a component to communicate its desired sizing to the layout manager.
The methods in Table 20-3 are property getters and represent the following:
Table 20-3 Sizing Properties
| Method | Description |
|---|---|
|
| The size a component would choose to be, that is, the ideal size for the component to look best. Depending on the rules of the particular layout manager, the |
|
| How small the component can be and still be usable. The |
|
| The largest, useful size for this component. This is used so that the layout manager won't waste space on a component that can't use it effectively. For example, |
|
| How the component would like to be aligned along the x axis, relative to other components. |
|
| How the component would like to be aligned along the y axis, relative to other components. |
To understand how each layout manager uses these pieces of information, see the individual layouts listed in Section 20.5.2, "Understanding Layouts Provided with JDeveloper".
JDeveloper provides the following standard layout managers from the Java AWT BorderLayout, FlowLayout, GridLayout, CardLayout, and GridBagLayout. For Swing, BoxLayout2 and OverLayout2 have been included.
JDeveloper also provides FormLayout, a grid-based container that places components in a grid of columns and rows, allowing specified components to span multiple columns or rows. FormLayout is provided by JGoodies Forms, an open source framework included with JDeveloper.
Additionally, JDeveloper provides these custom layouts:
XYLayout that keeps components you put in a container at their original size and location (x,y coordinates). PaneLayout, used by the SplitPanel control. VerticalFlowLayout, which is very similar to FlowLayout except that it arranges the components vertically instead of horizontally. You can create custom layouts of your own, or experiment with other layouts like the ones in the sun.awt classes, or third-party layout managers, many of which are public domain on the Web. If you want to use a custom layout in the Java Visual Editor, you may have to provide a Java helper class file to help the Java Visual Editor use the layout.
BorderLayout arranges a container's components in areas named North, South, East, West, and Center.
The BorderLayout that appears in Figure 20-1 is good for forcing components to one or more edges of a container, and for filling up the center of the container with a component. It is also the layout you want to use to cause a single component to completely fill its container.
You will probably find BorderLayout to be the most useful layout manager for the larger containers in your UI. By nesting a panel inside each area of the BorderLayout, then populating each of those panels with other panels of various layouts, you can achieve quite complicated UI designs.
Components are positioned in one of five areas within a BorderLayout, based on the constraints property. You can set the constraints property for the component in the Inspector to one of the following values: North, South, East, West, or Center.
For example, to put a toolbar across the top of a BorderLayout container, you could create a FlowLayout panel of buttons and place it in the North area of the container. You do this by selecting the panel and choosing North for its constraints property in the Inspector.
To set the constraints property:
constraints property in the Inspector, and click its value field. If you use the Java Visual Editor to change the layout of an existing container to BorderLayout, the components near the edges automatically move to fill the closest edge. A component near the center may be set to Center. If a component moves to an unintended location, you can correct the constraints property in the Inspector, or drag the component to a new position in the Java Visual Editor.
Each of the five areas can contain any number of components (or panel of components), however, unless the topmost component is not opaque, any lower components in the same area will be covered by the topmost one.
The following are some general guidelines for working with multiple components and BorderLayout:
XYLayout first to move the components to their approximate intended positions, with only one component near each edge. | Note: BorderLayout ignores the order in which you add components to the container. |
By default, a BorderLayout puts no gap between the components it manages. However, you can use the Inspector to specify the horizontal or vertical gap in pixels for a BorderLayout associated with a container.
To modify the gap surrounding BorderLayout components, select the BorderLayout object in the Structure window (displayed immediately below the container it controls), then modify the pixel value in the Property Inspector for the hgap and vgap properties.
BoxLayout2 allows you to arrange a container's components either vertically or horizontally. By nesting components in containers, you can achieve complex layouts. Figure 20-2 shows three panels (P1, P2, P3) arranged vertically. Each panel contains two buttons arranged vertically.
When you use BoxLayout2 for a component, you specify whether its major axis is the Y axis (top placement) or X axis (left to right placement). Components are arranged from left to right (or top to bottom), in the same order as they were added to the container.
BoxLayout2 attempts to arrange components at their preferred widths (for left to right layout) or heights (for top to bottom layout). The components will not wrap if the container is resized.
If all the components are not the same height in a horizontal layout, BoxLayout2 attempts to make all the components as high as the highest component. If that's not possible for a particular component, then BoxLayout2 aligns that component vertically, according to the component's Y alignment.
If the components are not all the same width in a vertical alignment, BoxLayout2 attempts to make all components in the column as wide as the widest component; if that fails, it aligns them horizontally according to their X alignments.
CardLayout places components (usually panels) on top of each other in a stack like a deck of cards. You see only one at a time, and you can flip through the panels by using another control to select which panel comes to the top.
CardLayout is a good layout to use when you have an area that can contain different components at different times. This gives you a way to manage two or more panels that need to share the same display space.
You can see an example of using CardLayout by looking at the wizards in JDeveloper. The Cancel, Next, and Back buttons control which panel is displayed next.
To create a CardLayout container:
CardLayout. For more information, see Section 20.7.9, "How to Create a Panel". CardLayout panel. This new panel will completely fill up the CardLayout panel. | Note: The first component you add to aCardLayout panel will always fill the panel. |
layout property for this new panel to XYLayout and add the desired components. CardLayout panel in the component tree in the Structure window to add it to the stack in CardLayout panel. XYlayout and add components to it. Using the Structure window, you can specify the amount of horizontal and vertical gap surrounding a stack of components in a CardLayout.
To specify the gap surrounding a cardLayout container:
Figure 20-3 cardLayout

hgap (horizontal gap) or vgap (vertical gap) property in the Inspector. FlowLayout arranges components in rows from left to right, and then top to bottom using each component's preferredSize. FlowLayout lines up as many components as it can in a row, then moves to a new row. Typically, FlowLayout is used to arrange buttons on a panel.
Figure 20-4 FlowLayout

| Note: Note: If you want a panel that arranges the components vertically, rather than horizontally, see Section 20.5.21, "Using VerticalFlowLayout". |
You can choose how to arrange the components in the rows of a FlowLayout container by specifying an alignment justification of left, right, or center. You can also specify the amount of gap (horizontal and vertical spacing) between components and rows. Use the Inspector to change both the alignment and gap properties when you're in the Java Visual Editor.
Alignment
To change the alignment, select the FlowLayout object in the Structure window, then specify a value in the Property Inspector for the alignment property as follows:
Gap
The default gap between components in a FlowLayout is 5 pixels.
To change the horizontal or vertical gap, select the FlowLayout object in the Structure window, then modify the pixel value of the hgap (horizontal gap) or vgap (vertical gap) property in the Inspector.
Order of Components
To change the order of the components in a FlowLayout container, drag the component to the new location, or right-click a component and choose Move to First or Move to Last.
FormLayout places components in a grid of columns and rows, allowing specified components to span multiple columns or rows. Columns and rows need not have the same width or height.
| Note: FormLayout is provided by JGoodies Forms, an open source framework included with JDeveloper. To add FormLayout layout manager, add JGoodies Forms library in the current project's library. |
You can change the following column and row properties. Columns and rows are specified by three parts: a mandatory size, an optional default alignment, and an optional resize behavior. To edit these properties, when you're in the Java Visual Editor, drag the mouse and select the entire FormLayout grid, then right-click inside the selected grid and choose Column Properties or Row Properties.
Alignment
The default alignment of components in a column or row. The default alignment in a FormLayout is Fill.
Size
The width of a column or height of a row. You can specify a constant size, a component size (minimum or preferred), or a bounded size (minimum and maximum). Constant size is specified by a value plus a unit. Component sizes give a column or row the maximum size of its contained components and are measured by the component's minimum or preferred size. Bounded size lets you specify lower and upper bounds for the column and row start size (before resizing). This ensures a minimum or maximum column or row size. Note that the maximum size does not limit the column/row size if the column/row can grow (see resize behavior).
Resize
Controls whether or not resizing is allowed. Columns and rows can grow if the layout container becomes larger than the preferred size. The default is not to allow resizing.
Gap
The default places gaps between components.
| Note: Gap size is currently fixed and can not be edited in the Property Inspector. |
Order of Components
To change the order of the components in a FormLayout container, drag the component to the new location.
GridLayout places components in a grid of cells that are in rows and columns. GridLayout expands each component to fill the available space within its cell. Each cell is exactly the same size and the grid is uniform. When you resize a GridLayout container, GridLayout changes the cell size so the cells are as large as possible, given the space available to the container.
Figure 20-5 GridLayout

Use GridLayout if you are designing a container where you want the components to be of equal size, for example, a number pad or a toolbar.
You can specify the number of columns and rows in the grid, but only one of the rows or columns can be zero. You must have a value in at least one so the GridLayout manager can calculate the other.
For example, if you specify four columns and zero rows for a grid that has 15 components, GridLayout creates four columns of four rows, with the last row containing three components. Or, if you specify three rows and zero columns, GridLayout creates three rows with five full columns.
In addition to number of rows and columns, you can specify the number of pixels between the cells by modifying the horizontal gap (hgap) and vertical gap (vgap) properties. The default horizontal and vertical gap is zero.
To change the property values for a GridLayout container, select the GridLayout object in the Structure window, then edit the values for the rows, cols, hgap, or vgap properties in the Property Inspector.
GridBagLayout is an extremely flexible and powerful layout that provides more control than GridLayout in laying out components in a grid. GridBagLayout positions components horizontally and vertically on a dynamic rectangular grid. The components do not have to be the same size, and they can fill up more than one cell.
Figure 20-6 GridBagLayout

GridBagLayout determines the placement of its components based on each component's constraints and minimum size, plus the container's preferred size.
In the following discussion:
While GridBagLayout can accommodate a complex grid, it will behave more successfully (and more predictably) if you organize your components into smaller panels, nested inside the GridBagLayout container. These nested panels can use other layouts, and can contain additional panels of components if necessary. This method has two advantages:
On the other hand, GridBagLayout requires more containers, and therefore your program uses more memory, than if you used other layout managers.
GridBagLayout uses a GridBagConstraints object to specify the layout information for each component in a GridBagLayout container. Since there is a one-to-one relationship between each component and GridBagConstraints object, you need to customize the GridBagConstraints object for each of the container's components.
GridBagLayout components have the following constraints:
GridBagConstraints give you control over:
For a detailed explanation of each of the constraints, including tips for using them and setting them in the Java Visual Editor, see the individual constraint topics.
When you use the Java Visual Editor to design a GridBagLayout container, JDeveloper always creates a new GridBagConstraints2 object for each component you add to the container. GridBagConstraints is derived from GridBagConstraints , and has a constructor that takes all eleven properties of GridBagConstraints so the code generated by the Java Visual Editor can be simpler.
For example:
You can modify the parameters of the GridBagConstraints2 constructor directly in the source code, or you can use the Constraints property editor to change the values.
When you create a GridBagLayout container by coding it manually, you only need to create one GridBagConstraints object for each GridBagLayout container. GridBagLayout uses the GridBagConstraints default values for the component you add to the container, or it reuses the most recently modified value. If you want the component you're adding to the container to have a different value for a particular constraint, then you only need to specify the new constraint value for that component. This new value will stay in effect for subsequent components unless, or until, you change it again.
| Note: While this method of coding GridBagLayout is the leanest (recycling constraint values from previously added components), it doesn't allow you to edit that container visually in the Java Visual Editor. |
If you have a GridBagLayout container that was previously coded manually by using one GridBagConstraints object for the container, you will not be able to edit that container in the Java Visual Editor without making the following modifications to the code:
GridBagConstraints2 object for each component added to the container. GridBagConstraints2 object must have a large constructor with parameters for each of the eleven constraint values, as shown above. GridBagLayout is a complex but useful layout manager. JDeveloper has additional features in the Java Visual Editor that make GridBagLayout much easier to design and control, such as a Constraints property editor, a grid, and a pop-up menu on selected components.
There are two approaches you can take to designing GridBagLayout in the Java Visual Editor. You can design it from scratch by adding components to a GridBagLayout panel, or you can prototype the panel in the Java Visual Editor using another layout first, such as XYLayout, then convert it to GridBagLayout when you have all the components arranged and sized the way you want them. This method can speed up your design work substantially.
Whichever method you use, it is recommended that you take advantage of using nested panels (for more information, see Section 20.5.33, "Working with Nested Containers and Layouts") to group the components, building them from the inside out. Use these panels to define the major areas of the GridBagLayout container to simplify your GridBagLayout design, which gives you fewer cells in the grid and fewer components that need GridBagConstraints.
When you prototype your layout in another layout first, the conversion to GridBagLayout will be much cleaner and easier if you are careful about the alignment of the panels and components as you initially place them, especially left and top alignment. Keep in mind that you are actually designing a grid, so try to place the components inside an imaginary grid, and use nested panels to keep the number of rows and columns as small as possible. Using XYLayout for prototyping gives you the advantage of component alignment functions on the components' popup menu (accessed by right-clicking a component in the Java Visual Editor).
As the Java Visual Editor converts the design to GridBagLayout, it assigns constraint values for the components based on where the components were before you changed the container to GridBagLayout. Often, only minor adjustments are necessary, if any.
Converting to GridBagLayout assigns weight constraints to certain types of components (those which you would normally expect to increase in size as the container is enlarged at runtime, such as text areas, fields, group boxes, or lists). If you need to make adjustments to your design after converting to GridBagLayout, you'll find the task much easier if you remove all the weight constraints from any components first (set them all to zero).
If even one component has a weight constraint value greater than zero, it is hard to predict the sizing behavior in the Java Visual Editor due to the complex interactions between all the components in the container.
You can easily spot a GridBagLayout whose components have weights because the components will not be clustered together in the center of the container. Instead, the components fill the container to its edges.
| Tip: When you remove all the weights from the components in a GridBagLayout, one of two things will happen:
|
If you want to create your GridBagLayout by starting out with a new GridBagLayout container and adding all the components to it from scratch, there are certain behaviors you should expect.
gridx and gridy constraints in the Constraints property editor. By using the GridBagLayout Constraints property editor, some of the GridBagConstraints can be specified in the Java Visual Editor without having to edit the source code.
Figure 20-7 Constraints Editor

One big advantage to using the Constraints property editor for setting constraints is the ability to change constraints for multiple components at the same time. For example, if you want all the buttons in your GridBagLayout container to use the same internal padding, you can hold down the Shift key while you select each one, then open the Constraints property editor and edit the constraint.
To use the Constraints property editor:
GridBagLayout container you want to modify, either in the Structure window or in the Java Visual Editor. The Java Visual Editor displays an optional grid that lets you see exactly what is happening with each cell and component in the layout.
GridBagLayout container itself) and the grid will disappear. The grid is only visible when a component inside a GridBagLayout container is selected. The Java Visual Editor allows you to use the mouse for setting some of the constraints by dragging the whole component or by grabbing various sizing nibs on the component. Directions for setting constraints visually are included in the individual following constraint topics.
Right-clicking a GridBagLayout component displays a context menu that gives you easy access to some of the properties of the Constraints property editor, and lets you quickly set or remove certain constraints.
Table 20-4 GridBagLayout Popup Menu Commands
| Menu Command | Action |
|---|---|
| Remove Padding | Sets any size padding values (ipadx and ipady) for the selected component to zero. |
| Constraints... | Displays the Constraints popup editor for the selected |
| Fill Horizontal | Sets (ors) the fill constraint value for the component to HORIZONTAL. The component expands to fill the cell horizontally. If the fill was VERTICAL, it sets the constraint to BOTH. |
| Fill Vertical | Sets (ors) the fill constraint value for the component to VERTICAL. The component expands to fill the cell vertically. If the fill was HORIZONTAL, it sets the constraint to BOTH. |
| Remove Fill | Changes the fill constraint value for the component to NONE. |
| Weight Horizontal | Sets the weightx constraint value for the component to 1.0. |
| Weight Vertical | Sets the weighty constraint value for the component to 1.0 |
| Remove Weights | Sets both weighty and weighty constraint values for the component to 0.0. |
The following section lists each of the GridBagConstraints separately. It defines each one, explaining its valid and default values, and tells you how to set that constraint visually in the Java Visual Editor.
anchor
When the component is smaller than its display area, use the anchor constraint to tell the layout manager where to place the component within the area.
The anchor constraint only affects the component within its own display area, depending on the fill constraint for the component. For example, if the fill constraint value for a component is GridBagConstraints.BOTH (fill the display area both horizontally and vertically), the anchor constraint has no effect because the component takes up the entire available area. For the anchor constraint to have an effect, set the fill constraint value to GridBagConstraints.NONE, GridBagConstraints.HORIZONTAL , or GridBagConstraints.VERTICAL.
Valid values:
GridBagConstraints.CENTER
GridBagConstraints.NORTH
GridBagConstraints.NORTHEAST
GridBagConstraints.EAST
GridBagConstraints.SOUTHEAST
GridBagConstraints.SOUTH
GridBagConstraints.WESTGridBagConstraints.SOUTHWEST
GridBagConstraints.NORTHWEST
Default Value: GridBagConstraints.CENTER
To set the anchor constraint in the Java Visual Editor:
You can use the mouse to set the anchor for a component that is smaller than its cell. Simply click on the component and drag it, dragging the component toward the desired location at the edge of its display area, much like you would dock a movable toolbar. For example, to anchor a button to the upper left corner of the cell, click the mouse in the middle of the button, and drag it until the upper left corner of the button touches the upper left corner of the cell. This sets the anchor constraint value to NorthWest.
You can also specify the anchor constraint in the Constraints property editor:
fill
When the component's display area is larger than the component's requested size, use the fill constraint to tell the layout manager which parts of the display area should be given to the component. As with the anchor constraint, the fill constraint only affects the component within its own display area. Fill tells the layout manager to expand the component to fill the whole area it has been given.
Valid values:
GridBagConstraints.NONE
(Don't change the size of the component.)
GridBagConstraints.BOTH
(Resize the component both horizontally and vertically to fill the area completely.)
GridBagConstraints.HORIZONTAL
(Only resize the component to fill the area horizontally.)
GridBagConstraints.VERTICAL
(Only resize the component to fill the area vertically.)
Default Value: GridBagConstraints.NONE
To specify the fill constraint in the Java Visual Editor:
The fastest way to specify the fill constraint for a component is to use the component's context menu in the Java Visual Editor.
You can also specify the fill constraint in the Constraints editor.
gridwidth, gridheight
Use these constraints to specify the number of cells in a row (gridwidth) or column (gridheight) the component uses. This constraint value is stated in cell numbers, not in pixels.
Valid values:
gridwidth=nn, gridheight=nn
(Where nn is an integer representing the number of cell columns or rows.)
GridBagConstraints.RELATIVE (-1)
Specifies that this component is the next to last one in the row (gridwidth) or column (gridheight.) A component with a GridBagConstraints.RELATIVE takes all the remaining cells except the last one. For example, in a row of six columns, if the component starts in the third column, a gridwidth of RELATIVE will make it take up columns three, four, and five.
GridBagConstraints.REMAINDER (0)
Specifies that this component is the last one in the row (gridwidth) or column (gridheight).
Default Value: gridwidth=1, gridheight=1
To specify gridwidth and gridheight constraints in the Java Visual Editor:
You can specify gridwidth and gridheight constraint values in the Constraints property editor.
gridheight in the Height field. Specify the number of cells the component will occupy in the row or column. You can use the mouse to change the gridwidth or gridheight by sizing the component into adjacent empty cells.
gridx, gridy
Use these constraints to specify the grid cell location for the upper left corner of the component. For example, gridx=0 is the first column on the left, and gridy=0 is the first row at the top. Therefore, a component with the constraints gridx=0 and gridy=0 is placed in the first cell of the grid (top left).
GridBagConstraints.RELATIVE specifies that the component be placed relative to the previous component as follows:
gridx, it specifies that this component be placed immediately to the right of the last component added. gridy, it specifies that this component be placed immediately below the last component added. Valid values:
gridx=nn, gridy=nn
GridBagConstraints.RELATIVE (-1)
A maximum value of 512 rows and columns is supported by GridBagLayout; therefore, values you specify for X and Y must be not exceed 512.
Default value:
gridx=0, gridy=0
To specify the grid cell location in the Java Visual Editor:
You can use the mouse to specify which cell the upper left corner of the component will occupy. Click near the upper left corner of the component and drag it into a new cell. When moving components that take up more than one cell, be sure to click in the upper left cell when you grab the component. Sometimes, due to existing values of other constraints for the component, moving the component to a new cell with the mouse may cause changes in other constraint values, for example, the number of cells that the component occupies might change. To more precisely specify the gridx and gridy constraint values without accidentally changing other constraints, use the Constraints property editor.
constraints property to display the Constraints editor. gridx value in the X field, or the row number for gridy value in the Y field. If you want the value to be RELATIVE, enter a -1. | Note: When you use the mouse to move a component to an occupied cell, the Java Visual Editor ensures that two components never overlap by inserting a new row and column of cells so the components will not be on top of each other. When you relocate the component using the Constraints property editor, the Java Visual Editor does not check to make sure the components don't overlap. |
insets
Use insets to specify the minimum amount of external space (padding) in pixels between the component and the edges of its display area. The inset says that there must always be the specified gap between the edge of the component and the corresponding edge of the cell. Therefore, insets work like brakes on the component to keep it away from the edges of the cell. For example, if you increase the width of a component with left and right insets to be wider than its cell, the cell will expand to accommodate the component plus its insets. fill and padding constraints never steal any space from insets.
Valid values:
insets = new Insets(n,n,n,n)
Top, left, bottom, right (where each parameter represents the number of pixels between the display area and one edge of the cell).
Default values:
insets = new Insets(0,0,0,0)
To set inset values in the Java Visual Editor:
The Java Visual Editor displays blue sizing nibs on a selected GridBagLayout component to indicate the location and size of its insets. Grab a blue nib (sizing handle) with the mouse and drag it to increase or decrease the size of the inset.
When an inset value is zero, you will only see one blue nib on that side of the cell, as shown in Figure 20-8.
As shown in Figure 20-9, when an inset value is greater than zero, the Java Visual Editor displays a pair of blue nibs for that inset: one on the edge of the cell and one on the edge of the display area. The size of the inset is the distance (number of pixels) between the two nibs. Grab either nib to change the size of the inset.
For more precise control over the inset values, use the Constraints property editor to specify the exact number of pixels.
constraints property to display the Constraints editor. | Note: Although negative inset values are legal, they can cause components to overlap adjacent components, and are not recommended. |
ipadx, ipady
These constraints specify the internal padding for a component. Use ipadx and ipady to specify the amount of space (in pixels) to add to the minimum size of the component for internal padding. For example, the width of the component will be at least its minimum width plus ipadx in pixels. The code only adds it once, splitting it evenly between both sides of the component. Similarly, the height of the component will be at least the minimum height plus ipady pixels.
ipadx specifies the number of pixels to add to the minimum width of the component. ipady specifies the number of pixels to add to the minimum height of the component. For example, when added to a component that has a preferred size of 30 pixels wide and 20 pixels high:
ipadx= 4, the component will be 34 pixels wide ipadx= 2, the component will be 22 pixels high. Valid values:
ipadx=nn, ipadx=nn
Default value:
ipadx=0, ipady=0
To set the size of internal padding constraints in the Java Visual Editor:
Setting the size of internal padding constraints in the Java Visual Editor. If you drag the sizing nib beyond the edge of the cell into an empty adjacent cell, the component will occupy both cells (the gridwidth or gridheight values will increase by one cell).
Figure 20-10 Before Dragging the Sizing Nib Beyond the Edge of a Cell

Figure 20-11 After Dragging the Sizing Nib Beyond the Edge of a Cell

For more precise control over the padding values, use the Constraints property editor to specify the exact number of pixels to use for the value.
constraints property to display the Constraints editor. To quickly remove the padding (set it to zero), right-click the component in the Java Visual Editor and choose Remove Padding. You can also select multiple components and use the same procedure to remove the padding from all of them at once.
Negative values are valid. They will make the component smaller than its preferred size.
| Note: Padding, much likeXYLayout, may not be accurate on different computer systems or in different languages. |
weightx, weighty
Use the weight constraints to specify how to distribute a GridBagLayout container's extra space horizontally (weightx) and vertically (weighty) when the container is resized. Weights determine what share of the extra space gets allocated to each cell and component when the container is enlarged beyond its default size.
Weight values are of type double and are specified numerically in the range 0.0 to 1.0 inclusive. Zero means the component should not receive any of the extra space, and 1.0 means the component gets a full share of the space.
weightx of all the components in the row. weighty of all the components in the column. Valid Values:
weightx=n.n, weighty=n.n
Default Value:
weightx=0.0, weighty=0.0
To set weightx and weighty constraints in the Java Visual Editor:
To specify the weight constraints for a component in the Java Visual Editor, right-click the component and choose Weight Horizontal (weightx), or Weight Vertical (weighty). This sets the value to 1.0. To remove the weights (set them to zero), right-click the component and choose Remove Weights. You can do this for multiple components: hold down the Shift key when selecting the components, then right-click and choose the appropriate menu item.
If you want to set the weight constraints to something other than 0.0 or 1.0, you can set the values in the Constraints editor.
constraints property to display the Constraints editor. weightx) or Y (weighty) value in the Weight area, then press OK. | Note: Because weight constraints can make the sizing behavior in the Java Visual Editor difficult to predict, setting these constraints should be the last step in designing aGridBagLayout. |
Examples of How Weight Constraints Affect Components' Behavior
GridBagLayout puts any extra space between its grid of cells and the edges of the container. weightx constraints of 0.0, 0.3, and 0.2 respectively, when the container is enlarged, none of the extra space will go to the first component, 3/5 of it will go the second component, and 2/5 of it will go to the third. In Figure 20-14, all the components in the GridBagLayout panel have a weight constraint value of zero. Because of this constraint, the components are clustered in the center of the GridBagLayout panel, with all the extra space in the panel distributed between the outside edges of the grid and the panel. The size of the grid is determined by the preferred size of the components, plus any insets and padding (ipadx or ipady).
In Figure 20-15, a horizontal weight constraint of 1.0 is specified for the ListControl. Notice that as soon as one component is assigned any weight, the UI design is no longer centered in the panel. Since a horizontal weight constraint was used, the GridBagLayout manager takes the extra space in the panel that was previously on each side of the grid, and puts it into the cell containing the ListControl. Also notice that the ListControl did not change size.
| Tip: f there is more space than you like inside the cells after adding weight to the components, decrease the size of the UI frame until the amount of extra space is what you want. To decrease the size of the frame, select the frame in the Java Visual Editor or the Structure window,this(BorderLayout), then click its black sizing nibs and drag the frame to the desired size. |
As shown in Figure 20-16, if a horizontal fill is then added to the ListControl, the component expands to fill the new horizontal dimension of the cell.
weightx value, GridBagLayout gives the whole column that weight. Conversely, if one component in a row has a weighty value, the whole row is assigned that weight. OverlayLayout2 arranges components over the top of each other. The requested size of the container will be the largest requested size of the children, taking alignment needs into consideration. The alignment is based upon what is needed to properly fit the children in the allocation area. The children will be placed such that their alignment points are all on top of each other. Unlike BorderLayout's centering, OverlayLayout2 does not expand the component to fill the available space, but instead leaves it at its preferred size.
As shown in Figure 20-17, PaneLayout allows you to specify the size of a component in relation to its sibling components. PaneLayout applied to a panel or frame lets you control the percentage of the container the components will have relative to each other, but does not create moveable splitter bars between the panes.
In a PaneLayout, the placement and size of each component is specified relative to the components that have already been added to the container. Each component specifies a PaneConstraints object that tells the layout manager from which component to take space, and how much of its existing space to take. Each component's PaneConstraints object is applied to the container as it existed at the time the component was added to the container. The order in which you add the components to the container is very important.
The constraint for a PaneConstraints component that is being added to a container consists of four variables:
The name for this component (must be unique for all components in the container - as in CardLayout).
The name of the component from which space will be taken to make room for this component.
The edge of the splitComponentName to which this component will be anchored.
Table 20-5 shows valid values.
Table 20-5 Valid values for String position
| Select this | To do this |
|---|---|
| PaneConstraints.TOP | This component will be above s |
| PaneConstraints.BOTTOM | This component will be below s |
| PaneConstraints.RIGHT | This component will be to the right of |
| PaneConstraints.LEFT | This component will be to the left of |
| PaneConstraints.ROOT | This component is the first component added. |
The proportion of splitComponentName that will be allocated to this component. A number between 0 and 1.
Components are added to PaneLayout as follows:
PaneConstraint is its name. Other components will use this value, specifying it as their splitComponentName. splitComponentName as the name of the first component. splitComponentName of subsequent components may be the name of any component that has already been added to the container. You can create a PaneLayout container in the Java Visual Editor.
To create a PaneLayout Container:
PaneLayout. This allows you to access the PaneLayout properties in the Inspector. PaneLayout container. This component will completely fill the container until you add another component. Figure 20-19 Component Dropped in PaneLayout Container

Figure 20-20 Second Component Dragged into PaneLayout

| Note: f the first component you added to aPaneLayout container was itself a container, the Java Visual Editor assumes you are trying to add the second component to the outer container instead of to the PaneLayout container. Use the component tree to specify to the containers that you want the component to be placed in. |
PaneLayout, draw it similarly to define its position relative to the other components. For example, to split the right half of the container, begin drawing the third component starting from the middle of the right edge of the panel to the bottom right corner of the first component.
Figure 20-21 Third Component Dragged into PaneLayout

VerticalFlowLayout arranges components in columns from top to bottom, then left to right using each component's preferredSize. VerticalFlowLayout lines up as many components as it can in a column, then moves to a new column. Typically, VerticalFlowLayout is used to arrange buttons on a panel.
Figure 20-22 VerticalFlowLayout

You can choose how to arrange the components in the columns of a VerticalFlowLayout container by specifying an alignment justification of top, middle, or bottom. You can also specify the amount of gap (horizontal and vertical spacing) between components and columns. It also has properties that let you specify the components should fill the width of the column, or the last component should fill the remaining height of the container. Use the Inspector to change these properties when you're in the Java Visual Editor.
Alignment
The default alignment in a VerticalFlowLayout is MIDDLE.
To change the alignment, select the verticalFlowLayout object in the Structure window, then specify a value in the Inspector for the alignment property as follows:
Gap
The default gap between components in a VerticalFlowLayout is 5 pixels.
To change the horizontal or vertical gap, select the VerticalFlowLayout object in the Structure window, then modify the pixel value of the hgap (horizontal gap) or vgap (vertical gap) property in the Inspector.
Order of Components
To change the order of the components in a VerticalFlowLayout container, drag the component to the new location.
Horizontal Fill
horizontalFill lets you specify a fill to edge flag which causes all the components to expand to the container's width.
Figure 20-23 horizontalFill

| WARNING: Your program can become unstable if the main panel has less space than it needs. This property also prohibits multi-column output. |
Vertical fill
verticalFill lets you specify a vertical fill flag that causes the last component to fill the remaining height of the container.
Figure 20-24 verticalFill

The default value for verticalFill is False.
XYLayout is a JDeveloper custom layout manager. XYLayout puts components in a container at specific (x,y) coordinates relative to the upper left corner of the container. Regardless of the type of display, the container will always retain the relative (x,y) positions of components. However, when you resize a container with an XYLayout, the components do not reposition or resize.
For XYLayout containers, the preferredSize of the container is defined by the values specified in the width and height properties of the XYLayout. For example, if you have the following lines of code in your container initialization,
xYLayoutN.setWidth(400);
xYLayoutN.setHeight(300);
and if xYLayoutN is the layout manager for the container, then its preferredSize is 400 x 300 pixels.
If one of the nested panels in your UI uses XYLayout, that panel's preferredSize will be determined by the layout's setWidth() and setHeight() calls. This value will be used for the panel in computing the preferredSize of the next (outer) container.
Figure 20-25 XYLayout

You'll discover that XYLayout is very convenient to use in prototyping a user interface. When you design more complicated user interfaces with multiple nested panels, XYLayout can be used for the initial layout of the panels and components, after which you can choose from one of the standard layouts for the final design.
| Note: XYLayout uses absolute x,y values when positioning objects on the screen, and does not adjust to different screen resolutions. To ensure your layout adjusts to other resolutions, don't leave any containers in XYLayout in your final design. |
You can use the UI design tools to specify the container's size and its components' x,y coordinates.
XYLayout, select the XYLayout object in the Structure window and enter the pixel dimension for the height and width properties in the Property Inspector. This setting specifies the size of the XYLayout container. constraints property edit field and enter coordinates for that component. the alignment options available from the context menu.
Table 20-6 Alignment Options
| Select this | To do this |
|---|---|
| Move to first | Moves the selected component to the top of the Z-order. |
| Move to last | Moves the selected component to the bottom of the Z-order. |
| Align left | Lines up the left edges of the selected components with the left edge of the first selected component. |
| Align center | Horizontally lines up the centers of the selected components with the center of the first selected component. |
| Align right | Lines up the right edges of the selected components with the right edge of the first selected component. |
| Align top | Lines up the top edges of the selected components with the top edge of the first selected component. |
| Align middle | Vertically lines up the centers of the selected components with the middle of the first selected component. |
| Align bottom | Lines up the bottom edges of the selected components with the bottom edge of the first selected component. |
| Even space horizontal | Evenly spaces the selected components horizontally between the first and last selected components. |
| Even space vertical | Evenly spaces the selected components vertically between the first and last selected components. |
| Same size horizontal | Makes all the selected components the same width as the first selected component. |
| Same size vertical | Makes all the selected components the same height as the first selected component. |
A simpler approach to XYLayout is to prototype the UI directly in the Java Visual Editor by setting the layout to null. UI components are set where you place them at the size you create them. For more information, see Section 20.6, "Prototyping Your UI with Layout Properties".
Each container normally has some kind of layout manager attached to its layout property. The layout manager has properties that can affect the sizing and location of all components that are added to the container. You can view and edit these properties in the Inspector when the layout manager is selected in the Structure window. The layout manager displays as an item in the Structure window just below the container to which it is attached.
Figure 20-26 Layout Properties

For each component you add to a container, JDeveloper may instantiate a constraints object, or produce a constraint value, which provides additional information about how the layout manager should size and locate this specific component. The type of constraint object or value created depends upon the type of layout manager being used. The Inspector displays the constraints of each component as if they were properties of the component itself, and allows you to edit them.
If your UI class is a Frame or Dialog, you can control its size and location at runtime. The size and location are determined by what the code does when the UI window is created and what the user does to resize or reposition it.
When the UI window is created, and various components are added to it, each component that is added affects the preferredSize of the overall window, typically making the preferredSize of the window container larger as additional components are added. This effect on preferredSize depends on the layout manager of the outer container, as well as any nested container layouts. For more details about the way that preferredLayoutSize is calculated for various layouts, see the sections in this document on each type of layout.
The size of the UI window, as set by your program (before any additional resizing that may be done by the user), is determined by which of the following container methods is called last in the code:
pack() setsize() The location of your UI at runtime will be at 0,0 unless you override this by setting the location property of the container (for example by calling setLocation() before making it visible).
The pack() method computes a window's preferredSize, based upon the components it contains, and sizes itself accordingly. pack() creates the smallest possible window, while still respecting the preferredSize of the components that are placed within it.
| Note: The Application.java file created by the New Application dialog callspack(), packing the frame to its preferredSize before making it visible. |
preferredSize is calculated differently for containers with different layouts
Portable layouts, such as FlowLayout and BorderLayout, calculate their preferredSize based on a combination of the layout rules and the preferredSize of each component that was added to the container. If any of the components are containers (such as a Panel), then the preferredSize of that Panel is calculated according to its layout and components. The layout calculation is recursed into as many layers of nested containers as necessary. For more information about preferredSize calculation for particular layouts, see the individual layout descriptions.
If you call setSize() on the container (rather than pack() or subsequent to calling pack()), the size of the container will be set to a specific size, in pixels. setSize() overrides the effect of pack() and preferredSize for the container.
| Note: Because different screens have different pixel sizes, if you usesetSize() you must call validate() in order for child containers to be properly laid out. Note that pack() automatically calls validate(). |
To make your UI portable, either use pack() or calculate an appropriate size to use with setSize() based on the pixel sizes of the various screens your application will be deployed on.
For example, you might want the UI to appear at 75% of the width and height of the screen. For the UI to appear at this sizing, you can add the following lines of code to your application class instead of calling pack():
| Note: To ensure portability, change all XYLayout containers to a portable layout after prototyping. For more information, see Section 20.6, "Prototyping Your UI with Layout Properties". |
If you don't explicitly position your UI, it will appear in the upper left corner of the screen.
To center the UI on the screen, obtain the width and height of the screen, subtract the width and height of your UI, divide the difference by two (in order to create equal margins on opposite sides of the UI), and use these figures for the location of the upper left corner of your UI.
The code in Example 20-1 is generated when you select the Center Frame on Screen option in the New Application dialog, and performs this calculation for you.
Example 20-1 Code Generated When You Select Center Frame on Screen Option
The calls to pack(), validate(), setSize(), or setLocation() can be made from inside the UI container class for example, this.pack(). These calls can also be made from the class that creates the container, for example, frame.pack(), after invoking the constructor, before setVisible(). The latter is what the New Application dialog-generated code does; the calls to pack() or validate(), and setLocation() are placed in the Application class, after the frame is constructed (after the call to jbInit()).
If you are constructing the UI from various places within your application, and you want it to come up in the same size and place, place your calls in the constructor of your UI container class (after the call to jbInit(). If your application instantiates the UI from only one place, such as in the New Application dialog generated application, put the sizing and positioning code in the place where the UI is created, in this case the Application class.
Most UI designs in Java use more than one type of layout to get the desired component positions by nesting multiple panels with different layouts in the main container. By creating a composite design, and by using the appropriate layout manager for each panel, you can group and arrange components in a way that is both functional and portable.
For example, Figure 20-27 demonstrates the use of nested panels with different layouts. The solid gray objects are the buttons and other visible components in the UI which are nested in various levels of panels.
You can nest panels within other panels to gain more control over the placement of components.
To create nested panels:
When you add a panel to the UI design, it uses FlowLayout. Change the layout to null initially because it is the easiest layout to work with during the design process. After you have all the panels and other components in place in your UI, you will set it to its final layout.
To locate a specific panel in the Java Visual Editor, you can select the panel in the Structure window.
JDeveloper supports the integration of other layout managers with its Java Visual Editor. Users will be able to work with the layout manager using both the Java Visual Editor and the Property Inspector when you:
oracle.jdevimpl.uieditor.LayoutAssistant implementation to be associated with the LayoutManager. LayoutAssistant implementation with the IDE. java.beans.PropertyEditor with the IDE to handle any special constraints type. To create a custom layout manager assistant:
Each LayoutManager must be associated with a LayoutAssistant implementation. The class oracle.jdevimpl.uieditor.assistant.BasicLayoutAssistant provides a minimal implementation of the interface oracle.jdevimpl.uieditor.LayoutAssistant and will be used for any LayoutManager for which no explicit registration has been made. There are several required methods in the interface, but it is beyond the scope of this topic to describe them. Integrators may wish to subclass their LayoutAssistant implementations from this minimal implementation. Refer to the Javadoc for the LayoutAssistant interface for details.
To register the layout assistant:
To register the new layout assistant, you need to add a key-value definition to oracle.jdevimpl.uieditor.UIEditorAddin section in the JDeveloper\lib\addins.xml file as follows:
where:
jdeveloper.uiassistant For example, if you were to register a LayoutAssistant implementation oracle.jdevimpl.uieditor.assistant.GridBagLayoutAssistant for the java.awt.GridBagLayout layout manager, the property to add would look like:
Note that in order for the layout assistant to be available from within the IDE, so that it will appear in the Property Inspector's layout property list, the layout assistant must be added to the IDEClasspath as a directive in JDeveloper\bin\jdev.conf file. For example:
AddJavaLibFile <myAssistant.jar>
where:
myAssistant.jar contains the compiled class file for your LayoutAssistant implementation.
To register a constraints property editor for the layout manager:
If your custom layout manager uses a constraint class, you may want to register a class implementing java.beans.PropertyEditor for editing the constraints. You register the property editor class under Inspector.PropertyEditor in the ide.properties file, where:
Inspector.PropertyEditor.count=# provides the total number of property editors that are registered in ide.properties. You must increment the count for each new property editor you wish to add. <#> is the zero-based index, in the list of registered editors, corresponding to the editor you are registering. <fully qualified type> is the fully-qualified type of the constraints for which a PropertyEditor is being registered. <Fully qualified class> is the fully-qualified classname of the java.beans.PropertyEditor implementation being registered for editing instances of the given constraints type. For example, if you were to register the property editor for the GridBagLayout layout manager's GridBagConstraints, your entry in the ide.properties file would look like:
| Note: Your property editor class also needs to be in the IDEClasspath as described above for the layout manager assistant. |
Before you start creating your UI, it is useful to sketch your UI design on paper to get an idea of the general strategy you'll use for placing various panels and components, and for assigning layouts. You can also prototype your UI directly in the Java Visual Editor. JDeveloper makes this easy by providing a layout called null that leaves the components where you place them at the size you create them.
To make this approach simpler, JDeveloper provides the null layout. When you start a project using the New Application dialog, JDeveloper generates a UI container class (usually one that extends Frame or JFrame) that uses null. You can open the frame in the Java Visual Editor and do your design work directly on the frame.
When you initially add a new panel of any type to the Java Visual Editor, you'll notice that the layout property in the Inspector says <default layout>, which means that the Java Visual Editor will automatically use the default layout for that container. However, you may want to change the layout property to the layout manager you want to use so it is visible in the Structure window and that component constraints can be modified in the Property Inspector. You cannot edit layout properties for <default layout>.
Design the big regions of your UI first, then, using null, work down into finer details within those regions. Once the design is right, work systematically from the inner regions outward, converting the panels to more portable layouts such as FlowLayout, BorderLayout, or GridLayout, making minor adjustments if necessary.
In most cases, you will place a container in your design first, then add components to it. You can also draw a new container around existing components. However, these components will not automatically nest into the new panel. After drawing the container, you must move each component in the container. You may even need to move a component out of the container, then back in. Check the Structure window to make sure each component nests properly. Each component inside a container should be indented in the Tree under its container.
When designing in JDeveloper, expect to work by trial and error, especially when changing the layouts. Be sure to save your work before experimenting with a layout change.
You may discover that a particular layout you planned to use doesn't work as you expected. You may need to reexamine your design process and use a different configuration of containers, components, and layouts. For this reason, you may want to copy the container file (for example Frame1.java) to a different name and safe location at critical points so that, when you need to back up in your work, you don't need to start over completely.
If you've used the null or XYLayout Manager to design your Java program, you'll need to change the layout manager to one of the standard layout managers that is supported across different platforms.
To change the layout manager, see Section 20.8.3, "How to Change the Layout for a Container".
JDeveloper provides easy tools to help you generate your containers. Containers hold and manage other components. When you lay out a form to design the UI in JDeveloper you use containers. There are two general classes of containers:
Containers are also components; you interact with them by getting and setting their properties, calling their methods, and responding to their events as with any other component.
A Window is a stand-alone top-level container component with no borders, title bar, or menu bar. Although a Window could be used to implement a popup window, you normally use a subclass of Window in your UI such as one of those listed in Table 20-7.
Table 20-7 Windows Subclasses
| Window | Description |
|---|---|
| Frame | A top-level window with a border and a title. A Frame has standard window controls such as a control menu, buttons to minimize and maximize the window, and controls for resizing the window. It can also contain a menu bar. |
| Dialog box | A popup window, similar to a Frame, but it needs a parent. Dialog boxes are used for getting input from the user or to present warning messages. It can also contain a menu bar. Dialog boxes are usually intended to be transient, or temporary, and can be one of the following types:
|
A Panel is a simple UI container, without border or caption, used to group other components, like buttons, checkboxes, and text fields. Panels are embedded within some other UI, such as in a frame or dialog. They can also be nested within other panels.
Table 20-8 Panels
| Panel | Description |
|---|---|
| Applet | A subclass of Panel used to build a program intended to be embedded in an HTML page and run in an Internet browser or applet viewer. Since Applet is a subclass of Panel, it can contain components, but does not have a border or caption. |
The lightweight Swing containers available from JDeveloper's Component Palette pages include JMenuBar, JPopupMenu, JSplitPane, JScrollPane, JTabbedPane, and JToolbar. All are a subclass of JComponent. You can add other containers and components to these containers, combining components and their containers in various ways to get the interface you want.
Table 20-9 Lightweight Swing Containers
| Lightweight Container | Description |
|---|---|
| Menu Bar | The lightweight Swing containers available from the Component Palette pages include JMenuBar, JPopupMenu, JSplitPane, JScrollPane, JTabbedPane, and JToolbar. All are a subclass of JComponent. You can add other containers and components to these containers, combining components and their containers in various ways to get the interface you want. |
| Popup Menu | A small window which pops up and displays a series of choices, which you create in JDeveloper using the Menu Editor. A JPopupMenu is used for the menu that appears when the user selects an item on the menu bar. It is also used for "pull-right" menu that appears when the selects a menu item that activates it. Finally, a JPopupMenu can also be used anywhere else you want a menu to appear -- for example, when the user right-clicks in a specified area. |
| Split Pane | Manages two panes that are separated horizontally or vertically by a divider that can be repositioned by the user. You can choose which pane to add a component to. You can specify the components with the properties |
| Scroll Pane | Manages two panes that are separated horizontally or vertically by a divider that can be repositioned by the user. You can choose which pane to add a component to. You can specify the components with the properties leftComponent and rightComponent, or topComponent and bottomComponent. In these properties, "Left" is equivalent to "Top" and "Right" is equivalent to "Bottom" -- so if you change the arrangement, your existing code still works. Subsequent adds to the same pane replace its contents with the new object. Along with its scroll bars and viewport, a JScrollPane can have a column header and a row header. Each of these is a JViewport object that you specify with |
| Tabbed Pane | Manages multiple panels that completely overlap each other. The user can select a panel to view by clicking on a "tab" attached to the panel (like the tab on a file folder). You add tabs in JDeveloper by dropping a JPanel onto the tabbed pane from the Component Palette. The tabPlacement property lets you position tabs on the top, bottom, left side, or right side of the container. |
| Toolbar | Provides a component which is useful for displaying commonly used Actions or controls. It can be dragged out into a separate window by the user (unless the |
A property is a named attribute of a class that can affect its appearance or its behavior. A property can be:
Properties are attributes that define how a component appears and responds at runtime. In JDeveloper, you set a component's initial properties during design time, and your code can change those properties at runtime.
The Property Inspector window displays the properties of the selected component(s) and is where you set the property values at design time for any component in your design. By setting properties at design time, you are defining the initial state of a component when the UI is instantiated at runtime.
| Note: To modify the initial property values at runtime, you can put code in the body of the methods or event handlers which you can create on the Events section of the Property Inspector. |
When you open the Property Inspector with more than one component selected in the Java Visual Editor, by default the Property Inspector displays all the common properties of the selected components.
Despite the fact that you may have selected multiple components in the Java Visual Editor, the Property Inspector still only displays property values for one component at a time. When the properties are shared among the selected components, sometimes the values will be the same, and in other cases, the property values may differ among the components. The Property Inspector helps you to identify which shared properties have differing values by representing the value in italics.
When the values for shared properties differ among the selected components, the property value that is displayed always belongs to the anchor selection. The anchor selection is the one that appears with hollow selection handles in the Java Visual Editor. You may alter the anchor selection by holding down the Shift key and clicking one of the other currently selected components. Altering the anchor selection changes which components' properties are shown in the Inspector, as well as altering which component the Java Visual Editor context menu operations apply to (for example, the Align context menu item).
When you change any of the shared properties in the Property Inspector, the property value changes to the new value in all the selected components.
This section explains the fundamental tasks you perform as you work with components and JDeveloper's UI design tools to create a user interface. If you're comfortable using controls in a graphical user interface environment, much of the material discussed here, such as selecting, sizing, and deleting components might be familiar to you.
Before you begin actually creating your UI, you may want to prototype your UI. For more information, see Section 20.6, "Prototyping Your UI with Layout Properties".
To design a user interface in JDeveloper:
To start your project:
These instructions assume that you have already created a project that includes a designable container class. If not, you will need to:
A frame is a top-level window with a border and a title. It has standard window controls such as a control menu, buttons to minimize and maximize the window, and controls for resizing the window.
The New Frame dialog adds a new class to the active project. It adds necessary import statements, creates a default constructor, and it creates a jbInit() method in which JDeveloper sets properties and other initialization code used by the Java Visual Editor.
To add a frame:
The frame is displayed as a.java source file in the Navigator.
To view the frame in JDeveloper:
A panel is a UI container that groups components such as buttons, checkboxes, and text fields. A panel has a border and may have a title if the border selected is a TitledBorder. Typically, a panel is embedded within a dialog box or frame.
The New Panel dialog adds a new class to the opened project that extends a panel you select. It creates a default constructor, and a jbInit() method in which JDeveloper puts property setters and other initialization code used by the Java Visual Editor.
To create a panel:
You can choose from any of the base classes installed with JDeveloper. If you prefer, you can search for another class that isn't from an installed package using the browse button. By default, the selection is limited to the panel container provided with the core J2SE (Java 2, Standard Edition) and Swing classes.
The panel is displayed as a.java source file in the Navigator.
To view the panel in JDeveloper:
A dialog box is a popup window with a border and a title. Dialog boxes are typically used to collect user input.
The New Dialog dialog creates a new class that extends Dialog or JDialog and adds it to the current project. It adds the necessary import statement. It also creates a jbInit() method in which JDeveloper puts property setters and other initialization code used by the Java Visual Editor. The jbInit() method will be invoked when using any of the constructors.
After adding the dialog box, you can design the dialog directly using the Java Visual Editor. This is how you add buttons and other controls to your new dialog box.
To create a dialog box:
java.awt.Dialog or javax.swing.JDialog. The dialog box is displayed as a.java source file in the Navigation window.
To view the dialog box in JDeveloper:
Once the dialog box has been created and its UI designed, you will want to test or use your dialog box from some UI in your program.
To test or use your dialog box:
getParent() on the applet. For a modeless dialog box (which we are calling dialog1 in this example), you can use the form of the constructor that takes a single parameter (the parent Frame) as follows:
Dialog1 dialog1=new Dialog1(this);
For a modal dialog box, you will need to use a form of the constructor that has the boolean modal parameter set to true, such as in the following example:
Dialog1 dialog1=new Dialog1(this, true);
You can either place this line as an instance variable at the top of the class (in which case the dialog box will be instantiated during the construction of your Frame and be reusable), or you can place this line of code in the actionPerformed event handler for the button that invokes the dialog box (in which case a new instance of the dialog box will be instantiated each time the button is pressed.) Either way, this line instantiates the dialog box, but does not make it visible yet.
(In the case where the dialog is a bean, you must set its frame property to the parent frame before calling show(), rather than supplying the frame to the constructor.)
dialog1.show();
show() method call, because show() doesn't return until the modal dialog box is dismissed. You can use a result property to determine whether the OK or Cancel button was pressed. A tabbed pane is a UI container that groups components such as buttons, checkboxes, and text fields on multiple panels. Each panel has a title and a tab that the end user clicks to view the panel contents.
To create a tabbed pane:
Swing Containers page of the Component Palette, click the JTabbedPane component. To work with a panel that is not currently the top most tab in the Java Visual Editor, click directly on the tab. When you select tab, you also raise the panel to the top of the stacking order. Alternatively, you can select tab panels by choosing the desired panel in the Structure Window. To view the panels you have added to the tabbed pane, expand the UI folder, expand the dataPanel node, and finally expand the JTabbedPane node to see the list of JPanels.
You can create and manage your container components using the JDeveloper tools.
There are several ways to insert a component from the JDeveloper Component Palette into a UI container you create.
When you visually add a component in the Java Visual Editor, JDeveloper generates an instance variable for the component and adds it to the source code. When you delete a component, the Java Visual Editor deletes the associated lines from the code.
To add a component to your UI using the mouse:
To add a component to your container using only keystokes:
The inserted component appears in the top, lefthand corner of the UI container. You may use the Property Inspector to size and position the inserted component.
To add multiple instances of a component:
Press the Shift key while clicking the component in the Component Palette. You may release the Shift key and the palette will still remain in multiple creation mode.
Click the arrow tool in the Component Palette to turn off multiple object creation.
The Property Inspector window displays the properties of the component selections you make in the Java Visual Editor. Use the Property Inspector window to set the property values at design time for any component in your UI design.
To set a component's properties at design time:
In the Property Inspector toolbar, type the name of the property in the Find text field, and press Enter to display the property in the Inspector. If you entered a partial name or more than one property exists by the same name, you can use the Up or Down arrow buttons to jump to properties matching the entered name.
To set properties for multiple components:
| Note: The Ctrl key causes the selection state of the selected object to be toggled (from either not selected to selected, else from selected to not selected). Using the Shift key to make selections also changes the object's anchor usage:
|
Using either the Ctrl or Shift key, if a control goes from being not selected to selected, it will become the new anchor until the user changes the anchor using the Shift select action.
JDeveloper provides a layout property in the Inspector, in which you can choose a new layout for any container in the Java Visual Editor.
To select a new layout:
JDeveloper does the following:
setLayout. When you drop a component into a container, JDeveloper creates an appropriate constraint object or value for that container's layout manager. JDeveloper automatically inserts this constraint value or object into the constraint property of that component in the Property Inspector. It also adds it to the source code as a parameter of the add() method call in the jbInit() method.
To edit a component's layout constraints:
constraints property in the Property Inspector and click its value field. When working with a null layout manager, there is no constraints property on the children, set the layout constraints on the bounds property instead.
Click the desired toolbar constraint button in the Java Visual Editor and, when available, choose the value from the dropdown list.
Before attempting to select an existing component in your UI, be sure the selection arrow in the Component Palette is depressed. Otherwise, you may accidentally place a component on your UI.
To select a single component, do one of the following:
To select multiple components, hold down the Ctrl key and do one of the following:
| Note: We recommend using the Ctrl key to perform multiple selections because the Shift key changes which of the selected objects is the 'anchor' of the selection. The selection anchor is the object whose property values will be displayed in the Property Inspector; it is also the object to which context menu actions apply (i.e., alignment).As you drag, you surround the components with a rectangle, or "lasso." When this rectangle encloses all the components you want to select, release the mouse button. If necessary, you can then use Ctrl+click to individually add or remove components from the selected group. Hold down the Ctrl key and select the components in the Structure window. |
For many layouts, the layout manager determines the size of the components by constraints, making sizing in the Java Visual Editor have no effect. However, when working with null, XYLayout, or GridBagLayout, you can size components when you first place them in your UI, or you can resize and move components later.
| Note: GridBagLayout currently ignores size on creation, but you can then resize components after creation. |
To size a component as you add it:
To move a component one pixel at a time:
To resize or move a selected component:
When you select a component, sizing handles or nibs appear on the perimeter of the component. For some containers, a move handle appears in the middle of the component.
To resize or move a group of selected components:
When you select a component, sizing handles or nibs appear on the perimeter of the component. For some containers, a move handle appears in the middle of the component.
OR
Click the desired size button in the Java Visual Editor toolbar. Operations which are invalid for the currently selected components appear disabled in the toolbar and context menu.
JDeveloper provides a number of container components for grouping components together so they behave as a single component at design time.
For instance, you might group a row of buttons in a Panel to create a toolbar. Or you could use a container component to create a customized backdrop, status bar, or checkbox group.
When you place components within containers, you create a relationship between the container and the components it contains. Design time operations you perform on the containers, such as moving, copying, or deleting, also affect any components grouped within them.
To group components by placing them into a container:
If you are working in a layout that considers size such as the GridBagLayout, null layout or XYLayout, you can drag to size it.
As you add components, they appear inside the selected container in the Java Visual Editor, and under that container in the Structure window.
| Tip: If you want the components to stay where you put them, change the container's layout to null before adding any components. Otherwise, the size and position of the components will change according to the layout manager used by the container. You can change to a final layout after you finish adding the components. |
JDeveloper lets you modify the order in which components, which have been visually stacked one on top of another, appear in the UI design. The topmost component specified by Z-order is the one which the user sees at runtime by default.
| Note: Although the Java Visual Editor only displays the topmost component in a stack, you can view the Z-order of the stack in the Structure window: the topmost component appears first in the list of nodes, followed by the next component in the stack, and so on. When you change the Z-order, the Structure window is updated to display the new order. |
To change the Z-order of the topmost component:
To change the Z-order of a component that is not visually on top:
JDeveloper supports Cut, Copy, Paste and Delete functionality in the Java Visual Editor. You can perform these operations between files of the same project or different projects.
| Note: When you cut, copy, paste from one file to a file in another project, you may be required to update your project properties on the target project to include additional libraries. If the target project does not define the right libraries for the pasted object, the paste will fail since the Java Visual Editor will not recognize the class of the incoming objects. |
Visual components copied in the Java Visual Editor are not copied to the system clipboard, and cannot be transferred into other applications. Use a screen capture utility to create an image of a control, or copy the source text to use the Java code in another Java development environment.
When you copy a component that has defined event methods, the event listener is copied with the component, but not the event handler. This is because in most cases it's the format of the control, and not the behavior, that you want to copy. If your goal is to copy the control and its behavior to a different Java class file, you need to separately copy the handler: open the file in the Code Editor, locate the handler code, select it, and choose Edit > Copy.
To copy one or more components:
The components are copied to a local clipboard in JDeveloper.
Before you cut your component be sure to paste the previously cut object since cutting the event code will overwrite the contents of the clipboard.
To cut a component from your user interface:
The component is removed from the Java Visual Editor and placed into a local clipboard only accessible by JDeveloper (not to the system clipboard). If you quit JDeveloper without pasting the control into a container, the cut version of the control will be lost.
The cut command is the first step in a cut and paste action. If you just want to remove a component, see Deleting a component, below. Deleting a component removes it without changing the contents of your clipboard. If you get in the habit of using the cut command to remove items permanently, there is a chance that one day you will inadvertently replace something in the clipboard that you would rather have kept.
When you cut a component that has defined event methods, the event listener is cut with the component. The event handler is not removed from the source code, nor is it placed on the clipboard. There are two reasons for this:
To cut an event handler in the Code Editor, locate the handler code, select it, and choose Edit, then Cut.
The components you copy or cut from a JDeveloper Design window can be pasted into any other designable class file.
To paste a component:
The JavaBeans components you paste will add any existing event listener code from the original component to your source code. The event handler code does not get copied or cut with the component: if you want to use the same event handler, you need to copy and paste the handler separately using the Code Editor.
Delete a component when you want to remove it from your Java program without affecting the contents of the clipboard.
To delete a component:
When you delete a JavaBeans component from the Java Visual Editor, the event listener methods, if any, are deleted from the source code, but the event handler methods are not. If you want to remove the event handler methods, you need to delete them in the Code Editor.
The basic parts of a menu are referred to using the following terms:
There are four types of menu component on the Component Palette: a MenuBar, JMenuBar, PopupMenu, and JPopupMenu.
MenuBar or a JMenuBar is attached to the main UI Frame, and appears at the top of the frame. PopupMenu or a JPopupMenu appears when the user right-clicks in your UI. At runtime, popup menus do not appear on the menu bar, instead they are displayed where the user invokes them. All of these controls can be edited in the Property Inspector.
The first MenuBar or JMenuBar control dropped onto the UI container is considered the current menubar for your UI. However, you can create more than one menubar for an application; they are displayed in the Inspector in the frame's MenuBar property. Select a menu from the MenuBar property dropdown list to make it active.
| Note: Menu components are only editable at design time in the Menu Editor, not the Java Visual Editor. The menu bar and its top-level menus display in the Java Visual Editor, but they are not selectable and cannot be edited from there. However, you can always see and select them in the Structure window. To see how the menu looks in your UI, run your application. |
You access the Menu Editor by opening the Java file in the Java Visual Editor, which makes the Structure window visible. Then, in the Structure window, when you click on a menu, menu item, or menu root node, the Menu Editor appears.
There are multiple ways that you work with the Menu Editor to create menus:
For instance, you can type labels directly into the menu component which has the current focus in the Menu Editor as indicated by the highlighted box. Pressing Enter validates the label and lets you type the next menu component label. You can also use the keyboard arrow keys to move the current focus in the Menu Editor to another position in the menu you want to edit. The Esc key changes the focus from anywhere inside a menu to the menu bar.
In addition to labels that you specify, you can insert various menu components either through the Menu Editor toolbar or the commands duplicated by right-clicking on a menu component. These operations are supported by the toolbar and context menu:
Additionally, you can rearrange entire menus or single menu items using drag and drop operations by clicking along the menus in the menu bar or inside the menus in their menu items.
JDeveloper synchronizes your changes as you work. As you edit menu items in the Menu Editor, all changes are reflected in the source code by the Code Editor and the Property Inspector. When you make changes to the menus in the source code or the Property Inspector, those changes are reflected in the Menu Editor.
For example, when you add a Menu to a MenuBar component, this Menu appears in the Structure window as a child of the MenuBar. Also, when you change properties for Menu or MenuItem (like text or enabled), those changes are reflected in the code, Menu Editor, and Property Inspector.
Since JDeveloper also maintains synchronization with the Code Editor, there is no need to save your menu design manually. JDeveloper generates the code which you can view and edit in the Code Editor as you use the Menu Editor. The generated code is saved when you save your Java source file. The next time you open the Java file and select a MenuBar component in the Structure window, the Menu Editor will open and reload everything for that component.
Once you add a menu component to the UI design, you can use the Menu Editor to design the menu structure. To activate the menus in the user interface, you must use the Property Inspector to attach the menu items to events, or enter the code manually in the Code Editor.
Since a non-popup menu can only be attached to container, such as a JFrame or a JDialog, you must first open or a container file. You can open one in one of the following ways:
To add a menu component to the UI:
You can choose either a menu bar or a popup menu.
Alternatively, you can open a file that already contains a menu component.
At this point, nothing is visible on the UI. The added menu component is displayed in the Structure window and opens in the Menu Editor.
Popup menus can be created so they open on a particular UI container. You add the popup menu to the container and create an event handler to specify the user's action that triggers the popup.
To add a popup menu:
panel1 was selected. MouseClicked event was selected and the name panel1_mouseClicked entered. Example 20-2 Event Handler Stub
Submenus can appear on menus to provide additional, related commands. Such nested lists are displayed with the menu text followed by an arrow. JDeveloper supports as many levels of submenus as you want to build into your menu.
Organizing your menu structure with submenus can save vertical screen space. However, for optimal design purposes you probably want to use no more than two or three menu levels in your UI design.
When you move a menu off the menu bar into another menu, it becomes a submenu. Similarly, if you move a menu into an existing submenu, it forms another submenu under the submenu.
To create a submenu:
Alternatively, you can create a submenu by selecting the menu item and pressing Ctrl and the right arrow key.
Use the JDeveloper Menu Editor to customize and manage your menu items.
When you first open the Menu Editor, it displays the menu bar or popup menu that you opened with any defined menu items. There is also a blank menu to the right of the last menu in the menubar and a placeholder at the end of each menu, indicated by a dotted rectangle.
To add menu items to an existing menu:
As you start to type, the highlighted dotted rectangle changes to a normal text edit field containing a cursor. The text field will scroll as you type to accommodate labels longer than the edit field.
The width of the list expands if necessary to display all the labels in the list, and a placeholder for the next menu item is automatically selected.
In addition to directly selecting items in the Menu Editor, you can use the arrow keys to move from the menu bar into a menu, and to move between items in the list; press Enter to complete an action.
You can prevent users from accessing certain menu commands based on current program conditions without removing the command from the menu. For example, if no text is currently selected in a document, the Cut, Copy, and Delete items on the Edit menu are disabled and are displayed dimmed.
Use the enabled property to disable a menu item. As with most properties, you can specify an initial value for enabled using the Inspector. The default enabled state of a menu item is True; this may change when an event occurs.
To disable a menu item:
false. In contrast to the visible property, the enabled property leaves the item visible. A value of false dims the menu item.
Accelerators enable the user to perform an action without accessing the menu directly by typing in an accelerator key combination. For example, a commonly used accelerator for File > Save is Ctrl+S.
To specify an accelerator for a menu item:
accelerator property from the Model section, and choose KeyStroke from the dropdown menu. Use the accelerator dialog to supply the key combination. A separator bar inserts a line between menu items and between sibling menu components, including menu items and submenus. You can use separator bars to indicate groupings within the menus.
To insert a separator bar on a menu:
The separator bar is inserted above the selected menu item.
Using the right-click menu to insert the separator will result in the line addSeparator() to be generated, whereas using the hyphen for the label will use the more memory intensive creation of an additional class member whose label is a hyphen.
To make a menu item checkable, you need to change the menu item from a regular MenuItem component to a CheckboxMenuItem. A CheckboxMenuItem has a State property (boolean) that allows an event-handler to determine how the associated event, or behavior, should be executed.
state property for a checked menu item is set to true. state property for an unchecked menu item is set to false. To change a regular menu item to a CheckboxMenuItem:
To insert a new, blank menu or menu item, place the cursor on an existing menu item and right-click and choose Insert (Menu or Menu Item).
Menus are inserted to the left of the selected item on the menu bar, and menu items are inserted above the selected item in the menu.
To delete a menu item, select the menu item and press the Delete key.
| Note: A default placeholder (which you cannot delete) appears after the last menu on the menu bar and below the last item on a menu. This placeholder does not appear in your menu at runtime. |
In the Menu Editor, you can move menus and menu items by dragging and dropping them. When you move a menu item with submenu items, the submenu items move as well.
You can move menu items and submenu items:
You move entire menus along the menu bar.
To move a menu item:
If you are dragging the menu item to another menu, drag it along the menu bar until the cursor points to the new menu.This action causes the menu to open, enabling you to drag the item to its new location.
To move a menu:
Use UI design tools in JDeveloper to attach event handler code to component and menu events.
In building your Java program, you can think of your code as being divided into two categories: initialization code and event-handling code.
button1.setLabel("OK") method call because you set the label property of a button, using the Inspector, to "OK". Your entire program consists of the initialization code, which says how things should look when they first appear, and the event-handling code, which says what should happen in response to user input.
There are some JDeveloper components, such as dialogs, which normally appear only when event-handling code is executed. For example, a dialog isn't part of the UI surface you are designing in the Java Visual Editor; instead it is a separate piece of UI which appears transiently as a result of a user selecting a menu item or pressing a button. Therefore, some of the code associated with using the dialog, such as a call to its show() method, might be placed into an event-handling method.
In Swing, a menu item has actionPerformed events and CheckboxMenuItems have itemStateChanged events. Code that you add to the actionPerformed event for a menu item is executed whenever the user chooses that menu item or uses its accelerator keys.
To add code to a menu item's event:
When you enter a name in the event value field, JDeveloper open the Code Editor and displays the source code in the Structure window. The cursor is positioned in the body of the newly created event-handling method, ready for you to enter code.
Using the Events page of the Inspector, you can attach handlers to component events and delete existing event handlers.
To attach event-handling code to a component event:
JDeveloper creates an event handler with the new name and switches to that event handler in the source code. JDeveloper also inserts some additional code into your class, called an Adapter, to make the connection from the event to your event handling method.
| Note: To find out what methods and events a component supports, right-click that component in the Code Editor and choose Go to Declaration to open the class in the Code Editor. You can also right-click the component and choose Browse Javadoc to view the documentation for that class. |
To quickly create an event handler for a component's default event:
| Note: The default event is defined by beanInfo, or asactionPerformed if none was specified. |
Use JDeveloper's UI design tools to create an applet class and applet HTML file. You can also convert any HTML files that contain applets to a format that can be used with the Java Plug-in.
In JDeveloper, you can easily create a skeleton Java applet and then edit it with the Code Editor.
To create a Java applet:
This will open the Create Applet dialog that will create the applet for you based on information you specify, including the name, package and class it extends.
When you are finished, you will have a skeleton.java file containing the applet class, based on the details you entered. You can edit this file in the Code Editor. Using JDeveloper you will also be able to embed your applet within an HTML page, which you can create with the Applet HTML File wizard. You can also run the applet standalone in order to test it from JDeveloper.
In JDeveloper, you can easily create a Java applet HTML file that acts as a container for your applet.
To create a Java applet HTML file:
The Applet HTML File wizard will create the file for you based on information you specify, including the file location, code attributes, positioning attributes, and applet parameters. You can also create an optional deployment profile.
JDeveloper includes the Java Plug-in HTML Converter; it can convert any HTML files that contain applets to a format that can be used with the Java Plug-in.
To convert HTML files that contain applets:
This plug-in places copies of your original files in the backup folder and converts all the files you specified in their original location. Once you have run the converter, your files will be setup to use the Java Plug-in.
Deploying your applet, or any other Java EE web modules in Oracle Application Server with JDeveloper is a completely automated process.
A standalone applet is packaged as a web archive (WAR) file which contains the applet, the Applet HTML file, as well as the standard Java EE web deployment descriptor, web.xml and possibly target-specific deployment descriptors, as well. After you have created the deployment profile and the appropriate deployment descriptor files, you can deploy the application to an application server, or as an archive file.
To configure a web application for deployment:
A profile may have already been created for your project. If you wish to deploy to multiple targets, create a separate profile for each.
web.xml deployment descriptor to your project, if it is not already present. Normally, this file is created with the WAR file deployment profile.
| Notes: If you encounter problems when deploying a Swing applet (JApplet), for example, the error "Class not found" is displayed, this may indicate that JDeveloper cannot locate the Swing libraries. Your clients may need to use Sun's Java SE browser plugin or bundle the Swing libraries for JVMs version 1.1 with your applet.Deployed applet files must reside in a separate location from any other web application files you have deployed. |
You can deploy web application components including applets as a WAR or EAR file to the target application server.
To deploy an applet as a WAR file:
| Notes: The deployed applet files must reside in a separate location from any other web application files you have deployed.If you encounter problems when deploying a Swing applet (JApplet), for example, the error "Class not found" is displayed, this may indicate that JDeveloper cannot locate the Swing libraries. You may need to force your clients to use Sun's Java SE browser plugin or bundle the Swing libraries for JVMs version 1.1 with your applet. |
In addition to JDeveloper's standard Java and PL/SQL debugger facilities, JDeveloper also provides support for debugging graphical user interfaces (GUIs) specifically for AWT and Swing-based client applications and applets.
The UI Debugger offers an alternative way of debugging a GUI application. Traditional debuggers let you examine the data structure and track program flow. Instead, the UI Debugger lets you examine the GUI structure and the event sequences. The UI debugger helps you to see the relationship between UI components displayed on the screen with the actual data. It will also show you the events that are fired by the UI components, and the listeners that receive the events.
To use the UI Debugger, you need to first download it by choosing Help > Check for Updates and following the instructions in the wizard. For more information on how to install an Oracle JDeveloper Extension, see the Oracle Fusion Middleware Installation Guide for Oracle JDeveloper.
There are no additional special prerequisites for the using the UI Debugger beyond those requirements for using the JDeveloper debugger, other than ensuring that the JDeveloper Runtime library, jdev-remote.jar, is selected in the Project Properties - Libraries page.
Debugging a GUI application can be a challenge since most traditional debuggers do not let you easily examine the tree structure of a GUI application, nor do they display the details of what is displayed by your application.
To start debugging, select a project and choose Run > UI Debug <projectname>.jpr to start debugging.
You can use the UI Debugger features which are exposed in JDeveloper via three dockable windows. The UI Tree and the UI Outline windows appear automatically when the UI Debugger is started. The Events window appears the first time you track events. You can toggle all three windows by choosing View > UI Debugger - <UI_debugger_window>.
| Note: No information is displayed in the UI Debugger windows until you take a snapshot. Click the Snapshot (F5) button to populate the UI Tree and the UI Outline windows. |
| Note: Since AWT components may not be painted correctly, Oracle recommends that you work in Outline mode for non-Swing based applications. |
Before performing any UI Debugger task, you'll need to first start the UI Debugger.
To start the UI debugger:
JDeveloper starts the UI Debugger. The application is launched and the UI Tree and UI Outline windows automatically appear. However, no information is displayed in the UI Debugger windows yet.
JDeveloper displays a hierarchical structure of the application in the UI Tree window and displays a graphical representation of the application's user interface in the UI Outline window.
The information in the UI Tree and the UI Outline windows and the relationship between them are always synchronized. Since the information in the UI Tree and the UI Outline windows is identical (only the way they are presented is different), whenever you select a component in the UI Tree hierarchy, JDeveloper locates and highlights the same object in the UI Outline window, and vice versa.
Before examining the application component hierarchy, you must start the UI Debugger and take a snapshot. Whenever the UI of the application is updated, you must click Snapshot again to update the information displayed by the UI Debugger windows.
Ways to examine the application component hierarchy:
To examine the data associated to a component, you can choose to watch the component in the JDeveloper Watches window. A watch enables you to monitor the changing values of variables or expressions as your program runs.
To display component information in the Watches window:
The Watches window opens as a tab in the Smart Data window (if it is not already open), and a tree representing the component's structure is displayed in it.
You can view the state of a UI component in a JDeveloper Inspector window.
To display a UI component in an Inspector window:
The Inspect window opens as a tab in the Smart Data window (if it is not already open), and a tree representing the component's structure is displayed in it.
Use the event tracing feature to monitor the firing of selected events generated by UI components. Use this information to determine the content of events, and their sequence.
To trace events generated by components:
The Trace Events dialog opens, displaying a list of the listeners that receive the event types fired by the component.
| Note: Event listeners are listed only for UI components that were visible when the snapshot was taken. If subsequent execution have added or removed UI components, the change will not be seen in the list. |
FocusListener, all focus events will be traced. Use the show listeners feature to find the recipients of events fired by UI components. Use this information to determine the extent of UI events.
| Caution: Event listeners are listed only for UI components that were visible when the snapshot was taken. If subsequent execution have added or removed UI components, the change will not be seen in the list. |
To trace events generated by components:
The Listeners dialog opens for the selected component, displaying a list of listener types informed by the component, the classes of the registered listeners for each listener type, and the event methods implemented by each class.
| Note: The debugger's tracing filter is applied to the listener's list. A listener whose class is excluded by the filter will not be shown. |
An edit window opens, showing the source code for the selected method.
JDeveloper supports remote debugging GUI applications via the command line. To achieve this, you must manually launch the program you want to debug. Once the program is launched and the JDeveloper debugger is attached to it, remote debugging is very similar to local debugging.
Performing remote UI debugging is similar to remote debugging any application. Just make sure that the following requirements are met first:
jdev-remote.jar, to the libraries To remote debug GUI applications:
where
...\jdev\lib\jdev-remote.jar is the JDeveloper Runtime Library classpath which you must add to the command. oracle.jdevimpl.runner.uidebug.debuggee.Debuggee is the name of the main class of the UI Debugger's agent. -uidport,<port> before the application's main class as follows: In this case, you will also have to specify the port number when you start the UI Debugger in the JDeveloper IDE.
To Start JDeveloper IDE for Remote UI Debugging:
The main method of your Java application is started.
Unless you have used the -uidport option, you should leave this value to the default 4030.
The list of events that can be tracked by the UI Debugger is not hard-coded but is dynamically discovered at runtime. It is therefore possible to track events fired by any listener, provided that they adhere to the following guidelines:
Listener. void. java.util.EventListener. add or remove. void. toString() method. Examples
Xxx, your component must have methods with the following signatures: XxxEvent class could be: This part describes how to use Oracle JDeveloper diagrams and related diagramming tools and technologies to model the various components of your application.
This chapter introduces you to the modeling features.
This chapter walks you through how to use and manage your diagrams.
This chapter details the modeling features related to your Java EE application modeling.
This chapter describes how to get started modeling your applications, and various application sub-systems, and databases using the diagrams and related diagramming tools and technologies included in Oracle JDeveloper.
This chapter includes the following sections:
JDeveloper supports four standard UML diagrams types, and four additional diagram types to model and collaborate the software and systems development for your applications. You can use the diagrams in JDeveloper to model your typical business applications, including custom applications.
JDeveloper provides New Gallery wizards to create the diagrams for your modeling projects. You can easily create any of these diagrams and related UML and non-uml components using the New Gallery wizards. Select File > New > General > Diagrams from the Menu bar.
Select your diagram type then double-click, or click OK to start the wizard. The wizard lets you choose the package for your new diagram, as well as select the optional components you want available for that diagram. The component selection feature enables you to choose the diagram-related components you want to show up in the Component Palette while you are editing your diagram. Figure Figure 21-1 shows an example create diagram dialog for a class diagram.
Choose from a variety of different tools, elements, and UML-compliant objects to model your application systems on the diagrams, for example, those available in the Component Palette for a typical class diagram, as shown in Figure 21-2.
JDeveloper offers four standard UML diagram types to model your Java classes. You can use all of the standard UML objects, and class and diagram transformation features for UML to easily transform classes to online and offline database objects, or vice-versa. For more information, see Chapter 22, "How to Transform UML and Offline Databases".
Available UML diagram types include the following:
You can model your business services and entities and their relationships in your applications using both regular and UML objects. Using JDeveloper transformation features for UML objects, you can transform online or offline database tables to classes, or classes to database tables. All of these objects can be modeled on any of the following four diagrams:
You can configure the settings of a JDeveloper project to specify the root locations of the package hierarchies for modeled elements available to that project. The model path is configured by default. Change it if you want to include model element files to your model that are stored somewhere else, or to store new model element files somewhere else.
Modeled elements can be shared between projects by adding their file system location to the model path for a project.
To set the model path for a project:
This chapter describes how to create and manage diagrams using the latest tools and technologies included in Oracle JDeveloper.
This chapter includes the following sections:
Oracle JDeveloper provides you with a wide range of tools and diagram choices to model your application systems. There are handy wizards to walk you through creating your diagrams and elements, as well as a Component Palette and Property Inspector to make it easy to drag and drop, and to edit a variety of elements without leaving your editing window. In addition that are four UML diagram options, including features to create, manage and transform your classes to UML and UML to classes, as well as XMI import and export capabilities.
Figure 22-1 shows the diagram editor window, with a class diagram, as well as the Application Navigator and Component Palette. You can open diagrams by double-clicking them in the Navigator, and once open, drop-and-drag components onto the diagram editor. Notice the standard formatting icons at the top of the editor, such as color, font, and zooming features.
You can perform many of the basic diagramming tasks and commands in a few clicks using JDeveloper menu options. Diagram files contain graphical properties such as positions, sizes and colors. The visual elements are generally stored in separate files. Changes you make to the diagram updates all related files. To ensure these are consistent, select File > Save All.
To create a new diagram:
To publish a diagram as a image:
Or
Click on the surface of the diagram that you want to publish as an image, then choose Diagram > Publish Diagram.
To rename a diagram:
To set up the page before printing:
To set the area of the diagram to print:
To clear a previously set print area:
To see a preview of the page before printing:
To delete a diagram:
You can also delete a diagram from the Application Navigator. In the Application Navigator, right-click on the diagram name and choose Delete.
To Zoom In and Out of a Diagram:
Use Ctrl+scroll to zoom in and out of diagrams. When using the thumbnail view, use scroll to zoom.
To display the diagram at original size:
In the zoom drop-down list, located on the diagram toolbar, choose 100%, or click the diagram, then choose Diagram > Zoom > 100%.
To display the entire diagram:
In the zoom drop-down list, located on diagram toolbar, choose Fit to Window, or click the diagram, then choose Diagram > Zoom > Fit to Window.
To display the selected elements at the maximum size:
In the zoom drop-down list, located on the diagram toolbar, choose Zoom to Selected, or click the diagram, then choose Diagram > Zoom > Zoom to Selected.
Use nodes and elements to represent the various elements and related resources of your system architecture.
A node is shape on a diagram.
To create a node on a diagram:
Or
Click and hold down the mouse button where you want to place one of the corners of the node and drag the node outline to the opposite node corner and release the mouse button.
Or
Complete the wizard.
| Note: To add properties to nodes on a diagram, double-click the node or right-click the node and choose Properties. Then add the properties using a dialog or editor. You can also create the property on the diagram using in-place creation. |
Nodes for certain elements can also be created inside other nodes.
To Create Internal Nodes on a Diagram Element:
Elements can be represented on a diagram as internal nodes on other diagram elements.
Internal nodes can be used to create the following:
Figure 22-2 Symbolic Diagram Class View

Figure 22-3 Expanded Diagram Class View Showing Internal Nodes

To create an internal node on a diagram element:
To change the way nodes are shown on a diagram:
Select the diagram element(s) and choose one of the following:
To connect two nodes on a diagram:
Relationships between node elements are identified using connectors. A connector is the end point of a diagram edge.
To optimize the size of nodes on a diagram:
There are many options available for changing the properties on your diagrams and managing the elements.
To select all elements of the same type:
To select all elements on the active diagram:
Choose Edit > Select All.
To select specific diagram elements on the active diagram:
Press and hold down the Ctrl key, then click the elements on the diagram to select.
To select all elements in a given area of the active diagram:
To deselect a selected element in a group of selected elements:
To group elements on a diagram:
To manage grouped elements on a diagram:
Use the Manage Group feature to move elements in and out of groups, move elements to other groups, or move groups in and out of other groups.
You can also move elements in and out of groups by Shift+dragging the element to the desired position.
To display related elements on a diagram:
Select the diagram item, then choose Diagram > Show Related Elements.
Or
Right-click the diagram item, then choose Show Related Elements.
To change the properties of a diagram element using the Properties dialog:
Open the Properties dialog in one of the following ways:
Or
To change certain properties of a diagram using in-place creation and editing:
You can create new secondary elements directly and change properties in place on modeled diagram elements.
To change the properties of diagram elements using the Property Inspector:
| Note: These options are not all valid for all elements. |
You can toggle the diagram display between symbolic mode, where all elements are displayed, and compact mode, where only basic information about the element is displayed.
To find an element on a diagram:
Click on the element name in the structure pane. The element is selected in the diagram. You can also use the thumbnail view of the diagram to find an element. To display a thumbnail view of a diagram, select the diagram either in the navigator or by clicking on the background of the diagram, then choose View > Thumbnail. You can grab the view area box and move it over elements on the thumbnail view of the diagram. The corresponding elements are brought into view on the main diagram.
To change the color or font of one or more elements that are already on a diagram:
Or
On the tool bar, select the font type, font size, or color box, then make the required change.
Or
Choose Visual Properties from the context menu, then make the required change.
To change the color or font of diagram elements to be added to a diagram:
To copy the diagram graphical options of fill color, font, font color, and line color to one or more elements:
To copy elements from a diagram and paste them into another diagram:
To copy elements from a diagram and paste them into another application:
Resize an element by dragging the grab bars until the item is the size you want. Some diagram elements cannot be resized, such as initial and final pseudo states.
Certain element types also have internal grab bars, that are displayed when an element is selected. These internal grab bars are for resizing the compartments of those diagram elements.
Whenever a diagram element is resized or moved towards the visible edge of the diagram, the diagram automatically scrolled. New diagram pages are added where an element is resized or moved off the diagram surface.
Dragging selected diagram elements on the diagram surface is the easiest way of moving elements incrementally on a diagram. To move elements over a larger diagrams, cut and paste them using the clipboard.
To resize a diagram element:
To move diagram elements:
A diagram element can be removed from the current diagram without removing the file, or files where that element is stored. It can also be removed from the file system.
Diagram nodes and inner elements are removed the following ways:
To remove an element from a diagram:
To bring elements to the front or back of a diagram:
Right-click the diagram element and choose Bring to Front or Send to Back.
You can undo and redo your most recent graphical actions. Graphical actions change the appearance of elements on the diagram surface and include the following:
Any change to a diagram element that is not graphical, such as changing the properties of that element, cannot be undone. Changing the properties of an element also prevents any previous graphical changes from being undone.
To undo the last graphical action on a diagram:
Choose Edit >Undo [...] or click the undo icon.
To redo a previously undone graphical action on a diagram:
Choose Edit > Redo [...] or click the redo icon.
You can create UML elements without having to create any type of UML diagram in the New Gallery. The UML elements that you create in the New Gallery are listed in the navigator and can be dropped onto your diagrams.
To create a UML element using the New Gallery:
A note or annotation is a graphical object on a diagram containing textual information. Notes are used for adding comments to a diagram or the elements on a diagram. A note can be attached to one or more elements. A note is stored as part of the current diagram, not as a separate file system element. Note options are available in the Component Palette, as shown in Figure 22-5.
To add a note to a diagram:
Or
To create the note at a different size, click the diagram, drag the note box to the desired size, and release the mouse button.
To attach a note to an element on a diagram:
To change the font size, color, bolding, or italics on an element:
Change the way your diagram is shown by right-clicking an element, or using the many options available under Tools > Preferences for diagrams.
Choose to hide a single connector or any number of connectors on your diagrams. Connectors that are hidden on a diagram continue to show in the Structure window, with 'hidden' appended. If there are any hidden connectors, you can bring them back into view individually or all at once.
To hide one or more connectors on a diagram:
You can also go to the Structure window, select the connector or connectors to hide, right-click and choose Hide Shapes.
To show one or more connectors that are hidden on a diagram:
In the Structure window, select the connector or connectors to show, right-click and choose Show Hidden Shapes.
To show all hidden connectors on a diagram:
Right-click any part of the diagram and choose Show All Hidden Edges .
To list all hidden connectors together in the Structure window:
Right-click an object listed in the Structure window and choose Order By Visibility.
You can display or hide page breaks on your diagrams. Page breaks are displayed as dashed lines on the diagram surface.
To display page breaks on new diagrams:
Connectors are laid out in oblique or rectilinear line styles.
Oblique lines can be repositioned at any angle. Rectilinear lines are always shown as a series of right angles. If the line style for a diagram is set to oblique, you can subsequently move the line (or portions of it) into a new position at any angle.
You can set the default line style for each type of connector element on a diagram. ("Line style" is one of the diagram preferences that you can set for each type of element that is a connector.)
You can also set the line style for a particular diagram, overriding the default line style for the diagram type:
Whatever the line style for a drawing, you can select individual lines on the drawing and change their line style. If you change an individual line from oblique to rectilinear, the line will be redrawn using right angles. If you change an individual line from rectilinear to oblique, no change will be made to the line, but you can subsequently reposition it (or portions of it) at any angle.
There is an option to straighten all lines that are already on a diagram. If you choose this option, all lines will be redrawn along the shortest route between their start and end points, using diagonal lines if necessary. Using this option will also set the line style for the current diagram to oblique. After this, setting the line style for the diagram back to rectilinear will redraw all the lines at right angles.
You can also choose the crossing styles for your lines to be bridge or tunnel style. Selecting bridge style creates two parallel lines where the lines intersect. Selecting tunnel style creates a semi-circle shape on the intersection. The default style is a regular crossing over of the two lines where the lines intersect.
To set the default line style for a diagram (or for an element type that is a connector):
To change the line style for particular connectors on the current diagram:
With the connector or connectors selected on the diagram, choose Diagram > Line Style, then either Oblique or Rectilinear.
To add a new elbow to a connector:
Shift+click on the connector where you want to create a new elbow. (New elbows can be added and used to change the route of a connector only if the line style is set to oblique.)
To remove an elbow from a connector:
Shift+click the elbow that you want to remove.
To straighten connectors:
Select the connector or connectors that you want to straighten on a diagram, then choose Diagram > Straighten Lines. (This will remove all intermediate elbows.)
To change the crossing style of all lines:
Select Tools > Preferences > Diagrams > Crossing Style. You can also change the crossing style in the Property Inspector for that diagram. The default style is a regular crossing over of the two lines where the lines intersect.
There are a number of ways to change the layout of a diagram. These include applying a layout style to any or all of the elements on a diagram, changing the height of nodes on a diagram so that they display all the properties of those elements, and aligning and distributing elements.
Diagrams can be laid out according to one of the predefined styles: Hierarchical, Symmetrical, Grid, and Row.
You can lay out diagrams, or just selected diagram elements according to one of several layout styles, depending on your requirements: hierarchical (top to bottom, bottom to top, left to right, right to left), symmetric, grid, orthogonal, and row.
This lays out the diagram elements in hierarchies based on generalization structures and other connectors with a defined direction. Connectors between the nodes are laid out using the most direct route. Nodes on a diagram that are not connected to any other nodes are laid out in a grid layout. Hierarchical layout is available in four orientations: top to bottom, bottom to top, left to right and right to left.
Figure 22-6 Hierarchical UML Diagram Layout

This lays out the diagram elements in the most symmetrical way based on the connectors between the nodes. Under certain circumstances, a symmetrical layout will position nodes in a radial layout around a central node. Nodes on a diagram that are not connected to any other nodes are laid out in a grid layout.
Figure 22-7 Symmetrical Diagram Layout

Orthogonal diagrams show hierarchical and non-hierarchical elements where the aligned edges of a component all follow the same direction. For UML class diagrams, a layout is created which represents each generalization hierarchy in an aligned fashion.
Figure 22-8 Orthogonal UML Diagram Layout

This lays out the diagram elements in a grid pattern with nodes laid out in straight lines either in rows from left to right, or in columns from top to bottom. Nodes are laid out in the grid pattern starting with the top left node.
Figure 22-9 Grid Diagram Layout

Diagram elements that are created or moved on a diagram can be automatically 'snapped' to the grid lines that are nearest to them, even if the grid is not displayed on the diagram. Grid cells on the diagram are square, so only one value is required to change both the height and width of the grid cells. By default, elements are not snapped to the grid on activity diagrams.
To define diagram grid display and behavior for the current diagram:
To define diagram grid display and behavior for new diagrams:
You can align elements both vertically and horizontally on your diagrams. You can also change the location of elements so that they have equal vertical and horizontal spacing.
When you are distributing elements, the outermost selected elements on the vertical and horizontal axes are used as the boundaries. To fine tune the distribution, move the outermost elements in the selection, then redistribute the element.
To align and size elements on a diagram:
To distribute elements on a diagram:
Layout styles are available by opening the context menu for a diagram and choosing Lay Out Shapes, or by using the Diagram Layout Options Dropdown as shown in Figure 22-10,
To layout elements on a diagram:
After the selected elements have been laid out they remain selected to be moved together to any position on the diagram.
To set the layout for new elements on the current diagram:
In the Property Inspector (View > Property Inspector), select the layout style.
To set the default layout of elements on a diagram:
JDeveloper supports UML transformations on your Java classes and interfaces as well as XMI import and export features. You can use these transformation features to produce a platform-specific model like Java from a platform-independent model like UML. You can perform transformations multiple times using the same source and target models. There are also some reverse transforms to UML from Java classes. You can do transformations on individual or groups of UML objects, classes, and interfaces in the following ways:
To transform UML, Java classes, or interfaces:
You can use the UML modeling tools to create a UML Class model, and to then transform it to an offline database or vice-versa.
To transform a UML class diagram to an offline database:
To transform offline database objects to UML
To create offline database objects from UML using the New Gallery Wizard:
If the category or item is not found, make sure the correct project is selected, and select All Features in the Filter By dropdown list.
When you invoke the wizard from the New Gallery, the offline database objects are only available in the Application Navigator.
During transformation you have the following choices:
To choose the type of transformation messages to log:
You have the option of reviewing the changes before running the transform. In addition, you can specify the types of transformation messages to be logged, and whether they appear in the Log Window or are sent to a log file.
Transformation generalization
There are four types of generalization to specify on the Set Class Options page on the Offline Database Objects from UML Class Model Wizard.
The options are:
Consider the case of two root classes and three leaf classes, as shown in Figure 22-15.
If you select the option Transform Root Classes, root classes are transformed into offline tables, and all the columns and foreign keys from their descendant classes in the hierarchy are also transformed as shown in Figure 22-16. You also have an option of creating a discriminator column. The discriminator column contains marker values for the persistence layer to decipher what subclass to instantiate for a particular row.
If you select the option Transform only leaf classes, inheriting from generalized classes, leaf classes are transformed into offline tables, and they inherit their columns and foreign keys from their ancestor classes, as shown in Figure 22-17.
If you select the option Transform all classes, inheriting from generalized classes, an offline table is created for every class in the transform set. Each table inherits columns and foreign keys from its ancestor tables but is otherwise independent, as shown in example Figure 22-18.
If you select the Transform all classes, creating foreign keys option to generalized classes, an offline table is created for every class in the transform set. No columns or foreign keys are inherited; a foreign key is created to the parent table or tables, as shown in Figure 22-19.
UML models created using other modeling software can be imported into JDeveloper using XML Metadata Interchange (XMI) if the models are UML 2.1.1 compliant.
The XMI specification describes how to use the metamodel to transform UML models as XML documents. JDeveloper complies with the specification. For more information see the "Catalog of OMG Modeling and Metadata Specification" at http://www.omg.org/technology/documents/modeling_spec_catalog.html.
The following are restrictions that apply to import processes:
Diagrams can be automatically created when you import classes, activity, sequence, and use case elements. The dialog will offer you this option during the process, as shown in Figure 22-21.
To import UML model as XMI:
Figure 22-20 Import Choose UML from XMI Dialog

To export UML model as XMI:
Figure 22-22 Export Choose UML as XMI Dialog

There are some typical errors and warnings that you can encounter in your XMI Import Log during import. Many of these can be easily resolved with a few simple steps.
As with other XML, the structure of a valid file is specified by an XML schema which are referenced by xmlns namespaces. The XML consists of elements that represent objects or the values of their parent element object and attributes that are values. Sometimes the values are references to other objects that may be represented as an href as for HTML. Double clicking on the items in the log navigates to the problem element. Often issues arise because of incorrect namespaces and standard object references.
The following are typical error messages, and how to resolve them:
Missing Profile
In UML there is an extension mechanism that allows further XML schemas to be specified in a 'profile'. The first three problems above indicate that a relevant profile has not been registered. To register a profile see, Chapter 22, "How to Work with UML Profiles".
Invalid XMI Version
This message occurs because there is a mismatch between the xmi:version attribute and the xmlns:xmi namespace. The xmi:version should be 2.1.
Invalid UML Namespace
This message occurs because the xmlns:uml namespace should be http://schema.omg.org/spec/UML/2.1.1/uml.xml.
Invalid Standard L2 Profile Namespace
This case is when a standard profile is already registered with the tool. Change the XMI so that the xmlns namespace is http://schema.omg.org/spec/UML/2.1.1/StandardProfileL2.xmi and the reference is http://schema.omg.org/spec/UML/2.1.1/StandardProfileL2.xmi#_0.
Invalid Standard L3 Profile Namespace
There is a second standard profile already registered. If the profile is incorrectly referenced the messages will be similar to the L2 Profile Namespace. The correct namespace is http://schema.omg.org/spec/UML/2.1.1/StandardProfileL3.xmi and the correct reference is http://schema.omg.org/spec/UML/2.1.1/StandardProfileL3.xmi#_0.
Invalid Standard Data Type Reference
There is a standard set of data types to reference and resolve this error, such as attribute type. The XMI href should be updated to one of the following:
UML Profiles are subsets of the UML metamodel. These subsets specify well-formedness rules beyond those identified in the UML metamodel. Well-formedness rule is a term used in the normative UML metamodel specification to describe a set of constraints written in UML Object Constraint Language (OCL) that contribute to the definition of a metamodel element. JDeveloper comes with a handful of standard profiles for UML.
You can add your own profile by going to Tools > Preferences > UML > Profiles, and clicking the add symbol, as shown on Figure 22-23. Once you have added a custom profile, edit the document URL by selecting the profile and clicking Edit. For more information on UML Profiles, see the OMG Catalog at, http://www.omg.org/technology/documents/profile_catalog.html.
Use the UML class diagram to model a collection of static elements such as classes and types, their contents and relationships, as well as visually create or inspect classes, interfaces, attributes, operations, associations, generalizations and realizations.
You can use the Component Palette to add classes and related elements to your class diagram. Each of the elements is represented by a unique icon and description as shown in Figure 22-24.
To add classes and interfaces to a diagram:
Create classes and interfaces by dragging the class onto the diagram. The element is created in the location specified by the model path in your project settings and default properties. (Application > Default Project Properties). You can also model packages by clicking on the package.
If you right-click a modeled package and choose Drill Down, a diagram is displayed for that package.
To add or edit class properties:
Class properties are added to modeled classes and interfaces on a diagram by doing one of the following:
To add generalizations, realizations, and associations:
Generalized structures are created on a diagram of classes by using the Generalization icon on the Class Component Palette.
Where an interface is realized by a class, model it using the Realization icon on the Class Component Palette for the diagram.
A variety of associations can be created between modeled classes and interfaces using the association icons. Associations are modified by double-clicking the modeled association and changing its properties.
To add nested classes and nested interfaces:
Nested classes and nested interfaces are created either by creating them in the modeled class or interface using in-place create (with symbolic presentation only) and by changing shape display preferences, or by right-clicking the class and choosing View As > Expanded then creating another class inside the expanded node.
To add attributes and operations:
Attributes and operations are added to modeled classes and interfaces by doing any of the following:
The order of an attribute or operation within a class or interface is changed by dragging it up or down on the screen. The Sort Alphabetically property for attributes or operations must be deselected: (Tools >Preferences > Diagrams > Class > Edit Preferences for: Class or Interface | Attributes or Operations | Sort Alphabetically).
To hide one or more attributes or operations:
To show all hidden attributes or operations on a class or interface:
Select the class or interface, then right-click and choose Show All Hidden Members.
Classes are represented as rectangles containing class name and details. Classes can be displayed as compact, symbolic or expanded nodes. To set the display properties go to Tools > Preferences > Diagrams > (Diagram Type) > Display Options.
You can also change the way elements are represented on a diagram. On the diagram, classes and interfaces are divided into compartments, with each compartment containing only one type of information. An ellipsis (...) is displayed in each compartment when not large enough to display its entire contents. To display all the attributes of a modeled class, right-click the class and choose Optimize Shape Height. Figure 22-25 shows an example of a typical class diagram layout.
All attributes and operations display symbols to represent their visibility. The visibility symbols are: + Public, - Private, # Protected, and ~ Package.
Table 22-1 Elements in Class Diagram
| Elements | Description |
|---|---|
| Interface | Interfaces are represented with a keyword in the name compartment: «interface». interfaces can be displayed as compact, standard or expanded nodes. Nested classes and interfaces can be modeled inside standard and expanded interfaces. |
| Enumeration | Enumerations are data types with a finite, and normally small, set of named literals. Enumerations contain sets of named identifiers to represent the values of the enumeration. An enumeration has a name that describes its role in a model. |
| *1 to * Association | One to Many defines a relationship between classes. Represented on the diagram as a solid line. |
| Directed One to One Association | Directed One to One Association is represented on the diagram as a solid line with an open arrowhead in the direction of the association. |
| Directed One to Many Association | Directed One to Many Association is represented on the diagram as a solid line with an open arrowhead in the direction of more than one association. |
| Directed Composite Aggregation | Represented on the diagram as a solid line with an open arrowhead in the direction of the association and a filled diamond shape at the originating end of the association. |
| Generalization | Defines generalization relationships between classes. Represented on the diagram as a solid line with an empty arrowhead pointing towards the specialized class or interface. |
| Realization | Defines where an interface is realized by a class. Represented on the diagram as a dashed line with an empty arrowhead pointing towards the implemented interface. |
| Dependency | Represents where one diagram element depends on another. Represented on the diagram as a dashed line with an open arrowhead in the direction of the dependency. |
| Class | Represents an object. Classes form the main building blocks of an object-oriented application. Represented on the diagram as a rectangle containing three compartments stacked vertically.* |
| Package | Use to divide a system into multiple packages, which can simplify and make the system easier to understand. |
| Data Type | Data types are modeled elements that define your data values. |
| Primitive Type | Primitive types or data types are data types such as boolean, byte, decimal, DateTime, Double Float, and Time. |
| Constraint | Constraints are the degree of freedom, or lack thereof that you have in modeling a system behavior, or solution. |
Operation notation in this release is closely related to the UML2 notation. Previously the notation for an operation in a class diagram followed Java-line syntax.
print(int param1, int param2):void
In this release of JDeveloper, operation notation follows UML2 syntax:
print(param1:int, param2:int):void
If you rename or move a class using the in-place edit functionality on a diagram, the source code for the class is refactored automatically. Renaming or moving a Java package on a diagram automatically refactors the contents of that package.
Deleting a field, method, or inner class on a diagram automatically applies the Delete Safely refactoring pattern. To apply a refactoring pattern to a Java class, interface, enum, or member on a diagram, select the class or member on the diagram and choose the refactoring pattern from the refactoring menu.
The following refactoring patterns are available for the Java classes, interfaces, and enums on a Java class diagram:
The following refactoring patterns are available for the Java fields and methods on a Java class diagram:
There are several automated refactoring operations available that enhance code quality by improving the internal structure of code without altering the external behavior.
To invoke a refactoring operation:
Use activity diagrams to model your business processes. Your business process are coordinated tasks that achieve your business goals such as order processing, shipping, checkout and payment processing flows.
Activity diagrams capture the behavior of a system, showing the coordinated execution of actions, as shown in Figure 22-26.
The Component Palette contains the elements that you can add to your activity diagram. An Activity is the only element that you can place directly on the diagram. You can place the other elements inside an Activity. Each of the elements is represented by unique icons as well as descriptive labels, as shown in Figure 22-27 and Table 22-2.
Table 22-2 Activity Diagram Elements
| Element | Description |
|---|---|
| Action | An action is the fundamental unit of behavior specification, for example, Send Invoice or Receive Payment. It represents a single step within an activity. An action takes a set of inputs and converts them into a set of outputs. The execution of an action represents some transformation or processing in the modeled system. An action may receive inputs in the form of control flows and object flows (the latter via input pins) and passes the results of its processing or transformations to outgoing control flows or object flows (the latter via output pins) and onto downstream nodes. Execution of the action cannot begin until all its prerequisites are satisfied. |
| Activity | A behavior performed by a system, for example a business process. An activity is a behavior defined by its owned actions, object nodes and the flows between them. |
| Activity Final Node | Terminates the execution of the activity when it first receives a control token. There can be multiple final nodes in an activity. An Activity Final Node indicates that every action on this diagram has finished. |
| Fork/Join | Displayed as a vertical or horizontal bar. A Fork is a control node that has a single incoming flow and two or more outgoing flows. A Join is a control node that synchronizes a number of incoming flows into a single outgoing flow. Fork/Join pairs can be combined as a single diagram node. |
| Call Behavior Action | Maps the action inputs and outputs are simply mapped to the behavior parameters as appropriate. |
| Call Operation Action | Transmits an operation call request to the target object, where it may cause the invocation of associated behavior. The behavior results become the action outputs. The argument values of the action are available to the execution of the invoked behavior. |
| Central Buffer | A type of object node. It gives the node the capability of storing (buffering) tokens. It manages the tokens that arrive at incoming flows from one or more object nodes and selects which tokens and in what order these tokens will be presented to the downstream object nodes via the outgoing flows. |
| Control Flow | Shows the flow of control tokens. |
| Data Store | A type of object node that passes a buffer for non-transient data. |
| Flow Final Node | Terminates any incoming flow without terminating the execution of the entire activity. |
| Initial Node | The starting point for executing an activity. It has no incoming flows and one or more outgoing flows. There can be only one initial state on a diagram. |
| Object Flow | Connects object nodes. Object flows can be connected to actions using pins. |
| Merge Node | A merge node has two or more incoming flows and a single outgoing flow. A Decision has one incoming flow and two or more outgoing flows |
To create an activity diagram:
To show a partition on an activity diagram:
To model activities, actions, central buffer nodes, and data store nodes, you need to start with a Activity diagram.
You create partitions on a diagram by selecting an action, then selecting Show Activity Partition under Display Options in the Property Inspector.
Activities are created by first selecting the Activity icon on the Component Palette, then clicking on the diagram where you want to create the activity or action.
An initial node is a starting point for an activity execution. A final node is the termination of execution, either for the activity if an activity final node, or a particular flow if a flow final node.To create, click the Initial Node icon, the Activity Final Node icon, or Final Flow Node icon on the Component Palette, then click on the diagram where you want to place the node.
The sequence diagram describes the interactions among class instances. These interactions are modeled as exchanges of messages. At the core of a sequence diagram are class instances and the messages exchanged between them to show a behavior pattern, as shown in Figure 22-28.
The elements you add from the Component Palette are laid out in a default position on your sequence diagram. Object lifelines are aligned vertically, unless they are related to another object lifeline, in which case they are aligned with the create message. Synchronous and asynchronous messages and are placed in time order down the page.
Figure 22-29 displays the elements in the Component Palette available to use in your sequence diagram. Each element is represented by a unique icon as well as a descriptive label.
Table 22-3 Sequence Diagram Elements
| Element | Description |
|---|---|
| Asynchronous Message | Represented on a diagram by a diagonal line with an open arrowhead. An asynchronous message is one for which the sender does not have to wait for a response before continuing with processing. |
| Creation Message | Represented on a diagram by the shifting down, relative to the originating object, of the rectangle and dashed line that represents the object to be created. A creation message is a message that leads to the creation of an object |
| Interaction | Captures the behavior of a single case by showing the interaction of the objects in the system to accomplish the task. |
| Message | A message is a model element that defines a specific kind of communication between participants in an interaction. A message conveys information from one participant, which is represented by a lifeline, to another participant in an interaction. |
| Object Lifeline | Represented on a diagram by a rectangular box with a vertical dashed line descending beneath it. An object lifeline represents the existence of an object over a period of time |
| Return | A return message is a message that returns from an object to which a message was previously sent. Return messages are valid only from synchronous messages, and are themselves synchronous. |
| Stop or Destroy Message | Represented on a diagram by showing the execution specification at the end of the message with a large cross through it. A stop message is a message that leads to the deletion of an object (or to the indication that an object is no longer needed). |
To create a sequence diagram:
To start the sequence tracer:
On any part of the sequence diagram, open the context menu and choose Trace Sequence. The tracer steps through each of the execution specifications and messages, highlighting each one.
| Note: Trace Sequence is available for a selected Interaction. It does not appear in the context menu for the diagram. |
The sequence diagram elements are added to your diagram by clicking or dragging and dropping from the component palette.
Model your interactions within a system by adding the Interaction component to your diagram. Interactions are a container for the specific elements that comprise the behavior.
You can right-click an Interaction and choose Sequence, then Automatic Layout to autolayout the elements within the Interaction.
You add object lifelines to a sequence diagram by first adding an interaction then clicking on the Object Lifeline icon, and then clicking on the interaction. An edit box opens for you to enter an instance name for the object. This can be left blank for anonymous instances.
You can add a classifier by right-clicking on the object lifeline and choosing Attach Classifier, which opens a list of elements from which you choose the one you want associated with the object lifeline. Another way to attach a classifier is to drag the classifying object from the navigator onto the object lifeline. These methods are confirmed by the appearance (in the top left of the object lifeline) of an icon representing the classifying element.
You add a synchronous message by clicking on the Message icon, then clicking on the vertical dashed line or execution specification that is the starting point for the message, and then on the vertical dashed line that is the destination of the message.
Merge execution specifications by overlapping them on the diagram. Then right-click and choose Merge Overlapping Occurrences.
You can move an execution specification (and the messages attached to it) to a position higher or lower than its original one. In some cases this will result in an invalid diagram. When this happens, the message line will turn red and the destination object will contain an arrow icon which indicates the direction the object should be moved, to make the diagram valid.
To resize an execution specification box, drag the small black box that appears on the lower edge when you select it. An execution specification will be resized if you drag a message line extending from it.
Open an editing box for the text by clicking on the message line and then clicking inside the gray box that appears.
The starting point and destination point of a synchronous message can be the same object lifeline, in which case you have created a self call.
Synchronous messages are depicted on the sequence diagram by solid lines with filled arrowheads.
Add a creation message by clicking on the Creation Message icon, then on the originating object, then on the object to create. The rectangle and dashed line that represents the object is shifted down the page relative to the originating object.
If the object to be created is not already on the diagram, click within the interaction that contains the originating object to create an object lifeline representing the object. By default, a creation message is given the name "create". You can open an edit box for the message name by clicking on the message line and then clicking inside the gray box that appears.
Before you add a stop or destroy message, you must already have added an object lifeline for the object that the message deletes.
Add a stop or destroy message by clicking on the Stop or Destroy Message icon, then on the originating object, then on the object to delete. If you start and end the stop message on the same object, you will create a self-deleting object. The execution specification at the end of a stop message is shown with a large cross through it. You can open an edit box for the message name (for example, close) by clicking on the message line and then clicking inside the gray box that appears.
If you add a stop message earlier in the sequence than other execution specifications, those execution specifications will be not be implementable and will be shown with a warning flag.
Add a return message by clicking on the Return icon, then on an end execution specification, then on the corresponding start execution specification. You will not be able to end this return message line on any other object. The return message is depicted by a dashed line with a filled arrowhead. You can open an edit box for the text of the message by clicking on the message line and then clicking inside the gray box that appears.
Add an asynchronous message (and the execution specifications at each end) by clicking on the Async Message icon, then clicking on the vertical dashed line or execution specification that is the starting point for the message, then on the vertical dashed line that is the destination of the message. You can open an edit box for the text of the message by clicking on the message line and then clicking inside the gray box that appears.
The starting point and destination point of an asynchronous message can be the same object lifeline, in which case you have created a self call.
Asynchronous messages are depicted on the sequence diagram using diagonal lines and open arrowheads.
On your sequence diagram interactions you will see combined fragment lock icons. Locking and unlocking an interaction allows you to keep the combined fragment behavior within that interaction on that diagram, or extend its reach to other interactions and other diagrams.
A combined fragment defines an expression of an interaction defined by an interaction operator and corresponding interaction operands. A Combined Fragment reflects a piece or pieces of interaction (called interaction operands) controlled by an interaction operator, whose corresponding boolean conditions are known as interaction constraints. It displays as a transparent window, divided by horizontal dashed lines for each operand.
Figure 22-30 shows a loop fragment that iterates through purchase items, after the cashier requests payment. At this point, two payment options are considered and an alternative fragment is created, divided to show the two operands: cash and credit card. After the fragment completes its trace, the cashier gives a receipt to the customer, under the fulfilled condition of payment requirements met.
Figure 22-31 shows the combined fragments that display in the Component Palette when your diagram is open in the diagrammer.
Table 22-4 Combined Fragments Interaction Operators
| Interaction Operator | Description |
|---|---|
| alt | Use to divide up interaction fragments based on Boolean conditions. |
| assert | Use to specify the only valid fragment to occur. |
| Break | Use to designate that the combined fragment represents a breaking scenario in the sense that the operand is a scenario that is performed instead of the remainder of the enclosing interaction fragment. |
| Critical | Use to indicate a sequence that cannot be interrupted by other processing. |
| Loop | Use to indicate that the operand repeats a number of times, as specified by interaction constraints. |
| Neg | Use to assert that a fragment is invalid, and implies that all other interaction is valid. |
| Opt | Use to enclose an optional fragment of interaction. |
| Par | Indicate that operands operate in parallel. |
| Seq | Use to indicate that the combined fragment is weakly sequenced. This means that the ordering within operands is maintained, but the ordering between operands is undefined, so long as an occurrence specification of the first operand precedes that of the second operand, if the occurrence specifications are on the same lifeline. |
| Strict | Use to indicate that the behaviors of the operands must be processed in strict sequence. |
Use case diagrams overview the usage requirements for a system. For development purposes, use case diagrams describe the essentials of the actual requirements or workflow of a system or project, as shown in Figure 22-32.
Use case diagrams show how the actors interact with the system by connecting the actors with the use cases with which they are involved. If an actor supplies information, initiates the use case, or receives information as a result of the use case, then there is an association between them.
Figure 22-33 displays the Component Palette with the elements available to add to your use case diagram. Each element is represented by a unique icon and descriptive label.
An Interaction is the only element you can add directly to the diagram. You put all of the other elements within an Interaction.
Table 22-5 Use Case Elements
| Component | Description |
|---|---|
| Actor | Represents an abstract role within a system. |
| Communication | Identifies where an actor is associated with a particular use case. |
| Dependency | Shows a relationship between one element and another. |
| Extend | Shows a target use case extends the definition of a source use case. |
| Generalization | Identifies where one or more elements specialize another element. For example, an actor Team Member could be specialized to actors Manager and Developer. |
| Include | Shows a relationship in a use case that includes another use case. |
| Subject | Two types of subjects are available. One system usually contains sets of use cases and actors that comprise the whole system being modeled. The second type usually contains groups of use cases that comprise a coherent part of the system being developed. |
| Use Case | Indicates that one element requires another to perform some interaction. |
To create a use case diagram:
You can determine the appearance and other attributes for subject, actor and other objects of these types by modifying the properties in the Property Inspector, or by right-clicking the object and modifying the properties, or by creating and customizing an underlying template file.
You can use templates to add the supporting objects to the Component Palette. For more information, see Chapter 22, "How to Work with Use Case Component Palette Templates".
You can show the system being modeled by enclosing all its actors and use cases within a subject. Show development pieces by enclosing groups of use cases within subject lines. Add a subject to a diagram by clicking on Subject in the Component Palette, then drag the pointer to cover the area that you want the subject to occupy. Figure 22-34 shows an accounting subject attached to their related actors. If you drop an element just inside a subject, the subject line expands to enclose the element. You also can manually resize subjects. If you reduce the size and there are elements that can no longer be seen, an ellipsis appears in the lower right corner.
Create actors on a diagram by clicking on the Actor icon on the Component Palette, and then clicking on the diagram where you want to create it.
To change the properties of an actor or use case, double-click on the modeled element and edit the element details in the editor.
You can represent interactions between actors and use cases on a diagram using the Communication icon on the Component Palette. You can create generalization structures between actors and between use cases by using the Generalization icon. To represent where one use case includes another, use the Include icon, and to represent where one use case extends another use the Extension icon.
You can annotate a diagram of use cases using notes, dependency relationships and URL links. Annotation components are available at the lower part of the component palette under Diagram Annotations.
You can represent interactions between use cases and subjects using the Communication icon on the Component Palette.
You can represent interactions between use cases and subjects using the Communication icon on the Component Palette.
XHTML files can be used as templates for the documents that support some objects in use case diagrams. Templates allow you to determine the appearance and other attributes of the document initially created for each object type. You can either edit the source code of a template directly or use the visual editor.
To open a use case template:
Choose File > Open, then navigate to the <jdeveloper_install>/jdev /system[...]/o.uml.v2.usecase.html/templates/usecase folder and open (by double-clicking) one of the files located there.
The files have the following names and uses:
Actor.xhtml_act - template for actor documents. Casual.xhtml_usc - template for casual use case document. FullyDressed.xhtml_usc - template for fully dressed use case documents. Milestone.xhtml_sub - template for subject - milestone use case documents. SystemBoundary.xhtml_sub - template for subject - use case documents. To edit the use case template source code:
Select the Source tab. To insert HTML tags at specific locations, open the context menu and choose Insert HTML.
As a general rule, do not remove tags that include the uml: prefix (for example <uml:usecase_extends>). If you are removing an entire section of the template (for example, between a td tag and a /td tag), any uml: prefixes can be safely removed along with the other content of the section.
To change the appearance of text on the use case [modeler] template:
Select the Editor tab and the text that you want to change, then choose one or more of the formatting options from the toolbar.
To insert HTML interface objects, code objects, and development inputs:
Select the Editor tab, select the place in the template where you want to make the insertion, then choose the required location and object from the context menu.
You can insert HTML interface objects (such as buttons and checkboxes), HTML code objects (such as anchors and tables), and development inputs (such as comments and processing instructions).
You are initially given the choice of inserting an object before a selected template item or after it, or into the <head> section of the template. Subsequently, these options are unavailable if inappropriate. If you choose HTML or Browse from the context menu, a dialog box is opened from which you can choose one of various HTML interface objects and code objects. Choosing an item here will open an insertion dialog to enter properties appropriate to the object.
New use case templates can be created by copying the one included in JDeveloper. You can modify the copies as needed.
For each new component palette there must be one use case template that supports it. The use case template that you specify is not copied or moved: it remains in its original location.
To create a new Component Palette page and add a new use case component:
Diagrams are stored on disk as diagram files. Diagram files reference the elements that are displayed on the diagram and contain display information for those elements (size, color, font, display of various properties etc.). Diagram files are stored in the folder for the package in which the diagram resides, and is stored in the model path specified in the project settings. Notes, diagram links and dependencies are also stored in the diagram file.
To set the model path, choose Application > Default Project Properties > Project Source Paths > Modelers.
Diagram elements such as Java classes are referenced in the diagram file, but their definition and implementation details are only stored in the implementation files for those elements. Although the diagrammatic details for these elements (position, color, size, etc.) are stored in the diagram file, no separate model definitions of these elements are stored.
UML elements are stored in individual files. Their location is dependent on the package property of the element. These element files hold the properties defined against the various elements, but the diagram file still defines which elements are displayed on the diagram and the visual properties of those elements. Element files for modeled UML elements are stored in the appropriate package folder under the folder specified in the project model path. To set the model path, choose Application > Default Project Properties > Project Source Paths > Modelers.
This chapter describes how to work with Java EE and Java application diagrams using the latest modeling tools and technologies included in Oracle JDeveloper.
This chapter includes the following sections:
Oracle JDeveloper provides you with a wide range of diagramming tools to model your Java EE and Java applications systems.
Use the business component diagram to visualize and organize the business entities and objects in your enterprise application.
For more information see, “Creating an Entity Diagram for Your Business Layer” in the Oracle Fusion Middleware Fusion Developer's Guide for Oracle Application Development Framework.
Enterprise JavaBeans (EJBs) modeling helps you visualize your EJB entity relationships and architecture, and to quickly create a set of beans to populate with properties and methods, and to create a graphical representation of those beans and the relationships and references between them. Whenever a bean is modeled, the underlying implementation files are also created.
To model EJBs start by creating an EJB diagram. For more information, see "To create a new diagram:". You can later add other elements like UML classes, Java classes, business components, offline database tables, UML use cases and web services to the same diagram. For more information, see "How to Work with Diagram Elements".
About Entity, Session and Message-Driven Beans
Enterprise JavaBeans are created on a diagram by using the Entity Bean icon, Session Bean icon or Message-Driven Bean icon on the EJB Component Palette for the diagram, and then clicking on the diagram where you want to create the element. The implementation files for the modeled elements are created in the location specified by your project settings.
| Tip: If you want to model the implementing Java classes for a modeled bean on a diagram, right-click the modeled bean and choose Show Implementation Files. |
Properties and methods are added by either double-clicking the bean and adding the property or method using the EJB Module Editor or by creating the new property or method 'in-place' on the modeled bean itself. For more information, see Section 23.3.5, "Modeling Properties and Methods".
Relationships Between Beans
References can be created from any bean to any other bean with a remote interface using the EJB Reference icon and local references can be created from any bean to any other bean with a local interface using the EJB Local Reference icon on the EJB Component Palette for the diagram. For more information, see Section 23.3.6, "How to Model Cross Component References".
A variety of relationships can be created quickly between modeled entity beans using the 1 to * Relationship icon, Directed 1 to 1 Relationship icon, Directed 1 to * Relationship and Directed Strong Aggregation icons on the EJB Component Palette for the diagram. For more information, see Section 23.3.3, "How to Model a JPA Relationship".
| Note: If you change, add to, or delete from, the implementation files for anything that is displayed on a diagram, those changes will be reflected on modeled representations of those elements. Conversely, any changes to the modeled Enterprise JavaBeans are also made to the underlying implementation files. |
You can annotate a diagram of Enterprise JavaBeans using notes, dependency relationships and URL links.
The relationships between entity, session, and message-driven beans, and their properties and methods, can all be modeled graphically on an EJB diagram. EJB diagrams are also used for modeling UML classes, Java classes, UML use cases, offline database objects, business components and web services.
To create a diagram of Java classes:
Table 23-1 EJB Component Palette Icons
| Drop-down List | Icon | Name |
|---|---|---|
| EJB Nodes |
| Entity |
|
| Message-driven Bean | |
|
| Session Bean | |
| Entity Relationships |
| Bidirectional * to * Relationship |
|
| Bidirectional * to 1 Relationship | |
|
| Bidirectional 1 to 1 Relationship | |
|
| Unidirectional * to * Relationship | |
|
| Unidirectional * to 1 Relationship | |
|
| Unidirectional 1 to * Relationship | |
|
| Unidirectional 1 to 1 Relationship | |
| EJB Edges |
| Entity Inheritance Edge |
|
| Session Facade Edge | |
| Diagram Annotations |
| Attachment |
|
| Group | |
|
| Link | |
|
| Note |
You can annotate your diagram by attaching notes to diagram elements. For more information, see Chapter 22, "How to Work with Diagram Annotations."
You can model session, entity and message-driven beans in JDeveloper. Modeled session and entity beans are made up of several compartments. For example, Message-driven beans have only a name compartment containing the «message-driven bean» stereotype and the name of the bean. For EJB 3.0 beans the model looks different because there are no compartments for interfaces.
Figure 23-1 EJB/JPA Components Diagram

Notice the relationship and connectors between the beans. References can be created from any bean to any other bean with a remote or local interface. References can only be modeled between beans that are inside the current deployment descriptor.
You can model a relationship between any two entities on a class diagram by dragging the relationship component from the palette. You can also show the inheritance edge between the root and child entity. The entity at each end of a relationship must have container-managed persistence and a local interface.
To model a relationship between two entities on a diagram:
| Notes: The navigability and multiplicity of a relationship end can be changed after it has been created.If these icons are not displayed, select EJB Components from the dropdown on the Component Palette. |
| Note: If you want to represent this relationship using a container-managed relationship (CMR) field, this is the bean in which the field will be created. |
| Note: To change the multiplicity of a relationship end on the diagram, right-click on the relationship end and choose either Multiplicity > 1 or Multiplicity > *. |
Entity, session, and message-driven beans can be modeled using the diagram features in JDeveloper. Properties and methods can also be modeled.
Properties and methods can be added to modeled EJBs by either double-clicking the bean and adding the property or method using the EJB Module Editor or by creating the new property or method directly on the modeled bean.
When creating a property directly on a modeled bean, enter the name and datatype of the property. For example:
name : java.lang.String
A public (+) visibility symbol is automatically added to the start of the property.
| Note: If a property type from thejava.lang package is entered without a package prefix, for example, String or Long, a property type prefix of java.lang. is automatically added. If no type is given for a property, a default type of 'String' (java.lang.String) is used |
Both local/remote and local/local home methods can be created on modeled beans on a class diagram. Modeling a method on a bean also creates the corresponding code in the implementing Java class.
When creating a method in-place on a modeled bean, enter the name, and optionally the parameter types and names, and return type of the method. The method return type must be preceded by a colon (:). For example:
getName(String CustNumber) : java.lang.String
A public (+) visibility symbol is automatically added to the start of the method.
| Notes: If a return type from the java.lang package is entered without a package prefix, for example,String or Long, a return type prefix of java.lang. is automatically added to the Java in the method's class. If no parameter types are provided, the method will be defined with no parameters. If no return type is specified, a default return type of void is used. To change a property of the method, double-click the class on the diagram, or on the Navigator pane, then change the details of the method using the EJB Editor. |
References can be created between modeled beans on a class diagram.
| Note: References can only be made to beans that are inside the current deployment descriptor. |
To model a reference between modeled beans:
| Note: If these icons are not displayed, select EJB from the list on the Component Palette. |
Each modeled bean has underlying Java source files that contain the implementation code for that element. These implementation files can be displayed on the diagram as modeled Java classes.
To display a modeled implementing Java class for a modeled bean:
The Java source code for a modeled bean can be displayed in the source editor with simple commands on the diagram.
To display the Java source code for a model element:
You can change the accessibility of a property or method on a modeled bean on a diagram with simple commands on a diagram.
To change the accessibility of a property or method:
The accessibility options are:
Modeled entity beans can be reverse-engineered on a diagram of EJBs from table definitions in your application database connection.
To reverse-engineer a table definition to an entity bean:
To reverse-engineer several tables to entity beans, hold down the Ctrl key, select the tables in the navigator and drag these tables to the diagram, then release the Ctrl key.
Model your Java EE Java classes and class systems using the Java class diagram features. For more information see Chapter 22, "How to Work with Class Diagrams."
Modeling your database structures gives you a visual view of your database schema and the relationships between the tables, stored in your online or offline database. You can also transform database tables to Java classes and interfaces and vice-versa using the transformation features. For more information on database transformation see Chapter 22, "Transforming Java Classes and Interfaces".
With JDeveloper, you can model offline database objects as well as database objects from a live database connection. You can also create database objects such as tables and foreign key relationships right on your diagram and integrate them with an online or offline database.
Use database diagrams to view your business entity structure and relationships, as well as create directly on your diagram components such as tables and foreign key relationships, views and join objects, materialized views, synonyms and sequences.
All of the database objects from online or offline databases, as well as the new objects you create, are displayed in the Application Navigator.
Add or create offline and live online database objects using the Application Navigator and the Component Palette.
Use a database diagram to do the following:
In addition, you can create database objects on a diagram based on templates.
Create your database using the New Gallery. See "To create a new diagram:". Once you've created your database diagram, you can choose from the available components in the Component Palette, as shown in Figure 23-2.
Create an offline database object on the diagram by clicking on the icon on the Database Objects Component Palette, and then clicking on the diagram where you want to create the object. You can also drag objects from a database connection in the Database Navigator, or from an offline schema in the Application Navigator, onto a diagram.
You can model online or offline tables on any type of diagram, (except an activity diagram), and you can add elements like UML classes, Java classes, business components, Enterprise JavaBeans, UML use cases, and web services on the same diagram.
You can create offline database objects on a diagram that are based on templates. The first time you add an object to a new database diagram, the Specify Location dialog appears, where you specify whether the objects are offline database objects in a project, or database objects in a database connection. If you want to create offline database objects based on templates, you can create a set of templates at the same time.
You can add the elements that define the object by either double-clicking the modeled object to display the appropriate edit dialog, or by creating the new element 'in-place' on the modeled object.
You can annotate a diagram of database objects using notes, dependency relationships, and URL links.
If you change, add to or delete from the definition of anything that's displayed on a diagram, those changes will be reflected on the modeled representations of those database objects. Conversely, any changes to the modeled database objects are also made to the underlying definitions.
Foreign keys
Foreign keys can be created quickly between modeled tables clicking Foreign Key on the Database Component Palette, then clicking the table you want to originate the foreign key, and then clicking the destination table for the foreign key. The Create Foreign Key dialog allows you to select an existing column in the target table, or create a new column.
Join Objects
You can create join objects between two table usages in a view by clicking (Join Objects) on the Database Component Palette, then clicking on the two table usages to be joined. The Edit Join dialog allows you to specify the join.
Materialized Views
Materialized Views are created on a diagram by clicking on (Materialized View) on the Database Component Palette, and then clicking on the diagram where you want to create the materialized view. You can also drag materialized views from a database connection defined in JDeveloper, or from an offline database in the Application Navigator, and drop them on the diagram.
Materialized Views from Template
Materialized Views based on templates are created on a diagram by clicking on (Materialized View from Template) on the Database Component Palette, and then clicking on the diagram where you want to create the materialized view. The Choose Template Object dialog is displayed, which allows you to choose the template you want to base the materialized view on.
Private and Public Synonyms
Synonyms are created on a diagram by clicking on (Synonym) on the Database Component Palette, and then clicking on the diagram where you want to create the synonym. You can also drag synonyms from a database connection defined in JDeveloper, or from an offline database in the Application Navigator, and drop them on the diagram.
Public synonyms are created in the PUBLIC schema.
Relation Usage
Define a base relation for a view by clicking on (Relation Usage) on the Database Component Palette, and then clicking on the view.
Sequences
Sequences are created on a diagram by clicking on (Sequence) on the Database Component Palette for the diagram, and then clicking on the diagram where you want to create the sequence. You can also drag sequences from a database connection defined in JDeveloper, or from an offline database in the Application Navigator, and drop them on the diagram.
Sequences from Templates
Sequences based on templates are created on a diagram by clicking on (Sequence from Template) on the Database Component Palette for the diagram, and then clicking on the diagram where you want to create the sequence. The Choose Template Object dialog is displayed, which allows you to choose the template you want to base the materialized view on.
Synonyms from Templates
Synonyms based on templates are created on a diagram by clicking on (Synonym from template) on the Database Component Palette for the diagram, and then clicking on the diagram where you want to create the synonym. The Choose Template Object dialog is displayed, which allows you to choose the template you want to base the materialized view on.
Tables
Tables are created on a diagram by clicking on (Table) on the Database Component Palette, and then clicking on the diagram where you want to create the table. You can also drag tables from a database connection defined in JDeveloper, or from an offline database in the Application Navigator, and drop them on the diagram.
You can choose to view table column icons on a modeled table which indicates which columns are primary keys, or foreign keys, or unique keys.
The first column in the modeled table indicates whether the column is in a primary, unique, or foreign key:
The second column indicates whether the table column is mandatory.
| Note: If a table column is in a primary key it will only display the primary key icon even though it may also be in a unique key or foreign key. |
Tables from Templates
Tables are created on a diagram by clicking on (Table from template) on the Database Component Palette, and then clicking on the diagram where you want to create the table. The Choose Template Object dialog is displayed, which allows you to choose the template you want to base the materialized view on.
Views
Views are created on a diagram by clicking on (View) on the Database Component Palette, and then clicking on the diagram where you want to create the view. You can also drag views from a database connection defined in JDeveloper, or from an offline database in the Application Navigator, and drop them on the diagram.
Define the view by adding tables and views, or table columns or elements of other views to the newly defined view. You can add the views by creating them from the Component Palette, by dragging other views and tables on the diagram onto the view, by dragging offline database objects from the Application Navigator, or by dragging database objects from a connection in the Database Navigator.
Views from Templates
Views are created on a diagram by clicking on (View from template) on the Database Component Palette, and then clicking on the diagram where you want to create the view. The Choose Template Object dialog is displayed, which allows you to choose the template you want to base the materialized view on.
| Note: All subsequent database objects will be created in the database or schema you have chosen. Existing objects are unchanged. |
This part describes the general concepts of working with Oracle JDeveloper to connect to and design databases and contains the following chapters:
This chapter introduces the various concepts and features.
This chapter introduces the tools and features that JDeveloper provides to help you to design and work with databases.
This chapter introduces connecting to Oracle and non-Oracle databases.
This chapter introduces designing databases in JDeveloper by modeling database objects, and how to generate these to a database.
This chapter describes the features that allow you to write and execute Java programs that access Oracle Databases.
This chapter how to use PL/SQL and Java Stored Procedures in a database.
This chapter describes how to get started using JDeveloper to work with databases. If you are new to using database you will find the section on connecting to Oracle Database XE, an entry-level, small-footprint database.
This chapter includes the following sections:
JDeveloper enables you to work with Oracle and non-Oracle databases directly, and to design, create, and edit databases by working with offline database definitions.
Refer to the following documentation to quickly get started with using Oracle databases in JDeveloper:
http://st-curriculum.oracle.com/obe/jdev/obe11jdev/11/index.html. Usually you start working with a database by creating a connection to it. JDeveloper helps you quickly to create connections to Oracle databases, and you can also connect to and work with a number of non-Oracle databases. Once you have a database connection you can search for database objects in the Database Navigator, or use the search tools to find specific objects, or compare databases and their contents. You can also edit data and import and export data, and you can create reports about the database and objects in it.
You can work directly with databases through a database connection using the integrated tools in JDeveloper which include SQL Worksheet and the database object editors, and you can edit database objects using the database object editors. Alternatively, you can create an offline database and working either in the Application Navigator or the database diagrammer you can work with offline database definitions to model the database and then generate the results to a database through a database connection.
Database connections can be listed in the Application Navigator or Database Navigator, where they are available to applications you are working on, or in the Resource Palette, where they are available for reuse in other applications.
Once you have a database connection, you can:
You can work with offline databases, which you can model on the database diagrammer or work with in the Application Navigator.
You can create, edit, and drop objects in a database or in an offline database.
You can write and execute Java programs using JDBC that access Oracle and non-Oracle databases.
If you are new to using databases with JDeveloper, one of the easiest ways to get started is to try out Oracle Database 10g Express Edition (Oracle Database XE).
If you are new to using databases with JDeveloper, one of the easiest ways to get started is to try out Oracle Database 10g Express Edition (Oracle Database XE). Oracle Database XE is an entry-level, small-footprint database based on the Oracle Database 10g Release 2 code base. It is free to develop, deploy, and distribute; fast to download; and simple to administer. You can download it from Getting Started: Oracle Database 10g Express Edition (XE), which is available at http://www.oracle.com/technetwork/database/express-edition/overview/index.html
After you have downloaded and installed Oracle Database XE, follow the instructions in the Getting Started Guide to unlock the sample user, HR. You may want to grant additional privileges, for example to create tables and materialized views. Now you can create a database connection from JDeveloper to the sample user.
In the Create Database Connection dialog, use the following values. Leave blank any fields that are not mentioned.
Table 24-1 Connection details for Oracle Database 10g Express Edition
| Field | Value |
|---|---|
| Create Connection In | Choose Application resources. The connection will be displayed in the Application Navigator, under Application Resources. |
| Connection Name | Enter a meaningful name for this connection. |
| Connection Type |
|
| Username |
|
| Password | Enter the password you entered when you unlocked the sample user or created a new user. |
| Save Password | Selected (default). |
| Driver |
|
| Host Name | When Oracle Database XE is installed on the local system use the default of |
| JDBC Port |
|
| SID |
|
Click Test Connection at the bottom of the dialog. Success! indicates that you have a connection to the database. If you get any other message, check that you have entered the values above correctly, and check that the Oracle Database XE has started.
There are a number of preferences that allows you to control how to use the database functionality in JDeveloper. These are available in the Preferences dialog, available from the Tools menu:
To manage database preferences in the Preferences dialog:
To manage properties in the Project Properties dialog:
As well as managing these preferences and properties, you can also filter schemas or objects in a database connection to just see the ones you want.
This chapter provides an introduction to the various tools that JDeveloper uses to help you work with and manage databases.
This chapter includes the following sections:
The Database Navigator provides you with a complete editing environment for online databases. You can create, update and delete database objects using the navigator.
The Database Navigator is integrated with:
In addition, you can drag database objects from a database connection onto a database diagram to either:
For more information about database modeling, see Section 23.5, "Database Diagram."
When you first open the Database Navigator, it appears in the docked position, along with any other open navigators. Its default docked position is in the upper left-hand corner, flush with the main work area of JDeveloper. When more than one navigator is open, each appears with a tab displaying its name.
Right-click on a node within the Database Navigator to bring up a context-sensitive menu of commands. The menu commands available depend on the node selected. You can open nodes in their default editors, as well as other editors common to that node type, using the context menu.
Table 25-1 Database Navigator Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | New Connection | Click to open the Create Database Connection wizard, where you enter the details to create a connection to a database. |
![]() | Refresh | Click to synchronize the display in the navigator with the contents of the connection. |
![]() | Apply Filter | Click to filter which objects will be displayed for a given connection. To enable the icon, select a node within the connection in the navigator and wait for the connection to be established. |
You can perform various tasks from the context menus in the Database Navigator. Right-click the IDE Connections node (for globally defined connections) or an application name node (for connections that are locally-scoped, and just available within the application) and select the appropriate menu item to:
You can perform the following operations from a database connection node:
There are additional options available from database object type nodes (for example, Tables, Indexes, or Procedures) or from database object nodes (such as a specific table, or a specific view). The options available depend on the node selected.
The database view of the Structure Window displays details of a database object selected in the Database Navigator, or an offline database object selected in the Application Navigator.
When you select a database object such as a table in a database connection in the Database Navigator or an offline database object such as a table in an offline database in the Application Navigator, a node for that object is shown in the Structure Window. You can expand the node to see details of the sub objects that make up the database object. In the case of a table, these include sub objects such as columns, constraints, and indexes.
Table 25-2 Icons in the SQL Worksheet Toolbar
| Icon | Name | Function |
|---|---|---|
![]() | Refresh | Click to refresh the content of the Structure Window. You may want to do this when a database object has been changed outside JDeveloper, for example using SQL*Plus, and you want to be sure that the Structure Window reflects the current state of the object. |
You can perform the following operations from the database view of the Structure Window:
Use the Database Reports Navigator to view reports about the database and its objects.
You can also create your own user defined reports.
To open a pre-defined report, expand Data Dictionary Reports and navigate to the report you want. Double-click the report name to run it. A number of dialogs may be displayed before the report is opened in the Reports Results window:
You can create your own reports and store them in folders and sub-folders under the User Defined Reports node.
Some reports may take some time to run, and the time is affected by the number and complexity of objects involved, and by the speed of the network connection to the database.
From the Data Dictionary Reports node you can:
User Defined reports are any reports that are created by JDeveloper users.
Information about user defined reports, including any folders for these reports, is stored in UserReports.xml in the directory for user-specific information.
You can perform the following operations from the User Defined Reports node:
The Shared Reports node is displayed once you have defined the first shared report in the Preferences dialog.
For more information about creating and sharing database reports, see Section 26.8, "Working with Database Reports".
The Find Database Object Window allows you to search for and work on database objects within a live database.
The Find Database Object Window is fully integrated with the online database functionality, including the SQL Worksheet and the Database Object Viewer.
While you are using the Find Database Object Window these features are available:
Table 25-3 Find Database Object Toolbar
| Name | Function |
|---|---|
| Connection | Choose the database connection to search in from the dropdown list. You must already have a connection to the database. |
| Name | Enter the search term. You can use the wildcard |
| Type | Choose the type of database object to restrict the search to. The default is |
| Usage | Only for certain types of object) Choose the usage of the object, for example |
| Lookup | Click to display the results of the search. The results of the search are displayed in the panel. Double-click on an object to open it in the appropriate editor. |
You can perform the following tasks from the Find Database Object window:
Use to enter and execute SQL, PL/SQL, and SQL*Plus statements. You can specify any actions that can be processed by the database connection associated with the worksheet, such as creating a table, inserting data, creating and editing a trigger, selecting data from a table, and saving that data to a file.
You enter SQL statements in the SQL Statement area, and use the buttons on the toolbar to perform actions.
Table 25-4 describes the icons and fields in the toolbar above the SQL Worksheet statement area.
Table 25-4 Icons in the SQL Worksheet Toolbar
| Icon | Name | Function |
|---|---|---|
![]() | Run Statement (Ctrl+Enter) | Click to execute the statement at the mouse pointer in the SQL statement area. The SQL statements can include bind variables and substitution variables of type |
![]() | Run Script (F5) | Click to execute all statements in the SQL statement area. The SQL statements can include bind variables and substitution variables of type |
![]() | Autotrace (F6) | Click to generate trace information for the statement. Too see trace information, click the Autotrace tab. |
![]() | Explain Plan (F10) | Click to generate the execution plan for the statement, which internally executes the |
![]() | Commit (F11) | Click to write any changes to the database. This ends the transaction and clears any output in the Results and Script Output tabs. |
![]() | Rollback (F12) | Click to discard any changes without writing them to the database. This ends the transaction and clears any output in the Results and Script Output tabs. |
![]() | Unshared SQL Worksheet (Ctrl+Shift+N) | Click to open a new unshared SQL Worksheet for a different connection. |
![]() | To Upper/Lower/Inicat (Ctrl+Quote) | Click to switch the selected text between upper case, lower case, and initial capitals. |
![]() | Clear (Ctrl+D) | Click to erase the statement or statements in the Enter SQL Statement area. |
![]() | Cancel | (Only displayed while a script is running) Click to stop execution of the script. |
![]() | (Only displayed once a statement or script has run) Displays the time it took to execute a statement or run a script. This can be used with Explain Plan to provide useful tuning information. | |
![]() | Use to choose a different database connection. |
The results area has a number of tabs:
The SQL Worksheet provides code insight for SQL code. When you type a word, a dropdown menu of valid code appears. For example:
select, SELECT is displayed. select *, a list containing BULK, FROM, and INTO is displayed. select * from em, a list containing the table employees and the view emp_details_view is displayed. To configure Code Insight for the SQL Worksheet:
To open the SQL Worksheet:
Alternatively, click the SQL Worksheet button on the JDeveloper toolbar.
For more information at any time, press F1 or choose Help from within the SQL Worksheet.
Alternatively, from the main toolbar, click and choose the database connection from the Choose Connection dialog.
You can create a SELECT statement by dragging and dropping table and view names, and by graphically specifying columns and other elements of the query using Query Builder. You can run the statement within Query Builder to see the results, and when you close Query Builder, the resulting SELECT statement is inserted into the SQL Worksheet.
To use Query Builder:
WHERE clause, click the Create Where Clause tab, and enter values for the clause. To execute a SQL statement:
For more information, see "Using the SQL Worksheet" in the Oracle Database SQLJ Developer's Guide.
An execution plan is the sequence of operations that will be performed to execute the statement, and you can use the SQL Worksheet to inspect the execution plans chosen by the Oracle optimizer for SQL SELECT, UPDATE, INSERT, and DELETE statements. You can also view explain plan for the SQL code for the query part of a view definition.
An execution plan shows a row source tree, which is the hierarchy of operations that comprise the statement. For each operation it shows the following information:
In addition to the row source tree, the plan table displays the following information about selected operations:
For more information, see "Using EXPLAIN PLAN" in the Oracle Database Performance Tuning Guide.
An additional source of information that can be used to tune SQL queries is the elapsed time that is displayed in the toolbar of the SQL Worksheet when statements are executed or scripts are run.
To view a SQL statement's execution plan:
The Explain Plan tab shows the explain plan information for the SQL statement.
The statements executed in a session with the SQL Worksheet are preserved in a history list. You can retrieve previous statements from the history, and re-execute them or view their execution plans.
To recall a statement from the SQL Worksheet history:
A dialog showing the list of the statements previously entered is displayed.
The statement is displayed in the upper pane of the worksheet.
The SQL History Window allows you to reuse statements previously executed in a session with the SQL Worksheet.
SQL statements and scripts that you have executed are listed in the window, and you can select one or more statements to have them either replace the statements currently on the SQL Worksheet or be added to the statements currently on the SQL Worksheet.
While you are using the SQL History Window these features are available:
Table 25-5 SQL History Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Append | Click to append the selected statement or statements to any statements currently on the SQL Worksheet. You can also append the selected statement or statements by dragging them from the SQL History window and dropping them at the desired location on the SQL Worksheet. |
![]() | Replace | Click to replace any statements currently on the SQL Worksheet with the selected statement or statements. |
![]() | Clear History | Click to remove all statements from the SQL history. |
![]() | Filter | Use to filter the SQL statements visible in the SQL History window. Type a string in the text box and click Filter. Only SQL statements containing that string are listed. To remove the filter, delete the string in the field and click Filter again. |
Snippets are code fragments, such as SQL functions, Optimizer hints, and miscellaneous PL/SQL programming techniques. Some snippets are just syntax, and others are examples. The Snippets Window is integrated with the SQL Worksheet and when you are creating or editing a PL/SQL function or procedure.
In the Snippets Window, the snippets are organized in categories in the drop-down list, such as Aggregate Functions or Character Functions. You can create new snippets and add them to an existing category, or to a new category. To see a brief description of a snippet, hover the mouse pointer over the function name.
To insert a snippet into your code in a SQL Worksheet or in a PL/SQL function or procedure, drag the snippet from the snippets window and drop it into the desired place in your code; then edit the syntax so that the SQL function is valid in the current context.
For example, you could type SELECT and then drag CONCAT(char1, char2) from the Character Functions group. Then, edit the CONCAT function syntax and type the rest, as in this example:
Table 25-6 Snippets Window Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Add Snippets | Click to open the Save Snippet dialog where you can create a new snippet and save it in an existing group or in a new group. |
![]() | Edit User Snippets | Click to open the Edit Snippets dialog which lists user snippets. You can create, edit and delete snippets in this dialog. |
From the Snippets window, you can:
The Database Object Viewer allows you to manage the structure and contents of objects in a database. The tabs available depend on the type of object being viewed.
You can edit the value in any of the cells by double-clicking the cell to select it, then clicking ... to open the Edit Value dialog.
Information about the object is contained in a number of tabs.
The specific buttons on the toolbar vary from tab to tab.
Table 25-7 Database Object Viewer Tabs Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Freeze and Unfreeze View | Use to toggle freezing the table viewer on the current view. |
![]() | Edit | Click to open the Edit Table dialog. |
![]() | Refresh | Click to refresh the data. |
![]() | Insert Row | Click to insert a new blank row below the row where the focus is. |
![]() | Delete Selected Row(s) | Click to delete the selected rows of data. |
![]() | Commit | Click to commit the changes to the database. The changes are logged in the Data Editor log window, and commit will fail if there is an error, such as a unique constraint violation. |
![]() | Rollback | Click to rollback database changes already made. The Data Editor log window reports on whether the rollback has succeeded. |
![]() | Click to open the Sort dialog where you specify the columns to sort by and the sort order. | |
![]() | Enter a value to reduce the number of records displayed, for example | |
![]() | Click to perform one of a range of common table actions. |
SQL*Plus is an interactive and batch query tool that is installed with every Oracle Server or Client installation. It has a command-line user interface. You can launch SQL*Plus from within JDeveloper. For more information, see the SQL*Plus User's Guide and Reference.
In most cases, using SQL Worksheet is preferable to using SQL*Plus as it is fully integrated with JDeveloper, and you can use SQL Worksheet to enter and execute SQL, PL/SQL, and some SQL*Plus statements.
SQL*Plus can use parameter substitution. The default escape character is '&', thus any comments that have '&' in them may cause an error. Additionally, the character used in the SQL*Plus session that runs the script can be changed from the default using SET DEFINE, so JDeveloper cannot look for the parameter substitution character in comments and warn you. If you encounter this error in a script, you can use SET DEFINE OFF to ignore the parameter substitution character or remove the character from the comment. For more information, see "'Using Scripts in SQL*Plus'" in the SQL*Plus User's Guide and Reference.
In order to launch SQL*Plus from JDeveloper, you must have SQL*Plus installed on your machine. For information about installing a SQL*Plus client, see the information about Oracle Database Instant Client at http://www.oracle.com/technetwork/database/features/instant-client/index-100365.html.
You can launch SQL*Plus from:
If you have not already specified the SQL*Plus executable in JDeveloper, you will able to do so when you launch SQL*Plus. Alternatively, you can specify the SQL*Plus executable in the Preferences dialog. You only need to perform this task once.
To specify the SQL*Plus executable:
| Note: On Unix, use xterm to create a terminal window to run the SQL*Plus command in. |
To launch SQL*Plus from a connection:
To launch SQL*Plus from a SQL file:
The PL/SQL DBMS_OUTPUT package enables you to send messages from stored procedures, packages, and triggers. The PUT and PUT_LINE procedures in this package enable you to place information in a buffer that can be read by another trigger, procedure, or package. In a separate PL/SQL procedure or anonymous block, you can display the buffered information by calling the GET_LINE procedure. The DBMS Output window is used to display the output of that buffer.
Add New DBMS Output Tab: Prompts you to specify a database connection, after which a tab is opened within the DBMS Output pane for that connection, and the SET SERVEROUTPUT setting is turned on so that any output is displayed in that tab. (To stop displaying output for that connection, close the tab.)
Table 25-8 DBMS Output Window Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Enable DMBS Output | Click to toggle the SET SERVEROUTPUT setting between ON and OFF. Setting server output ON checks for any output that is placed in the DBMS_OUTPUT buffer, and any output is displayed in this tab. |
![]() | Clear | Click to erase the content of this tab. |
![]() | Save File | Click to open the Save dialog where you can enter a filename to save the results in this tab. |
![]() | | Click to open the Print dialog, where you can choose the printer to print the content of this tab. |
| Buffer Size | For databases before Oracle Database 10.2, click to limit the amount of data that can be stored in the DBMS_OUTPUT buffer. The buffer size can be between 1 and 1000000 (1 million). | |
| Poll | Move the slider to set the interval (in seconds) at which JDeveloper checks the DBMS_OUTPUT buffer to see if there is data to print. The poll rate can be between 1 and 15. | |
| Choose DB Connection | Change to a different database connection by choosing it from the list. |
OWA (Oracle Web Agent) or MOD_PLSQL is an Apache (Web Server) extension module that enables you to create dynamic Web pages from PL/SQL packages and stored procedures. The OWA Output window enables you to see the HTML output of MOD_PLSQL actions that have been executed in the SQL Worksheet.
Table 25-9 OWA Output Window Toolbar Icons
| Icon | Name | Function |
|---|---|---|
![]() | Enable OWA Output | Click to toggle the SET SERVEROUTPUT setting between ON and OFF. Setting server output ON checks for any output that is placed in the DBMS_OUTPUT buffer, and any output is displayed in this tab. |
![]() | Clear | Click to erase the content of this tab. |
![]() | Save File | Click to open the Save dialog where you can enter a filename to save the results in this tab. |
![]() | | Click to open the Print dialog, where you can choose the printer to print the content of this tab. |
| Choose DB Connection | Change to a different database connection by choosing it from the list. |
This chapter describes how to create and work with database connections.
This chapter includes the following sections:
You can connect to and work with Oracle databases and a number of non-Oracle databases.
Database connections can be available in the Application Navigator or Database Navigator, where they are available to applications you are working on, or in the Resource Palette, where they are available for reuse in other applications.
Once you have a database connection, you can:
If you are new to using databases with JDeveloper, one of the easiest ways to get started is to try out Oracle Database Express Edition (Oracle Database XE). For more information, see Section 24.2, "Getting Started With Oracle Database 10g Express Edition."
You can define and manage connections to external data sources using the Create Database Connection dialog.
When you delete a connection, JDeveloper does not warn you that a project may be dependent upon it. For this reason, it is best to use caution when deleting connections.
In JDeveloper 11g you have two ways of creating and managing database connections. You can define database connections for an application (called an Application Resource connection) or for the IDE as a whole (called an IDE connection). You use the same dialog to define these, but their scope within JDeveloper is different.
When you first create a database connection, you choose the connection scope, which you cannot subsequently change. For more information, see Section 3.7.2.2, "Defining the Scope of a Connection."
When you create a database connection, JDeveloper creates a node for the connection in the Database Navigator, and an additional node in either the Resource Palette or in the Application Resources panel of the Application Navigator depending on the scope of the connection.
In the Application Navigator and Database Navigator, you can expand the database connection node to view and work with database objects. In the Resource Palette, you can only work with a database connection after you have added it to the application.
Database Connections Created as Application Resources
Database connections created as application resources are only available to the application in which they are created.
In the Database Navigator, the node for the connection is under the node with the same name as the application.
In the Application Navigator, the node for the connection is under Connections in the Applications Resources panel. Connection information is stored in connections.xml, which is under the Descriptors node, under ADF META-INF. You can open the file in the XML editor by double-clicking it, and you can discover the file path by hovering the mouse over the filename.
The file system location for the connection descriptor definition information is application_folder/.adf/META-INF/connections.xml where application_folder is the path for the selected application.
Database Connections Created as IDE Connections
These database connections are globally defined connections.
You can copy an IDE connection to the application navigator to use it in an application by:
The file system location for the connection descriptor definition information is sys-dir/jdeveloper/system11.1.x.x.nn.nn.nn/o.jdeveloper.rescat2.model/connections/connections.xml.
A connections.xml file is included with JDeveloper deployments, and in the application it is in the folder .adf\META-INF. This file contains the connection information necessary for deployment and the runtime connection execution.
After you have defined a connection, you can return to the dialog and edit its attributes.
| Note: You cannot change the connection type after the database connection has been created. |
To create a database connection:
Alternatively, from the main menu, choose File > New to open the New Gallery. In the Categories list, expand General and select Connections. In the Items list, double-click Database Connection to open the Create Database Connection dialog.
For more information at any time, press F1 or click Help from within the Create Database Connection dialog.
If the test succeeds, a success message appears in the status text area. If the test does not succeed, an error appears. In this case, change any previously entered information as needed to correct the error, or check the error content to determine other possible sources of the error.
The recommended way of connecting to Oracle Database is using the thin driver, however you can connect using OCI8 (thick connection).
To connect using OCI8:
oracle.jdbc.library. For example: To edit a database connection:
| Note: You can filter which schemas appear in the connection. |
You can also import and export database connections created as IDE connections in the Resource Palette. For more information, see Section 3.7.6, "How to Import and Export Catalogs and Connections."
When you export connections, selected connection descriptors are copied to an XML file. The file can be imported by other users to easily create connections.
To export a database connection:
The connection information for the selected connections is saved in the file and can be imported for use by others.
An alternative way of exporting connections, including database connections that are IDE Connections, is to use the Resource Palette.
You can import connection descriptors that have previously been exported.
To import a database connection:
An alternative way of importing connections that can include database connections is to use the Resource Palette.
You can manually connect to a database connection already defined in JDeveloper, or disconnect a database connection.
To open a database connection:
Alternatively, right-click the closed connection and choose Connect.
To close a database connection:
Deleting connections removes them from the Database Navigator and the installation of JDeveloper.
When you delete a connection, JDeveloper does not warn you that a project may be dependent upon it, and removes the connection from all of JDeveloper, not just a workspace or project. It is best to use caution when deleting connections.
To delete a database connection:
If you plan to use a third-party JDBC driver for the BI JDBC driver, or the WebLogic JDBC drivers for DB2, Informix, SQL Server and Sybase, you must register it with JDeveloper so that it will be available when you define the connection.
To register a new third-party JDBC driver:
A new entry appears in the list and in the Driver Class field, with a default driver class name.
Make sure that the correct entry is still selected in the Registered JDBC Drivers list.
Be sure to include this library in any project that uses the third-party driver.
The driver will now appear in the list of available third-party JDBC drivers both in this dialog (after you return to it) and in the Create Database Connection dialog.
Alternately, if you are already in the Create Database Connection dialog, you can register a third-party JDBC driver without leaving the dialog. Choose Generic JDBC as the Connection Type, and click New to open the Register JDBC Driver dialog where you provide the class name and library for the driver.
To connect to a non-Oracle database, you first have to create a library containing the JDBC drivers.
After you have created a user library, you can create a database connection.
To create a user library:
The library containing the JDBC drivers will be available for you to select when you create a connection to the non-Oracle database.
When you create connections using Oracle's JDBC/OCI drivers, be aware of the following platform-specific requirements:
.dll files on Windows, and .so/.sl files on UNIX). With the Oracle Type 2 driver (JDBC/OCI), the version of the JDBC driver must match the version of the Oracle home. For example, the Oracle JDBC Driver version 11 requires that Oracle home contain version 11 of ocijdbc11.dll, as well as the Oracle Network software and Required Support Files.
You can download drivers from the JDBC Driver Downloads page at http://www.oracle.com/technetwork/database/features/jdbc/index-091264.html.
If you are connecting to a local database which is a different version from the JDBC driver you are using, then you must install the Oracle client software into a separate Oracle home, and connect via the Oracle Net Listener.
ORACLE_HOME directory in which the client-side file for the required native libraries resides into a directory listed in your PATH environment variable. ORACLE_HOME%\bin directory in which the client-side DLL file resides. If you have multiple Oracle homes installed on your machine, use the Oracle home Switch utility to choose the correct Oracle home. {ORACLE_HOME}/lib directory in which the client-side .so/.sl file resides in your PATH environment variable. ORACLE_HOME environment variable. java.library.path, you can edit {$ORACLE_HOME}/jdeveloper/jdev/bin/jdev.conf with a line similar to the following, replacing the path shown with the full path to your Oracle home: On Windows: AddNativeCodePath C:/ORACLE/ORAnn/BIN
On UNIX: AddNativeCodePath /u01/app/oracle/product/n.n.n/lib
AddNativeCodePath adds to java.library.path the directory name in which the Java VM searches for shared libraries.
| Note: BecauseAddNativeCodePath only appends the directory to the path, if you have an OCI driver path already in the PATH environment variable, set ORACLE_HOME instead of editing PATH with AddNativeCodePath. |
You can control how much of the data source you view and how you view it, and search for database objects.
You can browse online databases and offline database objects.
You can browse online databases by opening JDBC connections accessible in the Database Navigator.
JDBC connections permit access to PL/SQL objects and blocks and the Java classes that implement those objects. Any database can be browsed; however only Oracle Database permits access to the full range of database objects.
Database connections are shown in the Database Navigator, under the IDE Connections node or the node for the application. Expand the connection to show the database's schemas. By default, the connection only allows the schema of the user identified in the connection to be browsed. Other schemas can be browsed as well, if the user has the required privileges. Expanding a schema shows nodes for the object types that the schema contains. Expanding the node for an object type show the individual objects it contains. When you have expanded a node as far as it can be expanded, you can double-click an object (or right-click and choose Open) to display its content. Depending on the type of the object, its structure may also be displayed in the structure pane.
You can browse offline database objects using the Application Navigator.
You can view database objects:
Changes to database objects in projects (i.e. visible via Application Navigator) can be reconciled against a live database, but until reconciliation, no changes to the offline objects affect online databases.
To open a navigator:
You can browse schemas and the objects they contain via a JDBC connection to an online database.
To browse live database connections:
| Note: By default, a filter is set on tables to exclude those in the recycle bin for an Oracle database. |
Browse offline databases and schemas in the Application Navigator to find objects such as offline tables or views.
To view offline schemas and the objects they contain:
You can filter schemas, database object types, and database objects within a type, so that a subset that you define is displayed under the connection node. This is useful in environments where there may be thousands of schemas accessible from a connection.
| Note: When you create a connection to Oracle Database, objects for the schema named in the connection are shown. To see the contents of other schemas, expand the Other Users node and then expand the node for the schema you want.If you connect via Generic JDBC or JDBC-ODBC connections, all schemas are shown. |
You can define a filter for schemas in a connection, or for any set of object types (Tables, Views, etc.) within a schema, or for any set of objects within an object type node (for example, display only the tables that begin with DB).
To use filters:
With the object still selected, click the Apply Filter button in the Database Navigator toolbar and a dialog appears, showing the current selection, if any. From this dialog, you can change the filter currently applied.
JDeveloper provides filters so that you can view defined sets of schemas, tables, views, or other objects.
To create filters for online database objects:
%. You can open a table in a live database connection in the Database Object Viewer.
There are a number of tabs along the bottom of the Database Object Viewer that allow you to examine and change the structure of the table and the data contained in the table.
To view and edit the structure of the table in the object viewer:
An alternative way of viewing and editing the structure of a table is in the Edit Table dialog.
You can edit the data in a table.
You can change the data in a database table, for example to test the functionality of an application you are developing. You can change the value in a single cell, and add and delete rows. When you have finished you can choose to commit your changes to the database, or to rollback the changes and leave the database table unchanged.
To edit data in a table:
You can search for database objects in Oracle Database which has a connection to JDeveloper using the Find Database Object Window.
You must already have a connection to the database.
To find database objects:
For more information at any time, press F1 or click Help from within the navigator.
% to return a number of matching objects. For example, enter EM% to return all objects with names starting with EM. More to enter more search criteria. This section describes how to connect to Oracle and non-Oracle databases.
When you create a database connection using the Create Database Connection dialog, the new connection is created and a node representing the connection is displayed in the:
You can connect to and work with Oracle databases. For information about the specific versions that are supported, see "JDeveloper Certification Information" at http://www.oracle.com/technetwork/developer-tools/jdev/documentation/index.html.
JDeveloper allows you to connect to:
You can also connect to (although the connection does not use Oracle (JDBC):
To create a database connection to Oracle Database:
myserver. If the test succeeds, a success message appears in the status text area. If the test does not succeed, an error appears. In this case, change any previously entered information as needed to correct the error, or check the error content to determine other possible sources of the error.
JDeveloper allows you to connect to MySQL 4.1 or, 5.0, or to emulate MySQL 4.1 or, 5.0 for offline database operations. For more information about MySQL, see http://www.oracle.com/us/products/mysql/index.htm.
The Create Table or Edit Table dialog is generic, and some features may not be available when working with MySQL. You can:
To create a database connection to MySQL:
http://mysql.com/downloads, download and install MySQL Connector/J 3.1. mysql-connector-java-3.1.8-bin.jar. MySQL com.mysql.jdbc.Driver jdbc:mysql://machine-name/database-name Oracle TimesTen In-Memory Database is a memory-optimized relational database that provides applications with extremely fast response time and very high throughput as required by many application in a wide range of industries. Deployed in the application tier, TimesTen databases reside entirely in physical memory with persistence to disk storage for recoverability.
JDeveloper allows you to connect to Oracle TimesTen In-Memory Database 6.0, 7.0, or 11g, or to emulate TimesTen databases for offline database operations. For more information about Oracle TimesTen In-Memory Database 11g, see http://www.oracle.com/technetwork/database/timesten/overview/index.html.
The Create Table or Edit Table dialog is generic, and some features may not be available when working with TimesTen databases. You can:
To create a database connection to Oracle TimesTen In-Memory Database:
Generic JDBC com.timesten.jdbc.TimesTenDriver timesten-install\tt60\lib\classes14.jar timesten-install\tt70_32\lib\ttjdbc5.jar timesten-install\tt1121_32\lib\ttjdbc5.jar jdbc:timesten:client:RunDataCS60 jdbc:timesten:client:RunDataCS_tt70_32 jdbc:timesten:client:cachealone1_CS Oracle Database Lite allows an image of an Oracle database to exist on a remote device. Users can update the data on Oracle Database Lite and commit it to the main database at given intervals. For more information about Oracle Database Lite 10g, see http://www.oracle.com/technetwork/database/database-lite/overview/index.html.
JDeveloper supports connections to and database emulation of Oracle Database Lite 10g Release 1 and Release 3. For information, see "JDeveloper Certification Information" at http://www.oracle.com/technetwork/developer-tools/jdev/documentation/index.html.
This driver requires installation of Oracle Database Lite 4.0 JAR or higher. Projects using the driver must include ORACLE_HOME/lite/classes/olite.jar in a library.
To create a database connection to Oracle Database Lite:
oracle-database-lite/lite/classes/olite.jar. ide.conf file to provide one new value: ide.conf in the jdev-install/ide/bin directory. Use the following values:
Oracle Lite Type 2 You can connect to and work with non-Oracle databases. For information about the specific versions that are supported, see "JDeveloper Certification Information" at http://www.oracle.com/technetwork/developer-tools/jdev/documentation/index.html.
In general, you can:
Creating a database connection:
In the descriptions below for specific types of connection the JDBC URL is shown, however if you prefer you can enter details of the server, port, and database in the fields of the Create Database Connection dialog.
Apache Derby is an open source relational database implemented entirely in Java. JDeveloper allows you to connect to Apache Derby 10.5, or to emulate Apache Derby 10.5 for offline database operations. For more information about Apache Derby, see http://db.apache.org.
The Create Table or Edit Table dialog is generic, and some features may not be available when working with Apache Derby. You can:
| Note: Column default values are not supported |
You can connect to Apache Derby using Derby's embedded JDBC driver or you can create a connection as a client.
To connect to Apache Derby using the embedded driver:
Use the following values:
Generic JDBC org.apache.derby.jdbc.EmbeddedDriver lib/derbyclient.jar jdbc:derby://machine-name:port/databases/database-name To connect to Apache Derby as a client:
Use the following values:
Generic JDBC org.apache.derby.jdbc.ClientDriver lib/derbyclient.jar jdbc:derby://machine-name:port/databases/database-name JDeveloper allows you to connect to IBM DB2 Universal Database 9.5 or 8.1, or to emulate IBM DB2 Universal Database 9.5 or 8.1 for offline database operations. For more information about IBM DB2 Universal Database, see http://www.ibm.com.
The Create Table or Edit Table dialog is generic, and some features may not be available when working with IBM DB2, and working with IBM DB2 databases is subject to the following limitations:
| Notes: IBM DB2 Universal Database 9.5 syntax of DROP column and ALTER COLUMN is supported for IBM DB2 Universal Database 9.5.You can only connect to DB2 Universal Database 8.1 with Fix Patch 3 or higher, or to DB2 Universal Database 9.5. When you have a DB2 connection, column and constraint information is not displayed in the Database Navigator. Instead columns and constraints are displayed in the Structure window when the table is selected in the Database Navigator. |
You can connect to IBM DB2 using the WebLogic JDBC driver or using IBM's native driver.
To connect to IBM DB2 using the WebLogic JDBC driver:
Use the following values:
Generic JDBC weblogic.jdbc.db2.DB2Driver jdbc:weblogic:db2://machine-name:port;DatabaseName=database-name To connect to IBM DB2 using the native driver:
Use the following values:
DB2 UDB com.ibm.db2.jcc.DB2Driver jdbc:db2://machine-name:50000/database-name JDeveloper allows you to connect to IBM Informix DS 10 or 11.5, or to emulate IBM Informix DS 10 or 11.5 for offline database operations. For more information about IBM Informix DS, see www.IBM.com.
The Create Table or Edit Table dialog is generic, and some features may not be available when working with IBM Informix DS. You can:
You can connect to IBM Informix DS using the WebLogic JDBC driver or using IBM's native driver.
To connect to IBM Informix DS using the WebLogic JDBC driver:
Use the following values:
Generic JDBC weblogic.jdbc.informix.InformixDriver jdbc:weblogic:informix://machine-name:port;informixServer=server-name;databaseName=database-name To connect to IBM Informix DS using native drivers:
install-directory\lib\ifxjdbc.jar. Use the following values:
Generic JDBC com.informix.jdbc.IfxDriver jdbc:informix-sqli://machine-name:port/database-name:INFORMIXSERVER=machine-name JDeveloper allows you to connect to Microsoft SQL Server 2005, or 2008, or to emulate Microsoft SQL Server 2005, or 2008 for offline database operations. For more information about Microsoft SQL Server, see http://www.microsoft.com.
The Create Table or Edit Table dialog is generic, and some features may not be available when working with Microsoft SQL Server. You can:
You can connect to Microsoft SQL Server using the WebLogic JDBC driver or using Microsoft's native driver.
To connect to Microsoft SQL Server using the WebLogic JDBC driver:
Use the following values:
Generic JDBC weblogic.jdbc.sqlserver.SQLServerDriver jdbc:weblogic:sqlserver://machine-name\MSSQLSERVER:port;databaseName=database-name To connect to Microsoft SQL Server:
SQLServer com.microsoft.sqlserver.jdbc.SQLServerDriver jdbc:sqlserver://machine-name:port;DatabaseName=database-name, where the section DatabaseName=database-name is optional What you May Need to Know
If you are using Windows Authentication credentials to connect to Microsoft SQL Server, you need to add do the following:
integratedSecurity=TRUE and the username and password values to the JDBC URL, for example sqljdbc_auth.dll to your PATH variable: installation-directory\sqljdbc_version\language\auth\x86 installation-directory\sqljdbc_version\language\auth\x64 For more information, see Building the Connection URL, which is available as part of Connecting to SQL Server with the JDBC Driver at the Microsoft MSDN website.
SQLite is a relational database management system represented by a platform-independent file that resides on a host computer, for example, smartphone platforms. JDeveloper allows you to connect to a SQLite 3.6 database file, or to emulate SQLite 3.6 for offline database operations. For more information about SQLite, see http://www.sqlite.org.
The Create Table or Edit Table dialog is generic, and some features may not be available when working with SQLite. You can:
To create a database connection to SQLite:
Generic JDBC org.sqlite.JDBC jdbc:sqlite://path/database-name, where path is the path of the database file and database-name is the name of the SQLite database at the specified location. If the database does not exist at specified location, it will be created when the connection is made. JDeveloper allows you to connect to Sybase Adaptive Server Enterprise 12.5 or 15, or to emulate Sybase ASE 12.5 or 15 for offline database operations. For more information about Sybase Adaptive Server Enterprise, see www.sybase.com.
The Create Table or Edit Table dialog is generic, and some features may not be available when working with Sybase ASE. You can:
Add column(s)
| Note: Column default values are not supported |
You can connect to Sybase ASE using the WebLogic JDBC driver or using Sybase's native driver.
To connect to Sybase ASE using the WebLogic JDBC driver:
Use the following values:
Generic JDBC weblogic.jdbc.sybase.SybaseDriver jdbc:weblogic:sybase://machine-name:port;DatabaseName=databas-name To connect to Sybase ASE using the native driver:
Use the following values:
Generic JDBC com.sybase.jdbc2.jdbc.SybDriver com.sybase.jdbc3.jdbc.SybDriver jdbc:sybase:Tds:machine:port/database-name You can import data into tables in a database through a database connection.
| Note: You cannot import date into offline tables as offline tables are just representations of database tables. |
You can import data from:
You can import the data into:
When you choose the SQL*Loader option in the Data Import Wizard, JDeveloper creates the following files in the same location as the import file containing the data: table.ctl, which contains information about the file containing the data and the table into which it can be imported. table.bat and table.sh, to run the import.
For more information, see "SQL*Loader Concepts" in Oracle Database Utilities.
You can import data into an external table, which is a flat file in which you can query data as though it were an Oracle table.
When you choose the External Table option, JDeveloper creates the SQL and displays it in the SQL Worksheet where you can examine it and make any necessary changes before running the script.
For more information, see "External Table Concepts" in Oracle Database Utilities.
You can import data into a table in a database through a database connection.
The following import file formats are supported:
To import data to an existing database table:
Click OK to launch the Data Import Wizard.
For more information at any time, press F1 or click Help from within the wizard.
You can import data into a database table that you create as part of the import process.
To import data to a new database table:
For more information at any time, press F1 or click Help from within the wizard.
You can create a SQL*Loader control file which can be used to import data.
To import data to a SQL*Loader control file:
Click OK to launch the Data Import Wizard.
For more information at any time, press F1 or click Help from within the wizard.
table.ctl is created in the same location as the data file, along with a table.bat and table.sh files which allow you to run it. If you selected Send to worksheet on the Finish page of the Data Import wizard, the SQL defining the table is displayed in the SQL Worksheet. You can import data into tables in a database through a database connection.
To import data to an external table:
For more information at any time, press F1 or click Help from within the wizard.
You can export data from tables in a database through a database connection.
The data can be saved to a file or to the clipboard. The following formats are supported:
csv, to create a file containing comma-separated values including a header row for column identifiers. | Note: You can choose a different delimiter. |
fixed, to create a file where records are the same byte length. html, to create an HTML file containing a table with the data. insert, to create a file containing SQL INSERT statements. loader, to create a SQL*Loader control file. For more information, see "SQL*Loader Concepts" in Oracle Database Utilities. text, to create a text file. ttbulkcp, to create a data files to be used with the TimesTen ttbulkcp command line utility. For more information, see Oracle TimesTen In-Memory Database 11g at http://www.oracle.com/technology/products/timesten/index.html. xls, to create a Microsoft Excel .xls file. The file will contain two worksheets, Export Worksheet, which contains the data, and SQL which contains the SQL statement used to export the data. xml, to create a file containing XML tags and data. In the Export Data dialog, you can limit the data to be exported by selecting only some columns, and by entering a WHERE clause.
| Note: If you encounter problems exporting large tables to Microsoft Excel files, try adding the following line to thejdeveloper.conf file to increase heap size, and then restarting JDeveloper: AddVMOption -Xmx1024M If the number of table rows exceeds 65,536, JDeveloper writes the rows to multiple worksheets within the |
You can also export data from a database using the Export Database wizard.
You can export data from tables in a database through a database connection.
To export data from a database table:
For more information at any time, press F1 or click Help from within the wizard.
You can copy database objects from a source schema to a destination schema. You can export database objects and data to a DDL file.
You can copy database objects from a source schema to a destination schema, subject to any restrictions depending on the type of operation, which determines the behavior if objects of the same name exist in the destination schema.
You must have the source and the destination database connections already defined.
To copy a database:
For more information at any time, press F1 or click Help from within the wizard.
You can find differences between objects of the same type and name (for example, tables named CUSTOMERS) in two different schemas, and optionally update the objects in one schema (destination) to reflect differences in the other schema (source).
Using the Diff wizard requires the licensing of the Oracle Change Management option for Oracle Database. To purchase a license, contact your Oracle sales representative or authorized Oracle Reseller, or go to the Oracle Store to buy online at http://shop.oracle.com
You must have the source and the destination database connections already defined.
To compare database schemas:
For more information at any time, press F1 or click Help from within the wizard.
You can export some or all objects of one or more types of database objects to a file containing SQL data definition language (DDL) statements to create these objects. Export Database wizard allows you to: Specify details of the DDL file that is generated. Select the database object objects to be exported. Choose to export data, and apply filters to specify the data to be included in the generated file.
You must have already defined a connection to the database you want to export.
To export a database:
For more information at any time, press F1 or click Help from within the wizard.
This section describes how to work with Oracle Database, as well as with non-Oracle databases. There are limitations on what you can do with JDeveloper with different databases. For more information, see the relevant information in Section 26.4.2, "How to Create Connections to Oracle Databases" and Section 26.4.3, "How to Create Connections to Non-Oracle Databases."
JDeveloper provides many reports about a database and its objects. You can also create your own user-defined database reports.
You can also run reports on offline database objects.
JDeveloper provides many reports about a database and its objects. You can also create your own user-defined database reports.
For some reports, you are prompted for bind variables before the report is generated. These bind variables enable you to further restrict the output. The default value for all bind variables is null, which implies no further restrictions.
The Database Reports Navigator allows you to run reports which query the database for the latest information. The time required to display specific reports will vary, and may be affected by the number and complexity of objects involved, and by the speed of the network connection to the database.
There are a number of predefined reports about the database and its objects.
You can also create your own user-defined reports.
You can examine the underlying SQL for a report, for example, to help you create your own report.
Database reports are organized in folders, and reports and folders can be exported.
You can share reports by exporting them.
The person who wants to share the report then adds it to their instance of JDeveloper using the Preferences dialog. Reports that have been exported can be imported into folders under the User Defined Reports node.
The Database Reports Navigator allows you to run reports which query the database for the latest information. The time required to display specific reports will vary, and may be affected by the number and complexity of objects involved, and by the speed of the network connection to the database.
Running a database report:
The report results are displayed in the Reports Viewer.
You can view the underlying SQL for a database report in the SQL Worksheet.
To view the SQL for a database report:
You can define your own reports for database features and objects.
To create user-defined reports:
You can edit user-defined reports.
To edit a user-defined report:
You can organize user-defined reports in folders.
To create a folder:
You can export database reports or folders of database reports.
If you are sharing a report, you export it, and users who want to share the report, then make it available in their instance of JDeveloper.
To export a database report or folder:
explain.xml. After you have exported database reports and folders, you can import them to a user-defined folder.
You need to first create the folder to hold the report.
This can also be a simple way to share database reports.
To import a database report or folder:
explain.xml. How to Share Database Reports
You can share database reports. The report is exported, then you add it to your invocation of JDeveloper.
Before a report can be shared:
Sharing a database report:
This section describes the pre-defined reports available under the Data Dictionary Reports node in the Database Reports navigator.
The reports are grouped into categories, with one or more different reports available in that category.
These reports list release information about the database associated with the connection. The reports include Version Banner (database settings) and National Language Support Parameters (NLS_xxx parameter values for globalization support).
These reports list information about all objects accessible to the user associated with the specified database connection, not just objects owned by the user.
These reports list information about Oracle Application Express 3.0.1 (or later) applications, pages, schemas, UI defaults, and workspaces. If you select a connection for a schema that owns any Oracle Application Express 3.0.1 (or later) applications, the Application Express reports list information about applications, pages, schemas, UI defaults, and workspaces. For more information, see Oracle Application Express Administration Guide.
These reports list information provided by the Active Session History (ASH) and Automated Workload Repository (AWR) features.
These reports list usage information about system resources. This information can help you to manage storage, user accounts, and sessions efficiently. (The user for the database connection must have the DBA role to see most Database Administration reports.)
These reports list information about the data dictionary views that are accessible in the database. Examples of data dictionary views are ALL_OBJECTS and USER_TABLES.
These reports list information about jobs running on the database.
These reports list information about your PL/SQL objects and allow you to search the source of those objects.
These reports list information about users that have been granted privileges, and in some cases about the users that granted the privileges. This information can help you (or the database administrator if you are not a DBA) to understand possible security issues and vulnerabilities, and to decide on the appropriate action to take (for example, revoking certain privileges from users that do not need those privileges).
These reports list information about stream rules.
These reports list information about tables owned by the user associated with the specified connection. This information is not specifically designed to identify problem areas; however, depending on your resources and requirements, some of the information might indicate things that you should monitor or address.
For table reports, the owner is the user associated with the database connection.
These reports list information about XML objects.
This section contains information to help you if you have problems connecting to a database.
If you get the following ORA-29552: verification warning: java.lang.UnsupportedClassVersionError when deploying Java to the database you need to change the version of the JDK used for that project to a version compatible with that used by the database.
This version of JDeveloper uses Java JDK Version 1.6.
Table 26-1 JDK Version Used by Different Database Versions
| RDBMS Version | JDK Version |
|---|---|
| 9.2 | 1.3.1 |
| 10.2 | 1.4.2_04 |
| 11.1 | 1.5.0_10 |
| 11.2 | 1.5.0_10 |
For information about changing the Java SE on a project by project basis, see the section on setting the target Java SE in How to Set Properties for Individual Projects.
You can download previous releases of Java SE from http://www.oracle.com/technetwork/java/javase/downloads/previous-jsp-138793.html.
This chapter describes how to:
This chapter includes the following sections:
You can use JDeveloper to:
You can create database objects and offline database definitions, you can edit those objects, and you can delete them or drop them a database connection.
This section describes how to work with database objects, such as tables, views, constraints, outside the context of a database schema. Offline database is a technology in JDeveloper that allows you to create and edit database object definitions within a project, saved as .xml files, using the same editors that are used to create and edit database objects on live database connections.
You can create new offline database objects, or import them from a connection to a live database. After you have finished working with them, you can generate DDL that can be used to create and update database definitions in online database schemas.
The JDeveloper Offline database supports the following object types:
For more information about Oracle Database support of any of these object types, see the Oracle Database SQL Language Reference.
Working with Offline Database Definitions
When you work with offline database definitions in JDeveloper, you work with objects that are stored as XML files, but which provide a model of objects in a live database connections. You can generate offline database definitions to live database connections to create, alter, or drop database objects.
JDeveloper provides the tools you need to create and edit database objects such as tables and constraints outside the context of a database. For example
How to Set Paths for Offline Database Files
You can configure a project's settings to specify the root locations for offline database objects available to that project. The database path is configured by default, so you only need to change it if you want to:
Offline database objects can be shared between projects by adding their file system location to the database path for a project. The order in which file system locations are entered in the database path signifies the order in which the directories are searched for offline database objects. The first location in the database path is the location in which new offline database object files are stored.
If you are modeling database objects, the model path (located on the Modelers preferences page in the Project Properties dialog) is used to specify the file location for the diagram.
| Note: When you are adding another database path to a project, you should save your work before proceeding. When you change the database path, the project reloads the offline database object definitions so any unsaved work for example, changes to tables, views, schemas or new objects that you have not yet saved, may be lost. |
You can set a default root directory for database objects that will be used for all new projects.
To set the default root directory for database objects for new projects:
You can change the database path for an existing project.
Setting the database path for an existing project:
;). JDeveloper works with offline database definitions in the context of offline databases that act as containers in a similar way to packages. In the Application Navigator, the offline database is shown below the Offline Database Sources node, shown in Figure 27-1.
In this case, a Java class and a database diagram have been created in the package project1, which is under the Application Sources node, and some offline database definitions have been created in an offline database called DATABASE1, which is under the Offline Database Sources node.
When you create an offline database, you choose the database emulation the offline database should have.
You can specify the type of database an offline database emulates. This determines the data types supported in the project.
The Oracle Database options available are:
The non-Oracle database options available are:
An offline database is a node in the Application Navigator that contains offline schemas and offline database object definitions.
To create an offline database:
For more information at any time, press F1 or click Help from within Create Offline Database dialog.
JDeveloper works with offline database definitions in the context of offline databases. Within the offline databases, schemas are the equivalent of schemas in live database connections. In the Application Navigator, the offline schema is shown below the Offline Database Sources node, illustrated in Figure 27-2.
In this case, a Java class and a database diagram have been created in the package project1, which is under the Application Sources node, and some offline database definitions have been created in a schema called MYSCHEMA, which is in an offline database called DATABASE1 under the Offline Database Sources node.
To create an offline schema:
Context Menu Shortcut:
In the Application Navigator, right-click the offline database, and choose New Schema.
You can create offline database objects from the New Gallery, or from the context menu of an offline database or offline schema in the Application Navigator. The process is similar regardless of the offline database object type.
About Tables
The types of tables that are available are:
| Note: You can only create and use relational table definitions in offline schemas, you cannot create and use object relational table definitions. |
About Partitions
You can partition a table, an index, or a materialized view. A partitioned table or materialized view is a table or materialized view that is organized into smaller and more manageable pieces called partitions. SQL queries and DML statements do not need to be modified in order to access partitioned tables; however, after partitions are defined, DDL statements can access and manipulate individual partitions rather than entire tables or indexes. Also, partitioning is entirely transparent to applications.
Temporary tables cannot be partitioned.
A partitioned index consists of partitions containing an entry for each value that appears in the indexed column(s) of the table.
There are three types of partitions:
If you have a RANGE partition on a table or index, you can additionally subpartition the table or index by HASH or LIST. Composite partitioning is a combination of two partitioning methods to further divide the data into subpartitions.
You can define subpartition templates which will be used in any partition for which you do not explicitly define subpartitions.
| Note: A table or index in Oracle Database which uses a hash partition by quantity will be displayed in JDeveloper as having individual hash partitions. You can either specify your individual partitions manually using the Create or Edit Table or Materialized View dialog, or define them by quantity and let the database do the work for you. Whichever way you choose to define your partitions, when you edit the database table or materialized view in JDeveloper, they will be displayed as individual partitions. |
About Indexes
You can create indexes on columns in tables in order to speed up queries. Indexes provide faster access to data for operations that return a small portion of a table's rows. In general, you may want to create an index on a column in any of the following situations:
You can create an index on any column; however, if the column is not used in any of these situations, creating an index on the column does not increase performance and the index takes up resources unnecessarily. Although the database creates an index for you on a column with an integrity constraint, explicitly creating an index on such a column is recommended. You can use the SQL Worksheet's execution plan to show a theoretical execution plan of a given query statement.
Indexes can be normal, where the index is either non-unique, unique, or bitmap, or they can be domain indexes.
In a non-unique normal index, the index can contain multiple identical values. In a unique normal index, no duplicate values are permitted. Use a unique normal index when values are unique in the column. In a bitmap normal index, rowids associated with a key value are stored as a bitmap. These are useful for systems in which data is not frequently updated by many concurrent systems, or where there is a small range of values.
Domain indexes are user-defined indexes, each of which indexes data in an application-specific domain. They are built using the indexing logic supplied by a user-defined indextype. An indextype provides an efficient mechanism to access data that satisfy certain operator predicates. Typically, the user-defined indextype is part of an Oracle option, like the Spatial option.
Working with User-Defined Data Types
JDeveloper allows you to define your own data types, which can be either object types and collection types.
Object types are abstractions of the real-world entities—for example, purchase orders—that application programs deal with. An object type is a schema object with three kinds of components:
An object type is a template. A structured data unit that matches the template is called an object.
JDeveloper allows you to create an object type specification, or an object type specification and body.
When you create a new object type spec, it is similar to
When you create an object type body, it is similar to
Collection types are different. Each collection type describes a data unit made up of an indefinite number of elements, all of the same data type. The collection types are array types and table types.
Array types and table types are schema objects. The corresponding data units are called VARRAYs and nested tables. When there is no danger of confusion, we often refer to the collection types as VARRAYs and nested tables.
Collection types have constructor methods. The name of the constructor method is the name of the type, and its argument is a comma-separated list of the new collection's elements. The constructor method is a function. It returns the new collection as its value.
An expression consisting of the type name followed by empty parentheses represents a call to the constructor method to create an empty collection of that type. An empty collection is different from a null collection.
JDeveloper allows you to create array types and table types.
n array type is similar to
A table type is similar to
| Note: In order to use data types when the project is configured for database emulation other than Oracle Database, the database it emulates must support type creation. |
About Materialized Views
Materialized views are database objects that contain the results of a query. The FROM clause of the query can name tables, views, and other materialized views. You can model, create, and edit materialized views in a live database connection, and offline materialized views in an offline database in JDeveloper.
When importing materialized views from Oracle Database to a JDeveloper project:
Validating Date and Time Values
When you create offline table definitions or tables in a database and use date and time default values, JDeveloper validates these values. For a date, you can use:
For a time stamp, you can use a quoted string of the form DD-MON-RR HH.MI.SSXFF AM TZR, where:
When you import tables from a database, date and time values are validated according to the rules above. If the validation prevents you from importing a table from Oracle Database, you can turn it off.
To turn off date and time validation:
To create an offline type definition:
For more information at any time, press F1 or click Help from within the Create Offline Type dialog.
Context Menu Shortcut:
In the Application Navigator, right-click the offline schema, select New Database Object, then select New Type.
You can edit user-defined types by double-clicking the type in the Application Navigator. The SQL comprising the type opens in the source editor.
To create offline database object definitions:
| Note: You can only create and use relational table definitions in offline schemas, you cannot create and use object relational table definitions. |
For more information at any time, press F1 or click Help from within the Create Offline Type dialog.
Context Menu Shortcut:
In the Application Navigator, right-click the offline schema, select New Database Object, then select object you want to create.
To drop an offline database definition:
Alternatively, right-click the offline table and choose File > Delete.
| Note: If the offline table has any dependencies, the Confirm Delete dialog warns you and allows you to see the usages. If you still choose to delete the offline table, the Cascade Confirm Delete dialog warns you which objects will also be deleted. |
You can drag tables, views, materialized views, synonyms, and sequences from a database schema onto a database diagram, where they become accessible as offline database objects.
Another way of working with database objects as offline database objects is to import them from a database to an offline database.
To drag objects onto a database diagram:
Alternatively, open an existing diagram.
Expand IDE Connections or application, and select a database connection.
You can drag more than one object of the same type onto a database diagram, by holding down the Ctrl key as you select them.
| Note: If you import the same object more than once a warning message is displayed. If you are using Copy to Project and choose to proceed, you can replace or delete the existing object. If you drag a database object onto the diagram and choose to proceed the new object overwrites the existing one. |
How to Copy Database Objects and Offline Database Definitions to Projects
You can copy database objects from a database schema to an offline database where they become available as offline database objects. You can also copy offline database objects to a project.
If you try to copy database objects to an offline database which emulates a different database version you will see an error message giving you guidance on how to proceed. In general, it is a good idea to make sure that the offline database uses the same database emulation as the source database.
You can apply filters in the wizard to only display the objects you are interested in, and when there are a large number of objects in the schema you can turn off auto-query so that the wizard does not refresh every time you type a filter character.
You can apply filters to select the objects that are displayed as available for import. In the Object Picker page (step 3 of the wizard), you can:
To import database objects:
For more information at any time, press F1 or click Help from within the wizard.
When you import a table from a live database schema to JDeveloper, information about any foreign keys will not necessarily be available. The following sections discuss how foreign key information is treated in different cases.
Importing Tables at Both Ends of a Foreign Key
This is the simplest case. When JDeveloper imports tables that have foreign keys between them, information about the foreign key is also imported. Therefore the foreign key is correctly shown on a database diagram and on the Constraint Information page of the Edit Offline Table dialog.
After you have finished working on the tables you can choose to generate your changes directly back to the database.
Importing a Table at One End of a Foreign Key
In the case that JDeveloper imports a table that has a foreign key, but the table at the other end of the key is not imported, an unvalidated foreign key reference (called a name-based foreign key) is used. The foreign key is displayed in the Constraints compartment of the owning table, but not as association lines on the database diagram. The table dialog will show the foreign key as broken. The name-based foreign key is not validated, but the DDL is correct so that changes can be generated directly to a database.
Best Practice
From the information above you can see that if you are importing tables to act as the basis of a new database schema, then you do not need to worry about foreign keys to tables that you are not interested in. You can safely make your changes and generate the online tables in a new schema.
However if you are importing tables so that you can make the changes you want and then generate the changes back to the same database schema you should either:
You can refresh any imported offline object from the database connection it was originally imported from. Note that if you reimport the object, you will lose any changes you have made in the offline object.
| Note: You cannot refresh an object that was created as an offline object in JDeveloper and then generated to the database. If you make changes to the object in the database and want those changes to be reflected in the offline object, you must import the object from the database and overwrite the offline object by selecting Automatically replace existing objects on the Select Target Schema page, or selecting Yes on the Confirm Overwrite message at the end of the wizard. |
To reimport an object from a database connection:
You can create offline database objects based on templates, for example: To use a default set of storage options for all tables created. To use a default set of user property values for all tables created. To use a set of default columns for all tables created. A template table can create a default primary key, a column sequence, and a trigger.
When you create a new object using the template, the properties that are set on the template are copied to the new object and therefore pre-populate the options in the create dialog. When the namespace of owned objects is not the parent object, the name must be unique within the schema, not just within the parent object. For example, Index and Constraint names must be unique within the schema, not just within the owning Table, Materialized View, or View.
How to Create Offline Templates
You can create offline database objects from templates.
To create default templates for an offline database:
TEMPLATE_object. You can edit the template database objects by right-clicking the one you want and choosing Properties, which opens the Edit object dialog. To edit the default templates for a new offline database:
To edit the default templates for an existing offline database:
How to Create Offline Database Objects from Templates
You can create offline database objects from templates as offline database objects in the Application Navigator, or as modeled offline database objects on a database diagram.
Before creating offline database objects based on templates, you first need to create the templates.
To create an offline database object based on a template:
When you click OK the object is created and listed in the Application Navigator under the offline database and schema.
You can also open the Choose Template Object dialog from the context menu of an offline database, or any node under it, in the Application Navigator.
To quickly create an offline database object based on a template:
To quickly create an offline database object based on another offline database object:
You can add user defined properties to database objects. For an instance of a database object; these user defined properties can be assigned specific values.
You can work with libraries that can limit the properties you can define for an offline database object. For example, you can determine that all tables must have a column of a particular type, or that only certain values are allowed, or that a property is mandatory.
User property libraries are defined in the context of an offline database. First you have to define user properties for the types of offline database objects you want to use. Then you can use the libraries when creating offline database objects in the offline database that the library is defined for.
User property libraries can contain properties defined for:
User property libraries are independent of offline databases, but can be added to them using the offline database edit dialog.
To create or use a user property library:
Once you have created a user property library for an offline database object type, you can use it to store user property value specific to that instance of the object.
You can provide validation for the user defined property value to validate the database objects by writing your own validation code. This is an advanced procedure which is outside the scope of this user guide. For more information see UserPropertyValidationManager in Oracle Fusion Middleware Java API Reference for Oracle Extension SDK. For information about using the Extension SDK, see Oracle Fusion Middleware Developer's Guide for Oracle JDeveloper Extensions.
Use user properties for database objects
Before you can use user properties in offline database objects, you must define one or more user property libraries for the offline database you are working in.
To use user properties in an offline database object:
The Generate SQL from Offline Database Objects wizard allows you to choose how to update a database schema with the offline objects that you have created or edited. You can:
If you choose to generate a SQL file, it will contain CREATE and DROP statements.
If you choose to generate a SQL file, it will contain ALTER statements.
Whether you are generating changes to a database, or reconciling changes, you can choose to:
Alternatively, if you just want to generate one or more offline tables back to the database connection they were originally imported from, you can do this directly from the navigator.
| Note: If you have made changes to tables that have foreign keys, it is possible that the foreign keys will be dropped when you generate your changes to the database. |
This section contains information about problems you may come across when reconciling.
Constraints can be created or dropped during reconciliation; they cannot be modified. The only ALTER TABLE reconciliations that can be performed are ADD CONSTRAINT, DROP CONSTRAINT, ADD COLUMN, DROP COLUMN, and WIDEN COLUMN.
You can change the name of a table when you import it or while you are editing it offline. If you try to reconcile the renamed table back to the database, you will receive an error message because the database does not have a record of the table with its new name.
To avoid this, create the renamed table in the database, do not reconcile or replace it.
How to Generate Database Definitions to a Database
Create a SQL file containing the CREATE and DROP statements that you can run against an online database schema.
| Note: If you have made changes to tables that have foreign keys, it is possible that the foreign keys will be dropped when you generate your changes to the database.If you have one or more offline database definitions containing information that you want to generate to a database, you can use this method. However if you want to quickly generate one or more offline database definitions back to their original database connection, you can do this from the navigator. When you have an offline version of an online database table, JDeveloper keeps track of the information comprising the offline database table columns behind the scenes. When the database is updated outside JDeveloper, for example when the generated SQL script is run in a SQL session, or when another user updates the database, JDeveloper cannot track the link between the offline database table and the table in the database. To get around this, you must refresh the offline schema objects from the database. |
To create the file:
Context Menu Shortcut:
In the navigator, right-click one or more offline database definitions and choose Generate to
or On the database diagram select one or more modeled database definitions, right-click and choose Synchronize with Database > Generate To.
JDeveloper has a limited ability to keep track of renamed offline database objects such as tables and sub objects such as columns or constraints. In some circumstances JDeveloper will drop the database object with the unchanged name and create a new database object with the new name, which can lead to loss of data. You need to be aware of the situations when this can arise so as to avoid them.
This can occur when an offline database object is generated to a database connection. If you then change the name of the offline database object or of a sub object such as a column or index, and then generate the changed offline database object to a database connection, in the database the object with the original name is dropped and a new object using the new name is created.
A different situation which can lead to loss of data is when an object is imported from a database connection, then the name of an offline database sub object is changed. In this case, the first time you generate to a database connection the database sub object is correctly updated. However if you attempt to generate to the database connection a second time the sub object with the original name is dropped and a new database sub object with the new name is created. The reason that this happens is because Copy to Project uses the original name in an internal reference to the online sub object.
JDeveloper provides many reports about an offline database and its objects. You can also create your own user-defined reports for offline database objects.
JDeveloper comes with a set of pre-built report definitions, and you can also define your own report definitions.
You can use the pre-built reports directly to provide information about an offline database, or you can alter them to create a report tailored to your specific requirements.
Once you have created a pre-built report, you can examine the SQL that makes up the query for the report, and if necessary change it. You can also set parameters in the report query that are called when the report is run.
The pre-built reports quickly provide useful reports which provide the following queries for an offline database:
When you run the Pre-Built Reports wizard, a separate file is generated for each of the pre-built reports that you choose to the location that you specified, and the file is listed in the Application Navigator under Resources.
You can examine the query for one of the pre-built reports by creating a new offline database report definition, and basing it on the pre-built report. You can also create a new report based on a pre-built report.
| Note: If you specify a location that is outside the current project the reports are generated, but they are not listed in the Application Navigator. The files have the file name pre-built-report.report, and they are structured as XML files. |
How to use predefined reports:
To edit a predefined report:
To run a pre-built report:
You can define your own report definitions. You can either define a query from scratch, or you can base the new report definition on an existing report or on one of the pre-built reports.
You can specify that just the report definition is produced, or you can specify that when the report definition is run a comma-separated file is produced, or that a formatted HTML document is produced.
If you choose to generate an HTML document, you can optionally specify that a CSS file is used, and you can edit the default boilerplate text that formats the body of the HTML document.
How to create a report:
To run a report:
JDeveloper provides some boiler-plate code to help you to format the report, and it includes three new HTML tags:
The boiler-plate code provided is:
Example 27-1 Boiler-plate code for User-Defined Reports
You can edit this in the Create or Edit Report dialog to customize the report.
You can change the properties of defined reports:
To edit a report:
You can transform a UML Class model to an offline database model using the Offline Database Objects from UML Class Model wizard. For more information, see Section 22.7.1, "How to Transform UML and Offline Databases."
Developer provides a number of features for developing in teams, including several version control software systems. These are described in Chapter 6, "Versioning Applications with Source Control".
Offline table definitions can be version controlled and shared using a source control system. JDeveloper provides a compare tool optimized for working with offline table definitions:
| Note: While you can only compare versions of offline database objects using a source control system, for example to see the dependency of a constraint on a column, you can manually reconcile changes before committing them to a database using the Generate SQL from Offline Database Objects wizard. For more information, see Section 27.2.1.12, "How to Generate Offline Database Objects to the Database." |
You can create database objects in a database connection in the Database Navigator.
You must have a database connection in order to create database objects, and the user name used to create that connection must have the privilege to create the database object, either by having been granted the appropriate privileges (CREATE, DROP, and so on) or having been granted a role such as administrator that contains the privilege.
For more information about Oracle Database objects, see the Oracle Database SQL Language Reference.
To create a database object in the Database Navigator:
Alternatively, click File > New to open the New Gallery. In the New Gallery, expand Database Tier, and select Database Objects. Select the offline database object type you want to create to launch the Create dialog or wizard.
For more information at any time, press F1 or click Help from within the Create object dialog.
To edit a database object:
For more information at any time, press F1 or click Help from within the Create object dialog.
To drop a database object:
JDeveloper provides a number of predefined reports about the database and its objects. You can also create your own user-defined database reports.
Database reports that query the database for latest information are run from the Database Reports Navigator. For more information, see Section 25.3, "Using the Database Reports Navigator."
You can generate database objects and offline database definitions to SQL scripts. You can also generate tables to Oracle MetaBase (OMB) scripts, which can be imported into Oracle Warehouse Builder.
You can create SQL scripts from offline database definitions in the Application Navigator, or from database objects in the Database Navigator.
To create a SQL script from a database object in the Database Navigator or from an offline database object in the Application Navigator:
or
Choose View > Application Navigator, navigate to the offline database definition you want to create the script from.
You can create scripts formatted as Oracle MetaBase (OMB) scripts for Oracle Warehouse Builder from offline tables in the Application Navigator.
The default name of the script is omb_scriptn.tcl, and it is generated into the current project and appears in the navigator under the same offline database as the tables from which is it generated.
To create a OMB script from a table in the Application Navigator:
JDeveloper supports features that allow you to write and execute Java programs that access Oracle Databases.
This chapter includes the following sections:
There are three aspects to using Java in the database:
JDeveloper supports two mechanisms for embedding SQL in Java programs:
SQLJ allows you to code at a higher level than JDBC, by embedding SQL statements directly in your Java code. The SQLJ precompiler that is integrated into JDeveloper translates the SQL into Java plus JDBC code for you. SQLJ with JDeveloper lets you write and debug applications much faster than you can using just JDBC.
You can mix JDBC calls with SQLJ statements in your program. One way to do this is through connection context sharing.
SQLJ is a standard way to embed static SQL statements in Java programs. SQLJ applications are portable and can communicate with databases from multiple vendors using standard JDBC drivers.
SQLJ provides a way to develop applications both on the client side and on the middle-tier that access databases using Java. Developing in SQLJ is fast and efficient, and JDeveloper completely supports SQLJ development. You can create or include SQLJ files in your JDeveloper projects. When you compile a project that contains SQLJ source files, JDeveloper automatically calls the SQLJ translator, or precompiler. The translator produces completely standard Java source code, with calls to JDBC methods to provide the database support. JDeveloper then compiles the Java that the SQLJ translator generates.
For more information, see the Oracle Database SQLJ Developer's Guide.
JDBC provides Java programs with low-level access to databases.
Oracle JDBC drivers can be grouped into two main categories with the following attributes:
The following figure illustrates how JDBC components and the driver run in the same memory space as an applet.
Figure 28-1 JDBC Components

The following figure illustrates how the Oracle JDBC OCI drivers run in a separate memory space from your Java application. These JDBC drivers make OCI calls to a separately loaded file.
Figure 28-2 Oracle JDBC OCI Drivers

| Note: Take care not to confuse the terms JDBC and JDBC drivers. All Java applications, no matter how they are developed or where they execute, ultimately use the JDBC-level drivers to connect to Oracle. However, coding using the pure JDBC API is low-level development, akin to using the Oracle Call Interface (OCI) to develop a database application. Like the OCI, the JDBC API provides a very powerful, but also very code-intensive, way of developing an application. |
How does SQLJ compare to JDBC? Here are some of the advantages that SQLJ offers over coding directly in JDBC:
However, JDBC provides finer-grained control over the execution of SQL statements and offers true dynamic SQL capability. If your application requires dynamic capability (discovery of database or instance metadata at runtime), then you should use JDBC.
You have to perform a number of tasks to embed SQL in Java programs with SQLJ.
You can create a new SQL (.sql) file and add it to the current project.
To create a SQL file:
For more information at any time, press F1 or click Help from within the dialog.
An empty SQL file is added to the current project and opened for editing.
Create a new SQLJ (.sqlj) file and add it to the current project.
To create a new SQLJ file:
For more information at any time, press F1 or click Help from within the dialog.
For more information at any time, press F1 or click Help from within the dialog.
A skeleton SQLJ class will be added to the current project and be opened for editing.
You can compile SQLJ classes into Java .class files.
To compile a SQLJ class:
The status bar at the bottom of the JDeveloper window shows the result of the compilation. Errors, if any, are listed in the log window.
A SQLJ executable statement can designate a connection context object that specifies the database connection where the SQL operation in that clause will execute. If the SQLJ statement omits the connection context clause, then the default connection context is used.
A connection context is an object of a connection context class, which you define using a SQLJ connection declaration.
To declare a context class:
Named connection contexts are not required: SQLJ statements that omit the connection context name use the default connection context.
For example, this statement declares the context class MyConnectionContext:
Context classes extend sqlj.runtime.ref.ConnectionContextImpl and implement sqlj.runtime.ConnectionContext.
After you have declared a context class, create a context object.
Before it can be used in an SQLJ statement, a declared connection context must be created.
To create a context object:
For example, use this statement to create an instance thisCtx for the connection context class MyConnectionContext:
You debug SQLJ code by debugging the SQLJ source directly, not the generated Java code.
SQLJ is debugged in JDeveloper in the same manner as other source code.
For more information, see the Oracle Database SQLJ Developer's Guide.
You debug SQLJ code by debugging the SQLJ source directly, not the generated Java code.
SQLJ is debugged in JDeveloper in the same manner as other source code.
For more information, see the Oracle Database SQLJ Developer's Guide.
You can control the translation of SQLJ classes through the controls in the Project Properties dialog:
To set the SQLJ translator options:
You can set SQLJ translator properties for all projects by choosing Default Project Properties from the Application menu
SQLJ connection options specify the database connection for online checking. The general form for connection options is
where option is one of the four options listed below.
The context tag is a connection context type, which permits the use of separate exemplar schemas for each of the connection contexts. If you omit the connection context type, the value will be used for any SQL statements that use the default connection context. The driver option does not allow a context tag.
The options are:
user This option specifies the user name for connecting to a database in order to perform semantic analysis of the SQL expressions embedded in a SQLJ program. It contains the user name, for example: The user command line option may include a connection context type. For example:
Whenever a user name is required for the connection to a database context Ctx1, SQLJ uses the user option that was tagged with Ctx1. If it can not find one, SQLJ issues a message and looks for an untagged user option to use instead.
Specifying a user value indicates to SQLJ that online checking is to be performed. If you do not specify the user option, SQLJ does not connect to the database for semantic analysis. There is no default value for the user option.
If you have turned on online checking by default (by specifying, for example, -user=hr), then in order to disable online checking for a particular connection context type Ctx2, you must explicitly specify an empty user name, for example:
password This option specifies a password for the user. The password will be requested interactively if it is not supplied. This option can be tagged with a connection context type. Examples of the two forms are: url This option specifies a JDBC URL for establishing a database connection. The default is jdbc:oracle:oci9:@. This option can be tagged with a connection context type. For example: driver This option specifies a list of JDBC drivers that should be registered in order to interpret JDBC connection URLs for online analysis. The default is oracle.jdbc.driver.OracleDriver. For example: This option cannot be tagged with a connection context type.
JDBC provides Java programs with low-level access to databases.
For more information, see the Oracle Database SQLJ Developer's Guide.
JDBC uses a driver manager to support different drivers, so that you can connect to multiple database servers. To connect your database application to a data server, you must have available the appropriate JDBC driver. JDeveloper provides the Oracle Thin and OCI JDBC drivers. OCI for Oracle is the default driver. If you wish you may install a non-default JDBC driver.
Consider the following when choosing a JDBC driver to use for your application or applet:
| Note: When the JDBC Thin driver is used with an applet, the client browser must have the capability to support Java sockets. |
| Note: JDeveloper does not supply the server-side Thin driver. |
| Note: JDeveloper does not supply the server-side Thin driver. |
If your JDeveloper programming environment as been modified to allow the use of a non-default JDBC driver, you can modify the current project to use the new driver by performing these steps.
To modify the project:
If necessary, select the library you added and drag it up to the top of the list.
You can establish a database connection in pure JDBC code.
A summary is given here, but for more information, see "Getting Started" in the Oracle Database JDBC Developer's Guide.
To code a JDBC Connection:
This statement is required for all JDBC programming.
Oracle.connect() method to set the default connection, the Oracle JDBC drivers are automatically registered. Alternatively, if you are using an Oracle JDBC driver, but do not use Oracle.connect(), then you must manually register the Oracle Driver class using the statement
If you are not using an Oracle JDBC driver, then you must register an appropriate driver class:
In any case, you must also set your connection URL, user name, and password.
getConnection() method, for example Use Oracle JPublisher to access Oracle objects and PL/SQL packages from your Java programs. Oracle JPublisher lets you specify and customize the mapping of Oracle object types, reference types, and collection types to Java classes in a strongly typed paradigm
You can use JPublisher to access Oracle objects and PL/SQL packages from your Java programs. JPublisher lets you specify and customize the mapping of Oracle object types, reference types, and collection types to Java classes in a strongly typed paradigm.
Also, SQLJ programmers who want to call stored procedures declared in PL/SQL packages can use JPublisher to generate SQLJ wrapper classes for the packages. The SQLJ wrapper classes let you invoke the PL/SQL stored procedures, and pass and return values from them, directly from your SQLJ program.
To access Oracle objects and PL/SQL packages using Java:
oracle.sql.CustomDatum interface. .sqlj files, and the Java or SQLJ compiler compiles the .java files. This process is illustrated in the following figure:
Figure 28-3 Oracle Objects and PL/SQL Packages

Oracle JPublisher increases your productivity by letting you access Oracle objects and PL/SQL packages from your Java programs. Oracle JPublisher lets you specify and customize the mapping of Oracle object types, reference types, and collection types (VARRAYs or nested tables) to Java classes in a strongly typed paradigm
JPublisher
JPublisher increases your productivity by letting you access Oracle objects and PL/SQL packages from your Java programs. JPublisher lets you specify and customize the mapping of Oracle object types, reference types, and collection types (VARRAYs or nested tables) to Java classes in a strongly typed paradigm.
SQLJ programmers who want to call stored procedures declared in PL/SQL packages can use JPublisher to generate SQLJ wrapper classes for the packages. The SQLJ wrapper classes let you invoke the PL/SQL stored procedures, and pass and return values from them, directly from your SQLJ program.
For more information, see the Oracle Database JPublisher User's Guide.
Object Types and JPublisher
JPublisher allows your Java language applications to use user-defined object types in Oracle Database. These objects can be user-defined objects, VARRAYs, nested tables, index-by tables, or REFs to object types. If you intend to have your Java-language application access object data, then it must represent the data in a Java format. JPublisher helps you do this by creating the mapping between object types and Java classes, and between object attribute types and their corresponding Java types.
The mapping is determined by both:
Additionally, JPublisher generates get and set accessor methods for each of the object's attributes, and optionally generates a wrapper method for each of the object's stored procedures. A wrapper method is a method that invokes a stored procedure that executes in the database. Wrapper methods generated by JPublisher are always instance methods even when the original object methods are static.
The following table summarizes the types of Java classes that JPublisher generates for objects.
Table 28-1 Mapping SQL Type to Java Class
| SQL type | Java class mapping |
|---|---|
| user-defined object type | Java class with accessor methods to get and set each attribute of the object, and optional wrapper methods to call the object's stored procedures. |
| VARRAY, nested table, index-by table. | Java classes that can get and set the following:
|
| REF to an object type | Java class to get and set the object to which the REF refers. |
Classes generated by JPublisher implement either the oracle.sql.CustomDatum interface or the java.sql.SQLData interface. Either interface makes it possible to transfer object type instances between the database and your Java program. It is recommended that you use the oracle.sql.CustomDatum interface.
PL/SQL Packages and JPublisher
You might want to call stored procedures in a PL/SQL package from your Java application. The stored procedure can be implemented in PL/SQL, or it can be a Java method that has been published to PL/SQL. Java arguments and functions are passed to and returned from the stored procedure.
To help you do this, you can direct JPublisher to create a class containing a wrapper method for each subprogram in the package. Like object methods, the wrapper methods generated for each subprogram are always instance methods even when the original method is static. The wrapper methods that JPublisher generates provide a convenient way to invoke PL/SQL stored procedures from Java code or to invoke a Java stored procedure from a client Java program.
JPublisher lets you generate Java wrappers by selecting an individual package, or by selecting the Packages node to select all of the packages in the schema. If you call PL/SQL code that includes subprograms at the top-level, JPublisher generates a single class containing a wrapper method for each top-level subprogram.
For PL/SQL functions, whether you generate Java for a single PL/SQL function or multiple functions, JPublisher generates a single class. For a single function, the class contains a single wrapper method for the function. For multiple functions, the class contains a wrapper method for each function.
For PL/SQL procedures, whether you generate Java for a single PL/SQL procedure or multiple procedures, JPublisher generates a single class. For a single procedure, the class contains a single wrapper method for the procedure. For multiple procedures, the class contains a wrapper method for each procedure
Java Mapping Options
The mapping options you select for data type categories determine the set of type mappings that JPublisher uses to translate object types and PL/SQL packages into Java classes:
usertypes category) JPublisher generates CustomDatum classes or SQLData classes and generates code for collection and REF types. You may select from the following mapping options:
For more information, see the Oracle Database JPublisher User's Guide.
Mapping Built-in Types
Syntax: jpub.builtintypes={jdbc|oracle}
The builtintypes parameter (and its JPublisher wizard equivalent Built-in Types) controls type mappings for all the built-in database types except the LOB and BFILE types (controlled by the lobtypes parameter) and the different numeric types (controlled by the numbertypes parameter). The following table lists the database types affected by the builtintypes parameter, and shows their Java type mappings for builtintypes=oracle and for builtintypes=jdbc (the default).
Table 28-2 Built In Mapping Types
| PL/SQL Data Type | Oracle Mapping Class | JDBC Mapping |
|---|---|---|
|
|
|
|
|
|
|
|
|
|
|
|
Mapping LOB Types
Syntax: lobtypes={jdbc|oracle}
The lobtypes parameter (and its JPublisher wizard equivalent LOB Types) controls type mappings for the LOB types. The following table shows how these types are mapped for lobtypes=oracle (the default) and for lobtypes=jdbc.
Table 28-3 LOB Type Mapping
| PL/SQL Data Type | Oracle Mapping Class | JDBC Mapping Class |
|---|---|---|
|
|
|
|
|
|
|
|
The BFILE type does not appear in this table, because it has only one mapping. It is always mapped to oracle.sql.BFILE, because there is no java.sql.BFILE class.
Mapping Numeric Types
Syntax: jpub.numbertypes={jdbc|objectjdbc|bigdecimal|oracle}
The numbertypes parameter (and its JPublisher wizard equivalent Number Types) controls type mappings for numeric PL/SQL types. Four choices are available:
jdbc mapping maps most numeric database types to Java primitive types such as int and float, and maps DECIMAL and NUMBER to java.math.BigDecimal. objectjdbc mapping (the default) maps most numeric database types to Java wrapper classes such as java.lang.Integer and java.lang.Float, and maps DECIMAL and NUMBER to java.math.BigDecimal. bigdecimal mapping maps all numeric database types to java.math.BigDecimal. The oracle mapping maps all numeric database types to oracle.sql.NUMBER. oracle mapping maps all numeric database types to oracle.sql.NUMBER. The following table lists the PL/SQL types affected by the numbertypes option, and shows their Java type mappings for numbertypes=jdbc and numbertypes=objectjdbc (the default).
Table 28-4 Numeric Type Mapping
| PL/SQL Data type | JDBC Mapping Class | Object JDBC Mapping |
|---|---|---|
|
|
|
|
|
|
|
|
|
|
|
|
Mapping User-Defined Types
Syntax: jpub.usertypes={oracle|jdbc}
The usertypes parameter (and its JPublisher wizard equivalent User Types) controls whether JPublisher generates CustomDatum classes or SQLData classes for user-defined types:
usertypes=oracle (the default), JPublisher generates CustomDatum classes for object, collection, and REF types. When usertypes=jdbc, JPublisher generates SQLData classes for object types. JPublisher does not generate anything for collection or REF types. Use java.sql.Array for all collection types, and java.sql.Ref for all REF types.
JPublisher generates a Java class for each object type that it translates. For each object type, JPublisher generates a type.java file (or a type.sqlj file if wrapper methods were requested) for the class code and a typeRef.java file for the code for the REF class of the Java type. For example, if you define an EMPLOYEE PL/SQL object type, JPublisher generates an employee.java file and an employeeRef.java file.
For each collection type (nested table or VARRAY) it translates, JPublisher generates a type.java file. For nested tables, the generated class has methods to get and set the nested table as an entire array and to get and set individual elements of the table. JPublisher translates collection types when generating CustomDatum classes but not when generating SQLData classes. JPublisher does not generate a typeRef.java file for nested tables or VARRAYs. This is because PL/SQL does not allow a REF to be made to these types.
For PL/SQL packages, JPublisher generates classes containing wrapper methods as SQLJ files. JPublisher also generates method wrappers in your class that invoke the associated package methods executing in the server. This is specified by the Include Methods option.
| Note: Since version 8.1.6, the wrapper methods that JPublisher generates to invoke stored procedures are in SQLJ only. Classes generated by JPublisher that contain wrapper methods must be compiled by SQLJ. |
A properties file is an optional text file where you can specify frequently used parameters or parameters that you cannot specify in the JPublisher wizard. Note that if you need only the default output of JPublisher, then you do not need a properties file.
The properties file is designated in the JPublisher wizard.
In a properties file, you enter one (and only one) parameter and its associated value on each line. Each parameter name must be preceded with the prefix "jpub." and you cannot use any white space within a line. You can enter any parameter except the props parameter in the properties file. JPublisher processes the parameters, in order, from the top of the list to the bottom. If you specify a parameter more than once, JPublisher uses the last encountered value.
A properties file might contain the following:
You can enhance the functionality of a custom Java class generated by JPublisher by adding methods and transient fields to it. For example:
The Declaration Name and Use Name fields in the JPublisher wizard give you the flexibility of extending generated classes. In the Declaration Name field, enter the name of the class that you want JPublisher to generate from the given database object. In the Use Name field, enter the name of the class that your Java program will use to represent the database object.
When publishing an object type where Use Name is different from Declaration Name, JPublisher creates a declaration_name.sqlj file and a use_nameRef.java file, where use_name represents the object type in your Java program.
JPublisher expects that you have written the class use_name, which extends declaration_name. If you do not provide this class, then the use_nameRef.java file will not compile.
For example, suppose you want JPublisher to generate the class JAddress from the PL/SQL object type ADDRESS. You have also written a class, MyAddress, to represent ADDRESS objects, where MyAddress either extends the functionality provided by JAddress or has a JAddress field.
Under this scenario, select ADDRESS in the Database Browser and right-click Generate Java. In the JPublisher wizard, enter JAddress in the Declaration Name field and MyAddress in the Use Name field. JPublisher will generate the custom Java class JAddress, and map the ADDRESS object to the MyAddress class—not to the JAddress class. JPublisher will also produce a reference class for MyAddress, not JAddress.
This is how JPublisher will alter the code it generates:
MyAddressRef rather than JAddressRef. MyAddress class, instead of the JAddress class, to represent attributes whose database type is ADDRESS. This situation occurs in classes generated by JPublisher, or in classes written by the user. MyAddress class, instead of the JAddress class to represent VARRAY and nested table elements whose database type is ADDRESS. MyAddress factory, instead of the JAddress factory, when the CustomDatumFactory interface is used to construct Java objects whose database type is ADDRESS. This situation will occur both in classes generated by JPublisher, and in classes written by the user. The class that you create (for example, MyAddress.java) must have the following features:
CustomDatum interface. The simplest way to do this is to inherit the toDatum() method from the superclass. CustomDatumFactory interface, either in the same class or in a different one. For example, you could have a class Employee that implements CustomDatum and a class EmployeeFactory that implements CustomDatumFactory. JPublisher options can be set for these types of PL/SQL subprograms in your schema.
How to Set JPublisher Options
JPublisher options can be set for these types of PL/SQL subprograms in your schema:
For more information, see the Oracle Database JPublisher User's Guide.
To set JPublisher options for PL/SQL subprograms in a schema:
How to Generate Classes for Packages and Wrapper Methods for Methods
Set the JPublisher methods option in the JPublisher wizard by checking Include Methods
The value of the methods option determines whether JPublisher generates classes for PL/SQL packages and wrapper methods for methods in packages and object types.
If selected, JPublisher generates PL/SQL classes and methods. This is default behavior.
If not selected, JPublisher does not generate PL/SQL classes and methods.
How to Omit the Schema Name from Generated Names
Set the JPublisher omit_schema_names option in the JPublisher wizard by checking the Omit Schema Names box.
The value of the omit_schema_names option determines whether certain object type and PL/SQL wrapper names generated by JPublisher include the schema name. If an object type or wrapper name generated by JPublisher does not include the schema name, the type or wrapper is looked up in the schema associated with the current connection when the code generated by JPublisher is executed. This makes it possible for you to use classes generated by JPublisher with a connection other than the one used when JPublisher was invoked. However, the type or package must be declared identically in the two schemas.
If selected, an object type or wrapper name generated by JPublisher is qualified with a schema name only if either:
That is, an object type or wrapper from another schema requires a schema name to identify it, and the use of a schema name with the type or package in the properties file or INPUT file overrides the omit_schema_names option.
If not selected, every object type or wrapper name generated by JPublisher is qualified with a schema name. This is default behavior.
How to Set the Package Name for Generated Classes
The package option specifies the name of the Java package JPublisher generates. The name of the package appears in a package declaration in each Java file. The directory structure also reflects the package name. An explicit name in the INPUT file, after the sql option, overrides the value given to the package option.
To set the package option:
A Java stored procedure is a Java method that resides and runs in a database. Stored procedures can help improve the performance of database applications because they are efficient: they are stored in the RDBMS in executable form, and run in the RDBMS (rather than the client) memory space.
Use JDeveloper to write methods in Java for new stored procedures and deploy them to Oracle Database. When you deploy a Java class to Oracle, you can select the methods that you want to publish to PL/SQL for use as stored procedures. Methods can be deployed together in a package or separately.
For more information, see "Developing Java Stored Procedures" in the Oracle Database JPublisher User's Guide.
A stored procedure is a program that resides and runs in a database. Application developers can use stored procedures to help improve the performance of a database application. Procedure calls are quick and efficient because a stored procedure is compiled once and stored in an executable form. Because a stored procedure runs in the RDBMS memory space, complex functions run faster than a routine run by a client. You can also use stored procedures to group PL/SQL statements so that they are executed in a single call. This reduces network traffic and improves round-trip response times. By designing applications around a common set of stored procedures, you can avoid redundant coding and increase your productivity.
A Java stored procedure contains Java public static methods that are published to PL/SQL and stored in Oracle Database for general use. To publish Java methods, you write call specifications, that map Java method names, parameter types, and return types to their PL/SQL counterparts. This allows a Java stored procedure to be executed from an application as if it were a PL/SQL stored procedure. When called by client applications, a Java stored procedure can accept arguments, reference Java classes, and return Java result values.
Figure 28-4 Java Stored Procedure Deployment

Any Java class can be deployed to Oracle Database and the conforming methods of the class can be published to PL/SQL as stored procedures. These Java stored procedures can then be executed from an application as if they were PL/SQL stored procedures. Java stored procedures can be an entry point for your application into other (Java and non-Java) procedures deployed to Oracle Database.
Deploying and publishing Java stored procedures to Oracle Database generates call specifications that act as PL/SQL wrappers for each of the methods selected for publishing. The PL/SQL wrappers allow the stored procedures to be accessible from SQL*Plus, JDBC, or any other Oracle application environment.
The call specifications (the PL/SQL wrappers) for Java stored procedure packages and methods deployed to a database schema can be inspected through Oracle Database connection. Only published Java stored procedures appear as PL/SQL blocks, and only public static methods in Java classes can be published to PL/SQL when deployed. Java classes can be deployed without being published, in which case they are not seen in the PL/SQL nodes.
Depending on how Java stored procedures were published, they appear in one of the following nodes under a schema:
To view a Java stored procedure's call specification, find its node in the schema's hierarchy, and double-click it.
How to Create Java Stored Procedures
You create Java stored procedures by first developing business application logic in a Java class file. Declare methods that are to become stored procedures as public static.
Use the editor in JDeveloper to add and edit business logic in the Java class. During deployment to Oracle Database, all public static methods included in the class file are available to be published to PL/SQL as stored procedures. You can choose which public static methods in the class to be published to PL/SQL.
There are different JDeveloper Java stored procedure creation scenarios:
For example, assume the following Java package Welcome was created with the public class Greeting and the public static method Hello().
When this package is deployed to Oracle Database and the Hello() method is published there, the call spec for the package as viewed in the source editor looks like this:
How to Deploy Java Stored Procedures
You create a deployment profile for Java stored procedures, then deploy the classes and, optionally, any public static methods in JDeveloper using the settings in the profile.
Deploying to the database uses the information provided in the Deployment Profile wizard and two Oracle Database utilities:
loadjava loads the Java class containing the stored procedures to Oracle Database. publish generates the PL/SQL call spec wrappers for the loaded public static methods. Publishing enables the Java methods to be called as PL/SQL functions or procedures. To deploy Java stored procedures in JDeveloper:
How to Create a Deployment Profile for Loadjava and Java Stored Procedures
The Loadjava and Java stored procedure deployment profile is very similar to the simple archive profile, except that the selected contents of the profile will be uploaded into Oracle Database via the command-line tool loadjava or in the case of Java stored procedures, they are stored in Oracle Database for general use.
| Note: Make sure that you have configured a database connection in JDeveloper before you complete this task. |
To create a deployment profile for Loadjava or Java stored procedures in JDeveloper:
If the category or item is not found, make sure the correct project is selected, and select All Technologies in the Filter By dropdown list.
.deploy filename extension. OK when you are done. The newly created storedProc.deploy deployment profile appears in the navigator below the specified project.
storedProc.deploy in the Navigator. Choose from the available context menu options. If a method on the list is dimmed, this indicates a problem with deploying this method as a Java stored procedure. Click Why not? for an explanation.
For more information, see "Developing Java Stored Procedures" in the Oracle Database JPublisher User's Guide.
CREATE PROCEDURE and CREATE FUNCTION SQL statements that are used to customize the stored procedure. CREATE PACKAGE BODY statement corresponding to the packaged procedure or function. CREATE PACKAGE BODY statement corresponding to the packaged procedure or function. How to Deploy to Oracle Databases
If necessary:
| Note: If you are deploying to Oracle9i Database release 2 (9.2) or later, set the compiler's target to 1.1 or 1.2. in the Project Properties dialog, available from the Application menu. |
To deploy Loadjava and Java stored procedures in JDeveloper:
storedProc.deploy which appears in the Navigator below the specified project. Deploy to and select one of the already existing database connections; the Java application's source files are uploaded directly into the selected database. Or, choose New Connection to display the Create Database Connection Wizard.
storedProc.deploy in the Navigator below the specified project and choose Settings. | Note: If you are deploying your files as both compiled files and source files and you have selected either-resolve or -andresolve in the Resolver page, then the deployment profile will only upload the source files. The reason is that when loadjava resolves the uploaded .java source files, loadjava also compiles the .java source files into .class files. You will only see the source files when previewing the loadjava deployment profile settings. |
How to Invoke Java Stored Procedures
The SQL CALL statement lets you call Java stored procedures.
To invoke a Java Stored Procedure using SQL:
Host variables, that is variables declared in a host environment, must be prefixed with a colon. The following examples show that a host variable cannot appear twice in the same CALL statement, and that a subprogram with no parameters must be called with an empty parameter list:
To invoke a Java stored procedure using JDBC:
Create a callable statement object:
prepareCall on the connection with a SQL CALL statement for the stored procedure. For example: | Note: The number of parameters in the stored procedure is represented by the number of place-holders in the SQL call. |
registerOutParameter for each output parameter, identifying it by position, and declaring its type. For example, if the second parameter is an SQL INTEGER (which maps to a Java int), and the third is a SQL VARCHAR (which maps to a Java String), then: To invoke a Java stored procedure using SQLJ:
Return values will be assigned to output and input variables.
To Invoke a Java Stored Procedure using PL/SQL
The CALL statement's arguments can be:
Correlation names are prefixes to column references. Use these names to qualify whether the reference applies to the existing column value of the row being processed by the trigger or the value being written by the triggering event:
An example of a complete trigger definition:
CREATE TRIGGER check_salary
BEFORE UPDATE OF salary ON employee
CALL salaryCheck(:new.job, :old.salary, :new.salary, :old.employeeID)
How to Test Java Stored Procedures
For stored procedures deployed in packages, access the stored procedure by the package name and/or the stored procedure name set during deployment. The package name may be the default name taken from the project or another name entered during deployment. The stored procedure name may be the default name taken from the method name or a name chosen for the stored procedure during deployment. Stored Procedures may also be deployed without packages.
For example, assume a public static method hello()is in the Java package Welcome and the public class Greeting. Further assume it is deployed in a package Openings.
You could execute a PL/SQL query to the deployed stored procedure that executes the public static method deployed there and returns the result. To invoke SQL*Plus from within JDeveloper, right-click a connection or select it from the Tools menu.
With a working connection to the database, your SQL*Plus client could execute the following:
You could execute a PL/SQL query to the deployed stored procedure that executes the public static method deployed there and returns the result. To invoke SQL*Plus from within JDeveloper, right-click a connection or select it from the Tools menu.
With a working connection to the database, your SQL*Plus client could execute the following:
Executing the code displays:
| Note: The reference to the stored procedure call spec uses package.method syntax; the name of the class from which the method originated is not part of the call. |
For stored procedures deployed separately (not in packages), access the stored procedure by the stored procedure name set during deployment. The stored procedure name may be the default name taken from the method name or a name chosen for the stored procedure during deployment.
For example, for a public static method hello() that was deployed as hello from a class greeting and package welcome, you could execute a PL/SQL query to the deployed stored procedure that returns the result.
Assume the above hello() method as the example method, but this time assume it was deployed without a package.
With a working connection to the database, your SQL*Plus client could execute the following:
The executed code displays:
Debug Java stored procedures through a database connection.
To debug PL/SQL:
Additional information is available in Debugging PL/SQL Programs and Java Stored Procedures.
To drop a stored procedure:
You can use JDeveloper to write methods in Java for stored procedures and deploy them to the database.
This chapter includes the following sections:
A Java stored procedure is a Java method that resides and runs in a database. Stored procedures can help improve the performance of database applications because they are efficient: they are stored in the RDBMS in executable form, and run in the RDBMS (rather than the client) memory space.
When you deploy a Java class to the database, you can select the methods that you want to publish to PL/SQL for use as stored procedures. Methods can be deployed together in a package or separately.
JDeveloper lets you run and debug PL/SQL program units. For example, you can specify parameters being passed or return values from a function giving you more control over what is run and providing you output details about what was tested.
| Note: The procedures or functions in Oracle Database can be either standalone or within a package. |
To run or debug functions, procedures, and packages:
INTERPRETED mode. | Note: The breakpoint must be set on an executable line of code. If the debugger does not stop, the breakpoint may have not been set on an executable line of code (verify that the breakpoint was verified). |
| Note: You will have a choice of target only if you choose to run or debug a package that contains more than one program unit |
DBMS_OUTPUT messages will also be displayed. In addition to debugging Java programs, the JDeveloper debugger enables you to debug PL/SQL programs and Java stored procedures in Oracle Databases.
JDeveloper supports both PL/SQL and Java stored procedures debugging in a single IDE tool. When debugging PL/SQL, the source code you are debugging must be stored in Oracle Database. For Java stored procedures, the source code should be in your JDeveloper project and the compiled code should be deployed in the database.
Also, the way the debug action is initiated is different depending on whether you are performing local or remote debugging. When debugging PL/SQL, this distinction is described as follows:
PL/SQL and Java stored procedure debugging information is displayed in the various JDeveloper debugger windows including the Smart Data, Data, Watches, Inspector, Stack, and Classes windows.
The Threads window, Heap window, and Monitors window are not applicable when debugging PL/SQL code.
When debugging PL/SQL, the user can use PL/SQL expressions in the Watches and Inspector windows as well as conditional breakpoints, including table element access; for example, mytable(i*10). This capability includes tables which are declared in functions, procedures, packages, and package bodies.
You can debug a PL/SQL program calling PL/SQL, PL/SQL calling a Java stored procedure (Oracle9i Release 2 and later databases), and a PL/SQL program issuing a SQL statement that fires a trigger.
You can initiate debugging PL/SQL from the following objects:
Any other PL/SQL object can be traced into as long as it meets the prerequisites, and as long as it is invoked from one of the above. For more information, see Section 29.3.3, "Debugging PL/SQL and Java Stored Procedures Prerequisites."
Consider the following when debugging triggers, Java stored procedures, and Oracle object types:
The debugger uses the database's JPDA (Java Platform Debugger Architecture) implementation. JPDA is the industry standard for Java debugging and the JPDA implementation in the database allows you to seamlessly debug Java and PL/SQL.
What You May Need to Know
For local debugging, JDeveloper issues this command for you. For remote debugging, you will need to issue this command in the same session that you use to call the PL/SQL you want to debug.
v_value or V_Value. Package variables are also case-insensitive, but the prefix leading up to the variable name is case-sensitive; for example: The simplest way to add a package variable to the Watches window is to drag and drop the variable from the Data Window or to drag and drop the package from the Classes Window.
When the database debugger is running, for example to debug PL/SQL through a database connection, the ports used are randomly assigned. This can cause problems with firewalls, and to avoid them you can edit the ide.properties file to ensure that a specific port is used.
To specify the port:
jdev_install/jdeveloper/jdev/system/oracle.jdeveloper.release_number/ide.properties. where port_number is the port number you want the debugger to use.
ide.properties. When you restart JDeveloper, the port you specified will be used. You can debug PL/SQL and Java stored procedures in JDeveloper.
Refer to the appropriate section below for additional information.
Ensure that the following prerequisites have been met before performing PL/SQL debugging:
DEBUG ANY PROCEDURE
DEBUG CONNECT SESSION
INTERPRETED mode. You cannot debug PL/SQL code that is compiled in NATIVE mode. You set this mode in the database's init.ora file. See Oracle Database documentation for more information about this file. DEBUG option enabled. Choose one of these techniques to accomplish this task: ALTER SESSION SET PLSQL_DEBUG = true, then create or recompile the object you want to debug. ALTER <procedure, function, package> <name> COMPILE DEBUG; Ensure that the following prerequisites have been met before performing Java stored procedures debugging:
When locally debugging PL/SQL programs, the call to initiate debugging is made directly from within JDeveloper. JDeveloper automatically launches the program you want to debug, also referred to as the debuggee process, and then attaches the debugger to that program.
Make sure that you've completed the prerequisites listed above.
To locally debug a PL/SQL program in JDeveloper:
| Note: The breakpoint must be set on an executable line of code. If the debugger does not stop, the breakpoint may have not been set on an executable line of code (check that the breakpoint was verified). Also, verify that the debugging PL/SQL prerequisites were met. In particular, make sure that the PL/SQL program is compiled in INTERPRETED mode. |
The main difference between remote debugging and local debugging PL/SQL programs is how you start the debugging session. For remote debugging, you must manually launch the program you want to debug with an Oracle client such as SQL*Plus, Dbms_Job, an OCI program, or a trigger firing. You must then establish the connection from the database program you want to debug (debuggee) to the JDeveloper debugger. After the debuggee is launched and the JDeveloper debugger is attached to it, remote debugging is very similar to local debugging.
You can use the debugger with PL/SQL programs and Java stored procedures in Oracle Database.
Make sure that you've completed the documented prerequisites, listed in Section 29.3.3, "Debugging PL/SQL and Java Stored Procedures Prerequisites."
To remotely debug a PL/SQL program using JDeveloper:
| Note: If you want to bypass this dialog the next time you are debugging on this port, select the Save Parameters check box from this dialog.In the Run Manager window, you should see which indicates that the debugger is listening for debugging connections. |
For example, if you are using SQL*Plus, issue the following commands to open a TCP/IP connection to the designated machine and port for the JDWP session:
where 123.456.789.012is the IP address or host name where JDeveloper is running, and 4000 is the port number on which the debugger is listening.
From this point on, when you make a call to the PL/SQL code containing the breakpoint, the JDeveloper debugger is activated.
In addition, notice that the layout in JDeveloper has switched from Design layout to Debugging layout (bottom-right of window). Also, the debugging windows including Stack, Data, and Watches, should now be visible.
In the Run Manager, an icon indicates that the port is continuing to listen and can accept multiple debugging connections.
where FOO is the name of a PL/SQL procedure.
The following message appears:
If you are debugging PL/SQL, then you can use PL/SQL expressions in the Watches window, Inspector window, Breakpoint conditions, and Breakpoint Log expressions.
The following table lists examples of acceptable legal PL/SQL expressions that you can use in the debugger.
Table 29-1 PL/SQL Expressions that can be used in the debugger
| PL/SQL Expression | Example |
|---|---|
| Simple variable name |
|
| Field Access |
|
| Table element |
|
| Comparison operation |
|
| Arithmetic operation |
|
| Logical operation |
|
| Package variable name |
|
| Fully-qualified Package name |
|
| PackageBody variable name |
|
| Fully-qualified PackageBody name |
|
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